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The shipping of Microsoft Windows NT 3.1, in August 1993, marked the beginning 
of a new era in microcomputing. 

Windows 3.1 and Windows for Workgroups, the two current MS-DOS-based 
versions of Windows, represented the acme of 1980s sophistication, allowing users 
to run powerful applications in an easy-to-Iearn, easy-to-use graphical multitasking 
environment. But Windows and Windows for Workgroups were 16-bit extensions to 
an 8-bit, single-tasking operating system that, in its very first incarnation, had been 
aptly nicknamed QDOS-for quick and dirty operating system. 

Windows 3.1 and Windows for Workgroups brought MS-DOS to levels of power 
and convenience that were undreamed of even in the mid-1980s. But they could not 
adequately support the passage of line-of-business applications from mainframes and 
minicomputers to desktop networks. This dominant trend of the 1990s demanded 
32-bit power and performance, better security, built-in networking support, and 
above all greater robustness and fault tolerance. To meet these needs, Microsoft 
developed Windows NT. 

Windows NT's major design features include the following: 

13 Preemptive multitasking. Earlier versions of Windows supported a non­
preemptive form of multitasking, in which the performance of the system 
depended on the good behavior and cooperation of each running applica­
tion. Applications shared processor time by periodically "yielding the floor" 
to the next application in line. If an application refused to yield, there was 
little the operating system could do about it. 
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Windows NT, in contrast, is a preemptive multitasking environment. 
Because the operating system is always in control, applications share 
processing resources more efficiently, and a "bad app" can never bring the 
entire system down. 

• Built-in networking support. Unlike most earlier microcomputer oper­
ating systems, Windows NT was designed from the ground up with 
networking in mind. As a result, facilities for sharing files, devices, and data 
objects are completely integrated into the Windows NT user interface. 
Administrators can centrally manage and monitor enterprise-wide networks. 
And, perhaps most important, the operating system provides the means for 
client-server applications ~o distribute their work across multiple computer 
systems. 

a Security. Windows NT meets the United States government's Class C2 
security specification, which means that the owner of a resource (a file, 
directory, printer, or shared data object, for example) can maintain control 
over access to that resource. You can specify multiple permission levels for 
resources, granting particular users or groups of users the appropriate level 
of access for each resource. And the operating system can detect who has 
successfully or unsuccessfully accessed any resource. 

• Multithreading. Windows NT supports multithreading, allowing appro­
priately designed applications to multitask their own processes. With a 
multithreading spreadsheet, for example, you might be able to recalculate 
one worksheet file while printing a second and loading a third into memory. 

• Support for symmetric multiprocessing. Windows NT supports com­
puters that incorporate multiple processors. Such systems will become 
common as more and more minicomputer and mainframe applications are 
redesigned for desktop networks. By assigning separate threads to separate 
processors, Windows NT can deliver superior performance for compute­
intensive applications. 

• Support for a wide range of computing platforms. When it shipped, 
Windows NT supported the Intel x86line of microprocessors (80386, 80486, 
and Pentium), as well as two RISC (reduced instruction set) platforms: Digital 
Equipment Corporation's Alpha and the MIPS R4000. The bulk of the 3.5 
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million lines of code in Windows NT are written in high-level programming 
languages (C and C++), with only a small portion encoded in machine­
specific assembly language. Because these hardware-specific portions are 
isolated in a "hardware abstraction layer" (HAL), porting Windows NT to 
other computing platforms will be relatively easy. In the near future you 
can expect to see versions of Windows NT running on a number of 
additional systems. 

• The ability to run applications written for other operating systems. 
Experience has shown that a new operating system cannot succeed unless 
it runs programs written for earlier systems. Windows NT incorporates 
subsystems for "Windows 16" (Windows 3.1 and Windows for Workgroups), 
MS-DOS, character-mode OS/2, and POSIX. With very few exceptions, you 
can count on being able to run all Windows-based applications under 
Windows NT, whether or not they were written specifically for Windows 
NT. MS-DOS-based programs, character-mode programs for OS/2, and 
POSIX-compliant UNIX-based applications should also run "out of the box" 
under Windows NT. 

II Support for multiple ide systems. In addition to supporting applications 
written for earlier operating systems, Windows NT also supports those 
systems' methods of organizing files on disk. You can format hard disks 
under Windows NT in any of three file systems: NTFS, FAT, and HPFS. NTFS 
is the file system deSigned specifically for Windows NT. The benefits of 
NTFS include long filenames and the ability to control and monitor access 
to particular files. (Without NTFS, you can control access to directories, but 
you can't set separate permission levels for individual files within directo­
ries.) FAT, which stands for file allocation table, is the file system used by 
MS-DOS and earlier versions of Windows: Use FAT if you want to share 
directories with computers running MS-DOS or MS-DOS-based versions of 
Windows. HPFS, the High Performance File System, is the native file system 
of OS/2; you might want to use HPFS if you share resources with other 
systems running OS/2. 

a A familiar user interface. If you're one of the millions of users who 
already work under another version of Windows, you'll appreciate the fact 
that Windows NT looks and feels almost exactly like the environment you 
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already know. Because the essential details of organizing files, starting and 
switching between programs, navigating through menus and dialog boxes, 
and customizing the working environment are practically the same under 
Windows NT as under Windows 3.1 or Windows for Workgroups, you can 
get started immediately and do productive work from the first day. Windows 
NT has advanced features not found in earlier versions, but you can get 
acquainted with them as you go, and this book can serve as your guide. 

About This Bool{ 
This book has five parts. The first part, Chapters 1 through 5, introduces you to 
the Windows NT user interface. Even if you're thoroughly familiar with Win­
dows 3.1 or Windows for Workgroups, you might want to scan through these 
chapters, because a few details are new in Windows NT. Program Manager, for 
example, now supports two kinds of program groups, and Control Panel in­
cludes some utilities that were not present in earlier versions. 

Part 2, Chapters 6 through 9, addresses networking issues. Chapter 6 
provides an overview of the networking features in the desktop and Advanced 
Server versions of Windows NT. Chapter 7 describes the steps involved in 
creating print servers and using shared printers (as well as unshared ones). 
Chapter 8 and Chapter 9 describe Mail and Schedule+, the two "groupware" 
programs shipped with Windows NT. 

Part 3, Chapters 10 through 14, is called "Security and Administration." 
Here you'll learn about passwords, permissions, and rights, the file-specific 
security features available with NTFS, how to audit users' access to shared 
resources, how to manage user accounts, and how to use the tape backup 
program provided with Windows NT. 

Part 4, "Using Applications," includes some material that will be familiar 
to users of earlier Windows versions, and some that will not be familiar. Write, 
Terminal, Paintbrush, and the desktop accessories (Clock, Calculator, Notepad, 
and so on) are nearly the same as their predecessors. (One important change: 
Notepad can now read and edit files greater than 64 KB.) But even if you're a 
Windows 3.1 veteran, don't skip this part entirely. Chapters 19 and 20 describe 
the powerful Windows NT command-prompt utility. The command prompt 
provides an alternative way to launch programs. More important, you can use 
it to run programs at particular times of day and to create batch files and logon 
scripts. 
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Finally, Part 5 includes three chapters that cover maintenance and system­
management issues. Here we describe how to use the Windows NT Disk Man­
ager and Performance Monitor programs, as well as how to use the Setup 
program to update equipment settings. 

Welcome to Windows NT! 
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Getting Acquainted 
with Windows NT 

Starting and Ending a Windows NT Session 
Type Ctrl + Alt+ Del and introduce yourself. 

Starting and Ending Programs 
A double-click in Program Manager, and you're ready to get to work. 

Switching Between Programs 
Press Alt+Tab or summon the Task List. 

Working with Windows 
Windows come in two flavors-application windows and document win­
dows. Both share a set of common landmarks. 

Working with Menus and Dialog Boxes 
Belly up to the menu bar, and enter into a dialog. 

Using Scroll Bars 
Scroll bars let you move quickly through documents of any size. 
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Creating, Opening, and Saving Files 
You'll see similar dialog boxes-and use similar techniques-for working 
with files in most applications for Windows. 

Entering and Editing Text in Documents 
The basic maneuvers are the same in almost all Windows-based programs 
that use text. . 

Working with Graphics 
A few generalizations can be made about manipulating graphic images. 

Working with Fonts 
A little knowledge about typography will help you generate documents 
that make an impact. 

Geffing Help 
Windows NT comes with a superb hypertext Help system. 
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37 
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his chapter introduces the Windows NT user interface. We'll look 
at the procedures for starting and ending a Windows NT session, 

starting and ending programs, switching between programs, opening and 
saving documents, and so on. We'll also take a brief tour through menu 
bars, tool bars, icons, buttons, and dialog boxes-the features you'll be 
relying on every day as you use Windows NT. 

Starting and Ending 
a Windows NT Session 

To start a Windows NT session on a computer that's turned off, first be sure 
there's no disk in drive A, and then turn on the system. In a moment or 
three, you'll be in Windows NT. 

If your computer has been set up to run two different operating 
systems-Windows NT and MS-DOS, for example-you'll arrive first at the 
flex-boot screen. You'll see the names of the available operating systems 
and a countdown timer. If you do nothing, Windows NT will start when 
the countdown expires. To avoid the countdown delay, be sure Windows 
NT is highlighted (move the highlight with the direction keys if necessary), 
and then press Enter. 

If your system is set up to run both Windows NT and MS-DOS, and 
it's currently running MS-DOS, you can switch to Windows NT by pressing 
Ctrl+Alt+Del or pressing your computer's hardware reset button. (Be sure 
all your MS-DOS work is saved before you do this!) In a moment, you'll be 
at the flex-boot screen. 

Logging On 
When Windows NT is ready, it displays a welcome message and invites you 
to log on. You do that by pressing Ctrl+Alt+Del. If you're accustomed to 
using MS-DOS (or Windows 3.1 or Windows for Workgroups), you may 
have some initial reservations about pressing Ctrl+Alt+Del. Not to worry­
you'll never lose work in Windows NT by pressing Ctrl+Alt+Del. Rather than 
resetting your entire machine (as it does in MS-DOS) or terminating the 

5 
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current application (as it does in Windows 3.1 and Windows for Work­
groups), Ctrl+Alt+Del invokes a component of Windows NT's security sys­
tem, allowing you to do such things as log on or off. When you press this 
key combination at startup, you arrive at the logon screen, which looks like 
this: 

!!sername: I Craig I 
~I ========::::::;IUj.~ .. ~' born: ~O_M_N_I1 ________________ •. ~_ 

~assword: I 

To get past this sentry, you need to provide three pieces of informa­
tion-your user account name, the name of your computer or domain, and 
your password. The first two are filled out with the entries last used, so if 
you were the last person to use Windows NT on this machine, all you need 
to do is type your password and click OK. 

After you've identified yourself, Windows NT comp~etes the logon 
pro~ess by restoring your personal working environment, including your 
Program Manager setup, your choice of wallpaper and screen colors, your 
mouse and keyboard option settings, your home directory and local path, 
and any network-drive connections you've established. For more informa­
tion about restoring network-drive connections at startup, see "Maintaining 
Connections Between Sessions," page 106. 

If a logon script has been associated with your user account, the 
commands in that script are executed. A logon script is like an AUTO EXEC 
batch file in the MS-DOS world-a program that's run automatically on 
startup. Your system administrator might have created one for you, or you 
can create one yourself. For more information, see "Using Logon Batch 
Files," page 662. 
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Locldng, Logging Off, and Shutting Down 
Windows NT provides three different ways to end or suspend a working 
session. 

Il Locking the system protects your privacy while you're away from 
your machine. It also prevents other users (except ones with admin­
istrative privileges) from taking over your workstation while you're 
away. To lock your system, press Ctrl+Alt+Del and click the button 
marked Lock Workstation. Windows NT displays the Windows NT 
startup logo (so no one can see what you were working on), along 
with a message indicating whet:l and by whom the system was 
locked. 

While your system is locked, progra"ms keep on running. Screen 
savers save, for example, and macros go on executing. Locking 
simply shuts other users out, preventing them from seeing what's 
going on or otherwise interacting with Windows NT. 

To unlock a locked system, press Ctrl+Alt+Del again and type 
your password. 

Il Logging off ends your session with Windows NT but keeps the 
computer running. This is a good choice if someone else will be 
using the system after you. You'll also want to log off, as opposed 
to· shutting down, when you are sharing any of your workstation's 
directories or local printers with other users on the network. Such 
resources continue to be available after you log off. 

To log off, press Ctrl+Alt+Del and click the Logoff button. (You 
can also log off by choosing the Logoff command on Program 
Manager's File menu.) Windows NT asks you to confirm that you 
want to end your session. Then it closes each running application, 
after first polling to see if there are any objections to the logoff. If 
you have unsaved work in any program, that program gives you 
the opportunity to save before it closes. If you happen to be 
running a program that cannot be safely terminated at that moment 
(for example, because it's busy writing to disk), you'll see a differ­
ent message, inviting you to log off later. 

7 
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C Shutting down your system means turning it off, rendering all local 
resources unavailable to other users on the network. The only safe 
way to do this is by means of the Shutdown command. Never simply 
turn off your computer. You'll find the Shutdown command in two 
places-in the set of buttons that appears when you press 
Ctrl+Alt+Del, and on Program Manager's File menu. 

When you choose the Shutdown command, Windows NT closes. 
all running applications, just as it does when you log off. Then it 
performs various other housekeeping chores, and finally it displays 
a message saying that it's safe to turn off the power. It is most 
important that you do not interrupt this process. Don't power down 
or hit the hardware reset button until you get the safe-to-quit 
message. 

Starting and lending Programs 
Unless your user account has a logon script that takes you elsewhere, the 
logon process leaves you in the Windows shell program called Program 
Manager. (For more information about Program Manager, see Chapter 2, 
"Managing Programs with Program Manager," page 55. For now, just note 
that this is the place from which you normally start your applications.) 

In the typical Windows setup, each installed program has one or more 
icons in Program Manager. Double-clicking the program's icon starts the 
program. 

To quit a running program, you can look for an Exit command (in 
most cases you'll find one on the program's File menu), or you can double­
click the Control-menu box, which is the broad horizontal bar in the upper 
left corner of the program's window. 

Killing a Bad Application 
As long as there are programs and programmers, there will also be bugs. If 
an application stops responding, you'll need a way to put it out of its misery 
and restore order to your system. In Windows 3.1 or Windows for Work­
groups, you do this by pressing Ctrl+Alt+Del to perform a "local reboot." 



Chapter 1: Getting Acquainted with Windows NT 

In W~ndows NT, the approved mercy-killing method is the End Task button 
in Task List. For more information about Task List, see "Using Task List," 
page 10. 

When you terminate a program in this manner, you might see a mes­
sage similar to the following: 

Microsoft Word - C:\WRITING\MSPRESS\RWNT\CH 

T his Windows application is not responding to the system. 
It may be busy, waiting for a response from you, or it may 

have crashed. 

o Press Cancel to cancel and return to Windows NT. 

o Press End T ask to close this application immediately. 
You will lose any unsaved information in this application. 

o Press Wait to give the application 20 seconds to finish 
what it is doing and then try to close the application 
again. 

As the message says, terminating a program with Task List causes you 
to lose any unsaved work in that program. It's a good idea, therefore, to try 
the Wait button first. 

Switching Beilween Progr91ms 
Windows NT is a multitasking system, so you can run as many programs at 
once as memory permits. You can also run multiple copies of certain pro­
grams. Some programs permit this; others do not. 

Windows NT offers several ways to switch between running programs. 
If the program you want to switch to is visible, simply click anywhere in its 
window. If it's not visible, you can switch by holding down the Alt key and 
pressing Tab. Each time you press Tab, Windows displays the name of the 
"next program in line." When you get to the one you want, release the Alt 
key. 

9 
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If you don't see program names in the center of your screen when you 
press AIt+Tab, you can make them appear by going to the Desktop section 
of Control Panel and selecting Fast "AIt+Tab" Switching. For more informa­
tion, see "Changing the Behavior of AIt+Tab, " page 147. 

KEYBOARD TIP: If you accidentally AIt+Tab past the 
program you're trying to switch to, continue holding down 
the AIt key, and then hold down the Shift key and press 
Tab again. Shift+Alt+Tab works exactly like AIt+Tab, 
except that it cycles through your programs in the opposite 
order. 

KEYBOAR D TIP: When you switch from one program to 
another with AIt+Tab, Windows puts the program you 
switched away from at the top of the stack. A single 
AIt+ Tab will then take you back to that program. This 
provides an efficient way to toggle back and forth between 
two programs. 

Using Tasl< List 
Pressing Ctrl+Esc summons a handy tool called Task List, shown on the next 
page. Task list may be the quickest way to switch programs when you have 
several programs running at once. You can switch by double-clicking the 
name of the program you want to switch to, or clicking that name once and 
then clicking the Switch To button. 

Task List has some other handy buttons in addition to Switch To. The 
End Task button terminates your program. The Cascade and Tile buttons 
arrange windows so that 'you can move between them more easily with the 
mouse. And the Arrange Icons button tidies up programs whose windows 
you have "minimized" (reduced to icons). 
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Task List 

raiQ's Pro ram Mana er 
Q uattro Pro for Windows 
File Manager 
Microsoft Word 
Lotus Improy 
Paintbrush - fig01 01 p. bmp 
Lotus 1-2-3 Release .. 
FreeCell Game 17 

H.ew Task: I I ~ 
IriwitChtgJ 1[E.nd~IIr:;r:~;(":/:;:1 
1r;&ai~;·:.II~1Jle.\<:':llfiii_~1 

WINDOWS TIP: Task List's Tile button is useful even 
W when you have only one open window. If you tile that 
W lone open window, Task List makes it as large as it can be 

without obscuring the icons at the bottom of your desktop. 

Working with Windows 
All applications for Windows run within rectangular frames called windows. 
Here are some important features common to all windows: 

Borders. The four edges that define the perimeter of the window are called 
borders. 

Tide bar. Directly below the top border of the window is a region that 
includes the window's name. This part of the window is called the title bar. 

Control-menu box. Just to the left of the title bar is a little box with a big 
dash inside. This is the Control-menu box. 

Sizing buttons. In the upper right corner of the window is a pair of 
arrows-one pointing down, the other pointing up. These are called sizing 
buttons. They're used to minimize and maximize the window, respectively. 

11 
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Menu bar. Directly below the title bar is the menu bar. The menu bar 
provides access to most of an application's commands. 

"\'lbrk area. The inside of a window is called the work area, or workspace. 

Maximizing, Minimizing, and Restoring 
Whenever you start a program, Windows chooses a size and a position for 
the program's window. That size and position depend on what else you 
have on your desktop and probably won't be the same each time you start 
the program. In most cases, the window will fill something less than your 
entire screen. 

When you want to focus all your attention on a particular program, 
you'll probably want to devote as much screen space as possible to that 
application. You can do so by maximizing the application's window. Here 
are two ways to maximize a window: 

a If you have a mouse, click the window's maximize button-the 
upward-pointing arrow in the upper right corner of the window. 

III If you don't have a mouse or you prefer to use the keyboard, press 
AIt, Spacebar, X. 

When you maximize a program, the button in the upper right corner 
of the window is replaced by a restore button-a double-headed arrow 
pointing up and down. Clicking the restore button returns a window to its 
pre-maximized size. 

MOUSE TIP: You can also maximize or restore a win­
dow by double-clicking its title bar. 

When you want to keep a program running but get it out of your way, 
you can click the downward arrow to minimize it. Your window then 
collapses into an icon at or near the lower edge of your screen. 
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Each Windows-based application you use has its own distinctive icon, 

so you can see at a glance what minimized applications you have on your 
desktop. (And just in case you forget what a program's icon looks like, 
Windows displays the program's name under the icon.) 

To return a minimized program to its former size, double-click the 
icon. (With the keyboard, press AIt, Spacebar, R) This action is also called 
restoring. 

~
{ 

. +,~.: ~;.: .. ),,,,.~ .. 

1 

MOUSE TIP: If a ~enu pops up out of the icon when 
you double-click it, it's probably because you moved the 
mouse slightly between the two clicks. Double-clicking 
takes a little practice. You can restore the window' from 
this menu by clicking the word Restore. 

Moving and Sizing Windows 
In addition to maximizing, minimizing, and restoring windows, you can also 
move them around on your desktop and expand or contract their borders. 

To move a window with the mouse, drag its title bar. That is, put the 
mouse pointer anywhere on the title bar, press and hold the primary mouse 
button, move the mouse in the direction you want the window to move, 
and then release the mouse button. The window simply follows your mouse. 

NOTE: The left mouse button Is normally the primary mouse 
button. You can make the right button the primary button by 
going to the Mouse section of Control Panel. For more 
Information, see "Customizing Your Mouse or Other Pointing 
Device," page 142. 

To move a window with the keyboard, start by pressing AIt, Spacebar, 
M. Then use any of the four direction keys to move your window. When 
you get the window where you want it, press Enter. 

To cancel a move, press Esc before releasing the mouse button or 
pressing Enter. The window remains where it was before you began the 
move. 

13 
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WINDOWS TIP: You can move a minimized window the 
same way you move an open one. That is, you can drag 
its icon around with the mouse or you can press AIt, 

. Spacebar, M and use direction keys to relocate the icon. 
It can be helpful to· move icons if you have several 
minimized applications on your desktop at the same time 
and their labels overlap one another. . 

To change the size of a window, move one or more of the window's 
borders inward or outward. Moving a border inward contracts the window, 
and moving it outward expands the window. 

To change the size of a window with the mouse, simply position the 
pointer on the border you want to adjust. The mouse pointer changes from 
a single-headed arrow to a double-headed one. Press and hold the primary 
mouse button, move the border as you please, and then release the button. 

You can move two adjacent borders at once by positioning the mouse 
pointer in the corner where those borders meet. 

To change a window's size with the keyboard, start by pressing AIt, 
Spacebar, S. A four-headed pointer appears in the center of the window. 
Use one of the direction keys to move that pointer to the border whose 
position you want to adjust. Then use the direction keys to adjust the border. 
When you're happy with the border's position, press Enter. 

To cancel a sizing operation, press Esc before releasing the mouse 
button or pressing Enter. 

Application Windows and Document Windows 
Windows come in two broad categories, called application windows and 
document windows. Programs run within application windows. Programs 
that allow you to work with two or more documents at once (some programs 
permit this, others do not) display documents within document windows. 
The following illustration shows two open document windows and several 
minimized document windows-all within an application window. 
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Application window 

...... --;:;;;.;;;------------~ir_r_ Document 
windows 

'-----"-- Minimized document windows 

Manipulating Document Windows 
Document windows have a lot in common with application windows. Like 
application windows, document windows can be maximized. To maximize 
a document window with the mouse, click its maximize button or double­
click its title bar. To maximize a document window with the keyboard, press 
Alt, hyphen, X. 

To restore a maximized document window with the mouse, click its 
restore button. To restore a maximized document window with the key­
board, press Alt, hyphen, R. 

If a document window can be minimized (most can), you'll find a 
minimize button in its upper right corner. Click that button, or press Alt, 
hyphen, N to turn the document window into an icon. Double-click the 
icon, or press Alt, hyphen, R to restore the icon to an open document 
window. 

Document windows can be moved and sized in the same way that 
application windows can, but they must stay within the confines of their 

15 
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application windows. The mouse procedures for moving and sizing are 
exactly the same as those for moving and sizing application windows. The 
keyboard procedures begin with Alt, hyphen, M (for moving) and Alt, 
hyphen, S (for sizing). 

Worl<ing with 
Menus and Dialog lBoxes 

One of the big advantages of working with applications for Windows is that 
they all use the same basic methods for entering commands. In virtually all 
applications for Windows, commands are chosen from drop-down menus­
sets of options that emerge from a menu bar at the top of the application 
window. When a program needs additional information from you before it 
can carry out your command, it presents a dialog box-a smaller window 
with places for you to fill in blanks or choose between preset options. These 
devices behave in a consistent and predictable way in all applications for 
Windows. 

The Control Menu and the Menu Bar 
The two main elements of a Windows-based application's menu system are 
the Control menu and the menu bar. The Control menu emerges from the 
Control-menu box-the large dash at the left side of the title bar. The menu 
bar is the row of command words directly below the title bar. 

The Control menu provides a set of generic commands common to all 
applications. With a few exceptions, each program's Control menu includes 
the same commands. 

The menu bar includes commands specific to the particular window's 
application. Each word on the menu bar opens a drop-down menu of related 
commands. For example, an application's File menu includes commands 
for opening and saving document files, the Edit menu has commands for 
changing the contents of a document, and so on. 

Choosing Commands with the Mouse 
To access the menu system with the mouse, simply click the desired word 
in the menu bar. To open the File menu, for ~xample, click the word File. 
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To open the Control menu, click the Control-menu box. To choose a com­
mand from a drop-down menu, click the mouse again on the command 
you want. 

To get out of the menu system without choosing a command, click 
the mouse anywhere outside the drop-down menu. 

Choosing Commands with the Keyboard 
To choose any command with the keyboard, begin by pressing the Ait key. 
When you do that, Windows highlights the first command on the menu bar, 
like this: 

At this point, you can move around the menu bar by pressing the Left 
and Right direction keys. Pressing the Right direction key in the illustration 
above, for example, highlights the word Disk. Pressing it again moves the 
highlight to the word Tree, and so on. If you press the Right direction key 
with the highlight on Help, the highlight moves to the Control-menu box. 
From there it moves to the document window's Control-menu box (see 
"Document Control Menus," page 20), then back to File, and the cycle 
repeats. 

KEYBOARD TIP: You can also access the menu system 
of any application for Windows by pressing FlO. Certain 
applications provide other access keys as well; in Microsoft 
Excel and Quattro Pro for Windows, for example, you can 
reach the menu system by pressing the slash key (j). 

Pressing either the Up or Down direction key opens the drop-down 
menu associated with the highlighted menu-bar word. In the preceding 
illustration, for example, you could press the Down key to open the File 
menu. 

17 
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A more direct way to open a particular drop-down menu is to press 
the underlined letter of the menu you want. For example, to open the 
Options menu in File Manager, do the following: 

1 . Press Alt to access the menu system. 

2. Press 0 (the underlined letter for the Options menu). 

To open the Control menu, press Alt followed by Spacebar. (Think of 
the Control-menu box as a picture of a Spacebar, and you'll never have 
trouble remembering this key combination.) 

After you've opened a drop-down menu, you can choose a command 
in either of the following ways: 

m Use the Up and Down direction keys to highlight the command 
you want, and then press Enter. 

m Press the underlined letter of the command you want. 

To get out of the menu system without choosing a command, press 
Alt or FlO again. Or press Esc. (In some ~pplications, you might need to 
press Esc twice-once to get out of a drop-down menu and a second time 
to leave the menu bar itself.) 

Keyboard Shortcuts 
Some menu commands have keyboard shortcuts assigned to them. These 
are single keystrokes or simple keystroke combinations that execute a com­
mand directly. For example, Shift+ F5 and Shift+ F4 are keyboard shortcuts 
for the Cascade and Tile Vertically commands on File Manager's Window 
menu. 

Keyboard shortcuts, when available, are usually the quickest way to 
choose a command, because you don't have to open a drop-down menu 
to use them. (And Windows doesn't have to redraw the screen to display 
the menu.) 

What's on the Control Menu 
As mentioned before, the Control menu is a standard item on all applications 
for Windows. Typically, it looks like the following illustration. 
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~Iose AIt+F4 

The Control menu includes commands for maximizing, minimizing, 
restoring, sizing, moving, and closing a window. It also includes a command 
(Switch To) that invokes Task List. 

Accessing the Control Menu on a Minimized Application 
You can access a minimized. application's Control menu in either of two 
ways: 

fl Click the application's icon once with the mouse. 

fl Use Alt+Esc to select the application's icon, and then press Alt, 
Spacebar. 

The Control menu pops up from the icon, as shown in the following 
illustration of a minimized File Manager. 

10 
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Document Control Menus 
Document windows do not have menu bars, but they do have abbreviated 
Control menus. You can access a document window's Control menu by 
clicking the little bar in the upper left corner of the window (the document 
Control-menu box) or by pressing AIt, hyphen. 

KEYBOARD TIP: You'll find it easier to remember how 
to access the Control menu if you notice the difference in 
the Control-menu-box icons: The longer horizontal bar in 
the application window's Control-menu box suggests a 
Spacebar, whereas the shorter bar in the document 
window's Control-menu box looks more like a hyphen .. 

Commands That Bring Up Dialog Boxes 
The ellipsis ( ... ) is a punctuation symbol signifying an incomplete com­
mand. In a Windows menu, an ellipsis following a command name means 

. that the command brings up a dialog box. A dialog box is a device used by 
Windows to get more information from you. 

The Ins and Outs of Dialog Boxes 
Dialog boxes come in all sizes and shapes~ Some are simple, others quite 
complex. But nearly all dialog boxes have the following components: 

IJ One or more places for you to enter information or choose options 

D One or more command buttons 

Most dialog boxes have a command button that you click after you've 
filled out the dialog box to your satisfaction and another that you click if 
you want to back out of the dialog box without making an entry. In many 
cases, these buttons are marked OK and Cancel, respectively. But you might 
also see verbs such as "Save" or "Accept" for the OK button and "Escape" 
for the Cancel button. 
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In rare cases, you might find dialog boxes in which the Cancel button 
has been omitted (probably to conserve space or memory). In such dialog 
boxes, you can generally press either Esc or Alt+F4 to back out without 
making an entry. 

Other Dialog Box Elements 
In the section of a dialog box where you enter information or select options, 
you'll encounter the following kinds of elements: 

C Text boxes 

C List boxes 

C Drop-down list boxes 

C Option buttons 

c Check boxes 

A text box is a place for you to type something. The big rectangle next 
to the words Find What in the following illustration is an example of a text 
box. 

- Find 

Find What: 

o Match Whole Word Only 

o Match!;.ase 

Note that the term text here doesn't mean words only, as opposed to 
numbers. In some text boxes, you will be expected to enter numbers-or 
perhaps both words and numbers. 

Occasionally you might find a text box that already has text in it. Such 
text is called a default entry, or default value. A default entry is an entry 
proposed by your application. If you're satisfied with that entry, you can 
simply leave the text box alone to accept it. 

To fill out a text box, click in the box. You'll then see a flashing vertical 
line, which is called an insertion point. If the text box is empty, the insertion 
point appears at the left side of the box. If the box already contains text, 

'1 
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the insertion point is located at the spot where you clicked the mouse. In 
either case, the insertion point marks the spot where the characters you type 
will appear. 

A list box presents a set of options in the form of a list, like this: 

Cartridges (max: 2) --------, 

: Courier 
B: lms Proportional 1 
C: International 1 
D: Prestige Elite 
E: letter Gothic 

Typically, the options in a list box are mutually exclusive, but they 
might not always be. In the printer cartridge list shown above, for example, 
you can select zero, one, or two cartridges. 

If the list contains more items than can be displayed at once in the list 
box, you will find a scroll bar at the right side of the list box. (The example 
above includes a scroll bar.) You can move through the list one item at a 
time by clicking the arrows at the top and bottom of the scroll bar. For more 
information about scroll bars, see "Using Scroll Bars," page 25. You can also 
move through a list box by pressing the Up and Down direction keys, PgUp, 
or PgDn. 

KEYBOAR D TIP: Another way to move quickly through 
a list box is to press the first letter of the item you want to 
move to. Pressing F, for example, takes you directly to the 
first item beginning with F. If you're already on an item 
starting with F, pressing F takes you to the next item be­
ginning with that letter-and so on. This technique works 
in all Windows list boxes and works with numbers as well 
as letters. It's usually the most efficient way to navigate in 
a large list. 

To select an item in a list box with the mouse, simply click the item 
you want. To select with the keyboard, use direction keys or any other 
method to move the highlight to the item you want. 
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In list boxes where you're allowed to select more than one item, the 
technique for making a multiple selection varies somewhat from application 
to application. Consult the docurrientation for the program you're using if 
you're not sure how to proceed .. 

A drop-down list box is an ordinary list box displayed in a more 
compact space. The following illustration shows four drop-down list boxes. 

Resolution: 175 dots per inch Itfl 
Paper Si~e: 1 Letter 8 ~ x 11 in Il!I 

Paper li.ource: IUpper Tray II!) 

.Memory: 1512KB 100 

You can recognize a drop-down list box by the underlined arrow on 
the right. Click that arrow (or press Alt+Down), and an ordinary-looking list 
box unfolds, like this: 

Resolution: 

Paper Si~e: 

Paper li.ource: 

.Memory: 

75 dots per inch lrl 
300 dots per inch 
150 dots per inch 

II I" 

l~ll"U I~ 

KEYBOARD TIP: You can use the first-letter method of 
navigating through a drop-down list box without first 
opening the list box. 

Option buttons (sometimes called radio buttons) present a set of mu­
tually exclusive options. For example, he following pair of option buttons 
lets you choose between portrait and landscape orientation on a LaserJet 
printer. 

Orientation -----, 

@ fortrait 

o !..andscape 
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Some check boxes have three states-checked, unchecked, and gray. 
Usually, a gray check box means that a certain condition applies to some 
of a selection, but not all of it. For example, in the following illustration, 
some of the selected cells in a Microsoft Excel worksheet have been for­
matted as italic. The rest of the cells are in normal type. In the Format Font 
dialog box, therefore, the Italic check box is gray. 

~\~;~~_ ~+~ []~iZ. ~,,>' 
MS Sans Serif 'v, 

:=IH=eIY=======~1 ImIIIIl 
tolor: 

r
samPle 

IffJ _ I Automatic 

Style---, 

o Hold 
[I Italic 
o Underline 
o Stri~eout 

o P!inter Fonts 

If a Dialog Box Gets in the Way 

Ir::OK0~1 
IFfanCet:~~1 

o H. ormal Font 

Many, though not all, dialog boxes appear in windows with title bars and 
Control menus. Like ordinary application and document windows, such 
dialog boxes can be moved. You usually can't change their size, however. 
Moving a dialog box is sometimes useful; you might need to see what lies 
beneath it. 

If the dialog box has a Control menu, you can use it as an alternative 
way to back out of the box without making an entry. Simply double-click 
the Control-menu box. Or press Alt, Spacebar and choose the Close com­
mand from the Control menu. 

Using Scroll Bars 
If a document or dialog box is too long to be displayed completely within 
the confines of a window, Windows adds a vertical scroll bar to the right 
side of the window. If the material is too wide to be displayed entirely, 
Windows adds a horizontalscroll bar. If it's too long and too wide, Windows 
adds both kinds of scroll bars. The following illustration shows a window 
with vertical and horizontal scroll bars. 
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Eile fdit 
DJIA 

3293.28 
3324.08 
3330.56 
3337.31 
3358.~9 
3345.42 
3361.63 
3331.64 

DDI-OTC 
-95 
-95 

~earch 

DJUA 
217.64 
218.08 
218.64 
219.02 
220.58 
220.89 
220.77 
220.08 

NlC 
4.99 
4.66 

Help 
NASDAQ Call/Put S&P Pre~ P.F. 
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567.80 1.26 0.76 +14 
570.22 1.28 0.64 +13 
575.21 1.33 0.60 +26 
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I 
Horizontal scroll bar 

Tick 
+549 
+435 
+128 
+211 - Vertical scroll bar 
+632 
+346 
+482 
+543 

M1 

Scroll bars provide an easy way to navigate through a document with 
the mouse. They also indicate your current position relative to the length 
or width of the document. 

Notice the square boxes in the scroll bars shown in the illustration 
above. In the vertical scroll bar, the box is about a tenth of the way down 
the length of the bar. This means that the text you're looking at is about ten 
percent of the way into the document. Similarly, the position of the box in 
the horizontal scroll bar tells you that the block of text you're looking at 
starts at a position about a fifth of the way across the page. 

You have several ways to scroll with a scroll bar: 

c To move up or down a line at a time, simply click the arrow at 
either end of the vertical scroll bar. To move side to side a character 
at a time, click the arrow at either end of the horizontal scroll bar. 

e To move several lines (or several characters) at once, click an arrow· 
and hold down the mouse button. When you arrive where you 
want to be, release the mouse button. 

c To move by a larger increment (approximately one windowful), 
click the mouse in the scroll bar itself. To move up, click above 
the box in the vertical scroll bar; to move down, click below the 
box. To move left, click to the left of the box in the horizontal scroll 
bar; to move right, click to the right of th~ box. 

t1 To move to a specific location, drag the box. To move directly to 
the last lines in the document, for example, drag the box to the 
bottom of the vertical scroll bar. 
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Scrolling with the Keyboard 
In most applications, you can scroll the contents of a document one line at 
a time by pressing the Up and Down direction keys when you reach the 
edge of the window. To scroll by larger increments, use PgUp and PgDn. 
In most applications that work with text, you can jump directly to the end 
of the document by pressing Ctrl + End or to the beginning of the document 
by pressing Ctrl+Home. 

Creating, Opening, and Saving Files 
Nearly all Windows-based applications use a similar set of procedures for 
creating a new file, loading an 'existing file from disk into memory, and 
saving a file to disk. We'll look at those procedures now, using Notepad as 
an example. 

The File Menu 
Because file operations are such a basic and indispensable part of working 
with applications, nearly every Windows-based program puts its File menu 
on the left side of the menu bar where it's easy to find. Notepad's File menu 
looks like this: 

Edit 1iearch Help 

Qpen ... 
1iave 
Save As ... 
Erint 
Page Setup .. . 
Print Setup .. . 

E~it 

Notepad's File menu is typical of many Windows-based programs. It 
has three basic command groups: a set of commands for moving files 
between disk and memory (New, Open, Save, and Save As), a group of 
commands for printing (Print, Page Setup, and Print Setup), and an Exit 
command. 

27 
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Creating a New File 
The New command, in Notepad and many other Windows-based applica­
tions, allows you to create a brand new document. In programs that use 
document windows, New generally opens a new, blank document window. 
In programs (such as Notepad) that don't use document windows, New 
erases any document currently in memory and presents you with an empty 
window in which to create a new document. If you haven't saved the 
document currently in memory, your program warns you-and gives you 
an opportunity to save-before removing the current document. 

Loading an Existing File from Disk into Memory 
To load an existing file from disk into memory, use the File menu's Open 
command. Your program presents a dialog box something like this: 

- Open 

File Hame: 

Ie 
Carl's Time SheeUxl 
ReadMe.lxt 
Thomas's file.lxt 

n.irectories: IJit&~ •• ;ltt 
c: \users\def ault 

~e--c:-\--------~llIlMIIlm 
e users 
It default 
CZJ SAVE 

Lisl Files of llpe: 0 rives: 

L..I T_e_xl_F_ile_s....;;.(·_.I_xt..:....l __ .JoIiIIl., I Iii c: 

In addition to the usual command buttons, this dialog box has a File 
Name text box and four list boxes. Let's take a quick tour. 

The File Name text box is a place where you can type the name of 
the file you want to load-if you happen to know its name and don't mind 
typing. If you prefer, you can select the name of your file from the accom­
panying list box. 

In most programs, the File Name text box starts out by displaying a 
wildcard specification-an asterisk followed by a period, followed by a 
three-letter filename extension. In the illustration above, Notepad's dialog 
box displays the specification ·.txt, because the defaultftlename extension 
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for Notepad (the extension the program uses if you don't tell it to do 
otherwise) is TXT. If your program's dialog box includes a list box labeled 
List Files of Type (or something similar), you might be able to use this list 
box to change the wildcard specification. Opening the file-type list box in 
Notepad, for example, reveals the following choices: 

List Files of '!ype: 

T ext Files (-.txt) Wi 

All Files (a.a) 

If you want to open a file with an extension other than TXT, click the 
All Files entry. The dialog box then lists all files in the current directory. The 
options available in the file-type list box vary from program to program. 
Some programs, such as Notepad, offer you a choice of the program's 
"native" file type (TXT, in this case) or files of any extension. Other pro­
grams, such as Paintbrush, have several native file types and so offer a larger 
assortment of file-type choices. 

WINDOWS TIP: Some programs allow you to enter two 
or more wildcard specifications, separated by semicolons, 
in the File Name text box. For example, if you type 
*.1XT;*.lNI in Notepad's File Name text box, the accom­
panying file list includes files with either extension. If the 
program you're working with does not support this option, 
it simply ignores the second and subsequent wildcard 
specifications. 

When the file you want to open is in the files list box, you can open 
it in any of the following ways: 

c Double-click the filename. 

c Click once on the filename. Then, with the filename highlighted, . 
click the OK button. 
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• Press the Tab key until you see a dotted line around the first name 
in the file list. Use the Up and Down direction keys to highlight 
the name of the file you want. Then press Enter. 

KEYBOAR D TIP: To open the first file in the file list, 
press Tab until the dotted line appears around that file­
name. Press Spacebar to highlight the name, and then 
press Enter. 

If the file you want to open is not stored in the current directory, you 
can use the Directories list box to change directories. In the illustration on 
page 28, for example, the current directory is C: \ USERS\DEFAULT, and the 
dialog box lists all TXT files in that directory. To open a file in the SAVE 
directory, a subdirectory of C: \ USERS\DEFAULT, double-click SAVE in the 
Directories list box. The file list then presents the names of all TXT files in 
C: \ USERS\ DEFAULT\ SAVE. To open a file in the root directory, double-click 
the entry at the top of the Directories list, C: \. 

If the file you want to open is not stored on the current disk drive, use 
the Drives list at the bottom of the dialog box. You'll find all your local 
drives listed here (complete with volume labels, if any), along with all 
connected network drives. After switching drives, you can pick the appro­
priate directory from the Directories list and the file from the File Name list. 

Saving a File for the First Time 
To save a file that you've just created-a file that's never been saved on disk 
before-use the File menu's Save or Save As command. It doesn't matter 
which you choose; either way, you get a dialog box similar to the illustration 
on the next page. 

This dialog box looks like the File Open dialog box, except that all of 
the filenames in the list box on the left are grayed out. This is how Windows 
tells you what filenames are already in use. Type a name for your new file, 
and click OK or press Enter. (If you type the name of an existing file, 
Windows presents a warning message and asks you to confirm that you 
want to overwrite the existing file.) 
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Save As 

File !lame: .Q.irectories: 1[:;· ,or~. <:] 
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Thomas's file. txt 

~ default 
CJ SAVE 

= ;~ W 
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MOUSE TIP: If you want to replace an existing file with 
the document in memory, click the file's name to put the 
name in the File Name text box. 

After you've saved a file, most Windows-based applications display 
the name of your file in the title bar of the file's document window (if the 
program uses document windows) or in the title bar of the application itself. 
Until the file has been saved that first time, programs typically display the 
word (Untitled) in their title bars. 

Resaving a File 
After you save a file at least once, you can save it again simply by choosing 
the file menu's Save command. You won't see a dialog box when you do 
this, because Windows already knows the name of the file. 

Saving a File Under a New Name 
To save a file on disk under a new name, use the File n1enu's Save As 
command. You'll see the current name highlighted in the Save As dialog 
box. Simply type the new name for your file, and press Enter (or dick OK). 
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WINDOWS TIP: When you use the Save As command 
to give a file a new name, the version of the file that you 
saved most recently under the old name remains on disk. 

Entering and Editing 
iext in Documents 

Unless you happen to be concerned only with visual images, you will 
probably spend much of your time in Windows entering and editing text. 
This is true whether your primary application is word processing, financial 
planning, database management, project management, or communications. 
Even though Windows is a graphical environment and uses your computer's 
graphics display modes, the information you work with consists primarily 
of letters and numbers-in other words, text. 

Fortunately, a basic set of concepts and procedures applies to text in 
most applications for Windows. 

The Insertion Point 
The flashing vertical line that you see whenever you work with text in an 
application for Windows is called the insertion point. It's analogous to the 
cursor in a character-based word processing program. The insertion point 
indicates where the next character you type will appear. 

There's one difference between the insertion point aIJ.d the cursor used 
in most MS-DOS-based programs: The insertion point is always positioned 
between two characters, before the first character in.a block, or afterthe last 
character in a block. It never appears directly under a character. That's 
because characters are always inserted at the insertion point; they don't 
overwrite existing text. 

In the following illustration, for example, the insertion point is located 
between the i and the n in the word tiny. 
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To replace existing text with new characters that you type, Windows 
uses a different concept, called selection. We'll talk more about selection in 
a moment. 

The I-Beam 
When you work with text, Windows changes your mouse pointer from an 
arrow to something that looks like a lanky capital 1 The pointer is then 
usually called an I-beam. In the illustration above, you can see the I-beam 
near the lower right corner of the window. 

The I -beam provides a way to relocate the insertion point. In the tiny 
text file above, for example, if you want to move the insertion point to the 
beginning of the line, simply use the mouse to position the I-beam before 
the capital T, and then click. (You can also use the keyboard to move the 
insertion point, as we'll see in a moment.) 

When you're typing text, you might sometimes find the I-beam dis­
tracting. If that happens, simply use the mouse to move the I-beam out of 
your way. It doesn't matter where you put it. 

The Selection 
To select something in Windows means to highlight it-with the keyboard 
or the mouse. In the illustration on the next page, for example, the word 
tiny has been selected. 
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The object that you select is called the selection. 

You might select a block of text for any of several reasons: 

lJ To apply a formatting change to the entire block (In the illustration 
above, for example, if you choose Write's Underline command 
after selecting the word tiny, the entire word is underlined.) 

lJ To copy, cut, or delete the entire block 

lJ To replace the entire block 

Notice that there's no insertion point in the illustration above. The 
insertion point disappears when you make a selection, because the next 
character you type replaces the entire selection. 

Positioning the Insertion Point 
As mentioned before, the easiest way to move the insertion point is with 
the mouse. Simply put the I-beam wherever you want the insertion point, 
and then click. 

You can also use the keyboard. The following keystroke combinations 
apply to most Windows-based applications that work with text. 

lJ The Right and Left direction keys move the insertion point forward 
or backward a character at a time. Ctrl+Right and Ctrl+Left move 
it forward or backward a word at a time. 
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a End moves the insertion point to the end of the line. Home moves 
it to the beginning of the line. 

II The Up and Down direction keys move the insertion point up or 
down a line at a time. 

1:1 PgUp and PgDn move up or down a windowful at a time. 

1:1 Ctrl+End moves to the end of the document. Ctrl+Home moves to 
the beginning of the document. 

Some applications use additional keystroke combinations for moving 
the insertion point. In Microsoft Word for Windows, for example, pressing 
Ctrl+Down takes you to the first word in the next paragraph, and Ctrl+Up 
takes you to the beginning of the previous paragraph. 

Selecting Text 
To select text with the mouse, put the I-beam at one end of the block you 
want to select. Then hold down the mouse button, move to the other end, 
and release the mouse button. In other words, simply drag the mouse across 
the text you want to select. You can select a word by double-clicking 
anywhere in it. 

To select text with the keyboard, first put the insertion point at one 
end of the block you want to select. Then hold down the Shift key and 
extend the selection to the other end of the block. The same keystrokes you 
use to move the insertion point extend the selection. 

For example, to select three characters within a word, put the insertion 
point before the first character, and then hold down the Shift key while 
pressing the Right direction key three times. To select an entire word, 
position the insertion point to the left of the word, hold down the Shift key, 
and press Ctrl+Right. To select from the insertion point position to the end 
of the line, hold down the Shift key and press End-and so on. 

Some programs implement additional keyboard and mouse proce­
dures for selecting text. In Write, for example, if you position the mouse 
pointer to the left of a line of text and then click, the entire line is selected. 
If you position the mouse pointer to the left of a line, hold down the Ctrl 
key and then click, Write selects the entire document. 
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Erasing Characters 
To erase a few characters of text, put the insertion point where you want 
to make the erasure. Then use the Backspace or Del key to make your 
corrections. Backspace deletes characters to the left of the insertion point; 
Del removes characters to the right of the insertion point. 

Erasing Blocl{s of Text 
To erase a block of text, first select the block. Then do one of the following: 

D Press Del or Backspace. 

D Choose the Edit menu's Delete or Clear command (if your appli­
cation's menu has such a command). 

c Choose the Edit menu's Cut command. 

Pressing Del or Backspace removes the selected text. Choosing Delete 
or Clear from the Edit menu does exactly the same thing. Choosing the Cut 
command, however, does something quite different. It removes the text 
from your document but stores it in an area of memory called the Clipboard. 
After the selection has been stored on the Clipboard, you can paste it 
somewhere else-either within the same or another document (even in a 
document created by a different application). 

Undoing a Deletion 
Many applications include an Undo command on their Edit menus. This 
command gives you the opportunity to change your mind about a deletion. 
The Undo command usually can reverse only your most recent edit, how­
ever. So, for example, if you delete a line of text, and then apply a formatting 
command to a different block of text, you won't be able to use the Undo 
command to reverse your deletion; at this point the Undo command is 
poised to undo the formatting change, not the deletion. 
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Copying and Moving Text 
The Clipboard makes it easy to copy or move text from one place to another. 
Follow these steps: 

1 . Select the text you want to move or copy. 

2. To move, choose the Edit menu's Cut command. To copy, choose 
the Edit menu's Copy command. 

3. Move the insertion point to the place where you want to move or 
copy your text. 

4. Choose the Edit menu's Paste command. 

This simple procedure can be used to move or copy text from one 
place to another in the same document, from one document to another 
created by the same application, or from one application to an entirely 
different application. 

For more information about using the Clipboard, see Chapter S, "Ex­
changing Information: The Clipboard, ClipBook Viewer, and OLE," 
page 167. 

Wor~{ing with Graphics 
A few generalizations can be made about entering and editing material in 
graphics documents. 

First, most graphics programs provide a set of tools for adding objects 
to an image or editing existing objects. Typically, the tool set is presented 
as an icon toolbox alongside or below the program's work area. In the 
illustration on the next page, which shows the desktop accessory Paintbrush 
with a blank canvas, the toolbox is the set of icons to the left of the canvas. 

The icon with the diagonal line, about halfway down the toolbox, is 
a line tool and allows you to add straight lines to the drawing. The rectangles, 
rounded rectangles, and circles below the line tool allow you to create 
various kinds of shapes, and so on.·You choose a tool from the toolbox by 
clicking its icon or using the keyboard's Tab and direction keys. 

•.. ' .. ~ ... Nor. .. of 

~ .~> 
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Notice the big cross in the lower right corner of the work area. That's 
the graphics equivalent of a text window's I-beam. You move the cross with 
the mouse to tell the program where you want to position a new object or 
modify an existing one. (Graphics programs commonly use other pointer 
shapes in addition to the cross. The shape of the pointer typically varies 
with the kind of graphics tool you're using.) 

Graphics programs, like text programs, employ the concept of the 
selection. In Paintbrush, for example, you can select a rectangular portion 
of an image by using the pick tool-the scissors with the rectangle in the 
upper right corner of the toolbox. In the illustration at the top of the next 
page, a chessman has been selected (it's enclosed in the dotted rectangle), 
and that portion of the image can now be cut or copied to the Windows 
Clipboard. 

A graphic image cut or copied to the Clipboard can be pasted into a 
different part of the same image, into another graphic image, or into a text 
document (provided the text application is able to accept images). The 
desktop accessory Write is an example of a text program that can handle 
graphics pasted from the Clipboard. (For more information about using 
graphics in Write, see "Including Pictures in Write Documents," page 425.) 



N~ •~ Chapter 1: Getting Acquainted with Windows NT r. ... 

When a portion of an image has been selected, it can be manipulated 
in various ways, just as selected text can be formatted in a text document. 
Here, for example, the selected chessman has been turned on its head. 
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For more information about Paintbrush, see Chapter 16, "Using Paint­
brush," page 473. 

Working with Fonts 
Windows offers the ability to print documents in a variety of typefaces and 
styles. Even with inexpensive dot-matrix printers, many Windows-based 
applications make it easy for you to generate reports, letters, and memos 
whose impact is enhanced by the power of typography: Understanding the 
basics of font terminology and technology will help you get the most out 
of your work in Windows NT. 

Terminology 
A font is a complete set of characters in one size and one typeface. For 
example, all the letters, numbers, punctuation marks, and other symbols 
available in 12-point Courier New bold italic constitute one font. The same 
set of characters in another size constitutes another font. 

Fonts are identified by their size, typeface family, weight, and style. In 
the name "12-point Courier New bold italic," for example, 12-point is the 
size, Courier New is the typeface family, bold is the weight, and italic is the 
style. When the weight is "normal" and t1!e style is "roman," these terms are 
usually omitted. 

Font Size 
A font's size is usually measured in points and expressed as a "point size." 
A point is a printer's measurement, equal to 1/12 of a pica, or approximately 
1/72 of an inch. A font's point size is approximately the distance in points 
from the top of its highest character to the bottom of its lowest character. 
(This definition applies to a font's printed size only. On screen, point size 
has no absolute significance at all, because of the differences in screen size. 
For example, a IO-point font on a 16-inch screen might be larger than a 
12-point font on a 14-inch screen.) 

Point size is a rough measure of a font's height but says nothing about 
width. Many font families come in compressed and expanded variants, as 
well as normal widths. 
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Style and Weight 
The most common style variants for fonts are roman and italic. Roman 
characters are the "normal" kind, with straight up-and-down strokes pre­
dominating. Italic characters, which are forward slanting and' often more 
rounded, are used for emphasis, for titles of books, and so on. 

The term weight refers to the thickness of a font's strokes. The most 
common weights are normal (also called regular) and bold, but some font 
families also include other weights, such as thin, light, heavy, ultra, and 
black. 

Serif and Sans Serif Fonts 
Most fonts fall into one of two categories-serif or sans serif Serif fonts have 
fine lines that finish off the main strokes-for example, at the bottom of a 
capital Tand the ends of the T's crossbar. These "finishing strokes," called 
serifs, are absent in sans serif fonts. Serif fonts, such as Times New Roman, 
are generally considered more suitable for conventional text, such as that 
in a newspaper or book. Sans serif fonts, such as Helvetica and Arial, have 
a more modern appearance and are often used in headlines, tabular material 
(such as spreadsheet reports), and advertising. 

Monospaced and Proportionally Spaced Fonts 
Fonts in which every character takes up the same amount of space are called 
monospaced. Fonts in which some characters (such as m and w) are wider 
than others (i and t, for example) are described as proportionally spaced. 
Proportionally spaced fonts produce a more typeset appearance and are 
generally considered easier to read. Monospaced fonts are often preferred 
for such things as legal documents, which have traditionally be~n produced 
on typewriters. 

Arial and Times New Roman are examples of proportionally spaced 
fonts. The most commonly used monospaced font is Courier. 

Note that although the widths of letters in a proportionally spaced font 
vary, the widths of numerals are usually all the same-so that numbers can 
be aligned in tables. 

Scalable and Nonscalable Fonts 
Fonts can be described as being either scalable or nonscalable. Scalable 
fonts are fonts that can be used at any number of different point sizes. 
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Nonscalable fonts are designed for use at particular sizes; enlarging or 
reducing them generally produces unattractive distortions (serrated diagonal 
lines, for example). 

Nonscalable fonts are sometimes described as bit-mappedfonts. That's 
because the form in which they're stored on your hard disk (or in a printer 
cartridge) records the relative position of each dot comprising each charac­
ter. For example, a capital I might be stored as a column of twelve dots plus 
two six-dot crossbars. To generate a character from a bit-mapped font, your 
video or printing hardware simply reproduces the bit map at the desired 
location. 

Most scalable fonts are stored as outlines; such· fonts, therefore, are 
often called outline fonts. An outline is a mathematical description of each 
character in the font. Before characters from an outline font are rendered 
on your screen or printer, font-management software converts them to bit 
maps, using a process called scan conversion. To avoid jagged lines and 
other distortions in the final rendering, particularly at smaller point sizes, 
the font-management software also employs hints-algorithms that modify 
the scan-conversion process to produce optimal-looking characters. 

Because outline fonts are stored as mathematical descriptions rather 
than as fully realized bit maps, they can be scaled to a wide range of point 
sizes. They can also be slanted, rotated, compressed, extended, inverted, 
and otherwise manipulated. Their metrics (character-width specifications) 
can also be modified as needed to produce kerned or letterspaced typo­
graphy. The one small disadvantage of outline fonts is that the scan­
conversion process takes a modest amount of processing time. The first time 
you use an outline font at a given point size, therefore, you might encounter 
a slight delay while your system performs the calculation required to convert 
the font's outline into the appropriate set of bit maps. After the bit maps 
have been rendered, however, they're stored in an area of memory called 
a cache. When you need to reuse the font, Windows simply grabs the bit 
maps out of cache memory, thereby avoiding the original calculation delay. 

Fonts Supplied with Windows NT 
Incorporated into Windows NT is a scalable font technology called True­
Type. Along with this font-management technology, Windows NT includes 
five TrueType typeface families-Arial, Times New Roman, Courier New, 
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Symbol, and Wingdings. Arial is a sans serif typeface that's similar to Helve­
tica. Times New Roman is a serif face similar to Times Roman. Courier New 
is a monospaced serif face, and Symbol is a serif face consisting of the Greek 
alphabet plus a few mathematical and phonetic symbols. Wingdings is a 
collection of icons, symbols, and "dingbat" characters that you can use to 
enliven your documents. The TrueType typefaces included with Windows 
are each available in four styles-roman, italic, bold, and bold italic. 

In addition to the five TrueType families, Windows NT also includes 
three stroke fonts, called Modern, Roman, and Script, and three sets of 
bit-mapped fonts-MS Serif, MS Sans Serif, and Courier. 

Like outline fonts, stroke fonts are scalable. But they're based on a 
simpler scaling technology and produce much less satisfactory results. Their 
single virtue is that they produce characters consisting only of straight lines 
and hence can be used on non-raster output devices (devices that do not 
operate by positioning dots on an output medium) such as plotters. Because 
stroke-font characters consist only of straight lines, such fonts are also 
commonly called vector fonts. 

The bit-mapped fonts are provided for compatibility with earlier ver­
sions of Windows. (MS Sans Serif was previously known as Helv, and MS 
Serif is the former Tms Rmn.) They're available only in certain point sizes, 
and you can't use them with laser' printers. 

Along with this assortment of font resources, you might find additional 
fonts available to you, courtesy of particular applications that you have 
installed. If you use Microsoft Word for Windows, for example, you will 
likely see a TrueType font named Fences listed in Word's Format Character 
dialog box. This font, used by Word's equation editor, becomes part of your 
Windows system automatically when you install Word. Other applications 
similarly install other fonts for their own use; typically, these fonts become 
available to any of your Windows-based applications. 

Additional Font Resources 
A number of type vendors provide fonts and font-management systems 
compatible with Windows NT. Adobe's Adobe Type Manager (ATM) for 
example, supports PostScript Type 1 fonts, an alternative to TrueType scal­
able fonts. 
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TrueType font packages sold for the MS-DOS versions of Windows 
(Windows 3.1 and Windows for Workgroups) should work without conver­
sion in Windows NT. So should TrueType fonts designed for the Macintosh. 

Your Printer's Own Font Resources 
In addition to the fonts that Windows supplies and any additional fonts that 
you install in Windows, you can take advantage of any of your printer's 
internal font resources. Your printer driver tells Windows which fonts the 
printer provides, and those fonts appear in the Font dialog boxes used by 
your applications. 

When you use your printer's own fonts, Windows doesn't have to 
download font information (or turn each page of your document into a bit 
map-a time-consuming process), so printing is likely to b~ quicker. In 
exchange for this speed increase, however, you might have to sacrifice some 
degree of correspondence between the appearance of your document on 
screen and its appearance on paper. 

When you format a document with an internal printer font, Windows 
displays the same font on screen-if it can. For example, if you're printing 
to an HP LaserJet III (or a compatible PCL-5 laser printer) and you have 
installed Hewlett-Packard's Intellifont software, Intellifont generates screen 
fonts that match your printer's internal fonts. 

If Windows does not have a screen font to match the printer font you 
select, it gives you the closest match that it can. For example, if you choose 
the Courier font that's built into your LaserJet Series II, Windows formats 
your te~t on screen with its own TrueType Courier font (Courier New). If 
you select your PostScript printer's Avant Garde font (and you have not 
installed Adobe Type Manager and the Avant Garde screen font), Wiridows 
uses the nearest TrueType equivalent (Aria!) on screen. Both are sans serif 
fonts". 

Even if the screen font used by Windows doesn't exactly match the 
printer font you select, Windows-based applications attempt to show you 
where your lines will break on the printed page. The correspondence of 
line endings on screen to line endings on paper might not always be perfect, 
however, and some applications do a better job of this than others. If precise 
text positioning is critical, it's always best to avoid printer fonts that don't 
have equivalent screen fonts. 
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Getting Help 
Most applications for Windows include a Help menu as the rightmost com­
mand on the menu bar. Any time you're unsure how a feature or command 
works, you can pull down the Help menu and find useful information. 

The Windows help facility is a hypertext system, which means that it 
lets you jump easily from one topic to another while keeping track of the 
path you follow. The system includes a Search command to help you find 
exactly the topic you're looking for, a Bookmark command with which you 

. can flag topics of particular interest, an Annotate feature that lets you add 
your own comments to the built-in help text, a Copy command that lets you 
replicate important help messages in Notepad or your word processor, and 
a Print command to convey screen text onto paper. 

Help appears in a full-fledged application window, complete with its 
own menu bar. You can maximize it and minimize it the same way you can 
any other application for Windows. The help window belongs to an appli­
cation called WINHELP.EXE. The text inside the window is a document file 
with the extension HLP. If you want to switch to a different program's help 
text, you can do so by using WINHELP's File Open command and selecting 
another HLP file. 

WINDOWS TIP: While you're learning a new applica­
tion, you might want to keep its help text available on 
your desktop. You can use Alt+Tab to switch quickly back 
and forth between the program and its help window. 
Alternatively, by choosing the Always On Top command 
from the help window's own Help menu, you can ensure 
that the help text remains visible no matter what you do 
within your application . 

.. " .. 
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In many help screens, some of the text appears in a contrasting color 
and underlined. These keywords indicate topics about which the help facility 
has additional information to offer. To get that additional information, dou­
ble-click the keyword. 

KEYBOAR D TIP: To see at a glance which keywords are 
available in the current help window, hold down the Ctr! 
key and Tab key. 

KEYBOAR D TIP: If you don't have a mouse, you can use 
the Tab key to skip from keyword to keyword. To get 
information about a topic, select its keyword and then 
press Enter. 

Keywords with Dotted Underscores 
Keywords underscored by a dotted line are defined terms, as opposed to 
major topics. Clicking a defined term pops up a definition window without 
changing the underlying screen. When you finish reading the definition, 
you can remove the definition window by clicking the mouse again. 

KEYBOAR D TIP: To pop up a definition window with 
the keyboard, press Tab to select the underscored term. 
Then press Enter. To remove the definition window, press 
Enter again. 

Some programs' help files include a Glossary button. Clicking this 
button gets you a listing of all defined terms in the help text. 
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Finding Particular Topics 
with the Search Command 
Scanning through a help document's table of contents is one way to find 
particular topics in which you're interested. You can redisplay the table of 
contents at any time by clicking the Contents button Cor by reinvoking the 
Help Contents command in your application). 

Another way to find a particular topic is to click the Search button or 
press Alt+S. When you do this, you see a display similar to the following 
illustration. 

- Search 

~~~: :t!-:~~ ;~::e;!~~:. from the list. 1ffi:_:<1(,;~;:1 

~ I II:_:;!_:(:' 

The upper list box in this dialog box lists the concepts and commands 
described by all the various topics in the current help document. When you 
select a concept and click the Show Topics button, the bottom list box 
reveals the names of all topics that discuss the selected concept. In Program 
Manager's help document, for example, if you select "applications, starting 
from a group" and click the Show Topics button 'Cor press Enter), a topic 
appears in the lower list box, as shown on the next page. 
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Type a !ford, or select one from the list. 
Then choose Show Topics. 

I applications, starting from a group J 
applications, starting bv using the Run command 

I I •• I I 

applications, starting when you log on 
applications, switching between 
arrange, icons 
change, icons 

Select a !opic, then choose Go To. 

[iliElWitiiliil!l5'U'I'ili'!i.ii" 

To read a topic, select its name in the lower list box, and click Go To 
(or press Enter). 

I<EYBOAR D TIP: A quick way to move directly to a 
concept in the Search command's upper list box is simply 
to begin typing in the text box. As you type, Windows 
searches through the list and displays those concepts 
beginning with the letters you have typed. 

Searching for Help Topics 
Across Multiple Applications 
The Windows NT help engine also includes a facility that lets you search 
for topics from multiple help documents. To see how this feature works, 
pull down Program Manager's Help menu, choose Contents, and then click 
the button marked Find. The following dialog box appears. 
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181 Backup 

181 ClipBook Viewer 

181 Control Panel 

181 Event Viewer 
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. On the Find line, type the topic you're interested in. In the Look At 
section, tell the system whether you want it to search help topic titles only 
or the full topic text. In the Look In section, select the check box for each 
application you want the help facility to search. Then click the Search button. 

In a moment, a "browser" box appears, listing all the available topicS. 
Here's an example of what the browser box might look like: 

Now you can use the Go To, Next, and Previous buttons to read any 
topic that interests you. 

WINDOWS TIP: The Find command can also perform 
"proximity" searches. For details, click Find, and then click 
Hints. 
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Retracing Your Steps 
A hazard of using some hypertext-style information systems is that you can 
lose your way while exploring the web of interrelated topics. You might 
want to reread the screen you looked at moments ago, but not remember 
how to get back to it. 

Fortunately, the Windows help system keeps track of every move you 
make. You can retrace your steps at any time, simply by clicking the Back 
command button or pressing Alt+ B. 

You can also use the History button to revisit a topic you read earlier 
without tracing through all the intervening steps. Clicking History (or press­
ing Alt+T) presents a list of the topics you've displayed in the current 
Windows session. 

Both the Back command and the History command can take you from 
the current help document to a document you've read earlier in the current 
Windows session. 

Using the Browse Buttons 
Some help documents include a pair of arrow buttons, one pointing left, 
the other pointing right. These buttons provide "browse" services for the 
current document, moving you between logically related topics. When 
you're first learning a new application for Windows, check to see if its help 
document includes these browse buttons. They can offer an excellent way 
to lear,n about your new program's features. 

Setting Bookmarl<s 
The Back and History commands are useful for revisiting topics you've read 
during the current working session, but they won't help you relocate infor­
mation you found useful three days ago. If you want to have certain topics 
at your fingertips at all times, you might want to flag them with a bookmark. 
To do this, first display the topic. Then pull down the Bookmark menu, and 
choose Define. You'll see a dialog box like the one shown on the next page. 
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- Bookmark Define 

Jlookmark Name: 

The top part of this dialog box displays the name of the topic you're 
looking at. The bottom part lists any bookmarks you've previously defined 
in the current help document. 

To define the bookmark, click OK or press Enter. If you want, you can 
change the name of the bookmark before clicking OK. 

After you define a bookmark, the name of that bookmark appears on 
the Bookmark menu, with a number next to it-like this: 

To find your way back to the flagged topic, simply pull down the 
Bookmark menu and choose the appropriate item. 

Printing Help Topics 
The Print Topic command, on the File menu, does just that-it prints the 
current help topic on the default printer. To print on a different installed 
printer, first choose the File menu's Print Setup command, and then select 
the printer you want to use from the list that appears. 

Copying Information from the Help System 
To copy some information from a help document into another application, 
first display the information you want to copy. Then choose the Edit menu's 
Copy command. You'll see a dialog box similar to the one shown on the 
next page. 
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iI!---------------C-op-y------------- --- -- "--- - --1 

~elect text to copy to the Clipboard_ . 

Selecting a Different Icon 
If more than one icon is available for a program item. you can change the 
icon that Program Manager uses. 
To select a different icon 

1 Select the icon you want to replace. 
2 From the File menu. choose Properties. 
3 In the Properties dialog box. choose the Change Icon bUll on. 
.. If more than one icon is available for the program item you selected. 
scroll through the icons by clicking the scroll arrows or by using the LEFT 
and RIGHT ARROW keys. 

If there is only one icon available for the program item you selected. or if 
you want more icons to choose from. you can scroll through all the 
available Program manager icons. Type c:\windows\progman.exe in 
the File Name box. and press ENTER. 

~ Iri@i'~:;1 

Irt~l 

The dialog box displays the entire text of the current help topic. To 
copy the entire topic, simply click the Copy button. To copy a portion of 
the topic, select the part you want to copy, and then click the Copy button. 

The Copy button transfers a copy of the selected text to the Windows 
Clipboard. To move the information into another application, simply use 
that application's Paste command. 

Using the Annotate Command 
to Add Your Own Help Messages 
The Edit menu's Annotate command allows you to add your own text to a 
help document. To annotate a help topic, first display that topic. Then pull 
down the Edit menu and choose Annotate. The dialog box that appears has 
a large area in wbich you can type your comments. Here's how it might 
look with an annotation for the Change Properties topic: 

~----------A-n-n-ot-at-e--------~ 

Annotation: 

When changing a program , 
group's properties. remember to , 
minimize the group window first 
before using the Properties 
command. 
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After you fill out the Annotation dialog box and click Save or press 
Alt+S, a paper-clip icon appears to the left of the annotated topic. 

To reread your annotation, click the paper clip-or tab to it and press 
Enter. 

Getting Help on Help 
Because the help facility is an application in its own right, it has its own 
help document. You can get help on using Help in either of two ways: 

[] Within any application that uses the help facility-Program Man­
ager, for example-pull down the Help menu and choose How To 
Use Help. 

[] Within the help facility itself, pull down the Help menu and choose 
How To Use Help. (Pressing Fl is the keyboard shortcut.) 

Either way you access it, the help facility appears with a document 
called WINHELP.HLP. 
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Managing Programs 
with Program 

Manager 

Program Groups and Program Items 
Program items are launchpads for applications. Program groups are win­
dows containing sets of related program items. 

Working with Group Windows and Icons 
Program Manager has handy commands for tiling and cascading group 
windows. 

Personal and Common Program Groups 
Personal groups are for your eyes only. Common groups are for every­
one. 

Customizing Program Groups 
Windows NT provides a few groups to get you started. You'll want to 
make more of your own. 

57 

59 

61 

62 



Customizing Program Items for Your Applications 
You can move and copy items between groups with simple drag-and­
drop maneuvers. 

Starting Programs with the Run Command 
The quickest way to start a program is to double-click its program item. 
But sometimes the Run command is handier. 

The Minimize on Use Command 
This handy command gets Program Manager out of the way when you 
launch a new application. 

Saving Settings 
There are two ways to preserve the layout of your program groups. 
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or most users, a Windows NT session starts and ends in Program 
Manager. The logon process ordinarily leaves you in Program 

Manager (it does so unless your account has a logon script that takes you 
elsewhere), and when quitting time comes, you probably use the Shutdown 
or Logoff command on Program Manager's File menu. 

In addition to starting and ending Windows sessions, Program Manager 
serves two vital purposes: It gives you a simple way to start applications, 
and it makes it easy for you to organize your programs and documents into 
logical working groups. 

Program Groups and Program ~~ems 
Program Manager's application window contains one or more document 
windows called program groups. Each program group contains icons called 
program items. (See the illustration on the next page.) You start a program 
from Program Manager by selecting its program item and pressing Enter­
or, more simply, by double-clicking the program item. You can select a 
program item either by using the direction keys or by clicking it. 

I(EYBOARD TIP: You can also select a program item in 
the active window by typing the first letter of its name. 
This navigation method works the same way in a program­
group window as it does in any Windows list box. 

A program item can be associated with one or more specific document 
files, so that the program automatically loads the specified documents into 
memory when you start the program. For example, if you frequently use 
the spreadsheet application Microsoft Excel with two worksheets named 
EASTJeLS and WESTJCLS, you can create a program item to start Microsoft 
Excel with both worksheets already in place. Or if you have a half dozen 
worksheets you use more often than any others, you can create separate 
program items for the combination of Microsoft Excel and each of those 
worksheets. 
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Program groups 

B 
Command 

Prompt 

~ II 
Mai Schedule+ 

sI 
WU'ldowsNT 

Setup 
PIFEditor 

&j iml -fJl" Cirt':::1 
Windows NT IIImIIIIII Help _ 

Program items 

Program Manager is extremely malleable; you can set it up in whatever 
manner best serves your working style, and you can easily modify your 
setup as your needs change. Program Manager lets you organize your 
applications and documents in logical groups. These groups have nothing 
to do with the directory structure on your hard disk. (To reorganize your 
files as they're stored on your hard disk, use, File Manager. For more infor­
mation about File Manager,' see Chapter 3, "Managing Files, Directories, and 
Disks with File Manager," page 77.) 

Program Groups Created 
When You Install Windows 
When you install Windows, the Windows Setup program creates several 
program groups for you. It puts program items for certain essential Windows 
programs-including Control Panel, File Manager, Print Manager, ClipBook 
Viewer, and Setup itself-in a program group called Main. For Mine­
sweeper, Solitaire, and FreeCell, Setup creates a group called Games. And 
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it lumps together the Windows desktop accessory programs-Notepad, 
Write, Terminal, Calculator, and so on-in a group called Accessories. Setup 
also creates an Administrative Tools group and a group called Startup. 

Using the Startup Program Group 
A program group with the name Startup gets special treatment from Program 
Manager. Any program items in this group are automatically launched at 
the beginning of every Windows session. Items for which you've checked 
the Run Minimized box are launched as icons (see "Starting a Program Item 
as an Icon," page 69); the others are launched as open windows. 

Worl<ing with Group 
Windows and Icons 

Program-group windows, shown below, are ordinary document wipdows 
in all respects except one . 
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They can be maximized, moved, sized, restored, and minimized, but 
you can't close them. (If you double-click a program group's Control-menu 
box, Program Manager minimizes the group window.) When program 
groups are minimized, their icons all look alike, except for the identifying 
text beneath them. 

Minimizing program groups that you're not using lets you focus on 
the ones you are. 

USing the Window Menu 
The Window menu, shown below, has a command for each program group, 
so you can activate any group window by choosing the appropriate com­
mand. 

1 Excel 
ZVB 
J. Winword 
~Maln 

".5. Accessories 
§ Startup 
1 Games 
.11 Administrative Tools 

You can also use the Window menu to cascade or tile all or some of 
your program-group windows. The Cascade and Tile commands affect open 
windows only, so you can minimize the groups you don't currently need 
and tile the rest, as shown on the previous page. 

WINDOWS TIP: Choosing the Tile command with only 
one program group open makes that group as large as it 
can be without covering the other groups' icons. 

II 
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Arranging Program Items 
With the mouse, you can drag program items from one place to another 
within a program group. For example, if you use particular programs more 
often than others, you can put their icons in the upper left corner of the 
program-group window. If you have several icons for the same program 
(each associated with a different document file), you can put them all 
together-and so on. 

Getting icons lined up neatly with the IDouse can be a trial, however, 
so Program Manager's Options menu includes a command called Auto Ar­
range. If this command is selected (that is, if a check mark appears beside 
it), Windows automatically keeps your icons in orderly rows any time you 
rearrange them. If you elect not to use the Auto Arrange command, you can 
still tidy up the current program group at any time by using the Arrange 
Icons command on the Window menu. 

The Arrange Icons command is also useful for straightening up the 
icons that represent closed program groups. If your program-group icons 
get out of line, simply select anyone of them, pull down the Window menu, 
and choose Arrange Icons. 

PersonOl~ Olnd 
Common Progro.m Groups 

Program Manager uses two kinds of program groups, called personal groups 
and common groups. Personal groups belong to particular user accounts, 

. whereas common groups belong to all accounts. Thus, personal groups that 
you create (or that were created for you by Setup or by your system admin­
istrator) appear only'when you are logged onto Windows NT. \Vhen some­
one else logs on at your workstation, that person sees his or her personal 
groups, not yours. Common program groups, on the other hand, are seen 
by all users of your workstation. 

You can distinguish between a personal group and a common group 
by looking at its title bar or its icon. The title bars of common groups include 
the word common. The title bars of personal groups show only the group's 
name. The icons for common groups include a computer; the icons for 
personal groups include a face. (See the figure on page 59.) 
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WINDOWS TIP: If, while logged on as a member of the 
Administrators or Power Users group, you install programs 
written for earlier versions of Windows, those programs 
are likely to create new common program groups for 
themselves. If you prefer not to share the new groups with 
other users, you'll want to create new personal groups, 
move the items from the common groups to the personal 
groups, and then delete the common groups. 

To create or delete common program groups, your user accoU'nt must 
belong to either the Administrators or Power Users group. If you are not a 
member of either group, you can copy program items from common groups 
into personal groups, but you can't modify the common groups. For more 
information about the Administrators and Power Users groups, see 
"Groups," page 317. 

Customizing Program Groups 
You're not limited to using the. program groups created by the Setup pro­
gram. You can add new groups, rename groups, or delete groups to suit 
your needs. 

Creating New Program Groups 
The steps to create a new program group are as follows: 

1. Choose the New command from the File menu. 

2. In the dialog box that appears, choose Personal Program Group or 
Common Program Group. (The latter option is grayed out if your 
account does not have the authority to create common program 
groups.) 

3. In the next dialog box, type the name you want to appear in the 
title bar of your new group. 

4 . . Click OK. 

, 
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WINDOWS TIP: When you first install Windows, Pro­
gram Manager is organized by. application type. Access­
ories furnished with Windows are in one group, other 
applications in another, and so on. Other organizational 
schemes are possible and might serve your needs better. 
For example, you can create program groups for each 
broad category of your work. If you're primarily a 
spreadsheet user, you can create a group called Budgeting, 
another called Forecasting, and so on. .If you're self­
employed, you can create a separate group for each of 
your clients. The possibilities are endless. 

Renaming Program Groups 
To rename a program group, follow these steps: 

1. Minimize the program-group window you want to rename. 

2. Click the group's icon. 

The Control menu for the program-group window pops up. You 
can ignore it. 

3. Choose the Properties command from the File menu. 

The Program Group Properties dialog box appears. 

4. Enter a new name in the Description text box, and click OK. 

I<EYBOAR D TIP: To rename a program group with the 
keyboard, first minimize the program group's window. 
Then press Ctrl+Tab or Ctrl+F6 until the group's icon is 
highlighted. Then choose the File menu's Properties 
command, and fill out the dialog box. 
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Deleting Program Groups 
To delete a program group: 

1. Minimize the program-group window you want to delete. 

2. Click the group's icon. 

The Control menu for the program-group window pops up. You 
can ignore it. 

3. Choose the Delete command from the File menu. 

Windows presents a confirmation prompt. 

4. Click OK to confirm the deletion. 

Be careful when deleting program groups. When you delete the group, 
you delete all the program items inside as well. You won't delete any files 
on disk when you delete a program group, but if you take out the wrong 
group by mistake, you have to rebuild it from scratch. 

Customizing Program 
~tems for Your Applications 

It's easy to modify program groups and program items as your needs and 
preferences change. You can rearrange the furniture at any time with a few 
simple mouse actions. 

-Moving Program Items 
Between Program Groups 
The easiest way to move program items is by dragging with the mouse. 
Alternatively, you can use the File menu's Move command. 

For example, suppose you use the Windows Terminal program often, 
but you seldom use Write, Notepad, or any of the other desktop accessories 
included in your Windows package. In this circumstance, you might prefer 
to move the Terminal icon from your Accessories group (which you rarely 
use) to your Applications group. 
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To move Terminal with the mouse, you would proceed as follows: 

1. Set up Program Manager so that your Accessories and Applications 
windows are both open. (One easy way to do this is to minimize 
all your other program groups and then use the Tile command.) 

2. Put the mouse pointer on the Terminal icon. 

3. Hold down the mouse button and drag Terminal to the Applications 
group. 

4. Release the mouse button. 

If you prefer working with the keyboard, you can perform the move 
as follows: 

1. Make Accessories the active program group. 

2. Press T to select the Terminal icon. 

3. Press AIt, F, M to choose the File menu's Move command. Program 
Manager presents the dialog box shown below. 

Move Program Item 

I ~, ... nlr:l:,:c~~1 
f' , .. ·~Ul\:' ,., 

Move Program Item: Terminal 
From Program Group: Accessories 

I.o Group: I J~Zc~r.c;~i:rr1 
I m1'lietp't"ETII 

4. Press AIt+ Down to open the drop-down list box, and then use the 
Down direction key to select Applications. 

5. Press Enter. 

Copying Program Items 
Copying a program item is as easy as moving it. With the mouse, simply 
hold down the Ctr! key while you drag the item from one window to 
another. With the keyboard, select the item you want to move. Then press 
AIt, F, C to choose the File menu's Copy command. This command works 
exactly like the Move command described in the preceding section. 
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WINDOWS TIP: You can copy a program item within a 
program group as well as betWeen program groups. You 
might want to create several copies of an application's item 
within the same window, and then modify some of them 
to associate different document files with the application. 
For more information, see "Changing a Program Item's 
Properties," page 73. 

Creating New Program Items 
To add a new program item, begin by activating the group window in which 
you want the new item to reside. (It must be a group for which your account 
has permission to add a program item.) Then pull down the File menu and 
choose New. Program Manager presents the following dialog box. 

- New Program Object 

New------------~ I 'lz;~~1AA~)1;~~1 
1'&lS~tI4 
Ili4IBiitij}:1 

@ r~~·~.~·~:~.~If~.~·J 
o fersonal Program Group 

o !;,ommon Program Group 

A'~~ 
<ie',"~\) 

~ 

MOUSE TIP: You can also get to the New Program dia­
log box by holding down the Alt key an~ double-clicking 
in a blank area of the program group to which you want 
to add the new item. 

The default option is Program Item, so all you need to do is click OK, 
or press Enter. You see the following dialog box. 
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Program Item Properties 

.Q.escription: :==========:1 ltJTT::o~::·?m 
Command Line: :=:=======~I IW~!';;:;\I 
Working Directory: 1 

~hortcut Key: INone I l!i·I'Ow"~i.~:> I 
'-O-R-u-n-M-i-ni-m-iz-ed----...... lE!!el~~Jl 

1r:;;·:R~:£~).;i·;1 

The information you supply in this dialog box constitutes your pro­
gram item's properties. Only one property is mandatory-the Command 
Line. If you leave the other areas of the dialog box blank, you can always 
come back later and fill them out-or change them. For more information, 
see "Changing a Program Item's Properties," page 73. 

Describing a New Program Item 
In the Description text box, type whatever you want to appear beneath the 
new program-item icon. Windows NT wraps long descriptions onto two or 
three lines if necessary, so you don't need to be terse. The description text 
will appear beneath the icon in Program Manager-but not beneath the 
icon that the application displays when minimized. (There's at least one 
exception to this rule, however. For more information, see "Changing Pro­
gram Manager's Title-Bar Text," page 70.) 

You can enter up to 40 characters in the Description text box. If you 
leave the box blank, Program Manager supplies a description for you. 

WINDOWS TIP: If you don't want any text to appear 
beneath your program item, type a space on the Descrip­
tion line. 

1-.7 
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Specifying the Command Line 
The Command Line text box is where you tell Program Manager what you 
want it to do when you launch your new program item. You must supply 
something in this part of the dialog box; the OK button will be grayed out 
until you do. 

To launch a program by itself, without a particular document file, 
simply enter the name of that program's executable file. For example, sup­
pose you want to create an item that launches the Wizzy Word Processor 
from WizzyWare, Inc. If the executable file for this program is named 
WZ.EXE and you've stored it in your Windows directory, you would type 
wz.exe in the Command Line text box. 

If the executable file is not stored in your Windows directory but is 
stored in a directory included in your system's Path environment variable, 
you can omit the path in the Command Line text box. It's a good idea to 
type the complete path, however. That way, Windows. will always be able 
to start your program, even if you subsequently change the Path variable. 

If you don't know which directory your program's' executable file is 
stored in, if you aren't sure how to spell its name, or you just don't feel like 
typing, you can call on the Browse button for help. Click Browse, and 
Program Manager presents a dialog box like the one shown below. 

Browse 

File H.ame: J!irectories: I 'ru:~:,~,:,$p Ri~?M:\q;~1 
c: \users\def ault 
r--::f2:7~. -c:-:-'\ -----rL.~'i~ l~an~'X::tl}d 

~ u;:::ult 1~1;~tl,iHeljj\}\m;d 

List Files of '!ype: Driyes: 

L-I P_ro_gr_am_s ___ --"'I!1_~' L-11iii_c_: ____ --"I!I_~ I!L'Ji;i~liijJ~~1~it~1 

When you select a filename and click OK, you'll be returned to the 
Program Item Properties dialog box with your command line in place. 
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Specifying a Working Directory 
The Working Directory text box gives you the opportunity to make a par­
ticular directory current when Windows starts your program. You might 
want to fill out this line if you expect to use documents stored in a particular 
directory. For example, you can create a program item tailored to working 
with files stored in your C: \ PERSONAL directory by entering c: \personal in 
the Working Directory text box. 

Starting a Program Item as an Icon 
If you want your program item to be launched as 'a minimized window, put 
a check in the Run Minimized box. This option is particularly handy for 
program items launched via the Startup prbgram group. 

Assigning a Shortcut Key 
A shortcut key lets you switch easily to the program or document launched 
by your new program item. For example, if you assign Ctrl+Alt+W and 
Ctrl+AIt+S as shortcuts for your word processor and spreadsheet, respec­
tively, you can switch between those programs quickly and easily by press­
ing the appropriate key combinations. 

A shortcut key also makes it a little easier to launch your program item. 
As long as Program Manager itself is the active window and at least one of 
your program groups is open (it can be any group; it doesn't have to be 
the one that contains the item you want to launch), you can launch a 
program item by pressing its shortcut key. So if you use a lot of program 
groups and have trouble remembering which one contains which programs, 
try assigning shortcut keys and memorizing them instead! 

Program Manager allows you to assign any of the following combina­
tions as a shortcut key: Ctrl+Alt+Key, Ctrl+Shift+Key, Shift+Alt+Key, or 
Ctrl+Shift+AIt+Key, where Key can be anything other than Esc, Backspace, 
Enter, Tab, Del, Shift, AIt, or Ctrl. To assign a shortcut key, simply move the 
insertion point to the Shortcut Key text box, and press the key combination 
you want. 

When you close the Program Item Properties dialog box, Program 
Manager checks to be sure you haven't assigned your new item a shortcut 
key that's already in use. If you have, you'll see a warning message, and 
you'll have an opportunity to choose a different shortcut. "Overbooking" 
your shortcut keys is legal but inadvisable. 
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Using Shortcut Keys to Switch Between Applications 
Program Manager's shortcut keys are designed as conveniences for launch­
ing programs-saving you the trouble of opening group windows and 
hunting for program items. In some cases, however, you can also use a 
Program Manager shortcut key to switch to a program that's already running. 
For example, if you assign Ctrl+Alt+F to the File Manager program, then 
any time File Manager is running, you can switch from any application to 
File Manager by pressing Ctrl+Alt+F. 

Not all programs work like File Manager, however. For example, if 
you assign a shortcut key to Write or Paintbrush, pressing that shortcut key 
from within another application (Terminal, for example) has no effect at 
all, whereas pressing the shortcut key again from within Program Manager 
launches a second copy of Write or Paintbrush. 

In general, if a program permits multiple copies of itself to be open, 
shortcut keys serve as launchers only, not as switchers. If a program does 
not allow multiple copies, you might be able to use its shortcut key as a 
quick-switch command. You will need to experiment to see how your own 
programs behave. 

Using a Shortcut Key to Switch to Program Manager 
An undocumented technique makes it easy to switch directly to Program 
Manager by means of a shortcut key. Simply create a program item for 
Program Manager (the executable file is PROGMAN. EXE , and you don't 
need to specify a directory path for it), put the item in your Startup program 
group, and assign it a shortcut key the same way you would any other 
program item. The logon process ignores the Startup group's request to run 
Program Manager (because a copy of Program Manager will already be 
running) but records the shortcut key anyway. 

Changing Program Manager's Title-Bar Text 
Oddly enough, if you create a Startup group item for Program Manager, 
you can also change the text that appears in Program Manager's title bar (as 
well as under the icon when Program Manager is minimized). Program 
Manager's title bar normally includes both your computer name and the 
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name of your user account. If you'd rather see something plainer, such as 
John's Program Manager (or just Program Manager), simply type your pre­
ferred text on the Description line of the New Program Item dialog box. 

Creating Program Items with File Manager 
If you have a mouse, you can create new program items by opening File 
Manager and dragging filenames from one of File Manager's windows to a 
Program Manager program group. For more information about creating 
items this way, see "Using File Manager to Create Program Items," page 121. 

Creating Program Items 
with the Setup Program 
When you first install Windows, the Setup program creates program items 
for the applications that it recognizes on your hard disk (if you select the 
Set Up Applications option). If you choose to bypass this step or if you've 
added new programs to your system since you installed Windows, you might 
want to rerun Setup and let it search your hard disk again. 

You can rerun Setup whenever you please. Simply double-click its 
icon in the Main program group. For more information about Setup! see 
"Using Setup to Create Program Items," page 769. 

Creating Program Items to Launch Documents 
Windows maintains a list of associations between document filename types 
and the applications in which the documents are created. It knows, for 
example, that files with the extensions WRI and TRM belong to Write and 
Terminal, respectively. Any filename whose extension is included on the 
associations list can be launched directly from a program item. 

For example, let's say you use Terminal once or twice a day to log 
onto Mel Mail, a public electronic mail service. You've created a Terminal 
document, called MClMAIL.TRM, that specifies the Mel Mail telephone num­
ber, the communications settings you use to dial this service, your password, 
and so on. (For more information about Terminal, see Chapter 15, "Using 
Terminal," page 441.) 
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Because you regularly use the same application (Terminal) with the 
same document (MClMAIL.TRM), you can make your life a little easier by 
connecting the two in a single program item. It's easy to do: 

1. Activate the Accessories program group (or whichever program 
group you want your MCI Mail item to reside in). 

2. Open the File menu, choose New, choose Program Item, and press 
Enter. 

3. In the Description text box, type the text you want to appear under 
the MCI Mail icon. 

4. In the Command Line text box, type mcimail.trm. 

5. Fill out the remainder of the dialog box as appropriate, and then 
click OK. 

Program Manager adds your MCI Mail program item to the Accessories 
program group. 

If you're not sure whether an association exists for the type of docu­
ment you want to launch, go ahead and create the program item on the 
assumption that it does. If you're mistaken, you'll get a polite error message. 
Click OK to return to the Program Item Properties dialog box. Then amend 
the Command Line entry to include the name of your program as well as 
the document file you want to launch. 

For example, suppose you attempt to create a program item for a 
document called REPORT.WZ, created by your Wizzy Word Processor. If 
the extension WZ hasn't been associated with WZ.EXE, Program Manager 
responds with an error message. Click OK to acknowledge the message, 
and then change the Command Line text box to read 

wz.exe report.wz 

To add to or change the associations list, you can use File Manager's 
Associate command. For more information about associations, see "Associ­
ating Documents with Programs," page 97. 
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WINDOWS TIP: If your Windows-based application can 
work with two or more documents at once, you can create 
program items that launch multiple documents. To do this, 
specify the name of the executable file (even if an 
association exists for the type of document you want to 
launch), followed by the name of each document. Separate 
the names with space characters. For example, to load 
Microsoft Excel with the worksheets EAST.XLS and 
WEST.XLS, create a program item with the following 
command line: 

c: \ excel \ excel.exe east.xIs west.xIs 

... 

Changing a Program Item's Properties 
The File menu's Properties command lets you change the properties asso­
ciated with a program item. You might want to do this for any of several 
reasons: because you've moved a program's executable file to a new direc­
tory, because you want an item to launch a different document file, because 
you want to change the descriptive text that appears under the item's icon, 
or because you want to change the icon itself. Whatever your reason, 
choosing the Properties command takes you back to the same dialog box 
you filled out when you created the item, allowing you to make the appro­
priate modifications. 

WINDOWS TIP: You can also get to the Properties dialog 
box by selecting an icon and pressing AIt+ Enter. Or you 
can hold down the AIt key and double-click the item. 

Changing a Program Item's Icon 
Ordinarily, when you create a new program item, Program Manager uses 
the same icon that the application itself uses when minimized. But if the 
program happens to use other icons for other purposes, you can select one 
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of those other icons for your program item instead. For example, the time­
management program Ascend uses the following symbol as its main icon­
the one that appears at the bottom of the screen when you minimize Ascend. 

But it also uses numerous other icons as shortcuts for various com­
mands within Ascend. You can select anyone of the program's many icons 
to represent Ascend in your program group. 

To change the icon assigned to a program item, invoke the Properties 
dialog box, as described above. Then click the Change Icon button. You'll 
see a dialog box similar to the following: 

~urrent I con: 

lie. 
I_I 
1_' 
11-

Select the icon you want to use (use the scroll bar to bring additional 
icons into view if necessary), and then click OK twice-once to return to 
the Properties dialog box, a second time to return to Program Manager. 

Using Another.Program's Icons 
The dialog box that appears when you click Change Icon includes a File 
Name text box. The default entry in this box is the name of the program 
whose item you're modifying. By entering a different filename here, you 
can appropriate an icon from another program. 

You can also link a program item to an icon that is not part of an 
executa~le file-for example, to an icon that you create yourself with an 
icon-editor program. Many public bulletin boards and online information 
services (such as the WINSHARE forum on the CompuServe Information 
Service) have public-domain or shareware icons available for downloading. 
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Such icons may be stored in stand-alone files (common extensions are leN· 
and ICO) or in icon-library files. Simply specify the name of the file con­
taining the icons in the Change Icon dialog box, and then select an icon 
from the scrollable display. 

Deleting Program Items 
Because program items take up a fair amount of space in your program­
group windows, it's a good idea to delete them when they're no longer 

. needed. To delete a program item: 

1. Activate the program group containing the item you want to delete. 

2. Select the item by clicking it or highlighting it with the direction 
keys. 

3. Press Del, or pull down the File menu and choose Delete. 

4. Click Yes in response to the confirmation prompt. 

Starting Programs 
with the Run Command 

Program items are the most convenient way to start programs that you use 
frequently. When you want to run a program only once-for example, the 
installation program for a new software package-you'll probably find it 
simpler to use the File menu's Run command. When you choose this com­
mand, Program Manager presents the following dialog box. 

!;.ommand Line: 

o Run Minimized 

1~1 
I~ 
II.~wl 

Ili\q;U"¥lll~1 

Enter the name of your program in the Command Line text box. Check 
the Run Minimized box if you want the program to start as an icon instead 
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of an open window. (You might want to do this if your program doesn't 
require input from you or if you're not planning to work with the program 
immediately.) Then click OK. 

If your program is not stored in the current directory or in a directory 
included in your Path environment variable, be sure to include the full path 
specification in the dialog box. 

Finding Files with the Browse Button 
If you need some help filling out the Command Line text box, click the 
Browse button. You'll see the dialog box pictured on page 68. When you 
select a filename in the Browse dialog box and click OK, Windows takes 
you back to the Run dialog box, ~with the selected name in place. All you 
need to do then is click OK one more time to run your program. 

The Minimize on Use Command 
After you've used Program Manager to start a program, it's nice to have 
Program Manager out of the way (unless you immediately need to launch 
another program). If you choose the Minimize on Use command from the 
Options menu, Program Manager automatically reduces itself to an icon 
each time you launch a program. 

Saving Seiiings 
The Options menu includes two commands for saving the layout of your 
program groups. If you choose Save Settings on Exit, Program Manager will 
do just that-record window positions every time you log off. This adds a 
moment or two to the logoff process but ensures that Program Manager 
starts each session looking the way it did when you quit the previous session. 

If you're like many users, however, you might always want Program 
Manager to start off looking a particular way, no matter how you rearrange 
the windows during the course of a session. If that's the case, you should 
deselect the Save Settings on Exit command. When you get your program 
groups arranged the way that best suits you (and the way you want them 
to appear at the start of your next session), choose Save Settings Now. 
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Exploring File Manager's Display 
Each directory window in File Manager can be divided into two panes­
one for a directory tree and one to list files. 

Changing the Drive Display 
Click a drive icon or press Ctrl plus a drive letter. 

Navigating Through a Directory Tree 
The keyboard is often the quickest way. 

Changing the Size of Tree and Directory Panes 
If the split is not equitable, drag the split bar. 

Customizing the Contents of Directory Panes 
What you see is what you want; use the V iew menu to express your 
wants. 
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Updating Directory Windows 
Use the Refresh command or press F5 to update the display with the 
latest changes. 

Opening New Directory Windows 
Double-click a drive icon to keep the current window and open a new 
one. 

Customizing the Toolbar 
There's a tool for every menu command. Put the ones you use most often 
on the toolbar. 

Starting Programs from File Manager 
Program Manager is not the only way to start programs. 

Associating Documents with Programs 
An association lets you start a program by launching a document. 

Printing Documents from File. Manager 
Drag a file icon and drop it on the printer. 

Using Drag and Drop to Embed Packaged Objects 
A simple mouse maneuver lets you stuff one document inside another. 

Sharing Directories with Other Users on the Network 
You can turn your hard disk into a file server ... 

Connecting to Remote Directories 
... or open a window onto someone else's hard disk. 

Working with Files and Directories 
File Manager is a housekeeper for your hard disk ... 

Formatting, Copying, and Labeling Disks 
... and for your floppies as well. 

USing File Manager to Create Program Items 
Drag a File Manager icon to a Program Manager group. 
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ike Program Manager, File Manager can be used to launch pro­
--_ ....... grams and documents. As a launcher, File Manager's principal 

virtue is that it shows you the directory and file structure of your disks-.both 
local and network-as opposed to the more task-oriented structure encour­
aged by Program Manager. Thus it's a great tool for opening files when you 
already have a pretty good idea where those files are stored. For example, 
if you work regularly with 10 or 20 documents, you might find it more 
convenient to launch those documents directly from File Manager, rather 
than creating individual Program Manager icons for each one. Provided the 
files have been properly associated with their parent programs (the pro­
grams in which they were created), you can simply double-click a file icon 
and that file will appear within its parent application. 

File Manager is a great deal more than a file opener and program 
starter, however. As its name implies, it's designed to help you take care of 
disk-oriented housekeeping chores. Here are some of the things you can 
do with File Manager: 

[] Copy, move, delete, or rename files 

[] Associate files with applications 

[] Search for files on local or remote hard disks 

[] Assign files to be "read only," so they can't easily be changed or 
deleted 

[] Print files without starting the application in which they were 
created 

[] Create, delete, or rename directories 

[] Copy entire directories 

[] Format floppy disks 

[] Copy floppy disks 
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C Assign volume labels to hard disks or floppy disks 

c Connect to or' disconnect from directories shared by other users 
on your network 

c Share local directories, so that other network users can access them 

c Set security controls for directories and files on disks that use the 
Windows NT file system (NTFS) 

We'll look at most of these topics in this chapter. For information about 
managing security on NTFS volumes, see Chapter 11, "File Security with 
NTFS," page 333. 

WINDOWS TIP: Because File Manager is such a rich and 
versatile program, you might want to create a program 
item for it in your Startup program group. You can do this 
by copying the icon from 'your Main program group. Or, 
if you don't find 'an icon for it there, use Program Manager's 
File New command to create one. Specify WINFILE.EXE 
as the command line. 

fE}{ploring File Manager's Display 
The figure on the next page shows various elements of File Manager's 
display. 

Just below the menu bar is File Manager's toolbar-a set of icon 
shortcuts for menu commands. The toolbar is customizable (for more infor­
mation, see "Customizing the Toolbar," page 93), and icons are available 
for all of File Manager's menu commands. Below the toolbar is the drivebar, 
which displays icons for all local drives and all network drives to which you 
have connected. Drive types are distinguished by their icons. In the figure, 
A and B are floppy drives, C and D are local hard disks, E is a CD-ROM 
drive, and F through K are network directories. 
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Minimized directory windows 

MOUSE TIP: To learn what a toolbar icon does, pointto 
it and hold down the mouse button. While the button is 
down, you'll see a description of the icon in the status bar. 
When you're finished reading the description, move the 
mouse off the toolbar, and then release the mouse button. 

I 

~------------------------------~----------------------------~I: 

Below the drivebar, you might see one or more directory windows. 
These are conventional document windows, just like the ones you use in 
Program Manager. Unlike program groups, however, each directory win­
dow can be split into two panes. The tree pane, on the left, shows the 
directory structure of the current drive. The directory pane, on the right, 
shows the contents of the current directory. You can adjust the relative size 
of the panes by dragging the split bar. 
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At the bottom of File Manager's display is the status bar, which pro­
vides information about the amount of free space available on the current 
drive or information about the file or files that are selected plus the total 
size of a directory's contents. 

WINDOWS TIP: Commands on the Options menu let 
you turn the toolbar, drivebar, and status bar on or off. 
You can make more room on screen for your directory 
windows by suppressing the display of these bars. 

Icons Used in Directory Windows 
Folder icons, in both tree panes and directory panes, denote directories. A 
hand under a directory's folder icon indicates that the directory has been 
shared (made available to other network users). In the figure on page 81, 
C: \ SS is a shared directory. 

An open folder indicates the current directory but says nothing about. 
whether the directory has subdirectories. To make the tree pane indicate 
the presence or absence of subdirectories, choose the Indicate Expandable 
Branches command from the Tree menu. File Manager then displays a plus 
sign within the folder of any directory that includes subdirectories. (Your 
tree pane might take a little longer to display with this option on, which is 
why File Manager leaves it off by default.) 

At the top of a directory pane, you might see an upward-pointing 
arrow with two dots next to it. This is your "go-back" icon; it represents the 
current directory's parent directory. 

File' Manager uses the following symbols to distinguish file types: 

D IT! 

The rectangle with the stripe across the top represents an executable, 
or program, file. These are files with the extensions BAT, COM, EXE, or PIP. 
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The dog-eared page symbol with horizontal lines across it represents 
a document file. A "document" in this context mean~ a data file that is 
associated with an application. You can launch a document by double­
clicking its icon. Looking at a File Manager directory window won't tell you 
which programs your documents are associated with, but the Associate 
command supplies that information. It also allows you to change associa­
tions or create new ones. For more information about the Associate com­
mand, see "Associating Documents with Programs," page 97. 

The dog-eared page symbol without horizontal lines represents an 
unassociated data file. Trying to launch one of these will get you an error 
message. 

A page symbol with an exclamation point inside represents a file that 
has either the hidden attribute, the system attribute, or both. These attributes 
are generally assigned to files that are critical to the functioning of your 
system. Because deleting or altering such files is likely to have disastrous 
consequences, File Manager doesn't ordinarily include them in its directory 
displays. You can override this default and display hidden and system files 
by choosing the View menu's By File Type command. For more information, 
see "Filtering the File Listing," page 90. 

Changing the Drive Display 
Click once on a drive bar icon to make the current window display a different 
drive. Double-click to open a new window for the selected drive. 

For example, to change the display in the figure on page 81 from C: 
to D:, click the D icon. If you want to see two'windows-one for C and 
one for D-double-click the D icon. (You can tile the two wind~ws using 
the Window menu.) 

You can also change the drive display by opening the drop-down list 
at the left side of the toolbar, by choosing the Disk menu's Select Drive 
command, or by holding down the Ctrl key and'pressing a letter key. For 
example, to switch to D:, you can press Ctrl+D. You'll find this last method 
particularly handy if you've turned off the drivebar display. 
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WINDOWS TIP: Because the drop-down list at the left 
side of the drivebar lists the volume labels associated with 
each available disk drive, you might find it the easiest way 
to switch to a network drive-particularly if you don't 
remember which of several drive letters has been assigned 
to which server. 

No]vigai~ng Through OJ Di~ectony iree 

I 

To change the contents of the directory pane, select the appropriate entry 
in the tree pane. You can move about the tree pane quickly with the mouse, 
either by clicking the folder icon or name of the directory you're interested 
in, or by scrolling with the scroll bars and then clicking. But often you'll 
find it even quicker to use the keyboard. Directories that share the same 
level in the tree are always listed alphabetically, and you can move between 
them the same way you move in any other Windows list: by pressing the 
first letter of the directory name you want to move to. 

The first time you use File Manager, the tree pane shows the current 
disk's structure to two levels of detail. That is, you'll see the root directory 
and all of the root's immediate subdirectories. To "open" a directory so that 
its own subdirectories are visible, you can either double-click that directory 
or move to it with the keyboard and then press Enter. (Repeat this process 
to close the directory and hide the names of its subdirectories.) 

File Manager's Tree menu also has a set of commands to help you 
manage the level of detail shown in the tree pane. 

Use Expand One Level or press the plus key to reveal the immediate 
subdirectories of the current directory. Use Expand Branch or press the 
asterisk key to reveal all subdirectories of the current directory. Use Collapse 
Branch or press the minus key to hide subdirectories of the current directory. 
And, if you want to see your entire directory tree, press Ctrl+asterisk or 
choose Expand All. Be aware that if your disk is large, you might need to 
wait a few moments for File Manager to build its full tree display. 
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WINDOWS TIP: If you choose the Expand All command 
and get tired of waiting for File Manager to create its full 
tree display, press the Esc key or click one of the drive 
icons. File Manager interrupts its directory scan and 
displays as much of the tree as it has built to that point. 
The message "Incomplete directory tree displayed" 
appears in the status bar. 

I<EYBOAR D TIP: To get from anywhere in the tree to the 
root directory one level at a time, press the Left direction 
key or Backspace repeatedly. To get directly to the root, 
press Home. 

Chon1g~ng the Size 01 
iree and Direciory Panes 

The first time you run File Manager, the program divides the screen real 
estate roughly equally between the tree pane and the directory pane. You 
might prefer to have a narrower tree pane and a wider directory pane. To 
adjust pane size with the mouse, put the pointer over the split bar-the 
narrow vertical bar to the right of the tree pane's vertical scroll bar (see the 
illustration on page 81). When the mouse is positioned correctly, the pointer 
changes to a two-headed arrow. Now drag the split bar to the left to widen 
the directory pane or to the right to widen the tree pane. 

To adjust pane size withthe keyboard, choose the View menu's Split 
command. A dark vertical bar appears within your document window. Use 
the Left and Right direction keys to reposition this split bar, and then press 
Enter. 
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Displaying One Pane at a Time 
By dragging the split bar all the way to the left or right side of the document 
window, you can get rid of either pane altogether. This way, you can con­
centrate entirely on the file contents of a directory or the directory structure 
of a disk. You can also use the commands in the top section of the View 
menu to eliminate one pane or the other. 

vt!ame 
All File Details 
Eartial Details ... 

v,S.ort by Name 
Sort.!!.yType 
Sort by SI~e 
Sort by Q.ate 

To restore the two-pane setup, revisit the View menu and choose the 
Tree and Directory command. 

Customizing the 
Contents of Directory Panes 

A directory pane normally lists all of a directory's subdirectories and files 
except those that have either the hidden or system attribute. Subdirectories 
appear at the top of the list, followed by filenames, and both parts of the 
list are alphabetized. Normally, you see only the names of the files and 
subdirectories, not their sizes, dates, times, or attributes. 

But you can customize a directory pane in a number of ways. With 
commands on the View menu, you can: 

EI Change the information included in the list 

D Change the order of the list 

D Filter the list, so that only particular kinds of files appear 
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Using a command on the Options menu, you can also change the font 
that File Manager uses to list your files. 

WINDOWS TIP: File Manager's customizing options 
affect only the current document window. If you want to 
change the appearance of all windows, close all but one. 
The changes you make to that window will then be 
inherited by any windows you subsequently open. 

Changing the Information in the File Listing 
Each entry in a directory pane ordinarily includes only an icon and a name. 
This arrangement allows you to see the largest possible number of files and 
subdirectories without having to scroll. For some directory windows, 
though, you might want a little more information. To see all the details about 
the files in a directory pane, activate it and choose the View menu's All File 
Details command. 

In addition to the icon and filename, the detailed directory listing 
shows the size of each file, the date and time it was last modified, and the 
presence of any attributes. If you are using the NT file system (NTFS) it 
shows both the. "long" NTFS name and an MS-DOS filename that's a con­
traction of the long name. (For more information about filenames, see "NTFS 
Filenames," page 88.) 

WINDOWS TIP: If you want detailed information about 
a particular file but don't need it for the whole directory, 
it's simplest to select the file and look in the status bar, 
where the file's size is displayed along with the date and 
time of the most recent save. For additional information 
about the selected file, press Alt+ Enter. That invokes the 
Properties dialog box, which displays the file's size, date 
and time of most recent save, attributes (if any), version 
number, and copyright information. 
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One of the advantages of using the Windows NT "native" file sys­
tem, NTFS, is that you can use long names for files and directories. 
NTFS allows names of up to 256 characters-a 23-fold 
improvement over the paltry 11 permitted by the MS-DOS (FAT) 
file system! NTFS filenames can also include various characters 
not allowed in FAT filenames: spaces, multiple periods, commas, 
square brackets, semicolons, equal signs, and plus signs. (You 
can also include both uppercase and lowercase letters in your 
long filenames, and your choice of case will be preserved for 
display purposes. Internally, however, Windows NT ignores case 
variants, just as MS-DOS does.) 

You can use long filenames without fear of making your files 
inaccessible to older applications or older operating systems. 
Windows NT simply stores two versions of each NTFS filename­
the one you supply and another one that's "MS-DOS legal." The 
alternative name is built from the first six characters of the long 
name, followed by a tilde, a numeral, a period, and the first three 
characters that follow the last period in your long name. So, for 
example, the short counterpart for the long name Accounts 
Receivable.XLS might be ACCQUN-l.XL5. 

You can see both versions of your filenames by choosing the 
Partial Details command on File Manager's View menu and 
selecting the fifth check box. 

In addition to the names-only and full-details displays, File Manager 
offers several in-between options. To see your choices, pull down the View 
menu again, and choose the Partial Details command. File Manager re­
sponds with the following dialog box. 
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Details-----------, If!"':"1l17 .• 
[8J 1,.~.·.·.·.·i.·.z.·.·.e.·.·.·,! 
[8J Last M.odification Date If.C.ncer~·1 
[8J Last Modification lime 

[8J file Attributes 

[8J MS-Q.OS file names for NTFS 

You can select any combination of the five check boxes. 

Changing the Sort Order 
The four Sort By commands near the bottom of the View menu let you 
change the order in which items appear in directory windows. The default 
order is by name. At times you might. find it more convenient to group files 
by type-that is, by their extensions. For example, suppose you're looking 
at a spreadsheet directory that contains a large number of program and 
worksheet files mixed together. If the document files all have the same 
extension (as they do with most spreadsheet programs), you might find it 
easier to locate particular files if you sort the directory by type. 

Sorting by size is convenient when you copy files from a hard disk to 
a floppy disk. The first thing you might want to know under these circum­
stances is whether any of your files are too large to fit on the floppy. If you 
sort by size, the largest files appear first in the list. (You might also want to 
include the file-size information in the listing.) 

If you back up files manually at the end of each day using File Man­
ager's Copy command, you might want to choose the Sort By Date com­
mand. That way, the files you worked with most recently appear at the top 
of your directory window and you can tell at a glance which ones you need 
to back up. 

NOTE: The Backup program furnished with Windows NT 
provides a better alternative for backing up your files. For more 
information about this program, see Chapter 13, \\Backing Up 
and Restoring Files," page 361. 

89 



90 

PAR T 1: Introducing Windows NT 

Filtering the File listing 
Looking for a specific file in a directory containing many files can be difficult 
and time consuming, especially when you're not sure about the file's name. 
To make the task simpler, you can "filter" the pane so that it displays only 
particular kinds of files. 

To do this, pull down the View menu and choose By File Type. File 
Manager presents the following set of choices. 

- By File Type 

Harne: 1=_=--___ ---' 
-File Type -------. 

[8] ,l!ireclories 

[8] frograms 

['8J Documenls 

[8] .Q.lher Files 

o Show Hidden/fulslem Files 

To use this dialog box, start by selecting the check boxes for the types 
of files you're interested in. If you want to see only program files, for 
example, deselect everything but Programs. Then, if you need to refine the 
filter, you can change the wildcard specification in the text box. For example, 
if you want to see only program files that begin with the letter S, you can 
type S*. * in the text box. (To restore the default filter, *. *, simply erase the 
current filter.) 

Changing File Manager's Font 
The Font command, on File Manager's Options menu, lets you change the 
typeface and style used in File Manager's current window. You might find 
this command useful if you want to see more filenames without scrolling; 
just choose a smaller point size or a narrower font. 
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Updating Directory Windows 
When you use File Manager with floppy disks, be aware that your tree and 
directory panes are not automatically updated when you switch disks. For 
example, suppose you are looking at the tree and directory panes for the 
floppy disk in drive A. If you put a new disk in drive A, neither pane will 
be correct. File Manager will still display information about the disk that 
was in drive A. 

To update a window after changing a floppy disk, select the window 
and press F5. (Or use the Window menu's Refresh command.) 

Depending on your network's capabilities, you might also need to use 
the Refresh command to update the information displayed for a directory 
on a network file server. 

Opening New Directory Windows 
When you're working with two directories or drives at once-for example, 
when you're copying files between a hard disk and a floppy-you'll find it 
convenient to display each directory or drive in its own document window. 
File Manager lets you open as many document windows as you please, and 
it has commands to organize them neatly on your screen. 

To look at two different directories in the same drive, choose the 
Window menu's New Window command. Initially, the contents of the new 
window will be the same as the one you were just working with. Use the 
techniques described earlier in this chapter to change the new window's 
contents. 

To open a new window for a different drive, double-click the appro­
priate drivebar icon. 

To remove a document window, double-click its Control-menu box, 
or select it and press Ctr1+F4. Note that you cannot remove all of File 
Manager's windows. The program insists on keeping at least one open at 
all times. You can, however, minimize any or all windows. 
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Organizing Directory Windows 
File Manager's directory windows can be moved, sized, tiled, and cascaded, 
exactly as Program Manager's group windows can. You'll find that a tiled 
display of two File Manager windows often makes it easier to copy or move 
files between disks or directories. 

You can tile directory windows in either of two ways-horizontally or 
vertically. To split the screen space vertically, choose the Tile Vertically 
command from the Window menu or press Shift+F4. Your screen looks 
something like this: 

improv.hlp 
Dimprov.ri 
D improv.tbl 
D improv. v20 

c:Jscripts £:]install.exe 
D addins20.dll ~ install. hlp 
Cl aminet.dll ~ install.ini 
D backbay.ri £:]instmainexe 
D bbicons.dll D ivc.dll 
D bbicons8.dll D ivcw.d11 
D bc30rtl.dll D libbbvw.dll 
D colortrg.dll D libbbz.dll 
~ diskflst.ini D libcb.dll 
D engine.dll D libdde.dll 
D fileio.dll D libflt.dll 
D ilsi.dll D libfmt.dll 
D ilsisrv.dll D libinfo.dll 
£:]imp20w.exe D libmb.dll 
£:]improv.exe D libomsvr.dll 

To split the screen space horizontally, pull down the Window menu 
and choose Tile Horizontally. The result looks like the figure on the next 
page. 
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You can switch between these two tiling modes at any time. 

WINDOWS TIP: When you tile windows, File Manager 
avoids covering any minimized document windows. To 
get the maximum screen space for your directories, 
therefore, close any windows you're not working with, 
rather than minimize them. 

I 

, 

I' 
i 

~-------------------------------------------------,---.------------------~ 
: 

File Manager's default toolbar includes icons for the commands Microsoft 
thinks you are most likely to use. But you can change the layout and content 
of the toolbar to suit your own needs. For example, if you never use the 
Permissions tool (the last tool on the right on the default toolbar), you may 
as well remove it from the bar and add a tool for a command that you do 
use. The only element of the toolbar that's fixed is the drop-down list on 
the left side. You can't remove, relocate, or resize this drop-down. 
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MOUSE TIP: The default toolbar is designed for a stan­
dard (640x480) VGA display. If you use a Super VGA or 
other high-resolution display driver, the default arrange­
ment leaves plenty of room on the right side for additional 
tools. Don't let valuable screen real estate go to waste! Fill 
out the toolbar with icons for the commands you use most 
often. 

Repositioning and Removing Tools 
To reposition a tool on the current toolbar, hold down the Shift key and 
drag the tool. For example, if you want the "open new window" tool (the 
fifth tool from the right on the default toolbar) to be next to the drop-down 
drive list, hold down the Shift key and drag that tool to the left. 

Note that you can use this dragging technique to tighten the spacing 
between tools. The default toolbar includes spaces to separate groups of 
functionally related tools. The "connect to network drive" and "disconnect 
from network drive" tools, for example, are separated from the "share 
directory" and "stop sharing directory" tools. These separators might be 
helpful initially. But when you know what each tool does, you might prefer 
to move the tools closer together to make room for additional tools. You 
can do this by holding down the Shift key and dragging a tool until it touches 
its neighbor. 

To remove a tool, hold down the Shift key and drag it off the toolbar. 

Adding Tools and Resetting the Default Toolbar 
To add a tool to the toolbar, pull down the Options menu and choose the 
Customize Toolbar command, or simply double-click the background area 
of the toolbar. File Manager presents the following dialog box. 
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A~ailable Buttons: 

~~~~~~~~ 

1f!S~1 
I (foveAown 1 

The list box on the left presents all the available tool icons not currently 
on the toolbar. The box on the right lists the tools currently on the toolbar 
in left-to-right order. To add a tool, select it in the left list box and click Add. 
File Manager adds the tool to the list on the right, positioning it directly 
above (which means to the left) of whichever tool is currently selected in 
the Toolbar Buttons list. If that's not where you want it to go, use the Move 
Up and Move Down buttons to reposition it. Or close the dialog box and 
Shift+drag the new tool where you want it to go. 

To restore the toolbar to its original layout, click Reset in the Customize 
Toolbar dialog box. 

Stariing Programs from file Manolger. 
To start a program from File Manager, open a window for the directory in 
which the program's executable file resides. Then do one of the following: 

c Double-click the name of the executable file. 

c Use the keyboard or mouse to select the name of the executable 
file. Then press Enter. 

c Pull down the File menu, and then choose Run. Fill out the dialog 
box with ·the name of the program's executable file. 
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WINDOWS TIP: Why would you ever want to use File 
Run, when double-clicking is so much simpler? Because 
File Run lets you specify a command-line parameter along 
with the name of your program. 

Using Drag and Drop to 
Launch a Document File 
You can start a Windows program with a particular document in place by 
dragging the document's icon onto the program's icon. For example, sup­
pose you want to run Quattro Pro for Windows and open a Lotus 1-2-3 file. 
The Lotus file is not associated with Quattro Pro for Windows, so you can't 
simply double-click its icon. Instead, you can do the following: 

1. If QPW.EXE and your 1-2-3 file are stored in different directories, 
display two File Manager windows-one for QPW and one for the 
1-2-3 file. 

2. Click the icon for your 1-2-3 file to select it. Drag it to your Quattro 
Pro directory window and drop it on the icon for QPW.EXE. 

When you bring your document-file icon into position above the 
executable file's icon, File Manager draws a rectangle around the latter, 
telling you that you've reac;hed the "drop zone" and it's okay to release the 
mouse button. At that point, depending on how you've set File Manager's 
confirmation options (for more information about these options, see "Con­
firmation Options," page 106), you might see the prompt shown in the figure 
on the next page. 

Click OK, and your 1-2-3 file will appear within Quattro Pro. 

Note that if you drop a document icon onto a directory or drive icon, 
File Manager thinks you want to move or copy your file, rather than launch 
it. In this case, you might see a different confirmation prompt. 
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D qpwqbe.dll 
D qpwview. dll 

I .JJ~~~=~!;;~~::8:;;;~~~i~~i~;;d'L:l~qWUPdate.exe Ir' - adme.txt 
Confirm Mouse Operation ereen.hlp 

eeond.bar 
Are you sure you want to start QP'vY.EXE using angogh.bar 
SALES.WK3 as the initial file? er.dll 

~ a_readme.wk3 ~ ine6s.wk3 ~ yearine2.wk3 
~ datalens.wk3 ~ ine7s.wk3 
~ inel0s.wk3 ~ ine8s.wk3 
~ inells.wk3 ~ ine9s.wk3 
~ ine12s.wk3 lI"haleswk3 I 
~ ine2s.wk3 ~ sampadns.wk3 
~ inc4s.wk3 ~ sum1991s.wk3 

MOUSE TIP: You can also launch a document by drag­
ging its icon onto a running application. If Notepad is 
already running, for example, you can drag a text-file icon 
and drop it onto Notepad's title bar or into Notepad's 
window. If Notepad is minimized, you can drop the file 
icon onto Notepad's icon. 

Assoc~o]t~D1g 
Documents wiih Programs 

A file that is associated with an application can be launched directly from 
File Manager. Double-click any file with the extension TXT, for example, 
and that file appears within Notepad-provided that TXT files have been 
associated with NOTEPAD.EXE. An application can be associated with one 
or more file types, but each file type can be associated with only one 
application. 
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The Windows NT Setup program automatically creates file associations 
for Cardfile, the Windows help system (WINHELP.EXE), Media Player, Paint­
brush, the registry editor (REGEDIT.EXE), Sound Recorder, Terminal, 
Notepad, and Write. The installation programs for many Windows-based 
applications also automatically create the appropriate associations for you. 
If you install Microsoft Excel, for example, you will not need to take any 
additional stepsto create associations for the files that Excel uses. 

You might, however, need to create associations for older Windows­
based applications that were designed without the Windows association 
feature in mind. You might also occasionally want to change or delete an 
existing association. 

To create, modify, or delete an association, first select any file with the 
extension you want to associate. Then pull down the File menu, choose 
Associate, and fill out the dialog box. 

For example, let's assume that you used to do your spreadsheet work 
in Lotus 1-2-3 Release 2.2, and you've recently converted to Quattro Pro for 
Windows. Your hard disk has hundreds of files with the extension WK1, 
and because QPW can read these files without a translation step, you'd like 
to associate the WK1 extension with QPW.EXE. Here's how to do it: 

1. Open a File Manager directory window for one of your 1-2-3 data 
directories. 

2. Select any file with the extension WK1. 

3. Choose the Associate command on the File menu. 

The following dialog box appears, showing that WK1 files are 
currently associated with (None). 

Associate 

files with Extension: 15 

(None) 
None 

AmiPro Document (G:\AMIPRO\AMIPRO.EXE) 
Calendar File (calendar.exe) 
Card File (cardfile.exe) 
Help File (winhlp32.exe) 
HiJaak Image (E:\HJWIN\HJWIN.EXE) 
Media Pia er MPla er.exe i+ 
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4. Scroll through the Associate With list until you find an entry for 
Quattro Pro for Windows. 

Associate 

files with Extension: IWKl I F':~'C""'bK'T~ ~~''''I 

Associate With: IFirow$;~.~~~1 IF·" 'Cancel' .... '<FI 
/Quattro Pro Notebook Ir::N.etif"TJPe.:l!:l 

• • I· I 1'1 II n:..t:r.t..,. • t .. 

Registration Entries (regedit.exe) r- If];hange':fype:r~FI 
Sound Recorder (soundrec.exe) '. 
Terminal Settings (terminal.exe) ~ lr;rD.ele~f9P;r""'~1 

~:rtl~:J~~~~t~~\~NWORD\winword.exe) ~ IFc;7~Tf!ejpS~"1 
~W~r~ite~Do~c~u=m~en~t~(w~r~it~e.~ex~e~~I ____________ ~ . _ 

5. Click OK. 

Chances are you'll find an entry in the Associate With list for the 
program you want to connect with. If you don't, all is not lost. Click Browse, 
and then navigate through the files and directories in the Browse dialog 
box until you find the name of your program's executable file. Select that 
file, click OK, and Windows NT creates the desired association. 

Changing or deleting an association is as easy as creating one. Select 
a file with the extension in question, use the Associate command, and then 
change or remove whatever appears in the Associate With text box. When 
you are finished, click OK. 

Priniing Documents 
1rom fUe Manager 

Most data files that are associated with applications can be printed directly 
from File Manager. You can do this in either of two ways: 

[J By dragging filenames from a File Manager window to the Print 
Manager icon (or the open Print Manager window) 

[J By selecting one or more files in a File Manager window and 
choosing the File menu's Print command 
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Either way, File Manager launches the document's associated program 
and uses the program's print command to print the document on the current 
default printer. 

USh1g Dwag and [D~op to 
Embed POJc~{Olged Objecfrs 

A packaged object is an iconic representation of a data object, such as a 
graphic irriage or a sound annotation. The data so encapsulated must origi­
nate in a program that supports object linking and embedding (OLE) as a 
server application, and it must be embedded in a program that supports 
OLE as a client application. 

File Manager provides a drag-and-drop shortcut technique for embed­
ding packaged objects. If you drag the icon for a file created by an OLE 
server and drop it in an OLE client's application window, Windows embeds 
the file as a packaged object. For example, if you want to embed the graphic 
image CHITZ.BMP in a Write document, you can do the following: 

1. Display Write and File Manager in tiled windows. 

2. Scroll the File Manager window so the icon for CHITZ.BMP is visible. 

3. Drag the icon for CHITZ.BMP and drop it in the Write window. 

Note that the Write window must be open for this to work. If you drop 
the BMP file onto a minimized Write icon, Write thinks you want to import 
CHITZ.BMP as a text file. 

For more information about OLE and packaged objects, see "Making 
Connections with OLE," page 184, and "Embedding Packages," page 187. 

Sha~~ng D~weciow~es w~ih 
Oifhew Usews on ifhe Networ~{ 

To make a directory on your hard disk available to other users on your 
network, select that directory in a File Manager window and choose the 
Disk menu's Share As command (or click its toolbar shortcut-the icon that 
shows a folder in an outstretched hand). File Manager presents the New 
Share dialog box, as shown in the following illustration. 
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New Share 

f.ath: I C:\WINPROJ 

~omment: 

r- User Limit: ----------, 

@ !J.nlimited 

o Allow L-I ___ ..... liI_: Users 

l~dK"····1 
HCancei ') 

I!Permi,*iom:::l 
Ir~~· :l:bdp ''''I 

NOTE: You must run the Server service on your computer before 
you can share directories. If you get an error message indicating 
that the Server service is not running, start Control Panel and 
double-click the Services icon. In the list of services that appears, 
select Server and click the Start button. (For more information 
about Control Panel, see Chapter 4, \\Customizing Windows NT 
with COQtrol Panel, II page 123.) . 

A shared directory is identified by its share name and path. By default, 
Windows NT uses the directory name as the share name, but you can modify 
that. For example, if you think your directory name would appear cryptic 
to another user, you might want to provide a more intuitive share name. 
To do this, type the name you want to use on the top line of the New Share 
dialog box. You can use up to 12 characters in the share name. 

NOTE: If you plan to share directories with users of Windows for 
Workgroups or other MS-DOS-based operating systems, you 
must limit your share names to 8 characters plus an optional 
3-character extension. If you share a directory on an NTFS 
volume, you might need to modify the default share name, 
regardless of who you intend to share with. If the directory name 
has more than 12 characters, Windows NT proposes it as the 
default share name but rejects the name when you click OK. 
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In addition to a share name and path, you can also attach a comment 
to a shared directory. Users will see ihis comment when they connect to 
your directory. You might use the comment field to describe the directory's 
contents or list any security restrictions associated with the directory. 

By default, any number of users can connect to a shared directory 
simultaneously. If this unlimited availability presents a problem (for exam­
ple, if your system becomes unresponsive because it's spending too much 
time acting as a file server), you can specify a maximum number of simul­
taneous users. You can do this by clicking the Allow option button and 
using the "spinner" arrows to indicate how many users you're willing to 
tolerate. 

The default permissions level for shared directories is Full Control to 
Everyone. You can modify this default in several ways. You might, for 
example, want to give everyone Read access only, instead of Full Control. 
Or you, might want to grant Full Control to particular users and No Access 
to everyone else. To change the permissions level for your share, click the 
Permissions button. 

For more information about setting permissions, see "Attaching Secu-
rity to Files," page 334. 

NOTE: Sharing a directory means sharing all files within that 
directory, including all subdirectories. If the directory is on an 

NTFS volume, however, you may restrict access to particular files 

and subdirectories. For information about setting permissions on 

NTFS volumes, see Chapter 11, "File Security with NTFS," page 333. 

When You No Longer Want to Share 
If you decide to stop sharing a directory, choose the Disk menu's Stop 
Sharing command. Select the directory or directories in the list that appears 
and click OK. To select multiple directories, hold down the Ctr! key while 
you click. 

For reasons of security· and efficiency, it's a good idea to cancel your 
shares as soon as they're no longer needed. You can tell which directories 
are currently being shared by looking at their icons in File Manager's tree 
and directory panes. The shared directories are the ones with the hands 
under their folders. 
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Connecting to Remote Directories 
To access a directory on another network computer-either a dedicated file 
server or another workstation in your workgroup-use the Disk menu's 
Connect Network Drive command or its toolbar shortcut. The toolbar short­
cut for this command is the one that looks like a drive icon with sunshine 
on its shoulder. 

File Manager displays the Connect Network Drive dialog box, which 
looks like this: 

Connect Network Drive 

Q.rive: I CJ L: 

fath: I 
.c.onnecIAs: I 

[gI Reconnect at Logon 

~hared Directories: 

r Microsoft Windows Network 
~ DOCUMENTATION 

6;lDOWNLOAD -
6;lINVOICES 
6;l LOANS 
6;l MSMDtJEY 
6;l SS 
6;l SSCOL 
6JWGPO 
6JWINDOWS 
6;lWRITING -

~ STINSON 

I!I Ir-'or: , ~I 
1L!1 If7Car;:cer~1 

I II";' He1P';'''~ I 

[gI [xpand bV Default 

'+ 
,'" 

, 

f'? 
T, 

~ 

Network type 
Domain or workgroup 
Computer 

Shared directories 

When you fill out this dialog box and click OK, File Manager displays 
the selected drive in a new directory window, adds a drive letter representing 
the connected directory to the drivebar, and adds both the drive letter and 
the full path of the connected directory to the drop-down list on the left 
side of the toolbar. At this point you can work with the remote directory's 
files the same way you would with any files on your local hard disks. 

Choosing a Drive Letter 
In the top line of the Connect Network Drive dialog box, Windows NT 
proposes a drive letter for connected directory. All, unused letters from A to 
Z are available. The first unused letter is the default choice, but you can 
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select a different letter if the default doesn't suit you, or you can choose no 
letter at all (the no-letter option is at the bottom of the drop-down list, just 
after Z). 

WINDOWS TIP: If you work with several remote direc­
tories at once, you might want to choose drive letters that 
have mnemonic Significance-such as P for Payables and 
I for Inventory. 

Using th~ Browser and the Path Line 
If· your network consists entirely of computers running Windows NT or 
Windows for Workgroups, you should be able to find the directory you 
want by browsing through the tree diagram in the lower half of the dialog 
box. This tree works like the diagrams in File Manager's tree panes. You 
can collapse or expand any elements in the tree to see more or less detail. 
The figure on page 103 shows some of the symbols you might see in the 
browser's network tree. On your system, the browser might look quite 
different, depending on the kind of network you're connected to. 

If the directory is one that you've used before, you can probably find 
it by clicking on the drop-down arrow on the right side of the Path text 
box. This opens a drop-down list of the dozen most recently used remote 
directories. 

You can also specify a remote directory by typing its network path 
directly into the Path text box. To do this, type two backslashes followed 
by the name of a computer. Do not include any hierarchical levels above 
the computer name, such as a workgroup or domain name. Then type one 
backslash, followed by the share name of the directory you're interested in. 

For example, suppose you want to connect to a directory that is shared 
under the share name HIGH, located on a server named ROCKY MOUN­
TAIN. To specify this in the Path text box, type: 

\ \ ROCKY MOUNTAIN\HIGH 
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WINDOWS TIP: Unless you're fond of typing, you'll 
probably find it easier to select directories from the 
browser, rather than by typing full path entries. But the 
Path line can be a valuable shortcut to a particular section 
of the browser. For example, suppose you know that you 
have a server named ROCKY MOUNTAIN somewhere on 
the network, but you're having trouble finding it in the 
tree diagram. Type \ \ rocky mountain on the Path line and 
press Enter, and the relevant section of the network 
hierarchy appears in the browser. Then you can scan the 
list of ROCKY MOUNTAIN's shared directories to select 
the one you want. 

WINDOWS TIP: You might not need to use File Manager 
to access network directories. Nearly all of Microsoft's 
applications for Windows, and many from other vendors 
as well, use a common set of dialog boxes for opening 
and saving files. Clicking the Network button in these 
dialog boxes has exactly the same effect as using File 
Manager's Connect Network Drive command. Even if your 
applications don't use the common dialogs, check to see 
if the dialogs they do use provide direct access to the 
network. 

Connecting to Root Directories 
To connect to a shared root directory on a Windows NT workstation, you 
must be logged on with a user account that has administrative privileges. 
Without administrative status, however, you can connect to shared root 
directories of non-Windows NT machines (machines running Windows for 
Workgroups, for example). 
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Maintaining Connections Between Sessions 
If you expect to use a remote directory repeatedly over a period of time, 
you'll probably want to select the Reconnect at Logon check box. That way, 
Windows NT restores the connection at the beginning of each work session. 

Windows NT maintains a separate list of recurring connections for 
each user account. Thus, if another user logs onto your workstation, the 
system will restore that user's directory connections, not yours. 

Breaking Connections 
It's a good idea to disconnect from network drives that you no longer need. 
To do this, use the Disk menu's Disconnect Network Drive command or its 
toolbar shortcut. The toolbar shortcut for this command is the one that looks 
like a phantom drive icon with a big X on its shoulder. 

Working with Files and Directories 
In addition to starting programs, associating files with programs, sharing 
directories with other users, and making and breaking network connections, 
File Manager lets you perform all kinds of housekeeping operations on files. 
You can move and copy files from one directory to another by dragging 
their icons with the mouse. And you can delete files by highlighting file­
names and pressing the Del key or clicking the Delete tool. 

You can also use File-menu commands or toolbar icons to move, copy, 
and delete files. Additional commands on the File menu let you rename 
files, print files, and change file attributes. 

You can perform these chores on individual files or on groups of files, 
as you choose. 

Confirmation Options 
Before experimenting with the techniques for manipulating files, you might 
want to acquaint yourself with the Confirmation command on the Options 
·menu. That command brings up the following dialog box. 
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Confirmation 

-Confirm On-----------..lr OK~~I 

[g] File _D elete 

[g] DIrectory Delete I Fcaooe. I 
[g] File Replace If 'tfeip'r:'7'1 
[g] M.ouse Action ,. 

[g] D is.l5:, Commands 

[g] Modifying fuJstem. Hidden. Read Only files 

It's a good idea to keep all options in this dialog box checked at all 
times. That way, File Manager warns you if you're about to do anything that 
might accidentally delete or overwrite data that you need. While you're 
leafning to use File Manager's various drag-and-drop options, it's a particu­
larly good idea to leave the Mouse Action confirmation setting checked. 

Selecting Files with the Mouse or Keyboard 
Most of the file operations described on the next several pages require that 
you first select one or more filenames, and then choose a command. Select­
ing one filename is straightforward: Simply click the mouse on the filename 
entry in a directory window, or use the keyboard to move the highlight to 
the filename. Selecting more than one filename at once is also easy, and 
File Manager gives you several ways to do it. . 

To select a group of contiguous filenames with the mouse, do this: 

1. Click the first filename in the group. 

2. Hold down the Shift key. 

3. Click the last filename in the group. 

To deselect the group, click the mouse anywhere else in the directory 
pane, without pressing the Shift key. 

To select a group of contiguous filenames with the keyboard, do this: 

1. Move the highlight to the first filename in the group. 

2. Hold down the ,Shift key. 

3. Move the highlight to the last filename in the group. 
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To deselect the group, use the cursor keys to move the highlight 
somewhere else. You can also deselect the group by pressing backslash (\). 

To select a group of noncontiguous filenames with the mouse, do this: 

1 . Click the first filename. 

2. Hold down the Ctr! key while you click each additional filename 
you want to select. 

To deselect the group, click the mouse anywhere else in the directory 
pane, without pressing the Ctr! key. 

To select noncontiguous filenames with the keyboard, do this: 

1 . Move the highlight to the first filename you want to select. 

2. Press Shift+F8. 

3. Use the direction" keys to move the dotted rectangle to the next item 
you want to select. 

4. Press Spacebar to select that item. 

5. Repeat steps 3 and 4 until you have selected all items. 

To deselect the group, press Shift+F8 again, and then use the cursor 
keys to move the highlight somewhere else. You can also deselect the group 
by pressing backslash. 

To select all files in a directory window, press slash (j). 

Selecting Files with the Select Files Command 
You can also use the Select Files command, on the File menu, to select all 
files that meet a wildcard specification. When you choose this command, 
File Manager presents the following dialog box. 

Select Files 
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Clicking Select adds all files that meet the wildcard specification to the 
current selection. Clicking Deselect does the opposite-it removes the speci­
fied group of files from the current selection. 

Be aware that the Select Files command does not replace the current 
selection with the wildcard group. Thus, for example, if the current selection 
is a file named MYFILE.BAK, and you want to select all files with the 
extension BMP, you might want to do the following: 

1. Choose the Select Files command. 

2. With the wildcard specification set to *. *, click Deselect. 

3. In the File(s) text box, type *.BMP. 

4. Click Select. 

5. Click Close. 

Step 2 clears the current selection. If you omit this, your selection will 
consist of all BMP files plus MYFILE.BAK. 

WINDOWS TIP: The status bar shows the size of the cur­
rent selection-both the number of files and the number 
of bytes. When you're copying a lot of files from one disk 
to another, glance at this information to be sure your 
selection isn't too large to fit on the target disk. 

" . 

Moving and Copying Files by Dragging Icons 
Although File Manager includes menu commands for moving and copying 
files, you might want to ignore them if you have a mouse. The simplest way 
to move and copy is simply to drag icons from one place to another. You 
can drag and drop one file at a time or in bunches, and you can drag from 
one directory to another on the same disk or between disks. 
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Remember these principles when dragging File Manager icons: 

e To move files, drag from one directory to another. To move files 
from one drive to another, hold down the Shift key as you drag. 
(Without the Shift key, File Manager interprets a drag between 
drives as a copy request, whether or not you hold down the Ctrl 
key.) 

e To copy files, hold down the Ctrl key as you drag. 

e The icon that File Manager displays while you drag is "document­
shaped" (it looks like a page with a dog-eared corner), regardless 
of the kind of file(s) you're dragging. 

e If your drag-and-drop operation is going to perform a copy, File 
Manager displays a plus sign in the drag icon. If it's going to 
perform a move, the plus sign is not displayed. 

e When moving or copying, it's safest to drop files onto directory 
icons. If you drop them onto an executable file's icon, File Manager 
thinks you want to run the executable file. (For more information, 
see "Using Drag and Drop to Launch a Document File," page 96.) 

e When you drop file icons onto a drive bar icon, File Manager copies 
the files into the current directory of the target drive. If you're not 
sure what that current directory is, it's a good idea to open a 
directory window and drop your files there-instead of dropping 
them onto the drive icon. 

e If you leave the Mouse Action confirmation setting on, File Manager 
will always tell you what you're about to do-so you needn't worry 
about misplacing files. (For more information, see "Confirmation 
Options," page 106.) 

Now let's look at a few examples. First, suppose your WINNT directory 
looks like the figure on the next page. 
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..... . ., • '·r~ 
Q file Qisk Iree Yiew .Qptions .liecurity Window Help l~ 
t !iii c: [OMNI1 FAT] l:!J~ ~1m:IXI~I~1 

\3a \3b lf23 cJ fi:]d !De !Elf f.i!I h '. !D i !Eli (E)k , 

- LJ mouse ~ ~ .. ~castle.bmp ~improv.ini ~qe.ini D system.bak ~winhelp.i 
- LJ ms·setup.t Clinibackp D cbkOS04.clp ~ leaves.bmp Dqeutil.dll ~ system.ini ~winlogo. 

l~12>'W 
Cllotustmp D cdplayer.bak Dlotus.bak Dqex.bak ~tada.wav ~winnt.brr 
Clmsapps ~ cdplayer.ini ~Iotus.ini ~qex.ini ~ tartan.bmp E:lwrite.exE 

~Ofu. Clsystem ~ chimes.wav D Itstools.bak Dqodbf.bak E:ltaskman.exe Dxlthreed. 
Cl prog Clsystem32 ~chitz.bmp ~Itstools.ini Dqodbf.dll ~thatch.bmp ~zigzag.b 
Clsam Lj default.pif ~chord.wav ~ marble. bmp ~qodbf.ini D vbrun100.dll 
LJ trans ' .. Dclock.bak D mplayer. bak D qpw.bak Ljvbsetup.exe 

Cl excel40a ~ 123r4.ini ~clock.ini ~ mplayer.ini ~qpw.ini Dviewer.bak 
Climprov ~ 256color.bmp D decomp.dll D msaccess.bak ~ readme. txt ~viewer.ini 
LJ qpw Dantsw.bak ~ding.wav ~ msaccess.ini ~ redbrick.bmp Dwin.bak 

- Cl tape "-; ~antsw.ini D dlodbc.bak Dmsafin.dll !':'lregedit.exe ~win.ini 
- Cltemp ..... ~ arcade.bmp ~ dlodbc. ini D msmail32.bak ~ regedit.hlp D win3270.cfg 
- Cltutor ~ arches. bmp ~egypt.bmp ~ msmail32.ini ~ rivets.bmp D winchat.bak 

Cl users ~ argyle.bmp D entpack.bak Ljnotepad.exe ~ sampbug.txt ~winchat.ini 
- Clvb D backup.bak ~ entpack.ini ~ passport.mid D saverdll.dll D winfile.bak 

~app' ~ backup. ini ~excel.xlb D progman.bak D schdpl32.bak ~ winfile.ini 
:twinnt ~ball.bmp D excel4.bak ~ progman.ini ~ schdpl32.ini D wingen.drv 
r- Cl inibackp ~ bugrep.txt ~ excel4.ini Ljqbasic.p~ Dsetup.log D winhelp.bak 
r- LJlotustmp ~ canyon. mid ~honey.bmp LjqbasicOO.pif ~ squares. bmp Ljwinhelp.exe 
I- Clmsapps 

~ 
~cars.bmp D improv.bak Dqe.bak D ssinterm.scr ~ winhelp.hlp 

I- LJ system 
'+1 J. L* +J.J " . : : ..... .:,' , .... ,'. , ...... ..... :: .. \'1'+ 

I':: ;l~ ,; : .' '.:", Jl1Toteill 0 iir",t"" (? m~AR\ :. ...•.. .'·.·:'W 

If you want to move the file 123R~.BAK to the INIBACKP subdirectory 
of C: \ WINNT, you can do so by dragging 123R4.BAK either to the INIBACKP 
icon in the tree pane or to the INIBACKP icon near the top of the directory 
pane. In either case, you will see the following prompt. 

Confirm Mouse Operation 

Are you sure you want to move the selected 
files or directories to C:\WINNl\INIBACKP? 

Click Yes to forge ahead or No to retreat. 

Now suppose you want to copy all files with the extension BAK to the 
root directory of your C drive. The surest way to proceed is to use the Select 
Files command to build a selection consisting of all files that meet the 
wildcard specification *.BAK. (For more information, see "Selecting Files 
with the Select Files Command," page 108.) Next hold down the Ctrl key 
while you grab anyone of the selected files with the mouse. Continue to 
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hold down the Ctr! key, drag the selection to the upward-arrow icon at the 
top of your directory pane, release the mouse button and Ctr! key, and then 
reply to the confirmation prompt. 

Because the current directory in this case is immediately subordinate 
to the root directory, there's an icon for the root in the directory pane. 
Dropping your selection there saves you the trouble of scrolling the root 
directory into view in the tree pane. If you were two levels below the root, 
however, you'd have to drag from the directory pane to the tree pane. (In 
this case, you might find it easier to use the File menu's Move command or 
its toolbar equivalent.) 

Note that you cannot copy the selection to the root directory by 
dropping it onto the C-drive icon at the top of the document window. If 
you do that, File Manager thinks you want to copy your files into the current 
directory of drive C, which also happens to be the source directory for your 
selection. Copying files into the same directory without giving those files 
new names generates an error message. 

Finally, suppose you want to copy all of your BMP files to the root 
directory of a floppy disk in drive A. First select * .BMP, following the Select 
Files procedure described earlier. Then be sure a disk is in drive A and drag 
your selection to the A-drive icon. You don't need to hold down Ctr! in this 
case (although you can), because File Manager treats all transfers between 
disks as copies, not moves. When you see the confirmation prompt, verify 
that the current directory on A is the root (it will be, unless you've recently 
been working in a subdirectory on that disk), and then click Yes. 

If the Target Disl{ Is Full 
If you try to copy 2 MB of files onto a 1.44-MB floppy disk, File Manager 
copies as many files as it can. Then it displays a message stating that the 
target disk is full. To continue copying the rest of the files, simply insert a 
fresh disk and click OK. 

If a File Already Exists on the Target Disk 
If you try to move or copy a file into a directory where a file of the same 
name already exists, File Manager presents a prompt similar to the following. 
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Confirm File Replace 

r]\. Replace File: I:\TOC.XLS 
~ 4119 bytes 4/13/931:0B:46PM 

With File: C:\WRITING\MSPRESS\RWNT\TOC\TOC.XLS? 
4119 bytes 417193 12:03:16PM 

Click Yes to proceed or Cancel to bail out. If you are copying or moving 
a multiple selection, you can also click Yes to All-in which case you won't 
see this prompt again. Or you can click Yes or No for each file that already 
exists on the target drive or directory. 

Note that this prompt does not appear if you deselect the File Replace 
option in the Confirmation dialog box. For more information, see "Confir­
mation Options," page 106. 

Moving and Copying Entire Directories 
You can move and copy entire directories in either of two ways-by select­
ing and dragging all files in a directory pane or by dragging a directory icon. 
If you select and drag all the files in a directory, File Manager simply moves 
or copies the files. If you drag a directory icon, File Manager creates a new 
subdirectory in the target directory. 

For example, suppose you want to store a backup copy of each file 
in C:\EXCEL\BUDGET in the root directory of the floppy disk in drive B. 
To do that, select everything in the directory pane for the BUDGET directory, 
and then drag to the B-drive icon. Now suppose instead that you want to 
create a directory named BUDGET on drive B and back up your budgeting 
files to that new directory. The simplest way to do this is to drag the directory 
icon for C:\EXCEL\BUDGET from the tree pane to the B-drive icon. File 
Manager responds by creating the directory B:\BUDGET and then copying 
all of C:\EXCEL\BUDGET's contents to this new directory. 

Moving and Copying with Menu Commands 
If you use Windows without a mouse, or if you simply prefer working with 
the keyboard, you can take advantage of two convenient keyboard shortcuts 
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for performing moves and copies. The F7 and F8 keys invoke the File menu's 
Move and Copy commands, respectively. With either command, you'll see 
a dialog box similar to the following. 

Move 

Current Directory: C:\ 

from: IAUTOEXEC.BAT 

10: 11:-01 __________ --J 

File Manager fills the top box with the current selection. Your job is 
to fill out the bottom box and click OK. 

If the current selection is a multiple selection, the Move or Copy dialog 
box lists each selected file, with a space between each filename. You can 
edit particular filenames out of this list (or add new names) if you wish. 

WINDOWS TIP: You can rename a file at the same time 
that you copy or move it. Simply use the File menu's Copy 
or Move command, and supply a new name in the To text 
box. 

Deleting Files and Directories 
To delete one or more files or directories, select what you want to delete, 
and then press the Del key (or choose the File menu's Delete command). 
Unless you have turned off the File Delete and Directory Delete options in 
the Confirmation dialog box, you'll be asked to confirm your intentions. 

Unlike MS-DOS, File Manager allows you to delete a directory that is 
not empty. When you do that, though, you'll get two or more confirmation 
prompts-one for the directory and another for each of the directory's files. 
You can bypass most of the file confirmations by clicking Yes to All. 

WARNING: Be careful with deletions if you turn confirmation 
prompts off! In particular, be aware that if you have deselected 
the File Delete and Directory Delete options in the Confirmation 
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dialog box and you delete a directory, everything in that 
directory-including all subdirectories and all files stored in all 

subdirectories-will automatically be expunged from your hard 
disk. If you're not comfortable with that level of automation, 
leave the Confirmation check boxes checked. 

Renaming Files and Directories 
To rename a file or directory, select its icon, choose the File menu's Rename 
command, and then complete the dialog box. 

WINDOWS TIP: With the help of "wildcard" characters, 
you can rename a group of files with a single command. 
For example, suppose you have a number of files with the 
extension NTS scattered about your hard disk. To make 
these files "launchable" in Notepad, you can associate the 
extension NTS with NOTEPAD.EXE. Or you can change 
all those NTS extensions to TXT. To do the latter, you can 
use File Manager's File Search command to put all the NTS 
files in a single window. Then select all files in that window 
and choose Rename from the File menu. On the To line 
of the Rename dialog box, specify * . TXT. 

Creating New Directories 
The File menu's Create Directory command creates a new subdirectory in 
whichever directory is currently selected. The easiest way to use this com­
mand is to start by selecting the new parent in the tree pane. For example, 
to create a new directory directly subordinate to the root directory, activate 
the tree pane and press Home to move to the root. Then choose the File 
menu's Create Directory command and fill out the dialog box. 
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Searching for Files 
The File menu includes a handy Search command that can help you locate 
files that have gone astray. You can search for a particular file or all files 
that match a wildcard specification, and you can search an entire disk, a 
particular branch of the directory tree, or a particular directory. 

The Search command is useful in the following situations: 

[J When you know you have a file somewhere on your hard disk, 
but you can't remember where 

[J When you think you have several versions of the same file scattered 
in different directories, and you need to figure out which is the 
most recent version 

When you choose the File menu's Search command, File Manager 
presents the following dialog box. 

Search 

.[earch For: I:=.=========================~I I~~lr(j~! 
Start from: IC:\WINDOWS Illjit~~1WJ 

!8J S~arch A" Subdirectories: 

1 ~~I··\,tij:1 ~\i:11!1~ p,.:}~t,; 

File Manager searches for all files meeting the specification in the top 
text box, beginning at the directory-tree branch specified in the lower text 
box. If you leave the check box selected, all subdirectories of the directory 
named in the lower text box will be included in the search. 

The Search command presents its results in a special window titled 
Search Results. The figure on the next page shows how a Search Results 
window might look if you asked File Manager to find all the DLL files on 
your C drive. Note that the status bar tells you how many files were found. 

If you need more information about the found files-their sizes and 
save dates, for example-you can take advantage of commands on the View 
menu. See "Customizing the Contents of Directory Panes," page 86. 
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c: \winnt\decomp. dll 14816 4/3/93 9: 56: 02pm 
c: \winnt\lotustmp\ ver .dll 9008 4/3/93 1:59:40pm 
c:\winnt\msafin. dll 39783 10/25/92 12:00:00am 
c:\winnt\msapps\grphflt\cgLgdi.dll 203792 8/8/91 5:48:28pm 
c:\winnt\msapps\grphflt\emwpg.dll 117664 10/15/91 11:48:38am 
c:\winnt\msapps\grphflt\imdrw.dll 78224 8/8/91 5:48:34pm 
c:\winnt\msapps\grphflt\imdxf.dll 85920 8/8/91 5:48:34pm 
c: \winnt\msapps\grphflt\imwmf. dll 69648 10/15/91 11:48:46am 
c: \winnt\msapps\grphflt\imwpg. dll 73296 8/8/91 5:48: 36pm 
c: \winnt\msapps\proof\msspell. dll 76800 4/1/92 12:00:00pm 
c:\winnt\msapps\wordart\fontfx.dll 42496 9/5/91 5:53:32pm 
c:\winnt\qeutil.dll 59312 9/30/92 2:35:00pm 

[) c:\winnt\qodbf.dll 166672 11/4/92 3:00:58pm 
[) c: \winnt\saverdll. dll 6656 5/13/91 12:11:48am 
[) c:\winnt\system\bwcc.dll 130064 9/15/92 1:00:00am 

c:\winnt\system\commdlg.dll 97984 2/6/93 11:45:36am 
c:\winnt\system\ctI3d.dll 13056 10/25/92 12:00:00am 
c:\winnt\system\ddeml.dll 36864 10/25/92 12:00:00am 
c:\winnt\system\ld.dll 175104 9/15/92 1:00:00am 
c:\winnt\system\mmsystem.dll 20992 2/19/93 1:14:48am 
c:\winnt\system \odapi. dll 740864 9/15/92 

You can use the filename entries in the Search Results window the 
same way you use filenames in a directory pane. For example, you can 
double-click a program name to start that program; select a group of files 
to be copied, moved, or, renamed; and so on. Unfortunately, you cannot 
sort the Search Results window by filename. File Manager insists on display­
ing the results in directory order. 

WINDOWS TIP: Unlike earlier versions of File Manager, 
the Windows NT version, while it is searching, shows you 
the number of instances of your search target as it finds 

._.them. You can click Cancel to stop the search at any time, 
and the Search Results window displays all the files located 
before you cancelled. Thus, if you're looking for a 
particular needle in a large hard-drive haystack, you don't 
have to wait until File Manager has combed through the 
whole haystack. You can click Cancel as soon as the 
"Matches Found'~ counter reads 1. 

... ............. .••••..•••.•••.•••.• . ·H .•. · , ............. . .... .... , 
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Changing File Attributes 
Attributes are markers that file systems employ to identify certain charac­
teristics of files. In the current versions of the MS-DOS (FAT) and Windows 
NT (NTFS) file systems, files can have any combination of the following 
attributes-or none of them: 

A Archive 

H Hidden 

R Read only 

S System 

The archive attribute indicates that a file has been modified since it 
was last backed up. Each time you create a new file or change an old one, 
the file system assigns the archive attribute to that file. Commercial backup 
programs (and Windows NT's own tape backup program) typically remove' 
the archive attribute when they back up a file. If you change the file after 
backing it up, the file again gets the archive attribute so your backup 
program can recognize it as needing to be backed up again. For more 
information about the archive attribute and its use in backup operations, 
see "Backup Methods," page 367. 

A few programs use the hidden and system attributes (either, but 
typically both) to mark important files that must not be modified or deleted. 
In the root directory of your boot. disk, for example, you might have hid­
den/system files named BOOT.INI, BOOTSECT.DOS, IO.SYS, MSDOS.SYS, 
NTDETECT.COM, and NTLDR. Some of these files are critical components 
of your operating environment; hence, they have both the hidden and 
system attributes. 

Hidden and system files do not appear in File Manager directory 
windows unless you choose the View menu's By File Type command and 
select the check box marked Show Hidden/System Files. 

You can load a file with the read-only attribute into a program, but 
you can't save it unless you first rename it. Programs that are designed for 
use on local area networks commonly employ the read-only attribute as a 
way of letting several people access the same file at once. With such pro­
grams, the first user to open a file typically gets both read and save privileges, 
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but subsequent users must access files in read-only fashion. As soon as the 
file has been opened by the first user, the program assigns it the read-only 
attribute. 

In many contexts, the read-only attribute not only prevents a file from 
being altered, but it also keeps it from being deleted. For example, the 
MS-DOS ERASE and DEL commands refuse to delete files that are marked 
read only. File Manager lets you delete read-only files, but only if you answer 
Yes in a confirmation dialog box. 

To change the attributes associated with one or more files, select the 
filenameCs) and choose the File menu's Properties command. Or hold down 
the AIt key while you double-click the filename. Then select the check box 
for each attribute you want to assign and click OK. 

Reading Version and Copyright Information 
The Properties dialog box might also include useful information about a 
file's version number and copyright. Here, for example, is the properties 
display for a file called COMCTL32.DLL: 

Properties for COMCTL32.DLL 

file Name: COMCTL32_DLL 
f.ath: C:\WINNT\SYSTEM32 
Last Change: 4/3/93 10:58:32AM 
Version: 3_10 
~opyright: Copyright @ Microsoft Corp_ 

Size: 65.536 bytes 

r- Attributes 

o Read Only 

[8J Archive 

o Hidden 

o fulstem 

I P":~~~OK~~~~?f:~:1 
IrT"'Ca;;cei'T';~1 

I r:;\?iHeJjl',:rT?1 

Irgpen uY31T?'1 

r-Version Information------------------, 

r.c~0;JmOOp,a~n~YN~ammme .... a," Custom Controls Library 
jI!1r.11t -
Internal Name 
Language 
Original Filename 
Product Name 
Product Version 

The fourth and fifth lines of this display tell you that this file came from 
Microsoft and is in revision.3.1. The list box at the bottom provides additional 
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details about the nature and purpose of the file. Software vendors can put 
whatever information they think is important in this lower section of the 
Properties dialog box. 

Formati~U1g, COpyh1Q, 
and LOJ[oeUng lDis~{s 

Commands on File Manager's Disk menu allow you to format, copy, and 
assign volume labels to disks. 

Formatting a Floppy Disl< 
To format a floppy disk, insert the disk, choose the Disk menu's Format 
Floppy command, and fill out the following dialog box. 

Q.isk In: 1 Drive B: lru 
hapacity:1 = 1:.4:4:t.t:B:::::lru:· . 

Options .--____ --, 
1.abel: ,-I ____ ---' 

o Quick Format 

I n~\;BrffKr;~~tl 
I ~"Can;;t;Fn~1 
I (T~¥H~lp\~';1 

First choose the drive containing the disk you want to format-if your 
system has more than one floppy disk drive. After you choose the drive, 
the Capacity drop-down list box shows the formatting options available for 
the specified drive. In the illustration above, for example, drive B is a 
1.44-MB, 3.5-inch drive, so the Capacity list box offers choices of 720 KB 
and 1.44 MB. 

NOTE: The Capacity options are determined by your disk drive, 
not the disk you put in the drive. If you choose a high-density 
formatting option for a double-density floppy disk, you might see 
an error message shortly after File Manager begins formatting. 
At this point, you'll have the option of replacing the disk with a 
high-density disk or switching to a double-density format. 
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If you choose a quick format, File Manager formats the disk but doesn't 
bother checking for bad sectors. 

Finally, you can assign a volume label to your floppy disk by filling 
out the Label text box. (If you decline this opportunity, you can assign a 
label later, using the Label Disk command.) 

NOTE: File Manager doesn't let you format a hard disk. To 
format a hard disk, you must open a command prompt window 
and use the Format command. For more information, see 
Chapter 19, "Working from the Command Prompt" page 627. 

Duplicating a Floppy DiSI{ 
The Disk menu's Copy Disk command allows you to make a duplicate of 
a floppy disk. Source and destination disks must be of the same size and 
density (for example, both 3.5-inch high-density or both 5.25-inch double­
density). This command is equivalent to the command prompt's DiskCopy 
command. 

Adding a Volume Label to 
a Hard Disl{ or Floppy DiSI{ 
The Disk menu's Label Disk command lets you assign a volume label, or 
name, to a hard disk or floppy disk. A volume label helps you keep track 
of what kind of information a disk contains. File Manager displays the 
volume label at the top of a disk's directory pane. 

Using fUe Manager to 
Cweo]~e P~ogwo]m ~~ems 

With the mouse, you can use File Manager to create program items in 
Program Manager. Here's how: 

1. Be sure that both Program Manager and File Manager are open and 
visible on your desktop. 

2. In File Manager, open a directory pane for the directory containing 
the program you want to add to Program Manager. 
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3. In Program Manager, be sure the program group to which you want 
to add the program item is open and visible. 

4. Drag the icon for your program's executable file from File Manager 
into Program Manager. 

That's all there is to it. Program Manager displays a new icon for the 
selected program. You can double-click that icort at any time to start your 
program. 

MOUSE TIP: If you drag an icon for an associated docu­
ment file from File Manager into Program Manager, you 
get a new program item that launches the document's asso-
ciated application and loads the document. 



Starting Co~trol Panel 
Control Panel presents a windowful of applets. 

Changing Desktop Colors or Patterns 
Beautify your desktop with custom color schemes. 

Adding and Deleting Fonts 
Fonts add impact to documents, but having too many on board can slow 
down your system. Use the Fonts applet to expand and contract your 
font library as needed. 

Configuring Serial Ports 
Set baud rate and other communications parameters with the Ports applet. 

Customizing Your Mouse or Other Pointing Device 
You can use the Mouse applet to swap primary and secondary mouse 
buttons. 
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Customizing Your Desldop 
The Desktop applet lets you add wallpaper, choose a screen saver, 
change icon spacing, and more. 

Adjusting the Keyboard Repeat Rate 
Slow it down or speed it up. 

Setting Country-Specific Options 
The International applet controls the way your system displays dates, 
times, and numbers. 

Changing Operating System Parameters 
You can use the System applet to change the default startup operating 
system, among other things. 

Setting the Date and Time 
If you move to a new time zone, you'll need the Date/Time applet. 

Using Alternative Mouse Pointers 
Check out the Windows NT animated cursors. 

Mapping Sound Files to System Events 
Put an end to Mac Envy. 

Installing Drivers 
Got a new sound board? Install its driver with the Driver applet. 

Modifying Private INI Files 
Some of your applications might store settings in private initialization 
files. 
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his chapter introduces Control Panel, the Windows utility that lets 
you tailor your systelll to suit your needs and tastes. You can use 

Control Panel to change the appearance of your electronic desktop, adjust 
the sensitivity of your mouse or the repeat rate of your keyboard, set your 
computer's clock and calendar, install printer drivers, configure serial ports, 
and do other similar tasks. 

Control Panel is organized as a set of "applets"-miniature applications 
designed to do specific tasks, such as changing the appearance of your 
desktop. 

NOTE: A few of Control Panel's applets are not discussed in this 
chapter. For information about the Printers applet-which 
actually invokes the Print Manager application-see Chapter 7, 
"Printing," page 211. For information about the Network applet, 
see "Changing Network Settings," page 210. For information 
about the Server applet, see "Monitoring System Use with 
Server," page 728. 

The changes that you make to your system using Control Panel are 
recorded in a system database called the registry. The registry stores much 
of the configuration information about your Windows NT system, including 
most of the information that previous versions of Windows recorded in 
various initialization files-WIN.lNI, SYSTEM.lNI, CONTROL.INI, PROG­
MAN.lNI, and so on. The registry consolidates this information into a single, 
secure location. 

On a Windows NT Advanced Server network, the registry facilitates 
centralized system administration. It also enables users with domain ac­
counts to log on anywhere within their domain and be greeted by their own 
personalized working environment. For more information about Windows 
NT Advanced Server, see "Two Levels of Networking Support," page 201, 
and "Servers and Domains," page 206. 

The registry also eliminates the need for private initialization files-INI 
files that store configuration information for individual applications. Pro­
grams written for Windows NT should store their configuration data in the 
appropriate sections of the registry. Applications written for earlier versions 

125 



126 

PAR T 1: Introducing Windows NT 

of Windows will probably continue to use their private INI files, however, 
so we'll conclude this chapter by looking at the way those INI files are 
structured and the general procedure for editing them. 

As shown in Table 4-1, some of the configuration decisions you make 
in Control Panel, such as your choice of wallpaper, affect only your own 
user account. Others-such as the date and time settings-affect everyone 
who logs on at your workstation. 

Choices of the latter kind are subject to security restrictions. Depending 
on how your account is set up, therefore, you might receive error messages 
when you try to make some of the changes described in this chapter. For 
information about account setup, see "Managing User Accounts," page 323. 

I~I 
Color * 

~ 
Fonts 

~ 

fi' 
Ports 

eJ 
Mouse* 

Desktop* 

"Changing Desktop Colors or Patterns," page 128 

"Adding and Deleting Fonts," page 138 

"Configuring Serial Ports," page 140 

"Customizing Your Mouse or Other Pointing Device," 
page 142 

"Customizing Your Desktop," page 144 

_ "Adjusting the Keyboard Repeat Rate," page 152 

Ke'yboard* 

Chapter 7, "Printing," page 211 

Printers 

TABLE 4-1. (continued) 

Control Panel applets. 
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TABLE 4-1. continued 

(i) 
International· 

Z 
System 

~ 
Date/Time 

Network 

Server 

Services 

Devices 

Cursors· 

JlC[ 
Sound· 

~ 
MIDI Mapper 

~~ 
Drivers -UPS 

"Setting Country-Specific Options," page 153 

"Changing Operating System Parameters," page 156, 
and "Initializing Environment Variables," page 657 

"Setting the Date and Time," page 161 

"Changing Network Settings," page 210 

"Monitoring System Use with Server," page 728 

"The At Command," page 612, "Starting and Stopping 
Services" and "Configuring Service Startup" in online 
help 

"Starting and Stopping Devices" and "Configuring 
Device Startup" in online help 

"Using Alternative Mouse Pointers," page 162 

"Mapping Sound Files to System Events," page 162 

"Creating a MIDI Setup" and "Selecting a MIDI Setup" 
in online help 

"Installing Drivers," page 163 

"Configuring the Uninterruptible Power Supply (UPS)" 
in online help 

* Changes that you make in these applets affect only your own user account. 

, 

: 
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Starting Control Panel 
To start Control Panel, double-click its icon in the Main program group of 
Program Manager. To start it from File Manager, double-click the name 
CONTROL.EXE in the directory window of the directory containing your 
Windows files. 

Control Panel offers a window full of icons. 

~--------------C-o-nt-ro-I-Pa-n-e-I-------------~ 

S.ettings Help 

I 4 ~ fj ~ III ~ rP 
Fonts Ports Mouse Desktop Keyboard Printers 

a ~ w & , ~ 
I nlernational System Dale/Time Network Server Services Devices 

~;g ~ Jl~ ~ ~ 
Cursors UPS Sound MIDI Mapper Drivers 

NOTE: Your own screen might not look exactly like this one. 
Because Control Panel is designed to be extensible, your screen 
might include icons for additional applets. Or some of the 
applets shown here might have been removed from your system. 

Each icon launches a particular Control Panel applet. If you work 
without a mouse, you can use the direction keys to move among icons, or 
you can ignore the icons and choose equivalent commands from the Settings 
menu. 

Changing Desktop Colors or Paiie~ns 
When you first install Windows NT, it uses a color scheme called Windows 
Default. It's a fine color scheme, but you can also choose from a number 
of alternative schemes. And if you don't like any of the color schemes 
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offered, you can design your own. You can assign a color (or a pattern, if 
you're working with a monochrome display) to each of 21 different screen 
elements, and then name and save the arrangement you create. You can 
design as many custom color schemes as you want, adding each to the 
menu of color schemes that Windows supplies. As mood or necessity dic;., 
tates, you can switch from one scheme to another by choosing from a simple 
drop-down list. 

Changes made in Control Panel's Color applet affect only the current 
user account. 

To change colors, double-click Control Panel's Color icon, or choose 
Color from the Settings menu. Windows presents the following dialog box. 

Color 

The illustration shows the Windows Default color scheme as you 
would see it in VGA resolution. If you're using a different display resolution, 
your screen will look different. Butthe basic elements will be the same. 
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Choosing from the List of Color Schemes 
To see what the built-in color schemes are called and what they look like, 
click the downward arrow near the upper right corner of the dialog box. 
The drop-down list unfolds, revealing the first four color-scheme options, 
as shown in the following illustratio~. 

Color 

Color .[chemes ----------, 

Now use the Down direction key to step through the list box. As you 
highlight the name of each color scheme, Windows displays a sample of 
that scheme in the lower part of the dialog box. You can apply any color 
scheme to your Windows environment by highlighting its name and clicking 
OK in the lower left corner of the window. 

Creating Your Own Color Scheme 
If you'd rather create your own color scheme, click Color Palette. Windows 
expands the dialog box. 
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Color £chernes------.. 

IWindows Default I'll 

IrSiyeS~'~'llrri'0~J:lVeSch;;mi;1 

File Edit 
Disabled 

Ip"'~' .~15OlotY~,~let\ft >'},'7" ,\. I 
Ip ;'oK.'?'1 I Fc;er: I Ir"Rftip:~,;1 

Color 
Screen [Iernen!: 

luma"" Iii 
!!.asic Colors: 

~[JCJDDL2lDD 
[iII D D CJ D rilliHlll1l D 
.DDC]aG.D 
.D •• r.z:J •• [5J •••••••• •••• IID.D 
!;.uslom Colors: 

DDDDDDDD 
DDDDDDDD 

Another drop-down list, called Screen Element, now appears on the 
right side of the dialog box with a set of color options below it. As the 
illustration above shows, you might see as many as 48 colors with a color 
display. With a monochrome display, you see 16 monochromatic patterns, 
ranging in density from pure black to pure white. 

Click the downward arrow to open the Screen Element drop-down 
list box. This list shows the names of the 21 screen elements to which you 
can assign colors. 

Color Schemes------.. 

IWind:Ws Defaull 

, ,Inactive ; 

File Edit 
Di~;abled 

1~~'lGo~1!'(~"7f~lt&~"9Yl);\il11{;01ltJtl 

Ir:;ii;{iKn(~1 l~r~~~'l 1~~lidP;!;TI 

Color 
Screen [Iemen!: 

Desktop 

o 
~D 

'-iiiiiiI~rr-"""""'"",,,"""""""""""'\IIiIID 

.D •• 81 •• D· 
•••••••• ••••• D.O 
!;.uslom Colors: 

ODDOODDD 
OODDDDDD 

Each screen element in this list is represented in the sample desktop 
on the left side of the dialog box. If you have a mouse, the simplest way to 
change the color of a screen element is to click the screen element in the 
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sample desktop. When you do this, the name of the screen element you 
click is selected in the drop-down list on the right side of the dialog box. 
With the screen element selected, click the color you want to assign. Then 
check the sample desktop to see if you're satisfied with the new color 
assignment. 

For example, suppose you want to change the active title bar so that 
it shows yellow text on a solid red background. Click in the title bar labeled 
Active (anywhere except directly on the word Active), and then click the 
first sample in the second row of the Basic Colors palette. That assigns the 
solid red color to the active title bar. Next click the word Active, and then 
click the second color in the second row. . 

MOUSE TIP: Successive clicks on the OK button in the 
sample desktop cycle the screen-element selection from 
Button Face through Button Shadow, Button Text, and 
Button Highlight. Similarly, clicking the word Highlighted 
in the sample desktop toggles the selection between 
Highlight and Highlighted Text. To see which element 
you've selected, check the drop-down list on the right side 
of the dialog box. 

If you don't have a mouse, here's how you can change screen colors: 

1 . If the Screen Element list box isn't highlighted, press Alt+ E to 
highlight it. 

2. Use the direction keys to highlight the name of the screen element 
you want to change. 

3. Press Tab to get to the color palette. 

4. Use the direction keys to move from color to color in the palette. 

5. When you get to a color that you want to assign, press Spacebar to 
select it. 

6. Press Shift+ Tab to move back to the list box. 
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7. Repeat steps 2 through 6 until you've assigned all the colors you 
want to assign. 

8. Press Enter to return to Control Panel, or follow the instructions 
below for naming and saving your new color scheme. 

Feel free to experiment with color combinations. The built-in color 
schemes always look the same, no matter what changes you make in Control 
Panel. If you turn your Windows desktop into something gruesome, you 
can always restore order by reinstating one of the built-in color schemes. 

WINDOWS TIP: It's possible to make your menus invis­
ible by setting Menu Text and Menu Bar to the same color. 
If you make this mistake, here's one way to recover: If 
Control Panel is still running, press AIt+Tab until it 
becomes the current application. (If Control Panel isn't 
running, press AIt+ Tab until Program Manager is the active 
application. Then press AIt, F, R to choose the Run 
command. Type control and press Enter to get to Control 
Panel.) Then press AIt, S, C to choose the Colors command 
on the Settings menu. When the Colors dialog box 
appears, reinstate one of the built-in color schemes. 

A Few Limitations 
Here are some additional points to note about setting colors in Control 
Panel: 

c Some applications set their own colors, overriding the choices you 
make in Color Panel. Solitaire and FreeCell, for example, use a "Las 
Vegas" green background, no matter what selection you make for 
the Application Workspace screen element. 

c You cannot assign a new color to the text that Windows uses to 
label minimized icons. Windows uses either black or white for this 
text, depending on the color of your desktop. 
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13 Some of Control Panel's colors are dithered (blended from two or 
more solid colors). If you assign a dithered color to any text 
element, Windows substitutes a solid color of its choice. 

WINDOWS TIP: If you switch from a 256-color display 
driver to a 16-color driver-or vice versa-you might find 
that some of your color choices look quite different. This 
is particularly likely 'to happen when dithered colors are 
assigned to text elements. A color scheme that looks fine 
in one resolution might not look good in another. The 
simplest way to deal with this phenomenon is to name 
your color schemes and switch to a different one when 
you change resolutions. 

Saving a Color Scheme 
When you assign new colors and press Enter or click OK, Windows records 
your selections as an unnamed color scheme (the information is registered 
in the Color Schemes section of the registry). Do not be concerned if the 
Color Schemes list box still displays the name of a built-in scheme when 
you click OK. The next time you return to this dialog box, the Color Schemes 
entry will be blank (indicating that you're using an unnamed color scheme), 
and the built-in scheme that was there when you saved will still be intact. 

If you hit upon a tolar scheme that pleases your eye, it's best to name 
it before you save it. That way, you'll be able to switch back and forth 
between your own color scheme and one of those supplied by Windows­
or between several of your own making. 

To save a named color scheme, simply click the Save Scheme button 
and supply a name. Windows adds the name to the bottom of the Color 
Schemes list box. 

If you tire of your named color scheme, you can easily remove it. 
Simply select its name, and then click the Remove Scheme button. 
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Customizing the Color Palette 
Windows lets you add up to 16 custom colors-colors that you define 
yourself by mixing red, green, and blue elements-to the 16 gray shades or 
48 colors of the basic palette. 

To define a custom color, start by clicking the Define Custom Colors 
button. Windows opens the Custom Color Selector. 

II Custom Color Selector 

If you have a mouse, you can specify a custom color by dragging the 
selection pointers for the two color scales-the big square one and the 
vertical bar. If you don't have a mouse, you can enter numbers for either 
or both of the two scales in the boxes at the lower right corner of the Custom 
Color Selector. 

To set a custom color with the mouse, you adjust the position of two 
pointers-the cross-hair in the big square grid and the arrowhead to the 
right of the vertical scale. For every possible position of those pointers, 
Windows displays a sample of the selected color in the two boxes at the 
lower left corner of the Color Selector. 

Why two sample boxes? Because your system isn't capable of display­
ing every possible combination of the three color parameters. (For more 
information about color parameters, see "How Colors are Defined," below.) 
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Windows uses dithering to approximate the colors that your system can't 
display directly. The sample box on the left (the one marked Color) displays 
the dithered color; the one on the right (marked Solid) displays a closely 
related color that your system can display without dithering. 

How Colors Are Defined 

Colors in Windows NT are recorded as a combination of three 
parameters: hue, saturation, and luminosity. Roughly speaking, . 
the basic quality of a color-its redness, blueness, or whatever­
is defined by its hue. The purity of a color is defined by its 
saturation; a lower saturation value means more gray is mixed 
in. The brightness or dullness of a color is defined 1?y its 
luminosity. 

Hue, saturation, and luminosity are the parameters that 
Windows uses internally, but your video display hardware lives 
by a different set of numbers. Images on a color monitor are 
formed by a combination of dots, or pixels. (A pixel is the smallest 
dot that can be displayed on your screen.) To make each pixel 
visible, a beam of electrons is fired, at three tiny spots of 
phosphor-one red, one green, and one blue. The result is three 
points of distinctly colored light so close together that they're 
perceived as a single light source'. The apparent color of that light 
source is determined by the relative intensities of its red, green, 
and blue components. 

Every combination of hue, saturation, and luminosity, 
therefore, is translated by Windows into varying levels of energy 
directed at those spots of red, green, and blue phosphor. 

Thus there are two boxes in the lower right corner of the 
Custom Color Selector-one for the parameters used by 
Windows, the other for the relative red, green, and blue 
intensities. You can define a custom color by modifying the 
numbers in either box. 
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Experimenting with Color 
The vertical scale on the right controls luminosity (brightness). As you move 
its pointer higher, the color becomes lighter. Putting the pointer at the top 
of the scale creates pure white, no matter where the cross-hair pointer may 
be in the grid; putting the pointer at the bottom of the luminosity scale 
produces jet black. 

The square grid controls hue and saturation. Moving the cross-hair 
from side to side changes the hue; moving it higher increases the saturati.on. 

To see the range ot "pure" colors available, start by putting the lumi­
nosity pointer about halfway up the vertical scale. Then put the cross-hair 
at the upper left corner of the square grid. This combination gives you a 
fully saturated. red of medium luminosity. Now slowly drag the cross-hair 
across the top of the grid; as you do so, you'll move from red through 
yellow, green, blue, violet, and back to red again. (Alternatively, you can 
click the upward arrow in the Hue box to step the Hue parameter from 0 
to 239.) 

To see the effect of luminosity on color, double-click the Solid sample 
box or press Alt+O. This moves the cross-hair to the nearest position where 
you see a pure color in both sample boxes. Then move the luminosity 
pointer up and down the scale (or click the arrows in the Lum box). 

To see the effect of saturation, put the luminosity pointer back in the 
middle of the scale and drag the cross-hair straight up and down in the 
square grid (or click the arrows next to the Sat box). 

Adding Custom Colors to Your Palette 
When you find a color you like, you can add it to your Custom Color palette 
by clicking Add Color. (If you prefer to add the solid color, double-click 
the solid box or press Alt+O first.) Windows adds the color to the first 
available Custom Color box. If you want to add it to a specific box in your 
custom palette (for example, if you want to replace a custom color), select 
that box with the mouse before clicking Add Color. 

When you've filled out the custom palette to your satisfaction, click 
Close. Now you can assign your custom colors to the screen elements exactly 
as you did the basic colors. 
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Adding and Deleting Fonts 
The Fonts applet provides you with a way to look at samples of all fonts 
installed in your Windows system. Changes made in Control Panel's Fonts 
applet affect all user accounts on the current workstation. 

When you run Control Panel and double-click the Fonts icon, you see 
a display similar to this: 

Fonts 

Installed fonts: 
rial (T rue Tv e 1 

aBbCcXxYyZz123 

This is a scalable TrueType font which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 74 KB 

In the upper part of this dialog box, you'll see a list of all your installed 
fonts. Note that this list includes only those fonts that Windows can display 
on screen. Fonts that are built into your printer (such as the Lineprinter font 
on a Hewlett-Packard Laser]et) do not appear on the list unless you have 
also installed equivalent screen fonts. 

As you select each name in the installed-font list, Windows displays a 
sample in the lower part of the dialog box. With TrueType and stroke fonts, 
you see only one point size; with bit-mapped fonts, you see a sample of 
each size available on your system. The bit-mapped fonts are identified in 
the font list by the available point sizes and the resolution of your display 
driver; in the figure above, for example, "Courier 10,12,15 (VGA res)" de­
notes a bit-mapped font in VGA resolution, available in point sizes of 10, 
12, and 15. 
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For more information about fonts, font terminology, and the types of 
fonts you can use with Windows NT, see "Working with Fonts," page 40. 

Adding Fonts 
You can also use the Fonts section of Control Panel to install new fonts. 
You might not need to do this with commercial font packages, because such 
packages typically include their own installation routines. With public­
domain or shareware fonts, or other fonts that don't include installation 
programs, you can invoke Control Panel's Fonts section and select the Add 
button. You can also use this command to restore native Windows fonts 
that you previously deleted. 

The Font applet's Add button displays a dialog box like this: 

Add Fonts 

list of fonts: 
Arial Narrow (TrueType) 
Arial Narrow Bold (TrueType) 
Arial Narrow Bold Italic (TrueType) 
Arial Narrow Italic (TrueType) 
Book Antiqua (TrueType) 
Book Antiqua Bold (TrueType) 
Book Antiqua Bold Italic (TrueType) 
Book Anti ua Italic TrueT e 

Q.irectories: 
g: \ttfonts\fontpak 1 Driyes: 

I Gi3 g: \\acadia\programlI!) (2J g:\ 
(2J ttfonls 

I PI?iOK1,/S7~?~1 
I r~'~'~CancQr::~~q 

IH,SelecTAlr,:.:1 
I r=:;7~Jlerp7\fr·1 
I f7N;tioJk:~?JJ;1 

I+: (g] kOPY Fonts to Windows Directory 
~---------------

Select the directory that contains your font files. Then select one or 
more files in the Fonts list and click OK. (Or, if you want to install all the 
fonts in the selected directory, click Select All and then click OK.) 

These steps copy the selected font files to the SYSTEM32 subdirectory 
of your WINNT directory and make the appropriate modifications to the 
registry. If you do not have enough space on your hard disk to store the 
selected font files, you can skip the file-copying part of this process by 
deselecting the Copy Fonts to Windows Directory option. Windows then 
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retrieves font information from your source directory (presumably a network 
drive) as needed. You must, of course, ensure that the specified directory 
is always available. 

Deleting Fonts 
If you're running low on disk space, or if you find you never use certain 
fonts, you can take advantage of the Font applet's Remove button. When 
you select a font name and click this button, Windows modifies the registry 
to make the selected font unavailable. The font file itself is not deleted from 
your hard disk unless you check the Delete Font File from Disk check box. 

NOTE: Windows uses MS Sans Serif for many of its dialog boxes. 

Therefore, you should not delete this font, even if you never use it 

in your applications. 

The technique just described can be used to delete only the fonts that 
are actually installed in your Windows system. Fonts that are generated by 
a font-management application, such as Adobe Type Manager, do not ap­
pear in Control Panel's font listing. To remove such fonts from your hard 
disk, consult the documentation that came with your font-management 
software. 

Configuring Serial Ports 
To configure a serial port means to tell Windows how you want information 
transferred through the port to your peripheral device. Windows NT sup­
ports up to 256 serial ports, named COMl through COM256. For each port, 
you can set five basic communications parameters: 

I'l Baud rate 

a Data bits 

D Parity 

11 Stop bits 

III Flow control 

Changes that you make in Control Panel's Ports applet affect all user 
accounts on the current workstation. 
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Baud rate refers to the speed at which data flows through the port. 
Baud rate is also sometimes expressed as bits per second (bps). 

Data bits and stop bits refer to the way in which characters are "framed" 
as they're sent through the serial port. A character consists of data bits 
(usually seven or eight), which are sent one at a time (serially). Stop bits 
mark the beginning and end of each character. 

Parity is a form of error checking employed by certain peripheral 
devices. If used, it comes in four "flavors": even, odd, mark, and space. 

Flow control refers to the way your computer and the external device 
let each other know they're ready (or not ready) to communicate. Flow 
control is also often referred to as handshaking. 

To set basic communications parameters for a serial port, double-click 
the Ports icon in Control Panel or pull down the Settings menu and choose 
Ports. Windows displays the following dialog box. 

EOIts: 
'COM1: ' . 
COM2: 

Ports 

Ir~cancer:~1 

!+ Iri;uing;:~'1 

l,. 
1[:~Ad~EI::~'1 
I n~~'iIeipf:i21 

Select the name of the port you want to configure, and then click 
Settings (or press Alt+S). Windows presents the Settings dialog box for the 
selected port, as shown below. 

!l.aud Rate: 

D,ata Bits: 

Earity: 

litop Bits: 

[low Control: 

Settings for COM1: 

lem I 

10 

INone 

11 
INone 

m 
100 
100 
100 

100 

IfA(jy~~~TII 

1'~l:t:UilmtlllJI 
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To determine the proper settings for your serial ports, consult the 
documentation for the devices you're using. 

The Advanced ~utton in the Settings dialog box produces an additional 
dialog box that you can use to change a serial port's base address or interrupt 
(IRQ). You won't ordinarily need to do this, however, and you shouldn't 
change either setting unless you know what you're doing. 

WINDOWS TIP: The communications settings you assign 
with Control Panel become the defaults for your serial 
ports. You can override these defaults temporarily with 
communications programs such as Terminal. Thus, if you 
use your modem to communicate with several different 
services, each requiring different parameters, you don't 
have to return to Control Panel each time you switch 
services. For more information about changing these 
settings in Terminal, see ."Communications Parameters," 
page 451. 

Customizing Your Mouse 
or Other Pointing Device 

Control Panel's Mouse applet lets you tailor the behavior of your mouse or 
other pointing device to suit your personal tastes. The options available 
depend on what kind of device you're using, but for most pointing devices 
you can adjust the tracking and double-click speeds, and you can swap the 
functionality of the left and right mouse buttons. You might find it handy 
to swap mouse button functions if you're left-handed, so you can put the 
mouse on the left side of your keyboard and still use your index finger for 
most mouse commands. 

Changes made in Control Panel's Mouse applet affect only the current 
user account. 
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To make mouse adjustments, double-click Control Panel's Mouse icon 
or pull down the Settings menu and choose Mouse. If you're using a Mi­
crosoft Mouse, you'll see a dialog box similar to this: 

Mouse 

,Mouse Tracking Speed 
Slow Fast 

1:+1 III r+1 

.Q.ouble Click Speed 
Slow Fast 

P.I 10 1 .. 1 
TEST 

I r"-:oiC'-'"I 
IrCan'Cer~1 

I Flleip""'-I 

o ~wap Left/Right Buttons 

The term tracking speed refers to the relationship between movement 
of the mouse on your desktop and movement of the pointer on screen. With 
a faster tracking speed, it takes less mouse movement to move the pointer. 

If you often find your mouse pointer overshooting its target as you 
select commands or objects in Windows, you'll probably find it helpful to 
decrease the tracking speed. On the other hand, if you find yourself "row­
ing"-picking up the mouse, bringing it back through the air, and then 
sliding it over the desktop again merely to get the pointer from one side of 
the screen to the other-try increasing the tracking speed. 

To decrease the tracking speed, click the arrow on the left side of the 
Mouse Tracking Speed scroll bar. To increase it, click the arrow on the right 
side. Alternatively, you can drag the box in either direction in the scroll bar. 

MOUSE TIP: Windows gives you immediate feedback 
about changes you make to the mouse tracking speed. 
That way you can tell whether you've made the right 
adjustment before you click OK to return to Control Panel. 
If you regret a change you make, you can click the Cancel 
button to restore your former setting. 
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The double-click speed specifies the time interval within which two 
mouse clicks are interpreted as a double-click. You can adjust this parameter 
the same way you adjust tracking speed-by clicking the arrow at either 
end of the Double Click Speed scroll bar or by dragging the box within the 
scroll bar. 

To test the double-click speed you set, try double-clicking the box 
labeled TEST. If your two clicks are read as a double-click, the box changes 
from light to dark or from dark to light. 

To swap the functionality of your mouse buttons, check the Swap 
Left/Right Buttons check box. Windows confirms the change by reversing 
the letters Land R in the diagram above the check box. 

Note that if you swap the button functions and then change your mind, 
you must click the check box with the right mouse button to undo the swap. 

Customizing Your Desktop 
The desktop is the background area of your Windows screen that lies outside 
any window or icon. Control Panel's Desktop section has a number of 
options that affect the appearance and behavior of your desktop. 

c The Pattern option lets you cover your desktop with a repeating 
dot pattern-one you create yourself or one that Windows sup­
plies. Doing this is somewhat like throwing a tweed tablecloth over 
your screen; just the ticket, perhaps, if you get bored with solid 

. colors or grays. 

c For a more pictorial backdrop, you can add "wallpaper" to your 
desktop. The wallpaper can be a small image repeated as many 

. tirries as necessary to fill the screen (in the manner of true 
wallpaper), a single image centered on the desktop, or a Single 
image that covers the entire screen. 

c To protect your screen while your machine is idle, you can install 
a screen saver. Windows supplies several screen savers to choose 
from. If you've installed a third-party screen saver on your system, . 
you might be able to use Control Panel to switch between the 
built-in savers and your third-party saver. 
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IJ A check box in the Desktop dialog box lets you specify whether 
you want long icon labels to be displayed on two or more lines. 
(This option is normally turned on.) 

IJ The Granularity option lets you control the positions of objects on 
your desktop by activating an invisible set of grid lines. With grid 
lines active, windows automatically align on the nearest grid line. 

Also included in the Desktop applet are commands for increasing or 
decreasing the cursor-blink speed, for setting the width of your icons, and 
for adjusting the thickness of window borders. 

Changes made in Control Panel's Desktop applet affect only the cur­
rent user account. 

To customize your desktop, double':'click Control Panel's Desktop icon, 
or pull down the Settings menu and choose Desktop. The following dialog 
box appears. 

Desktop 

PaUem----------, 

Rame:li_ [!) 
I l'EdiH!attern::';' 

Applications 

[8] Fast "Alt+Tab" Switching 

Wallpaper-----, 

file: IWinnl.bmp II:!) 

@ ,C,enter 0 lile 

Sizing Grid----' 

,!iranularity: Elt 
I!.order Width: [:=HI 

H"'~'ol(:' 'I 
I Franee) , I 
III :Heip:'~n 

Setting a Background Pattern 
To apply a background pattern to your desktop, click the downward arrow 
in the Pattern box, select one of the patterns listed, and click OK. If you 
want to look at the available patterns without applying any of them, click 
Edit Pattern. When the Edit Pattern dialog box appears, press the Down 

145 



146 

PAR T 1: Introducing Windows N~ 

direction key to step through the list and see a sample of each pattern. The 
following illustration, for example, shows what the Thatches pattern looks 
like. 

Desktop - Edit Pattern 

Harne 

I rt.m:.)A;.J(J~,:.·.1 ,:{\~".QU, .,,,,.,;,,,' 

I[~¥I 
Iml~~~ 

If you find a pattern to'your taste, you can apply it to the desktop by 
clicking OK in the Edit Pattern dialog box, and again in the Desktop dia­
log box. 

Editing a Background Pattern 
The big square in the center of the Edit Pattern dialog box represents the 
"cell" from which the selected background pattern is made. The cell is an 
eight-by-eight grid of dots; each dot is either dark or light. You can edit the 
background pattern by changing one or more dots from light to dark or 
dark to light. To do that, click the mouse on whichever dots you want to 
change. (There is no keyboard equivalent for this procedure.) 

As you make changes to the dot pattern in the cell, you can see the 
effect of those changes in the Sample box on the left. When you're satisfied 
with your editing, click Change to save the revised pattern. Then click OK 
to select it. 

Adding a New Background Pattern 
The easiest way to create a new background pattern is to edit an existing 
one (as explained above) and give it a new name by replacing the text in 
the Name text box (in the Edit Pattern dialog box). Windows grays out the 
Change button and activates the Add button. Click Add, and your new 
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pattern joins the list of existing patterns. You can then apply it to your 
desktop by clicking OK in the Edit Pattern dialog box and again in the 
Desktop dialog box. 

Changing the Behavior of Alt+ Tab 
Ordinarily, when you switch between Windows programs by pressing 
Alt+Tab, Windows displays a box in the center of your screen that shows 
the name and icon of the program you're about to switch to. This method 
of telling you where you're going is called "Fast 'Alt+Tab' Switching." If you 
prefer, Windows can display the window borders and title bar of each 
program as you press Alt+Tab. 

Most users find navigating between programs a lot easier with fast 
Alt+Tabbing. But if you prefer the alternative style, open Control Panel's 
Desktop applet and deselect the Fast "Alt+Tab" Switching check box. 

Choosing a Screen Saver 
Cathode-ray-tube (CRn displays used by desktop computers create images 
by firing electron beams at phosphor-coated screens. If the same picture or 
text remains on a screen for a long period of time, the phosphor coating 
can be damaged, leaving a faint but permanent image on the screen. Screen 
savers· reduce this hazard by monitoring screen activity. Whenever your 
screen remains unchanged for a specified length of time, the screen saver 
puts its own constantly varying image on the screen. As soon as you press 
a key or (with most savers) move the mouse, the screen saver restores the 
original image. 

That's the ostensible purpose of a screen saver, at any rate. In truth, 
with current display technology, the probability that you'll ruin your CRT 
with a burned-in image is pretty remote. But screen savers have other vir­
tues, as well. They're fun to watch, and they're one way to prevent others 
in your office from prying while you're away from your machine. Many 
screen savers have "save now" and password options. The save-now option 
lets you display the saver pattern on demand, either by pressing a certain 
keyboard combination or by moving the mouse to a particular corner of 
the screen. The password option ensures that only you are able to restore 
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the ariginal image. If yaur screen saver has these features, yau can display 
the saver image any time yau walk away from yaur camputer and be 
reasanably canfident that no. ane will invade yaur privacy in yaur absence. 

WINDOWS TIP: Anather way to. prevent snaaping is to. 
press Ctrl+Alt+Del and then lack yaur warkstatian. See 
"Lacking, Lagging Off, and Shutting Dawn," page 7. 

Using Cantral Panel's Desktap applet, yau can chaase fram several 
screen savers supplied with Windaws. If yau use a third-party screen-saver 
pragram, yau might find its chaices in the Screen Saver drap-dawn list, 
alangside the Windaws-supplied chaices. 

The default screen saver is Nane. The Name list also. includes a chaice 
called Default Screen Saver, which simply blanks the screen with no. pattern 
displayed. 

Belaw the screen-saver name list, yau'll find a setting called Delay. 
This specifies the length af idle time the saver will wait befare gaing into. 
actian. Yau can increase ar decrease this amaunt by clicking the arraws ar 

. typing in a new number. 

To. the right af the Name list and the Delay time, yau'll find cammand 
buttans labeled Test and Setup. The Test buttan lets yau see the appearance 
af a saver withaut cammitting to. it. The Setup buttan lets yau assign aptians 
specific to. the current saver. These aptians can significantly vary the ap­
pearance af a saver. Far example, the Marquee Display saver displays a 
maving line af text an yaur screen. Its Setup aptians allaw yau to. specify 
the fant, calar, speed, pasitian, and cantent af the text. 

Marquee Setup 
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WINDOWS TIP: Do not assign a screen saver in Control 
Panel if a third-party screen saver is already running. 

Wallpapering Your Desl(top 
If you want to drape your desktop with something livelier than a simple dot 
pattern, try the wallpaper option. This option lets you display a picture as 
a backdrop to everything you do in Windows. 

To try out the various wallpaper selections at your disposal, open the 
Control Panel's Desktop applet, and then click the downward arrow in the 
Wallpaper box. In the list box that unfolds, you'll find the name of every 
file in your WINNT directory that has the extension BMF. To wallpaper your 
desktop, select a filename and click OK. To remove the wallpaper, follow 
the same procedure, but select (None) from the drop-down list. 

WINDOWS TIP: The File drop-dowri list shows only the 
BMP files in your WINNT directory, but you can specify 
any RLE or BMP file in any directory (local or remote) by 
typing the drive, directory, and filename in the Wallpaper 
File box. 

Some wallpaper files produce a single image that covers your entire 
desktop. Others produce smaller images that can either be displayed once­
typically in the center of the desktop-or repeated as many times as nec­
essary to fill the screen. If you want the image to appear only once, select 
the Center option button; otherwise, select Tile .. 

Using Wallpaper to Customize Your Desktop 
You can personalize the appearance of your Windows system by designing 
your own custom wallpaper. Any image recorded in the Windows bitmap 
(BMP) format can serve as a backdrop for your desktop. Store the file in 
your WINNT directory and its name will appear in the Wallpaper list box. 
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WINDOWS TIP: You can create BMP files using drawing 
commands in Paintbrush. For information about Paint­
brush, see Chapter 16; "Using Paintbrush," page 473. 

You can also use a scanner to produce images such as photographs. 
and company logos, provided your scanner software can save the image as 
a BMP file. 

WINDOWS TIP: Many 'public bulletin-board systems 
(BBS's) have wallpaper images that you can download. 
The WINSHARE forum on CompuServe is a particularly 
good place to find public-domain wallpaper files. 

Wallpaper and Display Resolution 
A bit-mapped image, such as a BMP file, specifies the relative position of 
each pixel in the image. A BMP file that fills a standard 640x480 VGA screen 
specifies 307,200 (640 multiplied by 480) pixels. Such an image will not fill 
a higher~resolution screen, such as an 800x600 or 1024x768 Super VGA. 
Instead, the image appears smaller and is centered on the display. Con­
versely, an image designed to fill an 800x600 or 1024x768 display overflows 
a standard VGA screen. The upper left corner of the image appears in the 
upper left corner of your screen, but areas on the right and at the lower 
edges of the image are not displayed at all. 

It's a good idea to check the resolution of an image before download­
ing it from a bulletin-board service. The resolution is usually provided as 
part of the description of the image. 
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Controlling the Appearance 
of Icons and Their Labels 
By default, Windows NT wraps long icon labels-the text beneath icons in 
Program Manager and on the desktop-onto two or more lines. If you'd 
rather have your labels all on one line, open Control Panel's Desktop applet 
and deselect the Wrap Title check box. 

If you find that your program-item icons are crowded together too 
tightly in Program Manager's windows, you might want to increase the 
number in the Icon Spacing box. The icon-spacing value specifies the width 
of each icon, and determines how closely together icons are positioned at 
the bottom of your desktop when you minimize windows or use Task List's 
Arrange Icons command. 

The Icon Spacing value sets the icon width in pixels. (The width of 
the pixel depends on your screen's resolution; the higher the resolution, the 
smaller the pixel.) The largest value allowed is 512; the smallest depends 
on screen resolution. On a VGA screen, the minimum is 32 pixels. At this 
setting, your icons will stand shoulder-to-shoulder. 

Turning on the Size-and-Position Grid 
The Granularity value in the Sizing Grid section of the Desktop dialog box 
controls the spacing of an invisible set of grid lines on your desktop. These 
grid lines help you control the position and alignment of windows (but not 
icons) on your desktop. With Sizing Grid turned on, a window automatically 
snaps into place along· the nearest horizontal and vertical grid lines when­
ever you size or move the window. 

You can set the granularity to any number from 0 through 49. Setting 
it to 0 turns the grid off. A higher granularity value creates a coarser grid 
with fewer available positions for windows. You can see how this works by 
setting the granularity to 25 and clicking OK. After you do that, try clicking 
the mouse on Control Panel's title bar and dragging Control Panel around 
the desktop. On a standard VGA screen with the granularity set at 25, only 
six possible positions exist for the Control Panel window. 

Unless you're using a high-resolution display or you have a special 
need for a coarse grid, you'll probably want to keep the granularity set 
somewhere between 0 and 5. 
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Setting Border Width 
The Border Width option in the Sizing Grid section of the Desktop dialog 
box allows you to increase or decrease the thickness of the borders of all 
sizable windows. (A few programs, such as the game Minesweeper, appear 
in windows of fixed size that also have fixed-width window borders.) 

Thicker borders can make it a little easier to size windows with the 
mouse. On the other hand, they waste screen space. You can set the border 
width from an anorexic 1 through an obese 50. 

Setting the Cursor Blinl< Rate 
If the rate at which the Windows cursor blinks seems too fast or too slow 
for your taste, open Control Panel's Desktop applet and experiment with 
the Cursor Blink Rate scroll bar. The vertical line that appears next to this 
scroll bar shows the cursor blink rate before you make any changes. When 
you make changes with the scroll bar, the blinking line shows the new 
cursor blink rate. 

Adjusting the ~(eyboo]rd Repeat Rate 
Control Panel's Keyboard applet allows you to modify the "typematic" be­
havior of your keyboard. When you double-click the Keyboard icon, Control 
Panel presents this dialog box: 

Keyboard 

~:ra~o:~~o~:~~!-t R-e-pe-a-t ----.IJ\~11lKfBc~1(1 
Long Short 
Il;I,,\\ti\~~y,z1~~\;~l:~~}11\11;~~I., *t~~;\~\~~llt;1 

Repeat Rate 
Slow Fast 
11+ Il$~\;J1~\3h~'1~~Y~lt~lr\~tt;\li'lt¥ il;}Z~\\\l~lW£!lJ 

lest: 

Whenever you hold down the key for a character, Windows waits for 
a moment, and then begins repeating the character. The upper scroll bar in 



Chapter 4: Customizing Windows NT with Control Panel 

this dialog. box lets you change the length of time Windows waits before 
repeating. The lower scroll bar lets you change the repeat speed. 

To test a new setting before clicking OK, tab to the Test line, and then 
hold down any alphabetic or numeric key. The character you press will 
appear in the Test box, so you can judge whether the delay and repeat rate 
are satisfactory. 

Changes made in Control Panel's Keyboard applet affect only the 
current user account. 

Seiiing COQJD1~ry-S~oecif~c Opiions 
Control Panel's International applet lets you tailor your system for use in 
different countries. The International applet allows you to choose which 
currency symbol you want to use (and whether it appears in front of or 
behind numbers), the date and time format, which measurement system to 
use, and so on. 

Changes made in the International applet affect only the current user 
account. 

If you work in the United States, Windows is probably already set up 
with the country-specific settings that you need. Even so, you might find 
this section of Control Panel useful if you travel with your computer or if 
you need to correspond with overseas business associates. Most Windows­
based applications automatically base their display of dates, times, and 
currency symbols on the settings in the Control Panel's International applet. 

. , 

WINDOWS TIP: If a Windows-based application does 
not seem to be conforming to your current international 
settings, it's probably because you started that application 
before making your changes in Control Panel. Try closing 
and restarting the application . 

To change Windows' international settings, double-click Control 
Panel's International icon or pull down the Settings menu and choose 
International. You'll see a dialog box like the one .shown on the next page. 
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International 

.c.ountry: I~lllm 
language: ~IE_n_gl_is_h_~_m_e_ri_ca_n_) ________ ~I!l __ " I~~ 

Keyboard Layout: I L-U_S ________ .JOoli!l_" I~~J 

M.easurement:1 L..E_n.;;;..gl_is_h ___________ ---IjI!l_~ 

List lieparator: D 
.Q.ate Format Cyrrency Format 

10/19/93 

Tuesday. October 19. 1993 

[ TIme Formal 
12:31:09 PM 

$1.22 

-$1.22 

Humber Format 

1.234.22 =lttG=~=Jn='ii=":=·~~=>d' 

The easiest way to work with this dialog box is to start with the Country 
drop-down list. Click the downward arrow to open the list, and then pick 
the country whose settings you want to adopt. For example, if you're going 
to be working in Sweden, select Sweden in the Country list. Control Panel 
then adjusts the settings in the Measurement, Date Format, Time Format, 
Currency Format, and Number Format sections of the dialog box, like this: 

International 

.c.ountry: Ir~)~·~ :1l1~1 
language: IL-E....;ng;;;..-li_sh_(;;.-A_me_r_ic_an....:..) ____ ...IiII!l_~: I~~mlln 

Keyboard Layout: l'-u_s ____________ ..... IIl_:~' 

M.easurement: IL-M_e_tr_ic ____________ ..... I!l_! 

List lieparator: D 
.Q.ate Format Cyrrency Format---., 

1993-10-19 

den 19 0 ctober 1993 

[1.ime Formal 
12.32.49 

1.22 kr 

-1.22 kr 

Humber Format 
1 234 221 ..... ~--T=~ . .,.---.h\--~....,..f!11 

• ,~~JI,~:ii'~L 
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Normally, these settings will be correct for the country you choose. 
But if you need to make adjustments, you can click the appropriate Change 
button in the bottom section of the dialog box. Each Change button brings 
up its own separate dialog box. Here, for example, is what you see if you 
ask to change the date format: 

International - Date Format 

r- Short Date Format-----------, 

!!rder: 0 MDY 0 DMY @lYEP.J 
~eparalor: EJ 
[g] D..al' leading Zero [07 vs. 7] 

[g] Month leading Zero [02 vs. 2] 

[g] .c.enturl' [1990 vs. 90] 

I r~.""'tfK·:"";·':" I 
I F"Canc·ef\" I 

r-long Date Format----------------, 

Older: 0 MDY @ DMY 0 YMD 

1L...-_--"I!!1_! 015 1!!1DIMarch I!!1DI1993 1!!1 

den 5 March 1993 

Control Panel does not automatically change the Language and Key­
board Layout settings when you modify the Country setting. Choose a 
different Language if you need to perform a language-specific task, such as 
sorting or case conversion. 

Choose a different Keyboard Layout if you want to type accented 
characters directly from the keyboard. 

KEYBOAR D TIP: You can type accented characters with 
any keyboard using the AIt key and the numeric keypad 
or using Character Map. For more information about using 
Character Map, see "Character Map," page 562. 
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NOTE: If you change either the Language or the Keyboard 
Layout setting, Windows might ask you to insert one of your 
original distribution disks so that it can get the information file for 
your language or keyboard. 

Changing Operating 
System Parameters 

Control Panel's System applet, shown below, allows you to customize the 
Windows NT flex-boot apparatus, change the size and/or location of your 
paging (swap) file, and change the relative priority that Windows NT gives 
to the foreground application. 

Computer Name: OMNI1 

Operating System---------, 

~Iartup: 1,"lftfitiffllUiii4Ui·l,i' 

Show list lor ~ seconds 

System Environment Variables: 
ComSpec = C:\winnt\sjJstem32\cmd.exe 
Os2LibPath = C:\winnt\sjJstem32\os2\dll; 
Path = C:\winnt\sjJstem32 
windir = C:\winnt 

!!ser Environment Variables for Craig 

tmp = C:\temp 

1'"""·0.""" 

1!)1~l.lWil;;101';~1 

1~~1!~1c~!,;\1:1 

~ariable: ~I ======================::::1 I~~in~ 
V~lue: IIIR&tJ~m 
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NOTE: Control Panel's System applet also lets you specify 
environment variables for the current user account. For more 
information, see "Environment Variables," page 629. 

Changing the Default 
Operating System and Startup Delay 
The drop-down list at the top of the System applet's dialog box shows the 
names of all installed operating systems recognized by the Windows NT 
flex-boot facility. The system named at the top of the list is the default 
operating system for your computer-the one that runs automatically on 
startup after the designated startup delay has elapsed. The delay time ap­
pears directly below the drop-down list, in the box labeled "Show list for." 
In the figure, the default operating system is "Windows NT Version 3.1," 
and the startup delay is 10 seconds. 

To change the default operating system, open the Startup drop-down 
list and choose from the systems listed. To change the startup delay, click 
the appropriate spinner arrow. You can reduce the delay to 0, but even if 
you almost never use an alternative operating system, it would be prudent 
to leave at least a small delay so that you can always return to Windows 
NT. For example, if you set the delay to ° and change the default system, 
you cannot return to Windows NT. 

Adding Another Operating 
System to the Flex-Boot List 
The flex-boot facility can recognize more than two operating systems, pro­
vided that only one system requires startup files to be stored in the root 
directory of the boot disk. Both MS-DOS and OS/2 require that certain files 
be kept in the root directory. Therefore, you cannot flex-boot Windows NT, 
MS-DOS, and OS/2. You can, however, flex-boot Windows NT, MS-DOS or 

OS/2, and additional systems that are not root-based. 
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To add an operating system on an Intel-architecture computer (one 
that uses an 80386,80486, or Pentium microprocessor), first install the new 
operating system. Then edit the file BOOT.lNI, which is stored in your root 
directory. That file will look something like the following illustration. 

File Edit Search Help 
[boot loader] 
tillleout=10 
defaul t=lIIul ti( 0) disk (0) rdisk( O)partition( 1) \winnt 

[operating systellls] 
lIIulti( O)disk( O)rdisk( 0)partition(1 )\winnt="\lindows NT Uersion 3.1" 
c :\="I1S-DOS" 

Using a nonformatting editor (such as Notepad), add an entry for your 
new operating system under the heading Operating System. To the left of 
the equal sign,. specify the path for the new system's files. Enter the text you 
want to appear in the startup list to the right of the equal sign. 

NOTE: Your BOOllNI file might be assigned system and 
read-only attributes. If so, you'll need to do the following to edit 
it: From File Manager's View menu, choose By File Type, and 
then select the Show Hidden/System Files check box. Make a 
backup copy of the file. Then use the File Properties command 
to remove the read-only attribute. 

If you're using a RISC-based computer, you can add a new operating 
system simply by running the appropriate ARC setup program. Windows 
NT will automatically detect the new system and add it to the flex-boot list. 

Changing the Size or 
Location of Your Paging File 
A paging file is a large disk file used for virtual memory-that is, an extension 
of your computer's random access memory (RAM). When RAM gets close 
to full, Windows NT automatically moves some information to the paging 
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file to make room in memory for new data. When the contents of the paging 
file are needed again, Windows NT brings back what it needs, possibly 
swapping something else out of RAM in the process. This whole process 
goes on automatically and, for the most part, unnoticeably. (In earlier ver­
sions of Windows, the paging file is called a swap file.) 

Earlier versions of Windows offer two kinds of swap files, permanent 
and temporary. Windows NT uses only one kind of paging file. The file is 
permanent, in the sense that it is not deleted when you end a Windows NT 
session. But, like a temporary swap file in Windows 3.1, the Windows NT 
paging file can change size during a session. When you set up the paging 
file (or when the Windows NT Setup program does it for you), you specify 
an initial size and a maximum size. Windows NT begins by using the initial 
size and can expand the file to the maximum size, as the need arises. (It 
always uses at least 2 MB, regardless of the initial and maximum settings.) 
The file, called PAGEFILE.SYS, is stored in the root directory of your boot 
disk, and cannot be deleted while Windows NT is running. If you delete it 
while running a different operating system, Windows NT creates a new one 
at your next startup. 

Unlike earlier versions of Windows, Windows NT allows you to create 
multiple paging files-one per local hard disk. If you have more than one 
local disk and room to spare, you might be able to improve the performance 
of your system by adding another paging file. The; performance improve­
ment will be most noticeable if your system has only 8 or 12 MB of RAM, 
or if you run a large number of sizable applications at once. 

To change the size or location of your paging file, or to add new paging 
files, your user account must be a member of the Administrators local group. 
If you are not authorized to change these parameters, you can see the 
settings that are currently in effect, but you cannot edit them. 

To change or inspect the paging-file settings, click the Virtual Memory 
button in Control Panel's System applet. You'll see a display similar to the 
one shown on the next page. 
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Virtual Memory 

I!.rive [Volume label] Paging File Size (MBl 1~i111J;OK1tl1~~TI 
:: .. , .. OMNI1 FAT ' , 27-77 

D: [Omnil NTFS] 27 - 77 l~lTEitl1!~lJ~m 

Paging File Size for Selected Drive 
Drive: C: [OMNI1 FAT] 

Space Available: 95 MB 

initial Size (MBl: 127 
:===~ 

Maximum Size (MB l: 177 

Total Paging File Size for All Drives -------, 
Minimum Allowed: 2 MB 

Recommended: 27 MB 

Currently Allocated: 54 MB 

Ili~iJHe1~l~~iJ'l 

To change or add a paging file, select a drive letter at the top of this 
dialog box. Then specify initial and maximum values and click Set. You 
must shut down and restart your system for your changes to take effect. 

Changing the 
Foreground/Background Tasking Balance 
By default, Windows NT divides your computer's processing time between 
the foreground application (the one you're currently working in) and all 
other running programs so that the foreground program gets maximum 
priority. Your other programs continue to run, but they get a smaller portion 
of your computer's processing time. You'll probably want to keep your 
system set this way if you need to interact with the foreground application. 
Windows NT gives you two other priority options, however, as shown in 
the following illustration. 

F oreground/Background Responsiveness 

@ !!i~!!::f~r.~gr.~~~:~::~p'p'!i~:~H~~::~:~:~P'Q:~!~:::t.Jr.'i~j o foreground Application More Responsive than Background 
o Foreground and Background Applications [qually Responsive 
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To arrive at these options, click the Tasking button in Control Panel's 
System applet. Your settings here affect only your own user account. 

Setting the Daie and Time 
Control Panel provides a simple way to adjust your system date and time 
settings. You'll find this feature handy if you transport your computer into 
a new time zone. 

Changes to the system date and time settings affect all users on your 
workstation. 

To set the date or time, double-click Control Panel's Date/Time icon 
or pull down the Settings menu and choose Date/Time. Provided your 
account is authorized to change the system date and time, you'll see the 
following dialog box. 

, Date(Time 

.!!.ate: fills/s) ~ l.ime (Local): 

Time Z-one: I(GMT ·8:00) Pacific Time (US & Canada); Tijuana 

[gJ Automatically Adjust for Daylight Savings Time 

Iii IFcancei';:q 
I r"'t[eJpn::1 

Press OK when the correct Date. Time and Time Zone are displayed. 

To change a date or time setting with the keyboard, press Tab until 
the number you want to change is highlighted. Then type a new number. 
In the illustration above, for example, you can change the date to 10/20/93 
by tabbing once (to highlight 19) and typing the number 20. 

To change a date or time setting with the mouse, click the number 
you want to increase or decrease. Then click the upward or downward 
arrow to the right of the number. 

If you want Windows NT to adjust your computer's clock automatically 
when your locality switches to 'or from daylight savings time, first select the 
appropriate time zone in the Time Zone drop-down list. Then select the 
Automatically Adjust for Daylight Savings Time check box. 
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Ush19 A~ternat~ve Mouse Poin~ers 
Should you tire of the pedestrian arrow and hourglass, check out Control 
Panel's Cursors applet. There you'll find an assortment of replacements 
(many of them animated) for each of the standard Windows mouse pointers. 
To see what's available, select one of the standard pointer shapes, and then 
click Browse. A dialog box similar to the following will appear. 

File Hame: 

I drum. ani 

banana. ani 
barber. ani 
coin. ani 
counter. ani 
drum. ani 
fill it up. ani 
hand. ani 
horse. ani 

List Files of I.vpe: 

Icursors (".ani. ".cur) If!I 

Browse 

Qirectories: I~ 
c: \winnt\system32 

1~!Cl~~F1 ,.....,rc-:---c-:\--------,.:::!i""'"k\"H~. an.c~:ri;t:~f 

~ :~s~~m32 Im~~ 
C!J config 
C!J drivers 
C!J os2 
C!J repl 

Driyes: 

The files with the extension ANI are animated pointers. You might also 
see some nonanimated options with the extension CUR. When you select 
any cursor filename, a preview appears in the lower right corner of the 
dialog box. . 

Mapphng Sound 
fUes to System Events 

~f your computer is equipped with a sound board and you have installed 
the correct driver for it, you can set up Windows to respond to various 
events with sound files (files with the extension W A V) instead of its normal 
beep. When you open the Sound applet, Windows lists the available events 
in the following dialog box. 
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f.vents: 
'sh~risk ................... . 

Critical Stop 
Default Beep 
E Kclamation 
New Mail Notification 
Question 
Schedule+ Reminders 
Windows Lo off 

[g] Enable System Sounds 

Sound 

c:\windows 

Alongside the Events list is a listing of all W A V files in your Windows 
directory. To hear what any of these files sounds like, select a filename and 
click the Test button. (This button is grayed out if you have not installed an 
appropriate audio driver.) To map a system event to a WAY file, select the 
event in the list on the left and the filename in the list on the right. 

Turning Off the Sound 
Windows normally sounds a warning beep or plays the sound file mapped 
to the default beep when you try to do something it deems inappropriate. 
In the unlikely event that you've never been so rewarded, you can experi­
ence this signal for yourself as follows: 

1. Double-click Control Manager's Sound icon, or pull down the 
Settings menu and choose. Sound. 

2. After the dialog box appears, click the mouse anywhere in the 
Control Panel window, outside the dialog box. 

If you find the beep or sound file annoying, deselect the Enable System 
Sounds check box in the Sound dialog box. 

~nsto]IUrng Dr~vers 
If you add a new peripheral to your computer, such as a sound board or a 
video player, you might need to install a new driver as well. You can do 
that with Control Panel's Drivers applet. 

To add a new driver, double-click Control Panel's Drivers icon. Then 
click Add, choose a driver from the list that appears, and follow the prompts. 
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If the driver you need does not appear in the list, select the item labeled 
Unlisted or Updated Driver. Windows then prompts you to insert a disk 
with the unlisted driver in drive A. 

If the driver you install offers configuration options, the Setup button 
in the Drivers dialog box is enabled (not grayed out). Click that button and 
fill out the dialog box that appears. 

Modifying Private INI Files 
Although the registry is designed to record configuration information for 
individual applications as well as for your system as a whole, some programs 
will undoubtedly continue to rely on their own initialization files. You might 
occasionally find it necessary to change a program's configuration by editing 
its INI file. Fortunately, almost all INI files are Similarly structured, and edit­
ing an INI file is neither difficult nor dangerous-provided you first make 
a backup copy of the file. 

How INI Files Are Structured 
Here's what the beginning of a typical INI file looks like: 

= Notepad - 123R4.INI an 
file .Edit Search Help 

[COUNTRY] 
driuer=L1WUSF 

[AUTOLOAD ADDINS] 

[PRINTER] 
postscript=system 
numpostfonts=5 
driuer= 
fallbacktable= 
DefaultPrt=LaserJet lion LPT1: 

[DIRECTORIES] 
personal=C :\SS\ 123R4W\programs 
addin=C :\SS\ 123R4W\programs\addins 
install=C:\SS\123R4W 

[CONFIC] 
;use shared DLLs 
USESHARED=O 
read extension=WK* 
write extension=WK4 
;Display of negatiue numbers - O=parentheses. 1 = sign (default = 0) 
negatiuecO 
;Release 2 format - O=LICS, 1 = ASCII (default = 0) 
"release2=0 
;File translation - O=country, 1 = international (default = 0) 
translation=O 
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The file has several sections, each headed by a word enclosed in 
brackets. The first section in the file illustrated above is called [COUNTRY]. 
The second is [AUTOLOAD ADDINS], the third [PRINTER], and so on. Under 
each bracketed heading, you'll find a number of lines beginning with a 
single word (it may be a compound word such as numpostJonts) and an 
equal sign. These are called keywords. Each keyword controls some aspect 
of the way your application functions. On the right side of each equal sign 
are values that are assigned to the keyword. 

If nothing appears to the right of an equal sign, that means that your 
program has assigned a default value to the keyword. If a keyword itself 
(or a whole section of keywords) doesn't appear in the file, its absence also 
means that a default value has been assigned. 

The order in which the sections appear is not critical. Nor is the order 
in which keywords appear within a section. 

How to Edit an INI File 
The two principles to remember when changing the contents of any INI file 
are: 

IJ Make a backup copy of the file before you begin. 

IJ Do not use a "formatting" editor. 

Copying the file before you start gives you a way to recover if you 
make a mistake. A formatting editor is one that adds formatting information 
to the file-information about fonts, page dimensions, indents, and so on; 
most word processors fall into this category. Such information will almost 
certainly corrupt your INI file. 

WINDOWS TIP: By default, Windows NT associates INI 
files with NOTEPAD.EXE, which is fine because Notepad 
makes a perfectly suitable INI-file editor. For more infor­
mation, see "Notepad," page 541. 
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Inexpensive shareware editors are also available (on CompuServe or 
local bulletin-board systems) that add some handy bells and whistles-such 
as the ability to sort INI-file headings. 

Editing the WIN.lNI and SYSTEM.INI Flies 
Although Windows NT itself does not use the WIN.lNI or SYSTEM.lNI files, 
you might have applications written for older versions of Windows that 
depend on entries in these files. Should you need to edit WIN.INI or 
SYSTEM.lNI, you can do so by using the program Sysedit. If you don't have 
a program item for this program, choose Program Manager's File Run com­
mand and type sysedit. (You can also type this in a command prompt 
window.) 

Sysedit is a Notepad-like editor that works with only four specific files: 
WIN.lNI, SYSTEM.lNI, AUTOEXEC.BAT, and CONFIG.SYS. The program 
offers one convenience missing in Notepad: It automatically makes backups 
of its files before saving your edited versions. The backups have the exten­
sion SYD. 
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Using the Clipboard with Applications for Windows 
Cut and Paste work the same way everywhere ... 
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Using the Clipboard with Non-Windows-Based Applications 171 
.,. except in programs for MS-DOS, where they work almost the same 
way. 

Using ClipBool< Viewer 174 
The ClipBook V iewer lets you build a scrapbook of shared data. 



Maldng Connections with OLE 184 
OLE is the automated way to build compound documents. 

Embedding Packages 187 
An icon may be worth a thousand words, tones, or pixels. 



ne of the primary benefits of working in Windows is the 
~. ability to transfer information quickly and easily between 

programs. Windows NT offers two means of sharing information across 
applications: the Clipboard, and object linking and embedding (OLE). These 
features, along with the ClipBook Viewer application, are the subject of this 
chapter. At the end of the chapter, we'll also look at a utility called Object 
Packager that lets you embed an iconic representation of a data object. 

Using the C~ipboard w~th 
Applications 1orWindows 

The procedures for using the Clipboard are essentially the same in all 
programs for Windows-including programs written expressly for Windows 
NT and programs written for MS-DOS-based versions of Windows. The 
basic steps are as follows: 

1. Select the information you want to move or copy. 

2. Choose the program's Cut command if you want to move the infor­
mation, or the Copy command if you want to copy it. 

3. Switch to the program that you're going to copy or move the infor­
mation to. 

4. Position the insertion point or cursor at the place where you want 
the information to go. 

5. Choose the receiving program's Paste command. 

for example, if you want to copy the range A1:G10 from a Microsoft 
Excel worksheet into a note you are writing in Notepad, you start by 
activating Excel and selecting cells A1:G 10. Then you choose the Copy 
command from Excel's Edit menu. 

At this point, Windows puts a copy of the Excel information in an area 
of memory known as the Clipboard. 

Next you make Notepad the current window, position the insertion 
point in your note where you want the table to appear, and choose the 
Paste command from Notepad's Edit menu. 

After a copy operation, such as the one just described, the Clipboard's 
contents remain unchanged. This means that after you put something on 
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the Clipboard, you can paste it as many times as you like-into several 
different places within the same document or into several different docu­
ments. Generally speaking, the Clipboard retains its contents until you 
replace them with something else or unless you explicitly delete them with 
ClipBook Viewer. (There are a few exceptions. Microsoft Excel, for example, 
erases the Clipboard after you paste data and then perform other com­
mands.) 

The Copy, Cut, and Paste Commands 
Almost all Windows applications that work with user data have an Edit menu 
with Copy, Cut, and Paste commands. The three commands behave in a 
predictable and consistent way in almost all programs. Copy puts selected 
information on the Clipboard without removing it from the source docu­
ment. Cut puts the information on the Clipboard and at the same time deletes 
it from the source document. Paste puts a copy of the Clipboard's contents 
into the destination document without emptying the Clipboard. (Once again, 
Microsoft Excel is an exception. When you use Excel's Cut command, the 
selected information remains in place on the worksheet until you use Paste. 
If you change your mind and don't paste, Excel leaves your cut data in place 
on the worksheet.) 

Many programs also have Delete or Clear commands on their Edit 
menus. These commands differ from Cut in that they simply remove data 
from the current application without putting a copy of the data on the 
Clipboard. · 

Copying a Full Screen or Window 
Windows has commands for copying a windowful or an entire screenful of 
information to the Clipboard all at once. These commands are particularly 
useful when you're transferring information from an MS-DOS-based pro­
gram. (For more information, see "Using the Clipboard with Non-Windows­
Based Applications," page 171.) But you might also find them useful when 
your source program is a Windows-based application. 

To transfer a snapshot of the current window to the Clipboard, you 
press Alt+PrtSc. (On some keyboards, the PrtSc key is labeled Print Screen.) 
To transfer a snapshot of the current screen to the Clipboard, you press 
PrtSc (without Alt). 
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KEYBOAR D TIP: With some older keyboards, where 
PrtSc shares the asterisk key, you must press Shift+ PrtSc 
to transfer a snapshot of the screen. 

These commands transfer a graphic image (a bit map) of the current 
window or screen to the Clipboard. What you see on screen when you take 
the snapshot is exactly what goes onto the Clipboard and exactly what you 
can subsequently paste into another program. Any information beyond the 
confines of the current screen or window is not transferred. 

Using ~he CUpboolrd with 
Non-Windows-Based AppUcaiions 

The procedures for using the Clipboard with non-Windows-based programs 
(that is, programs for MS-DOS, OS/2, or POSIX, as well as character-based 
programs for Windows NT) are nearly the same as those just described for 
Windows-based programs. There are two significant restrictions: 

iJ You can copy data from a non-Windows-based program to the 
Clipboard,but you can't cut. 

e To transfer a graphic image of an MS-DOS-based program to the 
Clipboard using PrtSc or Alt+PrtSc, you must run the MS-DOS­
based program in a window. (If your program is running full­
screen, press Alt+Enter to display it in a window.) 

NOTE: If you press PrtSc or Alt+PrtSc while running an 
MS-DOS-based program full-screen, Windows transfers the 
contents of the screen to the Clipboard as text rather than as a 
graphic image. 

For more information about running non-Windows-based programs 
under Windows NT, see "Running All Kinds of Programs," page 590. 
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Copying a Text or 
Graphics Block to the Clipboard 
The simplest way to copy a block of text or graphics from a non-Windows­
based program to the Clipboard is as follows: 

1. Display the non-Windows-based program in a window. (Press 
Alt+Enter if necessary.) 

NOTE: If your MS-DOS-based program is running in graphics 
mode, the word Frozen appears on its title bar when you display 
it in a window. This is not a problem; it merely means that 
Windows NT suspends execution of the program while it's 
windowed. After you copy your data to the Clipboard, you can 
press Alt+Enter to resume execution of the program. 

2. Select the text or graphics you want by draggin~ the mouse, as you 
would in a Windows-based program. 

If dragging the mouse doesn't highlight the block, pull down the 
program's Control menu and choose Settings. You'll see a dialog 
box like this: 

Display Options 

@Window 

o FylJ Screen 

D !luickEdit Mode 

~ ~ave Configuration 

Special------, 

11,~I~fIDi~'it~t~1~1 

I~ 
ItamJ 

Select QuickEdit Mode and click OK. 

3. Press Enter or click the secondary (right, by default) mouse button. 

QuickEdit mode makes your mouse available for selecting text or 
graphics at the expense of making it unavailable for executing commands 
in your non-Windows-based program. If you need the mouse for choosing 
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menu commands, activating cells in a spreadsheet, or otherwise interacting 
with the non-Windows-based application, revisit the Control menu, choose 
Settings, and deselect QuickEdit Mode. 

Alternatively, if you prefer not to use QuickEdit mode, you can select 
data in a non-Windows-based program by choosing the Control menu:s Edit 
command, and then choosing Mark. After you choose Mark, the mouse will 
be available for selection, exactly as it is in QuickEdit mode. The Control 
menu's Edit Mark command, in effect, selects QuickEdit mode for only one 
mouse selection, and then restores the mouse's previous function. 

NOTE: If your mouse pointer disappears when you display your 
non-Windows-based program in a window, press Alt+Spacebar 
to open the program's Control menu. Then choose Display 
M.ouse Pointer. 

Pasting Information into a 
Non-Windows-Based Program 
To paste the Clipboard's contents into a non-Windows-based program, do 
the following: 

1. Display the program in a window. (Press Alt+Enter if necessary.) 

2. Position the cursor where you want the data to be pasted. 

3. Click the secondary mouse button. Or, choose the Control menu's 
Edit command, and then choose Paste. 

You can also paste into a minimized non-Windows-based program. 
The results are exactly the same; the Clipboard's contents arrive at the 
current cursor location in the minimized program. 

Be aware of the following issues when pasting into non-Windows­
based programs: 

Il The non-Windows-based program must be able to accept the type 
of data stored on the Clipboard. Most non-Windows-based pro­
grams can accept text only. If you copied graphics to the Clipboard, 
the Paste command will still be available (because Windows does 
not know the capabilities of your non-Windows-based programs), 
but the paste will have no effect. 

17~ 
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D When you paste text from the Clipboard into a non-Windows­
based program, the Clipboard adds a carriage return and line feed 
to the end of each text line as it appeared in the original document, 
even if those line endings were originally created by word wrap 
rather than by pressing Enter. That means that text pasted into a 
non-Windows-based word processor might have extra "hard" car­
riage returns and might need to be reformatted. 

D If you paste a column of numbers into a non-Windows-based 
spreadsheet, those numbers will all arrive in the same cell (with 
each line replacing its predecessor) unless you.r spreadsheet is one 
that moves the cell selector on Enter. If this feature is optional in 
your spreadsheet, you might want to activate it before pasting 
,numbers from the Clipboard. 

D If your non-Windows-based program drops characters pasted from 
the Clipboard, you might need to create a PIF (program information 
file) for it and deselect the "Allow Fast Paste" option. For informa­
tion about creating and using program information files, see "Using 
Program Information Files," page 670. 

Using ClipBook Viewer 
The ClipBook Viewer application performs four valuable services: 

c It lets you see the current contents of the Clipboard and provides 
a list of the formats in which the current Clipboard contents are 
stored. 

D It gives you a way to save Clipboard objects for easy reuse. 

D It provides commands for sharing local Clipboard objects with 
other network users. 

c It provides commands for connecting to Clipboard objects created 
by other users. 

ClipBook Viewer's program file is called CLIPBRD.EXE. Unless you've 
moved it, you'll find its program-item icon in your Main program group. 
When you launch ClipBook Viewer, you'll see something like the following. 
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FPTOC 
JJ Jurassic Park logotype 
JJ Schedule with connections 
JJ Writing fee schedule 

This illustration shows the ClipBook Viewer with two open windows­
the Clipboard window and the Local ClipBook. These windows can be sized, 
moved, and minimized, exactly like directory windows in File Manager. And 
just as in File Manager, you can use commands on the Window menu to 
switch between windows or arrange the windows neatly on your screen. 

The Clipboard window shows the current contents of the Clipboard. 
What you see here is what you can paste into an application. The Local 
ClipBook is a scrapbook for data that you want to keep-either because 
you want to reuse it or because you want to make it available to other users 
on your network. 

In addition to the Clipboard and the Local ClipBook, the illustration 
above also shows one remote ClipBook in a minimized window. The remote 
ClipBook holds items in another user's Local ClipBook-items that the other 
user has chosen to share. 

Your own ClipBook Viewer will include at least the Clipboard and 
Local ClipBook windows. You may also have one or more remote Clip­
Books. 
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Viewing the Clipboard's Contents 
When you cut or copy information from an applicat.ion to the Clipboard, 
the application transfers the information in as many formats as it can. 
Paintbrush, for example, normally supplies an image to the Clipboard in 
both bit-mapped and picture formats. Microsoft Word for Windows copies 
a block of text in several text formats. Microsoft Excel puts worksheet data 
on the Clipboard in an assortment of formats, including some that allow the 
data to be exported to other spreadsheet programs. (See Table 5-1 on 
page 178.) 

This multiple-format arrangement allows an application to receive 
pasted data in whichever format best suits it. For example, the fact that a 
block of cells from a Microsoft Excel worksheet arrives on the Clipboard in 
both graphics and text formats means that you can paste it into Notepad, a 
program that accepts only text, as well as into programs that accept only 
graphic material. 

To see which formats your Clipboard data is using, activate the Clip­
board window and open the View menu. The names of the available formats 
appear in the bottom segment of this menu. Depending on what kind of . 
information you've put on the Clipboard, your View menu might look rather 
simple, like this: 

ClipB oak on Local ClipB oak 
\\SEQUOIA 
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Or it can be impressively complex: 

ClipBook on Local ClipBook 
\\SEQUOIA 

Ioolbar 

Iext 
Csv 
Rich Text Format 
Native 
OwnerLink 
Link 
ObjectLink 
Display Text 
QEMText 
!!nicode Text 
Enhanced Metafile 

Table 5-1 on the next page lists a few of the terms you might encounter 
on ClipBook Viewer's View menu. 

You can change the appearance of the Clipboard contents by selecting 
any of the Display-menu names that appear in dark type. (Grayed-out names 
represent formats that the Clipboard is currently using but that ClipBook 
Viewer is incapable of displaying.) To return the viewer to its default display, 
choose Default Format. 

It's important to recognize that changing the format displayed in Clip­
Book Viewer's window has no bearing on the format that will be pasted 
into a receiving application. If you use the receiving program's Paste com­
mand, the program requests a particular format from the Clipboard, regard­
less of what happens to be displayed in the viewer. Some applications 
include a Paste Special command, however, in addition to the ordinary Paste 
command. This command lets you choose which of several formats to paste. 
ClipBook Viewer's Display menu, in this case, can help you make the choice 
by showing you which formats are there and what they look like. 
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Text 

OEM Text 

Rich Text Format 

Bitmap 

Picture 

TABLE 5-1. 

Unformatted character information (without style 
attributes, such as boldface and italics), using the 
ANSI standard character set (the one used by all 
Windows":based programs). 

Unformatted character information, using the 
"extended ASCII" character set (the character set 
used by MS-DOS-based programs). If you paste 
text data into an MS-DOS-based program, 
Windows supplies it in OEM-text format. 

A text format that uses embedded codes to store 
style information, such as boldface and italics. 
Microsoft Excel, Microsoft Word for Windows, 
and a growing number of other programs 
support the rich text format. 

A graphic format in which each pixel in an 
image is represented by one or more data bits. 
Unlike a picture or metafile, bit-mapped data is 
specific for a given output device. If you display 
a bit map on a device with different resolution 
or color capability than the one on which it was 
created, you're not likely to be pleased with the 
result. Also, although bit-mapped images can be 
resized or reshaped, this process generally 
introduces gross distortions. 
A graphic format in which image elements are 
stored as a sequence of commands. An image in 
picture format can be reproduced without gross 
distortion at different sizes or shapes, as well as 
on different kinds of output devices. But a bit-
mapped image might display more quickly, . 
because it doesn't have to be recreated from 
programmatic instructions. An image in picture 
format is also sometimes called a metafile 
(although the terms are not precisely equivalent). 

(continued) 

Some common Clipboard formats. 
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DIB 

BIFF, BIFF3, CSV, 
DIF, Sylk, Wkl 

Link, OwnerLink, 
ObjectLink 

Unicode Text 
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A device-independent bit map. This is a newer 
bit-mapped format (introduced with OS/2 
version 1.1) that eliminates some (but not all) of 
the device-specificity of the standard bit-mapped 
format by including information about the color 
palette and resolution of the originating device. 

Formats used for the exchange of spreadsheet or 
database information. 

Formats used to establish OLE links between 
documents. 

A 16-bit text-encoding format that allows for 
both Latin and non-Latin alphanumeric 
characters, plus an assortment of commercial, 
mathematical, and scientific symbols. 

Saving Clipboard Objects 
in Your local ClipBool< 
To save the current Clipboard contents as a page in your Local ClipBook, 
use the Edit menu's Paste command, type Ctrl+V, or click the Paste icon on 
the toolbar. The Paste icon is the middle icon in the toolbar's third group: 

.---- Copy Clip Book page to Clipboard 
Paste Clipboard contents to Local ClipBook 
Delete Clipboard contents or selected ClipBook page 

The dialog box that appears prompts you for a page name and asks 
if you want to share the item with other users. If you choose to share the 
item at this point, you'll see a new dialog box with some additional options. 
For information about sharing options, see "Sharing Clipboard Data," 
page 181. 
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Items pasted into your Local ClipBook are called pages and are listed 
alphabetically by the names you give them. On disk, they're stored in 
separate files, each beginning with the letters CLP, followed by a random 
number and the extension CLP. 

WINDOWS TIP: The CLP files created by Local ClipBook 
pages preserve all of the information currently on the 
Clipboard. Because the Clipboard often stores the data in 
multiple formats, CLP files tend to be rather large­
particularly if the information they contain is graphic. If 
disk space is at a premium, use ClipBook pages judicious­
ly, and delete pages when you no longer need them. To 
delete a ClipBook page, select it and press the Del key. 

NOTE: The Save As command, on ClipBook Viewer's File menu, 
also preserves the current Clipboard contents as a CLP file but 
does not create a new ClipBook page. This command is 
provided for compatibility with earlier versions of Windows. 
Unless your Local ClipBook is so crowded that you're having 
trouble finding pages, there's no reason to use this command 
instead of creating a ClipBook page. 

Viewing the Contents ,of Your Local ClipBook 
ClipBook v iewer can display the contents of your Local ClipBook (and any 
remote ClipBooks to which you are connected) in three ways: in an alpha­
betical listing by page title, as a set of thumbnail sketches, or in a fully 
rendered presentation. An example of the alphabetical listing, called Table 
of Contents view, is shown in the illustration on page 175. To switch to a 
different view, use the commands at the bottom of the View menu or the 
three rightmost tools on the toolbar. 
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,--- Choose Tabl~ of Contents view 
Choose Thumbnail view 
Choose Full Page view 

MOUSE TIP: You can toggle the fully rendered display 
(Full Page view) of a ClipBook page by double-clicking 
the page. 

Reusing Pages from Your Local ClipBook 
To reuse data that you've pasted into a Local ClipBook page, select the page 
you want and choose the Edit menu's Copy command or click the Copy 
tool. The selected page remains in your ClipBook, but a copy of it appears 
in the Clipboard window. You can then paste it into your spreadsheet, word 
processor, or other application. 

Sharing Clipboard Data 
To make your Clipboard data available to other users on your network, you 
must first Paste the data into your Local ClipBook, and then choose the 
Share command from the File menu. If you know you're going to be sharing 
the Clipboard information, you can accomplish both of these steps at the 
same time. When you choose the Edit menu's Paste command (or click the 
Paste tool) to transfer the data to the Local ClipBook, you can simply select 
the Share Item Now check box. Alternatively, if you have already created 
the ClipBook page and didn't choose to share it at the time you created it, 
you can select the page and then choose the File menu's Share command 
(or clickthe Share tool-the third tool on ClipBook Viewer's toolbar). 

Share selected ClipBook page 
Stop sharing selected ClipBook page 

: 
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When you choose the Share command, ClipBook V iewer presents the 
following dialog box. 

Share C/ipBook Page 

Page Name: Quarterly Sales Chart 

Sharing Options: 

o ili~:~i.f:~p.p.':!~:~~l:Q~:::Q~:::¢'Q~:~~:~~j 
o Run Minimized 

Setting Permissions 
By default, the person who shares a ClipBook page (the "owner") has Full 
Control over that page. If you're the owner, you can modify it, stop sharing 
it, or delete it. Everyone else, by default, has "Read and Link" privileges. 
That means that others can paste or paste-link the data, but they can't change 
it or delete it from the pool of shared ClipBook pages. 

To alter these permission levels for a particular user or group of users, 
do either of the following: 

c In the Share ClipBook Page dialog box (shown in the previous 
figure), click the Permissions button. 

c Select a page in your local ClipBook and choose the Permissions 
command on the Security menu. 

Either way, you'll see a dialog box similar to the one shown on the 
next page. In the Name list box, select the name of the user or group for 
whom you want to change permissions. Then open the Type of Access 
drop-down and select the permission level you want. The privileges asso­
ciated with those permission levels are shown in Table 5-2. 

If you want to change permissions for a user or group not listed in the 
top of the dialog box, click the Add button. You will then arrive at the Add 
Users and Groups dialog box. For information about using this dialog box, 
see "Setting User Rights Policies," page 330. 
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ClipBook Page Permissions 

ClipBook Page: Quarterly Sales Chart 

Q.wner: Administrators 

Harne: 

!It Administrators Full Control 
<t Everyone Read and Link 

,Iype of Access: 1-1 F_u_II_C_on_t_ro_1 _________ If!I_', 

.. , .... ,. 

No Access 

'Read 

Read and Link 

Change 

Full Control 

TABLE 5-2. 

ClipBook data is unavailable 

Il View the page in ClipBook Viewer 

Il Paste (embed) the contents of the page into 
another application 

Everything allowed by Read permission, plus: 

Il Establish a link to the page from another 
application 

Everything allowed by Read and Link 
permission, plus: 

Il Update the source document of a linked 
object (unless the source document is on 
another computer) . 

Il Update the link to the source document 

Il Delete the page from the ClipBook 

Everything ailowed by Change permission, plus: 

Il Set permissions for the page 

Il Take ownership of the page 

Permission levels for shared Clip800k pages. 

Ii 
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Connecting to Other Users' ClipBook Pages 
To connect to another user's Local ClipBook, click the leftmost icon on 
ClipBook Viewer's toolbar, or pull down the File menu and choose Connect. 
In the dialog box that appears, select the name of the computer whose Local 
ClipBook you want to use and click OK. ClipBook Viewer rewards you with 
another ClipBook window, identified by the network path of the remote 
workstation, cont';lining all ClipBook pages shared by the remote user. To 
paste a remote ClipBook page into one of your applications, copy the page 
from the remote ClipBook onto your Clipboard, and then paste it into the 
application. 

Making Connections with OLE 
OLE, or object linking and embedding, is a protocol for connecting docu­
ments dynamically. As its name implies, OLE provides two distinct services. 
When you link a source document to a destination document, the destina­
tion document can be updated automatically any time the source document 
changes. When you embed data from a source document in a destination 
document, the destination document doesn't change if the source is up­
dated. But you can double-click the embedded data to edit that data in the 
context of its source application. For example, if you embed a Paintbrush 
image in a Write document, double-clicking the image in Write invokes 
Paintbrush, allowing you to edit the picture and send the new version back 
to Write. 

To link with OLE, the basic steps are as follows: 

1. Copy data from an OLE-supporting program to the Clipboard. 

2. Use the Paste Link command in another OLE-supporting program. 

To embed, follow the same procedure but use the Paste command 
instead of Paste Link. 
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To link data stored on another network workstation, follow these steps: 

1. Use ClipBook Viewer to connect to that workstation's Local Clip­
Book. (See "Connecting to Other Users' ClipBook Pages," page 1~4.) 

2. Copy the page you want to link from the remote ClipBook to your 
Clipboard. 

3. Use your application's Paste Link command. 

To embed remote data, follow the same procedure but use the Paste 
command instead of Paste Link. 

In order to use OLE, both the application in which the data was created 
and the application receiving the data must support OLE. In addition, the 
program that supplies the data must support OLE as' a server application, 
and the program that receives the data must support OLE as a client appli­
cation. 

Some programs support OLE in only one mode. Paintbrush, for exam­
ple, can act only as an OLE server. Write and Cardfile can act only as OLE 
clients. Other programs support OLE in both modes. To find out if an 
application supports OLE, consult the program's documentation. 

OLE is an extension of DDE (dynamic data exchange), Microsoft's 
original protocol for interprocess communication under Windows. From the 
user's perspective, linking with OLE offers one large advantage over linking 
with DDE-namely, the ability to launch the server application directly from 
the client document. You do not have to remember where your data came 
from. (There are other improvements under the hood, as well.) Certain 
hazards that plagued DDE users in earlier versions of Windows still apply, 
however. If you rename or relocate a server document, you must repair or 
abandon any links in client documents. Most OLE client applications include 
commands to assist you with this. 

Linl<ing Versus Embedding 
Use linking rather than 'embedding when the source data is likely to change 
over time and you need to have it updated automatically in the client 
document. You should also use linking when you use the same data in many 
client documents; you can ensure consistency by linking each client docu­
ment to a single server. 

N ~ 
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The chief advantages of using embedding over linking are permanence 
and portability. Because the embedded data actually resides in the client 
application, you don't have to worry about renaming or moving the data's 
source. Obviously, you'll want to choose embedding over linking if you're 
going to send your client document to an off-site colleague who doesn't 
have access to your files. 

Here is a summary of the differences between linking and embedding: 

C When you link, the linked data is stored only in the server docu­
ment. Although you see the linked data in the client document, the 
client document records only the visual appearance of the data, 
plus pointers to the server document. 

When you embed, a copy of the embedded data is stored in the 
client document. 

C When you link, any changes made to the linked data in the server 
document are reflected in the client document-either immediately 
(if you've established an automatic link) or on request (if the link 
is manual). 

When you embed, changes in the server document have no 
effect on the client document. 

D Linked data must have been saved at least once in a disk file. 

D When you double-click a linked object (a data item paste-linked 
from an OLE server) in a client application, Windows launches a 
normal copy of the server application, loads the file containing the 
object, and selects the linked data. Changes you make in the server 
are then reflected in the client immediately or on request, according 
to the mode of the link. 

When you double-click an embedded object, Windows launches 
a special copy of the server application (one with a modified title 
bar and File menu), loads the file containing the object, and selects 
the linked data. Changes you make in the server application are 
not reflected in the client until you use the server application's 
Update command; you'll generally find that command on the File 
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menu. Alternatively, you can update the client document by 
quitting the server application and answering an update prompt 
affirmatively. 

C A linked object in one OLE client document may be linked to other 
OLE client documents. 

To edit linked or embedded data, follow these steps: 

1. Double-click the linked or embedded object. 

2. Make the changes in the server application. 

3. Use Update to send the changes back to the client document. 

For examples of linking and embedding procedures in Write and 
Cardfile, see "Linking and Embedding in Write," page 430, and "Linking and 
Embedding," page 554. 

Embedding Pacl<oges 
Windows includes a facility called packaging that lets you do the following: 

C Embed an iconic representation of an object in an OLE client 
document. The object can be any text, graphic, sound, video, or 
other data that originates in an OLE server application. 

EJ Embed an iconic representation of an entire file in an OLE client 
document. The file can be a data file or an executable file and does 
not have to originate in an OLE server application. 

IJ Embed a Windows command line, attached to an icon, in an OLE 
client document. 

In all cases, the embedded object is called a package or package object. 
The package is always embedded in the client document, although the 
contents of the package may be either an embedded object or a linked ob­
ject. If the package contains embedded data, then embedding the package 
stores an encapsulated copy of the data object in the client document. If 
the package contains linked data, embedding the package stores pointers 
to the package's source. (See "Linking Versus Embedding," page 185.) 
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Regardless of what the package contains, what you see after embed­
ding the package is an icon. The illustration below shows how a Write 
document with an embedded package might look. 

Eile Edit Find Character Paragraph o.ocument Help 

Fellow trustees: 

I have finally finished analyzing the budget I sent you a few weeks ago. and I am afraid 
news is not good. While there is a lot offine tuning that may be possible, the basic ne~ 
we will run out of liquid assets in somewhat less than two years. That is a lot more ser 
my earlier projection and indicates that we'd better get to work fast to plan what we are 
do. 

To inspect the projection worksheet, double-click the Excel icon below: 

~ 
PROJECTN.XLS 

Most of the numbers on this spreadsheet come from 1989-1991 averages, modified in 
".,' lio 

After you embed a package, you can play it by double-clicking it or 
choosing a menu command. Playing a packaged data object (a portion of 
a file) provides a convenient way to inspect or edit that object. Playing a 
packaged file is equivalent to choosing File Manager or Program Manager's 
File Run command and typing the name of the file. The same is true of 
playing a packaged command line; for example, if you package the com­
mand line TODOLIST.TXT, then playing the package invokes Notepad with 
a copy of your to-do list in place (assuming that TXT files are associated 
with NOTEPAD.EXE). 

To assist you in embedding packages, Windows NT includes a utility 
called Object Packager. This program's executable file is PACKGR32.EXE, 
and you'll probably find a program-item icon for it in your Accessories 
group. 

Why Use Pacl<oges? 
At this point you might be wondering why you would want to bother 
embedding a package when you CQuid instead embed or link a data object 
directly. One reason is compactness. In the previous figure, the embedded 
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package represents a large range of cells in a Microsoft Excel worksheet. 
While this worksheet presumably supports the argument you're making in 
your Write document, a full visual representation of the worksheet would 
be distracting. By encapsulating supporting data in packages, you can create 
a kind of footnoting system. Interested readers can summon supporting 
materials, while others can skip over the icons without losing the continuity 
of the main text. 

A second reason for using packages is that they're not limited to data 
that originates in OLE server applications. If you encapsulate an entire file 
in a package, as opposed to a block of data, that file can come from any 
program. 

Embedding a Pacl<aged Object or File 
The general procedure for embedding a packaged data object or file is as 
follows: 

1. Put the data or file you want to package on the Clipboard. 

2. Use Object Packager to create your package. 

3. Use Object Packager to customize the package's icon or label. 

4. Use Object Packager's Copy Package command to copy the package 
to the Clipboard. 

5. Use the client application's Paste command to embed the package. 

For information about packaging a command line, see "Embedding a 
Packaged Command Line," page 192.) 

If you're packaging an entire file and you're content to use the default 
text and icon for your package, you can bypass Object Packager. For more 
information, see "Packaging Files-the Direct Route,:' page 194. 

Putting the Data on the Clipboard 
If you're going to package an entire file, start by selecting that file in a File 
Manager directory window. (For information about using File Manager, see 
"Working with Files and Directories," page 106.) Then use the Copy to 
Clipboard command on File Manager's File menu (or press F9, its keyboard 
shortcut). 
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If the data you want to package is only a portion of a file, select the 
data in the usual way, and then use the Edit menu's Copy command to put 
the data on the Clipboard. Remember, however, that in this case the data 
must originate in an OLE server application. 

Creating the Package 
After the data you want to package is on the Clipboard, the next step is to 
run Object Packager. (If Object Packager is already running, activate it and 
choose its File New command.) Object Packager presents two work 
spaces-an Appearance pane on the left and a Content pane on the right. 
To create a new package, first activate the Content pane by clicking there 
or pressing Tab until Content is highlighted. Then choose either Paste or 
Paste Link from Object Packaget.:'s Edit menu. 

If you choose Paste, the package will contain a copy of the data or file 
on the Clipboard. Object Packager's display will look something like this 
(in this example, the packaged data is a Paintbrush file): 

flr-----o~aal 
Eile Edit Help 

--Appearance-- ImtiiilJe'8nxttfJ ~ 

~ 
'IS) 

EGYPT.8MP 

View: @ Description 0 Picture 

If you choose Paste Link, the package will contain only a link to the 
source data, not the data itself. Object Packager's display will then look 
something like this: 

Eile .Edit Help 

--Appearance-- I_WE'8lt~~l ~ 

~ .. 'IS) 
EGYPT.8MP 

View: @ Description 0 Picture 

;""'tiljbaal:JtIQ 
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If you're not sure whether you want the package to contain embedded 
data or a link, see "Linking Versus Embedding," page 185. 

Using Object Packager to Customize the Package 
By default, Object Packager uses a standard application icon to represent 
the packaged data. And, as you can see in the preceding two illustrations, 
it describes the data with either the filename or a standard object description. 

To change the icon associated with a package, click the Insert Icon 
button. Object Packager presents the standard Windows change-icon dialog 
box-the same one you see if you use Program Manager's Properties com­
mand and choose Change Icon. For more information about this dialog box, 
see "Changing a Program Item's Icon," page 73. 

To change the descriptive text associated with a package, activate the 
Appearance pane and choose the Edit menu's Label command. Type your 
new text in the dialog box, and then click OK. 

Copying the Pacl<age to the Clipboard 
When the package is all wrapped up and ready to go, it's time to put it on 
the loading dock-which, as usual, is the Windows Clipboard. Pull down 
the Edit menu and choose the Copy Package command (not the Copy 
command). 

Embedding the Package 
The final step is to activate the client application and choose the Paste 
command. (If your client program is Cardfile, be sure to put Cardfile in 
Picture mode first. Cardfile does not accept any kind of embedded data in 
Text mode.) 

After you paste the package, your client document displays the same 
icon and text you saw in Object Packager's Appearance pane. You can now 
play or edit your embedded package. (See "Playing and Editing Embedded 
Packages," page 193.) 
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Embedding a Packaged Command Line 
To embed a packaged command line, follow these steps: 

1. Start Object Packager. (If Object Packager is already running, acti­
vate it and choose the New command from the File menu.) 

2. Choose the Command Line command from the Edit menu. 

3. In the dialog box, type the command line you want to package and 
then click OK. 

The command line can be any legal Windows command line­
such as the name of an executable file or the name of a document 
file. When you embed this command line and play it from your 
client application, Windows behaves as though you entered it at 
the Windows NT command prompt or used Program Manager's File 
Run command. 

4. Customize the package's appearance and descriptive text. (See 
"Using Object Packager to Customize the Package," page 191.) 

You'll probably want to click Insert Icon and choose an icon for 
your packaged command line. 

5. Choose the Copy Package command from the Edit menu. 

6. Activate yo~r client application, move the insertion point to the 
appropriate location, and choose the client application's Paste 
command. 

The illustration on the next page shows a Cardfile card with a com­
mand line embedded as a package. The command line, which is not visible, 
reads c: \ss\ 123r4w\programs\jills. ini. Double-clicking the icon, or the line 
of descriptive text beneath, runs Notepad with the FILLS.INI file. 

Although it would be possible to package the entire file FILLS.INI and 
embed that in Cardfile, there would be no advantage to doing so (and it 
would add unnecessary bulk to the Cardfile file). To get to the INI file 
quickly, an embedded command line is more efficient. 
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II Dl 
file fdit ~iew ~ard .search !!elp 

Card View r<ilJU+J 43 Cards 
Ic:\ss\i~prou\install.ini 

Ic:\ss\i~prou\disklist.ini 
Ic :\ss\123r411J\proQra~s\tools .ini 

Ic:\ss\123r4w\progra~s\1~bsru.ini 
c: \ss\ 123r4\IJ\prograllls\ fills. ini 

£I ",,","" 

FILLS.lNI 
r-

Use this INI file to record cuStOIlI :--
"fill-by-exalllple" fills for 1-2-3 -
Release 4.1 f--

r--
-

Playing and Editing Embedded Packages 
P!ayingan embedded package invokes the source application for the pack­
aged data, allowing you to read the data-or hear it or watch it, as the case 
may be. Editing the package invokes Object Packager, allowing you to 
change the package's appearance or descriptive text. 

More specifically, this is what happens when you playa package: 

EJ If the package contains embedded data that originated in an OLE 
server application, Windows invokes a modified copy of the server 
application, with the data in place. You can then edit your data 
and send changes back to the client document by choosing the 
server application's Update command. 

EJ If the package contains an embedded file that did not originate in 
an OLE server application, Windows invokes a normal copy of the 
source application (the program in which the file was created) with 

193 



194 

PAR T 1: Introducing Windows NT 

a temporary copy of your packaged file. (The application's title bar 
displays a filename beginning with a tilde (-).) If you edit the file 
and use the application's Save command, Windows updates the 
contents of the package but does not change the original disk file. 

e If the package contains a linked file, Windows invokes the source 
application, with the packaged file in place. 

To playa package, you can double-click it in the client application or 
select it and use the client application's Activate Contents (or Play) com­
mand. To edit the package, select it and use the client application's Edit 
Package command. In most OLE client programs, you can get to the Activate 
Contents and Edit Package commands by first choosing an Edit-menu com­
mand called Package Object. Cardfile, for example, produces the following 
cascading menu when you choose Package Object. 

Paste ,S.pecial ... 
!ndex... F6 
Bestore 

custom 
,\-----------1 1-2-3 

Packaging Files-the Direct Route 
If you plan to package an entire file (not a data object), you can bypass 
Object Packager with the following shortcuts: 

e If you want your package to contain an embedded file, you can 
drag the filename from a File Manager window and drop it into 
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your client application. Or you can use File Manager's Copy to 
Clipboard command, and then use your client program's Paste 
command. 

IJ If you want your package to contain a linked file, you can select 
the filename in File Manager, copy the file to the Clipboard, and 
then use your client program's Paste Link command. 

Note that dragging the file from File Manager to your client program 
always creates a package containing an embedded file. 
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Win ows NT 

Two Levels of Networking Support 
Windows NT comes in two variants, a desktop version and Windows NT 
Advanced Server. The desktop version supports peer-to-peer networking 
only, whereas Advanced Server provides enterprise-wide networking. 

The Worl<group 
The workgroup is the nuclear family in a peer-to-peer network. 

Servers and Domains 
In an Advanced Server network, clusters of dedicated servers are organ­
ized into units called domains. 

Monitoring Use of Shared Resources 
Control Panel's Server applet can tell you who's doing what with your 
local resources. 

201 
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206 
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Changing Network SeHings 
Control Panel's Network applet lets you change the hardware and soft­
ware components of your network. 

210 



indows NT was designed from the ground up to be a 
, , networking operating system. In most other networking 

environments, the networking functionality is superimposed on a single­
user-oriented operating system. In Windows NT, networking features are 
fully integrated with every other aspect of the system. 

The networking aspects of Windows NT were designed to meet the 
following goals, among others: 

D Allow Windows NT workstations to coexist peacefully on networks 
with non-Windows machines 

D Allow Windows NT workstations to access non-Windows servers 
(such as servers running Novell NetWare or Microsoft LAN Man­
ager), as well as servers running Windows NT 

D Allow for development of distributed (client-server) applications 

D Allow for easy addition of new software and hardware networking 
components 

Two Leve~s 01 Networ~{ing Suppor~ 
Windows NT comes in two versions-one called simply Windows NT 
(sometimes referred to as the desktop version of Windows NT), the other 
called Windows NT Advanced Server. These two products provide distinct 
levels of networking services. Windows NT supports peer-to-peer network­
ing, a form of connectivity in which all members of the network have 
essentially equal status. Windows NT Advanced Server supports larger net­
works organized around servers and domains. 

Peer-to-peer networks are ideal for small organizations or department­
level units within larger organizations. In a peer-to-peer network, each, 
workstation can share its own resources-file directories, local printers, and 
ClipBook pages-with any other workstation on the network. And each 
workstation, provided it has the appropriate permissions, can make use of 
directories, printers, and ClipBook pages shared by any other workstation 
on the network. In other words, each workstation can act as both server 
and client to any other workstation. 
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Peer-to-peer networks are inexpensive to set up and maintain, because 
they do not require dedicated hardware or dedicated support personnel. 
Their relative informality, moreover, makes them an excellent choice for 
smaller companies that are moving into networked computing for the first 
time. 

Networks built around Windows NT Advanced Server offer many 
advantages of interest to larger organizations: 

C The ability to administer user accounts and permissions centrally 

C The ability to organize a large network into clusters of servers, 
called domains 

C The ability to create domain accounts, so that users can log onto 
any workstation in the domain with the same password 

C Advanced fault-tolerance features, enabling the network to con­
tinue operating even if a critical hardware component goes down 

C The ability to connect with Macintosh computers and LAN Manager 
servers, as well as other Windows workstations 

C The ability to act as a 3270 gateway to IBM minicomputers and 
mainframes (This requires an additional software component, SNA 
Services for Windows NT.) 

Because of its additional complexity, an Advanced Server network 
requires a considerable amount of dedicated hardware, as well as adminis­
trative personnel. 

The Worl<group 
The basic structural unit in a network of users running the desktop version 
of Windows NT is the workgroup. (See diagram on the next page.) A 
workgroup is simply a named collection of networked users functioning as 
peers. It can include computers running Windows for Workgroups as well 
as computers running Windows NT. Within the workgroup, each worksta­
tion is identified by its computer name. This is the name that appears on 
the middle line of the logon screen when you begin a Windows NT session. 
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Running Windows NT 

Running Windows 
for Workgroups 

Sharing Resources 

Running Windows NT 

Post office 
Running Windows NT 

As a member of a workgroup, you can share your own directories, printers, 
and ClipBook pages with anyone else on your network. 

c To share a directory, open File Manager, select the directory, and 
choose the Share As command. (For more information about 
sharing a directory, see "Sharing Directories with Other Users on 
the Network," page 100.) 

t:I To share a printer, open Print Manager by double-clicking its icon 
in Program Manager or by opening Control Panel's Printers applet. 
Then select the window for the printer you want to share, choose 
the Printer menu's Properties command, and select the check box 
labeled "Share this printer on the network." (For more information, 
see "Sharing a Printer," page 227.) 
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c To share a page in your local ClipBook, open ClipBook Viewer, 
make the local ClipBook the active window, select the page you 
want to share, and then choose the File menu's Share command. 
(For more information, see "Sharing Clipboard Data," page 181.) 

Connecting to Shared Resources 
You can also connect to resources shared by other users, provided those 
users have granted permission to your account. 

c To connect to a directory on another user's system, use the Connect 
Network Drive command on File Manager's Disk menu. (For more 
information, see "Connecting to Remote Directories," page 103.) 

c To connect to a printer attached to another user's computer, use 
the Connect to Printer command on Print Manager's Printer menu. 
(For more information, see "Connecting to a Shared Printer," page 
229.) 

c To connect to a page in another user's local ClipBook, use the 
Connect command on ClipBook Viewer's File menu. (For more 
information, see "Connecting to Other Users' ClipBook Pages," 
page 184.) 

In all cases, when you connect to a remote resource, Windows NT 
presents a network browser dialog box. The computer whose resource you 
want to use is identified in this box by its computer name. If you don't see 
the computer or printer name you're looking for, simply type it in the Path 
text box, preceded by two backslashes, like this: 

\ \ computername 

Windows NT then connects immediately, or displays the relevant sec­
tion of the network hierarchy, allowing you to see the names of resources 
that have been shared by this computer. 

Reaching Beyond the Workgroup 
Your network might include more than one workgroup. That is, your com­
puter might be physically connected to workstations that are not part of 
your own workgroup. You can connect to resources shared by workstations 
in other workgroups, but you might not see the names of the computers 
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you're looking for in the network browser dialog boxes. Again, the simplest 
way to find the computer or printer you want is to type its name directly 
into the Path text box, preceded by a pair of backslashes. 

One thing you cannot do with computers belonging to other work­
groups is share Mail messages or Schedule+ information. The versions of 
Mail and Schedule+ shipped with the desktop version of Windows NT 
operate only within a single workgroup. If you're in Workgroup A and want 
to send mail to a user in Workgroup B, you must leave Workgroup A and 
join Workgroup B. And you must have aMaH account on Workgroup B's 
post office. 

Joining a New Worl<group or Changing 
the Name of Your Current Worl<group 
To switch from one workgroup to another, or to change the name of your 
current workgroup, follow these steps: 

1. Start Control Panel and double-click the Network applet. 

A dialog box similar to the following appears. 

, Network Settings 

Computer Name: DENALI 

Workgroup: DOCUMENTATION 

I~:-rl 

If~~TI 

Network Software and Adapter Cards--------, 

Installed Net}!ork Software: 

C.9.mp..\!.\~r .. e.!'QY.:!§.~L .. _____ ,._._ ........... _ ... _ .... ___ . ~ 
NetBEUI Protocol 
NetBIOS Interface 
Novell N E 2000 Adapter Driver 
RPe Name Service Provider 

Installed Adapter Cards: 

Descrip!ion: I Noyell NE2000 Adapter 

lrAdd'fOf~~1 

I 'A'ddAdliiW,,:~:r::1 
1~~~i~At"l 

1f!?JmI!~~n:1 
ltt!ilI.ii.W~\,t,l 

Imnr11W~i:~~~1 

It\7t~:?n 

/[~~,;<\TI 

Inr_(1.7.~~71 

Ir:s::sIDiiV~1 

2. Click the Change button to the right of your current workgroup 
name. 

3. Type the name of the workgroup you want to join (or a new name 
for your current workgroup), and then click OK. 
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Windows NT displays a message welcoming you to the new work­
group. After you close the Network applet, you must shut down your system 
and restart it for your changes to take effect. 

NOTE: You must be logged on as a member of the 
Administrators group to change your workgroup name. For more 
information, see Chapter la, "Users, Passwords, Policies, 
Permissions, and Rights," page 313. 

Changing Your Computer Name 
The Network Settings dialog box, shown in the previous illustration, also 
allows you to change the name associated with your workstation. To switch 
to a different computer name, click the Change button next to your current 
computer name, and supply a new name. 

NOTE: You must be logged on as a member of the 
Administrators group to change your computer name. 

Logging onto a Different 
Computer in Your Worl<group 
User accounts in Windows NT workgroups are local to the computer. 
Therefore, if you want to work at more than one machine in your work­
group, you must have a separate user account for each computer you use. 
A person with administrative privileges on a computer can create a new 
user account with the User Manager program. For information about User 
Manager, see "Creating a User Account," page 323. 

Servers and Domains 
In an Advanced Server netWork, workstations are connected to dedicated 

. servers, and named collections of servers may be grouped into domains. 
(See diagram on the next page.) This method of organization allows for 
centralized network administration and enables Windows NT to serve as an 
enterprise-wide network operating system. 
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Server Server 

If your administrator has created a domain user account for you, you 
can log onto any workstation in your domain. Simply type your user name, 
domain name, and password in the iogon screen, and Winqows NT will 
recognize you and recreate your working environment. 

Sharing Resources 
On a server-oriented network, such as that provided by Windows NT Ad­
vanced Server, shared directories are normally kept on dedicated server 
machines, and shared printers are commonly attached to dedicated print 
servers. There is nothing to prevent you from sharing your own local re­
sources with others, however, exactly as you would on a peer-to-peer 
network. Simply follow the steps described earlier in this chapter to make 
your own directories, printers, or ClipBook pages available to other users. 
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. Trust Relationships Between Domains 
Windows NT Advanced Server allows users in separate domains to share 
resources with one another by means of trnst relationships. (See diagram 
below.) If Domain A and Domain B have established a complete trust with 
one another, a user in Domain A may log onto any server in Domain Band 
access that server's resources. Similarly, a user in Domain B may use re­
sources stored on any of Domain A's servers. 
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A trust relationship may be either bidirectional or unidirectional. In a 
bidirectional trust, a user in either domain has access to the other domain. 
In a unidirectional trust, selVers in the trusting domain are available to users 
in the trusted domain, but not vice versa. 

Monitoring Use of Shared Resources 
One of the potential disadvantages of peer-to-peer networking is that your 
own computer might have to do double duty-as a workstation for you and 
as a selVer for your workgroup-mates. If many users happen to be accessing 
files on your system at the same time, you might experience significant 
performance degradation. At such times, you might find it helpful to know 
who's doing what with your shared resources. Control Panel's SelVer applet, 
shown below, can provide this information. 

Server 

Usage Summary 

Sessions: 3 Open Files: 

File Locks: 0 Open Named Pipes: 

8 

o 

1f:l'~~\'O:K:);:1 

Iprc"8ri~i:~'1 

I~"'W""""~I L--______________ ----I f;',,:; elp;t;,\\ 

Q.escription: 

The SelVer applet's initial screen, depicted here, tells you how many 
users (sessions) are currently accessing your system and how many files 
they have opened. The buttons along the bottom of the window provide 
additional details. 

For more information about monitoring resource use, see "Monitoring 
System Use with SelVer," page 728. 

,.' , ~-~':",' 
I 
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Changing Network Settings 
If you are logged pn as a member of the Administrators group, you can use 
Control Panel's Network applet to change the hardware and software com­
ponents of your network. When you double-click the Network icon, you'll 
see a display similar to the one shown on page 205. 

To add a new software component, such as a new transport protocol, 
to your network, click the Add Software button. To add a new network 
adapter, click Add Adapter. To configure an already-installed element of 
your network software, double-click its name in the Installed Network 
Software list, or select the name and click the Configure button. 
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Introducing Print Manager 
Print Manager is a one-stop shop for everything related to printing. Use 
itto install new printers, change printer priorities, connect to print queues, 
share printers with other users, and more. 

Creating a New Logical Printer 
A logical printer is a group of settings applied to some physical printing 
device. You can create many logical printers for the same physical ma­
chine, each to accommodate different printing needs. 

Changing a Printer's Properties 
The Properties command lets you inspect and change a logical printer's 
settings. 

Creating Custom Forms for Your Print Server 
A form is a named combination of margin and paper-size settings. The 
most commonly used forms are supplied by your printer driver. You can 
supplement these with forms of your own. 

Connecting to a Shared Printer 
The Connect to Printer command puts you on. Jine with the network 
printer of your choice. 

7J 
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Managing Documents in a· Print Queue 
If you have permission, you can change the priority of any print job in 
the queue. 

Setting Permissions for Printers 
The Windows NT security system provides for four levels of printing 
permissions. If you have Full Control for a printer, you can modify the 
access levels for other users. 
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hen it comes to translating your work from the computer 
. screen to the printed page, Windows NT provides an 

unprecedented wealth of support. The operating system's printing features 
let you (or your system administrator) do the following things, among others: 

[l Print in the background to any local or shared network printer 

.tI Examine the print queues for any local or shared network printer, 
so that you can choose the printer that's likely to get your job done 
soonest 

c Control the position of documents in print queues, or remove 
documents from queues 

c Bypass the print spooler and print directly to a hardware port if 
the need arises 

C Create multiple logical printers for any physical output device, 
assigning different characteristics to each logical printer 

c Assign priority levels to various logical printers, in effect creating 
high- and low-priority variants of the same physical output device 

c Specify a range of operating hours for any logical printer, so that, 
for example, low-priority work or especially time-consuming jobs 
can be held until off-peak hours . 

c Create printer pools-groups of physical output devices repre­
sented by a single logical printer 

c Assign different groups of users different privilege levels for 
particular logical printers 

c Create custom separatorpagesthat are automatically printed before 
each print job to identify the originator of the printed document, 
the date and time the document was printed, and various other 
significant details 

c Use separator pages supplied by Windows NT to switch a PCLI 
PostScript printer from one page-description language to the other 

c Create custom forms to do such things as allow extra top margins 
for letterheads 

In this chapter, we'll explore these and other features. 
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Introducing Print Manager 
Print Manager is a multipurpose program that lets you create and configure 
logical printers, share printers with other network users, connect to shared 
network printers, inspect and manage print queues, and administer printers 
across the network. Its visual design, as shown below, somewhat resembles 
those of File Manager and ClipBook Viewer. 

Resume 
Pause 

Connect 
Remove printer 

Printer properties 

Each printer attached to your own computer and each network printer 
with which you've connected is represented by a separate window. Inside 
each printer window, Print Manager displays the printer's current queue of 
print jobs. Menu commands allow you to create and modify logical printers, 
manage documents in the current printer's queue, set options for Print 
Manager's own display and behavior, assign different permission levels for 
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the current printer to various groups of users, and switch between printer 
windows. Below the menu bar is a toolbar that provides quick mouse access 
to commonly used menu commands. 

MOUSE TIP: To change the width of any column in a 
printer window, move your mouse pointer to the right side I·. 
of the column heading. The pointer will change to a two­
headed arrow. Now drag the column divider to the left or 
right. I; 

WARNING: It's possible to drag a column divider all the way to 
the left so that the column disappears completely. If this fate 
befalls you, you can recover in either of two ways: 

You can deselect the Save Settings on Exit command (on the 
Options menu), close Print Manager, and then restart it. Print 
Manager discards your changes when it closes, and restores the 
previously saved window layout when it restarts. 

By carefully maneuvering the mouse pointer, you can grab the 
column divider for the miSSing column. Point at the column 
divider and move the mouse to the right. When the mouse 
pOinter changes from the two-headed arrow back to a normal 
arrow pointer, move slightly to the left-just until the pointer 
again becomes a two-headed arrow. Now you can drag the 
column divider to the width you want. 

Changing the Default Printer 
The default printer is the printer to which your output will be sent unless 
you specify otherwise. Most applications make it easy to route output to a 
non-default printer. Typically, you'll find a command such as Print Setup or 
Choose Printer on your application's File menu. To change the default itself, 
use the drop-down list at the right side of Print Manager's toolbar. 
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WINDOWS TIP: In earlier versions of Windows, a Con­
trol Panel applet is used for installing and configuring 
printers, whereas Print Manager is used for managing print 
queues. These functions have been merged in the Win­
dows NT Print Manager. For familiarity's sake, Control 
Panel still includes a Printers icon, but double-clicking that 
icon simply invokes Print Manager. 

Setting Print Manager Options 
Print Manager's Options menu is short and to the point. You can use it to 
suppress display of the toolbar or the status line (the line at the bottom of 
the screen). And you can use its Save Settings on Exit command to ensure 
that whatever arrangement of windows you have at quitting time appears 
at the start of your next session. If you want to see a particular window 
setu p each time you use Print Manager and you don't want to restore that 
setup manually at the end of a session, do the following: 

1. Set up your windows in your preferred arrangement. 

2. With the Save Settings on Exit command checked, quit Print Man­
ager. 

3. Restart Print Manager and deselect the Save Settings on Exit com­
mand. 

Creating a New logical Printer 
A logical printer is a constellation of settings applied to a particular output 
device or pool of output devices. These settings ~ay include the following: 

D The name of the printer 

D The printer driver-a software component that enables Windows 
NT to translate output into the language used by your physical 
printer 
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c Various driver-specific options, including which paper tray to use, 

the name of the form assigned to that tray, the amount of memory 
internal to the printer, any font cartridges or soft fonts in use, and 
so on 

c An optional description that will appear in the browser box when 
network users connect to the printer 

c The physical port or ports to which output should be sent 

c A share name and location description (if the printer is to be shared) 
that will appear in the network browser box 

c The printer's hours of availability 

c The name of a separator file, if one is to be used 

IJ A priority number for the printer 

c Certain other defaults, such as portrait or landscape orientation 

IJ The length of time Print Manager should wait before notifying you 
in case of an error 

WINDOWS TIP: When creating logical printers, think of 
how your physical printer will typically be used. For 
example, you will probably have both rush jobs and 
low-priority jobs to print. You can increase the efficiency 
of your printing setup by creating separate logical printers 
for the high- and low-priority work. If you also have certain 
jobs that are particularly time consuming and never need 
to be seen until the following morning, create a separate 
logical printer for those jobs and restrict the printer's 
availability to the hours between your office's closing and 
opening times. 

NOTE: To create a logical printer on a Windows NT workstation, 
you need to be logged on as a member of the Administrators or 
Power Users group for that workstation. To create a logical 
printer on a Windows NT Advanced Server, you must be logged 
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on as a member of the Administrators, Server Operators, or Print 
Operators group. For more information about these groups, see 
"Groups," page 317. 

NOTE: You need to create a logical printer only when you are 
installing a printer that is attached directly to your computer or 
to the network. If you want to print to a printer that is already 
shared on the network (that is, one that is attached to another 
workstation), add it to the list of printers in Print Manager by 
connecting to it. For more information, see "Connecting to a 
Shared Printer," page 229. 

When you choose a printer by using an application's Print Setup (or 
equivalent) command, or when you select the default printer in the drop­
down list at the right side of Print Manager's toolbar, each logical printer 
you have created appears as a separate device, even though two or more 
may be attached to the same output machine. 

To create a logical printer, start by choosing the Create Printer com­
mand on Print Manager's Printer menu. You'll see a dialog box similar to 
the following. 

Printer Harne: L-I __________ ...... 

.Q.river: IAdobe LaserJet II Cartridge v52.3 

D !!scription: 

o ,[hare this printer on the network ----...., 

S hi!re Name: I 
~==================~ 

1.0cation: 



Chapter 7: Printing 

On the top line of this dialog box, supply a name for the printer. The 
name you choose can have as many as 32 characters and will appear in the 
network browser box when other users connect to this printer (if you share 
the printer). 

Choosing a Printer Driver 
A printer driver is a software component that enables Windows NT to 
convert a generic description of your output into machine-specific language. 
The driver also tells your applications which built-in and downloaded fonts 
are present, and which additional options are available on your printer. This 
information enables your application (if it's a WYSIWYG application) to 
display your document in a form that closely resembles the ultimate printed 
appearance, as well as to offer you a meaningful set of formatting options. 

To choose a printer driver, click the downward arrow at the right side 
of the Driver line, and choose from the drop-down list that unfolds. If the 
driver you choose doesn't already reside on your local hard disk, Print 
Manager prompts you for a media source-a distribution diskette, CD-ROM, 
or network drive. 

What to Do If Windows NT Doesn't Support Your Printer 
As you'll see by scrolling through the driver list, Windows NT supports a 
large number of printers. If yours is not on the list, however, you might be 
able to obtain a Windows NT driver from your printer vendor. If you have 
such a driver, choose Other (the last item in the driver list) and follow the 
prompt to direct Print Manager to the diskette or directory where your 
vendor's driver can be found. 

If Windows NT doesn't support your printer, and your vendor can't 
supply you with a driver, check your printer documentation to see if the 
printer can emulate a supported printer. For example, if you have an un­
supported dot-matrix printer that includes an IBM Proprinter-emulation 
mode, set up the printer to operate in that mode and install the IBM Pro­
printer driver. 

NOTE: You must use a printer driver designed for Windows NT. 

Windows 3.1 and Windows for Workgroups drivers will not work 
correctly under Windows NT. 
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WINDOWS TIP: Printer vendors often update their print­
er drivers. To get the maximum functionality from your 
printer, be sure you're using the latest version of the driver. 
To update the driver for a printer you've already installed, 
select the printer's window in Print Manager and choose 
the Properties command. To find out about driver avail­
ability, contact your printer vendor or Microsoft Product 
Support Services. 

Determining Which Workstations Need a Printer Driver 
In most cases, if all users of a given printer will be at Windows NT work­
stations, only one copy of the driver needs to be installed. This copy resides 
on the hard disk of the print sewer-the computer to which the physical 
printer is attached. The driver is then copied across the network to particular 
applications as needed. 

For example, suppose you begin a session in Microsoft Word for 
Windows, and your default printer is attached to a remote print server. Word 
for Windows requests a copy of the driver and stores it in your own ma­
chine's random access memory for the duration of your session-or until 
you change the default printer. Word needs the copy of the driver to deter­
mine which formatting options it should present and to initiate the printing 
process. But it does not require a stored copy on the local hard disk. 

However, x86-based systems and systems that use RISC processors 
require different printer driver versions. Therefore, if your print server is 
x86-based and one or more of your client workstations is RISC-based (or 
vice versa), you need multiple copies of your printer driver. You can store 
the alternative versions of the driver on either the print server or the client 
machine. 

Also, if you plan to access network printers from non-Windows NT 
workstations, those workstations need their own locally stored printer driver 
versions. For example, if a Windows for Workgroups user needs access to 
a Hewlett-Packard LaserJet attached to a Windows NT print server, a copy 
of the appropriate Windows for Workgroups LaserJet driver must be installed 
on the Windows for Workgroups computer. 
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Specifying a Port for Your Printer 
Before your logical printer can print, you must direct it to an output port 
connected to your physical printer. You do this on the Print to line in the 
Create Printer dialog box. You can either type the name of a port or select 
from the drop-down list. 

The following kinds of ports appear in the drop-down list: 

c LPTn: 

c COMn: 

c FILE: 

c Remote print-share names 

c Network printer addresses 

LPTl: through LPT3: represent parallel ports numbers one through 
three on the local computer. COMl: through COM4: represent the local 
computer's first four serial ports. If you choose a serial port, you can use 
the Settings button to specify communications parameters for the port. 

You can add more serial ports by using the Ports applet in Control 
Panel. For more information about serial port setup, see "Configuring Serial 
Ports," page 140. 

Printing to a Disk File 
To send your output to a disk file, choose FILE: as your print destination. 
Windows NT will prompt for a filename when you print. You can copy the 
resulting disk file to a physical printer at a later time by using the command 
prompt. For example, if you have a physical printer attached to LPTl:, you 
can copy a print file to that printer by typing the following at the command 
prompt: 

C:\)copy filename lptl: 

The print-to-file option is also useful.if the machine on which you 
ultimately intend to print is not attached to your network-for example, if 
you plan to use a service bureau to generate high-resolution PostScript 
output. For more information about using the command prompt, see Chap­
ter 18, "Working from the Command PrQmpt," page 573. 
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The Remote Print Share Options 
If all your print selVers are machines running Windows NT or Windows NT 
Advanced SelVer, there is no value in choosing a remote print share in the 
Print to drop-down list. Doing so simply creates a redundant entry in your 
network printer browser boxes. (To print to a remote printer, use Print 
Manager's Connect to Printer command; for more information, see "Con­
necting to a Shared Printer," page 229.) You may, however, want to connect 
to a remote print share if the device in question is shared by a non-Windows 
NT computer. 

Printing to a Networl<-Interface Printer 
A network-interface printer is one that interfaces with the network by means 
of its own network adapter card, rather than via a print selVer's printer port. 
Because a network-interface printer is seen by the network as simply an­
other network workstation, rather than as a particular workstation's periph­
eral device, the network-interface printer does not have to be physically 
adjacent to a print selVer. The Hewlett-Packard LaserJet Illsi is an example 
of a network-interface printer. 

To print to a network-interface printer, you must have the Data Link 
Control protocol installed. This protocol is supplied with Windows NT. If 
it's not already installed, you can install it as follows: 

1. Run Control Panel and double-click the Network icon. 

2. Click the Add Software button. 

3. Select DLC Protocol and click Continue. 

4. Insert the appropriate distribution diskette in a floppy drive, or 
specify a CD-ROM or network directory where Windows NT can 
find the DLC files. 

5. Follow the prompt to restart your computer. 

After you have the DLC protocol installed, run a self-test on the physical 
printer to determine its network address. Then choose Network Printer in 
the Print to drop-down list and specify the appropriate network address. 

Printing Directly to a Port 
By default, Windows NT creates a spool file for your print job, and then 
feeds the spool file to the physical printer in the background while you go 
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on with other tasks. That's usually a great benefit; because it lets you get 
back to work before the job is printed and it lets you control the priority of 
the print job. 

At times, however, you might want to bypass the print spooler and 
send your job directly to the printer. You can do this by following these 
steps: 

1 . Click Details in the Create Printer dialog box. 

2. Select the Print Directly to Ports check box in the Printer Details 
dialog box. 

You might get your printout somewhat more quickly by printing di­
rectly to the port, but you will have to wait until the printer has finished the 
job before you can do any other work in the application from which you're 
printing. This option is not available when a printer is shared to ensure that 
two users don't attempt to print Simultaneously. 

Setting the Available Hours 
for Your Logical Printer 
To restrict the available hours for your logical printer, click the Details button 
in the Create Printer dialog box. You'll see a new dialog box similar to the 
following. 

Printer Details - LaserJet IIiP 

Available from: Iii: 00 AM I 10: 112: 00 AM II 
li.eparator File: ..... 1 _______ ---'''If_~:':_\1 

Print to Additional Ports: 
f.riorit}l: 

LPT2: 
LPT3: 
COM1: Print Processor: 
COM2: 

I m:W~'foiF¥IT}:;TI 
1~"§;Cl*m:el~\t~l 

1 ~.u~;::'Y\'::'3~~~.··1 ,,_Q";Qm~ .... J~.~ •.• 

1~~I'lli1li~~~1 

Iwinprint II!] 
COM3: D.!tfault Datatype: ..... IR_AW ____ ..IoioI!l_·~ 

o Print Directly to Ports 
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Click the spinner arrows in the From and To boxes to set the operating 
hours for your printer. As you send work to a time-restricted printer, Print 
Manager stacks the jobs in the printer's queue; it begins feeding them to the 
printer at the appointed starting time. 

NOTE: You can also specify printing hours for individual 
documents in a print queue. For more information, see 
"Changing the Printing Hours for a Particular Document," page 
233. 

Using Separator Pages 
A separator page is like the cover sheet for a fax transmission. It separates 
one print job from the next and can be used to identify the person who 
sent the print job, the time it was sent, and other details. Separator pages 
can also include codes to do such things as switch a printer from the peL 

page-description language to PostScript, or vice versa. 

Windows NT is shipped with three separator files, which you can use 
ready-made or customize. The supplied files are described in Table 7-1. 

All of these files are normally stored in your \ WINNT\ SYSTEM32 
directory. To specify a separator file, click the Details button in the Create 
Printer dialog box. Then either type a name on the Separator File line or 
click the ellipsis button and use the file browser to locate your file. 

PSLANMAN.SEP 

PCL.SEP 

PSCRIPT.SEP 

TABLE 7-1. 

• • 

A separator page for use with PostScript printers. 
Prints the account name and "Microsoft LAN 
Manager" on the separator page. 

A separator page that switches some PostScript 
printers to PCL. 

A blank separator page that switches some PCL 
printers to PostScript. 

Separator pages included with Windows NT. 
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Creating Your Own Separator Pages 
Separator pages are encoded in plain text files with the extension SEP. You 
can create your own separator pages either by modifying the ones supplied 
with Windows NT or by typing codes into a new plain-text document and 
saving that document in your \ WINNT\SYSTEM32 directory. Be sure to use 
Notepad or another plain-text editor to create or modify your SEP files. 

The full set of codes that you can use in your separator pages is listed 
in Table 7-2. Note that each separator file should start with the @ character 
on a line by itself and end with the characters @E. 

@N 

@I 

@D 

@T 

@L 

@Fpathname 

@Hnnn 

@Wnnn 

@B@S 

@B@M 

@u 
@n 

@E 

TABLE 7-2. 

Prints the user name of the person who submitted 
the print job. 

Prints the job number. 

Prints the date, in the date format specified by 
Control Panel's International applet. 

Prints the time, in the time format specified by 
Control Panel's International applet. 

Prints all characters following @L-until the next @ 
code. 

Prints the contents of the file specified by pathname. 

Sends a printer-specific control code. For example, 
@H015 sends the ASCII code 015 to your printer. 

Sets the maximum width of the separator page to 
the decimal value specified by nnn. Any characters 
beyond this width are truncated. (The default width 
is 80; the maximum is 256.) 

Prints in single-width block characters. 

Prints in double-width block characters. 

Turns off block-character printing. 

Skips n lines. (n can be 0 through 9.) 

Ejects the current page from the printer. 

Codes for separator page files. 

225 



226 

PAR T 2: Networking with Windows NT 

Creating a Printer Pool 
You can attach your logical printer to more than one physical device. Doing 
so creates a printer pool. When output is spooled to a printer pool, Print 
Manager uses the first available device in the pool. 

To create a printer pool for your logical printer, do the following: 

1. Connect your printer to an output port via the Print to drop-down 
list. 

2. In the Create Printer dialog box, click the Details button. 

3. In the Printer Details dialog box, select ports in the Print to 
Additional Ports list. 

Your pool comprises the printers attached to each selected port. 

Setting Job Defaults 
Within the Printer Details dialog box, you'll find a button labeled Job De­
faults. Click here to set additional options that indicate the way you normally 
print documents. The available options depend on your printer driver. The 
following illustration shows some of the options offered by the Hewlett­
Packard LaserJet HID. 

Document Properties 

form: 

I Leiter: 3-hole punched 1m 
Orientation ------, 

@ fortrait hopies 

o ,Landscape D 

2. Sided Operation 

o .t!one 

@ (~g:~ii!~~l 
o li.hort side 
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You can, of course, override the job defaults at any time by selecting 

options in your applications' Printer Setup (or equivalent) dialog boxes. 

Setting a Priority Level for Your Logical Printer 
The Priority spinner in the Printer Details dialog box is useful when you 
connect two or more logical printers to the same output device. When 
Windows NT receives requests for the same device from several logical 
printers, it gives first access to the logical printer with the highest priority 
number. 

WINDOWS TIP: If you share a local printer with other 
network users, you can ensure that your own jobs print 
ahead of the network traffic by creating a separate logical 
printer and assigning it a priority number of 99-the 
highest priority. 

NOTE: You can also set priority levels for individual documents in 
a print queue. For more information, see "Changing the Priority 
of a Particular Document," page 232. 

Sharing a Printer 
To make your logical printer available to other users on the network, select 
the Share check box near the bottom of the Create Printer dialog box. 
Windows NT automatically creates an eight-character share name based on 
what you've supplied on the Printer Name line. The eight-character share 
name allows users of MS-DOS and MS-DOS-based versions of Windows to 
access the printer. If you're not concerned about making the printer avail­
able to MS-DOS users, you can specify a longer share name. 

On the bottom line of the dialog box, you have the option of describing 
the location of this printer. Users will see the location in the network browser 
box when they connect to the printer. 
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Changing a Printer's Pro(oerties 
After you have created a printer, you may occasionally need to change some 
of its settings. To do that, simply select the printer window in Print Manager 
and choose the Properties command from the Printer menu. (Or click the 
fifth icon from the left on the tool bar.) 

Setting Driver-Specific Options 
Click the Setup button in the Printer Properties dialog to set options specific 
to your printer driver. In the dialog box that appears, click the Help button 
to get information about the choices available for your driver. 

Creai~ng Custom forms 
for Your Print Server 

A form is a named combination of margin and paper-size settings. Windows 
NT comes supplied with a number of standard forms. To see ~he names of these 
forms and assign particular forms to particular paper trays, select the printer 
window for the printer whose forms you want to manage, choose the Printer 
menu's Properties command, and then click the Setup button. 

You can also create your own custom forms, as follows: 

1. Choose the Printer menu's Forms command. 

2. Enter a name for your custom form on the Name line. 

3. Select either metric or English units. 

4. Enter the margin and paper-size settings for your new form. 

Form definitions are stored on the print server and are available to any 
printer attached to that server. 
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Connecting io a Shared Printer 
To connect to a shared printer, choose the Connect to Printer command 
from Print Manager's Print menu, or click the third icon from the left on the 
toolbar. Print Manager presents the network browser box, shown in the 
following illustration. Double-click the name of a printer, or type the com­
plete network path of a shared printer on the Printer line. 

f.rinter: !\\yOSEMITE\LaserJet 111 

Shared Printers: 

~ Microsoft Windows Network 
~.ADMINI5TRATION 
~"Vfl 

Connect to Printer 

1CJ!f:::7:' 
Irc-'~I 

t8l [xpand by Default Ii !Ie1P~1 

~ \\yOSEMITE\LaserJetlll PostScript HP LaserJetll1 PostScript Plus v2010. Chris's office 
+~ SEQUOIA 
+!J, YOSEMITE 
~ DOCUMENTATION 
!!J TECHSUPPORT 

Printerlnformation----------------. 
Description: HP LaserJet 111 on LPT1: 
Status: Ready Documents Waiting: 

Note that when you select a printer in the network hierarchy, Print 
Manager shows the status of that printer (whether it's printing, paused, off 
line, or idle) and the number of jobs currently in its queue. Thus, you can 
use the browser to determine which printers are most likely to handle your 
job quickly. 

WINDOWS TIP: You can also get to the network printer 
browser box from most applications for Windows NT. 
Look for a Printer Setup or equivalent command, and click 
the Network button in the dialog box that appears. In most 
cases, that takes you to the network browser, where you 
can pick the most suitable printer for your job. 

~ ~- .. ' 
...... ':'l 
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Mon101ging Documents 
in a Print Queue 

By opening the window for any logical printer, you can see at a glance 
which jobs are queued up for that printer. And using commands on Print 
Manager's Document menu, you can manipulate the documents in a queue 
in a variety of ways. In particular, you can do the following: 

c Pause and resume the entire queue 

[] Pause and resume individual documents in the queue 

c Restart printing of a document (print it again from the beginning) 

c Change the order of documents in the queue 

c Remove individual documents from the queue 

c Purge the entire queue 

c Change the priority of any document in the queue 

[] Change the printing hours of any document in the queue 

c For any document in the queue, specify who should be notified 
when the document has been printed 

To perform any of these operations, you must have the appropriate 
level of permissions. By default, Windows NT allows you to change the 
properties of documents that you've originated yourself. To make changes 
to other users' documents, you need either Manage Documents or Full 
Control permission. For more information about permissions in Print Man­
ager, see "Setting Permissions for Printers," page 234. 

Pausing and Resuming 
To pause an entire print queue, select the appropriate printer window and 
then be sure that you haven't selected any document in the window. If a 
document is highlighted, press Spacebar or click the document with the 
right mouse button to deselect that document. Finally, click the Pause tool 
(the second icon on the toolbar) or choose the Printer menu's Pause com­
mand. 
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To pause a particular document, select the document and click the 
Pause tool or choose the Pause command. Pausing the current document 
is equivalent to pausing the entire queue, but pausing other documents 
simply allows Print Manager to work around those documents. 

MOUSE TIP: When you point to the Pause tool and click, 
the status line at the bottom of Print Manager tells you 
whether your action is about to pause a particular doc­
ument or the entire print queue. If that's not the action 
you want, move the mouse pointer away from the Pause 
tool before you release the mouse button. 

To resume a paused printer, select the printer window (without select­
ing a document) and choose the Printer menu's Resume command or click 
the first tool on the toolbar. To resume a particular document, select the 
document and choose Resume or click the first tool on the toolbar. 

To pause and resume a printer, you must have Full Control permission 
for that printer. To pause and resume a document owned by someone else, 
you must have Manage Documents or Full Control permission for the current 
printer. 

Restarting a Document 
If you notice that the current document needs to be printed again from the 
beginning-perhaps because it didn't begin at the top of a page or because 
a page got mangled in the printer-you don't need to go back to your 
application and reissue the print command. Simply correct the problem at 
the printer, select the document in the print queue, and choose the Docu­
ment menu's Restart command. 

To restart a document that you don't own, you must have Manage 
Documents or Full Control access. 
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Changing the Order of 
Documents in a Print Queue 
To move a document up or down within a print queue, simply select the 
document and drag it to its new position. To do this with the keyboard, 
select the document and press Ctrl+Up or Ctrl+Down. 

To rearrange the order of a print queue, you must have Full Control 
access for the printer in question. 

, Removing Documents from a Print Queue 
To remove a document from a print queue, select the document and click 
the Remove Document tool-the sixth icon from the left on Print Manager's 
toolbar. Or select the document and choose the Document menu's Remove 
Document command. 

WARNING: Pressing the Del key with a print job selected also 
removes that document from the print queue. Because Print 
Manager provides no Undo command, you should be careful at 
the keyboard when working with print queues. 

To remove a document that you do not own, you must have Manage 
Documents or Full Control access for the current printer. 

Removing All Documents from a Print Queue 
To remove all documents from a print queue, select the window for the 
queue and choose the Printer menu's Purge Printer command. A confirma­
tion prompt protects you from accidental use of this command. 

To purge a printer, you must have Full Control access for that printer. 

Changing the Priority of a Particular Document 
To change the priority of an individual document, select that document and 
choose the Document menu's Details command or click the seventh icon 
from the left on the toolbar. You'll see a dialog box similar to the following. 
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Document Tille: Time$heet Professional: printing Ir"""olC:-'''''':' 
Status: Pages: 1 

Size: 13634 Owner: CariS 

Printed On: LaserJet III 

Printed At: 9:57 AM 

Processor: winprint 

Datatype: RAW 

Use the Priority spinner to modify the document's priority. Jobs with 
a higher priority number print before jobs with lower priority numbers. 
Changing priority for one of your own documents is a way of pushing to 
the front of the line. Without Manage Documents or Full Control access, 
you can't do this by dragging members of the queue. 

To modify the priority of a document you don't own, you must have 
Manage Documents or Full Control access for the current printer. 

Changing the Printing Hours 
for a Particular Document 
To change a document's printing hours, select the document and choose 
the Document menu's Details command or click the seventh icon from the 
left on the toolbar. In the Details window, use the Start Time and Until Time 
spinners to restrict the document to a particular range of hours. 

To change the printing hours for a document you don't own, you must 
have Manage Documents or Full Control access for the current printer. 

Telling Print Manager Whom to Notify 
Print Manager normally notifies the owner of a print job when the job is 
completed by popping up a window over the foreground application. You 
can turn off the notification or stipulate that some other person be notified 
by selecting the document and choosing the Document menu's Details 
command (or its toolbar equivalent). Type the name of the person to notify 
in the Notify box. 

To change the Notify setting for a document you don't own, you must 
have Manage Documents or Full Control access for the current printer. 
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Setting Permissions for Printers 
Normally, all users on a network are allowed access to shared printers, but 
not all users can manage documents in a queue Cother than those they own) 
or modify the properties associated with a printer. You can change the 
permissions assigned to a printer by selecting the printer window and using 
the Security menu's Permissions command. 

You must have Full Control access for a printer to change that printer's 
permissions. For more information about permissions in general, see "An 
Overview of Windows NT Security," page 314. 

Four permission levels are available for printers: No Access, Print, 
Manage Documents, and Full Control. The privileges associated with those 
permission levels are shown in Table 7-3. 

By default, Administrators and Power Users have Full Control on a 
Windows NT workstation. On a Windows NT Advanced Server, Adminis­
trators, Print Operators, and Server Operators have Full Control by default. 
All others have Print access by default. 

No Access Cannot connect to printer or manipulate its 
queue 

Print C Print documents 

D Control properties of owned documents 

D Pause, restart, and remove owned documents 

Manage Documents Everything allowed by Print Permission, plus: 

C Pause, restart, move, and remove queued 
documents 

Full Control Everything allowed by Manage Documents, plus: 

c Share printer 

TABLE 7-3. 

c Change printer properties 

D Remove printer 

c Change printer permissions 

Permission levels for shared printers. 



Mail in a Nutshell 
Mail is a store-and-forward messaging system in which one computer, 
called the mail server, plays post office. 

Signing into Mail for the First Time 
There's a little paperwork to do on your first visit. 

Starting and Ending a Mail Session 
Unlike most applications for Windows, Mail has two distinct Quit com­
mands. 

More About the Inbox and Outbox 
The Inbox is for transmitted mail, both sent and received. The Outbox 
stores messages pending delivery to the post office. 

Creating and Sending Mail 
Press Ctr1+N to open a Send Note window. This is where you can create 
your message. 

Worldng with Address Books 
Mail creates two address books for you, a global list and a personal list. 
If you work off line, you'll need to use your personal address book. 
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Creating Personal Groups 
When you need to send messages to the same group again and again, 
assign a name to the group. 

Reading and Responding to Your Mail 
Press Ctrl+G to get your mail. In addition to reading the incoming mes­
sages, you can print them, save them, delete them, forward them, edit 
them, a,nd reply to them. 

Working with Folders 
Private folders help you organize your own message file. Shared folders 
can serve as a post office bulletin board. 

Finding Messages 
What's lost can be found-using Mail's handy search utility. 

Backing Up and Restoring the Mail File 
Mail puts your entire collection of messages in a single file.' You'd do 
well to back it up regularly. ' 

Worldng Off Line 
You can read and compose messages while you're away. 

Importing, Exporting, and Purging the Mail File 
The Import and Export commands make it easy to transfer mail to your 
portable computer. You can also use the Export command to winnow 
out your message file. 

Changing Your Password 
It's not a bad idea to change your password now and then. 
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indows NT includes a slightly scaled-down version of a 
, separately sold product called Microsoft Mail version 3.2. 

The full-scale product is an enterprise-wide electronic mail (e-mail) program 
that also includes facilities for exchanging messages with public e-mail sys­
tems such as Mel Mail. The version bundled with Windows NT is restricted 
to use within individual workgroups. 

Fortunately, the two versions share an identical user interface. So 
whether you're working with the Windows NT version of Mail or the com­
plete Microsoft Mail, you can use this chapter as a guide to the most impor­
tant features of your mail system. 

Man in a Nutshell 
Mail is a store-and-forward messaging system-somewhat like the postal 
service, except that the mail gets picked up and delivered more often and 
more quickly (and no holidays are observed). When you send a message 
to one colleague or a group of colleagues, that message is first transferred 
across the network from your computer to the hard disk of another computer 
that is designated as the post office. Later-usually, not much later-your 
colleague's computer checks in with the post office and retrieves your mes­
sage, along with any others that happen to be waiting there for him or her. 

By default, each computer running Mail visits the post office every 10 
minutes. With each visit, any outbound messages are dropped off and all 
inbound messages are collected. This happens in the background, of course, 
but if Mail finds messages for you it notifies you by sounding a chime and 
flashing the Mail icon. (If you want, you can use the Mail menu's ,Options 
command to turn off either mode of notification.) 

The 10-minute interval between trips to the post office represents a 
tradeoff. You don't get instantaneous service, but your system doesn't waste 
a lot of energy trotting back and forth to the post office. You can modify 
the default interval to suit your needs, and you can force an immediate 
delivery and pickup at any time. 
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Changing the Delivery Interval 
To change the frequency with which Mail picks up messages: 

1. Choose the Options command from the Mail menu. 

2. Change the number in the Check for New Mail box. 

To Get Immediate Delivery and Pic!<up 
To get immediate postal service, pull down the V iew menu and choose New 
Messages. This command can be used to force an immediate delivery of 
outgoing messages to the post office, whether or not there's any new mail 
waiting for you at the post office. 

WINDOWS TIP: For truly immediate communication, 
you're better off using the telephone. Or, if your recipient 
is already on the phone, try the Chat program, which lets 
you communicate by typing (in effect) directly onto each 
other's screens. For more information about Chat, see 
"Chat," page 569. 

Important Features of Mail 
Mail includes a great many features that make electronic messaging easy 
and convenient: 

C Personal and global address books ensure addressing accuracy . 

. C Outbound messages can be stamped "high priority" to get recipi­
ents' attention, and return receipts can be requested. 

C Messages can include embedded data or have attached binary files. 
This means you can send formatted documents such as spread­
sheets as easily as you can send text. 

C Both received and sent mail can be organized into folders and 
subfolders, and folders can be either private or shared. 

C A search command makes it easy to locate a message in any folder. 
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D Messages are stored on disk in a compressed format to conserVe 

space. 

D An "offline" mode lets you read and compose messages while 
you're not connected to your network. Thus you can easily create 
mail on the road, and then send the mail as soon as you return to 
the office. 

D Import and export commands facilitate the transfer of message 
folders between your desktop and portable computers. 

D By adding date criteria to your export and import commands, you 
can purge your message file of messages you no longer need. 

D Mail provides "hooks" that other applications can use. For example, 
Schedule+ uses Mail to send meeting queries and notifications to 
other users on your network. For more information about Sched­
ule+, see Chapter 9, "Using Schedule+," page 273. You can also 
create custom message forms (for example, "while-you-were-out" 
forms for phone messages, or forms for recording customer queries 
or complaints) that can be sent to the appropriate persons with the 
help of Mail's transport services. 

We'll look at most of these features in this chapter. 

Signing into Mail ior the fi~st Time 
Before you can use Mail, there must be a post office on your network and 
you must have an account at that post office. The account is akin to a box 
at a traditional post office, except that you use a password instead of a key 
to open it. 

We'll assume that a system administrator or someone else responsible 
for the mail system on your network has already set up a post office. That 
person might also have created an account for you. But if that isn't the case, 
you can easily create one for yourself. In any event, the first time you. use 
Mail, you must do the following: 

1. Find out from your administrator or other responsible person what 
the network path to the post office is. 

2. Double-click the Mail icon in Program Manager. 
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3. In the Welcome screen that appears, select Connect to an existing 
post office. 

4. In the dialog box that appears next, type the network path of your 
post office and click OK. 

5. In the next dialog box, answer Yes if you already have an account. 
Then type your password. If you don't have an account yet; answer 
No and follow the steps described below to create your account. 

After your account is in place and your own copy of Mail knows where 
its post office is, the sign-in process is simpler. (For more information, see 
"Starting and Ending a Mail Session," page 241.) 

Creating Your Mail Account 
To create a mail account, answer No in step 5, above. You'll see the following 
dialog box. 

Fill out the dialog box as follows: 

1. In the Name field, type your name as you want it to appear in the 
system address book. You can type up to 30 characters. The name 
you type will appear in the global address book that's made available 
to each user in your mail system. Users address mail to you by typing 
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this name or (more commonly) pointing to the name in their address 
books. The default for the Name field is the user name you entered 
when you installed Windows NT. 

2. In the Mailbox field, type" a short version of your name-or an alias 
if you prefer. The limit is 10 characters. Mail uses this version of 
your name internally to identify your mailbox, and you use it to sign 
into Mail. 

3. In the Password field, type a password of no more than 8 characters. 
You can use your Windows NT logon password if you want, or you 
can choose a different one. (Unlike your Windows NT password, 
however, the Mail password is not case-sensitive.) 

4. Fill out the remaining fields or leave them blank, as you choose. 
These fields are optional. The information you enter here appears 
in other users' global address books. 

5. Click OK. 

SiOlwiirng and lEnding a Mail Session 
To start a Mail session after you set up your account, double-click the Mail 
ico~ in Program Manager. You'll see a simple sign-in screen in which you 
are asked to enter your mailbox name and your password. Mter you click 
OK, Mail opens a channel to the post office and presents its application 
window, shown in the illustration on the next page. (If Mail can't find the 
computer on which your post office is located, it asks if you want to work 
off line. For more information, see "Working Off Line," page 267.) 

As you can see, Mail's initial display presents the usual menu bar and 
toolbar, plus two iconized windows, called Inbox and Outbox. Clicking 
either icon opens the associated window. We'll look at these windows in a 
moment. 

Unlike most other applications for Windows, Mail has two distinct 
quitting commands. One is called Exit; the other is called Exit and Sign Out. 
If you exit with Exit, the mail transport service is still available to other 
applications (such as Schedule+) that rely on this service. If you choose Exit 
and Sign Out, the entire mail apparatus shuts down. 
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If you use Schedule+ or another Mail-dependent application, you 
might want to quit with Exit, rather than Exit and Sign Out. If you don't sign 
out, however, Mail does not ask for your password the next time you 
double-click the Mail icon in Program Manager. That means someone else 
could walk up to your computer and read your mail. To ensure privacy 
when you're away from your machine, use Exit and Sign Out. 

Double-clicking the Control-menu box or pressing AIt+F4 performs a 
simple exit-not a full exit and sign out. 

WINDOWS TIP: If you add your mailbox name to the 
command line with which you start Mail, you won't need 
to type it when you sign in. To add this information, hold 
down the AIt key and double-click the Mail icon in 
Program Manager. Then, after MSMAIL32.EXE, type a 
space followed by your mailbox name. If you're not 
concerned about privacy, you can add another space 
followed by your password. With both the mailbox name 
and the password on the command line, Mail skips the 
sign-in screen altogether. 
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More About the Inbo){ and Outbox 
The following illustration shows how Mail might look with the Inbox win­
dow opened. 

Folder pane Message pane 

Like a directory window in File Manager, Mail's Inbox window consists 
of two panes. On the left is a folder pane, on the right is a message pane. 
The message pane consists of three columns, labeled From, Subject, and 
Received. You can change the way this window space is distributed as 
follows: 

[J To change the width of either pane, drag the dividing line between 
the panes. 

C To change the width of any column in the message pane, position 
the mouse pointer on the divider line to the right of that column 
heading. When the mouse pointer changes to a two-headed arrow, 
drag the divider line. 
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MOUSE TIP: You can hide a message-pane column by 
dragging its divider line far enough to the left. To restore 
a hidden column, position the mouse pointer on the 
divider line for the column heading to the left of the hidden 
column. Drag that line to the right, and the hidden column 
will reappear. 

Sorting Your Mail 
The column headings in the message pane also serve as sort buttons. To 
sort by any of the three categories-From, Subject, or Received-simply 
click the heading you want to sort by. To reverse the sort order (for example, 
to display the most recent message first instead of last), hold etr! while you 
click the heading. 

The View menu also offers sorting commands, and by pulling down 
this menu you can see how the messages are currently sorted. The sorting 
option in use gets a check mark. 

WINDOWS TIP: You can open multiple copies of your 
inbox window and use different sorting orders in each 
window. To open a second copy of the current window, 
choose the Window menu's New Window command. 

The Inbox Window Stores Transmitted Mail 
We've been calling this window the inbox window, but a more accurate 
name might be "transmitted mail" window. The purpose of this window is 
to store all messages-both sent and received-that have already been 
handled by the post office. 

As you'll note in the figure on page 243, one of the folders in the folder 
pane is itself named Inbox. Your new mail always arrives in this folder. Like 
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the other two folders shown in the figure, Sent Mail and Deleted Mail, the 
Inbox folder is a standard part of your mail system. You can create additional 
folders for organizing your mail, but you can't delete or rename any of these 
three standard folders. 

WINDOWS TIP: Copies of mail that you send are auto­
matically retained for your records in the Sent Mail folder. 
If you don't want these copies, choose the Options com­
mand on the Mail menu and deselect the first check box. 

When Inbox is the active folder, the inbox window's title bar reads 
Inbox and the window's minimized icon looks like a desk tray. If you acti­
vate a different folder (by double-clicking it in the folder pane), the title bar 
changes accordingly, and the minimized icon changes to look like a folder 
instead of a tray. 

KEYBOARD TIP: You can activate the Inbox folder of 
your inbox window at any time by pressing Ctr1+G. 

The Outbox Window Stores Pending Mail 
The purpose of that other window, the one called Outbox, is to store 
pending messages-messages you have composed that are still awaiting 
pickup. If you work off line, your outbox can grow quite large. While you're 
on line, the outbox will probably be empty most of the time, because Mail 
dispatches its contents at regular intervals. 

Unlike the inbox window, the outbox window does not include a 
folder pane. 
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Creating and Sending Mail 
To create a new message, start by pressing Ctrl+N or clicking the Compose 
icon, the first icon on Mail's toolbar. Mail presents a Send Note window, 
which looks like this: 

In the top portion of this window, you enter the names of your ad­
dressees, the names of those to whom you want a courtesy copy sent, and 
a subject heading for your message. The large space at the bottom of the 
window is where you type your message. 

Addressing a Message 
You can include as many names as you please on both the To and Cc lines. 
One easy way to supply this information is by picking names from an 
address book. To do this, start by clicking the Address button at the top of 
the Send Note window. Mail responds by displaying the Postoffice List-a 
list of all mailboxes at your post office. A sample Postoffice List is shown in 
the following illustration. 
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Address 
r .' ',' DireCtory. POllloffice'LiiC' 

i ~ .ca91rolymn~Clamrk----.--.:+ii 
t" ~ Cheryl Kubiak 
" 1.!!!!.l Chris Wood 
\,~ Conference Room 
~ Craig Stinson jlfE51 David Calder 
,~ Eric Lee 

Gary Damron 
Jim Law 

The Postoffice List is one of two standard address books created for 
you by Mail. The other is your personal address book. Depending on the 
complexity of your company's mail system, you might have additional global 
address books as well. 

The Postoffice List includes everyone with an account at your post 
office. Your personal address book can include any subset of the Postoffice 
List-or all members of the Postoffice List, if you prefer. For more informa­
tion about creating and using address books, see "Working with Address 
Books," page 253. 

WINDOWS TIP: Global address books, such as the Post­
office List, are stored at your post office and are available 
only when you're working on line. Your personal address 
book is stored on your own computer and is always 
available. If you plan to compose mail off line, be sure that 
your personal address book includes all the addresses 
you're likely to need. 
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To add a name from the Postoffice List to the To line of your message, 
select the name and click the To button. To add a name to the Cc line, select 
it and click Cc. To put multiple names on either line, hold down the Ctrl 
key while you select each name, and then click To or Cc. Or you can simply 
select the first name, click the button, select the second, click the button 
again, and so on. Perhaps the easiest way to add names is to select them 
and then drag them to the To box or the Cc box. Mail separates the names 
on each address line with semicolons. 

Addressing a Message by Hand 
You can also address a message by typing the names of your recipients in 
the Send Note window's To and Cc boxes, using semicolons to separate 
multiple recipients. If you're not sure how an addressee's name is spelled, 
simply type a portion of the name. When you finish your message and click 
Send, Mail checks your address lines against all available address books. If 
what you've typed is sufficient to uniquely identify your addressees, Mail 
finishes the typing for you. If not, Mail presents a list of candidate addressees 
and lets you choose with your mouse. 

WINDOWS TIP: You can also use the Check Names but­
ton to fill out an addressee's name before you send your 
message. Type a portion of the name, and then click Check 
N ames or press Alt+ K. 

WINDOWS TIP: If you frequently send messages to the 
same group of recipients, you might want to define those 
recipients as a "personal group." Then you can simply 
select the group name from your personal address book. 
For more information about personal groups, see "Creating 
Personal Groups," page 256. 



Chapter 8: Using Mail 

Return Receipts and Priority Levels 
To request a return receipt or set a priority level for your message, click the 
Options button in the Send Note window, and then fill out the dialog box 
that appears. If you request a receipt, a confirmation message will arrive in 
your inbox . indicating the time that your recipient read (that is, opened) 
your message. 

Mail lets you assign one of three priority levels to messages-low, 
normal, and high. Normal priority is the default and requires no action on 
your part. You can use high priority to increase the likelihood that your 
recipient will read your note in the near future. Or you can use low priority 
as a courtesy to recipients who receive a large volume of mail. The high­
priority and low-priority messages will be identified as such in your recipi­
ent's inbox (see "Icons Used to Categorize Messages," page 257), allowing 
him or her to attend to more important mail first. 

Creating a Message 
In the bottom portion of the Send Note window, you can type a message 
of any length. Don't worry about putting in carriage returns to break lines; 
Mail does that for you as you reach the right side of the window. Other than 
word wrap, copy, cut, and paste, however, Mail's editing features are limited. 

WINDOWS TIP: Mail ordinarily displays messages­
those you receive as well as those you type-in MS Sans 
Serif, a proportionally spaced sans serif font. You can use 
the View menu's Change Font command to switch the 
entire text of the current message to a monospaced 
typewriter-like font. This alternative font might be 
preferable for messages that contain figures aligned in 
columns. The font you select-proportionally spaced or 
monospaced-becomes part of the message, so that font 
also appears on your recipient's display. 
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Fortunately, Mail easily accepts any kind of data created in other 
applications. For example, you can add graphics to a message as easily as 
text. Simply copy an image from its source application to the Windows NT 
Clipboard, and then paste it into your message. 

Inserting Text from a File 
If you plan to mail a body of text that already exists in another application, 
you can copy it to the Clipboard and paste it into your message. If the text 
is stored on disk, however, you might find it easier to use the Edit menu's 
Insert from File command. When you choose this command, Mail presents 
a file-browser dialog box. Select the file you want and click OK. 

The Insert from File command is designed for plain text only. Any 
formatting information is lost when you insert the file into Mail, and nontext 
data appears as illegible characters. You can send nontext information by 
attaching a file, as opposed to inserting it. 

Attaching a File 
To attach a file, click the Attach button at the top of the Send Note window. 
A file-browser dialog box appears, from which you can select as many files 
as you care to attach. Select the first file, click the Attach button, select the 
second, click Attach, and so on. Click the Close button when you are finished 
selecting files. The following figure shows an example of a message with a 
file named PREZ.WAV attached. 

A"'~ 
~;\J 

~ 

MOUSE TIP: You can also attach a file by dragging an 
icon from File Manager into your Send Note window. Or 
you can drag a File Manager icon into Mail's Outbox 
window. Mail then opens a Send Note window for you. 
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A couple of vermin-who shall of course remain nameless, for their own 
safety-have acknowledged having a couple items on the LSP treasure-hunt list. 

ON (I said nameless, not initial-less) sez he has a Dashboard at home. Better 
put it on the signout list bucko. 

And said signout list has been returned to its rightful place in the library. 

1,2tl 

As you can see, the attachment is displayed as an icon, and it appears 
at the point where you perform the attachment. If you've used Object 
Packager, you will recognize that the attachment is an embedded package. 
(For more information about Object Packager, see "Embedding Packages," 
page 187.) The recipient of your message simply double-clicks the package 
to read the attached file (or listen to the sound file, play the video file, or 
whatever the case may be). 

Because the attached file is stored within your recipient's mail file (a 
file with the extension MMF that stores all received mail), you don't need 
to worry that your recipient might already have an identically named file. 
To view or play the attachment, however, your recipient must have a copy 
of the attachment's native application. 

Embedding an Object 
Attachments embed entire files. You can also embed a portion of a file (an 
object), provided that the file originates in a program that supports object 

~':"."., ., 

, 
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linking and embedding as a server. (For more information, see "Making 
Connections with OLE," page 184.) To embed an object, copy the object to 
the Clipboard and paste it into your Mail message. If the data on the 
Clipboard comes from an OLE server application, Mail pastes it as an em­
bedded object. Your recipient will then be able to double-click the object 
to activate it in its native application. 

Sending a Message 
When your message is ready, click the Send button. Mail checks any ad­
dressee names' that it hasn't already confirmed (confirmed names are un­
derlined) and moves your message to the outbox, from which it will travel 
to the post office at the next pickup time. Before it's picked up, you can 
edit it by double-clicking it in the Outbox window. Or you can delete it by 
selecting it in the Outbox window and clicking the Delete button (or press­
ing bel). 

Printing an Outbound Message 
If you like to keep printed records of the mail you send, select the message 
and then choose the File menu's Print command at any time-before you 
send the message, after you send it but before it's picked up (while the 
message is still in the Outbox), or from your Sent Mail folder after the mail 
has been picked up. 

Saving a Message in a Separate Disl( File 
Mail normally keeps all your messages-those you receive and those you 
retain in the Sent Mail folder-in a single compressed file. You can't access 
this file directly. If you want to preserve a message in a separate disk file, 
choose the File menu's Save As command. You can do this while you're 
composing a message or by first selecting the message in a folder. 

Saving an Unfinished Message 
You can save an unfinished message for completion at a later time. Simply 
double-click the Control-menu box in the Send Note window or press' 
Ctrl+F4. Mail asks if you want to save the message. If you answer yes, the 



Chapter 8: Using Mail 

message will be stored in your Inbox folder. When you're ready to continue 
working on it, double-click it there and you'll be back in the Send Note 
window again. 

WINDOWS TIP: Mail won't let you send a message that 
has unconfirmed addressee names. If you're working off 
line and your personal address books don't include an 
addressee you need, press Ctrl+F4 to save the message 'in 
your Inbox. Later, when you're on line, you can access the 
global address book to finish addressing your message. 

WINDOWS TIP: If you periodically send a particular 
message-a monthly report, perhaps-to the same group 
of people, you can create a template. Address your 
message, fill in whatever parts of the message are constant, 
and then press Ctr1+F4. When it comes time to send the 
message, drag it to the outbox, and Mail opens it in a Send 
Note window. Complete the message and click Send. If 
you have several templates, you might want to create a 
separate folder for them. 

Mail automa.tically creates two address books for you-the postoffice List, 
which is a global list of all users with accounts at your post office, and a 
personal list. A typical Postoffice List is shown in the figure on page 247. 
The Postoffice List is stored on the mail server and is available only when 
you work on line. Your personal list is stored on your computer and is 
always available. It can contain any subset of the Postoffice List-or the 
entire list. 

I 

~
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Adding Names to Your Personal Address Bool< 
By default, Mail automatically puts the names of any users to whom you 
send mail in your personal list. (You can disable this feature by choosing 
the Mail menu's Options command and deselecting the third check box.) 
So, in the normal course of events, without any effort on your part, your 
personal address book lists the users with whom you actually exchange 
mail. To add other names to your personal address book, do the following: 

1. Choose the Address Book command on Mail's Mail menu to open 
the Address Book dialog box, shown below. 

Select address book 
(Ctrl+L) 

Open personal 
address book (Ctrl+P) 

Find address (Ctrl+F) 

Add new address 

Cheryl Kubiak 
Chris Wood 
Conference Room 
Cr aig Stinson 
David Calder 
Eric Lee 
Gary Damron 
Jim Law 
Postmaster 
Reggie Watson 
S andy Clements 
Stan DeGulis 
Sterling Wiggins 
Thomas Williams 

Add to personal address book 

2. If Mail does not display the Postoffice List, click the open book icon 
near the upper left corner of the Address Book display. Select Post­
office List from the menu of available address books and click OK. 

3. In the Postoffice List, select the names of the users you want to add 
to your personal address book. 

4. Press Ctrl + A or click the second icon on the button bar at the bottom 
of the dialog box-the button that looks like an index-card file with 
an arrow pointing to it. 
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Seeing Details About an Addressee 
To see all the information recorded at the post office about an addressee, 
select that addressee's name (in any address book) and click the Details 
button. You can do this at any time, including while you're addressing a 
note. 

WINDOWS TIP: If you access the Details window from 
your personal address book, the window includes a space 
for a short comment. You can type whatever you like 
about the addressee here and be assured that your com­
ments will be for your own eyes only. 

Finding an Addressee in an Address Bool{ 
If your address book is large or your memory is frail, it can be a challenge 
to find a particular person in the list. The Name Finder command can help 
you out. To locate a user or group of users, press Ctrl+F or click the icon 
that looks like a magnifying glass, and then f~ll out the Name Finder dialog 
box. 

NOTE: The Name Finder doesn't work like the Search command 
in your word processor. It searches only from the beginning of 
each word in each name. For example, typing ch as your search 
string turns up Chausson, Cherubini, and Chopin, but not Bach, 
Offenbach, or Tchaikovsky. 

SWitching Between Address Books 
To switch from any address book to your personal address book, press 
Ctrl+P or click the icon that looks like an index-card file. To switch to any 
other address book, press etrl + L or click the icon that looks like an open 
book. Then select from the menu of available address books. 
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Creating Personal Groups 
A personal group is a collection of addressees gathered under a single name. 
If you find yourself regularly sending messages to the same group of recipi­
ents, you might want to assemble those recipients into a personal group. 
Addressing your mail to the group saves you the trouble of entering the 
recipients individually and ensures that no intended recipient is inadver­
tently left off the mailing list. 

To create a personal group: 

1. Pull down the Mail menu and choose Personal Groups. 

2. Click the New button, type the name you want to use for your group, 
and click Create. 

Mail presents the Postoffice list if you're working on line or your 
personal address book if you're working off line. 

3. Select the name of the first member of your personal group, and 
then click Add. Repeat this process until your group is complete. 
(Alternatively, you can hold down Ctrl while you select all the 
members of your group, and then click Add.) 

4. When you're finished populating your group, click OK. 

The name of your new group appears in boldface characters in your 
personal address book. To address mail to the group, select the group name 
in the same way you would select the name of any individual in your address 
book. Alternatively, you can type the group name in the To or Cc box. 

Reading and Responding to Your Mail 
Incoming messages always appear in your Inbox folder. To open that folder, 
press Ctrl+G, double-click the word Inbox in your folder pane, or choose 
the Open Inbox command from the View menu. If the inbox window is 
minimized, you'll need to restore or maximize it after opening the Inbox 
folder. 
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KEYBOAR 0 TIP: No, there really isn't any good reason 
for Mail's use of Ctrl+G as a shortcut for Open Inbox. Think 
of it as Get mail. Or Go grab the Mail. Or maybe Gosh, I 
wonder if I have mail. 

Icons Used to Categorize Messages 
In your Inbox folder as well as all other folders, Mail uses the following 
icons to categorize messages: 

(2J Unopened message 

@j Opened message 

~ . Unsent message 

! ~ High-priority message 

.J,.~ Low-priority message 

~ Message with one or more attached files 

Unread messages are also identified by boldface type. 

Reading Messages 
To read a message, double-click its Inbox entry, or select the entry and press 
Enter. When you are finished reading, press Ctrl+F4 or double-click the 
message window's Control-menu box to return to the Inbox. 

If you're reading a group of messages, you can save time by not 
returning to the Inbox between messages. Simply click the Next or Previous 
buttons on the toolbar to move sequentially through the list. 
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Reading or Playing an Attachment 
If your message has an attached file, that attachment will be represented by 
an icon. To view or play the file represented by the icon, double-click it. 
Or select it and choose the Edit menu's Edit Attached File Object command. 

Printing, Saving, and Deleting Messages 
You can print any message from either the Inbox or the message window. 
Simply pull down the File menu and choose Print. The Print command prints 
the selected messages in the active window. 

By default, all messages sent and received are preserved in a single 
compressed-format file, which uses your mailbox name and an MMF exten­
sion as its filename. You do not need to take any action to keep your mail. 
If you want to save a message as a separate file, select the message header 
in the inbox window or display the text of the message. Then choose the 
File menu's Save As command and supply a filename. 

When you save a message this way, Mail appends the extension TXT 
to your file, unless you specify a different extension. If you accept the 
default, you'll be able to double-click the filename in a File Manager window 
and display your message in Notepad. 

To delete a message, select it and click the Delete button (or press the 
Del key). Deleted messages are transferred first to your Deleted mail folder, 
so Mail does not present a confirmation prompt. If you delete a message 
from your Deleted mail folder, the message is gone for good-but you still 
don't get a confirmation prompt. 

By default, your Deleted mail folder is cleaned out whenever you quit 
Mail. If you would rather keep the deleted mail and purge the folder peri­
odically yourself, choose the Mail menu's Options command and deselect 
the check box labeled Empty Deleted Mail folder when exiting. 

Saving an Attachment as a Separate File 
Attachments are normally saved in your MMF file, along with messages. To 
save the attachment separately, select its icon in the message and choose 
the File menu's Save Attachment command. 
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Replying to a Message 
To reply to a message, click either the Reply or ReplyAll button on Mail's 
toolbar and type your reply. If you click Reply, your response goes only to 
the sender. If you click ReplyAlI, everyone named on both the To and Cc 
lines of the original message also receives a copy of your response. 

WINDOWS TIP: When you need to reply to a message 
or take some action based on its content, but you aren't 
ready to do so yet, you'll find it handy to minimize the 
message. Click the message window's minimize button, 
and Mail collapses your message into a distinctive icon and 
displays the subject header beneath the icon. Later, when 
you're finished with the message, you can close the icon 
or drag it to the appropriate folder. 

oJ By default, the text of the original message is included at the end of 
your reply. 

I<EYBOAR D TIP: If you don't have the toolbar displayed, 
you can choose either the Reply or the Reply to All com­
mand from the Mail menu. The keyboard shortcuts for 
Reply and Reply to All are Ctrl+R and Ctrl+A. 

Forwarding a Message 
To forward a message, select it and click the Forward button. Mail presents 
a window almost exactly like the Send Note window. The subject header 
for the original message appears on the Subject line (preceded by the 
abbreviation FW· to indicate a forwarded message) but you can change that 
if you want. You can also add whatever you want to the body of the message 
itself-before it, within it, or after it. 
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KEYBOAR 0 TIP: The keyboard shortcut for Forward is 
Ctrl+F, or you can choose the Forward command from the 
Mail menu. 

Editing Received Mail 
You might occasionally need to edit mail you receive-for example, if you 
want to print a version of a message so that others can read it, while omitting 
or modifying certain details from the message. You can edit a received 
message exactly as you would edit outgoing mail. When you close the 
message window, Mail asks if you want to save your changes. If you reply 
affirmatively, the next time you read the message you'll find an asterisk on 
the From line-to remind you that the message has been edited. 

As you send and receive Mail, your Inbox and Sent Mail folders will soon 
accumulate a sizable volume of messages. To maintain order, you'll want 
to create new folders to organize your messages. You can create as many 
folders as you like, and you can create folders within folders. 

You might want to create separate folders for each 'person with whom 
you regularly exchange mail. Or you can create folders organized by project. 
If you're unsure about how to structure your folders, bear in mind that you 
can copy messages into multiple folders-so it's easy to keep folders organ­
ized by project as well as by person. 

Creating a New Folder 
To create a new folder: 

1. Choose the New Folder command from the File menu. Mail displays 
a simple dialog box. 
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2. Supply a name for the folder, and then click Options. Mail presents 
a more complex dialog box. 

New Folder 

Leve 
o lop Level Folder 
@ Sul!Jolder Of: 

Cl Deleted mail ;f-

II 

Cl Sent mail ~ Cl Templates 

Othef Users Can-------, 
DRead 0 ~rile 0 I!.elele 

J;;.ommenl: 

3. Fill out the Options dialog box and click OK. 

WINDOWS TIP: By default, Mail makes your new folder 
a private subfolder of whatever folder is currently selected. 
If that's what you want, you can skip the Options screen. 

; 
'.; 

i.' 
i. 
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Private Versus Shared Folders 
Private folders are stored on your own computer and are accessible only to 
you. Shared folders are stored on the mail server and can be seen by anyone 
with an account at your post office. Shared folders can be used as a kind 
of post office bulletin board. Private folders are for organizing your own 
messages. 

If you select the Shared button in the New Folder dialog box, the three 
check boxes in the group labeled Other Users Can become available. The 
default settings for these check boxes allow other users to read and write 
messages but not delete them. That means that others can read existing 
messages and add new ones, but only the post' office administrator can 
delete messages in the shared folder. 

NOTE: If you leave the Delete check box unselected, not even 
you will be able to delete the folder. To delete a shared folder, 
the person who created the folder must first choose Folder 
Properties from the File menu and select the Delete check box. 

Accessing Shared Folders 
To see your shared folders, dick the button labeled Private Folders at the 
top of your folder pane (see page 243). This button toggles your inbox 
window between private-folder display and shared-folder display (provided 
you have shared folders). 

Creating Folders Within Folders 
To create a folder within a folder, select Subfolder Of in the New Folder 
options dialog box. Then select the name of the folder in which you want 
to create the subfolder, and dick OK. 

Deleting Folders 
To delete a folder, highlight it in the folder pane and press the Del key. Mail 
warns you that deleting the folder also deletes all of the folder's messages, 
and prompts you for confirmation. 
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Moving and Copying 
Messages Between Folders 
The simplest way to move or copy a message from one folder to another 
is with drag and drop. Follow these steps: 

1. Activate the folder in which the message is currently stored. (See 
"Navigating in the Folder Pane," below.) 

2. In the message pane, select the header for the message you want 
to move. 

3. Be sure the folder to which you want to move the message is visible 
in the folder pane. 

4. To move the message, drag the header and drop it onto the 
appropriate folder name in the folder pane. To copy the message, 
hold down the Ctrl key while you drag and drop. 

If you prefer, you can also select a message header and choose the 
File menu's Move or Copy command. 

MOUSE TIP: To move a group of messages at once, 
select the entire group and then drag and drop. 

Navigating in the Folder Pane 
In the folder pane, the active folder is indicated by an open folder icon. All 
other folders are shown closed. A plus sign next to a folder means that the 
folder can be opened to reveal one or more subfolders; a minus sign means 
that the folder can be collapsed to hide its subfolders. 

Simply highlighting a folder does not make it the active (open) folder. 
To open a folder, double-click its name in the folder pane. Or use the 
direction keys to select the folder name, and then press Enter. 

To open a folder and reveal the names of its subfolders, double-click 
the folder's plus sign. To collapse a folder and hide the names of its sub­
folders, double-click the minus sign. 
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MOUSE TIP: Navigating in the folder pane is like 
navigating in a File Manager directory pane-almost. The 
difference is that to expand an entry in the folder pane, 
you must click the plus sign (clicking the name won't do), 
and you must click only once (a slJbsequent click collapses 
the folder). To expand an entry in a File Manager directory 
pane, you double-click the directory name. 

KEYBOAR 0 TIP: To expand a folder-pane entry with the 
keyboard, select it and press the Plus key. To collapse an 
entry, select it and press the Minus key. 

Finding Messages 
Finding a particular message or group of messages when your inbox con­
tains hundreds or thousands of them can be a challenge. Fortunately, Mail 
includes a handy search utility, called Message Finder. To use th.is tool: 

1. Choose Message Finder from the File menu. Mail presents the 
following screen. 

2. Fill out the top portion of the window with your search criteria. 

," 
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3. Click Where to Look and tell Message Finder whether you want to 
search all folders or a particular folder. Click OK to return to the 
criteria screen. 

4. Click Start. 

Message Finder presents its findings in the lower portion of the win­
dow, as shown in the following illustration. 

9 To: Carl Sie ... Lost Software Patrol 5/25/938:29AM 
k:Ill To: Carl Sie ... Lost Software Patrol: F... 5/25/938:52AM 
9 Chris Wood RE: Lost Software Patrol 5/25/938:45AM 

CJCariS 
CJCariS 
CJChrisW 

The results portion of Message Finder's window displays the names 
of the folders in which the found messages are stored. You can go there 
and read the messages, or you can open them in Message Finder's window. 
To keep the findings handy on your desktop, minimize the window. 

WINDOWS TIP: You can use Message Finder to auto­
matically scan for incoming messages that meet certain 
criteria. For example, you might want to know when a 
message from your boss arrives. To do so, open a Message 
Finder window, type your boss's name on the From line, 
and select Inbox in the Where to Look dialog box. When 
you minimize the Message Finder window, its icon is a 
folder with a magnifying glass. When a new message from 
your boss arrives in your Inbox, the icon changes to show 
an envelope peeking out of the folder. 
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MOUSE TIP: You can forward a found message simply 
by dragging it from Message Finder's window to the Out­
box. Mail presents a Send Note screen, allowing you to 
specify addressees and make any desired comments or 
edits to the message. 

Backing Up and 
Restoring the Mail File 

Mail keeps all your messages, as well as your folder structure, in a single 
file with an MMF filename extension. Because corruption or accidental 
deletion of that file would wipe out your entire collection of messages, it's 
wise to back up that file from time to time. You can use the Windows NT 
tape-backup program (for more information, see Chapter 13, "Backing Up 
and Restoring Files," page 361), or you can use Mail's own Backup com­
mand. To back up from within Mail: 

1. Choose the Backup command from the Mail menu. 

2. Supply the name and path for your backup file. 

If anything happens to your original file, you'll see an error message 
when you start Mail, followed by a file-browser where Mail asks you to 
direct it to your mail file. At that point you can supply the name and path 
of your backup copy. 

If you direct Mail to the backup copy in this manner, Mail asks if you 
want to "convert" the backup file. Converting in this context simply means 
making the backup file your primary mail file. Answer yes if your original 
mail really is lost or corrupt. 
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Under some circumstances, you might want Mail to use the backup 
file temporarily, even when the original file is not missing or damaged. For 
example, if you have deleted messages since you last backed up, it's possible 
to open the backup file to reread those messages. You can do that as follows: 

1. Rename or move your mail message file. Normally the message file 
is stored in your Windows directory, and its filename consists of 
your mail user name and an MMF extension. 

2. Start Mail. 

3. When Mail says it can't find your mail file, direct it to the backup 
copy, but do not convert the file. 

When you open a backup copy without converting it, Mail lets you 
read, print, and delete messages, as well as move and copy them within the 
folder tree. But you won't be allowed to send and receive new messages. 

Working 011 line 
To use Mail when you're not connected to your network, simply start Mail 
in the normal manner. You'll see an error message indicating that the mail 
server (the machine that houses the post office) is unavailable. After you 
acknowledge that message, Mail asks if you want to work off line. Answer 
yes, and you'll be in Mail. 

While working off line, you can't do any of the following: 

tl Access the Postoffice list 

C Send or receive messages 

D Access or create shared folders 

a Change your password 

But you can read messages you've already received, compose replies 
and new messages, print messages, move and copy messages within your 
folder structure, and so on. As soon as you return to the office or reconnect 
to the network, you can disgorge any messages that you've collected in your 
outbox and pick up whatever's waiting for you at the post office. 
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Importing, lExporting, 
and Pu~ging the Mail FUe 

If you take a portable computer on the road and plan to work with your 
mail file off line, you'll need a way to transfer the current mail file from 
your desktop computer to your road machine. The File menu's Export Folder 
and Import Folder commands take care of that need. Use Export Folder to 
transfer one or more folders to a new disk file. Use Import Folder to merge 
those selected folders into the copy of the mail file that you use on your 
traveling computer. 

Both the Export Folder and Import Folder commands let you specify 
a date filter, so you can easily transfer only the most recent messages. 
Because your entire mail file is likely to be quite large, you'll find this option 
particularly handy if your road machine doesn't have a large hard disk. 

WINDOWS TIP: The Export Folder command always ex­
ports a copy of your current personal address book, so 
there is no separate command to export the address book. 

Exporting Messages 
To export messages: 

1. Choose the File menu's Export Folder command. 

2.. Specify a name and path for your export file. 

If the file doesn't exist, Mail asks you to confirm that you want 
to create it. Then you'll see a dialog box similar to the following. 
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Export Folders 

Export File Name: 
C:\EXPORT .MMF 
Folders to Export.------------, 
o All Folders 

@ l:[~.!'~.~I~.~·.·.t~J~~.~.~.~J Messages 

iii CariS 9 D 
LZl CarolynC 
LZl ChrisW 
LZl DavidC 
LZl Deleted mail 
LZl GaryD 
LrJ Inbox 
LrJJimL 
L:3 Projects 

L:J Features 
I!:l MultiD 

13 
14 
1 
o 
3 
o 
3 
3 
o 
o 

l[ltoye····~1 

IF!cOR1tJ 
I f;\Do~" :TI 
IrfiP~;:TI 
I f0"~H.elp!!1 

3. If you want to transfer only certain folders, select those folders . 
. Otherwise, select the All Folders option button. 

To select a group of contiguous folders, select the first member 
of the group and then hold down the Shift key while you select the 
last. To select folders that aren't contiguous, hold down the'Ctrl key 
while you select each desired folder. 

4. If you want to transfer only those messages that fall within a particu­
lar date range, click the Options button and specify the date range. 
Click OK to leave the Options dialog box. 

5. Click Copy to transfer the selected messages to your export file. 

As you can see, this screen also gives you the option of moving 
messages out of your mail file-in effect, purging the file. We'll discuss that 
option in a moment. 
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Importing Messages 
To import messages: 

1. Choose the File menu's Import Folder command. 

2. Specify the path and name for your import file. 

3. Indicate whether you want to import all folders or only particular 
ones. If you want to limit the import to messages created or modified 
within a particular date range, click the Options button and specify 
the dates. 

4. Click Copy to transfer the selected messages. 

Purging the Mail File 
The Export Folder command's second vital function (besides giving you a 
way to take messages on the road) is to provide a way to prune the mail 
file-to purge it of messages you no longer need. You can get rid of 
messages one by one (select the message and press Del) or folder by folder 
(select the folder and press Del). But a simpler and more effective way to 
keep the file trim is to use Export Folder and specify a date range. To get 
rid of all messages received or modified prior to September 1, 1993, for 
example, do the following: 

1. Choose the Export Folder command. 

2. Specify a filename-such as PURG0993.MMF. 

3. Choose All Folders and click the Options button. 

4. In the date spinner labeled To, enter 9/1/93. Then click OK. 

5. Click the Move button. 

Mail removes the specified messages to your export file. For record­
keeping purposes, you can retain this file on your hard disk or transfer it 
to a server or some other medium. 
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Changing Vour Password 
To change your Mail sign-in password, choose the Mail menu's Change 
Password command. You'll be asked to specify your current password and 
the new password, and then to type the new password a second time to 
confirm its spelling. 

Because your password is stored at the post office, you must be 
working on line to change the password. 

If you forget your password, the post office administrator can assign 
a new one for you. 
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Starting and Ending a Schedule+ Session 
If Mail is already running, you can skip the Schedule+ sign-in screen. 
When it's time to quit, you can choose between two commands. 

Changing Your Password 
If an administrator has set up your account and assigned you a password, 
you'll probably want to create your own password to ensure privacy. 

Using Schedule+ Off Line 
While you're away, you can still keep track of tasks and appointments. 

+ 
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Scheduling Appointments with the Appointment Book 281 
Use the appointment book to enter time-specific commitments and notes 
that pertain to particular days. You can designate appointments as definite 
or tentative. 

Scheduling Appointments and Meetings with the Planner 291 
The planner shows a map of your commitments for at least two weeks. 
It can also show when others are busy or free. 

Managing Projects and Tasl{s with the Task List 
The task list can help you keep track of obligations that are not tied to 
specific times of the day. 
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Controlling Others' Access to Your Schedule+ File 
By default, others in your workgroup can see when you're busy and 
when you're free, but they don't get to see the details. You can change 
the viewing privileges for any user or all users. 

Viewing Others' Schedule+ Files 
If you've been granted permission, you can open another user's file and 
read it as though it were your own. 

Printing Your ApPointments and Tasks 
Schedule+ can put your agenda on paper in a variety of attractive formats. 

Exporting and Importing Schedule+ Files 
When you take your schedule on the road, you'll need the Export and 
Import commands. 

Archiving Your Schedule+ File 
Don't let your history eat your hard disk. 
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chedule+ is a calendar-management program with a decidedly 
social orientation. You can use it to keep track of your own 

appointments, projects, and tasks, as well as for planning meetings with 
coworkers. When you need to set up a meeting, you can ask Schedule+ to 
consult your own schedule as well as those of all other prospective attendees 
and find time slots when everyone is free. Then, because Schedule+ is 
designed to work hand-in-hand with Mail, you can send a meeting invitation 
to each attendee via e-mail, and each attendee can send back a note indi­
cating acceptance, regret, or tentative acceptance. 

Additional capabilities of Schedule+ include the following: 

t1 The program can be used both off line and on line. If you're not 
concerned about scheduling group activities or coordinating your 
agenda with those of other workers, you can. set up Schedule+ so 
that it always runs off line. 

t1 Schedule+ is designed to track both time-specific events (appoint­
ments) and general to-do items (tasks). Tasks can be assigned 
priority levels and categorized within project headings. 

t1 Appointments can be either singular or recurring. For example, you 
can schedule a meeting to occur on the third Friday of every month. 

C Schedule+ can automatically remind you of appointments at a 
specified time interval before each appointment. You can use this 
feature for some, all, or none of your appointments. 

t1 The planner in Schedule+ displays your schedule graphically, 
showing committed and uncommitted times as well as times with 
tentative commitments. When planning group activities, you can 
view a merged display showing others' commitments as well as 
your own. 

IJ If your system administrator sets up an account for a resource, such 
as a conference room or a piece of display equipment, Schedule+ 
can track the commitments and availability of that resource, just as 
it tracks people's schedules. 
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e You can make your calendar visible to all others in your work­
group, to certain workgroup members only, or to no one. And 
even if your schedule is visible, you can designate particular 
appointments as "private"-for your eyes only. 

e You can set up Schedule+ so that an assistant manages your 
calendar and all messages concerning meetings are either copied 
to your assistant or sent only to your assistant. 

c Schedule+ can print your calendar in a variety of attractive formats. 

WINDOWS TIP: If you have used earlier versions of Win­
dows, you might notice that the desktop accessory called 
Calendar is not included with Windows NT. It has been 
replaced by Schedule+. If you already have agenda files 
created with Calendar, you can import them into Sched­
ule+. For more information, see "Importing," page 307. 

Star~ing and lEnding 
OJ Scheduls+ Session 

Schedule+ uses your Mail account name to identify your schedule file, and 
it requires you to enter your Mail password when you begin a session. You 
must therefore have a Mail account before you can use Schedule+, even if 
you intend to use the program off line. (For more information about setting 
up a Mail account, see "Signing into Mail for the First Time," page 239.) 

When you launch Schedule+, the program first connects to your mail 
, server. ~f you're working away from the network, you'll see a message 
indicating that the server cannot be found and asking if you want to work 
off line. Answering "yes" begins an offline Schedule+ session. Answering 
"no" terminates the program. 

After the mail server is found or you agree to work off line, you see 
the following sign-in screen. 
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Mail Sign In 

Type your Mail password (not your Windows NT password, unless 
the two happen to be identical) and you're ready to work in Schedule+. 

Ways to Avoid the Sign-In Screen 
You can skip the Schedule+ sign-in screen in either of two ways: 

[] By launching Mail first 

IJ By including your Mail account name and your password in the 
command line used to launch Schedule+ 

Schedule+ and Mail use the same sentry to check your identity and 
password. If either program is running, the other lets you in without asking 
for ID. 

You can automate the Schedule+ logon process in the same way that 
you can with Mail-by adding your mailbox name and password to the 
command line. You can do this as follows: 

1 . Hold down the AIt key and double-click the Schedule+ icon in 
Program Manager. 

2. In the Command Line text box of the Properties dialog box, add a 
space after the word SCHDPL32.EXE. Then type your mailbox name, 
another space, and then your password. 

3. Click OK. 

WARNING: Don't add your mailbox name and password to the 
Schedule+ command line unless you're absolutely unconcerned 
about the privacy of both your mail and your calendar. When 
Schedule+ is running, anyone can start Mail at your machine 
without knowing your password. Throwing away the lock to 
either program makes both accessible to all comers. 
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Quitting Schedule+ 
Like Mail, Schedule+ has two quitting commands. One is Exit, the other is 
Exit and Sign Out. Pressing Alt+ F4 or double-clicking the Control-menu box 
is equivalent to choosing Exit. To exit and sign out, you must use the 
command at the bottom of the File menu. 

Here are some differences between the two commands: 

a If you choose Exit, the visible parts of Schedule+ disappear,. but 
Schedule+ continues to issue reminders for appointments (if you 
have asked for reminders). 

a If you choose Exit, you can get back into Schedule+ directly by 
double-clicking the Schedule+ icon in Program Manager; you won't 
be asked to sign in again. 

D Choosing Exit and Sign Out makes your schedule unavailable to 
other users. If you intend to share your schedule so that others can 
plan group activities with your commitments in mind, you should 
use Exit-not Exit and Sign Out. 

a Choosing Exit and Sign Out closes Mail as well as the entire Sched­
ule+ program. 

In short, it's advisable to stick with the Exit command. Use Exit and 
Sign Out only if you must free up as much memory as possible for use by 
other programs, or if you plan to leave your workstation unattended and 
you're concerned about privacy. 

NOTE: If you start Schedule+ and later use the Exit command to 
quit, the operating system still considers your calendar files to be 
in use. If a system administrator needs to manipulate those files 
with File Manager or commands entered at the Windows NT 
command prompt, you should exit and sign out. 
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Changing Your Password 
If a system administrator has set up your Schedule+ file, you will probably 
want to change the password to ensure your privacy. You can do so as 
follows: 

1. Choose the Options menu's Change Password command. 

2. Type your old password. 

3. Type your new password. 

4. Type your new password again. 

NOTE: It's best to do this while you're working on line. If you're 
off line at the time you change your password, the new 
password will work only for offline sessions and the next time you 
begin an online session, Schedule+ will require the password 
used by your Mail account. 

Using Scheduls+ Oi1line 
If your network's mail server is available when you start Schedule+, the 
program normally connects to the mail server, allowing you to work on 
line. In online mode you can use Schedule+ to arrange meetings with other 
users or to make reservations for shared resources, such as conference 
rooms and display equipment. 

Like Mail, Schedule+ can also be used off line. Here are some circum-
stances under which you might want to work off line: 

D When you aren't concerned with anyone's schedule but your own 

D When your mail server or your network is down for maintenance 

D When you're working away from the office 
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If you truly don't need Schedule+'s group-scheduling features, you 
might find that you get somewhat better performance working off line. Be 
aware, though, that while you are working off line you cannot schedule 
meetings with other users, and others cannot view your schedule. 

While you're working on line, you can switch to offline mode at any 
time by choosing the File menu's Work Offline command. If you want to 
resume working on line, go back to the File menu and choose Work Online. 

To set up Schedule+ so that its normal working mode is offline, do 
the following: 

1 . Choose General Options from the Options menu. 

2. Select the Startup Offline check box. 

You might want to do this if you are working on a portable computer. 
That way you won't have to wait at the beginning of each session while 
Schedule+ attempts in vain to locate your mail server. 

Offline and Online Calendar Files 
Schedule+ maintains two copies of your data. One is stored on your local 
hard disk in a file whose name consists of your mailbox name plus the 
extension CAL. The other is stored on your mail server under a random 
name plus the extension CAL. When other users check your schedule for 
the purpose of arranging meetings, they see data from the server file. When 
you work off line, you use the local file. 

Schedule+ keeps the two files synchronized by merging data whenever 
you begin or end an online session. It also copies data from the server file 
to your local file in the background while you work on line. 

If you do a lot of work off line, you might experience a delay at the 
beginning of your next online session. This is normal and unavoidable. 
Schedule+ must copy all changes from your local file to your server file 
before it can let you begin working on line. 
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Transferring Calendar Files to 
and from a Portable Computer 
Schedule+ provides Import and Export commands that enable you to copy 
your calendar to your laptop when you go on the road, and to merge your 
road work back into your desktop machine when you return. For more 
information about these commands, see "Exporting and Importing Sched­
ule+ Files," page 306. 

Scheduling ApPointments 
with the Appointmeni Book 

A Schedule+ session begins with the appointment book open to today's 
date. The appointment book, shown in the following illustration, is the 
electronic equivalent of a desktop appointment calendar. You can use it to 
enter time-specific commitments or other notes that pertain to particular 
days. 

Appointment Tentative appointment Notes 
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From the appointment book, you can switch to Schedule+'s other two 
views, the planner and the task list, by clicking the tabs that appear along 
the left side of the window: 

c Click Tasks or press Alt+T to get to the task list. 

c Click Planner or press Alt+ P to get to the planner. 

c Click Appts or press Alt+A to return to the appointment book. 

c Click Today or press Alt+Y to return to the appointment book and 
reset the appointment book to today's date. 

For more information about the planner, see "Scheduling Appoint­
ments and Meetings with the Planner," page 291. 

Definite ApPointments, 
Tentative Appointments, and Notes 
The illustration on page 281 shows two types of appointments plus a group 
of notes. The entry for Dr. Pollack, which occupies the 3:00- 4:00 time slot, 
is definite. The lunch date with Ralph, which occupies the 12:00-1:30 time 
slot, is tentative. Schedule+ uses a white background to display definite 
appointments and a gray background for tentative appointments. 

Two symbols appear beside the text for the appointment with Dr. 
Pollack: 

c The ringing bell icon indicates that a reminder has been set for this 
appointment. Schedule+ will beep and display a message box at a 
specified time interval prior to the appointinent time. 

II Reminder for 3:00PM Friday. June 11. 1993 

Dr. Pollack--3299 Hilyard 

o Notify me again in: D I minute[s) I!I 
@ Lti.~:~.~·L~.~:filf.::.~:~::.~·9..~·i.~:;J 
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c The key indicates that this appointment has been designated 
private. Other users looking at this schedule will see the lunch date 
with Ralph but not the doctor's appointment. (For information 
about permitting others to view your appointment book, see 
"Controlling Others' Access to Your Schedule+ File," page 303.) 

The entries in the Notes box are floating reminders for the day, attached 
to no particular time. When Schedule+ is started on this day, these reminders 
appear in a special reminder box, much like the appointment reminder. 

II Daily Reminder for Friday. June 11. 1993 

N.otes for Craig: 

Calls to return: 
EricT 
Gregg K 

Calls to make: 
Sergio M 
DaveK 

Expect to hear from Marjorie re meeting with the rector magnificus 

If you don't want this reminder, choose the Options menu's General 
Options command and deselect the Set Reminders for Notes check box. 

WINDOWS TIP: You can also suppress all reminders 
during a session by choosing the File menu's Turn Off 
Reminders command. 

Overlapping Entries 
If two or more appointments share a common time interval, Schedule+ 
displays them side by side, as the illustration on the next page shows. 

Normally you won't book overlapping appointments. But you might 
want to use the appointment book to indicate which tasks you expect to 
work on at particular times of the day. With Schedule+, you can assign tasks 
to time periods and still schedule appointments within those periods, as the 
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illustration below shows. As we'll see later in this chapter, you can create 
entries such as these directly from Schedule+'s Task List. For more informa­
tion, see "Assigning Tasks to Your Appointment Calendar," page 301. 

Navigating in the Appointment Bool< 
To move between dates in the appointment book, click the calendar in the 
upper right corner of the window. To move to a different month or year, 
use the drop-down lists at the top of the calendar. 

Alternatively, you can go directly to any date by pressing Ctrl+G or by 
choosing the Edit menu's Go To Date command and manipulating the date 
spinner that appears. You can also press Alt and a direction key to move to 
a different day, or Shift+Alt and a direction key to move to a different month. 

I<EYBOAR 0 TIP: If you choose General Options from 
the Options menu and then select the Show Week Num­
bers in the Calendar check box, the Edit menu sprouts a 
new command: Go To Week. You can use its keyboard 
shortcut, Ctrl+W, to move quickly to any week. 
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KEYBOAR D TIP: While the day of the week is high­
lighted in Schedule+'s date spinners, pressing the first letter 
of a weekday takes you to the next occurrence of that 
weekday. You can use this feature to move quickly 
through the calendar by weeks. For example, if the spinner 
is showing Mon 6/21/93, with Mon highlighted, pressing 
M takes you to 6/28/93. Pressing M again goes to 7/5/93-
and so on. 

Entering a New ApPointment 
To enter a new appointment, start by doing one of the following: 

[] Double-click the starting time slot for the appointment. 

[] Type Ctrl + N. 

[] Choose the Appointment menu's New Appointment command. 

Whichever method you use, you'll arrive at a dialog box similar to the 
following. 

Appointment 

[gJ Set Reminderfor!illiminute[s) Iii Beforehand 

o frivate 

NOTE: The Invite button appears only if you are working on line. 
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Type a description (of any length) in the description box, use the 
spinners to set the appointment's date, starting time, and ending time, and 
fill out the remaining check boxes as needed. 

Setting the Starting and Ending Times 
To modify the date and times, you can do any of the following: 

c Click the up or down spinner arrows to modify the date and time 
settings. 

c Click the appropriate element, and then use the Up or Down 
direction keys to adjust the selected number. For example, to 
change the starting time in the figure above from 12 to 1, click the 
number 12 and then press the Up direction key. 

c Tab to the appropriate section of the dialog box, use the Left and 
Right direction keys to select the element you want to change, and 
then use the Up or Down direction keys to adjust the selected 
number. For example, to change the starting date from Mon 
6/14/93 to Wed 7/14/93, press Tab until the starting date section 
is highlighted, press the Right direction key to select the number 
6, and then press the Up direction key to change 6 to 7. 

KEYBOAR D TIP: The Up and Down direction keys 
move time settings by IS-minute intervals. If you want to 
change the time by some other amount, simply type the 
time you want. 

KEYBOARD TIP: You can also create an appointment­
book entry simply by navigating to the appointment's 
starting time and date and pressing Enter. Schedule+ 
blocks out a blank half-hour, public, non-tentative entry 
with your current default reminder settings. An insertion 
point appears inside this entry, allowing you to type a 
description. 
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MOUSE TIP: Manipulating the time spinners is not the 
only way to set the starting and ending times for your 
appointment. You can also change the times by dragging 
the boundaries of the appointment entry after it appears 
in your appointment book. When you drag the lower 
boundary, Schedule+ moves only the ending time. When 
you drag the upper boundary, both the starting and ending 
times are moved. 

Making the Appointment Tentative 
To mark your appointment as tentative, select the Tentative check box. 
Schedule+ displays your appointment on a gray background. Tentative 
appointments do not appear as busy times when other users view your 
schedule. 

Setting a Reminder 
By default, Schedule+ issues a reminder 15 minutes before your appoint­
ment's start time. If you don't want the reminder, deselect the Set Reminder 
check box. If you want to be reminded at some other interval, type the 
appropriate number and select a time unit from the drop-down list. You 
can choose minutes, hours, days, weeks-or months! 

To change the default reminder setting, choose the General Options 
command from the Options menu. 

Using the Planner to Choose a Time 
Suppose you want to set a one-hour appointment but you're not sure when 
you have that much free time. The Planner can help you find the first 
available time slot: 

1. Type Ctrl+N or use some other method to open the Appointment 
Dialog box. 

2. Set the Start and End spinners for a one-hour interval. Don't worry 
about which times you select; just set the interval to one hour. 
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3. Click the Choose Time button. 

Schedule+ displays a small version of the planner, as shown 
below. 

The narrow bars in this window represent times that are already 
booked. The wide bar (shown extending from 8:30 to 9:30 in the 
figure above) represents the time you just entered via the spinners. 
That time is irrelevant for the moment. 

4. If you see a free time slot and want to use it, simply drag your mouse 
across it and click OK. To have Schedule+ automatically pick the 
first available slot of the appropriate duration, click the Auto-Pick 
button. 

The Auto-Pick button chooses only from times that fall within your 
normal work days and working hours, as defined in the General Options 
dialog box. To get to that dialog box, choose General Options from the 
Options menu. 
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Inviting Others to Your Appointment 
To invite others to your appointment, click the Invite button in the Appoint­
ment dialog box. For more information about that option, see "Scheduling 
a Meeting," page 294. 

Entering a New Recurring Appointment 
To create an appointment entry that recurs at some regular interval, start by 
choosing the Appointment menu's New Recurring Appointment command 
(or pressing Ctrl+R). You'll see a dialog box similar to the one shown on 
page 285. As you'll see in the top section of this dialog box, Schedule+ ini­
tially assumes that your appointment is to recur weekly. To choose a dif­
ferent interval, click the Change button, which takes you to this dialog box: 

This Occurs-­
O.!!.aily 

@ [Si.~:~.~i~.l 
o !!i-....... eekly 

o Monthly 

o Yearly 

; ." . 
.lyery ....... eek On: 
o Sun 0 Mon [8J Tue 

o ....... ed D Thu 0 Fri 0 Sat 

The first occuflence will be 6/15/93_ 

Here you can choose from several recurrence patterns, including every 
day, every weekday, every other week, every month on a particular day of 
the month, every month on the nth occurrence of a particular weekday, 
and so on. You can also use the spinners at the bottom of the dialog box 
to set a starting date and ending date for your recurrence pattern. 

WINDOWS TIP: If a particular instance of a recurring 
appointment is canceled or postponed, you can delete or 
move that event without affecting the remaining instances. 
Simply select the appointment and press Ctrl+D to delete 
it, or double-click and edit it to move it to different date 
or time. 
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Using Copy and Paste to Create 
Irregularly Recurring Appointments 
What if your recurring event doesn't fall into the available patterns? In that 
event, do the following: 

1 . Create the first instance of your recurring event, using the simple 
appointment dialog box shown on page 285. 

2. After clicking OK to leave the dialog box, select the entry in your 
appointment book and choose the Copy Appt command from the 
Edit menu. 

3. Navigate to the starting date and time for the next occurrence, and 
choose Paste from the Edit menu. 

4. Repeat step 3 for each subsequent occurrence. 

For information about navigating in the appointment book, see "Navi­
gating in the Appointment Book," page 284. 

Editing an Appointment 
To edit an appointment, double-click it. That puts you back in the Appoint­
ment dialog box, where you can change the description, dates, times, or 
any of the option settings. 

Alternatively, if you need to change only the description, click once 
on the entry and make your changes without going into the dialog box. 

KEYBOAR D TIP: You can use the Tab key to move from 
one appointment to the next on the current day. For simple 
edits of a day's appointments, therefore, it is often quicker 
to Tab to each appointment and type, rather than going 
into the Appointment dialog box. 



Chapter 9: Using Schedule+ ~ 
Moving an Appointment 
To move an appointment, you can do either of the following: 

c Drag the top border of the appointment-book entry. 

c Select the appointment and choose the Edit menu's Move Appt 
command. (The keyboard shortcut is Ctrl+O.) 

You'll need to use the latter technique when you want to move an 
appointment to a different date. 

Deleting an ApPointment 
To delete an appointment, select it and choose the Edit menu's Delete Appt 
command or type its shortcut, Ctrl + D. 

Finding an Appointment 
Can't remember when you agreed to have lunch with Jill? Choose the Edit 
menu's Find command. The command offers options for searching forward, 
backward, and across the entire universe of your appointment book. The 
Find command looks in the appointment-book descriptions for the text you 
specify in the Search For box. 

Scheduling Ap~ooiD1tments 
ono1 Meetings with the Planner 

In Schedule+'s appointment book, you look at one day at a time and one 
user at a time. In the planner, you can see a whole range of dates at once. 
If you use the planner's group-scheduling features, the planner can even 
show you a diagrammatic representation of many users' agendas. 

To get to the planner from the appointment book or the task list, click 
the Planner tab at the side of the window or press Alt+ P. The figure on the 
next page shows how the planner might look with only one user's schedule. 
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WINDOWS TIP: In standard VGA (640x480) resolution, 
with the planner window maximized, Schedule+ can show 
commitments for about two and a half weeks. You can 
expand this range by switching to a higher-resolution 
display. In 800x600 Super VGA, for example, the planner 
can show you nearly four weeks at once. 

Notice the following points of interest: 

III The dark vertical lines are "busy bars"; they indicate times when 
the current user (the one whose name appears in the planner's title 
bar) has commitments. These lines are blue by default. If you prefer 
another color, visit the Options menu's Display command. 

EI The solid block (11:00 A.M. on MondaY,]une 14, in the illustration) 
indicates the currently selected time. 
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o The calendar in the upper right corner is identical to the one used 
by the appointment book. If you have a mouse, you can navigate 
to other dates with this calendar. If you don't have a mouse, you 
can use the Edit menu's Go To Date command, or hold down the 
Alt key and press a direction key. 

o Normal working hours are drawn in white; weekends and "after 
hours" are drawn in gray. If your normal hours are not 8:00 A.M. 
to 5:00 P.M., you'll want to customize Schedule+ via the Options 
menu's General Options command. 

o The Attendees box, in the lower right corner of the window, lists 
the names of all users whose schedules are currently displayed in 
the planner. 

o A check mark next to a user's name in the Attendees box means 
that the user in question is free at the currently selected time. An 
Xbeside a user's name means that the user is busy at the currently 
selected time. 

Scheduling an ApPointment 
If you're using Schedule+ off line, the Schedule Meeting button in the lower 
right corner of the planner window is replaced by a New Appointment 
button. You can book an appointment from here as follows: 

1. Use your mouse to "paint" the date and time of your appointment. 

2. Click the New Appointment button. 

Schedule+ displays the Appointment dialog box with the date, starting 
time, and ending time already filled out. 

If you're working on line, you won't have a New Appointment button, 
but you can still book an appointment from the planner, as follows: 

1. Double-click the starting time and date for your appointment. 
Schedule+ returns you to the appointment book, with the select­

ed date and time current. 

2. Double-click again to get to the Appointment dialog box. 
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Scheduling a Meeting 
Perhaps the principal virtue of the planner is that it allows you to see a 
merged display showing not only your own time commitments, but also 
those of your colleagues. This feature can greatly streamline the task of 
scheduling meetings. 

NOTE: You must be working on line to schedule a meeting. 

To schedule a meeting from the planner display, begill as follows: 

1. Click the Change button at the right side of the planner window. 

Schedule+ displays the Select Attendees dialog box. 

Select Attendees 

Carolyn Clark 
Cheryl Kubiak 
Chris Wood 
Conference Room 
Craig Stinson 
D avid Calder 
Eric Lee 
Gary Damron 
Jim Law 

In the top portion of this dialog box, you'll find the Postoffice 
list-the main address book used by Mail. (For information about 
working with Mail's address books, see "Working with Address 
Books," page 253.) You can use this address book or switch to a 
different one, using the same commands that you use in Mail. 

2. Select the names of the people you want at your meeting, and then 
click Add. (You can select them one at a time, or you can hold down 
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the etrl key while you select the whole lot.) When the Attendees 
section of the dialog box includes the names of everyone who 
should attend, click OK. 

Schedule+'s planner now displays the busy times of all your attendees, 
as the following figure shows. 

As you read this display, keep in mind the following: 

D Your own busy bars are the dark blue ones (unless you used the 
Display command to choose a different color). 

D Your colleagues' busy times are displayed in dark gray. 

D A striped bar indicates a time when both you and at least one other 
user are busy. 

D An X next to an attendee's name means that the person is busy at 
the currently selected time. 

D If an attendee's name is dimmed, that means that Schedule+ was 
unable to check that person's schedule. 
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Determining Who's Busy When 
When you try to arrange a meeting, normally all you care about is finding 
a time when everybody's free. But on some occasions, you might look at 
the composite planner display and wonder which of your colleagues is 
responsible for some particular gray busy bar. You can figure that out by 
selecting the bar in question with your mouse. An X appears beside the 
names of those users who are busy at the selected hour. 

You can also alter the planner display so that it shows only the busy 
times of one or more particular users. You do that by a process of elimina­
tion. Click the name of any attendee, and Schedule+ removes that attendee's 
busy times from the planner. Click the attendee's name a second time to 
restore the display. 

Requesting a Meeting 
When you find a suitable time for your event, highlight the time with the 
mouse and click Request Meeting. Schedule+ responds with the Send Re­
quest form, as shown in the following illustration. 

we get together tomorrow afternoon for a couple of 
urs to talk about the first eight chapters? 

The Send Request form is a special type of Mail message. Like the 
standard Message dialog box (see "Creating a Message," page 249), it in­
cludes an area for the names of addressees and an area for your message. 
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Schedule+ fills out the addressee section with the names of those listed in 
the planner's Attendees box. In the message area, you can write a description 
of the meeting. When you're ready, click the Send button. 

After you click Send, Schedule+ displays an alert box indicating that 
the meeting was successfully booked-even though your fellow attendees 
haven't yet read your request. An entry appears in your appointment book, 
flagged as a meeting by means of a handshake icon. 

Where Schedule+ Messages Go 
When you send a message request from Schedule+, that message appears 
in two places on your recipients' desks: in their Mail inboxes and in Sched­
ule+'s Messages window. Your recipients can read and respond to the 
message in either program. Deleting the message in either program removes 
it from both. Responses to your meeting requests, similarly, arrive in both 
Mail and Schedule+. To view your messages in Schedule+, pull down the 
Window menu and choose Messages. 

NOTE: The Messages window is not available when you work off 
line. 

Letting Schedule+ Pick a Meeting Time for You 
If you don't want to pick a meeting time yourself, you can let Schedule+ 
do it for you: 

1. In the planner, click the Change button and select the names of all 
your attendees. 

2. After Schedule+ has updated the planner to show the composite 
schedule for the selected attendees, use your mouse to select the 
span of time you require for your meeting. For example, if your 
meeting will last two hours, drag the mouse across four half-hour 
time blocks. (With the keyboard, hold down Shift and press the 
Down direction key to extend the time selector.) 

3. Choose Auto-Pick from the Appointments menu. 

Schedule+ finds the first working-hour time period after your selection 
in which all attendees are free for the requisite time interval. 
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Rescheduling a Meeting 
If you need to reschedule a meeting, proceed as follows: 

1. Display your appointment book and double-click the meeting entry. 
(Or select the entry and choose Edit Appt from the Edit menu.) 

You will see a modified version of the Appointment dialog box, 
in which the names of your attendees are listed alongside a descrip­
tion of the appointment. 

2. To find another time when your attendees are available, click the 
Choose Time button. 

3. Change the date and time of your meeting, as needed, and then 
click the Invite button. 

Schedule+ presents a new message form, in which you can explain 
the reason for rescheduling and ask your attendees to confirm their avail­
ability. 

Canceling a Meeting 
If you need to cancel a meeting, Schedule+ can send out cancellation 
notices: 

1. Display your appointment book and select the meeting entry. 

2. Choose Delete Appt from the Edit menu. 

3. Answer Yes if you want to notify the attendees. 

Managing Projects 
and Tasks with the Task List 

The task list provides a simple means of tracking items on your to-do list 
that aren't tied to specific times in your appointment book. To view the task 
list, click the Tasks tab (or press AIt +D. You can organize your list into two 
hierarchical levels, called projects and tasks, as shown in the following 
illustration, or you can list tasks without putting them into project categories. 
Each task can be assigned a due date and a priority level, and you can sort 
the list by priority, due date, or description. 
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'"'I Eile .Edit Appointments Tasks Qptions Window Help L~ 

DS Labs; tentative deadline: 719 

C:h,:jpt~;r 9 
Chapter 6 
Introduction 

Do three items by 6/20 

Creating New Projects and Tasks 
To create a new project: 

1. Choose the New Project command from the Task menu. 

2. Supply a name for the project. 

3. Select the .Private check box if you don't want the project to be 
visible to others who can view your Schedule+ file. 

Private projects are indicated by a key icon next to the project name; 
any tasks subordinate to the project heading are also automatically made 
private. 

To create a new task: 

1. Select the heading for the project to which the task belongs (or any 
task under that heading): 

2. Choose the New Task command from the Tasks menu (or press 
Ctrl+T). 

Schedule+ presents the Task dialog box. 
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j!escription: I FuziCalc 
~========~~--------~ I First Look reviews II Project: 

Due Date: 1-1 O_H._o_n_e __ @_Il1' __ ' F_ri_7_'_9_'_93_1J_~---l1 
litart Work: [CJlweek(s) [i] Before Due [g]r.~.~:(:~'.~m~~.~~.~J 

Priori.ty:!III 0 frivate 

3. Fill out the dialog box as needed, and click OK. 

Alternatively, you can select the appropriate project heading, and then 
type a description of your task on the New Task line at the top of the task 
list window. Schedule+ then creates a task using default options. You can 
modify these options by editing the task entry. For information about editing 
the task entry, see "Editing Projects and Tasks," page 301. 

Creating Recurring Tasks 
Tasks, like appointments, can be singular or recurring. To create a recurring 
task, choose New Recurring Task from the Tasks menu. Your options for 
creating a recurring task are the same as those for a recurring appointment. 
For information, see "Entering a New Recurring Appointment," page 289. 

Creating Tasks Without Projects 
After you've created your first project heading, it might seem impossible to 
enter a new task that doesn't belong to a project category. But you can, as 
follows: 

1. Press Ctrl+T to create a new task. 

2. In the dialog box, click the drop-down arrow to the right of the 
Project line. 

3. Choose <None>, the first entry in the Project drop-down list. 
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WINDOWS TIP: You can create a new project ;;tt the 
same time that you create or edit a task. In the Task dialog 
box, type a new project name on the Project line instead 
of selecting an existing project from the drop-down list. 

Editing Projects and Tasl{s 
To edit a project or task, select it and press Ctri+E, or double-click it. Either 
way, you'll be back in the dialog box that you used to create the project or 
task heading. Make your edits and click OK. 

~ 
~\J 

"l 

MOUSE TIP: If you need only to adjust a task's priority, 
select the task and then click the up and down arrows in 
the lower left corner of the task list window. Priority 
settings range from 1 (highest priority) through 9 and then 
A through Z. 

Assigning Tasl{s to Your ApPOintment Calendar 
Although the items on your to-do list are, by definition, not tied to specific 
times on the calendar, you might still want to block out times in your 
appointment book to devote to certain tasks. You can do this quite e'asily, 
as follows: 

1. Select a task entry. 

2. Click Add to Schedule. 

3. In the mini-planner window that appears, select the time you want 
to devote to this task. Then click OK. 

Schedule+ creates an entry in your appointment book, identified by 
the task description and its project heading. You can edit this entry (adding 
details to the description, for example) as you would any other appoint­
ment-book entry. 
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While selecting a time in the mini-planner window, remember that 
you are not restricted to selecting "free" times. If you pick a time that's 
already marked by a busy bar, Schedule+ merely creates an overlapping 
entry in your appointment book. 

WINDOWS TIP: If you expect your colleagues to use 
Schedule+'s meeting-scheduling features, you might want 
to avoid assigning tasks to large time blocks on your 
appointment calendar. (Then again, you might not want 
to avoid this!) Such blocks appear to your coworkers as 
times when you are unavailable for meetings. 

Marldng a Task as Completed 
To mark a task as finished, simply select it and click the Completed button. 
Schedule+ removes the item from your task list and posts a note in today's 
appointment book indicating that the task was finished. 

Alternative Ways to View Your Tasl{ List 
To change the order in which your tasks are sorted within each project 
heading, click one of the three heading buttons near the top of the window: 
Priority, Due By, or Description. Normally, all sorts are in ascending order. 
To reverse the sort order, hold the Ctrl key while you click the appropriate 
heading button. 

To display only those tasks that are due today or already overdue, 
choose the Show Active Tasks command from the Tasks menu. To restore 
the full display, return to the Tasks menu and choose Show All Tasks. 

To remove the project headers from the task list display, choose the 
View by Project command from the Tasks menu. (Or press Ctrl+Shift+V.) 
Schedule+ retains the information about which projects your tasks belong 
to, but suppresses the display of these headings. This allows you to sort 
tasks strictly by priority, due date, or description without· regard to project 
grouping. To restore the full display, choose the View by Project command 
a second time to deselect it. 
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Controlling Others' Access 
to Your Schedule+ File 

By default, oth~r users in your workgroup are allowed to see what times 
you are busy and free, but they're not allowed to read the details of your 
appointment book or task list, nor can they change any part of your Sched­
ule+ file. This default privilege level helps your coworkers avoid requesting 
your presence at meetings when you have conflicting commitments, yet still 
protects your privacy. 

You can change the privilege level for particular users, or you can 
change the default privilege level. To do either, start by choosing Set Access 
Privileges from the Options menu. (You must be on line to do this.) Sched­
ule+ presents the following dialog box. 

!!sers: 

Set Access Privileges 

Privileges-------, 

o H.one 
@ yjew Free/Busy Times 
o R~ad Appointments" Tasks 
o ~reate Appointments" Tasks 
o M.odify Appointments" Tasks 
o Al)tis!<lnt 

1~~~?nK:t;!~1 

Ir'Cancer'~J 

IF~~:::,,':'J 

In:re;ni}Y~~~:J 

The last option in this dialog box, Assistant, is not available at first 
because you cannot make Assistant privileges the detault for all users. The 
other five options represent ascending degrees of permission. At the low 
end of the scale, the None option completely bars access to your Schedule+ 
data. At the high end, Modify Appointments & Tasks permits users to do 
everything with your Schedule+ file that you yourself can do. 

To change the default access privileges, do the following: 

1 . In the Users section of the dialog box, select Default. 

2. In the Privileges section of the dialog box, select the new default 
access privilege. 

3. Click OK. 
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To change the access privileges for a particular user or group of users, 
follow these steps: 

1. Click the Add button. 

Schedule+ displays the familiar post office list. 

2. Select the name of one or more users (hold down the Ctr! key while 
clicking to select more than one), and then click the Add button. 

The names of the selected users now appear in the Users list. 

3. In the Users section of the dialog box, select the names of the users 
whose access privileges you want to change. 

4. In the Privileges section of the dialog box, select the new access 
privilege. 

5. Click OK. 

Having an Assistant Manage Your Schedule 
To allow someone else to manage your Schedule+ file, proceed as follows: 

1. Choose the Set Access Privileges command from the Options menu. 
(You must be working on line when you do this.) 

2. Click the Add button in the Set Access Privileges dialog box. 

3. Select the name of your Assistant, click Add, and then click OK. 

4. Select your assistant's name in the Users list, select the Assistant 
button in the Privileges list, and then click OK. 

Meeting invitations sent to you will then be copied to your assistant, 
and your assistant will be able to respond, as well as issue new invitations, 
in your name. 

You can have only one assistant at a time. If you want to allow more 
than one person to manage your schedule, assign the Modify Appointments 
& Tasks privilege to each additional person. The only difference between 
this privilege and the Assistant privilege is that you have the option of 
automatically directing messages to your designated assistant. 



Chapter 9: Using Schedule+. ~ 
Redirecting All Messages to Your Assistant 
If you want Schedule+ message traffic to go only to your assistant, follow 
these steps: 

1. Choose the General Options command from the Options menu. 

2. Select the check box labeled Send Meeting Messages Only to my 
Assistant. 

This option is available only while you're working on line and only if 
you have already designated someone to be your assistant. 

Viewing Others' Scheduls+ files 
To see another user's Schedule+ file, choose the File menu's Open Other's 
Appt.. Book command. Then select one or more names in the post office 
list and click OK. Provided the others in question have granted you at least 
the Read Appointments & Tasks privilege, Schedule+ opens a new docu­
ment window for each selected user. You can switch between document 
windows with the help of the Window menu. 

Printing Your Appoontments and Tasks 
To print some or all of your Schedule+ file, choose the Print command from 
the File menu. You'll see a dialog box similar to the following. 

Print . 

Printer: Default Printer [\\EPS\HP) 

Schedule Range----------, 

S!arting: I Fri 6 /18/ 93 lit 

I~tll~ffl 
IrnJ~~1 

lyr'ifilUi!t1~[1 

p,rint: IDaily View Iii Print !luality: IHigh iii 
o Include !l.lank Pages Paper Format: IJ unior Iii 
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Select options as desired, and click OK. 

Schedule+ offers five content options, each of them available in three 
sizes. The options, which are accessed via the Print drop-down list, are: 

a Daily View 

m Weekly View 

I:J Monthly View 

D Text View 

C Tasks 

The size options, available via the Paper Format drop-down, are Stand­
ard, Junior, and Pocket. Standard is the largest, and Pocket is the smallest. 

The Daily View printout reproduces each day of your appointment 
book just as you see it on screen. Weekly View and Monthly View provide 
more compressed reports, truncating long text descriptions as necessary. 
Text View is handy when you want to see a lot of information in a small 
space; it simply lists your commitments by date and time, without attempting 
to mimic a calendar. Task List is the only choice that focuses on your projects 
and tasks. ' 

Note that if you choose Weekly View or Monthly View, Schedule+ 
prints your appointments beginning at the first day of the Starting Date's 
week or month. For example, if you set Starting Date to 6/20/93 and choose 
Monthly View for one month, Schedule+ prints appointments from June 1 
through June 30. 

Exporting and Importing 
Schedule+ Files 

If 'you plan to take your Schedule+ file on the road, you'll need a way to 
transfer it from your desktop computer to your laptop. The File menu's 
Export Appointments and Import Appointments' commands provide a 
means to do this., Simply export your calendar to a file on a floppy disk, 
and then import that file into the version of Schedule+ stored on your road 
machine. When you return, you can reverse these steps to update your 
desktop computer. 
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You can also use the Export Appointments command to transfer Sched­
ule+ files from the program's native format to text that is suitable for im­
porting into a word processor. And you can use the Import Appointments 
command to transfer data from the Windows 3.1 Calendar and WordPerfect 
Office programs into Schedule+. 

Exporting 
To export your Schedule+ file, choose the File menu's Export Appointments 
command. The following dialog box appears. 

Export Appointments 

File Format: I~'t! @@IJ Iii 
Schedule Range: 0 from:! Sat 6 J19J93f!$j 10: I Sat 6 J19J93Pi1 

@AII 
o include 0 ail}' Notes 

r--I p:"='"m='"]'[='",;r;t",:"'""'lI,';'I1 rTCance[:~l 

Specify a date range if you don't want to export your entire file, and 
choose Text in the File Format drop-down if you intend to incorporate your 
schedule into a word processing document. 

NOTE: The option to export a specific date range in the native 
Schedule+ format is available only if you are working on line. 

Although the command is called Export Appointments, your projects, 
tasks, and notes will also be exported. Deselect the Include Daily Notes 
check box if you want to leave your notes behind. 

After you fill out this dialog box, Schedule+ asks you to specify a name 
and path for the exported file. Both the export command and the import 
command use SCH as a default filename extension. 

Importing 
To import a calendar file into Schedule+, choose the File menu's Import 
Appointments command. You'll be asked to specify a filename and format. 
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The available formats are Schedule+, Windows Calendar (the Calendar ac­
cessory shipped with earlier versions of Windows), and WordPerfect Office. 
Schedule+ merges the specified import file with your current Schedule+ file. 

Before beginning this process, however, the program asks how you 
want it to handle duplicate and conflicting appointments. Duplicate appoint­
ments are those that exist in -identical form in both the import and the current 
file. Conflicting appointments are appointments in the import file with times 
that overlap appointments in the current file. 

In most cases, you'll want to select the option button labeled Do Not 
Add Duplicate Appointments. If you Jllake a mistake here and wind up with 
a file full of duplicate entries, you'll need to go through the pages of your 
appointment book and delete the duplicates (by selecting each one and 
pressing Ctrl + D). 

If you put a check in the box labeled Ask About Conflicting Appoint­
ments, Schedule+ stops each time it sees a time overlap and asks for in­
structions. This slows down the import process considerably, but you might 
want to use this option if you're importing a set of records from the Windows 
Calendar or WordPerfect Office program. In this case, what may look to 
Schedule+ like overlapping appointments may actually be duplicates ex­
pressed in a different fashion. 

Archiving Your Scheduls+ file 
The longer you use Schedule+, the bigger your file will grow and the longer 
it will take to load at the start of every session. You can control this growth 
with periodic use of the File menu's Create Archive command. This com­
mand presents the following simple dialog box. 

Create Archive 

Archive i!.ata Before: II:ImI 6 /1 /93\11 
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Select a date and click OK. Schedule+ prompts for a filename and path, 
and then purges your calendar of all records prior to the selected date. If 
you ever need to see the purged information again, choose the Open 
Archive command and select the appropriate filename. 

WINDOWS TIP: If you expect to need your archive files 
again, be sure to make the archive dates recognizable in 
the archive filenames. This will be easy to do if you archive 
to an NTFS directory. For example, you could name an I 

NTFS archive Third Quarter 1993.ARC. 

NOTE: Because archived records cannot be merged back into 
the current calendar file, you will be asked for confirmation 
before Schedule+ begins the archive process. If you reopen an 
archive with the Open Archive command, Schedule+ creates a 
new calendar document under the archive name. You can then 
use the Window menu to switch between your current calendar 
and the reopened archive. 

~no 



S)<ecOJjw~iW (Q1U1ld 

Adm~fl\)~$~w©JtDon 



Chapter 10 Users, Passwords, Policies, 313 
Permissions, and Rights 

Chapter 11 File Security with NTFS 333 

Chapter 12 Auditing Security 349 

Chapter 13 Backing Up and Restoring Files 361 





;~'~~~.'X' .. '~·.l.~; •··· .. (0).:.'·0· .. · ••. " .. ' 
" /"";: """:" 

\ ",;" "/' ~»,~, .. ;.t'",. ,,:, 

'::',:(f~:~{~:;~~;;:,:l;,~:: :,:.:,:: " 
, ' ~ ,"' .• '},.'l ':,:~";' ',: '/, i:,.\' 

, 
, 

An Overview of Windows NT Security 
Permissions, rights, user accounts, and groups form the basis of Windows 
NT security. 

Managing Groups 
Managing users by grouping together people with common access re­
quirements can make system administration a snap. 

Managing User Accounts 
The User Manager lets you add, remove, and appropriately empower 
users on your system. 

Setting Account Policies 
Account policies set the rules for creating and using passwords. 

Setting User Rights Policies 
You can grant and revoke system privileges to users and groups. 
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indows NT offers the ability to let several users share a 
single computer, as well as share resources such as direc­

tories or printers over a local area network. 

These ideas aren't new, but Windows NT gives you a remarkable 
degree of control over system resources-assuming that you have the 
proper rights, that is. For example, you can keep stored data away from 
prying eyes by locking certain users out of the files or directories where the 
data resides. Windows NT also lets you control and monitor access to system 
resources, as well as restrict certain users from performing particular system 
activities. 

This chapter explains how security is implemented in Windows NT 
and how you can administer access to the resources on your system. We'll 
also examine the permissions and rights that can be assigned to users and 
groups of users. 

NOTE: Many of the procedures described in this chapter can be 
performed only by a system administator (that is, someone who 
logs on as a member of the Administrators group), but the 
concepts can also be useful if you are simply trying to use a 
shared resource. 

An Overview of Windows NT Security 
Windows NT implements discretionary security. In this approach to secu­
rity, each resource that is subject to access control, such as a file on an NTFS 
partition or a printer, is assigned an owner. (You become the owner when 
you create such a resource, or when ownership is transferred to you.) The 
owner of a resource has discretion over who can and cannot access the 
resource. The owner must explicitly grant other users access; otherwise, 
they have no access to the resource. Some resources, however, might have 
default security settings based on their owner or their location. For example, 
a file assumes certain security settings based on the directory in which it 
was created. 

The backbone of Windows NT security is the ability to identify a user 
uniquely. Each user is identified by a name-a username-when logging 
onto a Windows NT computer. Each username is protected by a password. 
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Windows NT manages security by associating each system resource 
with an access control list, or ACL. The owner of the resource determines 
which users are on the list. When a user tries to access a system resource, 
Windows NT checks the resource's ACL to see if the user has access. An 
unauthorized user is denied access to the resource, and the operation that 
the user attempted fails. 

Windows NT enforces security at all times. This security cannot be 
disabled or circumvented. 

Permissions 
Although controlling access to a system resource might seem simple, Win­
dows NT takes a very comprehensive approach. Each user is assigned a 
number of permissions that secure access to certain files and directories. 
Windows NT allows a system administrator to precisely control which op­
erations the user can perform on the particular file or directory. Permissions 
are also assigned to system resources. 

For example, you may have files that need to be maintained as read­
only. A system administrator can assign permissions to the files so that all 
users are allowed to read the files, but no users are allowed to modify them. 
(For information about assigning these permissions and controlling a user's 
access, see Chapter 11, "File Security with NTFS," page 333. In this chapter, 
we'll concentrate on managing the users and groups of users that are af­
fected by these permissions.) 

Rights 
Rights are another level of security; they control what a user can do with 
the computer after logging on. Rights are associated with accounts; accounts 
are said to have the right to perform certain actions. Windows NT allows 
system administrator accounts the greatest freedom-that is, complete con­
trol over the system. Typical user accounts have only a few rights, which 
keeps the system secure and stable; only a few trusted users are given 
accounts with complete control. 

The easiest way to manage rights is to rely on the predefined groups 
installed with Windows NT, which assign default rights to users with ac­
counts in those groups. To give a user more or fewer rights, a system 
administrator can move the account to a different predefined group. A finer 
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degree of control over rights can be exercised with the help of User Man­
ager's User Rights Policy dialog box. (For information about this option, see 
"Setting User Rights Policies," page 330.) Later in this chapter, we'll discuss 
the rights afforded to particular groups of users, and examine how those 
groups are maintained. But first, let's explore user accounts using the User 
Manager application. 

User Accounts 
User accounts are created, changed, and maintained with User Manager, an 
application that comes with Windows NT and is installed in Program Man­
ager's Administrative Tools program group by default. When you launch 
User Manager, you see the User Manager window, similar to the one shown 
in the following illustration. 

~ser folicies 

Irlf Administrator n Craig n Guest 

Administrators 
t Backup Operators 
t Guests 
t Power Users 
t R eplicator 
tUsers 

Qptions Help 

Built-in account for i!ldministering the computer/doma 
Craig Stinson 

Built-in account for guest access to the computer/do 

Members can fully administer the computer/domain 
M embers can bypass file security to back up files 
Users granted guest access to the computer/domain 
M embers can share directories and printers 
Supports file replication in i!I domain 
Ordinary users 

The top part of the window lists the user accounts on the system. User 
Manager shows the username and full name for every account on the system; 
if there are many accounts, the scroll bar allows you to scroll through the 
entire list. The username is the name the user types in when he or she logs 
on. The full name is the user's full name, which identifies the user when 
the short username is insufficient. 

Some accounts are special. The Administrator account belongs to the 
system administrator and is always present on the system. This account has 
full rights over the entire system; it can create other user accounts, and is 
generally responsible for managing the system. Many system features and 
rights are off limits to accounts other than Administrator (or a user who is 
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a member of the Administrators group). For example, most of User Man­
ager's features are disabled when the current user is not Administrator or a 
member of the Administrators group. For more information about the Ad­
ministrators group, see "Administrators," page 318. 

WINDOWS TIP: Even if you decide not to take advantage 
of the security features of Windows NT, you can benefit 
from creating a nonadministrative user account for 
yourself for day-to-day use. When you use this account, 
you will not run the risk of aCcidentally altering a system 
configuration setting. When you need to change the 
features or setup of your system, you can log on using the 
Administrator account. 

.. ,. . ...... . 

I 

The Guest account is special as well. It gives users who might not 
otherwise have access to the system a way to log on. The Guest account is 
intended for infrequent users of the system. Using this account, a guest can 
access the system in a very limited manner; he or she is prevented from 
altering the system or viewing any restricted information. Choices made by 
the system administrator determine the level of access afforded to the Guest 
account. 

Groups 
The bottom part of the User Manager window shows the groups that the 
system recognizes. Groups provide a system administrator with a way to 
assign the same access rights to a group of user accounts. For example, if 
everyone in the accounting department needs access to the PAYABLE direc­
tory, you can create a group called Accounting and grant the entire group 
access to the PAYABLE directory. All of the user accounts that belong to 
employees in the accounting department can then be added to the Account­
ing group. These users will automatically have access to the PAYABLE 
directory because they are members of the Accounting group. 

Note that each user account can be a member of more than one 
group-or no groups at all. For more information about group member­
ships, see "Assigning Group Memberships," page 326. 
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The system has several predefined, standard groups, which bear some 
examination. The standard groups include Administrators, Power Users, 
Users, Guests, Backup Operators, and Replicator. 

Administrators 
The Administrators group is the most powerful group, because its members 
have more control over the system than any other group of users. The Ad­
ministrators group, by default, contains the built-in Administrator account. 
If you add other user accounts to the Administrators group, theyautomat­
ically receive the privileges reserved for system administrators. 

Although members of the Administrators group have complete control, 
a user can create a file that members of the Administrators group cannot 
access. The file security in NTFS allows users to explicitly deny any user, 
including system administrators, access to a given file. A system administra­
tor can gain control of the file by taking ownership of it, but this action 
generates an entry in the system log (when file-access logging is turned on), 
and the operation cannot be undone. For more information about file 
security, see Chapter 11, "File Security with NTFS," page 333. 

Power Users 
The Power Users group is intended for users who need ~any of the privi­
leges of the Administrators group, such as setting the system time or creating 
common program groups, but it restricts those users from the most potent 
capabilities. Power Users cannot take ownership of files or manage the 
security and auditing logs, for example. 

Users and Domain Users 
The Users group is a catch-all group. Except for the built-in Administrator, 
Guest, and initial user accounts, all accounts are members of the Users 
group. The Users group provides base-level access to the system. Ideally, 
the great majority of users on a system are members of this group and no 
other. 

The Users group is jOined by the Domain Users global group when a 
Windows NT computer participates in a Windows NT Advanced Server 
domain. This means that anyone accessing your system over the network 
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from a domain enjoys the same rights on the system as users in your local 
domain. You can prevent Windows NT from adding the Domain Users 
group to the Users group by explicitly removing the group using User 
Manager's group-editing capabilities. For information about deleting a group 
member, see "Modifying a Group," page 322. 

Guests 
The built-in Guest account is automatically a member of the Guests group. 
Users who log on infrequently are also good candidates for the Guests 
group. Permissions granted to regular, well-known users of the system­
who are probably members of the Users group-can be withheld from 
members of the Guests group to limit their access and to improve security. 

Backup Operators 
Members of the Backup Operators group have the right to back up and 
restore directories and files. Backup operators also have access to the 
Backup application. For information about Backup, see Chapter 13, "Back­
ing Up and Restoring Files," page 361. 

Replicator 
The Replicator group is a special group that should contain only one mem­
ber: the domain user account that uses the system's Directory Replicator 
service. (The Directory Replicator service duplicates a set of directories from 
a server.) Although you can add normal users to this group, you should 
refrain from doing so because the group is intended strictly for automated 
maintenance of directories. 

System Groups 
Windows NT manages four special groups for the system. These groups are 
not normally displayed in selection lists of groups, although they are often 
displayed in lists of groups or users that own a right. You'll see the group 
names (shown in Table 10-1 on the next page), for example, in the User 
Rights Policy dialog box. For more information, see "Setting User Rights 
Policies," page 330. 
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Everyone 

Interactive 

Network 

Creator 
Owner 

TABLE 10-1. 

System groups. 

This group contains anyone using the computer. This 
includes both local and remote users-the group contains 
the Interactive and Network groups. Members of this 
group can access the network, connect to the computer's 
shared directories, and use the computer's printers. 

A subset of the Everyone group containing members who 
are interactive, local users. 

A subset of the Everyone group containing members who 
are users from another computer and are accessing the 
computer through the network. 

This group contains any user who has created or owns a 
system resource, such as a document sent to the printer, 
a file or a directory, or a printer. 

Managing Groups 
By examining the needs of the users who will be accessing your system, 
you can probably identify users who have common access requirements. 
These users should all be placed in a single group. This way, as time goes 
on, their accounts can be conveniently maintained and managed. You 
should not create so many groups that you cannot easily decide where to 
place a given user. However, you should feel free to create enough groups 
so that you can conveniently manage all of the users on your system. 

You will probably find that rights for some system activities need to 
be granted to large numbers of people. If you are working with a group of 
software developers, for example, you will almost certainly want to create 
a group for them. That group should be allowed to debug applications, start 
and stop services, and perhaps view the system log. If you are working with 
a group of lawyers, bankers, or accountants, or any other group of people 
with very strict security needs, you will want to carefully isolate resources 
between groups. 
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Creating a Group 
To create a group: 

1. Choose the New Local Group command from User Manager's User 
menu. User Manager presents the New Local Group dialog box. 

New Local Group 

!iroup Name: IL--__________ ---I 
Q.escription: 

Members: 

I f'Ctlltt":-:'"'1 

1 FCancel;~-' 

Ir~'ll8ip'~"~" I 

It(Ad(i~;";,:m 

I~AlllOO~a~1 

2. In the Group Name text box, type a name for the group. 

3. In the Description text box, type a description of the group. Try to 
use a concise and meaningful deSCription for the group; that way, 
everyone on the system will know the group's purpose. 

4. Click Add. The Add Users and Groups dialog box appears. 

Add Users and Groups 

List Names From: 1...::1 ~~' ...:..."_OM_N_11' _____ -IoI!l ... '" 

Hames: 
• Admlnlstlator BUllt'ln account for admlnlsterino the com uter/do 

Ii Craig (Craig Stinson) 

Ii Guest 

A.!!.d Names: 

Built·in account for guest access to the computerl 
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5. In the Add Names box, type the usernames of the users you want 
added to the group. Separate the usernames with semicolons. 
Alternatively, you can select the usernames in the Names list box, 
and then click Add. 

6. Click OK in the Add Users and Groups and the New Local Group 
dialog boxes. 

Modifying a Group 
You can change a group's name, description, or membership by selecting 
the group in the User Manager window and choosing Properties from the 
User menu. You'll see the Local Group Properties dialog box, which-aside 
from its name-is identical to the New Local Group dialog box shown 
above. You can then change any of the settings made when the group was 
created. 

Deleting a Group 
To delete a group: 

1. In the bottom part of the User Manager window, select the name of 
the group you want to delete. 

2. Choose the Delete command from the User menu or press the Del 
key. User Manager presents a dialog box that warns you of the 
consequences of deleting a group. Click OK. 

Each group is represented by a unique identifier which is 
independent of the group name. Once this group is 
deleted. even creating an identically named group in the 
future will not restore access to resources which currently 
name this group in the access control list. 

1[.1;Q5ii,1IB_:~ 

3. User Manager presents a dialog box that asks you to confirm the 
deletion. You can click Yes to delete the group or click No to cancel 
the deletion. 
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Take a deep breath and think carefully before deleting a group! It is 
frustrating to recreate all of the rights and memberships that most groups 
contain. 

Managing User Accounts 
A system administrator or a member of the Administrators group uses User 
Manager to create and delete user accounts and to manage account prop­
erties such as password requirements, group memberships, and account 
logon scripts. 

Creating a User Account 
To create a new user account, you must be logged on as a member of either 
the Administrators group or the Power Users group. 

1. Choose the New User command from User Manager's User menu. 
User Manager presents the New User dialog box. 

New User 

!!sername: 

FullH.ame: 

Qescription: L--_________ --' 

fassword: 

J;.onlirm 
Password: 

o User Must hange Password at Next logon 

o U1er Cannot Change Password 

o Pass!,!ord Never Expires 

o Account Disa.!!.led 

I F'l'Ul",<~r I 
IF~i";1 

1~1liiP~'1 

2. In the Username text box, type the username of the user for whom 
the account is being created. (Each user must have a unique user­
name.) 

3. In the Full Name text box, type the full name of the user. (This entry 
is optional.) 
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4. In the Description text box, type a description of the account. (This 
entry is also optional.) The description can be used to record more 
detailed information about the user. For example, some system 
administrators might include the department that employs the user, 
or the user's telephone number or extension. 

5. In the Password and the Confirm Password text boxes, type the 
user's temporary password. (The password is typed twice to ensure 
that it is entered correctly.) Remember that passwords are case­
sensitive. 

6. Select the appropriate check boxes. It's a good idea to select the 
User Must Change Password at Next Logon check box so that the 
user will be prompted to change the password when he or she first 
logs on. 

7. Click OK. 

For information about the other choices in the New User dialog box­
the Groups and Profile buttons-see "Managing User Account Properties," 
below. 

You can also create a new account by copying an existing account. In 
this case, you will be prompted for a new name for the new account. The 
Copy command on the User menu presents the Copy Of dialog box, in 
which you can establish different user properties. (Follow steps 2 through 
7 above.) 

Managing User Account Properties 
Each user account has a small amount of basic information associated with 
it, including the user's full name, a brief description of the user, and whether 
the account is disabled. This information can be altered by a member of the 
Administrators group. If you double-click a username in the top section of 
the User Manager window, or if you select a username and choose the 
Properties command from the User menu, User Manager displays the User 
Properties dialog box, as shown on the next page. 
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User Properties 

Username: Craig 

Full H.ame: I Craig Stinson 

~escription: '-_________ --' 

fassword: I ............ .. 
~~~~~~rd: I ............ .. 
o User Must Change Password at Next Logon 

o U.ter Cannot Change Password 

o Pass!!ord Never Expires 

o Account Disa!!.led 

I f-~"n~7,,;~1 
IFc;ncer~1 

1!.!ielP ";";) 

This dialog box shows information about an account belonging to 
Craig Stinson. The account's password is represented by a row of asterisks. 
A system administrator can change the account's password using this dialog 
box but cannot learn what the password is without altering it. The User 
Properties dialog box also allows a system administrator to set several pass­
word options. 

If you select ~he first check box, the user is forced to change the 
password the next time he or she logs on. This is convenient when you first 
create an account or after you reset a user's password. A system adminis­
trator can select the User Cannot Change Password check box to prevent a 
user from changing the password. This option is useful for an account that 
is shared by several users, such as the Guest account; no user can assume 
exclusive access to the account by changing the account's password. 

Account passwords normally expire after a period of time that is set 
using User Manager's Account Policy dialog box. (For information about 
this dialog box, see "Setting Account Policies," page 328.) To prevent an 
account's password from expiring, select the Password Never Expires check 
box. 

A system administrator can disable an account by selecting the Account 
Disabled check box. A user who tries to log onto a disabled account is told 
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to contact the system administrator because the account has been disabled. 
This option conveniently lets a system administrator disable an account 
temporarily without having to delete and later re-create the account and all 
its associated properties. 

Assigning Group Memberships 
Click Groups in the User Properties dialog box to determine which groups 
the user belongs to. The resulting Group Memberships dialog box, shown 
below, also allows a system administrator to add the user to or remove the 
user from any group. 

Group Memberships 

Usel: Claig (Claig Stinson) 

Im~£·>:ll 

Administrators 
Guests 
Power Users 
Replicator 

I~ 
lB!l!llil 
I ... ~ 

r*=!!fiue!.! 11~ .. !t;\ ... l. 
~----------~ ~----------~ 

This dialog box shows that the user Craig Stinson is in the Backup 
Operators group as well as the Users group. To remove Craig from the 
Backup Operators group, select that group name in the Member of list box 
and then click Remove. To add Craig to a group, select the group name in 
the Not member of list box and click Add. The list boxes are updated to 
show the groups to which the user does and does not belong. 

Using Logon Scripts and Setting a Home Directory 
The User Environment Profile dialog box allows a system administrator to 
alter each user's environment individually. To do so, click Profile in the User 
Properties dialog box. The User Environment Profile dialog box appears, 
similar to the one shown on the next page. 
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User Environment Profile 

User: Craig (Craig Stinson) I i'tUi!,'IIt1:rf;";' 
It'.M:;}I 

!:.ogon Script Name: "'-1 ------------" If;.\fl.l~0·1 

Home Directory 

@Localfath: I'-___________ ~ 

o tonnect D I!I To 1'-________ --' 

The User Environment Profile dialog box allows you to set up a logon 
script for a user account, as well as define a home directory for a user 
account. The Logon Script Name identifies a batch file or an executable 
program that is run automatically when the user logs on. Bear in mind that 
the batch file or executable program is executed every time the user logs 
on. You will probably want to keep the batch file short, or provide the user 
with an option to skip the logon script. You can specify a full pathname in 
the Logon Script Name text box, or you can specify a filename in the default 
logon script path, which is C:\ WINNT\SYSTEM32\REPL\IMPORT\ 
SCRIPTS. The user's access rights for the file must include read and execute 
privileges. 

The Home Directory group box allows you to specify a home directory 
for the user. This directory is the current directory when the user logs on, 
and is the default directory for the File Save and File Open dialog boxes in 
applications that don't set their own default path. Most administrators create 
one home directory in the \ USERS directory for each user. Users should be 
made the owners of their own home directories so that they can maintain 
security on their own directory and share files with other users. If you want 
to place a user's home directory on the local computer, type the pathname 
to the directory in the Local Path text box. If you want to place a user's 
home directory on another computer, select the Connect option button, 
select a drive letter from the drop-down list, and type the network path in 
the To text box (\ \OMNI1 \ USERS\CRAIGS, for example). The user must 
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have permission to connect to the other computer and read the directory 
in question. Otherwise, Windows NT fails to make that directory current for 
the user . 

.. Deleting a User Account 
To delete a user account: 

1. In the top part of the User Manager window, select the· username 
of the account you want to delete. 

2. Choose the Delete command from the User menu or press the Del 
key. User Manager presents a dialog box that warns you of the 
consequences of deleting a user account. Click OK. 

User Manager 

Each user account is represented by a unique identifier 
which is independent of the username. Once this user 
account is deleted. even creating an identically named 
user account in the future will not restore access to 
resources which currently name this user account in the 
access control list. 

3. User Manager presents a dialog box that asks you to confirm the 
deletion. Click Yes to delete the user account or click No to cancel 
the deletion. 

When you delete a user account, the account is removed from any 
groups to which the user belonged. If the user owned any system resources, 
those are marked as being owned by a deleted account. A system adminis­
trator can take ownership of the resources and assume responsibility for 
managing them from that point onward. 

Setting Account Policies 
A system administrator can set certain policies regarding passwords and 
accounts. To do so, choose the Account command from User Manager's 
Policies menu. You'll see the Account Policy dialog box, similar to the one 
shown on the next page. 
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Compuler: ONNl1 

Naximum Password Age-

o (~:~!!!i:i?~~::!i~:i.~:i:::~~p.[i:~!l 
@ lxpires In ~ Days 

Account Policy 

Ir~"'YiK'''''w~1 

Ninimum Password Age----, l~caneer:1 

@ Allow Changes Immedialely Ir~"ReipY"';"1 
o Allow J;.hanges In CtB Days 

Ninimum Password Lenglh- Password Uniqueness-----, 

@ Per mil .!!Iank Password @ .Qo Nol Keep Password Hislory 

o AI.!..easl CI Characlers 0 Remember c=t9 Passwords 

The Account Policy dialog box is divided into four group boxes: 
Maximum Password Age, Minimum Password Age, Minimum Password 
Length, and Password Uniqueness. 

The Maximum Password Age settings dictate how long a password 
remains valid before it expires. Select the Password Never Expires option 
box if you want passwords to remain valid indefinitely; otherwise, select 
the Expires In option button and type the number of days an account 
password will remain valid. 

The Minimum Password Age settings let a system administrator set the 
amount of time a password must be used before the user is allowed to 
change it. Select the Allow Changes Immediately option button to specify 
that a password can be changed at any time; otherwise select the Allow 
Changes In option button and type the number of days that must pass before 
a user is allowed to change the password. This can help prevent users from 
changing passwords excessively, which often results in a user forgetting the 
password and then pestering a system administrator for help in resetting the 
password. 

The Minimum Password Length setting forces users to have passwords 
that are longer than or equal to a certain number of characters. Select the 
Permit Blank Passwords option button to remove this limit; otherwise, select 
the At Least option button and type the minimum password length. This 
forces users to provide a password that is more secure, because longer 
passwords are generally harder to guess. 

The Password Uniqueness setting can be used to force users to pick 
a password that they haven't used recently, rather than reusing an old one. 
When a password expires, many users avoid the hassle of remembering a 
new password by alternating between two passwords, thereby reusing the 
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same passwords over and over again. This compromises security. To avoid 
this problem, a system administrator can select the Remember Passwords 
option button and specify the number of most recently used passwords to 
be remembered by Windows NT. When the user changes his or her pass­
word with this option in effect, the system compares the new password to 
the list of remembered passwords. If there is a match, the new password is 
deemed unacceptable and the user is not allowed to make the change. 

Each user and each member of a group has a list of rights associated with 
his or her account. Choose the User Rights command from User Manager's 
Policies menu to change these rights. The User Rights Policy dialog box 
appears, similar to the one shown here: 

Computer: ONNI1 

Righ!: 

!irant To: 

,6,dr(ut"u ~tr,,,tor~ 

Everyone 
Power Users 

o ,[how Advanced User Rights 

IB_!11 

"BiI' 
This dialog box allows you to see which users and which groups of 

users have a given right. To do so, select a right from the Right drop-down 
list box. The right selected in the drop-down list in this example has been 
granted to the groups Everyone, Administrators, and Power Users. To re­
move a right from a given group or user, select the user or group in the 
Grant To list box and click Remove. This revokes the right from the user or 
group and updates the list box accordingly. 

Only the basic system rights are initially available in the drop-down 
list of rights. To see a complete list of rights, select the Show Advanced User 
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Rights check box. This adds the advanced system rights to the list. The 
drop-down list of rights is then more crowded, but it contains all manageable 
system rights. 

To grant a right to a user or group, click Add. The Add Users and 
Groups dialog box appears, as shown below. This dialog box is very com­
mon in Windows NT security applications. 

Add Users and Groups 

List Names From: L..::I ~~\\_OM_N_11· _____ .JoI!J ... t 
H.ames: 

Admlnlstlators Members can tully administer the computer/damar, 
Backup Operators 
Everyone 
Guests 
INTERACTIVE 
NETWORK 
Power Users 
Replicator 
Users 

A.!!.d Names: 

Members can bypass file security to back up files 
All Users 
Users granted guest access to the computer/doma 
Users accessing this obiect locally 
Users accessing this obiect remotely 
M embers can share dilectories and printers 
5 upports file replication in a domain 
Ordinary users 

The Add Users and Groups dialog box lets you build a list of users 
and groups by selecting them from the Names list box and clicking Add to 
move the users or groups to the Add Names list in the bottom part of the 
dialog box. To remove a user or group from the Add Names list, highlight 
the name of the user or group you want to remove and press the Del key. 
You can also use the Ctrl+C and Ctrl+V keystrokes to copy and paste names, 
or you can even type names into the list. 

Initially, the Names list box contains only the names of groups. How­
ever, you can request that usernames be shown by clicking Show Users. 
The usernames are added to the list, and you can add them to the Add 
Names list. 

If you manage a system that is frequently accessed via the network, 
you might be interested in adding users and groups from other domains. 
To do so, select a domain in the List Names From drop-down list box; the 
Names list is updated to show the users and groups in that domain. 
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You can expedite your search for a user by clicking Search. The Find 
Account dialog box appears, similar to the one shown here: 

Find Account 

Find.!!.ser or GrouP:L-' _________ ----' 

@ Search All 

o Search Qnll' In: 

~ \\OMNI1' 

Search!!esulls:----------------I 

The Find Account dialog box allows you to search in all domains or 
only selected ones, and you can match accounts based on partial names. 
In the Find User or Group text box, type the username or group you want 
to find and click Search. The Search Results list box at the bottom of the 
Find Account dialog box lists all of the matching accounts. Click Add to 
close the Find Account dialog box and bring the found names back to the 
Add Names list in the Add Users And Groups dialog box. 

When you are done building your list of names to add, click OK to 
close the Add Users and Groups dialog box and to bring the names back 
to the list of users and groups in the User Rights Policy dialog box. Click 
OK to grant the selected right to the users and groups in the list. 
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Attaching Security to Files 
File Manager's Security menu has commands that let you set permissions 
for files on NTFS volumes. You can control who can access files, and 
you can specify exactly what they can do with those files. 

Attaching Security to Directories 
When you change permissions for a directory, you also change the 
permissions for files within the directory. 

The User's View of Security 
Here's what you'll see when you haven't been granted appropriate per­
mission for a file or directory. 

Security on New Files and Directories 
New files and directories inherit the permissions associated with the 
directory in which they are created. 
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indows NT provides the ability to secure access to many 
shared resources. Probably the most obvious and impor­

tant securable shared resource is the file system. You can set up your 
Windows NT system so that you have complete control over any user's 
ability to read, write, create, or modify your shared resources, regardless of 
which file system you use-FAT, NTFS, or HPFS. Windows NT can also 
manage security for local users of your files and directories, but only for 
one file system-NTFS. 

This chapter discusses how to use Windows NT to manage security of 
your NTFS files and directories. We'll examine the security measures that 
File Manager provides, and take a look at the different permissions you can 
apply to files and directories. 

Attaching Security to Files 
The Windows NT file system, called NTFS, stores a great deal of information 
about each file. Other file systems you might be familiar with, such as a FAT 
partition under MS-DOS, store information such as the file's name, size, and 
last modification date and time. In addition to storing all of this information, 
NTFS also manages an access contra/list, or ACL, which defines the type of 
access that users have to the files and directories on the system. Every file 
and directory stored on an NTFS partition has an ACL associated with it. 
For more information about ACLs, see "An Overview of Windows NT Se­
curity," page 314. 

NTFS file security is managed using File Manager's Security menu 
commands-Permissions, Auditing, and Owner. We discuss the Permissions 
and Owner commands in this chapter. For information about the Auditing 
command, see Chapter 12, "Auditing Security," page 349. 

The commands on File Manager's Security menu are disabled when 
they are not appropriate. If File Manager's currently active window is not 
an NTFS partition, for example, the commands on the Security menu are 
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disabled because security is implemented only for NTFS partitions. Some 
or all of the Security menu commands might also be disabled for a selected 
file or directory if you are not the owner of the file or directory, and the 
owner has not assigned you access privileges. 

When you select a file in File Manager and. choose the Permissions 
command from the Security menu, a File Permissions dialog box appears, 
similar to the one shown below. 

file: C:\WINNT\WIN.lNI 

!!wner: Administrators 

Harne: 

File Permissions 

It Administrators Full Control (All) 
<!t Everyone 
~SYSTEM 

Change (RWXD) 
Full Control (All) 

!ype of Access: L-IF_ul_1 C_o_n_tro_I ________ ..... I!!I_' 

If you are not the file's owner, you might be warned that you are only 
allowed to view-but not change-the permissions for the file. In this case, 
the Add and Reinove buttons in the File Permissions dialog box are disabled. 

You use this dialog box to view and change a user's access to a file. 
In this example, the dialog box shows that the selected file, WIN.INI in the 
WINNT directory on drive C, is owned by the Administrators group. The 
Name list box shows that the file's ACL has three entries-one for the 
Administrators group, one for the Everyone group, and one for a special 
user called SYSTEM. (SYSTEM is not really a user; it is the Windows NT 
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operating system itself.) The right side of the Name list box displays the 
type of access each user or group has to the selected file. In this example, 
the Administrators group has Full Control access and the Everyone group 
has Change access. 

Access Types and Permissions 
You can think of the access types listed in the Name list box as shorthand 
for specific combinations of permissions. In this example, the letters RWXD 
after the Change access type indicate the specific permissions. Table 11-1 
shows the individual permissions and their abbreviations. 

R Read Allows the user to view the contents 
of the file 

W Write Allows the user to change the 
contents of the file 

X Execute Allows the user to run the file­
which is useful only if the file is an 
executable file, such as an EXE file 
or a BAT file 

D 
p 

0 

TABLE 11-1. 

File permissions. 

Delete 

Change 
permissions 

Take 
ownership 

Allows the user to delete the file 

Allows the user to modify the 
permissions associated with the file 

Allows the user to assume ownership 
of the file 

There are four predefined access types. Table 11-2 shows the individ­
ual permissions that each access type includes. 



No Access 

Read 

Change 

Full Control 
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None 

Read and Execute (RX) 

Read, Write, Execute, and Delete (RWXD) 

All 

I •• 

I· 

~--------------------------------------------------------~ ... 

TABLE 11-2. 

Predefined access types. 

For many situations, the predefined access types do not provide 
enough control over the access that a user or group has to a file. For 
example, you might want a user to be able to display a file's permissions, 
which requires Read, Write or Execute permission for the file. But you might 
not want to give the user Change access because Change includes all of 
these permissions plus Delete. To accommodate such situations, you can 
assign permissions individually. To do this, select the user name or group 
whose access privileges you want to modify in the Name list box, and then 
select Special Access from the Type of Access drop-down list. File Manager 
displays the Special Access dialog box, similar to the one shown below. 

Eile: C:\WINNT\WIN.lNI 

Name: Administrators 

@ Full Control (All) 

Olher 

DRead (RJ 

D Write [W) 

D Eliecute (X) 

D .Jlelete (0) 

D Change f.ermissions (P) 

D Take Qwnership (0) 

Special Access 

I f:\~\~i1iJK1'T~::1:Il 
I r?!TE~n1:1iri~~~1 
I tTJrHli;~~;~1 
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To give the user or group full control over the file, select the Full 
Control option button. Otherwise, select the Other option button and select 
the check boxes associated with the permissions you want the user or group 
to have. Click OK to save the changes or click Cancel to close the dialog 
box without saving the changes. 

How Conflicts Are Resolved 
User groups provide an easy way to assign and revoke access to files and 
directories for many users. However, the effects of adding and removing 
permissions to a group are sometimes problematic. The most obvious prob­
lem involves granting access to a group when a group member's access 
privileges have been explicitly revoked. (For more information about user 
groups, see "Managing Groups," page 320.) 

When making security changes, it is important to understand that 
permissions are cun1ulative. Therefore, you should always review a group's 
membership to be sure you are not granting a permission to someone who 
should not have that permission. For example, let's examine a scenario 
involving two users: Anthony, a member of the Human Resources group, 
and Melinda, a member of the Accounting group. Anthony has Read per­
mission for the JANUARYXLS file in the PAYROLL directory. Melinda has 
Change access to this file. 

If Delete permission for the file is given to the Human Resources group, 
Anthony receives that permission because he is a member of the Human 
Resources group. Because permissions are cumulative, Anthony continues 
to have Read permission for the file, but also gains Delete permission. 

The No Access access type is an exception to the cumulative rule. It 
overrides all other permissions, regardless of how the No Access access type 
or the individual permissions were assigned. If the Human Resources group, 
for example, is given No Access to the file, Anthony is denied access to the 
file-even if you explicitly give him Full Control access. 
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WINDOWS TIP: Because permIssIons are cumulative, 
you must devise your security management strategy with 
some care. Perhaps the simplest approach is to rely on 
groups for all security settings, rather than making settings 
and modifications for individual users. Instead of ap­
proaching the problem as granting access to users for par­
ticular files, think of granting access to groups. Do this 
only once-and then add and remove users from the 
groups. 

In our example, the Accounting group should have 
Change access to the accounting· files. Because Melinda 
works in Accounting, she is a member of the Accounting 
grou p and has all of the same permissions as her 
coworkers. However, there might be another group of 
users with greater·access to the accounting files-perhaps 
called Accounting Supervisors. This group has Full Control 
access to all accounting files. If Melinda is promoted to. a 
management position; her new access needs can be 
addressed by moving her from the Accounting group to 
the Accounting Supervisors group. Ifher access is modified 
directly, she might not automatically receive all of the per­
missions she needs. Furthermore, in a large organization, 
explicitly managing permissi?ns for individual users can 
become very tedious. 

Changing Permissions for a File or Directory 
Although it is easiest to administer file access privileges by adding users to 
groups that have certain file permissions, one or more users might need 
access privileg~s not given to any group. In this case, you need to explicitly 
change a user's permissions. In other situations, you might want to update 
the permissions for an entire group. 
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You can alter a user's or a group's access privileges to a file or directory 
by doing the following: 

1. Use File Manager to select the drive that contains the file or directory. 

2. Select the file or directory. 

3. Choose the Permissions command from the Security menu. 

4. When the File Permissions dialog box shown on page 335 appears, 
select the user or group (in the Name list box) whose access 
privileges you want to change. 

5. Select the new access type from the Type of Access drop-down list. 
Or, if you want to give the user or group a special combination of 
permissions, select Special Access from the Type of Access drop­
down list. This opens the Special Access dialog box, shown on page 
337, where you can select individual permissions. 

6. If you've used the Special Access dialog box, click OK to return to 
the File Permissions dialog box. 

7. If you need to make changes to the permissions for other users or 
groups, return to step 4. Otherwise, click OK in the File Permissions 
dialog box to save the changes you've made. 

WINDOWS TIP: Remember that you can select more 
than one file in File Manager. If you do this before 
choosing the Permissions command, the changes you 
make affect all of the selected files. 

Take care when changing the access privileges of groups. Before 
proceeding, you might want to first determine who is in the group, as 
described in the next section. 
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Adding a User or Group 
If the user or group whose access privileges you want to change is not listed 
in the Name list in the File Permissions dialog box, follow these steps: 

1. Click Add in the File Permissions dialog box to bring up the Add 
Users and Groups dialog box, shown below. 

Add Users and Groups 

L.is! Names Flom:\ L...:: ~,,---\\_OM_~l_I1' _____ ~liJ_ 
Names: 

Everyone 
Guests 
INTERACTIVE 
NETWORK 
Power Users 

,l} R eplicator 

"'~ SYSTEM 
Users 

A!!d Names: 

All Users 
Guests of the domain 
Users accessing this obiect locally 
Users accessing this obiect remotely 
M embers can treat the computer as their own 
Members can administer domain controller rep 
The operating system 
Ordinary users of the domain 

IYpe of Access: IL-R_ea_d _____ -JI_;!J 

2. Select the group you want to add. Click Show Users if you want to 
add a user. You can hold down the etrl key and select more than 
one username or group name. 

3. Click Add. The names you selected are added to the Add Names list 
in the bottom part of the dialog box. You can directly edit this list 
by typing in usernames and group namess separated by semicolons, 
or by deleting usernames or group names. 

4. If you need to add more usernames or group names, return to step 
2. Otherwise, click OK to close the dialog box and return to the File 
Permissions dialog box. 

If you have a large number of users or groups, you can find users or 
groups by clicking Search in the Add Users and Groups dialog box. This 
opens the Find Account dialog box, which allows you to search for users 
more easily. 
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When you want to see which users belong to a particular group, select 
the group in the Names list in the Add Users and Groups dialog box and 
click Members. This opens the Local Group Membership dialog box, which 
allows you to select the names of users to be added, or to simply view the 
names of users in the group. 

Taking Ownership of a File or Directory 
It is sometimes necessary for a system administrator to take ownership ofa 
file or a directory. For example, if a user who owns a file will no longer be 
responsible for its maintenance, a system administrator can take ownership 
of the file before granting ownership to another user; another user can also 
take ownership of the file directly. 

In order to take ownership of a file or directory, you must have Take 
Ownership permission for the file or directory. To take ownership of a file 
or directory, follow these steps: 

1. In File Manager, select the drive that contains the file or directory . 

. 2. Select the file or directory you want. 

3. Choose the Owner command from File Manager's Security menu. 
The Owner dialog box appears, as shown below. 

Owner 

file Name: C:\WINNT\WIN-INI 

Qwner: Administrators 

4. Click Take Ownership. 

Remember that a file can have only one owner. If you take ownership 
of a file, you take' the ownership away from another user. However, it is 
also possible for a group to own a file. In that case, all members of the 
group have Creator/Owner access to the file. 
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WINDOWS TIP: To see who owns a file, select the file 
in File Manager and choose the Owner command from the 
Security menu. Close the Owner dialog box without click­
ing Take Ownership. 

Remember that the user who creates a file or directory is the owner 
of that file or directory (until ownership is taken by someone else). Although 
every member of the Administrators group has the power to take ownership 
of the file or directory, the owner always has the final say on who has access 
to the file. 

Throughout this chapter, we've talked about setting permissions for files 
and directories. Although the effects of setting permissions for files and 
directories is mostly the same, there are some important differences. 

Most importantly, when you change the permissions for users' access 
to a directory, you also change the permissions for the files within the 
directory. However, permissions for the directory's subdirectories and the 
files in the subdirectories are not changed, unless you explicitly request that 
the changes you make to the directory's permissions be propagated to those 
subdirectories and files. 

Because changes to a directory's permissions might change the per­
missions associated with a particular file, the Name list box in the Directory 
Permissions dialog box, shown on the next page, displays two different 
groups of permissions. The permissions in the first group are the permissions 
for the directory; the permissions in the second group are permissions for 
the files in the directory. Note the Replace Permissions on Subdirectories 
check box. Select this check box if you want your changes to be propagated 
to all of the directory's subdirectories and the files in those subdirectories. 
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Directory: C:\WINNT\SYSTEM32 

Qwner: Administrators 

o R~lace Permissions on Subdirectories 

H.ame: 

u..._.:l:1 

~ CREATOR OWNER 
~ Everyone 
<PSYSTEM 

Full Control [All) [All) 
Change [R\vXO) [R\vXO) 
Full Control [All) [All) 

I1'pe of Access: I L-F_u_" _C_on_t_ro_' _________ If!1_'" 

The table below shows the different access types and permissions that 
are predefined by Windows NT. The major difference between this list and 
the list of the file access types and permissions (Table 11-2 on page 337) is 
that directories can be secured against reading. If a user does not have Read 
permission for a directory, he or she cannot see the files within that directory. 
(The user might see subdirectories, however, if the user has Read permission 
for the subdirectories.) Windows NT security is very stringent in this respect. 
Not only can a user be denied access to files, he or she can be prevented 
from even knowing what files are in a directory. 

No Access None None 

List Read and Execute Not Specified 

Read Read and Execute Read and Execute 

Add Write and Execute Not.Specified 

Add & Read Read, Write, and Execute Read and Execute 

Change Read, Write, Execute, and Read, Write, 
Delete Execute, and Delete 

Full Control All All 
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The Type of Access drop-down list in the Directory Permissions dialog 
box has two additional options. One is Special File Access and the other is 
Special Directory Access. The Special File Access option works in the same 
manner as the Special File Access option in the File Permissions dialog box. 
Selecting it brings up the Special File Access dialog box, which allows you 
to customize the permissions assigned to the files in the selected directory. 
The Special Directory Access option brings up the Special Directory Access 
dialog box, shown below. This dialog box is nearly identical to the Special 
Access dialog box, but instead of modifying the permissions for the files in 
the selected directory, it modifies permissions for the directory itself. 

Special Directory Access 

Directory: C:\WINNT 

Hame: Administrators 

@ Full Control (All) 

Other 

DRead (R) 

o Write (W) 

o E~ecute (X) 

o ,Ilelete (D) 

o Change fer missions (P) 

o Take .Q.wnership (0) 

I rVIOKTITV~;1 
I F0;Cari~etl;l~q 
1~~llelp~~TI 

As in the Special File Access dialog box, select the Full Control option 
button to give the user full control over the selected directory. Or select the 
Other option button and select the appropriate permissions check boxes to 
specify exactly which permissions you want to grant to the user. 

To change the permissions for a directory, follow these steps: 

1. Select the directory in File Manager. 

2. Choose the Permissions command from File Manager's Security 
menu. (If that command is disabled, you have selected a directory 
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that cannot be protected. This might be because the directory is on 
a drive that is not an NTFS partition, or you might not own the 
directory.) The Directory Permissions dialog box appears. 

3. Select a user or group in the Name list box. If you want to add a 
new user to the list, click Add. This opens the Add Users and Groups 
dialog box, which lets you add users to the Name list box in the 
Directory Permissions dialog box. For more information about 
adding a user or group, see "Adding a User or Group," page 341. 

4. Select the access type you want to set for the user or group in the 
Type of Access drop-down list. If you want to set up custom access 
for the directory, select Special Directory Access or Special File 
Access, as appropriate. 

5. If you need to make changes for more users, repeat these instruc­
tions starting with step 3. Otherwise, click OK to save the changes 
or click Cancel to close the dialog box without saving the changes. 

Click Remove to remove the currently selected user or group in the 
Name list box. This resets the user's or group's access to No Access. Re­
member that if the user or group is not specifically given access to a file or 
directory, that person or group does not have access. 

The User's View of Security 
We've discussed the different features that are available to system adminis­
trators and file owners for setting file permissions. Now let's now look at 
the way everyday system users are affected by security. 

When a user attempts to perform an operation on a secured file, 
Windows NT checks the file's access control list. If the ACL allows access, 
the user's request is granted. However, if the user does not have access 
privileges to the file, the request is denied. The exact error message the user 
gets depends on which application is running. For example, an attempt to 
delete a protected file in File Manager results in a dialog box message similar 
to the one shown on the next page. 
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Confirm: Ignore file or directory and continue 

r(\ Access is denied. ignore: C:\WINNT\WIN.lNI? 

\..iJ You do not have permission or the file is in use. 
Click yes to ignore this file and continue operation. 

File Manager detects that the file cannot be deleted by the current user, 
and offers to ignore the error and continue operation. If the user clicks Yes, 
the file isn't deleted, but the requested operation continues for any other 
selected files. If the user clicks No, the operation is discontinued. 

Attempting to delete the same file at a command prompt results in an 
error message similar to this: 

C:\winnt>erase win.ini 
Access is denied. 

If the user's command was to delete several files, the system displays 
an error message for each restricted file and deletes selected files that are 
not restricted. 

Security on New Files and Directories 
So far, our discussion of security has dealt with security settings on existing 
files and directories. To complete your understanding of Windows NT file 
security, you should understand how security affects newly created files 
and directories. 

The rule is very simple: New files and directories assume the permis­
sions associated with the directory in which they are created. For example, 
if you create a file in a directory to which the Accounting department has 
Change access and the Human Resources department has Full Control ac­
cess, the Accounting department has Change access and the Human Re­
sources department has Full Control access to the newly created file. 
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About Auditing 
Windows NT can monitor successful and unsuccessful accesses to any 
system resource. 

Auditing File and Directory Access 
Using File Manager to set up auditing of directories and files can make 
you aware of unauthorized attempts to access your data. 

Auditing Access to Printers 
Setting up audits for your printers lets you keep an eye on their usage. 

Auditing Other User Activities 
Using the User Manager to set up auditing for user activities is the final 
step in making your system's security completely airtight. 
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hile Windows NT provides system administrators with the 
ability to control the security of files and other system 

resources by setting permissions and rights, it is often helpful to have a 
method of actively monitoring use of the system. For example, if users 
repeatedly attempt to log on with improper passwords, it might be an 
indication that unauthorized users are trying to gain access to the system. 
Or, repeated failures at accessing a directory or file might indicate that some 
software was incorrectly installed or that security for the file was improperly 
set up. 

To this end, Windows NT provides the ability to audit security by 
recording attempts at accessing system resources. In this chapter, we exam­
ine the various auditing tools at the disposal, of a system administrator or 
resource owner. We examine their purpose and use, and explain what 
information they supply when used properly. 

About Auditing 
When a user attempts to access a system resource, Windows NT checks the 
resource's access control list to determine whether the user should be 
allowed access. This is the essence of Windows NT security. 

If auditing of events is enabled, you can also request that Windows 
NT audit access to a given resource~ (For information about enabling audit­
ing of events, see "Auditing Other User Activities," page 359.) Windows NT 
will record (in a file called a log) any attempts to access a given resource. 
You might want to request that Windows NT record all failed print jobs on 
a given printer, for example, or record all failed file-read requests for a 
certain directory. Windows NT stores this information in the security log, 
one of the three system-wide logs that Windows NT manages. Windows NT 
also manages a system log,' which records events that are generated by 
components of Windows NT, such as display or network drivers, and an 
application log, which records events generated by applications. For exam­
ple, a database application might generate events when it detects a corrupt 
file or a corrupt index. 
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Event Viewer 
Before we examine auditing in File Manager and Print Manager, let's first 
take a look at Event Viewer-the administrative application that allows you 
to examine the events that have been recorded. The icon for Event Viewer 
is in the Administrative Tools group in Program Manager. You must be a 
member of the Administrators group, or have been explicitly granted access 
by a system administrator, to view Event Viewer's security log. The following 
illustration shows an Event V iewer window with some typical events. 

'·Ii;'; 
1.og Yiew .Qptions .!:!.elp 

Date'''' . "'liimct . \]SoiJrce' ················· •• ·ICiiegory"· ">IEvent "lOser'···· ';lcompUier;i~" 
: I 

06/29/93 9:47:40 PM Serial None 25 N/A OMNI1 
06/22/93 9:40:16 PM Service Control Manager None 7026 N/A OMNI1 
06/22/93 9:39:43 PM Serial None 25 N/A OMNI1 
06/8/93 12:41:27 AM Service Control Manager None 7026 N/A OMNI1 
06/8/93 12:41:01 AM Serial None 25 N/A OMNI1 
05/12/93 10:02:49 PM Print None 10 N/A OMNI1 
05/12/93 10:00:42 PM Parallel None 15 N/A OMNI1 
05/12/93 10:00:40 PM Parallel None 15 N/A OMNI1 
C5/12/93 10:00:16 PM Parallel None 15 N/A OMNI1 
05/12/93: 7:56:07 PM Service Control Manager None 7026 tVA OMNI1 
C 5/11/93 7:35:44 PM Service Control Manager None 7026 tVA OMNI1 

T.he window's title bar identifies the application as Event Viewer, and 
also shows that the system log is selected. You can use Event Viewer to 
examine any of the three logs-system, security, or application-by choos­
ing the appropriate command from Event Viewer's Log menu. The currently 
selected log is indicated by a check mark next to its name on the Log menu, 
as shown below . 

II Yiew .Qptions .!:!.elp 

Se.!;urity .. . -
Application None 25 N/A OMNI1 

.Qpen ... Control Manager None 7026 N/A OMNI1 
None 25 N/A OMNI1 

Saye As ... 
Control Manager None 7026 N/A OMNI1 

Clear All Events None 25 N/A OMNI1 

Log Settings ... None 10 N/A OMNI1 
~lone 15 N/A OMNI1 

,S.elect Computer ... None 15 N/A OMNI1 

E~it AlttF4 None 15 N/A OMNI1 
Control Manager None 7026 N/A OMNI1 

05/11/93 7:35:44 PM Service Control Manager None 7026 N/A OMNI1 
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Because this chapter deals with security, we'll concentrate on the 
security log. (For more information about Event Viewer and other logs, see 
"Monitoring System Activities with Event Viewer," page 716.) If you select 
the security log by choosing the Security command from the Log menu, 
Event Viewer's window changes, as shown here: 

Qptions !:!.elp 

a ego 
11:08:35 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:08:29 PM Security Logon/Logoff 537 SYSTEM OM Nil 
11:08:21 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:07:51 PM Security Logon/Logoff 537 SYSTEM OM Nil 
11:07:21 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:07:09 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:07:08 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:07:07 PM Security Logon/Logoff 537 SYSTEM oMNll 
11:07:07 PM Security Logon/Logoff 537 SYSTEM oMNI1 

I I .. 

This example seems to indicate that an unauthorized user has been 
attempting to gain access to the system. By examining the dates and times, 
you can see a close relationship between all of the security logon/logoff 
events-they happened within a few minutes of each other. By contrast, 
the events in the first illustration on page 351 were widely and randomly 
spaced, suggesting that they were the result of normal system operation. 
(For information about the icons in the security log, see "Viewing a Log," 
page 719.) 

If you want more information about an item in the log, select the item 
and choose the Detail command from Event Viewer's View menu. The Event 
Detail dialog box appears, similar to the one shown on the next page. 

It appears that someone has tried to log onto DHILL's account. You 
can examine other entries in the log using the Detail command, by selecting 
the item and pressing the Enter key, or by double-clicking the item. 

If you were viewing a system event or an application event, the bottom 
list box in the Event Detail dialog box would provide pertinent binary 
(hexadecimal) information about the device, command, record, .or file that 
caused the event. The data that can be shown in this list box is very specific 
to the type of event recorded. For more information about this binary data 
and an example, see "Taking a Closer Look," page 720. 
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Event Detail 

Date: 6/30/93 Event ID: 537 
Time: 12:05:26 AM Source: Security 
!J.ser: NT AUTHORITY\SYSTEM Type: Failure Audit 
CO!!!puter: OMNI1 Category: Logon/Logoff 

Q.escription: 

~ogon Failure: 
Reason: An unexpected error occured during logon 
User Name: dhill 
Domain: OMNI1 
Logon Type: 
Logon Process: 
Authentication Package: 

MICROSOFT_AUTHENTICATION_PACKAGE_VCO 

. By carefully examining all of the events, you might be able to find a 
pattern in the attempts to gain access to the system. You can take measures 
to tighten up security, such as warning users to change their passwords, 
and monitoring the security log more closely. 

In addition to letting you view a log and event details as described 
here, Event Viewer has some powerful features that let you dictate the way 
the system maintains event logs. For information about Event Viewer's other 
features, see "Monitoring System Activities with Event Viewer," page 716. 

Auditing fUe and Directory Access 
You can use the Windows NT File Manager to request that Windows NT 
audit certain files or directories in your system. While this is a useful tech­
nique for monitoring access to your system, you should be careful when 
auditing busy directories or files-and be particularly careful about auditing 
successful accesses. Each time a user successfully completes an' operation 
on the file or directory, the system writes a record to the security event log 
to reflect the access. 
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WINDOWS TIP: Avoid auditing too many successful 
events. The overhead incurred by continually writing 
event records to the security log can severely degrade 
system performance. . 

~-----------------------------------.--... -.-.--.-.. -----.-.-.. -... --... ----.. ---., .. ~ .... 

The Windows NT File Manager allows only members of the Adminis­
trators group to audit files and directories. Windows NT can audit a variety 
of events, and can audit different events for different users. To audit a file, 
select the file in File Manager and choose Auditing from the Security menu. 
The File Auditing dialog box appears, similar to the one shown below. 

File Auditing 

[ile: C:\USERS\DEFAULHdhill\dhili resume. doc 

Name: 

I~ Administrators 

~ Everyone 

E yents to Audit 

Success 

Read [2J 
~rite [2J 
E.!!.ecute 0 
Itelete 0 
Change fermissions 0 
Take .Q.wnership 0 

Failure 

[2J 
[2J 
[2J 
[2J 
[2J 
[2J 

1~1ro'tlm 

I~s~a~il 
Ifll~~l'l 
l~miOVil;1 
IrSl"ll~1f1't"~l1 

If an event's Success check box is selected, Windows NT generates a 
security log record containing (among other things) the time and date of 
each each successful attempt at the event by the specified user or group for 
the specified file. Similarly, if an event's Failure check box is selected, 
Windows NT generates a security log record each time the specified user 
or group unsuccessfully attempts the event for the specified file. The Event 
Detail dialog box shown on the next page shows a record of a successful 
event in the security log. 
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1- • 

Date: 6/30/93 Event 10: 560 
Time: 2:29:30 AM Source: Securit~ 

J!ser: dhill Type: Success Audit 
COmPuter: OMNl1 Category: 0 bject Access 

n.escription: 

Object 0 pen: 
Object Server: Securit~ 
Object T ~pe: File 
Object Name: C:\USERS\DEFAULT\dhill\dhili 

resume_doc 
New Handle ID: 
Operation ID: {O.38756} 
Process ID: 150 
Primary User Name: dhill 
Primary Domain: OMNl1 

D.i!ta: @ fuotes 0 '!'£ords 

I'~ 
NOTE: File auditing cannot occur unless the auditing of events is 

enabled using User Manager's Audit Policy dialog box. (Security 

checks still occur when the auditing of events is disabled.) Note 

that the auditing of successful events and failed events can be 

enabled or disabled independently. For more information about 

User Manager's Audit Policy feature, see "Auditing Other User 

Activities," page 359. 

To audit file or directory access by a user or a group, take these steps: 

1. Use File Manager to select the file or directory whose access you 
want to audit. Remember that you can select more than one file or 
more than one directory. 

2. Choose the Auditing command from File Manager's Security menu. 
The File Auditing dialog box or the Directory Auditing dialog box 
(shown on the next page) appears, depending on whether you 
selected a file or a directory. 
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Directory Auditing 

Directory: C:\FlSHING 

o R!tlIlace Auditing on Subdirectories 

[8J Replace Auditing on Existing files 

Events to Audit------------, 

Success Failure 

Read 0 0 
~rite 0 0 
El!.ecute 0 0 
!!elete 0 0 
Change fermissions 0 0 
Take !!wnership 0 0 

IFfl~lll;j'~iiR;1 

I fltC&\Clil'ftt1 
I J0\:;aa~\i~rl 
Ip~1l1iiV'iNl 
I rN1felPi:'l~;1 

3. In the Directory Auditing dialog box, you'll find the Replace Auditing 
on Subdirectories and Replace Auditing on Existing Files check 
boxes. Select the Replace Auditing on Subdirectories check box to 
have your auditing selections replace the exisiting auditing selec­
tions Of any) for all subdirectories of the selected directory and all 
files in the subdirectories. 

The Replace Auditing on Existing Files check box is selected by 
default, which means that the your auditing selections will replace 
existing auditing selections Of any) only for selected directory and 
its files. Deselect the Replace Auditing on Existing Files check box 
to have your auditing selections apply to the selected directory, but 
not to its files. 

4. Select the username or group whose access to the file or directory 
you want to audit, and then select the appropriate check boxes in 
the Events to Audit group box. If you don't see the username or 
group whose access you want to audit, click Add and follow the 
procedure for adding usernames and groups to the Names list box 
described in "Setting User Rights Policies," page 330. 

5. Click OK. 
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Audiiing Access fro Printers 
Windows NT allows the owner of a printer to both set and audit access to 
the printer. All of the printer security features are managed through the 
Windows NT Print Manager. 

Members of the Administrators group can enable the auditing of printer 
access by following these steps: 

1. Select the printer's window or icon in Print Manager. 

2. Choose the Auditing command from Print Manager's Security menu. 
The Printer Auditing dialog box appears, as shown below. 

Printer: ELLIS 

Name: 
.~ Account Oper aters 

CREATOR OWHER 
Domain Users 

, Ever one 

E vents to Audit 

frint 

[ull Control 

J!.elete 

!;.hange Permissions 

lake Ownership 

Printer Auditing 

Success 

0 
0 
0 
0 
0 

Failure 

I2l 
0 
I2l 
0 
0 

Il:':'t';"bf'"~c'71 

I~r~el~~:?il 

Ir~'add;:::':T:1 

1['Remove""1 
IP"Iielp'!"Y"~ I 

3. In the Name list box, select the username or group you want to 
audit. If you don't see the username or group whose access you 
want to audit, click Add and follow the procedure for adding 
usernames and groups to the Names list box described in "Setting 
User Rights Policies," page 330. 
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4. Select the events to audit by selecting check boxes. It is often useful 
to audit unsuccessful print jobs and deletions from the print queue, 
because these events can indicate a problem with the printer or 
difficulty in using the printer. 

5. Click OK. 

When Windows NT logs a printer event such as successful printing or 
deletion from the print queue, the event record is written to the system log. 
Security events, such as attempts to access a printer for which an account 
does not have access rights, result in an event record being written to the 
security log. A successful deletion of a print job generates a record in the 
system log that is similar to the one shown here in the Event Viewer's Event 
Detail dialog box. 

Event Detail 

Date: 711193 Event /0: 10 

Time: 7:30:40 PM Source: Print 
l!.ser: Administrator Type: Information 

CO'!!!puter: OMNI1 Category: None 

.!!escription: 

Document Paintbrush· (Untitled) owned by Administrator was printed on ~ 
ELLIS via port LPTl:. Size in bytes: 154468; pages printed: 0 ;;: 

I

D!!.ta:@fuotes 0 ~ords I~ 
~ 

tl 
~u~'I.s, ~;j,lJ\:l 1\ 1\l1~'n·*, cl'Y)t;'t;,\ll'WA1}:f ;1\1\,\1\ :\<:1;:1\1<\ ,:;:It! ~I: 

NOTE: Printer auditing does not occur unless the auditing of 
events is enabled using User Manager's Audit Policy dialog box. 
(Security checks still occur when the auditing of events is 
disabled.) Note that the auditing of successful events and failed 
events can be enabled or disabled independently. For 
information about User Manager's Audit Policy feature, see the 
next section. 
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Auditing Other User Activities 
While Windows NT offers auditing of access to files and printers via File 
Manager and Print Manager, respectively, the system also provides the ability 
to audit other activities, such as logon and logoff events, and requests to 
shut down or restart the system. These features are provided by User Man­
ager. If you choose the Audit command from User Manager's Policies menu, 
the Audit Policy dialog box appears, similar to the one shown below. 

Computer: 0 M N 11 

o I!.o Not Audit 

Audit Policy 

• lA~.~J(Ih~.~.~·.Iy'.~·~.~.~.~·,f-; ---------, 
Success Failure 

.Logon and Logoff D [g] 
Eile and Object Access [g] [g] 
!J.se of User Rights [g] [g] 
User and !iroup Management D D 
.[ecurity Policy Changes D D 
Restart. Shutdown. and System [g] [g] 
.Erocess Tracking D D 

IFi< OK~';'~':'iil 

IFEanceT~wl 

Ir~Relp ~~tl 

When these events are audited, they generate records in the security 
log and the system log. Note that the Auditing Policy dialog box controls 
auditing for almost all of the system. To audit an event, you must be sure 
that the corresponding check box is selected in this dialog box. 
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Backup Strategy 
The job always goes easier if you use the right tool. You might choose 
a backup tool depending on the amount of data you have, who else 
shares the data, and what backup hardware you have on your machine. 

Backup Tactics 
No matter which tools you choose, backups follow a few simple princi­
ples. Once you understand how backups work, you can decide whether 
to use normal, incremental, differential, copy, or dated backups. 

Using Windows NT Backup 
The Windows NT Backup program is designed to be the workhorse for 
backing up large amounts of data to a tape drive. You can use it inter­
actively, or you can launch automated backups from the command line. 

Using the Bacl{up and Restore Commands 
Nobody. wants to back up a large hard disk to floppy disks, but if you're 
only backing up a directory or two and you don't have a tape drive, the 
Backup command still has enough power for the job. 
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Backing Up with XCopy 
Like a Swiss army knife, the XCopy utility has something for everybody. 
Its backup capabilities might be just what you need for small, specialized 
backup jobs. 
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ou don't have to use computers long to know the frustration 
of losing data. It happens to everyone. Windows NT can't save 

you from the silly little mistakes that everyone makes occasionally, but it 
does provide tools to back up recent copies of data easily, reliably, and 
preferably automatically. 

Because Windows NT is targeted at powerful computers with large 
hard disks in a corporate environment, backup is no longer merely a good 
idea, as it is with MS-DOS; it is a requirement. Furthermore, the built-in 
networking features of Windows NT make it easy to design corporate 
backup strategies in which administrators back up local machines peri­
odically with no intervention by local users. Automatic backup doesn't 
always get you off the hook, however. You might still need to do some 
local backup tasks. 

The other side of backup is restoring. Ironically, making regular back­
ups seems to reduce the likelihood that you'll ever need to restore. Accord­
ing to the Unnecessary Backup Addendum to Murphy's Law, you never 
need to restore until you forget to back up. 

This chapter tells how to lessen the likelihood that disaster will strike 
you, and when it does, how to make it as painless as possible. 

Backup Strategy 
The built-in networking and security features of Windows NT change the 
way you need to think about backup. You won't necessarily follow the same 
procedures you do with MS-DOS or Windows 3.1, even if your MS-DOS 
computer is networked. We'll talk about this subject in two parts: strategy 
and tactics. By strategy we mean the tools and devices you use. By tactics 
we mean how often you back up, how much you back up, and where you 
store your data. Here are a few scenarios to get you thinking about strategies: 

c You have a tape drive installed on your computer. You use 
Windows NT Backup to periodically back up your data to tapes. 
This is a pretty traditional method, and it works fine with Windows 
NT. The only problem is that you need a tape drive and tapes for 
every computer. There ought to be a better way in a networked 
system. 
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c You don't have a tape drive, so you periodically back up your data 
to floppy disks using the MS-DOS backup utilities (BACKUP.EXE 
and RESTORE.EXE). This is how people used to back up when 
hard disks were small and tape drives were rare and expensive, 
and some people still do it that way. It's tedious to keep feeding 
your machine floppy disks, but if that's all you have .... Windows 
NT provides versions of BACKUP.EXE and RESTORE.EXE, but 
you'll probably find them inadequate except for saving a few small 
directories. For one thing, RESTORE.EXE works correctly only with 
the MS-DOS file system (also called the FAT file system). We'll talk 
more later about the problems of restoring an NTFS drive with the 
MS-DOS backup utilities. 

c A key part of your job involves working on files that you share 
with others. The files are located on a network server or on another 
user's disk. Someone else (probably the network administrator or 
the owner of the disk) takes care of backing up the files. In other 
words, backup isn't your problem. This is great, but no doubt you 
have some personal files that you keep on your own disk. You still 
need to back them up. Or maybe the shared files are on your disk 
and other people are counting on you to preserve their data. 

c You and other people working on your project use a source control 
program that automatically coordinates new versions of data files. 
The program keeps a master copy of the data files on a network 
server, where they are periodically backed up by the network ad­
ministrator. You have local copies of data files on your disk, which 
you have checked out from the server to make changes. If your 
local copy gets damaged or destroyed, you can restore from the 
master copy. You might still have some personal files that need to 
be backed up, however, and you might want to back up your local 
copies of the data files. 

c You have a limited amount of data you need to back up-perhaps 
because your important work is stored on a network server or you 
use a source control program. You ask your network administrator 
to assign you some backup space on another network server so 
you can periodically copy your work to the other network server's 
drive, which is backed up by the network administrator. Your 
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network administrator will probably be reluctant to assign large 
amounts of network server disk space for this purpose. Server disk 
space is an expensive commodity, usually reserved for files needed 
by more than one person. 

Il Your network administrator asks you to create an account for him 
or her and put that account in the Backup Operators group for 
your machine. You tell the administrator which directories you 
need backed up regularly, and he or she writes a batch file that 
automatically logs onto your computer every morning at 2 A.M. 
and backs up those directories to an administrator's tape drive. You 
might even be assigned a machine with Windows NT preinstalled 
and everything set up for automatic backup. The backup problem 
is out of your hands. 

The key point of all except the first two scenarios is that someone 
other than you takes care of getting your key data onto a backup tape. You 
can't beat that. Many Windows NT users will find themselves in that circum­
stance. Built-in networking makes corporate solutions to backup the most 
efficient way to protect data. However, you might not be so fortunate. If 
you need to back up some or all of your data, the rest of/this chapter 
describes several ways to do so. 

Backup Tactics 
Over the years, backup tactics and principles have evolved. These principles 
apply no matter what backup tools or media you use. Windows NT Backup· 
supports five common backup methods-normal, incremental, differential, 
copy, and dated. You can perform the same operations with other tools, 
such as the Backup and Restore commands, the XCopy command, or backup 
programs from other vendors. 

Choosing backup tactics involves evaluating tradeoffs between safety 
on the one hand, and time and media space on the other. If safety were 
your only concern, you could backup your entire hard disk every hour on 
the hour. But you wouldn't have any time to work, and you'd spend a 
fortune on backup tapes or disks. If spending minimal time and money on 
backups were your only concern, you might back up only a few crucial 
files once a month. Common sense tells you there must be a happy medium. 
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Back in the old days before Windows NT, competition in the 
backup software field was hot and heavy. The MS-DOS Backup 
and Restore utilities weren't flexible, fast, or reliable enough for 
business use, so several software publishers fought it out, match­
ing and exceeding each other's new features' with each release. 
Eventually even Microsoft got into the act, providing powerful 
new tools with MS-DOS version 6. 

If you're used to backing up to floppy disks instead of a tape 
drive, you might want to use one of these familiar backup tools 
instead of the new Windows NT Backup, which works only with 
a tape drive. For example, if you have flex boot with MS-DOS 6, 
you might have the bright idea of using the character-based 
program MSBACKUP .EXE or the Windows-based program 
MWBACKUP .EXE from a Windows NT command prompt. Unfor­
tunately, you can't. To work efficiently, these backup programs 
are designed to bypass the operating system and directly access 
the computer's hardware. Windows NT doesn't permit this be­
cause any program that bypasses the operating system <;an bypass 
security. Therefore, many powerful backup tools for the MS-DOS 
environment will not work with Windows NT. 

However, the companies with experience in backup technol­
ogy will undoubtedly develop new backup tools for Windows 
NT. Of course, their new programs will need a lot of great features 
to compete with Windows NT Backup, which has one major 
competitive advantage: It's free. 

Backup Principles 
Keep the following simple principles in mind when designing your backup 
procedures: 

D Exclude program files from backups. They never change (except 
for program updates). Back them up once when you purchase 
them. Keep programs in separate directories from data so you can 
easily exclude them from backups. 
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a When the time required to recreate lost files exceeds the time 
required to back them up, it's time to back up. 

a Configuration files change rarely, and are usually easy to recon­
struct. Back them up informally when you make major changes. 

a Focus on data files. These files often change regularly, the changes 
are hard to track, the files are difficult to reconstruct, and the data 
in the files can be very valuable. 

a Don't store your backups near the originals. If your office burns 
down, you'll probably lose both. 

Bacl{up Methods 
Most operating systems, including Windows NT, maintain an archive bit for 
each file. You don't have to understand what a bit is-just think of it as an 
archive check mark for a file on your disk. (We'll call the archive check 
mark an archive marker.) Every file is either marked as needing to be 
archived (backed up), or it isn't marked. This one tiny piece of data is the 
key variable in most backup methods. 

For purposes of this discussion, there are two kinds of applications­
backup programs and other programs. Whenever a non-backup program 
modifies a file, it marks the file as needing to be archived (by setting the 
archive marker), indicating that the file has changed since the last archive. 
The operating system takes care of this; you don't have to worry about it. 
When the backup program sees a file with an archive marker during a 
backup, it backs up the file and clears the archive marker. Next time it sees 
the file, the archive marker is gone (unless you've modified the file again) 
and the backup program knows that it doesn't have to back up the file. 
(Technically, any program can be written to clear the archive marker on a 
file, but by convention only backup programs do so. Backup schemes would 
fail if non-backup programs violated this rule.) 

With this background in mind, let's look at the different kinds of 
backups. 
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Operations on Archive Markers 
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File starts 
out archived 

"""'-A [J" 

File is 
archived 

Non-backup 
program 

A program 
changes 
the file 

Non-backup 
program 

A program 
reads the 
file, but 
doesn't 

change it 

File is 
marked as 
needing 
archive 

File is 
archived 

Backup 
program 

Backup 
program 

~ 

~ ca 
Backup 
program 
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archive 
marker 

Backup 
program 

Backup 
program 
checks 
archive 
marker 

Yes, the file 
needs to be 
archived, 
so copy it 
and clear 
archive 
marker 

Backup 
program 

No, the file 
doesn't 

need to be 
archived, so 
don't copy 
it or clear 
archive 
marker 
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Normal Backups 
A normal backup simply copies all of the selected files and clears any archive 
markers. It doesn't pay any attention to which files have an archive marker. 
The normal backup method is generally used with the incremental and 
differential backup methods described in the next two sections. You do a 
normal backup on a long cycle-say, once a week. You do incremental or 
differential backups on a short cycle-probably daily. This will become 
clear when we discuss the other backup methods. 

Step 1: 

Check 

Step 2: 

Normal Backups 

Archive markers 
are ignored 

Copy CO ~
t[ .. )~?'''''77 .. ;"1~ ..... }'':§,''''((.:".l . 

~ 
. '. '. .... \. '. . .' All selected files 
~ """ X are backed up 

Step 3: 

Mark ~ 

Incremental Backups 

Archive markers 
are cleared 

An incremental backup copies only files whose archive markers are set. It 
then clears the archive markers. The backup disk or tape contains only the 
files changed since the previous backup. For example, you might do a 
normal backup every Friday night and an incremental backup every other 
night of the week. Monday night's backup would contain all of the files that 
changed on Monday, Tuesday night's backup would have Tuesday's 
changes, and so on. If the file CHANGE.DAT changes every day of the week, 
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there would be a separate copy of it in each incremental backup. But if the 
file SAME.DAT changes only on Monday, it would be saved only in Monday's 
backup. 

Now, using these backup tactics, let's assume that disaster strikes on 
Friday afternoon. To restore your week's work, you first restore last Friday's 
normal backup. Then you restore the incremental backups for each week­
day in order. You want the last copy of CHANGE.DAT to overwrite earlier 
copies, but you still have to restore each day's backup because files that 
changed on only one day (such as SAME.DAD exist only on one backup. 
If you need to restore Wednesday's version of CHANGE.DAT, it's available 
on Wednesday's backup. 

Incremental Backups 

Monday Tuesday Wednesday Thursday 

~'% 
Slep I: Slep I: Slep I: ",.v' 

7~ l~ f~ '" C'heck ... Check Check 

Slep3: 

~~ 
Slep3: 

~~ 
Slep3: 

~~ 
Slep3: 

~~ 
Monday Tuesday Wednesday Thursday 

Incremental Incremental Incremental Incremental 

Slep I: 

~?~ 
c'hec~ 

SI;;;~~ .... -;:'!'!J cogi4:Jj 
Slep3: 

~~ 
Friday 

Normal 

Slep3: 

~~ 
Friday 

Normal 
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The advantage of incremental backups is that they are secure, don't 
take long to do, and use less storage space than other methods. The disad­
vantage is that if something goes wrong, restoring can be tedious. 

Differential Backups 
A differential backup copies only files whose archive markers are set, but 
it doesn't clear the archive markers. After the backup, the archive marker 
for evety selected file that changed since the last normal backup is still set, 
and the backup disk or tape contains only the files that changed since the 
last normal backup. You might do a normal backup evety Friday night and 
a differential backup evety other night of the week. Monday night's backup 

Differential Bacl{ups 

Monday Tuesday Wednesday Thursday 

~7'~ 
Step 1: 

S~;'~ 
Step 1: ./V' 

:(e~ f~ 
Check Check· .... Check· ... ; 

Step 2: 
Sl'p 2~""" 

Step 2: 

Sl.p 2~ r" 
lO~tcr!J CO ~.~ . .A. ~~~J:J CO ':.1: .. 

Copy Copy Copy Copy·· . 

Step 3: 

_Sl~~ 
Step 3: Step 3: 

~!CO ~~ ~~ Mark ...... 

Monday Tuesday Wednesday Thursday 
Differential Differential Differential Differential 

Step 2: 

~~~~ 
Step 3: 

~~ 
Friday 

Normal 

Step 1: . 

'?~/V' 
chec:~. 

Sl~~~ 
Copy 

Step 3: 

~~ 
Friday 

Normal 
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would contain all of the files that changed on Monday, Tuesday night's 
backup would contain all of the files that changed on Monday and Tuesday, 
and so on. If the file SAME.DAT changed only on Monday, there would still 
be a separate copy of it in each differential backup. 

Using these backup tactics, let's again assume that disaster strikes on 
Friday afternoon. To restore your week's work, you restore last Friday's 
backup, and then this Thursday's backup. You don't have to worry about 
the backups in between those days. You can still get Wednesday's version 
of CHANGE.DAT from Wednesday's backup if you need it. 

The advantage of differential backups is that they are secure and easy 
to restore. However, they do take longer than incremental backups and 
consume extra storage space with duplicate versions of files. 

Copy Backups 
A copy backup simply copies all of the selected files and ignores their ar­
chive markers. The archive markers of the backed up files are the same as 
the· unchanged archive markers of the files on the source disk. You can use 
the copy method to move files to another disk or to do occasional backups 
of program files. You can also use this method to do a special back- up of 
certain files without disturbing your normal backup routine. It's exactly the 
same as copying files with the Copy command. 

Dated Backups 
A dated backup ignores archive markers and instead checks for files created 
or changed on or after a given date. A daily backup is a form of dated 
backup that simply copies any files with the current date and ignores all 
others. An update backup compares dates on the source and the destination 
version of each file and only copies if the source file is newer than the 
destination file. You can use a dated backup to copy all files that were 
changed today or this week on your business machine to a disk and take 
them to your home machine. 

Windows NT Backup supports daily backups. The MS-DOS Backup 
and XCopy commands support dated backups based on any date. The 
XCopy command also supports update backups. 
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Security Considerations 
If you are backing up your own disk, you need sufficient privileges to copy 
all of the files. You might need a different set of privileges to restore your 
disk, because this involves writing and potentially changing files. Further­
more, you might need different privileges to back up or restore an NTFS 
drive, because its file permissions can be more flexible and varied. Gener­
ally, you need to log on as a member of either the Administrators or Backup 
Operators group. Better yet, you can log on as an administrator and set up 
an At command that does your backups automatically at a scheduled time. 
For more information about the At command, see "The At Command," page 
612. For information about how to create accounts that are members of the 
Administrators and the. Backup Operators groups, see "Creating a User 
Account," page 323. 

If someone else (usually a network administrator) backs up all or part 
of your system, you might need to give that person the appropriate privi­
leges on your machine. In most cases, the administrator will take care of 
this directly or will give you instructions for setting up the proper accounts. 

Using Windows NT ~OlC~{UP 
Windows NT Backup is a program designed to make backing up to a tape 
drive quick and painless. You simply select what you want to back up, and 
then click a Backup button that brings up a dialog box where you select 
the kind of backup you want. Restoring files is just as easy. Backup can also 
be used from the command line or in a batch file if you want to automate 
the whole process. 

Starting Bacl{up 
To start Backup, double-click the Backup icon or type the following in a 
command prompt window: 

C:\)start ntbackup 

When you start Backup, one of two things happens. If you don't have 
a tape drive installed or if it is turned off or otherwise unavailable, you get 
a message saying that no tape drive is detected. This might surprise you if 
you expected Backup to work with floppy disks or network drives. It 

373 



374 

doesn't. For information about backing up to media other than tape, see 
"Using the Backup and Restore Commands," page 391, and "Backing Up 
with XCopy," page 394. 

If your tape drive is ready for action, you see a Backup window similar 
to this: 

Tapes 

\ 

~
OCJ TEMP 
oC±J tmp 
oC±J USERS 
o CJ WIN32APP 
Blt:=J WINNT 

tOCJ SYSTEM 
l8lfi'l1l.li'mE 

DRIVERS 
I8ICJ OS2 
I8ICJ RAS 
I8ICJ REPL 
I8ICJ SPOOL 
1810 1af67a25.sm 
1810 AB32.DLL 
181 ~ ACLCONV.EXE 

You can do most common backup tasks from Backup's main window 
without using menus. Backup has menus, but most of them duplicate op­
erations that are easier to select from the toolbar or from the Drives and 
Tapes windows. Table 13-1 on the next page describes some of the elements 
in Backup's main window. 

Although you can do most backup tasks from the toolbar, you'll find 
a few less common operations on menus. 

c To format a tape, choose Format Tape from the Operations menu. 
If your tape drive uses preformatted tapes, this command is 
inactive. 

D If you have multiple tape drives, choose Hardware Setup from the 
Operations menu to select the tape drive you want. 

c If the drive window does not show all existing drives, choose 
Refresh from the Window menu. For example, if you connect to a 
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network drive in File Manager or from a command prompt window 
while Backup is running, you need to use the Refresh command 
to make Backup recognize the new drive. 

Backup button 

Drives window 

File selection 
window 

Restore button 

Tapes window 

Catalog button 

Retension Tape 
button 

TABLE 13-1. 

Backup window elements. 

,,,, 

Used to back up files and directories to a tape. 
It brings up a dialog box where you can set 
backup options and perform a backup. The 
button is closely linked to the Drives window, 
where you specify the files and directories to be 
backed up. 

Used to select the drive or drives to be backed 
up. You can expand any drive to display and 
select specific files and directories. If this 
window is inactive, the Backup button is also 
inactive. 

Used to select files and directories on a drive. 
(When expanded, the Tapes window also has a 
file selection window.) 

Used to restore files and directories from a tape. 
It is closely linked to the Tapes window. It 
brings up a dialog box where you can set 
options and perform a restore. 

Used to select the tape be restored. You can 
expand any tape to display and select specific 
files and directories. If this window is inactive, 
the Restore button is also inactive. 

Loads the catalog of backup sets from a tape. 

Eliminates loose spots on the tape by fast 
forwarding to the end of the tape and then 
rewinding. On tape drives that do not require 
this command, the button is inactive. If the 
button is active on your machine, check the 
manufacturer's instructions on how often to use 
this command. 

(continued) 
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TABLE 13-1. continued 

Eject Tape button 

Erase Tape button 

Check button 

Uncheck button 

Rewinds the tape. Some tape drives 
automatically eject the tape; others require 
manual ejection. 

Erases the tape. A warning and confirmation box 
comes up before the deed is done. Be sure you 
want to erase the tape before clicking OK. 

Marks all selected items in the current window 
(Tape, file selection, or Drives) as checked. 
Because each file and directory in the window 
has a check box, you'll probably find it more 
convenient to check items directly in the 
window. However, this button might be 
convenient if you want to select multiple items 
in the window and then check them all at once. 

Marks all selected items in the current window 
(Tape, file selection, or Drives) as unchecked. 

Backing Up to Tape 
Backing up is a simple process with a few complications. Follow these steps: 

1. If the Drives window is closed, double-click the Drives icon to open 
the window. 

2. Select the drives. you want in the Drives window by clicking the 
check box to the left of each drive. If you want to back up specific 
files or directories on a drive, double-click the drive's icon to open 
a file selection window, where you can select individual files and 
directories. Selecting files and directories is explained in the next 
section. 

3. When you have selected the files you want backed up, click the 
Backup button. A Backup Information dialog box appears. Fill in 
the fields in this dialog box as explained in the section titled "The 
Backup Information Dialog Box," page 378. Click OK. 
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4. Watch the Backup Status dialog box to follow the progress of the 
backup. You can click Abort at any time to terminate the backup. 
More likely, you'll want to go to another window and work on 
something else while Backup slaves away in the background. 

5. When the backup finishes, eject the tape if appropriate and label it. 
Store the tape in a safe place (preferably in another building). 

Selecting Files and Directories 
If you've used File Manager, you'll soon feel right at home using the Drives 
window and the file selection window to select the files and directories you 
want to back up. There are a few differences, however, as you can see in 
the following figure. 

1.i3c=J , 

~
OLJ TEMP 
oGJ Imp 
oGJ USERS 
QLJ WIN32APP 
tac=J WINNT 

tOLJ SYSTEM 
rEI~~ 

to.. rEID ACLEDIT.DLL 
I-;:rEI"';ID~CO=N=FIG:-----'1 rEID ADVAPI32.DLL 
rElLJ DRIVERS rEID ALRSVC.DLL 
rElLJ OS2 rEID AMDNCDET.D 
rElLJ RAS rEID ANSI.SYS 
rElLJ REPL rEID APP.INF 
rElLJ SPOOL . rElC APPEND.EXE 
rEID 1afG7a25.sm rEID APPSTART.AN 
rEID AB32.DLL rEID APPXEC32.DLl 
rElC ACLCONV.EXE rElC AT.EXE 

The key feature to notice is that every drive, directory, and file has a 
check box you can click to indicate that you want the item backed up. 
Fortunately, you don't have to click every file to back up the entire drive. 
Selection works at several levels for maximum efficiency and convenience. 

1. To select all of the files on the drive, click the check box next to 
the drive's icon in the Drives window. If you don't want to back up 
the entire drive, double-click the drive's icon to open a file selection 
window that displays the files and directories on the drive: 

2. To select all of the files in a directory, click the check box next to 
the directory's folder icon. If you don't want to back up all of the 
files in the directory, double-click the directory's icon to expand the 
directory. Expanding works the same here as in File Manager. The 
left side of the file selection window shows the directory icons in a 
tree format. The right side of the file selection window shows all of 
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the files and directories at the current level. You can use the View 
menu to change the appearance of the file selection window-you 
can display full file details, change the relative size of left and right 
panes, even eliminate the Tree or Directory view. 

3. To select a file, click the check box next to the file's icon. You can 
also select groups of files, and then click the Check button on the 
toolbar to check them. The easiest way to select a group of 
contiguous files is to click the first one and then drag down to the 
last one. (You can't use this handy technique in File Manager 
because File Manager reserves dragging for moving and copying.) 
You can also select contiguous files by clicking the first file and then 
holding down the Shift key while selecting the last file, or you can 
select non-contiguous files by holding down the Control key while 
clicking. 

Usually, it is easier to display the appropriate directory, and then check 
the items you want to back up, but you can also do it the other way around. 
You can check everything at a high level (maybe even the whole disk), and 
then display individual directories and uncheck the items you want to 
exclude from the backup. When some items in a disk or directory are 
checked but others are not, the check box for the disk or directory is checked 
but is gray to indicate partial selection. 

Checking a file or directory does not in itself ensure that the file will 
be backed up. Everything is subject to security limitations. Regardless of 
your selections, you can back up a file only if you have permission to read 
the file. 

The Backup Information Dialog Box 
After you've selected the files you want to back up, click the Backup button 
on the toolbar. (You can also choose Backup from the Operations menu.) 
The following dialog box appears. 
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CUllent Tape: 

Creation Dale: 

Owner: 

Tape created on 7122/93 

7122/93 3:26:26 PM 

OM Nil \Administrator 

lape Name: ITape created on 7125/93 
Operalion-

o ~erily After Backup o Backup Registry 
o BPpend 

@ Replace o R~strict Access to Owner or Administrator 

Backup Set Inlormation (1 011 sets) -----------, 

Drive Name: C: OMNI1 
Jlescription:1 r----------------, 

D.ackup Type: INormal lID 
Log Inlormation------------------, 

log File: 1 C:\winnt\BACKUP.LOG Id 
o full Detail @ ~ummary Only 0 D.Q.n't Log 

Table 13-2 describes each field in the dialog box. 

Current Tape 

Creation Date 

Owner 

Tape Name 

Operation 

Shows the name of the tape (if any). 

Shows the time and date that the tape was 
created (not the time of the current backup). 

Displays the account name of the person who 
created the first backup set on the tape. 

If the operation is Replace, you can type in a 
new name of up to 50 characters for the tape. If 
the operation is Append, this field is disabled, 
and the name created by the last Replace 
operation is displayed in the Current Tape field. 

The Replace operation creates a new backup set, 
overwriting any existing backup on the tape. 
The Append operation adds the current backup 
set at the end of the last backup set on the tape. 
Append is disabled on blank tapes. 

. 

~,--" •.. -..• -... -... --.. ---.-,,-.-... --.------------------------~--------------------------~, 
TABLE 13-2. (continued) 

Backup Information dialog box fields. 

379 



380 

PAR T 3: Security and Administration 

TABLE 13-2. continued 

Verify Mter Backup 

Backup Registry 

Restrict Access to 
Owner or 
Administrator 

Backup Set 
Information 

Drive Name 

Description 

Backup Type 

Log Information 

Log File 

Confirms a backup by comparing the files on the 
drive and the files on the tape after the backup 
is completed. 

Backs up the Windows NT registry 
(configuration) files. 

Restricts access to the person who created (and 
therefore owns) the tape. You can't restore to a 
computer other than the one you backed up 
from. Members of the Administrators and 
Backup Operators groups can override these 
restrictions. You can use this field only with the 
Replace operation. 

This group of controls has a scroll bar if the data 
to be backed up is from more than one drive. 
The Drive Name changes for each drive and you 
can set the Description and Backup Type 
differently for each drive. 

Displays the letter and the label or network 
name of the selected drive. 

You can fill in a description of up to 50 
characters for the backup set on each drive. 

Determines which files will be backed'up and 
how their archive bits will be set. For 
information about archive bits and different 
types of backup, see "Backup Methods," page 
367. 
This group of controls determines what data, if 
any, will be written to the backup log file. 
Summary Only logs only major events such as 
starting the backup and failing to open a file. 
Full Detail logs everything, including each file 
and directory name. 

Determines the name of the file to which the log 
is written. You can type in a name or click the 
button to select a file. 

: 

.. 

.. 

, .. 
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The Backup Status Dialog Box 
When you've filled out the Backup Information dialog box, click OK. If the 
operation is Replace on a nonblank tape, you'll see a message box asking 
if you really want to wipe out existing data. If you confirm that you do, the 
disk light flickers, the tape whirs, and the backup starts. The following 
Backup Status dialog box appears as the work continues. 

Directories: 
Files: 
Bytes: 

I%!J C: OMNI1 

I 
CJ \winnt 
D _DEFAULT.PIF 

Summary 
Backup Status 

Backup Status 

2 Elapsed time: 
6 Corrupt files: 

50.990 Skipped files: 

Rewinding the tape. Please wait... 

Backup of "C: OMNI1" 
Backup set 112 on tape 111 

00:09 
o 
o 

Backup description: "Windows NT files" 
Backu started on 7125/93 at 1:21:02 PM. t+' 

11~~;\~:"tn:::~"";-'\''':1 I F'lA6oHr~~"1 IFrRelii""~'~ I 

Events, directories, files, and bytes fly by along with seconds, minutes, 
and hours. During the backup, the OK button is inactive but the Abort button 
is active in case you want to quit. If you click Abort, the current file will be 
completed if less than one megabyte remains to be backed up. Otherwise, 
a message box lets you choose whether to continue or to stop and record 
the file as corrupted. If you reach the end of the tape before finishing, an 
Insert New Tape dialog box appears, prompting you to insert a new tape. 

When the backup finishes, the OK button in the Backup Status dialog 
box becomes active (and the Abort button becomes inactive). The final line 
in the Summary box tells whether the backup was completed. You can scroll 
through the Summary box to inspect the events of the backup. The Summary 
box contains the same information that is written to the log file. 
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Backing Up from the Command Line 
The Windows NT interface makes the Backup program easy to learn and 
fun to use. However, after you've backed up the same drive with the same 
commands 30 times in 30 days, you might be ready fora shortcut. Fortu­
nately, the Backup program also works as a command-line utility. You can 
automate your backups with a batch file or the At command, as described 
at the end of this section. 

When you run Backup from the command line, it runs in a window; 
but instead of waiting for mouse and keyboard input, it performs the actions 
you specified on the command line. You'll see buttons pushed and status 
displayed as if a ghost has taken over your machine. When it's all over, 
Backup terminates. 

Backup's program name is NTBACKUP.EXE. To use it from the com­
mand line, use the following syntax: 

NTBackup Backup [pathnames [options]] 

"Backup" is required as the first argument. Path names takes the place 
of information entered in the Drives and file selection windows. You can 
include entire drives or directories, or individual files. Of course, it's not as 
convenient or flexible as checking the items you want in a dialog box, but 
you generally don't need complex backup selections. If you run out of space 
for pathnames on the command line, you can use multiple Backup com­
mands. 

WINDOWS TIP: You might think you can use NTBackup 
to restore by specifying Restore instead of Backup as the 
first argument on the command line. You can't. But, as a 
practical matter, restoring from the command line doesn't 
make much sense. You shouldn't have to restore very 
often; and when you do, the operation will be different 
each time. 
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Options takes the place of entries in the Backup Information dialog 
box. Most check boxes in the dialog box have a corresponding command­
line option. Usually, absence of the option is equivalent to leaving the check 
box unchecked. Although some options indicate that you need to use 
quotation marks around text or question marks, the quotation marks are 
actually optional. You can choose any option by spelling out its full name 
or by typing the first letter of the option. Table 1~-3 on the next page shows 
command-line options and the corresponding dialog-box fields. 

WINDOWS TIP: You might think that because Windows 
NT is a multitasking operating system, you can do a back­
up in the background while you do other tasks. It's true 
that your computer and operating system do a fine job of 
multitasking, but your hard disk doesn't. If you try to run 
another application that requires a lot of disk access during 
a backup, you'll see performance grind to a halt. You'll be 
more satisfied if you use the At command to launch your 
disk backups at midnight while you're out of the office. 
However, if you really need to work during a backup, you 
can minimize the visual and disk interference using the 
Start command's /MIN and /LOW options command, as in 
this example: 

C:\)start fmin flow ntbackup backup c:\ 

The Start command runs the program in a separate 
window so that you can continue working at the command 
prompt while Backup works. The /MIN option runs the 
program minimized (as an icon). If you can't control the 
output, you don't need the distraction of seeing it. The 
/LOW option runs the program at the lowest priority. 
Whatever you choose to do, the foreground task gets first 
crack at machine resources; Backup runs only when you're 
not doing anything else. For more information about the 
Start command, see "Launching Programs," page 595. 

: 
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IA[ppend] Operation. If you use this option, the backup set 
is appended to the current tape. 
Othetwise the backup set replaces 
all previous contents of the tape. 

ID[escription] Description If you use this option, Backup stores 
"text" text as the description of the backup 

set. 

IE[xceptions] Log If you use this option in combination 
Information with the IL option, a simple log file 

with events only is created. If you do 
not use the IE option, the log file 
shows the name of each file and 
directory. The IE option is ignored if 
you do not use the IL option. 

IL[ogfile] Log File If you use this option, a log file 
''filename'' named filename is created. 

Othetwise no log file is created. 

IR[estrict] Restrict If you use this option, Backup 
Access to restricts access to the person who 
Owner or created the tape or members of the 
Administrator Administrators or Backup Operators 

groups. The option is ignored if you 
do not use the I A option. 

IT[ype] type Backup Type The type can be Normal, Copy, 
Incremental, Differential, or Daily. If 
you do not use the IT option, 
Normal is assumed. 

/V[erify] Verify Mter If you use this option, all items are 
Backup verified by comparing the disk 

version with the tape version. 

TABLE 13-3. 

Command-line equivalents for Backup Information dialog box fields. 

You might want to experiment with the command-line syntax before 
putting commands into batch files that are run automatically. When you run 
Backup interactively, it displays warnings and gives you a chance to change 
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your mind if you do something dangerous. When you run it from the 
command line, Backup assumes that you know what you're doing. Be sure 
that you do. 

Here are some batch-file examples of Backup commands. We'll call 
the first example NORMALC.BAT: 

@echo off 
cd %temp% 
ntbackup backup C: /d Normal /1 N.LOG 

This batch file creates a new backup set (overwriting any existing backup 
set) and does a normal backup of the C drive. 

We'll call this example INCRlVlNTC.BAT: 

@echo off 
cd %temp% 
ntbackup backup C: /a It incremental /d Incremental /1 I.LOG 

This batch file does an incremental backup of the C drive, appending the 
backup set to any existing backup sets. 

Now let's assume that you want to do a normal backup every Friday 
night at 11:30 P.M. after everyone has gone home, and in~remental backups 
Monday through Thursday at .11:30 P.M. Use the At command to call the· 
appropriate batch file. 

C:\)at 23:30 /every:F "normalc" 
C:\)at 23:30 /every:M,T,W,Th "incrmntc" 

You must have appropriate security privileges to run the At command. After 
you set everything up, you can forget it-except you must be sure that the 
tape drive has a tape with enough space for the backup every weeknight. 

For information about batch files, see "Using Batch Files," page 644. 

For more information about the At command, see "The At Command," 
page 612. 

Restoring from Tape 
Restoring with Backup works the opposite of backing up. When you make 
backups, Backup automatically maintains catalogs of all the backup sets and 
the files in each set. When you restore, it's not quite so automatic. You need 
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to understand a little about how cataloging works. Each tape has a catalog 
of backup sets. Each backup set also has its own catalog of files. If a backup 
set spans more than one tape, the set catalog is on the last tape. 

With that in mind, let's look at the steps for restoring data: 

1. Select the tape you want to restore from and insert it in the tape 
drive. 

2. If the Tapes window is closed, double-click the Tapes icon to open 
the window. Backup displays the first backup set on the tape in the 
Tapes window. 

im"" """ - ""--"--"-- """-" """-""--"- "" "r --;;p;~ --"-" "-" -" -"~ -"" "" ""-- "--" --""" ""Gill 
1 ~ H' C OMNI1 Set 1 Tape 1 norm 7/2/33 I 

Notice the question mark on the folder icon for the backup set. 
This indicates that the catalog of files in the set has not yet been 
loaded. At this point you can't tell from the display whether there 
is only one backup set on the tape or whether the catalog of backup 
sets has not been loaded. 

3. Load the catalog of backup sets by clicking the Catalog button on 
the toolbar or by double-clicking the Tape icon on the left side of 
the Tapes window. The Catalog Status dialog box appears while the 
drive loads the catalog of backup sets. When finished, all of the 
backup sets are displayed, each with a question mark in its folder 
icon because no file catalogs have been loaded. 

:If--"-------~---- -"-- T~p~s""--"·"'"" "-------""-"-~-"-""'-"--aal 

: ~ H' C OMNI1 Set1 Ta e1 norm 712133' 

4. In the Tapes window, select the backup set you want by clicking 
the check box to the left of the folder icon. If you want to back up 
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only certain files or directories, double-click the desired folder icon. 
In order to display the file selection window, Backup must first load 
the file catalog. A status dialog box with an Abort button appears 
while the file catalog is read. When finished, the question mark in 
the folder icon changes to a plus sign and the file selection window 
for the backup set appears. 

... .,- '·:';1:· 
o 1II IT ape created on 7/2/931 D~ C:OMNI1 Set 1 Tape 1 norm 712/93 

D(!jl C: OMNI1 Set2 Tape 1 incr 7/2/93 
D~ C:OMNI1 Set3 Tape 1 incr 712/93 

+Ju '<,.,\ '\,,'\' """ -,;,~-;-q" +J2], .,'"\'-.''. ;':,:,;""",,,,:\.:, ,,:',V'Y,",,' \0 ;",,:,,>:,\<,\,1:,+ 

File selection works the same for restoring as for backing up. 

5. When you have selected the files you want, click the Restore button. 
A Restore Information dialog box appears. Enter the appropriate op­
tions, as explained in the next section. Click OK. 

6. Watch the Restore Status dialog box to see the restore operation's 
progress. You can click Abort if you made a mistake. 

The Restore Information Dialog Box 
The Restore Information dialog box looks like this: 

Restore Information 

Backup Set In/ormation (1 0/1 sets) -------------, 

Tape Name: Tape created on 7122193 

Backup Sel: ..... indows NT /iles 

Creation Date: 7122/93 3:26:26 PM 

Owner: OMNIl\Administrator 

Restore to !2rive: Ic: [OMNIl] I@ 
~============~ Alternate fath: I'--__________ ..... ,_V:: ... ,'J 

o ~eri/y After Restore o Restore File Permissions 

o Restore local Registry 

log In/ormation----------------, 

log File: I C:\winnt\BACKUP.lOG IEttl 
o [ull Detail @ ~ummary Only 0 DQn'tlog 
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Looks a lot like the Backup Information dialog box, doesn't it? We'll 
look at the fields more briefly this time because you're already familiar with 
most of them from the Backup Information dialog box. See Table 13-4. 

Backup Set 
Information 

Tape Name 

Backup Set 

Creation Date 

Owner 

Restore to Drive 

Alternate Path 

Verify Mter Restore 

TABLE 13-4. 

This group of options has a scroll bar if you 
selected files from more than one backup set. 
The fields in the Backup Set Information group 
can have different entries for each backup set. 
Fill in all of the fields for the first backup set, 
then scroll to the next and fill in the fields, and 
so on. 

Displays the name given to the tape when it was 
created. 

Displays the name Of any) given to the current 
backup set when it was created. 

Shows the time and date that the backup set was 
created. 

Displays the account name of the person who 
created the backup set. 

Provides a drop-down list with all available 
drives. Select the one to be restored to. The 
default is to restore to the drive from which the 
backup set was created. You can set this field 
separately for each·backup set. 

If you want to restore to a different path than 
you backed up to, type the path here or use the 
Browse button to select a path. Normally you 
should leave this field blank to restore the 
original path. You can set this field separately 
for each backup set. 

Confirms the restore by comparing the files on 
the tape and on the drive. 

(continued) 

Restore Information dialog box fields. 
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Restore Local 
Registry 

Restore File 
Permissions 

Log Information 

Log File 
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Restores the Windows NT registry 
(configuration) files. This field is inactive if the 
registry wasn't backed up in the selected backup 
set, or if the target drive isn't an NTFS drive. 

Restores the file permissions of each file. If this 
check box is not selected, the restored files 
inherit the permissions of the directory they are 
restored to. If you are restoring the files to the 
directory they were backed up from, this is no 
problem, but it can be significant if you are 
restoring to a different drive or if you have 
changed permissions since the backup was 
done. This field is inactive if the drive being 
restored to is a FAT or HPFS drive, because file 
permissions do not exist with these file systems. 

This group of controls determines what data (if 
any) will be written to the backup log file. 
Summary Only logs major events such as starting 
the restore operation and failing to open a file. 
Full Detail logs everything, including each file 
and directory name. 

Determines the name of the file to which the log 
is written. You can type in a name or use the 
Browse button. 

The Restore Status Dialog Box 
When you've filled out all of the appropriate fields in the Restore Information 
dialog box, click OK. The Restore Status dialog box, shown on the next 
page, appears during the restore operation. 
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Restore Status 

Directories: 1 E lapsed time: 
Files: o Corrupt files: 
Bytes: o Sk.ipped files: 

.. T ape created on 7122/93 

I CJ \winn. 

Summary 
Restore Status 

Searching for the back.up set. Please wait... 

00:00 
o 
o 

During the restore operation, the OK button is inactive and the Abort 
button is active in case you want to quit. If you abort, the current file will 
be completed if less than one megabyte remains to be restored. Otherwise, 
a message box lets you choose whether to continue or stop. 

If a file to be restored already exists on the drive, this dialog box 
appears to allow you to confirm the replacement: 

Confirm File Replace 

(j) Replace File: c:\runnt\add-lsl 
W 278 bytes 7/119312:38:26 AM 

With File: c:\runnt\add-lst 
278 bytes 711/9312:38:26AM 

Ut?f(it~!0J IrrQ~toJl'il \t;:'t1!ti??'l?l 1~1Yf!~:;1 

When the restore operation finishes, the OK button becomes active 
and the Abort button becomes inactive. You can scroll through the Summary 
box to inspect the events of the restore operation. The Summary box con­
tains the same information that is written to the log file. 
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Partial qnd Incomplete Catalogs 
If a backup operation spans several tapes, you must insert the last tape to 
load the catalog. But what if the last tape is missing? You can still build a 
partial catalog. You might also need to build a partial catalog if you want 
to restore from a tape that was not created by Windows NT Backup. If the 
tape has the Microsoft/Maynard Tape Format (MTF) , you can still read it, 
although you might have to build a catalog. 

To build a catalog, follow these steps: 

1. Insert the tape into the tape drive. 

2. Double-click the Tapes icon to open the Tapes window if necessary. 

3. Click the Catalog button on the toolbar, or double-click the Tape 
icon. The Catalog Status dialog box appears. Backup scans the entire 
tape to identify all of the backup sets, and then scans the tape again 
to identify the contents of each backup set. It might take a while to 
get all of the information and build the necessary catalogs. 

Using the lBacl{up 
and Restore Commands 

The MS-DOS operating system provides backup and restore utilities for 
doing backups to floppy disks. For compatibility, Windows NT provides the 
same tools, although they are not a crucial part of the Windows NT backup 
philosophy. Backing up to floppy disks is not a practical option for most 
people running Windows NT. 

Floppy disk backup made sense when hard disks were typically 
smaller than about 60 MB. You wouldn't look forward to backing up your 
system onto 40 floppy disks, but it wasn't unthinkable. These days, the 
Windows NT system files alone wouldn't fit on those 40 disks. Imagine 
backing up a 200-MB hard disk onto 140 floppy disks. True, you don't 
normally back up the whole disk-only the crucial data files. That's the 
context in which the Backup and Restore commands can still be useful. 

391 



~
f' 

"".:"',',',:'.,::','.,.',',',',',''',''"" ~," .>~ ,.,' 

392 

PAR T 3: Security and Administration 

Let's say you don't have a tape drive and you have a directory of 
personal files that you don't want anyone, not even the system administrator, 
to see. Assume that these files will fit on two or three floppy disks. It's not 
unreasonable to use the Backup command in this situation, but only if the 
files are on a FAT (MS-DOS file system) disk or follow the MS-DOS filename 
conventions. If you try to use the Backup command on files that have long 
filenames, the files are saved on disk with the short MS-DOS versions of the 
names. (For information about long and short filenames, see "Understanding 
File Systems and Filenames," page 597.) When you use the Restore com­
mand, you restore the files, but they have different filenames than they 
started out with. For instance, if you back up the file VeryS ecretStuff. Dat, 
you restore a file with a name something like VERYSE~1.DAT. You can get 
around the problem by saving a list of long filenames in the directory you 
are backing up. If you are backing up the PERSONAL directory for example, 
use this command to create the list of long filenames: 

C:\>dir Is Ix personal> personal\file.lst 

After you restore, 'use this list to rename the files to their original long 
filenames. This can be very tedious, but if avoiding tedium were your only 
goal, you wouldn't be backing up to floppy disks in the first place. 

The Backup command works by compressing all of the data in the 
source files and writing it into two files-BACKUP.OOx and CONTROL.OOx­

on each floppy disk. The xrepresents the number of the floppy disk. Restore 
works by decompressing the data on the floppy disks and copying it back 
to the source disk. You must feed the disks back to Restore in the same 
order that you created them with the Backup command. Be sure that you 
label the disks carefully so you know the order in which to insert them 
when restoring. Backup and Restore both prompt you when you need to 
insert a new floppy disk. 

Using the Bacl{up Command 
By default, the Backup command does a normal backup. (For more infor­
mation about the different types of backups, see "Backup Methods," page 
367.) Use the IS option to back up the directory tree, including any subdi­
rectories. For example, use the following command to do a normal backup 
of the PERSONAL directory and all of its subdirectories to drive A and create 
a log file showing the actions. 
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C:\)backup personal a: Is 11 :friday.log 

You can do an incremental backup using the 1M option. For example, 
you can use the previous command do a normal backup on Friday night, 
and a command like the following to do an incremental backup on other 
weeknights: 

C:\)backup personal a: Is 1m la 11 :monday.log 

This command backs up only files that have changed since the last normal 
backup. The I A option appends the differential backup to the last disk of 
the current backup instead of overwriting all previous files to create a new 
backup. If you want to keep each differential backup on separate disks, 
don't use the I A option. 

The Backup command does not support differential backups, but you 
'can cl? dated backups. The following command backs up every file that has 
changed since Christmas Day, 1993: 

C:\)backup personal a: Is Id:12/25/93 Il:backup.log 

Use the I? option for details about the more obscure options for the 
Backup command. 

Using the Restore Command 
The Restore command works about the same as the Backup command, 
except backwards. You can restore an entire directory or a single file. Here's 
the command to restore the PERSONAL directory shown in earlier examples: 

C:\)restore a: personal\ Is 

Assume that you created a normal backup on Friday night and an 
incremental backup on other weeknights. You used the I A option to append 
each incremental backup to the same set of disks. Then disaster strikes on 
Friday afternoon. The command above first restores the files from the normal 
backup, and then overwrites each file that changed throughout the week 
with a new copy. If a file changed every day, five copies are overwritten. 
If you kept each incremental backup on separate backup disks, you need 
to first restore from the normal backup disks, and then restore from each 
day's incremental backup disks in order. 
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You can restore the incremental files for a particular day using the IB 
and the I A options. For example, to restore the files backed up on July 27, 
1994, use the following command: 

C:\>restore a: personal\ Is la:7-27-94 Ib:7-27-94 

Notice that you must use both the I A and the IB options to limit the restore 
operation to files from a particular day. Use the 1M option to restore only 
the files that changed since the last normal backup. For example: 

C:\>restore a: personal\ Is 1m 

You can also restore a single file: 

C:\>restore a: personal\jones.dat Is 

Use the I? option to get details about other Restore options. 

Backing Up with XCopy 
Among its many and varied uses, the XCopy command can be used to back 
up files to disk. Whether you really want to do this is another question. If 
you have two hard disks, you can back up from one to another, but is that 
really how you want to use your precious disk space? And is your data really 
safe? You might want to back up to a network server, but chances are the 
network administrator won't consider that a very good use of resources. If 
you have lots of spare time, you can back up to floppy disks, but in that 
case the Backup command is probably a better option because it compresses 
files. Nevertheless, the day might come when, for reasons of your own, you 
want to back up some data (probably not very much) to another disk. When 
that day comes, XCopy will be ready. 

Perhaps the most common backup with XCopy is the copy backup. 
You overwrite the old files every time you back up without worrying about 
keeping multiple versions. However, you can also do normal, incremental, 
differential, and dated backups. For more information about different kinds 
of backups, see "Backup Methods," page 367. 
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To do a copy backup with XCopy, use a command line similar to this: 

C:\)xcopy mail m:\mail Ie Ii Ih 

Everything gets copied regardless of its date or archive status. The IE option 
in the example· creates a duplicate tree on the destination drive with all 
subdirectories, including empty ones. The II option prevents unnecessary 
prompts that ask if the destination is a file or directory. In the backup 
context, you always want a directory. The· IH option copies hidden and 
system files. Of course, you must have appropriate privileges to copy any­
thing, hidden or not. 

A normal backup is a little harder to do. The XCopy command doesn't 
have a way to copy a group of files and clear th~ir archive markers. However, 
you can use XCopy to copy them, and then use the Attrib command to clear 
their archive markers: 

C:\)xcopy mail m:\mail Ie Ii Ih 
C:\)attrib -a mail\*.* Is 

The -A argument of the Attrib command removes the archive attribute from 
all files in the MAIL directory. The IS option says to do this throughout the 
whole directory tree. Alternatively, you can set all of the archive markers, 
and then use XCopy with the 1M option to copy all archived files and clear 
their archive markers. 

C:\)attrib +a mail\*.* Is 
C:\)xcopy mail m:\mail Ie Ii Ih 1m 

In this case the + A argument adds the archive attribute. 

To do an incremental backup, use the 1M option: 

C:\)xcopy mail m:\mail Ie Ii Ih 1m 

Only the files that changed since the last normal backup are copied. They 
are marked as archived so that they won't be backed up again until they 
change or until the next normal backup. 

To do a differential backup, use the I A option instead of 1M. Only the 
files that changed since the last normal backup are copied, but they are not 
marked as archived. Thus they will be backed up again at each differential 
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backup until the next normal backup. This doesn't make any sense if you 
are overwriting each backup with the next. The option is available in case 
you want to use XCopy to make differential backups to floppy disks or to 
separate directories on a hard disk. The Backup command doesn't support 
differential backups, so you can use XCopy if you really want this method. 
Here is a command to do a differential backup to floppy disks: 

C:\)xcopy mail a: Ie Ii Ih la In 

The IN option copies long filenames on the source disk to shortened file­
names on the destination disk. You need this if you want to back up an 
NTFS disk to floppy disks, and it doesn't do any harm if the source disk 
doesn't have long filenames. XCopy prompts you to insert a new disk when­
ever you run out of space on the current floppy disk. 

To do a dated backup, use the ID option: 

C:\)xcopy mail m:\mail Ie Ii Ih Id:7/1/93 

This copies all of the files with dates on or before July 1, 1993. If you use 
the ID option without a date, the source and the destination date of each 
file are compared. If the destination version is older or doesn't exist, the file 
is copied. 

WINDOWS TIP: You can use Doskey macros to create 
XCopy commands for the different kinds of backup. Use 
Notepad or another editor to create a file named 
XBACKUP . MAC that contains the commands shown in the 
listing on the next page. Then load the macros with the 
following command: 

C:\)doskey Imacrofile=xbackup.mac 

You don't need to know how the macros work to start 
using them. For more information about Doskey, see 
"Using Doskey Macros," page 637. 

, 
; 
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;= Copy backup; syntax: BackCopy src dst 
BackCopy=xcopy Ie Ii Ih $1 $2 
;= Normal backup; syntax: BackNorm src dst 
BackNorm=xcopy Ie Ii Ih $1 $2 & attrib -a $1\*.* Is 
;= Incremental backup; syntax: BackIncr src dst 
BackIncr=xcopy Ie Ii Ih 1m $1 $2 
;= Differential backup; syntax: BackDiff src dst 
BackDiff=xcopy Ie Ii Ih la $1 $2 
;= Dated backup; syntax: BackDate src dst date 
BackDate=xcopy Ie Ii Ih $1 $2 Id:$3 
;= Update backup; syntax: BackUpdate src dst 
BackUpdate=xcopy Ie Ii Ih Id $1 $2 
;= 
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Starting Write 
Double-click the pen to get a blank sheet of paper. 

Selecting a Printer 
Be sure of your printer selection before you begin creating a document. 

Entering Text 
Simply type, and let Write worry about the line endings. Enter soft 
hyphens if you want words to break at the right margin. 

Editing Text 
It's easy to insert, replace, and delete text. 

Using the Undo Command 
Undo can erase many kinds of mistakes, from inadvertant deletions to 
formatting changes that you don't like. . 

Using the Keyboard to Move the Insertion Point 
Write includes a large set of keyboard shortcuts to simplify navigation. 

Selecting Text in a Write Document 
There are also mouse shortcuts for selecting the current word, line, or 
paragraph. 
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Copying and Moving Text with the Clipboard 
Use Copy, Cut, and Paste to rearrange your document. 

Using the Find Command 
In addition to searching for text, you can look for white space, tab 
characters, paragraph endings, or page breaks. 

Using the Replace Command 
You can apply the Replace command to an entire document or to the 
current selection. 

Applying Document Formatting 
The Document menu lets you specify or change headers, footers, tab 
settings, page numbering, and other details. 

Applying Paragraph Formatting 
Use the Paragraph menu to specify alignment, indention, and line spac­
ing. Apply your preferences to one paragraph or to consecutive para­
graphs. 

Applying Character Formatting 
Fonts are the province of the Character menu. You can change the size 
or style of type. 

Including Pictures in Write Documents 
Make your point graphically by adding pictures to your Write documents. 
After you paste a picture, you can reposition or resize it. 

Controlling a Pasted Object's Format 
The Paste Special command lets you choose between available formats. 

Linldng and Embedding in Write 
You can embed objects from other programs in Write documents, or 
embed Write documents in other programs. 

Saving and Retrieving Files 
You can ask Write to back up your document every time you save. You 
can also save your file as plain text or as a Microsoft Word file. 

Paginating and Printing a Write Document 
To control where page breaks occur, use the File Repaginate command. 

If You Change Printers 
Line breaks and fonts might change if you switch to a different printer. 
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his chapter introduces Write, the word processor that comes with 
" Windows NT. Write lets you create highly formatted documents 

that can include pictures as well as text. You can format individual para­
graphs to be flush left, flush right, centered, or justified, and you can choose 
from three line-spacing options. Documents can be printed with multiline 
headers or footers that can include automatic page numbering. Write also 
supports object linking and embedding as a client application. 

Even if you eventually move to a more powerful word processor, such 
as Microsoft Word for Windows, Ami Pro, or WordPerfect for Windows, you 
will find working in Write a valuable introduction to word processing in a 
graphical environment. And, of course, the documents you create in Write 
can be transferred by way of the Clipboard to many other Windows-based 
applications. 

Starting Write 
To start Write, double-click its program-item icon. You'll find it in the 
Accessories program group (unless you have moved it to another group). 

Write's opening display looks like this: 

1m----------------W--rit-e--(-Un-ti-t1e-d)------------------a~ 

Eile Edit Find ~haracter Earagraph .!1ocument !!elp 

I 

-,1-

You'll see the folloWing symbols as you work in Write: 

Insertion point. The flashing vertical line is the insertion point. It indicates 
the place where your next character will appear. 
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End mark. The small object to the right of the insertion point in the 
preceding illustration is the end mark. As its name suggests, the end mark 
appears beside the last character in your document; when you create a new 
Write document, the end mark appears right next to the insertion point. 

I-beam. The I-shaped pointer below and to the right of the end mark in 
the illustration is the I-beam. Your mouse pointer becomes an I -beam when 
you work in a Write document. The I-beam allows you to relocate the 
insertion point. If you don't have a mouse, you won't see an I-beam, but 
you'll be able to move the insertion point with the keyboard. 

On the right and bottom edges of your Write window, you'll find scroll 
bars. And in the lower left corner, Write displays the current page number. 
Don't be disconcerted if the page number remains at 1 while you create a 
lengthy document. As soon as you print or repaginate your document, the 
page numbers will be reported accurately. 

(If you have used Write already, you might see a "ruler" at the top of 
your window. For information about the ruler, see "Displaying a Ruler," 
page 417.) 

Selecting OJ Printer 
The first Write command you should acquaint yourself with is Print Setup, 
on the File menu. Write adjusts its screen display and its Fonts dialog box 
to reflect the currently selected printer, so whenever you start a new docu­
ment, be sure that Write is set up for the printer you want to use. 

The Print Setup command presents the following dialog box. 

Print Setup 

f.rinter: !Ij_~., ~-~1~"~~~~!!~ ••• IliI~!J~'~II~tt~;~lJK$~~{101 
form: I Letter lID IfG!fC_)'n'~ 
Orientation------, 

@ Po[trail 

o ,landscape 

2-Sided prinlin@-N-on-~------' 1!\?lllm1~~~~1 

lm 0 Long Side 1~;:llit!t()ro'?tll:~l 
o ~hort Side 
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When you start Write, the program is always set to use the current 
default printer (as specified in Print Manager). To use a different printer, 
click the Printer drop-down list box and choose from the list. Write auto­
matically adjusts the dialog box to display the paper size and paper source 
options available for the printer you select. Be sure those options are set as 
you want them, click OK, and you're ready to get to work. 

WINDOWS TIP: Be sure that your printer is set for the 
correct orientation-portrait or landscape. Write adjusts 
the dimensions of the document you're working on to 
reflect the printer's orientation setting. In portrait 
orientation on letter-size paper, the default text area is 6 
inches wide; in landscape orientation, it's 8.5 inches wide. 
(With some printers, your font options also depend on 
your printer's orientation setting.) 

You can change printers after you begin working on a Write document. 
Later in this chapter, we'll see how such a change affects your document. 

lEnter~ng lext 
To enter text in Write, simply type. As you type, Write adjusts your docu­
ment's line lengths to match the way they will appear when printed, based 
on the printed width of each character. When your text reaches the right 
margin, Write starts a new line for you. You don't have to press the Enter 
key until you come to the end of a paragraph. If a word is too long to fit 
entirely on one line, Write moves the entire word to the next line. 

If you want a blank line between paragraphs, press Enter twice at the 
end of each paragraph. If yOl} want each paragraph to start with an indent, 
you can simply press the Tab key at the beginning of each new paragraph. 
Or you can use the Indents command, on the Paragraph menu, to automat­
ically indent the first line a specified distance. For more information about 
the Indents command, see "Setting Indents," page 421. 
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Using Soft Hyphens 
Write does not ordinarily hyphenate words at the right margin. If you want 
W rite to hyphenate, you must insert soft hyphens wherever hyphenation is 
acceptable. To enter a soft hyphen, type Ctrl+Shift+hyphen. Unlike a normal 
hyphen, a soft hyphen is ignored unless it occurs at the end of a line. 

For example, suppose you're nearing the right margin and the next 
word in your document is mononucleosis. When you type that word, Write 
moves the entire word down to the next line, leaving your document with 
a very ragged right edge. You might want to go back and insert a soft hyphen 
after the second 0 (or at some other appropriate hyphenation point). If the 
portion of your word to the left of the soft hyphen fits on the previous line, 
Write moves it back. 

Soft hyphens remain invisible unless Write actually uses them to divide 
words. 

Editing Text 
To insert text into existing text, simply position the insertion point where 
you want the new material to go. You never have to concern yourself with 
an "insert" or "overstrike" command, as you do in many character-based 
word processors. 

To replace existing text with new text, start by selecting the text you 
want to replace using either the mouse or the keyboard. (We'll review how 
to select text in a moment.) Then type; the text you selected disappears, 
and the new text you type takes its place. 

To erase a small amount of text, position the insertion point either 
before or after the text you want to erase. Then press Backspace to erase 
text to the left of the insertion point, or Del to erase text to the right of the 
insertion point. 

To erase a large amount of text, start by selecting the text. Then press 
the Del key. If you want to delete a block of text but preserve it on the 
Clipboard, select the text and then use the Edit menu's Cut command or 
press Ctrl+X, which is the keyboard shortcut for the Cut command. Keeping 
the deleted text on the Clipboard gives you the option of putting it back 
where it was if you change your mind, or reusing it in another location. 
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Using the Undo Command 
Write's Edit menu includes a versatile and valuable Undo command. Undo 
enables you to recover from many kind of accidents: inadvertent deletions, 
overtyping, formatting changes that don't produce the desired effect, and 
even search-and-replace operations that you immediately regret. The Undo 
menu item is dynamic-that is, it changes to indicate the action it's able to 
undo at any given moment. For example, after you make a formatting 
change, the Undo menu item appears as Undo Formatting. After you make 
an editing change, such as a deletion, it appears as Undo Editing. 

I<EYBOAR 0 TIP: The keyboard shortcut for the Undo 
command is Ctrl+Z. 

Using the ~(eyboard to 
Move the Insertion Point 

For information about moving the insertion point in Write documents, see 
"Entering and Editing Text in Documents," page 32. In addition to the 
techniques described there, Write uses the 5 key on the numeric keypad as 
a "Go To" key. For example, you can press the 5 key followed by the Down 
direction key to move to the next paragraph, or you can press 5 followed 
by the Up direction key to move to the previous paragraph. 

NOTE: The Go To key does not work when your keyboard is in its 

Num Lock state. If pressing Go To puts a 5 in your document 
erase the 5, press the Num Lock key, and then try again. 

The keystrokes used by Write for moving the insertion point are sum­
marized in Table 14-1 on the next page. Note that the Go To, PgDn and Go 
To, PgUp keystroke combinations do not function until a document has 
been printed or paginated. (For information about printing, see "Paginating 
and Printing a Write Document," page 438.) 
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Right 

Left 

Down 

Up 

Ctrl+Right 

Ctrl+Left 

Ctrl+Down 

Ctrl+Down 

Ctrl+Up 

PgDn 

PgUp 

Ctrl+PgDn 

Ctrl+PgUp 

Home 

End 

Ctrl+Home 

Ctrl+End 

Go To, Right 

Go To, Left 

Go To, Down 

Go To, Up 

Go To, PgDn 

Go To, PgUp 

TABLE 14-1. 

To the next character 

To the previous character 

To the next line 

To the previous line 

To the next word 

To the next word 

To the previous word 

To the next line (and scrolls the window) 

To the previous line (and scrolls the window) 

Down one windowful 

Up one windowful 

To the last line in the current window 

To the first line in the current window 

To the first character in the current line 

To the last character in the current line 

To the first character in the document 

To the end mark of the document 

To the beginning of the next sentence 

To the beginning of the previous sentence 

To the beginning of the next paragraph 

To the beginning of the previous paragraph 

To the beginning of the next page 

To the beginning of the previous page 

Navigation keystrokes in Write. 

KEYBOAR D TIP: Don't use Tab, Spacebar, or Backspace 
when all you want to do is move the insertion point. The 
Tab key and Spacebar add blank space to the content of 
your document, and the Backspace key erases the char-
acter to the left of the insertion point. 
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NOTE: Keystrokes that move the insertion point to a previous 
location, such as Go To, Left (which moves to the beginning of 
the previous sentence), have a two-step action. The first time 
you press Go To, Left, the insertion point moves to the beginning 
of the current sentence. Press the keys again to move the 
insertion point to the beginning of the previous sentence. 

Selecting Text in a Write DocLOmen~ 
Write uses the same techniques for selecting text that were described in 
Chapter 1. (For information about these techniques, see "Entering and Ed­
iting Text in Documents," page 32.) You can do either of the following: 

[J Use the mouse to position the I-beam at one end of the area you 
want to select, press and hold down the primary mouse button, 
drag. the I-beam to the other end of the area to be selected, and 
then release the mouse button. 

[J Put the insertion point at one end of the area you want to select, 
press and hold down either Shift key, navigate to the other end of 
the area to be selected, and then release the Shift key. 

Write also allows you to use the mouse to quickly select the current 
line, the current paragraph, or the entire document. To select any of these 
items, start by positioning the mouse pointer in the area to the left of your 
text. You'll see the mouse pointer change from an I-beam to an arrow 
pointing "northeast." 

Eile f.dit Find .!;.haracter earagraph .!locument Help 

IPRINTERS.WRI 

/1 USING WRITE TO VIEW ON-LINE DOCUMENTS 
ZN --------------------------------------------------------------------

* If you enlarge Write to its maximum size. the following document will be 
easier to read. To do so. click the Maximize button in the upper-right 
corner of the Write window. Or open the Control menu in the upper-left 
corner of the Write window and choose Maximize. 

* To move through the document. press PAGE UP and PAGE DOWN or 
click the arrows at the top and bottom of the scroll bar along the right 
side of the Write window. 

.,. .. ...,. ...., 
-41" 

'+ 
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Now you can do any of the following: 

Il Click once to select the current line 

Il Double-click to select the current paragraph 

Il Hold down the Ctr! key and click once to select the entire document 

Copying and Moving 
Text with the Clipboard 

You can use the Clipboard techniques described in Chapter 5 to copy or 
move text from one place to another within a Write document, from one 
Write document to another, or from a Write document to a document 
created in a different application. For more information, see "Using the 
Clipboard with Applications for Windows," page 169. 

Using the Find Command 
Write's Find menu offers a handy set of commands for finding and changing 
text. The Find menu looks like this: 

The Find command on the Find menu helps you locate a particular 
combination of letters or words. You type the text you're looking for in the 
Find What text box of the dialog box shown below. 

Find 

Find What: lL-b_la_h _bl_a~-,--_______ ----, 

o Match Ylhole Word Only 

o Match,C.age 
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You can enter up to 255 characters in the Find What box. 

Including Wildcards in the Search Text 
If you include a question mark in your search text, Write interprets it as a 
wildcardthat can stand for any single character. For example, if your search 
string looks like this: 

?ray 

W rite will find bray, Cray, fray, gray, pray, tray, and ray. (Write finds ray 
because the space before it matches the wildcard.) 

To search for an actual question mark in your document, specify the 
search text like this: 

A? 

To type the caret character on a keyboard with the standard U.S. layout, 
press Shift+6. 

Including White-Space Characters 
in the Search Text 
Write lets you search for particular kinds of "white space," such as tab 
characters or paragraph endings. The following codes are recognized by 
Write's Find command: 

AW Any kind of space-a space between words, a tab character, 
a paragraph ending, or a manual page break 

At A tab character 

Ap A paragraph ending 

Ad A manual page break (Manual page breaks are discussed 
later in this chapter.) 

So, for example, if you want to find all examples of the word agenda 
(followed by a period) that fall at the end of a paragraph, you can specify 
the following as your search text: 

agenda.Ap 

To search for a caret character, specify the search text like this: 

AA 

411 



412 

PAR T 4: Running Applications 

Specifying Search Options 
Before beginning the search, you can select either or both of the check-box 
options in the Find dialog box. 

If you check Match Whole Word Only, Write ignores any instances of 
your search text that are not complete words. For example, if you search 
for graphic with the Whole Word option selected, Write ignores the words 
graphical, graphics, and typographic. 

If you check Match Case, Write finds only those examples of your 
search text that have the same capitalization as the search text in the Find 
What text box. 

Starting the Search 
After you fill out the Find What text box and choose your search options, 
start the search by clicking the Find Next button, by pressing Enter, or by 
pressing Alt+F. Write searches in the forward direction, starting at the current 
position of the insertion point. If Write reaches the end of your document 
without finding the search text, it continues the search starting at the top of 
the document. 

As soon as Write finds the search text, it selects the text and stops 
searching, but leaves the Find dialog box on screen. At this point, you have 
several options: 

a If Write has found what you're looking for and you don't want to 
do any more searching, you can remove the dialog box by pressing 
Esc or Alt+F4, or by clicking the dialog box's Cancel button. 

a If you want to search for the next occurrence of the same search 
text, you can restart the search by clicking Find Next, by pressing 
Enter, or by pressing Alt+F. 

a If you want to search for different text or use different search 
options, you can fill out the dialog box again and then restart the 
search. 
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Repeating the Search 
If you want to resume working on your document but think you might need 
to search for the same text again later, you can do either of the following: 

c Move the Find dialog box to a position on your screen where it 
won't be in your way. Then click outside the dialog box or press 
Alt+ F6 to return to your document. When you want to repeat the 
search, click the Find Next button again or press Alt+F6 to return 
to the Find dialog box, and then press Enter or Alt+ F. 

c Remove the dialog box by pressing Esc or Alt+F4. When you want 
to repeat the search, press F3 or open the Find menu and choose 
Repeat Last Find. 

Using the Replace Command 
The Find menu's Replace command lets you replace one set of characters 
or words with another. You can confirm each change, or you can have Write 
change every occurrence of the search text automatically. You can apply 
the command to the entire document or to the current selection only. 

When you choose the Replace command, Write presents the following 
dialog box. 

Replace 

1 
~'Y"c":''''''''i:i''~'C~''f'''''''''''''''''':':7;'1'~:1\~''~'' I 

Fin.d 'What: "--________ ----11 .!";;;::!:,mdNt~~t;;"«. 

R eJ!lace 'With: 1 1 I ~!::;~~'};;Ij~;pmE;JTr'r;~;~~" I 
o Match 'Whole 'Word Only 

o MatchI;.ase 

I !;'?}i]!;'~H~~;j;m;;':~1~7;r(7:FI 
I f'?i:~~"~:::7n:lti$ij:~:T"";; .• ·g~'~ I 

Telling Write What to Change 
To specify the text you want to change, fill out the Find What text box. You 
can enter up to 255 characters in the Find What box, including wildcards 
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and white-space characters. For information about specifying these charac­
ters, see "Including Wildcards in the Search Text," page 411, and "Including 
White-Space Characters in the Search Text," page 411. 

Specifying Search Options 
The Match Whole Word Only and Match Case check boxes work exactly 
the same way for the Replace command as they do for the Find command. 
For information about these check boxes, see "Specifying Search Options," 
page 412. 

Specifying the Replacement Text 
To specify the replacement text, fill out the Replace With text box. 

A question mark in the Replace With text box does not function as a 
wildcard, as it does in the Find What box, but you can use the four white­
space codes-Aw, At, Ap, and Ad. (For information about the white-space 
codes, see "Including White-Space Characters in the Search Text," page 411.) 
For example, if you want to remove the blank line between paragraphs, 
you can specify AP"P as the search text and Ap as the replacement text. 

Limiting the Replacement to a Selection 
If you select an area of text before you choose the Find menu's Replace 
command, Write makes the specified replacement only within the selection. 
If no text is selected when you choose the Replace command, Write makes 
the replacement throughout the entire ~ocument, starting with the current 
position of the insertion point. When it gets to the end of the document, it 
continues at the beginning. 

Replacing Automatically or Selectively 
After you fill out the Replace dialog box, you can start the Replace operation 
in either of two ways: 

c To replace all occurrences of the search text automatically, click 
Replace All. (If you selected an area of text before choOSing the 
Replace command, click Replace Selection.) 

EI To have Write pause for confirmation before making each change, 
click Find Next. 
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If you click Find Next, Write stops as soon as it finds your search text. 

At that point you can do any of the following: 

tI If you do not want Write to change this occurrence of the search 
text, click Find Next. 

c If you want Write to change this occurrence and continue searching 
for further occurrences, click Replace, and then click Find Next. 

c If you want Write to change all occurrences, click Replace All (or 
Replace Selection). 

c To stop the Replace operation without making any further changes, 
press Esc or Alt+F4, click the dialog box's Close button, press 
Alt+F6, or click anywhere outside the Replace dialog box. 

If you press Alt+ F6 or click outside the dialog box, the Replace dialog 
box remains on screen. You can use it again at any time by pressing Alt+F6 
again or clicking within the dialog box. 

Applying Document formOliiing 
Write arranges its formatting commands on three menus: Document, Para­
graph, and Character. This section describes the commands on the Docu­
ment menu. For information about the Paragraph menu, see "Applying 
Paragraph Formatting," page 420. For information about the Character 
menu, see "Applying Character Formatting," page 423. 

Commands on the Document menu apply to the whole document. 
You use these commands to: 

c Specify a header or footer that prints at the top or bottom of each 
page 

c Display or remove a ruler at the top of your document 

c Define tab stops 

c Tell Write to begin numbering pages at a number other than 1 

c Specify left, right, top, and bottom margins 

c Specify inches or centimeters as Write's default measurement unit 
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Specifying a Header 
A header is one or more lines of text printed at the top of each page. Each 
Write document can have one header, which can include page numbers. 

To specify a header, choose the Header command on Write's Docu­
ment menu. The Page Header dialog box appears on your screen. 

;a HEADER II!! 
file fdit Find ~haracter Earagraph D.ocument Help 

J!.islance from Top: ~ 0 ~Iinl on Fils! Page 

-,1-

Notice that behind the dialog box, you now see a window titled 
Header. This window looks like an ordinary window for creating a Write 
document. You see an insertion point, an end mark, and an I-beam if you're 
using a mouse. 

Type your header text in this window exactly as you would type 
ordinary document text. You can use any of Write's formatting commands 
as you type. Dont type any page numbers, though; we'll see how to add 
page numbers in a moment. 

When you finish typing your header text, you're ready to select the 
options in the Page Header dialog box. If you want to include a page number 
in your header, put the insertion point where you want the number to appear 
before you go to the dialog box. Then click the mouse inside the dialog 
box or press Alt+ F6. 
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The Distance From Top setting in the dialog box indicates the amount 
of space that Write will leave between the top of your header and the top 
edge of each page. The default is 0.75 inch; you can specify a different 
value. 

The Print On First Page check box indicates whether or not your header 
will appear on page one. The default is no; put a check in the box if you 
want a header on the first page. 

To add page numbers to your header, click Insert Page #, or press 
Alt+I. The marker (page) will appear in your header at the insertion point. 
When your document prints, Write replaces the marker with the appropriate 
page numbers. Page numbering begins at 1 unless you specify a different 
starting number in the Page Layout dialog box, which we'll come to in a 
moment. 

When you're satisfied with your header, click the Return To Document 
button. To start over and create a new header, click Clear. 

Specifying a Footer 
A footer is one or more lines of text printed at the bottom of each page. 
Each Write document can have one footer, which can include a page 
number. 

The procedure for specifying a footer is exactly the same as for speci­
fying a header, except you begin by choosing Footer from the Document 
menu. For more information, see the preceding section. 

Displaying a Ruler 
To display a ruler at the top of the document, pull down the Document 
menu and choose Ruler On. The ruler looks like this: 

e ., ;;;IFI 
File Edit Find Character Paragraph Document Help 

.~I!DI !i!(§.~ 13 B@~~, IS 6~ 
I 'to 't. 'to 1:': 

une-spacinJ leans I paragr~Ph-alignmenllcons 
Tab-stop icons Tab-stop marker 

First-line indent marker Right-indent marker 

Left-indent marker 
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As you move through a document, the ruler shows you the line spac­
ing, paragraph-alignment style, indents, and tab stops that are currently in 
effect. It also gives you a simple way to change any of these settings with 
the mouse. 

The ruler has three groups of icons, directly above the inch (or centi­
meter) markings. The two icons in the leftmost group provide mouse short­
cuts for setting ordinary and decimal tab stops. (For information about 
setting tabs, see "Setting and Using Tabs," page 418.) The three icons in the 
middle group indicate the current line spacing and provide a mouse shortcut 
for changing the line spacing. (For information about setting line spacing, 
see "Choosing Line Spacing," page 421.) The four icons in the rightmost 
group show the current paragraph alignment and provide a mouse shortcut 
for changing it. (For information about setting paragraph alignment, see 
"Choosing Paragraph Alignment," page 421.) 

Three markers· on the ruler itself show the current position of the left 
and right margins and first-line indents. They also provide a convenient way 
to change indent settings with the mouse; simply drag the marker to the 
desired location. (For information about setting indents, see "Setting In­
dents," page 421.) 

Setting and Using Tabs 
Write offers two kinds of tabs: ordinary and decimal. An ordinary tab left 
aligns text at the tab position. Decimal tabs align the decimal points in a 
column of numbers at the tab position, with the whole-number and frac­
tional portions of the numbers to the left and right of the tab. 

By default, Write has ordinary tabs every 0.5 inch. You can replace 
these default tabs with up to 12 tabs of your own (positioned wherever you 
like) by filling out a dialog box or by using the ruler's tab icons. When you 
set your own tabs, Write erases the default O.5-inch tabs to the left of your 
tabs, but leaves in place the O.5-inch tabs to the right of your rightmost tab. 

Tabs in Write apply to an entire document; you can't have different 
tabs for different paragraphs. 

To set tabs using the dialog box, open the Document menu and choose 
Tabs. The dialog box looks like the one shown in the following illustration. 



Chapter 14: Using Write ~ 
Tabs 

fosilions: 

,!!,ecimal: D. D. 0 . D. D. 0 . 

fosilions: ...... 1 __ J-I __ ...... 1 __ ..l-I __ ...L.I __ ..... I_----' 
.!!.ecimal: 0 . D. 0 . D. D. 0 . 

In the wide boxes labeled Positions, specify the distance of each tab 
from the left margin. Write assumes that you mean inches if the page layout 
measurements are set to inches, or centimeters if the page layout measure­
ments are set to centimeters. (For information about setting page layout 
measurements, see "Choosing Default Measurement Units," page 420.) You 
can override the default unit of measurement by including the units in the 
boxes. For example, you can enter a tab such as 5.08 cm. Write converts 
the measurements you enter to the default unit when you click OK. 

To set a decimal tab, click the Decimal check box below the tab 
position box. Write assumes that all tabs are ordinary unless the associated 
Decimal box is checked. 

To remove a tab, open the Tabs dialog box, select the tab you want 
to remove, and press the Del key. To remove all tabs, open the Tabs dialog 
box and click Clear All. 

To set tabs using the ruler's tab icons, first display the ruler. (For 
information, see "Displaying a Ruler," page 417.) Then do the following: 

1 . Click the icon for the type of tab you want: Click the icon with the 
bent arrow for an ordinary tab; click the icon with the straight arrow 
and the decimal point for a decimal tab. 

2. Position the tip of the mouse pointer directly below the ruler position 
where you want the tab, and then click. A bent arrow or straight 
arrow appears on the ruler to mark the new tab position. (For more 
information, see "Displaying a Ruler," page 417.) 

To change a tab's position, drag the tab marker along the ruler. 

To remove a tab using the ruler, drag the tab marker away from the 
ruler and release the mouse button. 

419 



420 

PAR T 4: Running Applications 

Setting the Starting Page Number 
Write normally numbers pages starting at 1. If you want to use a different 
starting number, choose the Document menu's Page Layout command. Enter 
the new number you want in the Start Page Numbers At box in the Page 
Layout dialog box. 

Setting Margins 
Write's default top and bottom margins are 1 inch. The default left and right 
margins are 1.25 inches. To change any of these settings, choose the Docu­
ment menu's Page Layout command and enter the new margins in the 
Margins boxes in the Page Layout dialog box. 

Margins apply to the entire document. If you want to offset a particular 
paragraph a different amount from the edges of the paper, apply an indent 
to that paragraph. (For information about indents, see "Setting Indents," 
page 421.) 

Choosing Default Measurement Units 
Write measures indents, margins, and tab positions in inches, unless you 
have changed your Windows Measurement setting to Metric using Control 
Panel's International applet. (For information about the International applet, 
see "Setting Country-Specific Options," page 153.) Regardless of your Win­
dows measurement setting, you can switch Write's measurement from 
inches to centimeters-or vice versa-by choosing the Page Layout com­
mand from Write's Document menu, and then selecting inch or cm in the 
lower left corner of the Page Layout dialog box. 

Applying Paragraph Formatting 
Commands on the Paragraph menu apply to individual paragraphs or se­
lected consecutive paragraphs. You can use these commands to: 

t1 Set left,centered, right, or justified paragraph alignment 

D Choose single-space, 11/2-space, or double-space line spacing 

a Apply indents 
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To apply a paragraph formatting command to new text, position the 

insertion point where you're about to type, and choose a formatting com­
mand. To apply a format to an existing paragraph, position the insertion 
point anywhere in the paragraph, and then choose a formatting command. 
To apply a format to a group of paragraphs, first select some text in each 
paragraph, and then choose a formatting command. 

Choosing Paragraph Alignment 
Write offers four paragraph alignments: 

a Left Cleft margin straight, right margin ragged) 

a Centered (both margins ragged, each line-including the last line 
of each paragraph-centered between the margins) 

a Right Cleft margin ragged, right margin straight) 

a Justified (both margins straight) 

You can apply any of these options either from the Paragraph menu 
or by clicking one of the ruler's paragraph-alignment icons. 

Choosing Line Spacing 
Write offers three line-spacing options: single, 11/2, and double. You can 
apply one of these options either from the Paragraph menu or by clicking 
one of the ruler's line-spacing icons. 

Setting Indents 
You can use three kinds of indents in a Write document: 

a An indent from the left margin that applies to all lines in a paragraph 

a An indent from the right margin that applies to all lines in a 
paragraph 

a An indent from the left margin that applies only to the first line in 
a paragraph 

The last of these options can be used to set up automatic paragraph 
indenting or to create paragraphs with hanging indents. See "Setting Hang­
ing Indents," on the next page. 
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Like tabs, indents can be set using either a dialog box or the ruler. 

To set indents using a dialog box, choose the Paragraph menu's In­
dents command. The Indents dialog box looks like this: 

first line: 

Right Indent: 

Simply fill out the boxes for the indents you want and click OK .. 

On the ruler, the right-pointing triangle marks the position of the left 
indent; it is at 0 if no left indent is in effect. The left-pointing triangle marks 
the position of the right indent; if no right indent is in effect, it indicates the 
position of the right margin. The first-line indent is indicated by a dot; if no 
first-line indent is in effect, the dot and the left-indent triangle are superim­
posed. 

To apply or change an indent setting using the ruler, drag the appro­
priate symbol to the ruler position you want. 

Setting Hanging Indents 
A paragraph has a hanging indent when all of its lines except the first are 
indented. Hanging indents are useful for such things as bulleted or num­
bered lists. To set up a hanging indent, specify a positive left indent and a 
negative first-line indent. For example, if you set a left indent of 2 inches 
and a first-line indent of -2 inches, all lines except the first will start two 
inches from the left margin. The first line will start at the left margin. 

Selecting Default Paragraph Settings 
You might have noticed one more command on the Paragraph menu: 
Normal. This command provides a shortcut for returning to Write's default 
paragraph settings. The default settings are: 

C Left paragraph alignment 

EI Single line spacing 

D No indents 
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Applying Character Formatting 

Commands on the Character menu apply to individual characters or selec­
tions of characters. You can use these commands to: 

1:1 Apply typographic styles such as boldface, italic, underlining,' 
superscript, and subscript 

II Select fonts and point sizes 

To apply character formatting commands to new text, position the 
insertion point where you're about to type, and choose a formatting com­
mand. The command is applied to all new text that you type, but not to 
existing text. To apply a character formatting command to existing text, first 
select the text to which you want to apply the command, and then choose 
a formatting command. The command is applied only to the selected text. 

Applying Typographic Styles 
Write's style options include Bold, Italic, Underline, Superscript, and Sub­
script. Commands for all five are located on the Character menu. You can 
use these styles singly or in combination (except Superscript and Subscript, 
which cannot be used together). Write displays a check mark next to each 
style option currently in effect. 

To remove all style options from the current selection or from text 
you're about to type, choose the Character menu's Regular command. 

KEYBOARD TIP: You can press Ctrl+B, Ctrl+I, and 
Ctrl+U as keyboard shortcuts for bold, italic, and underline, 
respectively. The shortcut for the Regular command is F5. 

NOTE: Unfortunately, although Write is aware of most of your 
printer's capabilities and limitations, it won't warn you if you 
apply a style command that's not available on your printer. For 
example, if you're using a Hewlett-Packard LaserJet with a font 
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cartridge that includes 14-point Helvetica in roman but not italic, 
Write still lets you format text in 14-point Helvetica italic. It 
appears italic on screen, but prints in roman. You might want to 
experiment to be sure you know your printer's capabilities before 
creating formatted docur:nents in Write. 

Reducing and Enlarging a Font 
The most precise way to change a font's point size is to choose the Fonts 
command and select a size from the Size list box. As a shortcut for some 
circumstances, Write provides the Reduce Font and Enlarge Font commands 
on the Character menu. 

The Reduce Font and Enlarge Font commands allow you to change 
the size of selected text through a predefined set of point sizes. The point­
size sequence, which is the same for all fonts, is as follows: 

• 6 8 10 12 14 18 24 30 36 48 

72 
Each time you choose the Reduce Font or Enlarge Font command, the 

point size of the selected text decreases or increases to the next size in the 
sequence. 

Some of these sizes might not be available for particular typefaces on 
your printer. Therefore, exercise some caution when using the Reduce Font 
and Enlarge Font commands. 
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Choosing a Font and Point Size 
To apply a font in a particular point size, pull down the Character menu 
and choose the Fonts command. The Fonts dialog box shows you the 
typefaces and point-size options available on your printer. The dialog box 
looks like this: 

font: 

Arial Narrow 
~ Book Antiqua 
~ Bookman Old Style 
~ Centur Gothic 1+ 

Font 

Font St.v.le: 

IBoid 
Regular 
Italic 
:1_ I 

Bold Italic 

[SamPle 

~ize: 

~ 

1+ 

AaBbYyZz 

I f~''\~roK:;~~1 
Ii I rn;ar;cei~~~1 

This is a TrueType font. This same font will be 
used on both your printer and your screen. 

Fill in or choose a font and a point size, and click OK. To specify a 
point size that doesn't appear in the list box, type a number in the Size box. 

For more information about fonts, see "Working with Fonts," page 40. 

Including Pictures in Write Documents 
W rite documents can include pictures as well as text. To incorporate a 
picture in a Write document, do the following: 

1. Create the picture in a Windows-based graphics program, such as 
Paintbrush (or load a picture file from a disk into a program such 
as Paintbrush). 

2. In the graphics program, select the area of the picture you want to 
use in your Write document. 
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3. Use the graphics program's Copy or Cut command to put the picture 
on the Windows Clipboard. 

4. In your Write document, move the insertion point to the place where 
you want the picture to appear. 

5. Choose the Paste command from Write's Edit menu to insert the 
picture. 

If your graphics program puts the picture on the Clipboard in more 
than one format, Write's Paste Special command, on the Edit menu, will 
also be available. Use this command to choose between the available for­
mats. (For more information, see "Controlling a Pasted Object's Format," 
page 428.) 

Repositioning a Picture 
When you first paste a picture into a Write document, the picture is aligned 
with the left margin. You can center the picture or align it with· the right 
margin using Write's Paragraph menu, as follows: 

1. Select the picture by clicking it or by using the direction keys. 

2. Open the Paragraph menu and choose Centered or Right. 

You can also adjust the horizontal position of a picture with the Edit 
menu's Move Picture command. When you select your picture and choose 
this command, Write puts a square cursor in the center of the picture, as 
shown in the illustration on the next page. 

Use the Right and Left direction keys to relocate your picture, and then 
press Enter. If you change your mind about the move, press Esc before 
pressing Enter to cancel the move. 

To move your picture with the mouse, simply move the mouse left or 
right. When the outline is where you want your picture, click the primary 
mouse button. 



Chapter 14: Using Write 

1:1 Write - (Untitled) an 
Eile Edit Find ~haracter Earagraph Ilocument Help 

l!J!ng!:~ ? _______________ .. _____ . __ . ___________ . __ . _______ ._, 
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II 
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Resizing a Picture 
You can also change the size of a picture after pasting it into Write. To do 
this, select the picture and choose the Edit menu's Size Picture command. 
Like the Move Picture command, Size Picture puts a square cursor in the 
center of the picture. But unlike the Move Picture command, it displays 
sizing information in the lower left corner of the Write window (where the 
current page number is usually displayed). 

~----------------W--rit-e--W--IR-IN-G-.W-R-I-----------------II~ 

Eile Edit Find ~haracter Earagraph Ilocument Help 

Network Wiring in Older Homes 

r-_.Y.~u.·~.h9.r:!)-El.!9-Q.~~!~~-t~lis, 

I I 
I El33J IWJ I 
i I 
I EIE. EIEI 
i I 
'you're probablYunaware-ofthe difficulties of installing a computer network in your home; 
otherwise, you would have moved long ago. For those who haven't attempted to coax coaxi 
cable through mouse passageways, this guide should convince you that it's not a task that 
be completed during halftime. 
II 
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You can size your picture with the mouse, the direction keys, or both. 
The mouse can be quicker, but the keyboard can be more effective for 
precise adjustments. 

To size the picture using the mouse, move the mouse pointer. When 
you're satisfied with the new size, press the primary mouse button. 

To size the picture using the direction keys, first move the square cursor 
to the edge of the picture you want to move. For example, if you want to 
stretch or compress the picture from the right edge, start by pressing the 
Right direction key. Then use Right, Left, or both to adjust the right edge of 
the picture. 

If you want to adjust two adjacent sides at once, move the cursor to 
the corner where the two sides meet. 

When you're satisfied with the new size of your picture, press Enter. 

WINDOWS riP: The X and Y numbers in the lower left 
@ corner of the window indicate the picture's current size 
W relative to its size when you first imported it into Write. If 

you make the picture wider, the X value increases; if you 
make it taller, the Y number increases. To avoid distorting 
the shap~s of the objects depicted in your image, it's best 
to modify the X and Y dimensions evenly. On the other 
hand, if you want to create funhouse-mirror effects, you 
can to change one dimension more than the other. 

Controlling a Pasted Object's Format 
Sometimes when you copy an object to the Clipboard, the source program 
puts the object on the Clipboard in more than one format. For example, it 
might store a picture on the Clipboard in both picture format and bit-mapped 
format. (For more information about data formats and the Clipboard, see 
"Viewing the Clipboard's Contents," page 176.) Whenever the object to be 
pasted is available in more than one format, Write enables the Paste Special 
command, allowing you to choose which format to use. 



Chapter 14: Using Write 

For example, here is how the Paste Special dialog box looks when an 
object is available in both picture and bit-mapped formats: 

Paste Special 

.Q.ata Type: 
Picture 

~L...-B_itm_a_p _______ ---,llr"~canc;;r~-1 

Select the format you prefer, and click Paste. 

Usually, Write's Paste command chooses the best format for you auto­
matically. For example, when the available formats are picture and bit­
mapped, it chooses picture, which usually gives you more satisfactory 
results. (In particular, because the picture format is not tied to the re'solution 
of a specific output device, it usually gives you a much better printed image 
than the bit-mapped format.) However, the Paste Special command allows 
you to override the default choice. 

When the source program is an OLE server, Write's Paste command 
automatically embeds the object that is stored on the Clipboard. (See "Link­
ing and Embedding in Write," below.) If you want your pasted object to be 
static, rather than an embedded object, use the Paste Special command 
instead of Paste. Paste Special's dialog box in this case looks like this: 

Paste Special 

Source: EKcel Chart 
HOMICIDE.XLC Chart 

Its posifion at the top of the Data Type list tells you that Write will 
embed this Excel Chart Object by default. Embedding the image doesn't 
add any more bulk to your file than pasting it as a static object, and it allows 
you to edit the image quickly and easily. (To change a static object, you'd 
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have to copy it back into your graphics package, delete it from your Write 
document, make your edits in the graphics program, and then recopy it into 
Write-a far more laborious process.) The Paste Special command, how­
ever, allows you to override Write's default procedure. 

Linl(ing and Embedding in Write 
Write is capable of acting as an OLE client application. This means that you 
can store links to or embed the following kinds of data, among others, in 
your Write documents: 

c Graphic images copied to the Clipboard from OLE server programs, 
such as Paintbrush or Ami Pro 

c Charts or worksheet "pictures" copied from Microsoft Excel 

c Sound annotations copied from the Windows Sound Recorder 
accessory 

c Packages copied from the Windows Object Packager accessory 

To link an object from the Clipboard, use Write's Paste Link command. 
To embed the object instead of linking it, choose the Paste command. If the 
object's source application is an OLE server, the object will automatically 
be embedded. (For more information about linking and embedding, the 
differences between the two, and the advantages and disadvantages of each, 
see "Linking Versus Embedding," page 185.) 

Alternatively, you can link or embed an object by choosing the Paste 
Special command. (For information about the Paste Special command, see 
"Controlling a Pasted Object's Format," page 428.) If the object on the 
Clipboard came from an OLE server, the Paste Special dialog box indicates 
what type of object it is and which program it came from, as with the Excel 
Chart Object in the previous illustration. The first format in the Data Type 
list includes the word object. To store a link to the object's source, select 
the format you want to use and click Paste Link. To embed the object, select 
the first option and click Paste. 
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WINDOWS TIP: If the Paste Special dialog box indicates 
that the Clipboard's data came from an OLE server, but the 
Paste Link button is grayed out, that probably means the 
data has never been saved in the source application. To 
create a link to OLE server data, you must first have saved 
that data in a disk file. 

Moving and Sizing 
Linl{ed or Embedded Objects 
For display purposes, Write handles linked and embedded objects the same 
way it handles static graphic images. You can move and size such objects 
using the same procedures you use with static objects. For more information, 
see "Repositioning a Picture," page 426, and "Resizing a Picture," page 427. 

WINDOWS TIP: If you double-click an embedded object 
after changing its size in Write, the object appears for 
editing-at its original size-in the source application. 
When you update the Write document after making your 
edits, however, the image reappears at the modified size. 

Activating, Playing, and Editing 
Linked or Embedded Objects 
When you select an object in a Write document that was linked or embedded 
from an OLE server, the Object command on Write's Edit menu becomes 
available. It also changes to reflect the kind of object you select. The illus­
tration on the next page, for example, shows how the Object command 
appears if you select a graphic embedded from Paintbrush. 
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Move Picture 
Size Picture 

Choosing this command activates the object's source application­
Paintbrush in this example-arid allows you to edit the object. (A simpler 
way to edit an embedded image is to double-click it.) 

If the linked or embedded object is a graphical representation of a 
non-graphical data type, such as a sound annotation or a package, the Object 
command presents a small submenu, like this: 

Choosing Play "renders" the object (by letting you hear the sound 
annotation, for example); choosing Edit invokes the object's source appli­
cation. Double-clicking in this case is a shortcut for the Play command. If 
you want to edit the object, you have to use the menu command. 
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Linking and Embedding 
with the Insert Object Command 
The Insert Object command on Write's Edit menu lets you initiate the linking 
or embedding process from within your Write document, instead of from 
within an object's source application. When you choose this command, 
Write presents in a dialog box all the "linkable" and "embeddable" object 
types listed in your Windows system's registration database. 

Insert Object 

Qbject Type: 
':2~3 Worksheei . .... .... .. 

Equation 
Improv Presentation 
Improv'Worksheet 
Media Pia er 

ii I r"~''''OK~:~:~':: I 
I rcit1lt?iii71 

Choose the kind of object you want to link or embed, and click OK. 
Write activates the object type's source application, allowing you to create 
an object (or load one from a disk file). 

Modifying Linl{s with the Links Command 
When you link an object, as opposed to embedding it, Write does not store 
. the object in your file. Instead, it stores a "pointer" to the object's source-the 
name of the source application and the file in which the object is stored, 
for example. If you subsequently rename or move the object's source file, 
the stored link will no longer be valid. In that case, you can repair the link 
with the help of Write's Links command. 

The Links command on Write's Edit menu lists all objects linked to the 
current Write document. 

Links: 

Microsoft Excel ...... orksheet ClMBX.XlS 
Microsoft Excel ...... orksheet CFISX.XlS 

Update: @ Automatic 0 M.anual 

Links 

curvalue Automatic 
cur value Automatic 

IrmliatlliRl11 1.]mnteJtir.l~l 1~~'if~"§1 

1~)lo~l1J1 

1~1:Mc'llJ 

IJaCtiVa\e\JI 

I~~f'diifml 
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To change the source file for a link, select the link you want to modify, 
and click Change Link. Write presents a file-browser dialog box, allowing 
you to pick the file you need. 

The Links command also allows you to change a link from automatic 
to manual, or vice versa. Links are always automatic by default, which means 
that any changes in the source data are reflected as soon as possible in your 
Write document. If you prefer to have them updated only on demand, 
choose the Links command, select the link you want to change, and then 
click Manual. 

Saving and Retrieving Files 
Write uses the same techniques for saving and retrieving files as most other 
Windows-based applications. (For more information about these proce­
dures, see "Creating, Opening, and Saving Files," page 27.) The following 
commands are on Write's File menu: 

c Save, to save the current file 

c Save As, to save the current file under a new name or to choose 
different file-saving options 

c New, to create a new file 

c Open, to load an existing file from disk 

Write's normal file extension is WRI. If you don't specify an extension, 
Write automatically uses WRI. You can use a different extension-or no 
extension-if you want. To save a file with no extension, include a period 
at the end of its name. 

Bacldng Up When You Save 
When you save a file the first time, Write presents the Save As dialog box. 

If you check the Backup box, Write preserves the previously saved 
version of the file each time you save. That way, if you regret the changes 
you made, you can return to the previous version. 

Write's backup files are saved with the extension BKP. To open a 
backup file, use the File menu's Open command and specify your filename 
with the extension BKP. 
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Save As 

File N,.ame: J!.irectories: I F:"'~''"'''''i:'fK':''':~''':'''''''"' I 
c:\users\default 
I"""='"""------~ 1[":'''':'CanceT~:'''''1 
r2.7 c:\ ~ , . 
r2.7 users 
f:} default 

o Ilackup 

Save File as !'ype: Driyes: 

I,-W_r_ite_F_il_es_l_"._W_R_Il __ llI_'" IL-liia_c_: _____ -'-It!J_"" IrN'eiio1E:~'::~1 

Saving a Text File 
To save your file as plain (unformatted) text, choose Save As, and then open 
the Save File As Type drop-down list. In the list that unfolds, choose either 
Word For DOS/Txt Only or Text Files (*.TXT). Either way, Write saves the 
words in your file but removes all character, paragraph, and document 
formatting. Your file also loses any embedded or linked data and any 
pictures pasted in as static objects. 

You might want to save your document as a text file under these 
conditions: 

[] If you need to transmit the document over a modem to a system 
that cannot accept a binary file transfer (For information about 
binary and text file transfers, see "Sending and Receiving Files," 
page 465.) 

[] If you need to transfer your document into a non-Windows-based 
word processor that cannot read a formatted Write document 

WINDOWS TIP: If you need to transfer a Write document 
into a Windows-based word processor that doesn't accept 
files with the extension WRI, use the Windows Clipboard. 

, 

: 
, 
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Saving a Microsoft Word File 
To save your Write document in a format that can be read by the MS-DOS­
based version of Microsoft Word, choose Save As and open the Save File 
As Type drop-down list. Choose Word For DOS C*.DOC). All paragraph 
formatting and document formatting is preserved. Character formatting is 
preserved if your Word printer driver is the same as your Windows printer 
driver. If the printer drivers differ, Word makes appropriate font substitu­
tions. 

Any linked or embedded data and any pictures in your Write document 
are lost when you save the file in MS-DOS-based Microsoft Word format. 

If you check the Backup box when saving a file in Microsoft Word 
format, the backup file is stored with Word's backup extension, BAK. 

Opening a Text File 
A text file is a file that contains text characters only, without formatting 
information. Examples include files created by Notepad or by the MS-DOS 
text editor, Edit. Most word processors, both Windows-based and non­
Windows-based, include options for saving documents as text files. 

You can use Write to read and edit text files. When you're finished 
working with such a file, you can save it again as a text file or convert it to 
a formatted Write file. 

To open a text file, specify the name of the file in the Open dialog 
box. As soon as Write begins reading the file into memory, it recognizes 
that it's a text file, and you'll see the following dialog box. 

Write 

T ext document 
Do you want to convert this file to Write format? 



Chapter 14: Using Write 

You need to convert the file to Write's format only if both of the 
following are true: 

IJ Your text file contains special characters, such as accented letters; 
mathematical symbols; trademark, copyright, or registration sym­
bols; or line-drawing characters. 

IJ Your file was created in a non-Windows-based application. 

If you do not convert a non-Windows text file that contains special 
characters, those characters might be incorrect when they appear in your 
Write window. 

Opening a Microsoft Word File 
Write can work with files created in the MS-DOS-based version of Microsoft 
Word. You don't need to convert your Word files to plain text before loading 
them into Write. 

To open a Word file, specify the name of the file in the Open dialog 
box. As soon as Write begins reading the file into memory, it recognizes 
that it's a Word file and you'll see the following dialog box. 

Write 

CJ). Microsoft Word for DOS document 
Do you want to convert this file to Write format? 

Click Convert to load the file or Cancel to abandon the whole idea. 

Paragraph and docuI!lent formatting in your Word file are preserved 
in Write. Character formatting is preserved to the extent that your Windows 
printer driver supports it. If the driver you use in Windows is different from 
the driver you used when creating the Word file, some of your original font 
specifications might be lost. 

Write does not translate Microsoft Word style sheets. 
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Paginating and Printing 
a Write Document 

To print your Write document, pull down the File menu and choose Print. 
You'll see a dialog box like this: 

. Print 

Printer: System Printer (LaserJetlll) 

Print Range 

@lAi.n 
o S~Jection 
o ,eages 

from: E:=J I.o: E:=J 
Print Quality: 1L-3_oo_dP_i ____ ..... I!l_"" 

o Print to File 

I J\l'~1\O~l\\ltfq 
I w\"lY:'~~"'~""'~"'''~~'%~''''1 !i,~;l!~Cancfll?\~{: 

kopies: D 
[g] Collate Coples 

If you want more than one copy, change the number in the Copies 
box. If you want to print a selection of pages instead of the entire document, 
fill in the page numbers you want in the From and To boxes. 

As it prints, Write decides where to put page breaks. If you want to 
know where those page breaks will be, or if you want to exert some control 
over where the pages will be broken, choose the File menu's Repaginate 
command before choosing Print. You'll see this dialog box: 

Repaginate Document 

If you want to be able to modify Write's page-break choices (for 
example, to avoid a page break between a heading and its associated text 
or in the middle of a table), put a check in the Confirm Page Breaks box 
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before clicking OK. With the Confirm option on, Write stops at each pro­
posed page break and presents the following: 

Repaginating Document 

Use up and down buttons 
to move page break 
if necessary. 
then confirm. 

I r"'"")!!pr~"" II rConlirm"~' I 
IFDown::'''''J Ir~can'c;r""1 

Click Up if you want to move the page break up. With each click, 
W rite moves the proposed page break up one line. 

Click Down if you have already moved the proposed page break up 
and you want to lower it again. (You can't move the page break any lower 
than Write's initial proposed location.) 

When you're satisfied with the location of the break, click Confirm. If 
you override Write's initial proposed location, a "manual" page break will 
be inserted into your document at the location you choose. 

Manual page breaks are represented in your document by dotted lines. 
"Soft" page breaks-page breaks chosen by Write, not by you-are identi­
fied by a guillemet (») in the left margin. 

If you edit your document and print it or repaginate it, the soft page 
breaks will probably appear in different locations. Your manual page breaks 
will remain where you put them, however. Therefore, if you edit a document 
that already contains manual page breaks, you might want to paginate it 
again before printing, to ensure that the manual page breaks you chose 
earlier are still appropriate. 

If You Change Printers 
As mentioned earlier in this chapter, Write formats documents using the 
current printer driver. The selection of fonts and point sizes presented in 
the Fonts dialog box, as well as the locations of line and page breaks, all 
depend on the characteristics of the current printer. If, after creating a Write 
document, you switch to a different printer or switch between portrait and 
landscape orientations, your line breaks will almost certainly move, and the 
contents of the Fonts dialog box will change. 
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If you select a block of text that was originally formatted with a font 
not available on the current printer, Write's Font dialog box will look some­
thing like this: 

font: 

Arial 
W AvantGarde 
W Courier 
~ Courier New 
W Helvetica 

Font 
Font St,l!.le: 

I Regular 
• - I • 

Italic 
Bold 
Bold Italic 

[SamPle 

The Font box-and sometimes the Font Style and Size boxes-will be 
blank. If you print your document without assigning a different font to this 
text block, Write will print the block in the font that's closest in style to your 
original choice. If you return to the printer driver for which the document 
was originally formatted, your original font specifications will be restored. 
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A Typical Terminal Session 
Pull up a settings file and tell Terminal what to do. Use the Dial command, 
and then log onto the host computer or service. 

Creating a Settings File 
A settings file stores all the information Terminal needs to connect to a 
particular user or service. 

Initiating a Telephone Call 
Open the Phone menu and choose Dial. 

Answering a Call Initiated by the Remote System 
A simple command to your modem makes it answer the phone after a 
specified number of rings. 

Hanging Up the Telephone 
With some information services, you need to use Terminal's Hangup 
command even after you've logged off. 

I 
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Creating a Transcript of Your Communications Session 463 
You can capture your session on disk or send a transcript to your printer. 

Timing a Communications Session 
The timer can help you keep connect charges under control by showing 
how much time has elapsed. 

464 



Inspecting and Selecting Text in Terminal's Buffer 
Text from the buffer can be copied, but not cut, to the Clipboard. 

Transmitting Data from the Clipboard or the Buffer 
Press Ctrl+Y to transmit Clipboard text. 

Sending and Receiving Files 
You can send and receive text files or binary files. Terminal supports the 
XModem/CRC and Kermit error-checking protocols. 

Communicating Without Telephone lines 
With a null-modem cable, you can leave Ma Bell out of the loop. 
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erminal is a program that allows your computer to communicate 
with other computers. You can use it to do such things as retrieve 

data from a company mainframe, explore an online information service such 
as CompuServe, or send electronic mail (e-mail) over a public e-mail net­
work such as Mel Mail. 

To communicate with a remote computer using Terminal, you must 
have a modem attached to one of your computer's serial ports. The modem 
converts signals from your computer into a form that can be transmitted 
over telephone lines. The party with whom you're communicating must also 
have a modem to reconvert the telephone signals into the form understood 
by computers. 

This chapter tells you how to use Terminal's features. You'll learn to 
set up a communications link, send and receive files, use Terminal's error­
checking options, create printed transcripts of your communications ses­
sions, and so on. You'll also find out how to save "settings" files that are 
tailored for the various computers and services you communicate with 
regularly. 

A lypica~ Terminal Session 
A typical communications session using Terminal goes something like this: 

1. Start Terminal. 

2. Load or create a "settings" file. 

Before establishing a communications link, you must supply a 
number of "communications settings." These settings tell Terminal 
what number to dial, the speed to use for transmitting and receiving, 
what kind of parity (error checking) to use, and so on. Several of 
these settings might be different for each computer or service you 
connect with. 

Usually, the service or host computer with which you're commu­
nicating will tell you what settings it requires, so it's not a problem 
if you don't understand all the technical details about each setting. 

To save you the trouble of reentering settings each time you start 
a communications session, Terminal lets you create settings files. 
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These files store all the information Terminal needs to connect with 
a particular computer or selVice. So, for example, if you frequently 
get stock quotes or other news from the Dow Jones News/Retrieval 
selVice, you might create a settings file called DOWJONES.TRM. 
Any time you want to log onto Dow Jones, you can simply load 
DOWJONES.TRM into Terminal and you'll be ready to go. 

3. Use the Dial command. 

Terminal uses your modem's built-in dialing capability to estab­
lish a telephone connection with the remote computer. After a 
connection is established, whatever you type in Terminal's window 
is sent to the other computer. If the person or computer at the other 
end of the connection sends information back, it appears in Termi­
nal's window as if someone behind the screen were typing. 

You can continue to use Terminal's menu commands after you 
establish a connection with the other computer. Your interaction 
with Terminal's menu system is not transmitted. 

4. Log onto the host computer or selVice. 

If you're communicating with a mainframe or an information 
selVice, you'll probably be required to enter your name and a 
password as soon as the connection is established. This process is 
called logging on. To simplify this and other routine procedures, 
Terminal lets you assign strings of characters to your keyboard's 
function keys. The function-key assignments are saved in your 
settings files, so you can have a different set of assignments for each 
selVice you use. 

5. Interact with the party you're connected to. 

Your interaction might consist of nothing more than simple 
messages typed at the keyboard. Or you might transmit a great deal 
of information at once by pasting it into Terminal from the Clip­
board. 

You can also exchange files with the host computer. Terminal 
lets you send and receive two kinds of files-text files and binary 
files. We'll see what the differences are and what procedures are 
used for file transfers later in this chapter. 
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WINDOWS TIP: If you're receiving or sending a lot of 
information, you might want to let Terminal do its work 
in the background while you focus your attention on a 
different application. 

6. Log off the remote computer or service. 

7. Use Terminal's Hangup command to break the telephone connec­
tion. 

When you log off, the host computer might break the telephone 
connection itself. Terminal will not know that, however, so it's best 
to use the Hangup command regardless of what the other party 
does. 

8. Quit Terminal. 

If the telephone line is still open (or if Terminal thinks it is), 
Terminal prompts you to close the connection before quitting. 

Creating a Seiiings fUe 
The procedure for creating a new settings file is as follows: 

1. Start Terminal. 

Double-click the Terminal icon in Program Manager. If it hasn't 
been moved, you'll find it in your Accessories program group. 

NOTE: The first time you start Terminal, a Default Serial Port dialog 
box appears, as shown below. Simply select the port to which 
your modem is attached and click OK. 

Default Serial Port 

5 erial ~orls: 

one 
COM1 
COM2 
TELNET 
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2. Select the appropriate options on Terminal's Settings menu. 

The Settings menu looks like this: 

Ierminal Emulation ... 
Terminal Ereferences ... 
Function ~eys .. . 
Te~ Transfers .. . 
Ilinary Transfers ••• 
!;.ommunications ... 
MODem Commands ... 

Printer Echo 
Timer Mode 
Show function 

The first eight commands on this menu all bring up dialog boxes. 
All of the choices you make in these dialog boxes are saved in your 
settings file. Each settings file can have a different arrangement of 
choices. (The bottom three commands are toggles-options that are 
either turned on or turned off. Your choices here are not recorded 
in your settings files.) 

3. Pull down the File menu, choose Save As, and supply a name for 
the file. Terminal uses the extension TRM if you don't specify one. 

We'll look at each of the Settings menu's many details now. 

Modem Commands 
We'll start with Modem Commands, because the settings you assign here 
should be appropriate for every settings file you create. The Modem Com­
mands dialog box, shown on the next page, tells Terminal what signals it 
should send to your modem to originate a call, prepare to receive a call, 
dial the telephone, and hang up. 

The dialog box is initially filled out with the settings required by a 
Hayes or Hayes-compatible modem. If your modem fits that description and 
your telephone system uses tone dialing, the default modem commands will 
be correct for all your settings files. 

If your telephone uses pulse (rotary) dialing, change the Dial Prefix 
setting from ATDT to ATDP. 
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Modem Commands 

Commands Ir-O~K~"""I 
Prefix: Suffix: 

IrCancer"'1 Qial: Iwm II 

l:!.angup: 1+++ IIATH 

BinarylX: I II 
M.odem Defaults 

@ Hayes 
Binary fiX: I II o MultiTech 
!,!riginate: IATQOV1 E1 SO=O o T r ailB lazer 

o None 

If you're using a MultiTech or TrailBlazer modem, click the appropriate 
option button under Modem Defaults. The settings in the rest of the dialog 
box will change appropriately. 

If your modem conforms to none of the three supported standards­
Hayes, MultiTech, or TrailBlazer-click None and consult your modem's 
documentation to fill out the rest of the dialog box. 

Terminal Preferences 
The Terminal Preferences dialog box, shown below, lets you specify about 
a dozen options, each of which has something to do with the way your 
system behaves while connected to another computer. 

Terminal Preferences 

Terminal Modes 

[g] (k~:ri~5ii~:~p') 
o Local.E,cho 

[g] ~ound 

[g] Show Scroll Bars 

CR -) CR/LF 

o Inbound 

o Outbound 

Cursor 

I r71)K?::~~\"1 
1~~1tnEel~~1 

@ Jl.lock 0 ll.nderline 

[g] Blink 

lranslations 

United Kingdom 
Denmark/Norwa 

o IBM to ANSI 

Buffer l.ines: 1100 I 

o Use Function. Arrow. and ~trl Keys for Windows 
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Terminal Modes 
The Terminal Modes section of the dialog box includes three check boxes: 
Line Wrap, Local Echo, and Sound. 

Select the Line Wrap option if the host computer sends lines that are 
too long for your computer to display. With this option set, a long line will 
be "wrapped" to the next line on your screen, as it would in a word 
processing program. 

If you're connected to a remote computer but the characters you type 
do not appear on your screen, select the Local Echo check box.· On the 
other hand, if every character you type appears twice on your screen, 
deselect this check box. 

If the Sound check box is selected, your system will beep if the remote 
system sends a "bell" character (Ctrl+G). Unless you object to the sound, 
it's probably best to . leave this option selected. 

Translate CR to CR/LF 
The CR~CR/LF options govern how line endings (carriage returns) are 
handled by your computer and the remote computer. If everything sent by 
the host computer appears on a single line on your screen, select the 
Inbound box. If the party you're communicating with complains that every­
thing on his or her system is displayed on one line, select the Outbound 
box. 

Obviously, if you're communicating with an information service, a 
bulletin board, an electronic mail service, or some other unattended system, 
there won't be anyone on the other end of the line to complain to you. But 
if you're not communicating successfully with the remote system, try select­
ing the Outbound box to see if that helps. 

80 or 132 Columns 
If your screen can display 132 characters on a line, and if the system you're 
communicating with sends more than 80 characters per line, select the 132 
button in the Columns section of the dialog box. Otherwise, accept the 
default setting of 80 columns. 
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Cursor Shape and Blink 
You can choose between two cursor shapes: block and underline. You can 
also decide whether or not you want the cursor to blink. You might want 
to experiment to see which cursor style you like best. 

Terminal Typeface and Size 
Terminal can display your communications session in any monospaced font 
installed on your system. Like the cursor choice, your decision about type­
face and size is strictly a matter of taste. The font you pick has no effect on 
what you send to the remote computer. 

For more information about fonts, see "Working with Fonts," page 40. 

Translations 
The Translations setting is used for communicating with a computer in 
another country. It allows the data you send to be formatted in the character 
set used by the host computer. Retain the default setting, None, if you're 
communicating within your own country. 

Buffer Size 
A buffer is an area of memory used to store something temporarily. While 
you're connected to another computer, everything you send and receive is 
stored in a buffer and displayed in Terminal's window. The buffer gives 
you a way to review what you send and receive, without capturing the 
"conversation" in a disk file or generating a printed transcript. As long as 
the buffer's capacity has not been exceeded, you can scroll up and down 
in the Terminal window to reread everything that has passed back and forth 
over the telephone line. (There is one exception: Binary files that you send 
or receive are not recorded in the buffer.) You can also select any text stored 
in the buffer and copy it to the Clipboard. To do so, use the Edit menu's 
Copy command, as you would in most other Windows applications. (For 
information about the Clipboard, see "Using the Clipboard with Applications 
for Windows," page 169.) 

When the buffer reaches its capacity, each new line replaces the oldest 
line already in the buffer. For example, if the buffer size is set at 100 lines, 
when the 101st line arrives, the first line is discarded. 
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You can set the buffer size at anywhere from 25 to 399 lines. If you 
have plenty of memory, reserve a full 399 lines; if memory is scarce, choose 
a smaller size. If you don't have enough memory for the buffer size you 
request, Terminal gives you as much as it can. 

Scroll Bars 

WINDOWS TIP: The buffer is convenient because it lets 
you reread material that has scrolled off your screen. But 
if you want a complete record of your communications 
session, consider sending a copy of it to your printer or 
recording it in a text file. For information about printing 
or recording to a text file, see "Creating a Transcript of 
Your Communications Session," page 463. 

Terminal normally displays scroll bars to help you read lines that have 
disappeared off the top of Terminal's window or that extend beyond the 
right edge. You can get rid of the scroll bars by deselecting the Show Scroll 
Bars check box. Doing so increases the size of Terminal's window slightly. 

Special Keys 
By default, Terminal is set so that codes generated by the function keys, 
Ctrl+key combinations, the direction keys, PgUp, PgDn, Home, and End are 
.not transmitted to the remote computer. You can change this setting by 
selecting the check box labeled Use Function, Arrow, and Ctrl Keys for 
Windows. You might find it convenient to select this check box, for example, 
if you frequently need to send a Ctrl+C to the service you're communicating 
with. 

Note that certain function keys and Ctrl+key combinations are proc­
essed by Windows (rather than being transmitted) regardless of the state of 
this check box. For example, whichever way the check box is set, the FI 
key still invokes the Help system, FlO gets you to the menu bar, Ctrl+Esc 
summons Task List, and keyboard shortcuts defined in Program Manager 
continue to perform as usual. 

l 
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Communications Parameters 
The settings in the Communications dialog box govern the way your data 
is sent over the telephone line. For communication to be successful, most 
of the settings in this dialog box must be identical to those of the system 
you're communicating with. 

Communications 

H.aud Rate 

0110 0300 0600 @(1:?:9.9.) 

o 2400 0 4BOO 0 9600 0 14.4K 
o 19.2K 0 3B.4K 0 57.6K 0115.2K 

~top Bits 

I r:'-u'K'"w:"":,,, 

IFcanc~E""1 

,Data Bits 
_050607@B @1 01.5 02 

f.arity [low Control konnector 

@ None @ XonlXoff rone 

~ o Odd o Hardware j~J~J \+ 
o Even o None 

o Mark 

o Space o Parity Chec~ o Carrier Detect 

Connector 
In the Connector list box, select the serial port to which your modem is 
attached. If you select None, Terminal uses the first available port, and 
begins its search with COMl. 

NOTE: For information about communicating directly with 
another computer using a nUll-modem cable, see 

. "Communicating Without Telephone Lines," page 472. 

Baud Rate 
Baud rate is the speed, in bits per second, at which information is transmitted 
and received. The speeds most commonly used are 14400 baud, 9600 baud, 
2400 baud, and 1200 baud. 
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Data Bits, Stop Bits, and Parity 
In a typical asynchronous communications link (the kind used by Terminal), 
each character transmitted consists of seven or eight bits of data, followed 
by one stop bit. The stop bit is used as a timing signal to tell the receiving 
computer where one character ends and another begins. Some older systems 
use fewer than seven data bits and more than one stop bit, but such systems 
are now rare. 

Systems that use seven (or fewer) data bits might also employ an 
error-checking method called parity. Different systems use different types 
of parity checking-hence the Odd, Even, Mark, and Space options in the 
Parity section of this dialog box. 

The most common arrangement of these parameters for use with 
mainframe computers and online information services is 7-E-l, which means 
seven data bits, even parity, and one stop bit. Public bulletin-board systems 
(BBS's) most commonly use 8-N-l, or eight data bits, no parity (None), and 
one stop bit. 

Parity Check 
The check box marked Parity Check tells Terminal what to do if you're using 
a parity setting other than None and a parity error is detected. If you select 
this box, Terminal displays a question mark in place of any incorrectly 
received character. Otherwise, Terminal displays whatever character it re­
ceives, even if it is incorrect. 

Flow Control 
When information sent by the remote computer fills Terminal's buffer to 
capacity, Terminal has to tell the remote system to pause momentarily before 
sending any more characters. Otherwise, incoming data will be lost. When 
Terminal is ready to receive again, it sends another signal to the remote 
computer. A similar pair of signals is used by the remote computer to control 
the flow of data being sent by Terminal. 

These "pause" and "resume" signals are known as handshaking. The 
particular method of handshaking is determined by the Flow Control setting. 
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Terminal's default choice, Xon/xoff, is the method most commonly 
used today. A few older systems still use hardware handshaking. If you're 
not sure which method is used by the system you're going to communicate 
with, try Xon/Xoff. 

If the remote system has no handshaking capability, choose None. 

WINDOWS TIP: If characters you transmit are being lost 
by the remote system, regardless of your Flow Control 
choice, you can try sending one character at a time or one 
line at a time. For more information, see "Options for 
Transferring Text," page 458. 

Carrier Detect 
If you select the Carrier Detect box, Terminal relies on a hardware signal 
from your modem to determine whether you've established a connection 
with the remote computer. This option is normally off; if you're having 
trouble connecting, try turning it on. 

Terminal Emulation 
The Terminal Emulation setting determines how your screen behaves when 
it receives "formatting" information (such as commands to position the 
cursor or to erase characters) from the system with which you're commu­
nicating. It also determines which characters are sent to the remote computer 
when you press function keys, direction keys, and so on. 

When you choose the Terminal Emulation command, you see the 
following dialog box. 

Terminal Emulation 

o lTV (Generic) 

@ ji~~::v.t.:I9.!LtA~~!.J] 
o DECVT-li2 

1~1J~~fJl 
l~rcl~~l 
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With the default setting, shown here, Terminal makes your keyboard 
and screen behave like a VT-IOO terminal from Digital Equipment Corpo­
ration (DEC). This is a popular standard, and many mainframe computers 
and online information services base their interaction with you on the 
assumption that you're either using or emulating this terminal. Therefore, 
it's best to try this setting first if you're not sure what's required. 

Alternatively, you can make your system emulate a DEC VT-52 terminal 
or a TTY ("dumb") terminal. A TTY terminal recognizes no formatting codes 
except Carriage Return, Line Feed, Tab, and Backspace. 

Assigning Strings of 
Characters to Function Keys 
Terminal's Function Keys command lets you create as many as 32 miniature 
macros to perform routine typing chores. The command is called Function 
Keys because each macro you create is executed with the combination of 
Ctr+Alt plus one of the first eight function keys (Fl through F8). You can 
also display the names of your macros at the bottom of the screen and 
execute them by clicking the mouse. 

When you choose the Settings menu's Function Keys command, you 
see the following dialog box. 

Key Name: 

Fl: 
:=:=====: 

Fl.: 
~=====: 

F1: 
~===~ 

F,!: 
:====~ 

F~: 
:====~ 

Fli: 
:====~ 

Fl: 
:=====~ 

FB: 

Function Keys 

Command: 

Key.Level 

@102 
0304 

o Keys Visible 
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In the boxes on the left, under the heading Key Name, you can assign 
a name for each key you want to use. In the boxes on the right, under the 
heading Command, enter the keystrokes you want the macro to type for 
you. You can enter up to 41 characters for each function key. 

If you need more than eight function-key assignments, you can switch 
to a different "level" by clicking one of the numbers in the Key Level box. 
With each new level, you get a fresh set of macro slots. 

If you select the KeY$ V isible check l?ox, Terminal displays the names 
of your function-key assignments-eight at a time-in the buttons below 
the horizontal scroll bar. You can also display the function-key assignments 
by choosing Show Function Keys from the Settings menu. Here's how your 
Terminal window might look, for example, if you assign some of the most 
common Mel Mail commands to function keys: 

File Edit Settings Ehone Iransfers Help 

The function-key assignments are shown starting with Fl in the upper 
left corner of the group of buttons ("dial and log on" in the illustration 
above). Below Fl is F2, to the right of Fl is F3, and so on. 

When you position the mouse pointer over one of these function-key 
buttons, it changes from an arrow to a hand, as shown in the illustration 
above. You can then execute the character sequence assigned to that func­
tion by clicking its button. You can switch between the four function-key 
levels by clicking the button marked Level, on the right side of the 
function-key display. 
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If you don't have a mouse, you can· execute function-key character 
sequences by holding down the etr! and AIt keys while pressing the desired 
function key. To use the keyboard to switch to a different function-key level, 
you can go back to the Function Keys dialog box and select a different Key 
Level. But there's a better way: You can assign a level-switch code to one 
of the function keys at each level, as described in the next section. 

Assigning Special Codes to Function Keys 
In addition to ordinary characters, you can assign control characters and a 
few commands to your function keys. Table 15-1 lists the available com­
mands and their effects. 

So, for example, to dial and log onto an information service, you can 
use a function-key assignment like this: 

I\$CI\MI\$D02nameI\MI\$D02passwordAM 

This sequence starts by dialing whatever number you entered in the 
Phone Number dialog box. When the remote computer answers, your com­
puter sends a Return character (sending etrl+M is equivalent to pressing the 
Enter key; the character sent is called Return). 

I\A through I\Z 

I\$C 

I\$H 

I\$B 

I\$Dnn 

I\$L1 through I\$L4 

TABLE 15-1. 

Sends Ctr! plus the associated letter. To send 
Ctr!+M, for example, enter I\M. 

Dials the telephone. This is a shortcut for the 
Phone menu's Dial command. It dials the 
number entered in the Phone Number dialog 
box. 

Hangs up the telephone. This is a shortcut for 
the Phone menu's Hangup command. 

Sends a Il7-millisecond break code. 

Pauses for nn seconds. Two digits are required; 
use a leading a for numbers less than 10. 

Switches function-key levels. To switch to level 
2, for example, use I\$L2. 

Special codes available for function-key assignments. 
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Your system then pauses for two seconds, allowing the remote com­
puter to respond to the Return character. After the two-second delay, your 
system sends your name, followed by another Return character. After an­
other two-second delay, your system sends your password followed by one 
more Return character. 

You might have to experiment with a sequence like this to get the 
timing right; the amount of delay needed depends on the responsiveness 
of the remote computer. Note, however, that you do not need to include a 
delay to allow your own system to dial or the remote system to answer. 
After reading the dialing code (I\$C), Terminal does not send the next 
characters in the sequence until connection with the remote computer is 
established. 

WINDOWS TIP: If you don't have a mouse and you're 
using all four function-key levels, you'll probably want to 
reserve one assignment at each level (F8, perhaps) as a 
level-switcher key. Assign I\$L2 to that key at levell, I\$L3 
at level 2, and so on. 

SuppreSSing the Function-I{ey Display 
If you're not using the function keys, or if you temporarily need to see as 
many lines of Terminal's buffer as possible, you can suppress the function­
key display by opening the Settings menu and choosing Hide Function Keys. 

Phone Number 
The Phone Number dialog box tells Terminal what number to dial. The 
dialog box looks like this: 

Phone Number 

Ilial: 

limeout If Not Connected In ~Seconds 

D Redial After Timing Out D ,S.ignal When Connected 
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You can enter the telephone number with parentheses and hyphens 
if you like. Terminal ignores these punctuation marks when it dials. You 
must include all the digits that need to be dialed, however. For example, if 
your number is in a different area code, be sure to include a I-or whatever 
other prefix your long-distance carrier requires. 

If you need to dial 9 or some other number to get an· outside line, 
include that as well. And if you want the modem to pause after requesting 
the outside line (to allow time for the outside dial tone to sound), include 
one or more commas in the dialing sequence. Each comma causes a delay 
of about two seconds. For example, to have your modem dial 9, wait four 
seconds, and then dial 555-0971, enter the following in the Phone Number 
dialog box: 

9,,555-0971 

The Phone Number dialog box provides three options in addition to 
the phone number. The Timeout If Not Connected In box tells Terminal 
how long to wait before giving up if no one answers the phone. The default 
value, 30 seconds, is also the minimum value Terminal will accept. If you 
check the Redial After Timing Out check box, Terminal tries again if no one 
answers the phone. The interval between retries is the same as the Timeout 
If Not Connected value. To interrupt the retry sequence at any time, click 
Cancel. A check in the Signal When Connected box tells Terminal to beep 
when someone answers the phone. It's a good idea to check this box. That 
way, if you switch to a different program while Terminal dials, the beep 
tells you when to switch back. 

Options for Transferring Text 
The standard Xon/Xoff flow control system usually ensures that all charac­
ters you send are received by the remote system. (For information about 
Xon/xoff, see "Flow Control," page 452.) If you find that the remote system 
is losing characters with standard flow control, you can break lines into 
shorter lengths, or you can elect to transfer one line at a time or one character 
at a time by choosing the Settings menu's Text Transfers command. The 
Text Transfers dialog box looks like the one shown on the next page. 



Text Transfers 

Flow Control------. 

@ ili~:~~:~~:~:~:ItQ:~::~Q:r.i~~Q:H 
o ,!;.haracter at a Time 

o line at a Time 

I r"]rK~""""'''1 
Ircancef'''I 

Transfer Using Standard Flow Control 
Selected Flow Control Method: XonlXoff 

o Word Wrap Outgoing Text at Column: ~ 

Brealdng lines with Word Wrap 
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The remote system might be losing characters because the lines you're 
sending are too long. You can have Terminal automatically "break" lines at 
a specified column position (on screen) by selecting the Word Wrap Out­
going Text at Column check box. The default word-wrap column is 79, 
because most screens display 80-character lines. To send shorter lines, enter 
a smaller number for the word-wrap column. 

Transferring a Line at a Time 
If the Word Wrap option doesn't solve your problem, try choosing Line at 
a Time. Transmission will be slower, but it might enable the remote system 
to process all your data. When you select Line at a Time, the dialog box 
changes to reveal two additional options, as shown below. 

Text Transfers 

Flow Control-------, 

o ~tandard Flow Control 

o ,!;.haracter at a Time 

@ i!Iri~:::~~::~:::~n~:~} 

Transfer a Line at a Time ---------, 

@ Delay .Iletween lines: DJ10Sec 

o Wait for f.rompt String: lAM 

o Word Wrap Outgoing Text at Column: ~ 
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You can specify a timed delay between lines (in increments of a tenth 
of a second), or you can tell Terminal to pause after each line until it receives 
a sp'ecific character or string of characters from the remote system. Jf you 
choose the Wait for Prompt String option, the dialog box displays AM (the 
Return character) as the default prompt string. That should work fine with 
systems that "echo" everything you send, as many systems do. If the remote 
system does not echo and a person is available on the other end of the line 
to interact with you, you can try a different prompt string, such as "OK." 

Transferring a Character at a Time 
To slow down your transmission even further (increasing the likelihood that 
every character you send will be received), try the Character at a Time 
option. As with Line at a Time, there are two ways for this mode of trans­
mission to proceed. 

Text Transfers 

Flow Control--------, 

o .s.tandard Flow Control 

@ l£h~~:~£~~~::~:~:::~::~n:~~l 
o 1.ine at a Time 

Transfer a Character at a Time -------, 
@ J2ela.v Between Characters: D/l0Sec 

o Wait for Character ,Echo 

o Word ~rap Outgoing Text at Column: ~ 

You can enter a timed delay between characters, in tenths of a second, 
or you can tell Terminal to wait for an echo (confirmation) of each character 
sent. 

For more information about transmitting text, see "Transmitting Data 
from the Clipboard or the Buffer," page 465, and "Sending and Receiving 
Files," page 465. 

Options for Transferring Binary Files 
Terminal offers two error-checking methods (protocols) for transferring 
binary f~les-XModem/CRC and Kermit. The default choice is 
XModem/CRC. If you regularly use Kermit when communicating with a 
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particular remote system, choose the Settings menu's Binary Transfers com­
mand, and then choose Kermit in the dialog box. Your preference for Kermit 
will then be recorded in your settings file. 

For more information about transferring binary files, see "Sending a 
Binary File," page 470, and "Receiving a Binary File," page 471. 

Saving and Retrieving Settings Files 
To save a settings file, use the File menu's Save or Save As command. These 
commands work exactly the same way in Terminal as they do in other 
Windows-based applications. Terminal uses the extension TRM unless you 
supply a different extension. 

Note that the contents of Terminal's window are not saved in your 
settings file. Only the selections you make in the Settings menu's dialog 
boxes are saved. 

To retrieve an existing settings file, use the File menu's Open com­
mand. To begin creating a new settings file (thereby removing the current 
one from memory), use the File menu's New command. 

Initiating a Telephone COlU 
To initiate a telephone call, load the settings file for the system you want to 
contact. Then open the Phone menu and choose Dial. 

If you don't have a settings file for the system you want to call, choose 
the Dial command and Terminal will prompt you for the number to dial. 

While Terminal is dialing, you see a display like this: 

Terminal 

• Dialing:853-1212 

.'~ '" Time Remaining: 30 

At the same time, the dialing command sent to your modem is dis­
played in Terminal's application window. 

When the remote system answers, the message box disappears and 
your system beeps (if you selected the Signal When Connected check box 
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in the Phone Number dialog box). Depending on your modem and the 
baud rate you're using, you might also see a message in Terminal's window 
indicating that a connection has been established. 

If a connection is not made with the remote system within the time 
specified in the Phone Number dialog box, Terminal hangs up. If the Redial 
After Timing Out option in the Phone Number dialog box has been selected, 
Terminal redials. You can stop this sequence at any time by clicking Cancel. 
For more information about the Phone Number dialog box, see "Phone 
Number," page 457 . 

. Answering a Call 
Initiated by the" Remote System 

When someone at another computer is going to initiate a data link with 
your computer, you can put your modem in auto-answer mode so that the 
modem will answer the phone when it rings and establish the connection. 

To put your modem in auto-answer mode, you must type your mo­
dem's auto-answer command in Terminal's window. To find out what to 
type, check your modem's documentation. 

For example, if you're using a Hayes or Hayes-compatible modem, 
you type 

ATSO=l 

This character sequence sends a command to the modem, telling it to 
pick up the phone on the first ring. To have the modem pick up on a 
different ring, substitute a different number for the 1 in the command. 

NOTE: Unlike most Windows NT commands, many modem 
commands are case-sensitive. You must type them exactly as 
they appear in your modem's documentation. 

If your modem is not in auto-answer mode but you are working in 
Terminal when someone dials your telephone number, the word RING 

might appear on your screen. You can have your modem answer the call 
in this case by typing ATA and pressing Enter if you are using a Hayes or 
Hayes-compatible modem. 
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WINDOWS TIP: If you often use auto-answer mode, you 
can assign the command string to a function key. For a 
Hayes or Hayes-compatible modem, use the command 
string A TSO=l"J"M. (The "J"M characters are added so 
you don't have to press Epter.) 

Hanging Up ~he Telephone 
When you're through communicating, use whatever command the host 
computer requires to log off. Then pull down the Phone menu and choose 
Hangup. 

Creating a TrOlnscrip~ 01 
Your CommlUnico]~ions Session 

You can create a transcript of some or all of your communications session 
in either of two ways. You can "echo" everything that's sent and received 
to your printer, or you can "capture" everything in a text file on disk. 

To create a printed transcript, open the Settings menu and choose 
Printer Echo. A check mark will appear beside the Printer Echo menu 
command, and Print Manager will appear on your desktop. 

To record your session in a text file, open the Transfers menu, choose 
Receive Text File, and fill out the dialog box. For more information about 
the Receive Text File options, see "Receiving a Text File," page 468. 

You can begin copying your session to the printer or a disk file at any 
time before or after you dial the telephone. And you can end the copy at 
any time, as well. To stop the printer echo, open the Settings menu and 
choose Printer Echo a second time. To stop capturing information in a text 
file, pull down the Transfers menu and choose Stop, or click the Stop button 
at the bottom of Terminal's window. 
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Timing a Communications Session 
If you made your function-key assignments visible at the bottom of Termi­
nal's window, in the lower right corner Terminal shows you either the 
current time of day or the number of minutes and seconds that have elapsed 
since the beginning of your most recent connection. The elapsed time can 
be particularly useful if you're connected to an information service that 
charges by the minute. 

If you have a mouse, you can switch between time of day and elapsed 
time by clicking on the time window. If you have don't have a mouse, 
choose Timer Mode from the Settings menu to switch the time display. 

If the function-key assignments and the time window are not visible, 
open the Settings menu and choose Show Function Keys. 

Inspecting and Selecting 
Text in Terminal's Buffer 

Terminal stores text that is sent or received in a buffer. The entire contents 
of the buffer, including the portion of it that scrolled off the screen, are 
available to look at and use. As soon as the buffer is full, however, Terminal 
begins deleting the earliest lines in the buffer to make room for new material. 

You can select text in the buffer the same way that you select text in 
other Windows-based applications-by dragging the mouse, or by position­
ing the insertion point and using the direction keys while holding down the 
Shift key. 

In Terminal, selected text can be copied, but not cut, to the Clipboard. 
From there, you can paste the selection into a word processor, a spread­
sheet, or other application. 

A text selection cannot be deleted from the buffer. If you select a block 
and press the Del key, Terminal merely deselects the block. You can empty 
the entire buffer at once, however, by choosing the Edit menu's Clear Buffer 
command. You might want to do this after finishing one communications 
session and before beginning another-provided you no longer need the 
material in the buffer. 
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Transmitting Dcta from 
the Clipboard or the Buffer 

Any text stored in the Windows Clipboard can be transmitted to a remote 
computer. Simply use the Edit menu's Paste command after establishing a 
connection with your party. The Clipboard's text appears in Terminal's 
window exactly as if you were typing it. 

You can also transmit material stored in the buffer. Simply select it, 
and then choose the Edit menu's Send command. You might want to use 
this technique if you get a message from one party that you want to forward 
to another. 

Sending and Receiving Files 
Commands on Terminal's Transfers menu allow you to send and receive 
two kinds of files: text files and binary files. 

A text file is a file containing nothing but letters, numbers, punctuation 
symbols, and "control codes." (Control codes include functions such as 
carriage returns, line feeds, tabs, form feeds, and escape codes.) Examples 
of text files include the following: 

c Any document created in Notepad or in a plain-text editor 

c Any document created in a word processor and saved with a "text 
file," "text only," or "unformatted" option 

c Any report formatted for the printer but redirected to a disk file (a 
Lotus PRN file, for example) 

I:J A database file saved in a "comma-delimited," "comma-and-quote­
delimited," or "fixed-length-record" format 

EI An MS-DOS batch file (a file with the extension BAD 

A binary file is any file that's not a text file. Examples include the 
following: 

Il An executable program file (one with the extension COM, EXE, or 
PIF) 

Il A program "overlay" file (such files often have the extension OVL) 
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D A "dynamic link library" file (one with the extension DLL) 

D A formatted word processing document, such as the kind Write 
saves if you don't use the "text only" option 

El Any file containing graphics information 

El Any file saved with a file-compression utility (one with the exten­
sion ZIP or ARC) 

Text files are typically transmitted without any special error-checking 
protocol (other than parity, if you selected a parity-checking option in the 
Communications dialog box). This is not because errors are less likely to 
occur, but because they're more easily detected. Usually, you can tell by 
the context whether a character has been transmitted incorrectly. 

WINDOWS TIP: If you're not sure whether a file is a text 
file, try loading it into Notepad. If you can read all of it in 
Notepad, it's a text file. 

Binary files, on the other hand, are almost always sent and received 
with the help of some kind of error-checking routine because a transmission 
mistake in a binary file can be difficult to find and can have very serious 
consequences. For example, even a slight corruption in a program file can 
render it worthless. Terminal lets you choose between two protocols: 
XModem/CRC and Kermit. 

Although it is not necessary, you can use one of Terminal's error­
checking protocols when sending or receiving a text file. To do so, follow 
the procedures for working with a binary file. You might want to do this if 
you're using a "noisy" telephone line, for example. 

Similarly, you can send or receive binary files without error checking 
by treating them as text files. This is not a good idea, however! 

Sending a Text File 
To send a text file, open the Transfers menu and choose Send Text File. 
You'll see a dialog box like the one shown on the next page. 
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Send Text File 

File Harne: Q.ireetories: I r~~'":Q#tfK"~~":"rr'w'l 
ID e: \users\def ault 

IF":~CanceF"71 ~ (27e:\ ~ 
(27 users 
~ default 

I rr'~lietwoik~~w~;~J 

~ ~ Following CR: 

list Files of IYpe: Driyes: 
o APpend LF 

[g] litrip LF I Text files("'. TXT) It!] I rae: I!!J 

Specify the file you want to send, choose either of the options under 
Following CR, if appropriate, and click OK. 

The Following CR options tell Terminal how to handle line endings in 
your file. If the remote system receives your file with extra space after each 
line (double spaced, for example, when your file is single spaced), select 
the Strip LF check box. (Strip LF is selected by default.) If everything arrives 
at the remote computer on a single line (or is Single spaced when your file 
is double spaced), select the Append LF check box. 

While your document is being sent, you'll see a display at the bottom 
of Terminal's window, like this: 

On the left side of this display is a Stop button. Click this if you don't 
want to send any more of the file. Next to the Stop button is a Pause button. 
You can interrupt the transmission of your text file by clicking this button. 
When you click Pause, the button changes to Resume. If you don't have a 
mouse, use the Pa1,lse, Resume, and Stop commands on the Transfers menu 
to control your transfer. 

The document bar, to the right of the Pause/Resume button, indicates 
how much of your file you've sent and how much remains. In the preceding 
illustration, for example, you can see that about 20 percent of the file has 
been transmitted. 
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The last element in this display shows the name of the file that Terminal 
is sending. 

When all of your text file has been sent, Terminal removes the buttons, 
document bar, and filename from the screen. 

Viewing a Text File 
Terminal includes a command that lets you inspect a file before you send 
it (or after you receive it). To inspect a file, open the Transfers menu, choose 
V iew Text File, and fill out the dialog box. Terminal scrolls your file into 
the buffer as if it were transmitting it, but nothing is sent. 

Receiving a Text File 
Choosing Receive Text File puts Terminal in a "capture" mode, in which all 
characters passing through the buffer-those you send as well as those you 
receive-are copied to the specified file on your disk. Thus, you can use 
this command to receive text documents sent by a remote computer, and 
to transcribe all or part of a communications session. 

To receive a text file, choose Receive Text File from the Transfers menu. 
You'll see the following dialog box. 

File H,ame: 

Receive Text File 

J!irectories: 
c:\users\default 

12:7 c:\ 
12:7 users 
e default 

j:l 0 APpend File 
~-------------- o Save I;,ontrols 

list Files of !ype: Driyes: 0 
II-T_e_xt_fi_le_sl:-"._TX_T_1 __ ..... I!I_! 1-1 raJ __ c_: __________ ...... li!I_V'f lable Format 

Specify the name of the file you want to receive, check any appropriate 
options, and click OK. You can choose all, some, or none of the following 
options: Append File, Save Controls, and Table Format. 
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Append File 
Choose Append File if you want the incoming file to be added to an existing 
file on disk. If you do not select this box and you specify the name of a file 
that already exists, you'll see the following warning message. 

Terminal - Error 

ill Replace existing file? 

If you click Yes, your new file will replace the existing file. 

Save Controls 
The Save Controls option, when selected, allows the receipt of control 
codes. Some applications include control codes for text formatting-even 
when you save a file as "text only." If you do not select Save Controls, 
control codes other than Carriage Return and Line Feed are "stripped" from 
the file as it is received. When you're receiving files that truly contain only 
text, the setting of this option has no effect. 

Table Format 
If you select the Table Format option, Terminal replaces blocks of two or 
more spaces in the incoming file with tab characters. This option might 
enable you to create a neatly structured table from mainframe data in which 
numbers are separated by spaces instead of tabs. 

While Terminal is receiving or capturing text to a disk file, you see a 
display at the bottom of the screen like this: 

The Stop and Pause buttons allow you to terminate or interrupt the 
operation. When you select Pause, the button changes to Resume. If you 
don't have a mouse, you can use the Pause, Resume, and Stop commands 
on the Transfers menu to control the operation. 
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Use Stop when you have captured all the text you want. Otherwise, 
Terminal remains in capture mode until you quit Terminal. 

Choosing a Protocol for Binary File Transfers 
Terminal offers two error-detecting protocols for the transmission of binary 
files: XModem/CRC and Kermit. Select the protocol you want in the Binary 
Transfers dialog box (on the Settings menu). 

XModem/CRC is a faster protocol than Kermit, so you should select it 
if the system with which you're communicating supports it. Select Kermit if 
the remote system supports Kermit but not XModem/CRC. 

Sending a Binary File 
To send a binary file, open the Transfers menu, choose Send Binary File, 
and supply the name of your file in the Send Binary File dialog box. There 
are no other options. 

Before file transmission can begin, the party with whom you're com­
municating must prepare his or her system to receive your file-using the 
same protocol that you are using. If you issue the Send Binary File command 
before the remote computer is ready, Terminal waits for a ready signal from 
the remote computer. 

While the file transfer is in progress, you will not see any data move 
through the buffer, but you can track the progress of the transmission by 
looking at the display at the bottom of your window. 

You can stop the transfer by clicking the Stop button (or choosing its 
equivalent on the Transfers menu), but you cannot pause a binary-file 
transfer. 

Next to the Stop button, Terminal displays a document bar to show 
the progress of your file transfer. To the right of the document bar, you'll 
find the name of the file you're sending. 

If any transmission errors are detected during the transfer, the block 
of data in which the error occurred is resent. The Retries number, to the 
right of your filename at the bottom of Terminal's window, indicates the 
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number of times Terminal has resent a block of data. If Terminal is unable 
to send or receive a block of data correctly after six consecutive retries, it 
notifies you that the file transfer has been aborted. Try again on a different 
telephone line or at a different time of day. 

When the entire file has been sent, the buttons, document bar, file­
name, and retry counter disappear from your screen. 

Receiving a Binary File 
To receive a binary file, open the Transfers menu, choose Receive Binary 
File, and supply a name for the incoming file. There are no other options. 

While the file is being received, you will not see any data moving 
through the buffer. You can track the progress of the file transmission by 
watching the byte counter in the display that appears at the bottom of your 
window. 

II-----------------Te-r-m-in-al---Cl-S-~-RM-------------------II~ 
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This display looks and functions exactly like the one for a binary send, 
except that Terminal reports the number of bytes received instead of show­
ing you a document bar. If you know the file's total size in bytes, you can 
use the counter to estimate how long the transmission will take. 
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Communicating 
Without lelephone Lines 

You can use Terminal to transfer data directly from one computer to another 
without a modem. Here's how: 

1. Connect the serial ports of the two computers with a null-modem 
cable. 

2. Choose Communications from the Settings menu. 

3. In the Communications dialog box, choose the Connector your null­
modem cable is attached to and set the baud rate to 19200. 

4. Be sure that all the options are the same on both computers. 

5. Because your computers are directly connected, you won't need the 
Dial command. Use the rest of Terminal's commands and functions 
as if you were communicating over telephone lines. 

6. If necessary, change the Local Echo or CR--7CR/LF options in the 
Terminal Preferences dialog box so that you can see what you are 
typing. 
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Paintbrush and OLE 
You can embed Paintbrush images in other applications that support 
object linking and embedding. 

Starting Paintbrush 
Paintbrush presents a blank canvas, a toolbox, and other features. 

Other Cursor Shapes 
The cursor's shape depends on the particular drawing or editing tool 
you're using. 

The Size of the Picture 
Your canvas can be as large as your desktop or as small as a postage 
stamp. 

Seeing the Larger Picture 
Double-click the Pick tool for a full-screen view of your work. Or use 
the View Picture command or the Zoom Out command. 

Navigating on a Large Canvas 
A set of keystroke commands can help you get around. 

Precise Cursor Positioning 
When you need to be exact, choose the Cursor Position command. 
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Working with the Mouse and Keyboard 
Sometimes the keyboard is more convenient. 

Setting Up for a New Picture 
Choose your canvas size and background color or pattern before using 
the New command. 

Drawing Basics 
Each tool in the toolbox is specialized for a particular kind of drawing. 

Quick Fixes: Backspace and the Undo Command 
Use Backspace for touchup and Undo for surgery. 

Exploring the Toolbox 
The toolbox contains 18 handy tools for drawing and editing images. 

Working with Cutouts 
Cutouts let you flip, skew, shrink, grow, tilt, sweep, and copy. 

Fine-Tuning Your Image with Zoom In 
Zooming in lets you edit inividual pixels. 

Working with Custom Color/Pattern Palettes 
You can mix the paint yourself. 

Saving and Opening Paintbrush Files 
Paintbrush lets you save and retrieve files in any of five file formats. 

Printing a Paintbrush Image 
Adjust the margins, size, and output quality before you print. 
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aintbrush is a program that lets you create and edit graphics 
images. You can use it to produce anything from simple text 

banners and line diagrams to complex works of art. You can start with a 
blank canvas, or you can modify a scanned image or an image imported 
from another Windows-based program, such as a chart from Microsoft Excel. 
Any graphics information that can be copied to the Clipboard as a bit map 
can be pasted into Paintbrush. 

Paintbrush replaces Paint, the drawing program that was included in 
versions of Windows before 3.0. If you used Paint, you will appreciate the 
following improvements in Paintbrush: 

[] Images created in Paintbrush can be in color or in black and white. 

t1 Paintbrush offers a more extensive set of drawing tools and editing 
commands than Paint. 

[] In addition to its default file format (BMP), Paintbrush reads and 
writes PCX files-a format that can be generated by many scanning 
programs and incorporated into a number of MS-DOS-based word 
processing programs (such as Microsoft Word and WordPerfect). 

Images saved in Paint's file format (MSP) can be read into Paintbrush, 
but you can't save a Paintbrush image as a Paint file. 

POl~rlibrush olnd OLE 
The Windows NT version of Paintbrush supports object linking and embed­
ding (OLE) as a server application. That means that pictures created or edited 
in Paintbrush can be embedded in documents created by OLE client appli­
cations, such as Write and Cardfile. For information about using embedded 
objects with OLE client applications, see "Linking and Embedding in Write," 
page 430, and "Linking and Embedding," page 554. 

S~a~iing Paintbrush 
To get Paintbrush running, double-click its program-item icon. (It's in the 
Accessories program group, if you haven't moved it.) If you're using File 
Manager as your shell, double-click PBRUSH.EXE in your Windows direc­
tory. 
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Paintbrush's opening screen looks like this: 

Drawing 
and 

editing 
tools 

", I 

File fdit ~iew Iext Pick .Qptions Help 

*~ 
r'abc 

Drawing area 

1l 

:::I~I;~' ~~~~~~~~~~~~~~~~~~~~~~ -- ~oregrOUnd color 
Background color 

Line-size box 
Cursor 

NOTE: This illustration, like all others in this chapter, is a black­
and-white representation of a color VGA screen. On a color 
display you will see a palette of colors along the bottom of the 
window instead of the shades of gray shown here. 

The blank area that makes up most of Paintbrush's window is the 
drawing area. The icons to the left of the drawing area are drawing and 
editing'tools, which you use to draw and edit images in the drawing area. 

Like an artist's palette, the color/pattern palette at the bottom of the 
window displays the available colors that you can apply to your canvas. 

Immediately to the left of the color/pattern palette, Paintbrush displays 
the current foreground and background color selections. In the illustration 
above, Paintbrush's foreground color is black, and its background color is 
white. 
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In the lower left corner of Paintbrush's window is the line-size box. 
The setting in the line-size box determines the thickness of the lines that 
Paintbrush draws. 

The dot in the lower right corner of the drawing area is the cursor. 
Like the insertion point in a word processing program, the cursor indicates 
where your next drawing action will take place. 

Other Cursor Shapes 
The cursor's s~ape depends on the 'drawing or editing tool you're using. 
Paintbrush's default tool is the brush, and the cursor shape corresponding 
to that tool is the dot shown in the preceding illustration (you can make the 
dot appear bigger by choosing a broader brush). At other times during your 
work in Paintbrush, you will see the following cursor shapes: 

When you work with text in Paintbrush, the cursor is replaced by an 
insertion point and an I-beam exactly like the ones in Write and Notepad. 

The Size of the Picture 
The actual size of your picture may be larger or smaller than what you see 
in Paintbrush's drawing-area window. When you first start Paintbrush, the 
program determines an optimum picture size, based on the type of display 
you're using and the amount of memory your computer has. But you can 
choose a larger or smaller canvas if you want. 

The size of a picture is determined when you first begin to create the 
picture. You can't make a picture larger or smaller after you've begun. (You 
can enlarge or reduce selected sections of a picture, however.) 

The illustration on the next page shows a picture that is much smaller 
than Paintbrush's drawing-area window. 
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And here's a picture that's considerably larger: 

478 
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Seeing the Larger Picture 

Paintbrush offers three ways to see more of a large picture. You can: 

c Use the View Picture command. 

c Remove the tools, line-size box, and palette. 

c Use the Zoom Out command. 

The View Picture Command 
The View menu's View Picture command temporarily removes Paintbrush's 
toolbox, line-size box, palette, and scroll bars, leaving the maximum pos­
sible space for your picture. After you use this command, your very next 
keystroke or mouse click returns the display to its previous state, so you 
can't do any work with your picture in this mode. It's a useful command, 
though, when you want to see parts of your picture that lie just off-screen. 

/~ 
<>'·~U 

1 

MOUSE TIP: As a mouse shortcut for the View Picture 
command, double-click the Pick tool-the scissors with 
the rectangle in the upper right corner of the toolbox. 

I<EYBOAR D TIP: As a keyboard shortcut for the View 
Picture command, press etrl + P. Then press any key to 
return to the normal display. 

Removing the Toolbox, 
Line-Size Box, and Palette 
To work with the largest possible area of your picture, use the View menu's 
Tools and Line Size command and Palette coriunand. Choosing Tools and 
Line Size extends the drawing-area window to the left edge of Paintbrush's 
application window. Choosing Palette extends the drawing-area window to 
the bottom of the application window. 

'I 
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Both commands are toggles. Choose Palette once, for example, to 
make the palette go away. Choose it again when you want to reuse the 
palette. 

Zooming Out to Get the Whole Picture 
To see an entire large picture, use the View menu's Zoom Out command. 
Here's how the doll maker in the previous illustration looks after using the 
Zoom Out command: 

When you zoom out, Paintbrush reduces your picture so that every­
thing fits in the window-no matter how large the picture. 

In addition to letting you see your entire picture, the Zoom Out com­
mand serves another valuable purpose: It allows you to select a larger area 
of your picture than would normally fit on the screen. For example, if you 
want to copy all of the doll maker from head to toe, you can zoom out, use 
the Pick tool to select the entire image, and then copy it to the Clipboard. 

To return to Paintbrush's normal view after using the Zoom Out com­
mand, pull down the View menu again and choose Zoom In. 
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KEYBOARD TIP: Ctrl+N and Ctrl+O are keyboard short­
cuts for Zoom In and Zoom Out, respectively. After you've 
zoomed out, Ctrl+N restores the normal display. A second 
Ctr1+N takes you to a closeup view. Similarly, after you've 
zoomed in, you can press Ctr1+0 once to restore the 
normal view and a second time for the panoramic view. 

, 

WINDOWS TIP: When you paste an image into Paint­
brush, only the data that fits in the current drawing area 
is accepted. Anything that doesn't fit within that space is 
"clipped" from the pasted image. To paste an image larger 
than the size of your screen, therefore, do the following: 

1. Choose the Image Attributes command from the Op­
tions menu to specify a canvas size large enough to 
accommodate the image you're about to paste. 

2. Choose the View menu's Zoom Out command. 

3. Paste the image. 

4. Click anywhere outside the image area. 

5. Choose the Zoom In command. 

Navigating on a Large Canvas 
Paintbrush displays scroll bars whenever the picture is too big to fit in the 
drawing area. If you have a mouse, you can click the scroll bars to move 
the cursor to a different part of a large picture. For example, in the doll­
maker graphic shown on page 478, a couple of clicks on the vertical scroll 
bar bring the doll maker's skirt and shoes into view, as shown on the next 
page. 
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If you don't have a mouse, you can scroll the window with the key­
strokes listed in Table 16-1. 

Shift+ Right 

Shift+Left 

Shift+Down 

Shift+Up 

Shift+PgDn 

Shift+PgUp 

PgDn 

PgUp 

Home 

End 

Shift+Home 

Shift+End 

TABLE 16-1. 

Moves right one space 

Moves left one space 

Moves down one line 

Moves up one line 

Moves right one screen 

Moves left one screen 

Moves down one screen 

Moves up one screen 

Moves to the top of the picture 

Moves to the bottom of the picture 

Moves to the left edge of the picture 

Moves to the right edge of the picture 

Navigation keystrokes in Paintbrush. 
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Precise Cursor Positioning 
For certain kinds of work in Paintbrush, it's helpful to know precisely where 
the cursor is. For example, to draw two vertical lines of exactly the same 
length, you might find it convenient to know the distance from the beginning 
and end of the first line to the picture's edges. The View menu's Cursor 
Position command can provide the information you need. 

When you choose Cursor Position, Paintbrush displays the x and y 
(horizontal and vertical) coordinates of the current cursor position in a small 
window near the upper right corner of the Paintbrush window. 

In the following illustration, the center of the cross-hair cursor has x 
and y coordinates of 312 and 280, respectively. One tip of .the cursor rests 
on the southern end of Baldwin Avenue. To add another street parallel to 
Baldwin extending the same distance south, you can maintain a y coordinate 
of 280 while moving the cursor the appropriate distance east or west of 
Baldwin. Then draw another straight vertical line at that new position. 

210 

Los Angeles 

Baldwin Ave. 

+ 

-
The cursor position is reported by Paintbrush as an offset in pixels 

from the upper left corner of the picture. (A pixel is the smallest dot your 
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screen can display and the smallest increment by which you can move the 
cursor.) So, for example, the coqrdinate pair 312,280 represents a point 312 
pixels to the right of and 280 pixels below the upper left corner of the 
picture. The 0,0 point is always the upper left corner of the picture, not the 
upper left corner of the drawing-area window. 

As long as the Cursor Position display is on, Paintbrush updates your 
cursor coordinates as you move the cursor. If you get tired of looking at 
these constantly changing numbers, you can remove the display by pulling 
down the View menu and choosing Cursor Position again. Or you can 
double-click the Control-menu box in the corner of the cursor-position 
window. 

Wor~{ing wiih the 
Mouse and Keyboard 

You can do almost anything in Paintbrush with either the mouse or the 
keyboard. Generally, the mouse is easier to use, but for certain actions­
such as positioning the cursor prior to drawing a line-you might want to 
use the keyboard. It's difficult to move the cursor a mere pixel or two with 
the mouse; on the other hand, it's tedious to draw a line halfway across the 
canvas by leaning on a direction key. 

Paintbrush uses both left and right mouse buttons for commands. (If 
you use a three-button mouse, the middle button is inactive.) For example, 
to change the foreground color, you click on the palette using the left mouse 
button. To change the background color, you click with the right button. 

/:,~ ~OU 
1 

MOUSE TIP: If you have used Control Panel to reverse 
the behavior of your mouse buttons, the term left button 
in this chapter always means right button to you-and vice 
versa. 



Chapter 16: Using Paintbrush 

Many drawing and editing procedures in Paintbrush involve clicking 
or dragging the mouse in the drawing area. If you don't have a mouse, you 
can carry out these same procedures using the keyboard equivalent shown 
in Table 16-2. 

Click left button Press Ins 

Click right button Press Del 

Double-click left button Press F9+Ins 

Double-click right button Press F9+ Del 

Drag, holding left button Hold down Ins and use direction keys 

Drag, holding right button Hold down Del and use direction keys 

TABLE 16-2. 

Keyboard equivalents for mouse actions. 

If you are working without a mouse, you can use the Tab key to move 
from the drawing area to the toolbox. Press Tab again to move to the 
line-size box, and press a third time to get to the color/pattern palette. 

Seiting Up for a New Picture 
Before beginning a new picture, you have to prepare your canvas. In 
particular, you need to decide the following: 

[J The background color or pattern that will be used for your entire 
picture 

[J The size and shape of the picture 

[J Whether you want to work in color or in black and white 

After you apply the first brush stroke to a new picture, you can't change 
any of these items. 

NOTE: If your system uses a monochrome display, you can't 
. create color pictures. You can load a color picture into 

Paintbrush, but Paintbrush changes it to black and white. 
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Choosing a Bacl<ground Color or Pattern 
Paintbrush always uses one color (or one black-and-white pattern) as a 
default background. You might think of this as the color of the canvas before 
you start to paint. You can change the background color in any part of the 
picture, but after you start a picture, you can't change the canvas ,as a whole. 

To select a background color or pattern, put the cursor on the color 
or pattern of your choice in the color/pattern palette and click the right 
mouse button. 

Establishing the Size and Shape of Your Picture 
To specify the size and shape of your picture, choose Image Attributes from 
the Options menu. You'll see a dialog box like the one shown in the 
following illustration. 

Image Attributes 

Width: 10 

H.eight: ,-15_.°_--, 

CQ.lors 

o B lack and White 

@ Colors 

1l.nits 
@ in 

Ocm 

o pels 

Specify the width and height you want for your picture, in whatever 
units you find most convenient to work with. You can select inches, centi­
meters, or pixels (abbreviated as pels in the dialog box). 

To use the picture dimensions that Paintbrush considers optimum for 
your display and the amount of memory in your system, click Default. 
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Choosing Color or Black and White 
The Options menu's Image Attributes command allows you to choose 
whether your image will be in color or in black and white. (If you're working 
at a monochrome display, the Colors option is grayed out.) 

When making this choice, it's a good idea to consider the medium in 
which you're most likely to output your new image. Color is more interesting 
to work with than black and white, but if you're going to send your image 
to a black-and-white printer, you'll get better control of the final product 
by working in black and white. 

NOTE: If the last picture you created was in color and you want 
your next one to be in black and white, proceed as follows: First 
select Black and White in the Image Attributes dialog box. 
Choose a black-and-white background pattern, as described 
on the previous page, and then choose New on the File menu. 
Paintbrush performs a similar reduction if you open a 256-color 
bit map on a system that uses a 16-color display driver. The 256 
colors of the original file are displayed in the nearest available 16 
colors, and if you save the file to disk, Paintbrush saves it as a 
16-color file. 

~ ',;:'c'l.) 

~ 

MOUSE TIP: As a shortcut for the New command, you 
can double-click the Eraser tool, which is the third tool 
down on the right side of the toolbox-directly under the 
tool marked abc. 

Installing Your New Canvas 
After you make your dimension and color choices, click OK in the Image 
Attributes dialog box. Paintbrush then presents a new, blank canvas with 
the attributes you selected. (If you have an unsaved picture when you click 
OK, Paintbrush gives you a chance to save it before proceeding.) 
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Drawing Basics 
After you set up your canvas as described in the previous section, you're 
ready to start drawing. In general terms, the process of putting an object on 

. the canvas goes as follows: 

1. Select a drawing tool. 

Each drawing tool is specialized for a particular kind of object. 
To draw straight lines, for example, select the Line tool; to create a 
box, select one of the box tools-and so on. For information about 
the properties of the various tools, see "Exploring the Toolbox," 
page 491. 

To select a tool, click it. 

2. Select a line width from the line-size box. 

You can draw with lines from one to nine pixels wide. Simply 
click the width you want to use. 

3. Select a foreground color or pattern. 

To select a foreground color or pattern, use the mouse to point 
to the appropriate box in the color/pattern palette, and then click 
the left mouse button. 

If you don't find the color or pattern you want on the palette, 
you can create it with the Edit Colors command. For information 
about this command, see "Working with Custom Color/Pattern 
Palettes," page 516. 

4. Select a background color or pattern. 

Some tools use the background color as well as the foreground 
color. Others use the foreground color only. You only need to con­
cern yourself with this step if the tool you're about to apply makes 
use of the background color. 

To select a background color, use the mouse to point to the 
appropriate box in the palette, and then click the right mouse 
button. 

5. Draw. 
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While you are drawing, before the new object is "pasted down," 
you can touch it up by pressing Backspace or remove it altogether 
with the Edit menu's Undo command. For more information, see 
"Quick Fixes: Backspace and the Undo command," below. 

6. When you're satisfied with the new object, paste it down to make 
it a permanent part of your picture, as described below. 

An object that has been pasted down can still be erased or edited, 
but it can't be removed in one fell swoop with the Undo command 
or touched up with Backspace. 

Pasting Down an Object 
To paste down an object, do any of the following: 

c Select another tool (or reselect the same one). 

D Use any command on the View menu except Cursor Position. 

c Scroll the picture. 

D Change the size of the Paintbrush application window. 

c Change the position of the Paintbrush application window. 

c Switch to a different application. 

As soon as you take any of these actions, the Undo command appears 
grayed out on the Edit menu. 

Quicl< fixes: Backspace 
and the Undo Command 

Immediately after you draw a new line, circle, rectangle, or other object, 
Paintbrush gives you two easy ways to make adjustments to it. These quick­
fix options-the Backspace key and the Undo command-become unavail­
able as soon as you paste down your new object. 

Touching Up with the Bacl{space Key 
When you press Backspace after drawing a new object, the cursor turns 
into a square with an X inside. This new cursor is a special-purpose eraser 
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that can rub out any part of your new object but has no effect on objects 
already pasted down. You'll find the Backspace eraser handy for such tasks 
as shortening lines that went farther than you intended. 

To touch up an object before you paste it down, press Backspace. 
Then drag the eraser over any part of the new object that you want to 
remove. 

WINDOWS TIP: You can change the width of the Back­
space eraser by selecting a different line width in the line­
size box. For very careful erasing, select the narrowest 
width. 

Note that the Backspace key works differently when you're using the 
Text tool-the one marked abc. With that tool, Backspace erases the char­
acter to the left of the insertion point-exactly as it does in most word 
processing programs. 

WINDOWS TIP: Be sure to paste down any object that 
you're satisfied with. That way, you won't inadvertently 
remove good work the next time you use Undo or the 
Backspace key. Remember, you can always use Paint­
brush's other editing procedures to alter your pasted-down 
objects later. 

Another good way to protect yourself against accidental 
erasures is to save your picture on disk at regular intervals. 
For information about Paintbrush's Save command, see 
"Saving and Opening Paintbrush Files," page 518. 

Radical Surgery with the Undo Command 
~he Edit menu's Undo command wipes out everything you've added to 
your canvas since the last time you pasted down an object. Because some 
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of Paintbrush's drawing tools may not always give you exactly what you 
have in mind the very first time you use them, you're likely to find the Undo 
command invaluable. 

Exp~oring the 1foolbo}{ 
Paintbrush's toolbox includes the following 18 tools: 

~ 
[j] 

~ 
o 
[Q] 

~ 
[Q] 

The Scissors tool selects an irregularly shaped cutout. (A cutout 
is a selection that can be cut, copied, moved, and manipulated 
in a number of ways. For more information about cutouts, see 
"Working with Cutouts," page 504.) 

The Pick tool selects a rectangular cutout. 

The Airbrush creates "spray-paint" effects. 

The Text tool adds letters, numbers, and words in various 
typefaces, sizes, and styles. 

The Color Eraser changes an object's foreground color. 

The Eraser removes objects from a picture. 

The PaiI~.t Roller fills enclosed shapes with the foreground color. 

The Brush creates freehand shapes. 

The Curve tool draws smooth curves. 

The Line tool draws straight lines. 

The Box tool creates unfilled rectangles. 

The Filled Box tool creates rectangles filled with the 
foreground color. 

The Rounded Box tool creates unfilled rectangles with rounded 
corners. 
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The Filled Rounded Box tool creates rectangles with rounded 
comers filled with the foreground color. 

The Circle/Ellipse tool creates unfilled ellipses or circles. 

The Filled Circle/Ellipse tool creates circles and ellipses filled 
with the foreground color. 

The Polygon tool creates irregular closed shapes. 

The Filled Polygon tool creates irregular closed shapes filled 
with the foreground color. 

Think of the Scissors, the Pick, the Color Eraser, and the Eraser as edit­
ing tools, and the rest as drawing tools. We'll look at the drawing tools first; 
then we'll take up the editing tools. 

Using Paintbrush's Drawing Tools 
Paintbrush provides 14 drawing tools that let you create freehand images, 
lines, curves, and predefined shapes. 

Drawing with Spray Paint: The Airbrush Tool 
The Airbrush tool deposits a circular pattern of dots in the foreground color. 
To get a wide dot pattern, select a wide line in the line-size box; for a narrow 
pattern, select a narrow line. 

To draw with the Airbrush, hold down the left mouse button and drag 
the mouse. The speed with which you move the mouse affects the density 
of the line; the more slowly you move, the denser the line you get. 

Freehand Drawing: The Brush Tool 
The Brush tool works somewhat like a normal paintbrush. To use the Brush, 
hold down the left mouse button and drag the mouse across the canvas. 
Paintbrush deposits the foreground color along the path of the Brush. 

You can modify both the width and the shape of the Brush to get 
different kinds of brush strokes. To change the width, select one of the lines 
in the line-size box. To change the shape, open the Options menu and 
choose Brush Shapes. You'll see the following dialog box. 
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Brush Shapes 

The default brush shape is the one on the left in the illustration. It 
produces strokes of even width in all directions. (The big square around 
the little square is not part of the brush shape; it merely indicates that the 
shape is currently selected.) If you're adept at calligraphy, try one of the 
diagonal shapes with a broad brush width; that combination will give you 
narrow strokes in the direction parallel to the Brush's own shape and broad 
strokes in the perpendicular direction. 

MOUSE TIP: As a shortcut for the Brush Shapes com­
mand, double-click the Brush tool icon (the fourth icon 
down on the right side of the toolbox). 

To draw with the Brush, hold down the left mouse button and drag. 

The Brush is primarily for freehand drawing. If you want straight lines, 
it's best to use the Line tool instead (unless you want to take advantage of 
one of the non-square brush shapes) .. 

You can, however, draw perfectly straight horizontal and vertical lines 
with the Brush. To do that, hold down the Shift key as you draw. To get 
perfect right angles, do the following: 

1 . Hold down the Shift key. 

2. Draw the horizontal or vertical leg of the right angle. 

3. Move the cursor in the direction of the other leg of the right angle 
while still holding down the mouse button and the Shift key. 

4. Release the Shift key before releasing the mouse button. A straight 
line appears between the cursor and the first line. 
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Straight Edges: The Line Tool 
The Line tool creates straight lines in the foreground color. The current 
setting in the line-size box determines the width of the line. 

To use the Line tool, put the cursor where you want the line to begin, 
press and hold down the left mouse button, move the cursor to the place 
where you want the line to end, and then release the mouse button. 

Paintbrush always gives you the straightest, smoothest line possible 
on your display. For a perfect horizontal, vertical, or 45-degree diagonal 
line, hold down the Shift key as you draw. 

Smooth Curves: The Curve Tool 
The Curve tool lets you create a line with either one or two curves in it. 
Follow these steps: 

1. Put the cursor where you want your curved line to begin. 

2. Hold down the left mouse button and move the cursor to the place 
where you want the curved line to end. Release the mouse button. 

At this point, you have a straight line. 

3. Put the cursor near the part of the line that you want to bend. Hold 
down the left mouse button and move the cursor in the direction 
you want to bend the line. 

Now you have a line with one curve. 

4. If you want to bend the line only once, click again without moving 
the cursor. If you want a second bend, repeat step 3. 

It might take some practice to get accustomed to the behavior of the 
Curve tool. If your curve isn't shaping up the way you want it, click the 
right mouse button any time before finishing the second bend to remove 
the line and start over. 

Like the Line, Brush, and Airbrush tools, the Curve tool does its work 
in the current foreground color. Your choice in the line-size box determines 
the width of the curved line. 

Perfect Rectangles: The Box and Filled Box Tools 
To create rectangles and squares, use either the Box tool or the Filled Box 
tool. The Box tool draws an open rectangle in the current foreground color. 
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The Filled Box draws a rectangle in the current background color and fills 
it with the current foreground color. The width of the rectangle'S borders 
is determined by the line-size setting. 

To use either tool, first put the cursor where you want one corner of 
your rectangle to be. Then hold down the left mouse button and drag the 
mouse toward the diagonally opposite corner. As you move the mouse, 
Paintbrush expands the rectangle. When you get to the place where you 
want the opposite corner, release the mouse button. 

To draw a perfect square, hold down the Shift key as you drag the 
mouse. 

Beveled Rectangles: The Rounded Box 
and Filled Rounded Box Tools 
To draw open or filled rectangles with rounded corners, use the Rounded 
Box tool or Filled Rounded Box tool. These tools work exactly like their 
unrounded counterparts, described under the previous heading. 

Circles and Ovals: The Circle/Ellipse 
and Filled Circle/Ellipse Tools 
To create circles or ovals (ellipses), use the Circle/Ellipse tool or Filled 
Circle/Ellipse tool. The Circle/Ellipse tool draws a circle or ellipse in the 
current foreground color. The Filled Circle/Ellipse tool draws a circle or 
ellipse in the current background color, and fills it with the current fore­
ground color. 

To use either tool, first put the cursor where you want the corner of 
an imaginary rectangle that will contain your figure. Then hold down the 
left mouse button and drag the mouse to expand the figure. When the figure 
reaches the desired size, release the mouse button. 

To draw a perfect circle, hold down the Shift key as you drag the 
mouse. 

Irregular Closed'Shapes: The Polygon 
and Filled Polygon Tools 
To create any kind of closed shape other than a rectangle, square, circle, or 
ellipse, use the Polygon tool or the Filled Polygon tool. With these tools, 
you can draw as many straight line segments as you want. Each segment 
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begins where the last one ended. When you double-click the left mouse 
button, Paintbrush closes the figure by connecting the end of your last line 
segment with the beginning of your first. 

You can create anything from simple triangles to complex shapes with 
overlapping lines. If you select the Polygon tool, Paintbrush draws the lines 
in the foreground color. If you select Filled Polygon, Paintbrush draws with 
the background color and fills the resulting figure with the foreground color. 
In either case, the width of the lines is determined by the current line-size 
setting. 

To draw with either polygon tool, follow these steps: 

1. Put the cursor where you want your first line segment to begin. 

2. Hold down the left mouse button, and drag the mouse to the end 
of the first line segment. Release the mouse button. 

3. Move the cursor to the place where you want your next line segment 
to end, and click the left mouse button. 

4. Repeat step 3 until you reach the end of the next-to-Iast line segment 
in your figure. 

5. Double-click the left mouse button to close the figure. 

For perfect horizontal, vertical, or 45-degree diagonal line segments, 
. hold down the Shift key as you click the mouse button at the end of the 
segment. 

,<.~ 
<!\J 
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MOUSE TIP: The right mouse button cancels any draw­
ing made with the Line, Curve, Box, Filled Box, Rounded 
Box, Filled Rounded Box, Circle/Ellipse, Filled Circle/ 
Ellipse, Polygon, and Filled Polygon tools-as long as the 
drawing action isn't completed. Therefore, for all except 
the Curve, Polygon, and Filled Polygon, you must click the 
right mouse button while still holding the left button to 
cancel the action. 
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Filling an Enclosed Shape: The Paint Roller Tool 
The Paint Roller tool allows you to fill any enclosed portion of your picture 
with the current foreground color. When you select this tool, the cursor 
changes to look like this: 

To use the Paint Roller, position the lower left tip of the cursor any­
where within the space you want to fill. Then click the left mouse button. 

Note that if the space you want to fill has any gaps-even a gap of a 
single pixel-the rolled-on paint will leak through the gap. If that happens, 
wait until the roller has finished painting, use the Undo command, patch 
the leak, and try again. To patch a very small leak, you might want to use 
the Zoom In command. For information about this command, see "Fine­
Tuning Your Image with Zoom In," page 515. 

Letters, Numbers, and Words: The Text Tool 
Paintbrush's Text tool is a special kind of implement. You don't really draw 
with this tool; instead you select typefaces, styles, and point sizes, and then 
insert characters from the keyboard or the Clipboard. Nevertheless, after 
you've pasted down your text characters, they behave exactly like any other 
component of your Paintbrush image. 

The general procedure for adding text to a Paintbrush picture is as 
follows: 

1 . Select the Text tool. 

The cursor becomes an I-beam. 

2. Select a typeface, font style, and point size. 

3. Put the I-beam at the place where you want your text to begin, and 
then click the mouse. 

An insertion point appears. 

4. Type. If you want to enter text from the Clipboard, choose Edit Paste 
or use its keyboard shortcut, Ctrl+V. 
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5. Paste down the text you just typed. (For information about this, see 
"Pasting Down an Object," page 489.) Or click the mouse to move 
the insertion point. 

Until you paste down the text, you can change its typeface, size, or 
style. You can also erase it one character at a time by backspacing over it. 

To select a font, open the Text menu and choose Fonts. The following· 
dialog box appears. 

font: 

Arial 

Arial Narrow 
1t Book Antiqua 

Font 
Font St.tle: 

e ular 
Italic 
Bold 
Bold Italic 1t Bookman Old Style 

ll' Centur Gothic R+. 

Effects --------, 

D Strikeout 

D l!nderline 

[SamPle 
AaBbYyZz 

1~?1\rfR01 

Iln;i~f1 

You can select any typeface, style, and point size available on your 
system using the drop-down list boxes. For more information about fonts, 
see "Working with Fonts," page 40. 

You can also choose Bold, Italic, Underline, Outline, and Shadow styles 
directly from the Text menu, shown below. 
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You can choose multiple styles from the Text menu to produce special 

effects such as Bold Italic or Italic Shadow Underline. (Paintbrush does not, 
however, allow you to combine Outline and Shadow styles.) If you choose 
a style and change your mind, choose it again to deselect it. To deselect all 
styles, choose Regular. 

When you choose Outline, Paintbrush draws a border one pixel wide 
around each character using the current background color. When you 
choose Shadow, Paintbrush adds a drop shadow to the left of and below 
each character using the current background color. The following illustra­
tion shows examples of Outline text and Shadow text. 

(())1illLdlfum® ~ 
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Using Paintbrush's Editing Tools 
Changing Colors: The Eraser and the Color Eraser 
Paintbrush's toolbox includes two tools for erasing objects: an Eraser tool 
and a Color Eraser tool. The Eraser "erases" objects of any color; the Color 
Eraser "erases" only those objects drawn in the current foreground color. 
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The word erases is in quotation marks because neither of these tools 
works quite like the rubber tip at the end of your pencil. When you erase 
something in Paintbrush, you change the object from its present color to 
the current background color. 

To use the eraser tools to completely erase an object, set the current 
background color to match the default background color-the color of your 
entire canvas before you started drawing on it. The objects you "erase" with 
the eraser tools then become invisible because they blend in with the 
background. 

You can also use either eraser tool as a color-switcher. Simply set the 
current background color to some shade other than the default background. 

When you select the Eraser tool, the cursor changes to an open square. . 
When you select the Color Eraser, the cursor changes to a square with a 
cross in it. 

To erase an object (or change its color), put the eraser cursor at one 
end of the object, press and hold the left mouse button, and drag the mouse. 
Whatever the cursor passes over is erased. If you change your mind, choose 
the Edit menu's Undo command before selecting your next tool, scrolling 
the Paintbrush window, or taking any other action that "pastes down" your 
erasure. For more information, see "Pasting Down an Object," page 489. 

You can make the eraser fatter or thinner by changing the selection in 
the line-size box. For careful work, select the top line in the box. When you 
want to wipe out large areas with a few broad strokes, pick a line near the 
bottom. 

For careful work in a color picture, select the Color Eraser tool and set 
the foreground color to match the object you want to erase. That way, if 
your eraser strays onto an object in a different .color, that object is not 
affected. 

WINDOWS TIP: When you're working with a black-and­
white picture, the Eraser and the Color Eraser perform the 
same function. 
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The Color Eraser has a global option that you can use to change all 
objects of one color "into another color-much like a search-and-replace 
command in a word processor. To use this option, double-click the color 
eraser. 

For example, if you grow tired of looking at red lines in your picture 
and decide you'd rather see green, you can make the switch by choosing 
red as the foreground color and green as the background color, and then 
double-clicking the Color Eraser tool. 

This global option works on only the portion of your picture that you 
can see in Paintbrush's drawing-area window. If your picture extends be­
yond the window, you need to scroll each section into view and repeat the 
global switch. 

The Color Eraser and Eraser have almost identical toolbox icons, but 
you can tell them apart by remembering the difference between the two 
tools, shown below. 

Color 
eraser 

Eraser 

WINDOWS TIP: Be careful when using the Color Eraser's 
global-switch option if the current foreground color is a 
dithered color. Because a dithered color is actually a 
mixture of pixels in two or more solid colors, the Color 
Eraser under these circumstances modifies each compo­
nent color. As a result, areas of your picture that you 
wanted to leave alone might change color. 

To be safe, save your work before you use any 
command-such as a global color switch-that has the 
potential to alter your picture radically. Then check the 
results after you use the command. If you don't like what 
you see, use Undo. If you discover a problem after it's too 
late to use Undo, use File Open to reload the picture you 
saved. 
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The Eraser tool alters all objects in its path, regardless of their color, 
so its icon shows a white stripe across several strips of contrasting colors. 
The Color Eraser affects only the current foreground color, so its icon shows 
the colored strips without the white stripe. " 

Defining Cutouts: The Scissors and the Picl< 
The tools at the top of the toolbox-the scissors with the star and the scissors 
with the rectangle-are used for specifying cutouts-defined areas of a 
picture that can be manipulated in various ways. (For information about 
cutouts, see "Working with Cutouts," page 504.) The tool with the scissors 
and star is called the Scissors tool; the one with the scissors and rectangle 
is called the Pick tool. 

The Scissors tool allows you to define an area of any shape in your 
picture as a cutout. The Pick tool allows you to define a rectangular area. 

Regardless of which tool you use, your cutout can be no larger than 
the drawing-area window. To define an area that extends beyond the win­
dow, use the Zoom Out command. For information about this command, 
see "Zooming Out to Get the Whole Picture," page 480. 

The Scissors tool is useful when you want to select an irregularly 
shaped object without including any of the surrounding canvas. For exam­
ple, if you want to work with one branch of holly from the illustration on 
the next page, the Scissors is the appropriate tool. 

To use the Scissors, start by clicking the Scissors tool icon. Then put 
the cross-hair cursor anywhere along the edge of the object you want to 
select. Press and hold down the -left mouse button, and drag the cursor 
around the object. Paintbrush displays a solid line in the path of the cursor. 
When you have the object surrounded, release the mouse button. Paintbrush 
changes the solid line surrounding the object to a dotted line to indicate 
that the object is selected. (You don't actually have to close the selection; 
when you release the mouse button, Paintbrush connects the current cursor 
position to the place where you started.) 
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WINDOWS TIP: You might find the keyboard more ef­
fective than the mouse when you need to select a convo­
luted shape such as the holly shown in the illustration. To 
use the Scissors tool with the keyboard, position the cursor 
near an edge of the object to be selected. Hold down the 
Ins key and use the direction keys to encircle the object. 
Release the Ins key when you complete the selection. 

When the object you want to select is rectangular or when it doesn't 
matter if you pick up a little background canvas along with the object, the 
Pick tool is handier to use than the Scissors. 

To use the Pick tool, position the curso'¥ at one corner of the object 
you want to select. Press and hold down the left mouse button, and drag 
the mouse toward the diagonally opposite corner. When you get there, 
release the mouse button. 
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MOUSE TIP: The right mouse button cancels any selec­
tion made with the Scissors and Pick tools-but only if the 
editing action isn't completed. Therefore, you must click 
the right mouse button while still holding the left button 
to cancel the selection. 

Worl<ing wi~h Cutouts 
After you define a cutout, you can do any of the following with it: 

c Cut it to the Clipboard. 

c Copy it to the Clipboard. 

c Copy it to a disk file as a bit map. 

c Move it to another place within the current picture. 

c Copy it to another place within the current picture. 

c "Sweep" it across the current picture, leaving a trail of copies in its 
wake. 

c Change its size or shape. 

D Tilt it. 

c Flip it horizontally. 

c Flip it vertically. 

D Reverse its colors. 

Cutting or Copying a Cutout to the Clipboard 
To put your cutout on the Clipboard, pull down the Edit menu and choose 
Cut or Copy. If you ch'oose Cut, Paintbrush removes it from the current 
picture and transfers it to the Clipboard. If you choose Copy, Paintbrush 
puts a copy of the cutout on the Clipboard and leaves the current picture 
unchanged. 
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WINDOWS TIP: Paintbrush's Cut and Copy commands 
normally transfer information to the Clipboard in two for­
mats: picture and bit-mapped. (For more information 
about these formats, see "Viewing the Clipboard's Con­
tents," page 176.) If the application you are pasting into 
doesn't need the picture format, you can force Paintbrush 
to transfer only the bit-mapped format. To do so, choose 
Omit Picture Format from the Options menu. The bit. 
map-only alternative is quicker and uses less memory, but 
picture format provides better quality at different 
resolutions and sizes. 

When you remove a cutout to the Clipboard using the Cut command, 
the area that the cutout occupied assumes the current background color. If 
you want this area to look like blank canvas after the cutout is gone, be 
sure the current background color matches your initial (default) background 
color. 

Copying a Cutout to a Disl< File 
You can copy a cutout to a disk file as well as to the Clipboard. It's a good 
idea to do this if you think you might want to paste your cutout into a variety 
of different pictures, if you're planning to use it in another application (such 
as Cardfile or Write), or if you want to use the cutout as wallpaper for your 
Windows desktop. 

To save a cutout as a disk file, use the Edit menu's Copy To command 
and fill out the dialog box that appears. The dialog box is identical to the 
one presented by the Save As command-the command you use to save an 
entire picture for the first time (or to save it under a new name). For 
information about this dialog box, see "Saving and Opening Paintbrush 
Files," page 518. 
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Pasting a Cutout from the Clipboard 
To paste a cutout from the Clipboard into the current picture, choose the 
Edit menu's Paste command. The cutout appears in the upper left corner 
of the drawing area, surrounded by a dotted line. You can then move the 
cutout by dragging it to where you want it. Or you can copy it, sweep it, 
or manipulate it in any of the other ways described below. 

Note that pasting in Paintbrush is a little different from pasting in other 
kinds of applications. In a word processor, for example, you position the 
insertion point at the place where you want the Clipboard's contents to 
appear; then you choose Paste. In Paintbrush you choose the Paste com­
mand first; then you position the pasted object. 

NOTE: Paintbrush handles Clipboard text differently than 
graphics. When you paste text from the Clipboard, you must 
position the insertion point first; then choose the Paste command. 

Pasting from a Disk File 
To paste a cutout that was saved as a disk file, choose the Edit menu's Paste 
From command, and then fill out the dialog box that appears. The dialog 
box is the same as the one used by the File menu's Open command. 

WINDOWS TIP: The dialog box that appears when you 
choose Paste From includes an Info button. This button 
presents size and color-format information about any 
selected file. You might want to check this information if 
you think the file you want to paste might be too large for 
the picture you're currently working in. 

When you use the Paste From command, Paintbrush displays the 
cutout in the upper left corner of the current picture, surrounded by a dotted 
line. You can then move the cutout to the place where you want it. Or you 
can copy it, sweep it, or manipulate it in any of the other ways described 
below. 
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Moving a Cutout 
To move a cutout from one place to another in a picture, put the cursor 
anywhere within the dotted line that encircles the cutout. Then press and 
hold down the left or right mouse button while you drag the cutout to its 
destination. 

When you move a cutout, the area that the cutout occupied assumes 
the current background color. If you want this area to look like blank canvas 
after the cutout is gone, be sure the current background color matches your 
initial (default) background color. 

Moving Transparently or Opaquely 
When you move a cutout transparently, any part of the cutout drawn in the 
current background color assumes the color of the location to which it's 
moved. When you move a cutout opaquely, all parts of the cutout retain 
their colors at the new location. 

The mouse button you press while dragging the cutout determines 
whether the move is transparent or opaque. To move a cutout transparently, 
drag it using the left mouse button. To move it opaquely, drag it using the 
right mouse button. 

Copying a Cutout within a Picture 
To copy a cutout from one place to another within the same picture, place 
the cursor anywhere within the dotted line that encircles the cutout. Then 
hold down the Ctrl key while you drag the cutout to its destination. Paint­
brush makes a copy of the cutout at the new location, leaving the original 
cutout unchanged. 

You can copy the cutout transparently or opaquely. To copy the cutout 
transparently, drag it while holding down the left mouse button. To copy it 
opaquely, drag it while holding down the right mouse button. For more 
information, see "Moving Transparently or Opaquely," above. 

Sweeping a Cutout 
"Sweeping" a cutout means creating a trail of copies as you move the mouse 
across the canvas. In the illustration on the next page, for example, a cutout 
of a wagon wheel has been swept across the canvas. 
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II Paintbrush - (Untitled) lin 

To sweep a cutout, first move the cutout to the place where you want 
to begin the sweep (if it's not there already). Then put the cursor anywhere 
within the dotted line that encircles the cutout and hold down the Shift key 
while you drag the cutout. To sweep transparently, drag the cutout while 
holding down the left mouse button. To sweep opaquely, drag the cutout 
while holding down the right mouse button. For more information, see 
"Moving Transparently or Opaquely," page 507. 

The slower you move the mouse, the more copies you will generate 
with the sweep. 

Modifying a Cutout with 
the Shrink + Grow Command 
The Pick menu's Shrink + Grow command allows you to expand or contract 
a cutout. In the process you can either maintain the cutout's original ratio 
of width to height or change it-as you choose. The resized cutout can 
either replace the original cutout or appear in another location as a modified 
copy of the cutout. 

The Shrink + Grow command always produces an opaque replica of 
the original cutout. 
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Maldng a Copy in a New Size and Shape 
To make a copy of a cutout in a new size and shape, follow these steps: 

1. Use either the Scissors tool or the Pick tool to define a cutout. 

2. Pull down the Pick menu. If a check appears next to the Clear 
command, choose Clear to remove the check. (If the Clear command 
is checked, the new copy replaces the original cutout.) 

·3. Choose the Pick menu's Shrink + Grow command. 

4. Put the cursor at one corner of the position where you want the 
resized and reshaped copy to appear. Then hold down the left 
mouse button and drag the mouse toward the diagonally opposite 
corner. A dotted-line rectangle follows the path of the mouse to 
show you the size and shape the cutout will assume. 

At this point, your picture might look something like this: 

.- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - ~ 
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5. Release the mouse button. 

Paintbrush draws your copy, as shown on the next page. 
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6. To make another copy, repeat steps 4 and 5. 

You can make as many resized and reshaped copies as you want. 
When you've made enough, paste down the copy. For information about 
pasting down, see "Pasting Down an Object," page 489. 

/'~ ";'U 
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MOUSE TIP: The right mouse button cancels any change 
made with the Shrink + Grow command-but only if the 
editing action isn't completed. Therefore, you must click 
the right mouse button while still holding down the left 
mouse button to cancel the change. 

Making a Copy in a New Size and the Original Shape 
To maintain the original shape of the cutout while you make a copy in a 
new size, follow steps 1 through 6 above, but hold down the Shift key 
during steps 4 and 5. 
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Replacing a Cutout with a Resized and Reshaped Version 
To change the size and shape of a cutout and at the same time remove the 
original cutout from the picture, follow steps 1 through 6 above, but be sure 
a check mark appears next to the Clear command in step 2. 

Modifying a Cutout with the Tilt Command 
The Pick menu's Tilt command allows you to distort a cutout by slanting 
one edge of it. For example, you can use Tilt to change the shape of a cutout 
from a rectangle to a parallelogram. 

The Tilt command works much like the Shrink + Grow command, de­
scribed in the previous section. Start by defining the cutout you want to 
modify. Then choose Clear on the Pick menu if you want to replace your 
original cutout with the modified version. Or deselect (remove the check 
from) Clear if you want to maintain the original and produce a modified 
copy. Then choose the Tilt command. 

After chOOSing Tilt, put the cursor at the place where you want the 
upper left corner of the tilted version to appear. Press and hold the left 
mouse button while you move the mouse to the left or right. As you move 
the mouse, Paintbrush displays a tilted dotted outline, as shown in the 
follOWing illustration; 
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When the outline has the shape you want, release the mouse button. 
Paintbrush redraws the cutout to fit the new shape. 

MOUSE TIP: The right mouse button cancels any change 
made with the Tilt command-but only if the editing 
action isn't completed. Therefore, you must click the right 
mouse button while still holding down the left mouse 
button to cancel the change. 

Flipping a Cutout Horizontally or Vertically 
With the Pick menu's Flip Vertical and Flip Horizontal commands, you can 
flip or invert a cutout. Simply define the cutout, and then choose the ap­
propriate Flip command. For example, the following illustration shows how 
our Christmas banner would look after using both the Flip Horizontal and 
Flip Vertical commands. 
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Reversing the Colors of a Cutout 
The Pick menu's Inverse command "reverses" the colors of your cutout. 
Black becomes white, white becomes black, and colors switch to their 
complementary colors on a red-green-blue color wheel. 

If you apply the Inverse command to a dithered color, each component 
of the color is inverted separately. The result might be a color different from 
any you now have on your palette. You might want to experiment to see 
what effects you can achieve with this command. 

Working with Large Cutouts 
If you want to define a cutout larger than Paintbrush's drawing-area window 
(that is, larger than you can see on screen without zooming out), you must 
first pull down the View menu and choose the Zoom Out command. The 
same is true if you want to paste an image (from a file or from the Clipboard) 
that's larger than the drawing-area window. If you paste a large image 
without first using the Zoom Out command, Paintbrush pastes only as much 
of the image as it can fit in the drawing-area window. 
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When you use the Paste or Paste From command after zooming out, 
Paintbrush displays the pasted image as a cross-hatched shape in the upper 
left corner of the window, like this: 

Drag the cross-hatched cutout to the place where you want to put it, 
and then click anywhere outside the cutout. Paintbrush removes the cross­
hatches. The following illustration shows the result. 

Use the View menu's Zoom In command to return to the normal view. 
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Fine-Tuning Your Image with Zoom In 
Paintbrush stores the images you create as bit maps, which record the 
relative position of each visible dot on screen. The individual dots are called 
pixels. 

You might not normally be aware of separate pixels as you create and 
modify Paintbrush images, but when you want to see and edit the image 
pixel by pixel, Paintbrush will accommodate you. 

Simply choose the View menu's Zoom In command. Paintbrush turns 
your cursor into a small rectangle. Position the rectangle over the portion 
of the image that you want to zoom in on, and click the left mouse button. 

Here's an example of an image that has been zoomed in: 

Each little square in this view represents one pixel of the image. You 
can change any pixel to either the foreground or background color by 
positioning the mouse on the pixel and clicking. To change the pixel to the 
current foreground color, click the left mouse button; to change the pixel 
to the current background color, click the right mouse button. 

515 



~ PAR T 4: Running Applications 

516 

You can "paint" a group of pixels at once with either the foreground 
or background color by holding down the appropriate mouse button and 
dragging the mouse. Be careful not to move too quickly when you do this, 
though, or some of the pixels in your path might not be painted. 

/~ ";;;:}··U 
i'i 

MOUSE TIP: To paint straight horizontal or vertical lines 
in zoom-in mode, hold down the Shift key while dragging 
the mouse: 

When you're ready to return to the normal view of your image, open 
the View menu again and choose Zoom Out. 

Working with Custom 
Color/Pattern Palettes 

Paintbrush gives you a set of 28 default colors or patterns to use in your 
pictures. With a 16-color display driver, 16 of these are solid colors. The 
remaining 12 are dithered-mixtures of two or more solid colors. (For 
information about selecting a display driver, see "Changing System Settings," 
page 766.) 

You can create additional custom colors or patterns by choosing the 
Option menu's Edit Colors command. Each new color or pattern replaces 
ot;le color or pattern in your palette, but you can use as many different 
colors or patterns as you want. 

. Note that pictures that use more than 16 solid colors can be imported 
into Paintbrush, and-if your display adapter permits-all solid colors will 
be displayed. You cannot use more than 16 solid colors to modify such 
pictures, however. 
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Creating a New Color or Pattern 
To create a new color or pattern, do the following: 

1. Put the cursor on the color or pattern you want to replace, and click 
the left mouse button. 

2. Open the Options menu and choose Edit Colors. 

You'll see this dialog box: 

Edit Colors 

Red 13 :.c ...••• 

!ireen Ia' ·:·10'······ 
!l.Iue 13.\ <It] 

1[??o~~~:?;1 

3. Use the scroll bars to adjust the red, green, and blue levels. 

Note that when you're using Paintbrush in black and white, the 
three scroll bars are locked together; when you adjust one, the other 
two adjust at the same time. 

As you experiment with different levels of red, green, and blue, 
you can see the result of your mixture in the sample box to the 
right of the scroll bars. 

4. When you achieve the color you want, click OK. 

If you change your mind and want to reinstate the color you started 
with, click Cancel. If you change your mind after clicking OK, choose Edit 
Colors again. Then click Reset and OK. The default (standard) color is 
reinstated. 
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MOUSE TIP: To edit one of the current palette colors, 
simply double-:-click it in the palette. Doing so immediately 
displays the Edit Colors dialog box. 

Saving and Retrieving Custom Palettes 
If you create a color or pattern you particularly like, you can save your mod­
ified palette with the Options menu's Save Colors command. You'll be asked 
to supply a filename for your custom palette; Paintbrush supplies the ex­
tension PAL. 

At the start of your next Paintbrush session, you can replace the stan­
dard palette with the custom palette you saved. To do this, choose the 
Options menu's Get Colors command. 

Saving and Opening Paintbrush Files 
To save a Paintbrush image for the first time, choose the Save As command. 
Thereafter, choose Save to save it. Both commands are located on the File 
menu. 

You'll see the following dialog box when you choose Save As: 

File Hame: 

I lID 

Save As 

J!.irectories: 

c: \users\def ault 
r-::18:7:--, -c:-\ ----""'T~::;;::O'~: 1i!1~~tu~:i 

18:7 users 
lEE> default 

Save File as lYpe: ...-Dr...;;:iy:;....es_: ------r:~ 
116 Color bitmap [".OMP)1m I [iii c: 111 r;;:IERM~",';;;;;;~tlW;;;;;;'J,,;;;;;:iJm;;;;;:i:'-it;;;:)" 
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File Format Options 
Paintbrush provides five file-format options. To see your choices, click the 
arrow at the right of the Save File as Type list box, shown in the following 
illustration. 

FileName: 

I"·bmp 

Save As 

J!.irectories: I mi:T;?fjK1'~~"'~:~:~' I 
c: \users\def ault 

IF " ,Cancer"'71 [+ r:(C,=--c-:\-------r::-;+:::-:o'" I.ioo, ___ ...... _ 

(C, users 
f250 def ault 

The two file formats used by Paintbrush are PCX and BMP. But, as the 
illustration shows, the BMP format is available in four flavors: monochrome, 
16-color, 256-color, and 24-bit. 

You should save your file in the PCX format if you want to be able to 
import it into a non-Windows-based application that does not support BMP 
files. Such applications currently include a number of non-Windows-based 
word processors, such as Microsoft Word and WordPerfect. 

Use one of the BMP (bit map) formats if any of the following is true: 

tI You want to use your picture as wallpaper for your Windows desk­
top. (For information about wallpaper, see "Wallpapering Your 
Desktop," page 149.) 

tI You want to incorporate the picture into a document created under 
the OS/2 Presentation Manager (version 1.2 or later). 

tI You want to incorporate your picture into another Windows-based 
application that supports BMP files, but not PCX files. 
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If you're not concerned about using your picture as Windows wallpa­
per or importing it into another application, you can take your pick between 
PCX and BMP. If you choose BMP, pick your flavor according to the follow­
ing guidelines: 

EJ If your picture is black and white, select Monochrome bitmap. 

EJ If your picture uses only the standard 16 solid colors, select 16 
Color bitmap. 

I'll If you created or imported a picture into Paintbrush that uses more 
than 16 but no more than 256 colors, select 256 Color bitmap. 

c If you created or imported a picture into Paintbrush that uses more 
than 256 colors, select 24-bit bitmap. 

NOTE: If you're not sure how many colors your picture uses, click 
the Info button in the Save As dialog box. The Info button also 
shows the size of the picture you're working on. 

Opening a Paintbrush File 
To open an existing Paintbrush file, choose the File menu's Open command. 
You'll see the following dialog box. 

File Hame: 

I-·bmp;-.dib 

256color. bmp 
arcade.bmp 
arches.bmp 
argyle.bmp 
ball.bmp 
cars.bmp 
casUe.bmp 
chitz. bll!P 

Open 

J!.irectories: 

c:\winnt 

List Files of ,lype: ,.-D,...;;ri.Y::::...,e_s: _____ -.=::o 

I Bitmap files (".BMP;".DIIII1 IIiiI c: II ~g~!B1 

This dialog box works like its counterparts in other Windows-based 
applications, except that you need to specify a file type, and you can click 
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a button to get information about a file you might want to open. The Files 
box lists only those files that have the selected format. If you don't find the 
file you're looking for with BMP selected, try selecting MSP or PCX. 

The MSP option in the List Files of Type box allows you to import a 
file that was created in Paint, the drawing program included in versions of 
Windows before 3.0. Paint files are black and white only. You can edit them 
in Paintbrush, but you can't save them again in MSP format. Choose PCX 
or Monochrome bitmap to save a modified Paint file. 

Click Info to open a dialog box that displays size and color-format 
information about a selected file. 

Printing a Paintbrush Image 
To print a Paintbrush image, first be sure your printer is set for the graphics 
resolution and orientation you want to use. To change resolution or orien­
tation, or to switch to a different printer, use the File menu's Print Setup 
command. This command works the same way in Paintbrush as it does in 
W rite, Terminal, and the Windows desktop accessories. 

Paintbrush normally prints with half-inch margins on all four sides. 
You can change any of these margins by choosing the File menu's Page 
Setup command. The dialog box for this command, shown below, also gives 
you an opportunity to specify a header and footer for your printout. 

Page Setup 

!!eader: 

footer: 

Margins 

lop: 10 I.!l.ottom: /0.50 

~eft: 10.50 I Right: 10.50 

You can use codes to specify the position of your header or footer, or 
to insert the current date or time, the name of your file, or the page number. 
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The codes used by Paintbrush are the same as those used by the desktop 
accessories. For information about these codes, see "Notepad's Printing 
Commands," page 545. 

When you're ready to print, open the File menu again and choose 
Print. The Print dialog box looks like this: 

Quality 

o .Qraft 

@ f.roof 

Print 

Window 

@ Whole 

o Pa!tial 

Humber of copies: U ,S.caling: ~ % 

o !!se Printer Resolution 

As you can see, you have some choices to make before printing. 

Draft or Proof Quality 
If your printer offers a draft mode, you can select Draft for fast printing and 
lower quality, or select Proof for higher quality printing. 

Whole or Partial Printout 
By default, Paintbrush prints your entire image. If you want to print only 
part of it, select Partial. When you choose OK to start the printout, Paintbrush 
adjusts the screen to display your entire image. Put the cursor at one corner 
of the area you want to print, press and hold down the left mouse button, 
and drag the mouse to the diagonally opposite corner. 

Number of Copies 
Change the value in this box if you want more than one copy of your 
artwork. 
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Resolution and Scaling 
Paintbrush stores the relative position of each pixel in your picture. When 
you print, that information is simply transferred to your printer and repro­
duced with dots on paper instead of points of light on a video screen. The 
size of the dots used by your printer is determined by its graphics resolution. 
The higher the resolution, the smaller the dots. 

By default, Paintbrush prints at screen resolution, which approximates 
what you see on your video display. If you're not satisfied with the printed 
image you get with screen resolution, put a check in the Use Printer Reso­
lution check box. 

Selecting printer resolution usually produces finer, but smaller, output 
than screen resolution because the dots on most printers are smaller than 
those on most screens. If neither the screen resolution nor any of your 
printer's resolution options produces the image size you want, pick the 
setting that comes closest. Then enter a scaling factor in the box marked 
Scaling. To make the image larger, enter a value greater than 100; to make 
it smaller, enter a value less than 100. 

When you enter a scaling factor other than 100, Paintbrush adds or 
removes dots from the image's bit-mapped information to produce the size 
you request. As a result, scaled-up images might have unacceptably jagged 
diagonals and curves, and scaled-down images might lose detail. For these 
reasons, it's usually best to try changing resolution before applying scaling. 
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Clock 
It won't chime or make coffee, but Clock can give you the time of day, 
even when it's minimized. 

Calculator 
For simple calculations, Calculator is more efficient than a spreadsheet 
program. It uses little memory, loads immediately, and offers all the 
functionality you'd get from a desktop calculator. 

Notepad 
As a plain-text editor, Notepad is ideal both for quick jottings and for 
editing INI files. In the Windows NT version, Notepad can accommodate 
very large text files as easily as small ones. 

Cardfile 
Cardfile is an electronic equivalent of the familiar Rolodex file. Unlike its 
paper counterpart, though, Cardfile can dial your telephone. 
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Character Map 
Need a copyright sign, an accented letter, or a Wingdings dingbat? Char­
acter Map can help you find it quickly and will even copy it into your 
document. 

Sound Recorder 
You can use Sound Recorder to create and edit WAY files, which you 
can then use as system sound effects or for annotating documents. 

Chat 
With Chat, you and your network-mates can type messages onto each 
other's screens. 
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n this chapter, we'll look at seven desktop accessories: Clock, Calcu­
i lator, Notepad, Cardfile, Character Map, Sound Recorder, and Chat. 

IJ Clock is just what its name implies-an electronic timepiece. You 
can run it as either an analog (traditional) or a digital clock. And 
even when it's minimized, you can tell at a glance what time it is. 

a Calculator is an electronic calculator with a full set of scientific 
functions. Calculations made in Calculator can be transferred easily 
into any Windows-based program by way of the Windows Clip­
board. 

IJ Notepad is a plain-text editor with a handy time-stamping feature. 
You can use it as a scratch pad while you work in other applica­
tions. Files created in Notepad can be read by virtually any word 
processing program. 

IJ Cardfile is the Windows equivalent of a Rolodex file. But unlike a 
Rolodex, Cardfile automatically sorts your cards, merges cards from 
different files, and even dials the phone for you (provided that 
your computer is equipped with a modem). 

IJ Character Map helps you enter special characters, such as accented 
letters or mathematical symbols, in your text documents. With 
Character Map, you can look at the complete character set for each 
font installed on your system and copy special characters to your 
document by pointing and clicking with the mouse. 

IJ Sound Recorder allows you to record, play, and edit sound files in 
waveform (W AV) format. Because Sound Recorder supports object 
linking and embedding (OLE) as a server application, you can also 
use it to embed sound annotations in programs, such as Microsoft 
Excel, that support OLE as client applications. To use Sound 
Recorder, your computer must be equipped with audio hardware, 
and you must have an appropriate sound driver installed. 

IJ Chat is a program that lets you and another member of your 
domain or workgroup converse by typing messages onto each 
other's screens. 
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Clock 
Clock is the simplest of the Windows accessories. It does nothing but report 
the date and time. Clock continues to operate when minimized. In fact, you 
can still read the time when Clock is reduced to an icon. This makes Clock 
a handy item to have around: It doesn't take up much space, it doesn't use 
much memory, and you can glance at it whenever you need to know the 
time. 

Clock also includes a handy Always on Top command on its Control 
menu. If you choose this command, Clock is always visible, whether mini­
mized or open, even when you're working in a maximized application. In 
the following illustration, for example, Lotus Improv is maximized, but Clock 
can still be seen in a small window near the upper right corner of the screen. 

I Net Revenue by Division I 

If you like to keep Clock visible at all times, you might also want to 
simplify its display by removing the title and menu bars. You can do that 
by double-clicking anywhere within the Clock window. (The title bar and 
menu bar have been removed in the illustration above.) Double-click a 
second time to restore the title bar and menu bar. 
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Clock's Settings menu includes commands to switch between Digital 

and Analog display modes, and to turn on or off display of the second hand 
and the the current date. If you use Clock in its digital mode, you can also 
change the font by choosing the Settings menu's Set Font command. Any 
screen font available on your system can be used for the digital display. 
You'll get the best results, however, by sticking with TrueType or other 
scalable fonts. (For more information about fonts, see "Working with Fonts," 
page 40.) 

Ii 

WINDOWS TIP: Clock gets its time from your computer's Ii 

internal clock. If you need to reset the clock, you can do 
so with Control PaneL For information about setting the 
clock, see "Setting the Date and Time," page 161. 

Calculator 
Calculator has two operating modes. You can use it as a standard arithmetic 
calculator with memory buttons, in which case it looks like this: 

= Calculator a 
fdit Y:iew Help 

D.' 

Or you can us it as a scientific calculator, in which case it looks like 
the illustration on the next page. 
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1:1 Calculator a 
fdit ~iew Jjelp 

o. I 
I 0 Hex @ Dec 0 Oct 0 Bin I I @ Deg 0 Rad 0 Grad I 
C~~Jl._~~IJI Dlnv 0 Hyp I D D D 
~@CDCD@0000~J~) 
8~)(~)GJ§)000(-=:JGE) 
(sum)B(~)GJ~000( - )(~8 
G.JB@)08~)~)DG.JL.)L!_~.~.J 
~~0~0~00(Dl00 

To switch from one mode to the other, use the View menu. 

Calculator retains any displayed value and any value in its memory 
register when you switch from one mode to the other. 

In both standard and scientific modes, Calculator can operate on num­
bers ranging from _10308 through 10308, including numbers as small as 10-323. 

Results or entries outside of that range produce an error message. (To re­
cover from an error, click Calculator's C (clear) or CE (clear entry) button, 
or press Esc.) 

Entering Numbers and Symbols into Calculator 
You can enter numbers and symbols either by clicking them with the mouse 
or by typing them at the keyboard. For example, to have Calculator compute 
the sum of two and two, you can: 

1. Click 2. 

2. Click the plus sign (in the lower right corner of the standard-mode 
window). 
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3. Click 2. 

4. Click the equal sign (right next to the plus sign). 

Or you can type 

2+2= 

Try both methods to see which works best for you. 

If you're adept at typing numbers, you might find it easier to enter 
numbers using the keyboard. To get the result of a calculation using the 
keyboard, you can either press the Enter key or type an equal sign. 

All of Calculator's buttons have keyboard equivalents. Table 17-1 lists 
the keyboard equivalent for each of the standard calculator's buttons. Table 
17-2 on the next page lists the keyboard equivalents for the additional 
buttons available in the scientific calculator. 

1\": 

, .. ~ 'I".'r 

·t:l!ffiml ~, 
+ + Back Backspace or Left 

C Esc 

CE Del 

/ / M+ Ctrl+P 

+/- F9 MC Ctrl+C 

. or, MR Ctrl+R 

% % MS Ctrl+M 

= or Enter sqrt @ 

l/x R 

TABLE 17-1. 

Keyboard equivalents for the standard calculator buttons. 
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( ( log L 

) ) Lsh < 
And & Mod % 

Ave Ctrl+A n! 

Bin F8 Not 

Byte F4 Oct F7 

cos a Or I 
Dat Ins PI P 

Oec F6 Rad F3 

Deg F2 s Ctrl+D 

dms M sin S 

. Dword F2 Sta Ctrl+S 

Exp X Sum Ctrl+T 

F-E V tan T 

Grad F4 Word F3 

Hex F5 xl\y U 

Hyp H xl\2 @ 

Int xl\3 # 

Inv Xor 1\ 

In N 

TABLE 17-2. 

Keyboard equivalents for the scientific calculator buttons. 

Cutting and Pasting with Calculator 
Calculator can exchange numbers with other applications by way of the 
Windows Clipboard. If you choose the Copy command from Calculator's 
Edit menu, whatever number Calculator is currently displaying is transferred 
to the Clipboard. If you choose the Paste command from Calculator's Edit 
menu, the current contents of the Clipboard are transferred into Calculator 
character by character, as if you typed the characters at the keyboard. 
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Using the Standard Calculator 
Here's a quick tour of the standard arithmetic calculator. It functions almost 
exactly like a simple pocket calculator, except that you don't have to fumble 
around looking for it on your desk. 

Clearing and Correcting 
If you make a mistake while entering a number, press Backspace or click 
Calculator's Back button. This erases the last digit from the display. Continue 
erasing a character at a time until you correct the error. 

To clear the last entry in a sequence of numbers and arithmetic sym­
bols, press Del or click the CE (clear entry) button. For example, if you're 
adding up a list of numbers and you make a mistake, you can click the CE 
button and reenter the last number. You don't have to start over. 

To clear the current calculation entirely and return the display to 0, 
press Esc or click the C (clear) button. 

Numbers and Operators 
The heart of Calculator's standard window is the 10-key pad. To the right 
of and below the pad are the basic arithmetic operators. Note that for divi­
sion, you use the slash (j), and for multiplication, you use the asterisk (*). 

The sqrt button produces the square root of whatever number is in 
the display. To get the square root of 796.5, for example, enter 796.5 and 
click sqrt. (You don't have to click the = button.) 

The % button calculates percentages. For example, to calculate 8.75% 
sales tax on a $56.50 purchase, do the following: 

1. Enter 56.5 (with or without the trailing 0; it doesn't matter). 

2. Click the multiplication button (*). 

3. Enter 8.75. 

4. Click the percentage button (%). 

The display shows 4.94375, or $4.94 in sales tax. 

The l/x button produces the reciprocal of whatever number is in the 
display. For example, if you enter 10 and then click l/x, the display shows 
0.1, or 1/10. 
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The +/- button changes the sign of the number currently in the display. 
A typical use for this button is to enter a negative number in the middle of 
an arithmetic operation. For example, to multiply 52 times -23, you can: 

l. Enter 52. 

2. Click the * button. 

3. Enter 23. 

4. Click the +/- button. 

5. Click the = button. 

The result is -1196. If you enter 52, click the * button, and then click 
the minus sign followed by 23, Calculator treats the minus sign as a replace­
ment for the multiplication operator and simply subtracts 23 from 52. 

Repeating Calculations 
After you click the = button to finish a calculation, you can make Calculator 
repeat the last part of the calculation by clicking = (or pressing Enter) again. 
For example, if you enter 

1034.5+23471/4= 

Calculator displays 6126.375. Click = again, and Calculator divides that result 
by 4, giving 1531.59375. Subsequent clicks on the = button produce further 
divisions by 4. 

Using Calculator's Memory Features 
Calculator has four memory buttons, markedMC, MR, MS, and M+. Here's 
what each memory button does: 

II MS stores the currently displayed value in the memory register, 
replacing any value that was there before. An M is displayed in 
the upper right corner of the Calculator window. 

Il M+ adds the value currently displayed to the value already in the 
memory register. 

EJ MR recalls the value currently in memory and enters it into the 
current calculation. The value remains in memory. 

II MC clears the memory regis~er. The M displayed near the upper 
right corner of the Calculator window disappears. 
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For example, suppose you want to divide each of a dozen numbers 
by the same factor-say, .01375. To spare yourself the drudgery of entering 
that factor in a dozen separate calculations, you can do this: 

1. Enter .01375. 

2. Click the MS (store in memory) button. 

Calculator stores the current value (.01375) in its memory register 
and displays an.M in a box near the upper right corner of the 
window. 

3. Enter the first of your dozen numbers. 

4. Click the / button. 

5. Click the MR (recall from memory) button. 

6. Click the = button. 

7. Repeat steps 3 through 6 for each remaining number. 

Using the Scientific Calculator 
Calculator's scientific mode has all the features of the standard calculator, 
plus the following: 

1.1 Additional arithmetic operations 

1.1 Exponential and logarithmic operations 

1.1 Calculations in the binary, octal, and hexadecimal numbering 
systems 

1.1 Bitwise operations 

c Trigonometric calculations 

1.1 Statistical calculations 

Order of Evaluation in the Scientific Calculator 
In Calculator'S standard mode, calculations are always performed in the 
order in which they're entered. If you type 4+5*6=, for example, Calculator 
displays 54, the result of adding 4 to 5 and multiplying the sum by 6. 

This is not the case in Calculator's scientific mode. Here, the order in 
which an expression is evaluated depends on the operations involved. 
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Multiplication and division, for example, are always performed before ad­
dition or subtraction. In the scientific calculator, therefore, the expression 
4+5*6 returns 34, the result of adding 4 to the product of 5 and 6. 

Fortunately, it is not necessary to memorize Calculator's rules about 
operator precedence. You can simply watch Calculator's display as you enter 
your calculation. Whenever you type an operator (for example, +, *, or /), 
Calculator checks to see if the operator you just typed has higher precedence 
than the previous operator you entered. If it does not have higher prece­
dence, Calculator evaluates the last operation and displays an intermediate 
result. If it does have higher precedence, no intermediate result is displayed. 

For example, suppose you type the following using Calculator's sci­
entific mode: 

4*5+ 

After you type the plus sign, Calculator, recognizing that addition has 
lower precedence than multiplication, evaluates 4*5 and displays the inter­
mediate result, 20. If, on the other hand, you type 

4+5* 

Calculator sees that your last operation, multiplication, has higher prece­
dence than the previous one, addition. So it does not display an intermediate 
result. Instead it waits for your next number or numbers. If you follow the 
asterisk with 

6= 

Calculator goes ahead and multiplies 5*6. Then it adds 4 to the result. 

What if you need to override Calculator's normal order of operations? 
You can do that in either of two ways. In the case of 4+5*6, for example, 
you can simply click the = button after entering the 5. That forces Calculator 
to carry out the addition and display the intermediate result, 9. Now you 
can complete the calculation by entering *6=. 

Alternatively, you can enter parentheses before and after the operation 
you want Calculator to perform first. Expressions within parentheses are 
always evaluated immediately, regardless of what follows the closing pa­
renthesis. 

With the discussion of precedence out of the way, let's now take a 
tour of the scientific calculator's capabilities. 
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Additional Arithmetic Operations 
The Mod (modulus) button returns the remainder of a division. For example, 
if you enter 65, click the Mod button, enter 7, and then click the = button, 
Calculator returns 2, because 65 divided by 7 is 9, with a remainder of 2. 

The n! button returns the factorial of the currently displayed number. 
For example, if you enter 6 and then click the n! button, Calculator returns 
720 (6 X 5 x 4 x 3 x 2 xl). 

The ( Cleft parenthesis) and) (right parenthesis) buttons allow you to 
nest calculations within calculations, in effect changing the order in which 
expressions are evaluated. You can nest up to 25 levels. 

The Int (integer) button strips the fractional component from the cur­
rently displayed number. For example, if you click Int when 456.789 is 
displayed, the display changes to 456. You can strip the integer portion of 
a number by first selecting the Inv (inverse function) check box, and then 
clicking Int. The Int button works only when Calculator is using the decimal 
numbering system. 

The Exp (exponent) button lets you enter numbers in scientific nota­
tion. For example, to enter 6.4 x 10-14 (which is displayed as 6.4e-014), 
enter 6.4, click Exp, enter 14, and then click +/-. The Exp button works 
only when Calculator is using the decimal numbering system. 

Exponential and Logarithmic Operations 
The xJ\y button lets you raise a number to any power. For example, to find 
the seventh power of 2, enter 2, click xJ\y, enter 7, and then click the = 

button. 

The xA3 button returns the cube of the currently displayed number. 

The xA2 button returns the square of the currently displayed number. 

The log button returns the base-IO logarithm of the currently displayed 
number. 

The In button returns the natural (base e) logarithm of the currently 
displayed number. 

The Inv check box, located next to the Back button, provides the 
inverse function of the above operations. First select Inv, and then click the 
function you want to use. After you use an inverse function, the Inv box is 
automatically turned off. 
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When the Inv box is checked, xAy returns the yth root. For example, 
to find the seventh root of a number, enter the number, click Inv, click xAy, 
and then click 7. 

Similarly, the inverse of xA3 and xA2 return a number's cube root and 
square root, respectively. And the inverse of log and In return 10 and e, 
respectively, raised to the power of a number. 

The F-E button toggles the display (in decimal numbering) between 
normal (floating point) and scientific (exponential) notation. 

Using Binary, Octal, and Hexadecimal Numbering 
The Hex, Dec, Oct, and Bin option buttons let you switch numbering 
systems. If Calculator is displaying a number when you switch, it converts 
that number to the system you switch to. For example, if you want to know 
the octal equivalent of 123456 decimal, simply enter that number in decimal 
mode and then click the Oct button. 

You can enter only those digits that are appropriate for the current 
numbering system. If you're in binary, for example, Calculator accepts only 
o and 1. If you're in hexadecimal, you can use the numerals 0 through 9 
and the A through F buttons. 

When you're in binary, octal, or hexadecimal numbering, you can use 
the option-button group at the Calculator window's right side to change the 
size of the value currently displayed. If this group is set at Dword, Calculator 
displays the full value of the current number. If you switch to Word, Calcu­
lator displays only the least significant 16 bits. If you choose Byte, you see 
only the least significant 8 bits. 

Bitwise Operations 
The And, Or, Xor, and Not buttons perform logical bitwise operations on 
numbers in any numbering system. The Lsh button shifts numbers left one 
bit; when the Inv box is checked, Lsh shifts one bit to the right. 

Trigonometric Functions 
The sin, cos, and tan buttons return sine, cosine, and tangent, respectively. 
When the Inv box is checked, they return arcsine, arccosine, and arctangent. 

For hyperbolic functions, first click the Hyp box, and then click the 
button for the function you want. 
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When you're in the decimal numbering system, the option-button 
group on the right side of Calculator's window governs the way Calculator 
expects to see angles expressed. The default setting is Deg (degrees), but 
you can switch to Rad (radians) or Grad (grads). 

To switch the displayed number from normal decimal format to de­
gree-minute-second format, click dms. In degree-minute-second format, the 
degrees are to the left of the decimal point. The minutes are the first two 
digits to the right of the decimal, and the seconds are to the right of the 
minutes. To switch back, select the Inv check box, and then click dms. 

Clicking the PI button enters the constant pi (1t). A shortcut for entering 
21t is to select the Inv check box, and then click PI. 

Opening a Statistics Window 
To calculate sums, averages, and standard deviations of groups of numbers, 
first click the Sta bution. That opens a separate window, in which you can 
enter as many numbers as your computer's memory allows. The statistics 
window looks like this: 

$aj -. Calculator 
Edit View Help 

I o. I 
I 0 Hex ""'" ; I 0 Rad 0 Grad I 

C~)CI I~DD 
~~](~§)~J 
~)~ 1!!A~frl l!LoAl)';1 I~Kl.bl\~'1 Ir:CAD)'1 JC:=)(~.J(~ 
~~ "=0 .......... _ .............. ]D0~) 
08~0~CDGJUC;-)OGD 
~)8§)0fiC)( A )CD0~)( E lC!J 

The first thing you'll want to do after opening this window is move it 
to another part of the screen so that it doesn't overlap the main Calculator 
window. You'll be moving back and forth between the two windows, so 
it's helpful to be. able to see both at once. 
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If you have a mouse, you can move between the two windows simply 
by clicking the one you want. If you're working with the keyboard only, 
press Alt+ R (RET) to move from the statistics window to the main window. 
Press Ctrl+S to move from the main window back to the statistics window. 

To enter numbers in the statistics window, do the following: 

1. Activate the main Calculator window. 

2. Enter the number. 

3. Click the Dat button or press the Ins key. 

/ 
I 

When you have entered all the numbers you need to work with, you 
can perform the following calculations. The result is displayed in the main 
Calculator window. 

D Sum. Click the Sum button. 

a Sum of squares. Select Inv, click Sum. 

a Mean. Click Ave. 

c Mean of squares. Select Inv, click Ave. 

II Sample standard deviation. Click s. Calculator uses n-l for the 
population parameter. 

C Population standard deviation. Select Inv, click s. Calculator uses 
n for the population parameter. 

The four buttons in the statistics window do the following: 

c RET activates the main Calculator window. 

C LOAD makes the main Calculator window display the number that 
is currently selected in the statistics window. This makes it easy to 
perform arithmetic operations on particular values in the statistics 
window. 

D CD deletes the number that is currently selected from the statistics 
window. 

IJ CAD deletes all numbers from the statistics window. 
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Notepad 
Notepad is an editing program that reads and writes plain text files-files 
that contain words and numbers but no formatting information. Although 
it works with only one font and has very little formatting capability, Notepad 
is more effective for certain tasks than a full-featured word processor. It's 
quicker on screen than programs that display text in a variety of styles and 
sizes, and it's extremely easy to learn. 

The fact that Notepad creates plain text files is also a virtue under some 
circumstances. For example, Notepad is ideal for creating files that you can 
upload via modem to a bulletin board, a public e-mail service, or another 
personal computer. It's also good for creating and modifying batch files 
(such as an AUTOEXEC.BAT file) that you run at the MS-DOS command 
line, and for working with initialization (INI) files. (For more information 
about INI files, see "Modifying Private INI Files," page 164.) 

WINDOWS TIP: Unlike many other Windows-based ap­
plications, Notepad permits you to open multiple copies 
of itself. Thus, for example, you can keep one copy of 
Notepad around for logging phone conversations, another 
for tracking your to-do-list, a third for miscellaneous rumi­
nations-or whatever. If you like to work with the same 
number of Notepad files each day, consider putting multi­
ple copies of the Notepad launch icon in your Startup 
program group. 

Opening and Saving Files 
Notepad uses Windows' standard File Open, File Save, and File Save As 
dialog boxes. For information about these dialog boxes, see "Creating, 
Opening, and Saving Files," page 27. If you save a file without specifying a 
filename extension, Notepad uses the extension TXT. If you want to save a 
file with no extension at all, add a period at the end of the filename. 
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Turning Word Wrap On or Off 
Unlike full-featured word processing programs, Notepad does not automat­
ically perform word wrap. That is, when you reach the right side of the 
window, Notepad does not automatically move the insertion point to the 
beginning of the next line. 

The fact that Notepad doesn't wrap words automatically makes it 
convenient for entering program source code, but it's less convenient for 
ordinary notes and memos. To keep your lines from extending beyond the 
right side of Notepad's window, open the Edit menu and choose Word 
Wrap. To turn word wrap off again, repeat the Word Wrap command. 

NOTE: Notepad does not save the Word Wrap setting between 
sessions. Therefore, if you want to use Word Wrap, you must 
select it each time you start Notepad. 

Word Wrap is a display and· printing option. It does not affect the 
Notepad file in any way. If you .change the width of Notepad's window 
while Word Wrap is on, the lines adjust to fit the new window width. Without 
word wrap, some information might not show in the window. 

Using Notepad's Time-and-Date Stamp 
Notepad has a feature that automatically places a time-and-date stamp in a 
document every time it is opened. If you frequently use Notepad to jot down 
notes on conversations, ideas, or just changes in schedules, you can have 
the time printed above your notes. You can also use Notepad to keep a time 
log of your activities and determine the amount of time you spend at specific 
tasks. If the first line in a Notepad file consists of the characters .LOG (a 
period followed by the word LOG), then each time the file is opened, 
Notepad adds the current time and date to the end of the file. So, to keep 
a time log, you can ?O the following: 

1. Start Notepad. 

2. In the empty Notepad window that appears, type 

.LOG 

3. Choose the File menu's Save command and give your file a name. 
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Notepad is now ready to record the time and date each time the 
file is opened. 

4. Use the File menu's Open command to reopen the file you just 
saved. 

Your file reappears. Below the word .LOG, you see the current 
time and date. 

5. Below the time-and-date stamp, type a description of the task you're 
about to start. 

6. Use the File menu's Save command, and then close Notepad. 

7. When you finish your task, start Notepad again and open your file. 

Once again, Notepad adds the current time and date to the end of the 
file. You can now subtract the first time from the second to determine the 
amount of time you spent on this task. You can continue using this log file 
to time additional tasks, or you can start a new one for each task. 

WINDOWS TIP: Another way to log time usage with 
Notepad is to use the Edit menu's Time/Date command. 
Choose this command-or press its keyboard shortcut, 
F5-and Notepad types the time and date at the current 
location of the insertion point. 

WINDOWS TIP: You can use Calculator's scientific mode 
to add or subtract times expressed in hours and minutes. 
Use the inverse dms function to convert a time to decimal, 
do your calculation, and then use the dms function to 
convert the result back to hours and minutes. For more 
information about the dms function, see "Trigonometric 
Functions," page 538. 
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Using the Undo Command 
The Edit menu's Undo command reverses your last editing action in 
Notepad. For example, if you delete a paragraph and then realize that you 
meant to delete a different paragraph instead, you don't have to retype the 
one you aCcidentally deleted. Simply choose Undo (or press Ctrl+Z). 

Using the Clipboard with Notepad 
You can copy or cut any amount of Notepad text to the Clipboard, and then 
paste it into a different Notepad file or a different application. You can also 
use the Clipboard to paste unformatted text that originated in a different 
application into Notepad. 

To place a block of Notepad text on the Clipboard, start by selecting 
the block. You can do so by simply dragging the mouse over the text you 
want to select. To select with the keyboard, position the insertion point at 
the beginning of the block, hold down the Shift key, and move the insertion 
point to the end of the block. To select all of the text in a Notepad file, use 
the Edit menu's Select All command. 

After you have selected the text, use the appropriate Edit menu com­
mand. Copy puts the selection on the Clipboard without removing it from 
your file; Cut puts it on the Clipboard and deletes it from the file. 

To insert text from the Clipboard into a Notepad file, position the 
insertion point where you want the text to go. Choose Paste from the Edit 
menu, and the Clipboard text is inserted into the file before the remainder 
of the file's text. 

If you want to replace a block of Notepad text with text stored on the 
Clipboard, first select the text you want to replace. Then choose Paste. 

Searching for Text in Notepad 
The Search menu has two commands, Find and Find Next. When you choose 
Find, Notepad presents the dialog box shown on the next page. 

Type what you're looking for in the Find What text box. Choose Up 
or Down in the Direction box, depending on whether you want to search 
backward toward the beginning or forward toward the end of the file, 
starting from the insertion point. Click the Find Next button to begin the 
search. 
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Direction 
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The Find command normally ignores case-that is, it considers NEXT, 

next, and NeXT to be equivalent. If you want to limit its search to text that 
matches your string exactly, including capitalization, select the Match Case 
check box. 

Notepad's Find command does not accept wildcard characters. The 
asterisk and question mark are treated as ordinary text characters. 

After you use the Find command, you can use Find Next to search for 
the next occurrence of the same text. F3 is the keyboard shortcut for Find 
Next. 

Notepad's Printing Commands 
To print a Notepad file, choose the File menu's Print command. If you have 
Word Wrap turned on, Notepad will do its best to make the printout's line 
breaks match those of the display window. If you want your lines longer 
or shorter, adjust the window accordingly. 

To change to a different printer, choose the File menu's Print Setup 
command. The resulting dialog box, shown in the following illustration, lists 
all installed printers and offers a few other useful options as well. 

Print Setup 

f.rinter: ~1'S~Si~I~~~j~:I~"~i,~_~-~m~.'~1I~~~ ••• Il!.II!l '!??1~tDlt~;~·' 
Eorm: I Lener III If~:cilat'1T1 

2-Sided printin@-N-On-.!l.---' l~wAOt"Wi1))n 

~ 0 Long Side IrFGt!tm~1 

Orientation-------, 

@Portrait 

o Landscape o ~ortSide 

Select the printer you want to use, and then click OK. 

545 



546 

PAR T 4: Running Applications 

To change the default margins, header, or footer, choose the File 
menu's Page Setup command. You'll see the following dialog box. 

Page Setup 

Header: =I[]J=--___ ---I 

[ooler: ..... 1 P_ag_e_&_p __ --' 

Margins 
heft: 1r-.7-5----, flight: 1 ...... 7_5_---' 

lop: L-ll __ ...J H.oUom: lL-l __ ...J 

The margin values are expressed in inches. 

The header and footer boxes can use a combination of text and special 
codes recognized by Notepad (and the other accessory programs). Four of 
these codes are replaced by text when your file is printed. The codes and 
their replacements are as follows: 

&d The current date 
&t The current time 

&f The name of your file 

&p Page number 

You can use the following three codes to tell Notepad how to position 
the header and footer: 

&l Flush with the left margin 

&c Centered between the left and right margins 
&r Flush with the right margin 

The header and footer codes can be used singly or in combination. 
For example, to create a header with today's date flush left and the name 
of your file flush right, type the following in the header line: 

&l&d&r&f 

Headers and footers are centered by default. 



, ..... 

Chapter 17: Using the Desktop Accessories 

. WINDOWS TIP: If your Notepad window is maximized 
and you're printing with default margins in portrait 
orientation, Notepad might try to print more characters per 
line than your printer accommodates. The result will be a 
very ragged printout with alternating long and short lines. 
You can avoid this problem in either of two· ways: by 
choosing the Print Setup command and selecting land­
scape orientation, or by choosing the Page Setup com­
mand and decreasing the left and right margins. 
Unfortunately, the orientation and margin settings are not 
saved with a file's contents when you use the File Save 
command. Therefore, you might need to make these 
adjustments each time you print a file. 

Using Drag and Drop with 
Notepad and File Manager 
If you have File Manager and Notepad running at the same time, you can 
take advantage bf a convenient drag-and-drop feature for opening files in 
Notepad. Simply drag a file icon from a File Manager window and drop it 
onto a Notepad· window (or icon). Notepad opens your file, exactly as it 
would if you used the File Open command. This feature makes Notepad a 
convenient file viewer for plain-text files. 

Cardfile 
Cardfile is an electronic index card system. You can use it to store the kind 
of information you might have in a Rolodex, to maintain research notes for 
a project, to log telephone calls, and to do many other tasks. 

Cardfile has several features you won't find in a conventional Rolodex 
system: You can store colorful pictures as well as text on your cards, you 
can have Cardfile dial your phone (if you have a modem), and you can 
merge cards from separate Cardfile fi!es. 
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Cardfile's Display 
A Cardfile card consists of an index line and an area for notes . 

I~ 
. " -~~ ~ - ~ ~." .. ... _. - .-- --- - aal Cardfile - ADDRESS.CRD 

File .Edit View Card Search Help 
Card View IIJI!I 12 Cards 

-'Re-organizational Support Croup 
-,Procrastinate HOW! 

iorganize IT 
llnternational Pack Rat Societu 

IHappu Trails AuditinQ 
IHairshirt Health Foods. Inc. 

ICorp. for Redundant Applications. Inc. 
IColllputel" Phobics Bulletin Boal"d 

IColllpanl} Hallie Seruice 
Alllerican Soc. AQainst Ethnocentrics 
1776 U .H. Plaza 
Hew York. HY 10001 

r-
(212) 555-1492 r-

r-
r-

-
-

-
-

Cardfile automatically sorts your cards according to what's on their 
index lines, so if you're using the program to store information about people, 
you should enter their last names first. 

WINDOWS TIP: You can have more than one card with 
the same index line. When you add a card that has the 
same index line as an existing card, Cardfile inserts the 
new card in front of the existing card. 

In addition to the card view shown above, Cardfile also offers a list 
view. In list view, you see only the index lines, as shown in the illustration 
on the next page. 
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ri!r---~-s.-cR-D------aill 
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Company Name Seruice 
Computer Phobics Bulletin Board 
Corp. for Redundant Applications, Inc. 
Hairshirt Health Foods, Inc. 
Happy Trails Auditing 
International Pack Rat Society 
Organize IT 
Procrastinate NOln 
Re-Organizational Support Croup 
Society for the Elim. of Bad Abbreu. 
Sure thing Inuestments, Inc. 

12 Cards 

To switch from one view to the other, use the commands on the View 
menu. 

When you first open Cardfile, the program gives you one blank card. 
You can simply start typing information in the note area, or you can begin 
by filling out the index line. 

To fill out the index line, double-click the mouse there or press F6. 
Cardfile presents a dialog box. 

Index 

index line: 
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Type whatever you want to appear on the index line, and then click 
OK or press Enter to get back to the note area. 

Cardfile's note area can hold up to 11 lines of text. When you fill the 
card, simply start a new card. 

WINDOWS TIP: You can write notes in Notepad or an­
other Windows-based application, and then transfer them 
to Cardfile cards with the help of the Clipboard. If your 
Clipboard text exceeds Cardfile's II-line limit, however, 
Cardfile beeps and refuses the transfer. 

Starting a New Card 
To add a new card to your file, choose the Card menu's Add command-or 
press F7, its keyboard shortcut. Then type the new index line, and click OK. 
Your new card appears at the front of the stack, and remains there until you 
select a different card. When you do that, your new card is placed in its 
proper alphabetic position within the existing card stack. 

Duplicating Cards 
Should you ever need to create two or more cards that are identical except 
for minor details, you can take advantage of the Card menu's Duplicate 
command. Select the card you want to duplicate (see the information below 
about navigating in Cardfile), and then choose Duplicate from the Card 
menu. Tren select the duplicate card and ma~e whatever changes are 
needed. 

Changing a Card's Index Line 
If you need to change the index line of a duplicate card (or any other card), 
select that card, and then double-click the index line or choose the Edit 
menu's Index command. Or press F6, the keyboard shortcut for the Index 
command. With any of these techniques, Cardfile presents a dialog box in 
which you can edit the index line. 
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Another way to change an index line is to switch to list view. Then 

double-click the card whose index you want to change. Cardfile presents 
the same dialog box that you get by pressing F6. 

Navigating in Cardfile 
You can move from card to card in a number of ways. If you have a mouse 
and you can see the index line of the card you want to move to, simply 
click that index line. If you can't see the card you want or you don't have 
a mouse, here are some other methods: 

D Click the left or right arrow below the menu bar to move forward 
or backward through the card stack. 

D Press PgUp to move forward in the stack or PgDn to move 
backward. 

1:1 Switch to list view (so you can see the index lines for more cards), 
select the card you want, and then switch back to card view. 

D Choose the Search menu's Go To command or press F4, its 
keyboard shortcut. 

Go To is a search command that looks only at index lines, disregarding 
the note area of your cards. When you choose the Go To command or press 
F4, you see the following dialog box. 

Go To 

!io To: 
"--------' 

Fill out any part of the index line (even the .middle of a word, if you 
like), and Cardfile will take you to the first matching card. 

Whatever method you use to select a card, Cardfile "cuts the deck" to 
bring the selected card to the front. For example, suppose your file consists 
of cards for Campbell, Jones, Miller, Smith, and Wilson. If you select Miller, 
the Miller card comes to the front. Behind Miller are Smith and Wilson (as 
before), and behind Wilson come the cards at the front of the alphabet­
Campbell and Jones. 
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Searching for Cardfile Text 
The Go To command is fine when you're looking for a card with a particular 
(known) index line. But what if you want to find some text that's out there 
somewhere on a card-and you have no idea which card? For that purpose, 
Cardfile provides the Find command. 

The Find command is located on the Search menu. Fill out the dialog 
box, click OK, and Cardfile takes you to the first card containing the text 
you specify. To find another card that matches your search text, press F3 
(or choose the Search menu's Find Next command). 

The Find command limits its search to the cards' note areas, in contrast 
to the Go To command, which limits its search to the cards' index lines. 

Editing Cards 
To change the contents of a card, position the insertion point where you 
want to make changes, and then use the same editing techniques that you 
use in other applications for Windows. For more information, see "Entering 
and Editing Text in Documents," page 32. 

Cardfile's Edit menu has the usual Copy, Cut, and Paste commands. 
These commands make it easy to duplicate information on several cards or 
move information from one card to another. 

The Edit menu also has two commands to assist you in case you make 
changes that you regret. The Undo command reverses your last edit, and 
the Restore command reverses all changes made to the current card since 
you brought it to the front of the stack. After you move a new card to the 
front of the stack, changes you made to the previous card can no longer be 
reversed with the Restore command. 

Using Pictures 
You can put pictures as well as text on Cardfile's cards. You can do such 
things as add scanned photographs to a personnel file or clarify research 
notes with charts created in a Windows-based spreaQsheet program. 
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Any graphics information that can be stored on the Windows Clipboard 
can be pasted onto a Cardfile card. The procedure is as follows: 

1. Use a graphics program (such as Paintbrush) to create or import an 
image. 

2. Use the graphics program's Cut or Copy command to transfer the 
image to the Clipboard. 

3. Bring the card you want to use to the front of the Cardfile stack. 

4. Choose the Edit menu's Picture command. 

5. Choose the Edit menu's Paste command. 

The image appears in the upper left corner of the card's note 
area. The aspect ratio (ratio of width to height) of the original is 
preserved. 

6. Drag the image with the mouse or use the direction keys to position 
the image where you want it on the card. 

WINDOWS TIP: Cardfile accepts color as well as black­
and-white images. It also scales imported graphics to fit 
your card. However, if the original image is a large bit 
map, the scaled-down version of it might lose too much 
detail to be useful. If you have a choice between importing 
an image in a picture format (such as CGM or WMF) or 
importing it in a bit-mapped format (such as BMP or PCX), 
choOSing the picture format will give you better results. 

Graphics and text can be mixed on the same card. To annotate an 
image, for example, choose the Edit menu's Text command and begin 
typing. You can use Spacebar or Tab to move the text away from the graphic. 
Or you can switch back to Cardfile's graphics mode and use the mouse or 
keyboard to reposition the image away from the text. 
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Linking and Embedding 
Cardfile supports object linking and embedding (OLE) as a client applica­
tion. (For more information about OLE, see "Making Connections with OLE," 
page 184.) If you paste an object that was created in a program that supports 
OLE as a server application, you can establish a permanent connection to 
the source, enabling you to either edit the object more easily or have it 
updated automatically if it changes in the source application. 

In the next few pages, we'll look at the procedures for embedding and 
linking objects in Cardfile, using Paintbrush as an example of a server 
application. The techniques described apply to any OLE server, however. 
If you have a multimedia-capable system, for example, you can also link or 
embed sound objects from an OLE server program. 

Using Paste to Embed a Graphic 
If you copy an image from an OLE server application-such as the Windows 
Paintbrush program-onto the Windows Clipboard, and then you use Card­
file's Paste command to replicate the image on a Cardfile card, Windows 
treats the image as an embedded object. This means that when you double­
click the image on the Cardfile card, Windows brings the server application 
to the desktop with the image in place so you can make any changes you 
need. After you edit the image, you can use the Update command in the 
server program to send the modified image back to Cardfile. 

For example, suppose you want to create a cardfile of maps to friends' 
houses. Do the following: 

1. Create the maps in Paintbrush and use Paintbrush's Copy command 
to put a map on the Clipboard. 

2. Switch to Cardfile. 

3. Create a new card. 

4. Choose the Picture command from the Edit menu to tell Cardfile 
you want the current card to display an image instead of text. 

5. Open the Edit menu again and choose Paste. 
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After the image arrives in Cardfile, you can verify that it is an embedded 
object (as opposed to a static image) by opening ~he Edit menu once more. 
Near the bottom of the menu you see "Edit Paintbrush Picture Object" where 
there was a grayed-out "Object" before. 

Cut 
!;.opy 
Easte 
Paste bink 
Paste ~pecial ... 

CtrltX 
CtrltC 
CtrltV 

Index... F6 
Restore 

Te~ 

.JPictur.\:. 

Link ... 
Edit Paintbrush Picture Qbject 
Insert Object ... 

Now suppose you decide to change a few details on the map. If you 
double-click the image in Cardfile or choose the Edit Paintbrush Picture 
Object command from Cardfile's Edit menu, Windows brings a copy of 
Paintbrush to the desktop (a new copy if Paintbrush happens to be on the 
desktop already) and loads your original map image. 

NOTE: Before you can edit an embedded object. Cardfile must 
be in Picture mode. To put it in Picture mode, open the Edit 
menu and choose Picture. Cardfile always defaults to Text 
mode, even if it was in Picture mode when you last quit the 
program. 

After you make your changes, open Paintbrush's File menu. 

Because you're using Paintbrush to edit an embedded object, the File 
menu differs in two respects from the norma,! Paintbrush File menu. In place 
of the Save command, you see an Update command. And the Exit command 
now says "Exit & Return to" followed by the name of your Cardfile docu­
ment. 

As 'you edit your image in Paintbrush, you can pass along the changes 
to the Cardfile document by choosing the Update command. When you 
finish, you can close Paintbrush (and update the Cardfile document) by 
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choosing the Exit command. If you don't want the changes you've made to 
appear in your Cardfile document, use the Control menu's Close command 
(or double-click the Control-menu box) instead of the File menu's Exit 
command. 

Embedding an Object with 
the Insert Object Command 
The simplest way to embed an object in a Cardfile document is to copy that 
object from the OLE server application to the Clipboard, and then use 
Cardfile's Paste command. The Insert Object command on Cardfile's Edit 
menu provides an alternative method. When you choose this command, 
you see a dialog box listing all object types recognized on your system. 
Select an object type, click OK, and Windows invokes the appropriate server 
application. There you can create the document you want to embed. 

Linking an Object with Paste Linl< 
Another way to establish a connection between an image in Cardfile and 
its source is to use Cardfile's Paste Link command. Using Paste Link instead 
of Paste creates an "automatic" or "hot" link to the source application, so 
that whenever the object is changed in the source program, the changes are 
immediately reflected in Cardfile. If you prefer, you can change the link to 
a "manual" or "cold" link. In this case, changes in the source application are 
not reflected in Cardfile until you explicitly ask for them to be. 

After you paste-link an image into Cardfile, the Edit menu's Link com­
mand becomes available. Choosing Link brings up a Link dialog box. (As a 
shortcut to the Link dialog box, hold down the AIt key and double-click the 
object.) 

Link 

M~~~~~-ofl-E-Kc-el--E-X-ER-CI-SE-.X-LS---R-1C-l:-R9-C4------, 11OO'1i~1lJ 

Updale: @ l~:~i~i!!.~\!.~J 0 M.anual 

1f$-1JI'~~ IIW§1!mil 1~'11lnt"!'JI 

1~~&l11 

1,.'lti~11 

Ir.·i1\1 
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The top part of this dialog box provides information about the source 

of the linked object. Here, for example, you can see that the linked object 
is the range RICl:R9C4 in the Microsoft Excel worksheet EXERCISE.XLS. 

Changing a Hot Link to a Cold Linl<-and Vice Versa 
The Link dialog box gives you a way to change the "temperature" of a link 
from hot to cold or vice versa. Choose Automatic for a hot link or Manual 
for a cold link. If you make the link manual, changes to the linked object 
in the source document will not be reflected in Cardfile until you click the 
Update Now button. 

Editing a Linked Object 
Just as you can edit an embedded object by double-clicking it, you can also 
edit a linked object. Double-clicking a linked object, however, invokes a 
normal copy of the source application, not one with" a modified title bar 
and File menu. If your link is automatic, changes that you make in the source 

. application are immediately passed to Cardfile. If the link is manual, the 
changes don't take effect until you use the Update No~ button in Cardfile's 
Link dialog box. 

NOTE: Before you can edit a linked object or modify the link in 
any way, Cardfile must be in Picture mode. To put it in Picture 
mode, pull down the Edit menu and choose Picture. Cardfile 
always defaults to Text mode, even if it was in Picture mode 
when you last quit the program. 

WINDOWS TIP: If you don't have a mouse, you can 
invoke a linked object's source application by selecting 
the object in Cardfile, and then pressing Alt, E, O. Alterna­
tively, if you happen to be in the Link dialog box, you can 
press Alt+ E. 

Breaking the Link 
If you decide that you no longer want a linked objeCt to respond to changes 
in the source document, you can convert it to a static object. To do this, 
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select the object in your Cardfile document. Then invoke the Link dialog 
box (by holding down Alt while double-clicking, or by choosing the Edit 
menu's Link command). In the dialog box, click the Cancel Link button. 

Changing a Link 
If you move or rename the document to which a Cardfile object is linked, 
you must let Cardfile know about the change. You can do that by invoking 
the Link dialog box and clicking the Change Link button. When you do, 
you'll get a familiar-looking dialog box. 

FileName: 

allman.xls 
behrman. xis 
chess. xis 
exercise. xis 

. picks. xis 
sliders. xis 
sliders2.xls 
lml.xls 

Change link 

Qireclories: 1~~"Bl;11 
c: \ss\exceI40a 

~~~ .. -c:-\--------~;~~ I~~~&~tn 
IO-ss 
fa} excel40a 
Ltl examples 
Ltl excelcbl 
Ltllibrary 
~qe 

Lisl Files of .I.vpe: r-D_ri:!.;...e_s: _____ ~ ==== 
IMicrosofl Excel Workshllf!) IIi3 c: II!) lmr;litl~kt!~\lm 

This is simply Windows' standard File Open dialog box with a Change 
Link title bar. Find the current location or name for your source file, click 
OK, and your link will remain up-to-date. 

Controlling the Format of a 
Graphic Object with Paste Special 
By default, when you paste or paste-link a graphic object into Cardfile, you 
get the most information-rich format available. For example, if the object 
on the Clipboard came from an OLE server application and you choose 
Paste, you get an embedded (rather than a static). object. If the image on 
the Clipboard is a drawing made in Paintbrush and you choose Paste Link, 
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the image is displayed in your Cardfile document in picture format rather 
than bit-mapped format. (For more information about these terms, see 
"Viewing the Clipboard's Contents," page 176.) 

Cardfile's Paste Special command (available only in Cardfile's Picture 
mode) gives you an opportunity to override the default. When you choose 
this command, a dialog box appears listing of all the formats accessible to 
Cardfile for whatever data is currently on the Clipboard. Here, for example, 
is how this dialog box would appear if the object on the Clipboard is a 
range of cells copied from an Excel worksheet: 

Paste Special 

Source: Microsoft Excel 
R4C5 

~:=:~=l~=re~ ________________________ ~1 If~~1 

To paste or paste-link a particular format into Cardfile, choose that 
format from the list and click the appropriate command button. 

Using Cardfile to Dial the Phone 
If you have a Hayes-compatible modem, you can use the Card menu's Auto­
dial command to dial any phone number listed on the card at the front of 
your Cardfile stack. 

Before you use this feature the first time, follow these steps to set up 
the modem's speed and dialing method, the communications port you'll be 
using, and any access code you may require: 

1. Choose the Card menu's Autodial command or press FS, its keyboard 
shortcut. 

2. In the dialog box that appears, click Setup or press Alt+S. Cardfile 
presents the dialog box shown on the next page. 
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Autodial 

Humber: 1-1 ____ --' 

. Prefix: 1-19_-_-' 

o .u.se Prefix 

DialIvpe 

@ tt:~.~~J 0 Pulse 

f.ort 

@ COM1 0 COM3 

o COM2 0 COM4 

ImtfOKt~lNl 

I!l!," 
ImlWPS 

.D.aud Rate 

0110 04800 

0300 09600 

@ 1200 019200 

02400 

3. In the Dial Type box, select Tone if your telephone uses tone dialing 
or Pulse if it does not. 

4. In the Port box, select the communications port to which your 
modem is connected. 

5. In the Baud Rate box, select the speed (baud rate) at which you 
want your modem to operate. 

6. If you need to dial a preflx to get an outside line (or for some other 
purpose), enter that prefix in the Prefix box. 

7. If you will always be using the dialing prefix, check the Use Prefix 
box. Otherwise, leave it blank for now. 

8. Click the OK button. 

To dial a number, bring the card containing the phone number to the 
front of the stack. Then press F5 or choose the Card menu's Autodial 
command. Cardfile displays in a dialog box the number it proposes to dial. 

Autodial 

Humber: HtmBlI1f1flt.1tl 

Prefix: 1-19_-_-' 

o Use Prefix 
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Select the Use Prefix box if you want the prefix dialed, be sure that 
the number is correct, and then click the OK button. Cardfile dials the num­
ber and displays a message instructing you to pick up the telephone. 

If the card you're dialing from contains more than one telephone 
number, Cardfile will propose to dial the first one it finds-or the first one 
it thinks is a telephone number. If you want to dial a different number, you 
can type that number in the dialog box. Alternatively, you can select the 
number itself on the card before using the Autodial command. 

WINDOWS TIP: To ensure that Cardfile's Autodial com­
mand chooses the correct number automatically, you 
might want to type in the phone number above the ad­
dress, which might contain numbers confusing to Cardfile. 

Saving, Loading, and Merging Cardfile Files 
Cardfile's New, Open, Save, and Save As commands work the same way as 
in the other Windows desktop accessories. (For more information about 
these commands, see "Creating, Opening, and Saving Files," page 27.) Card­
file's files have the extension CRD. 

WINDOWS TIP: Because it supports OLE, Cardfile uses 
a slightly different file format from Cardfile versions 
included with Windows version 3.0 or earlier. To load a 
Cardfile file created in one of those versions, choose the 
Open command, open the file-type list box, and select 3.0 
Card File (*.CRD). 

Cardfile's File menu also has a Merge command that lets you combine 
a CRD file stored on disk with one currently in memory. Cardfile simply 
blends the two files together into a single alphabetized file. The combined 
file retains the name of the file you're currently working with. 
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Printing Cardfile Information 
You can print Cardfile information in three ways: 

D To print a single card, move that card to the front of the stack and 
choose the File menu's Print command. 

III To print all cards in a file, put Cardfile in card view (not list view). 
Then choose the File menu's Print All command. 

1:1 To print a summary consisting of only the index lines for each card 
in your file, put Cardfile in list view. Then choose the File menu's 
Print All command. 

As in Notepad and Calendar, you can switch to a different installed 
printer by choosing the Print Setup command. And you can change Cardfile's 
margins, header, or footer by using Page Setup. These commands work the 
same way in Cardfile as they do in Notepad. For more information about 
Notepad, see ",Notepad's Printing Commands," 'page 545. 

Character Map 
Character Map is a simple utility that helps you place accented letters and 
symbols in your text documents. Character Map's initial display looks like 
the following illustration. 

II Character Map a 
Eont: I ~ Arial I!!I Ch.!!.racters to Copy: ,<--___ -' Ipl:w«.~~l 
~~~~~~~~~~~~~~~~~~~~~ 1~1~~~1 

!"#$%&'()'+,-,/0123456789: ,,~>? WieRIC(~,'. 

@ ABC 0 E F G H I J K L M N 0 P Q R STU V W x y z [ \ ) A I~t~~~~ 
'abcdefghl jk Imnopqrstuvwxyz{1 }ND 

o 0 , f " ", t i • 'Io. is (p: 0 0 0 0 ' , " " • - '- • TO' S > ce 0 0 Y 
I ¢ £);( ¥ i §" @' «~- ® -. ±. , • IJ 1[, , ,o,.!4 Yz'41, 

A All A A ~ ~ ~ ~ @ ~ j f i I fl fu 0 6 6 6 0 x 0 0 0 0 0 ~ ~ ~ 
aaaaiit'ieel(eeee 1 r l' 'i afib66oo+l!IuuQ(jy~y 

In the top left corner of the window is a drop-down list in which you 
can select any font available on your system. (For more information about 
fonts, see "Working with Fonts," page 40.) Below the font list is a table 
displaying all the characters available in the chosen font. You can't change 
the size of the Character Map window (other than to minimize it), but you 



Chapter 17: Using the Desktop Accessories 

can get an enlarged view of any character by selecting it with the mouse or 
the keyboard. Here is how Character Map looks when the copyright symbol 
in the TrueType font Arial is selected: 

= Character Map II 
font: I ~ Arial Iii Ch.i!.raclers 10 Copy: ,-I ___ -----' Ir"clo,e~"'~1 

~'~"-#~$~%~&~'~(~I)~I-'~+~,~_-.~/~O~1~2~3~4~5~6~7~8~9~:~;~~~~~>~? Irldea~1 
@ABCDEFGHI'IJKLMNOPQRSTUVWXYZ[\)A _ I~~~~~~.~~I 

i" kOPY . 
• abc d e f g hili) k , m n 0 p q r stu v w x y z { I } N 0 

I 

o 0 , f ..... t :j: I r-::::-"i < CE 0 0 0 0 ' , .. .. • - r • n. S > ce 0 0 Y Ir~"'.ilelP'7~'1 
I¢(~¥:§IJ©I«~-@""':!:" 'lJlI·. '·,.%Y,'4L 

A A A A A A.lE G I~ Elf f r f) iii 6 6 6 6 6 x 0 U U 0 0 Y p B 

a Ii 11 Ii ii Ii €I! 11 /llelS e 1 r i r d n 0 6 6 6 0 ... " u u a (j y ~ 9 

The panel in the lower right corner of the Character Map window tells 
you how you can produce any character using the keyboard. For example, 
in the illustration above, the panel reads "Keystroke: AIt+0169." This means 
that if you are working on a document in a word processor and need a 
copyright symbol in the Arial font, you can do the following: 

1. Use the word processor's formatting commands to specify Arial as 
your font. 

2. Hold down the AIt key. 

3. Type 0169 on the numeric keypad. 

4. Release the AIt key. 

Note that you must type the numbers 0169 on the numeric keypad; 
the number keys at the top of your keyboard won't work.' 

If you don't want to type AIt+ key sequences, you can generate special 
characters with the help of Character Map's Select and Copy commands. 
For example, you can enter a copyright symbol in your document by doing 
the following: 

1. Be sure the Characters to Copy box (in the upper right corner of 
the Character Map window) is blank. If it is not blank, clear it by 
selecting whatever is currently there and pressing the Del key. 

2. Use the mouse or keyboard to select the copyright symbol in the 
main part of the Character Map window. 

3. Click the Select· button or pressAIt+S. 
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4. Click the Copy button or press Alt+C to copy the contents of the 
Characters to Copy box to the Clipboard. 

5. Activate your word processor and use its Paste command. 

You can use this method to copy more than one character at a time. 
Each time you click the Select button, Character Map adds the current 
character to the end of the character sequence in the Characters to Copy 
text box. 

./"<~ 
~« \J 

~ 

MOUSE TIP: Double-clicking a character in the main 
part of the Character Map window is equivalent to select­
ing the character and then clicking the Select button. 

Fonts and Character'Sets 
Most of your Windows fonts share a common character layout known as 
the eight-bit American National Standards Institute (ANSI) character set. This 
is simply a table in which each character in the font is mapped to a particular 
number from 0 through 255. In memory and on disk, the characters in your 
documents are recorded by their ANSI character-set numbers, and because 
most of your fonts use the same mapping scheme, switching a block of text 
from one font to another usually produces a change in the typeface, style, 
or size, but not a change in the characters themselves. 

You should be aware, however, that the ANSI character set used by 
most Windows fonts is not the same as the IBM PC, or extended ASCII, 
character set used by most MS-DOS-based applications. The "normal" al­
phabetic and numeric characters-the letters A through Z in uppercase and 
lowercase, the numerals 0 through 9, and the common punctuation sym­
bols-are mapped to the same character values in both the ANSI and 
extended ASCII character sets. But the two systems diverge widely for 
accented letters and other special symbols. Therefore, an Alt+key sequence 
that produces a particular symbol in your favorite MS-DOS-based applica­
tion will probably have quite a different effect in a Windows-based program. 

When you copy text to the Clipboard from most Windows-based ap­
plications, the text is stored on the Clipboard in at least two formats, called 
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Text and OEM Text. (For more information about data formats and the 
Clipboard, see "Viewing the Clipboard's Contents," page 176.) The inclusion 
of the OEM Text format, in most cases, allows you to copy symbols from a 
Windows-based application to the Clipboard, and then paste those symbols 
(unchanged) into an MS-DOS-based application. 

For example, if you copy the letter u with a circumflex accent (li) from 
Word for Windows to the Clipboard, and then paste this character into an 
MS-DOS-based application, you will still get a it in your MS-DOS-ba.sed 
program, despite the fact that this character is mapped to the value 251 in 
the ANSI character set and the value 150 in the extended ASCII set. Windows 
takes care of the translation for you. A similar conversion process takes place 
automatically when you copy text to the Clipboard from an MS-DOS-based 
program. 

Unfortunately, the extended ASCII character set includes characters 
not available in the ANSI set, and vice versa. The block-graphics characters 
in the extended ASCII character set, for example, are not available in the 
ANSI set (which is usually no great loss, because Windows is a graphical 
environment). If you attempt to copy such incompatible characters from 
one environment to the other, you will get something-but not what you 
started with. 

WINDOWS TIP: If you use Character Map to compare 
the character sets of your various Windows fonts, you will 
find some differences in the fourth row of the Character 
Map table. In most non-TrueType fonts, the values in this 
portion of the character set are undefined. (Character Map 
uses either a solid vertical bar or an open square to indicate 
an undefined character value.) In most TrueType fonts, 
many values in the fourth row have been assigned to useful 
symbols, such as true typographic quotation marks, em 
and en dashes, and an ellipSiS. You might want to use 
these TrueType characters occaSionally, even if the docu­
ment you're creating is based primarily on non-TrueType 
fonts. 
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The Symbol Font 
In addition to the Wingdings "dingbat" font, Windows' NT includes one other 
TrueType font that does not use the ANSI character set. That font, called 
Symbol, includes the Greek alphabet, the four standard card-suit symbols, 
plus a variety of other mathematical, logical, chemical, and business sym­
bols. The following illustration shows what's available in the Symbol font. 

11 Character Map II 
Eonl: 11QIiJ1ffl\!TH I!J Ch~raclers 10 Cop,: ...... , ___ --' 1~i;"Cl()$11t~"1 

rT" -V~#T3'r.-.~&T3~(~)~*~+~,~_~·'. -/~O~I'-2~3T4'-5~6T7'-8~9T:~;~<~=~>~ 1[I~ea~1 
~ A B X A E 1> r H I Q. K A M Non ® P l: T Y ~ 0 !! '¥ Z [ :. J 1. - Ir;l"t'OP,"'l"l 
a:~xo EiP'Yl1 tql1CA ~vollepO'1:U1:ilc.J~1VC;; {I} NO 

o 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1~1;Rifp11't'\'1 
o "( . 5 I (X) 1 of, • ., ... Bf- t ~,J, • ± .. ~ x 0:: a • + .. = " ... II-.J 
~~Wp0~0nv~~~ccE~Lv@©~n~'~Av~en~U 

<>(®@'''r(1 ~rllr! Llo)I rlJII)lIJl fJo 

Some of the characters in the bottom row of this character set are 
meant to be combined with one another in an over-and-under fashion. The 
tenth and twelfth characters from the right in the bottom row, for example, 
can be assembled to produce a large integral symbol. 

Sound Recorder 
Sound Recorder is a utility that lets you record, edit, and play sound files 
in waveform format. You can also use it to provide sound annotations for 
documents created in programs that support object linking and embedding 
(OLE) as client applications. (For more information about OLE, see "Making 
Connections with OLE," page 184.) Before you can use Sound Recorder, 
your computer must include audio hardware, and you must have installed 
a driver appropriate for that hardware. For information about installing 
sound drivers, see "Installing Drivers," page 163 .. 

Sound Recorder's display, shown on the next page, looks somewhat 
like a tape recorder with a built-in oscilloscope. 

You can operate the buttons by clicking on them with the mouse, or 
you can tab to them with the keyboard and press Enter when the button 
you want to use is highlighted. 
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111 Sound Recorder - PREZ.WAV II 
file fdit Effect,!i Help 

The two-headed arrow buttons in the lower left corner are rewind and 
fast-forward controls, respectively. The single-headed arrow is the play 
button, the square is the stop button, and the microphone icon at the right 
is the record button. 

Windows NT includes a few sample sound files, all of which have the 
extension W A V. To listen to these files, choose Sound Recorder's Open com­
mand from the File menu, and then click the play button. As the sound is 
played, the scroll box moves from left to right across the scroll bar, and the 
oscilloscope display gives you a visual representation of the sound. 

To record a new sound file, use the File menu's New command. Then 
click the record button and begin speaking into your microphone. Unlike 
most tape recorders, Sound Recorder doesn't require you to press two 
buttons at once to begin recording. As soon as you click the microphone 
button, Sound Recorder is in recording mode. You can record up to a 
minute's worth of sound. When you finish, use the File menu's Save com­
mand and supply a filename. 

You can embed a sound file in any application that supports object 
linking and embedding as a client program. To do so, follow these steps: 

1. Open or record the file you want to embed. 

2. Use Sound Recorder's Copy command to put the sound data on the 
Clipboard. 

3. Activate the application into which you want to embed the sound 
(the client application). 

4. Put the cursor where you want the sound file to be embedded. Then 
use the client program's Paste command. 
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In the client document, the embedded sound file is displayed as a 
small microphone icon. To play the sound, double-click the icon. 

Editing Sound Files 
Sound Recorder's Edit menu has six editing commands, in addition to the 
Copy command. 

Easte Insert 
Paste Mi~ 

Insert File ... 
Mix with File ... 

Delete f!efore Current Position 
Delete After Current Position 

Ctrl+V 

The Insert File and Mix with File commands allow you to combine 
two or more sound files. To use either command, first use the scroll arrows 
to position the scroll box at the point in the current file where you want 
the incoming file to appear. The Position indicator to the left of the oscillo­
scope display will help you find the appropriate spot. 

The Insert File command adds a sound file at the current location and 
moves the remainder of the file forward. The Mix with File command 
superimposes the incoming sound file on whatever sound data is already 
at the current location. 

The Paste Insert and Paste Mix commands combine sounds in a similar 
manner, except that they use the Clipboard as their source instead of a file. 

The last two commands on the Edit menu simply delete data from the 
current location to the beginning or end of the file. 

You can also edit a sound file with commands on the Effects menu, 
shown on the next page. 

These commands actually change the sound data that makes up your 
file, not merely the playback mode. For example, if you increase the speed 
of a file and then use the Save command, the file plays at the increased 
speed each time you open it. 
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Increase Speed [by 1 ~O%) 
D~crease Speed 

Add Echo 
Reverse 

Chat is a simple utility that allows you to exchange messages in real time 
with another user in your domain or workgroup. Conversing with Chat is 
like talking on the phone, except that you use your keyboard instead of 
your voice. 

When you double-click the Chat icon, a simple window divided into 
two panes appears, similar to this: 

Chat 

After you establish a connection, everything you type or paste (with 
Ctr1+V or the Edit Paste command) appears in the top pane of your Chat 
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window and simultaneously in the lower pane of the other user's Chat win­
dow-and vice versa. If you want, you can use the Options menu's Prefer­
ences command to change the window so that the space is split vertically 
instead of horizontally. 

Dialing 
To initiate a Chat session, click the Dial tool (the leftmost tool on the Chat 
window's toolbar). Or choose the Dial command from Chat's Conversation 
menu. A network browser dialog box appears, similar to the following: 

komputer: II:-' __________ ---' 

~elect Computer: 

iJADMINISTRATION 
- DOCUMENTATION 

AC6.DIA 
< BADlANDS 

BIG BEND 
BRYCE C6.NYON 
DENALI 

, GREAT BASIN 
. ROCKY MOUNTAIN 

Select the name of the computer whose user you want to chat with, 
and then click OK. 

Windows NT launches Chat as an icon on the selected user's computer, 
if Chat is not already running, and alerts the user by sounding the computer's 
speaker. He or she can then "answer the phone" by double-clicking the 
Chat icon. 

Answering the Phone 
When you receive a Chat call, your speaker beeps. (It doesn't beep if you've 
turned off that form of notification. See "Options," below.) If your copy of 
Chat isn't running, Windows NT launches it as an icon. You'll see an image 
of a telephone with its receiver bouncing in the hook. To "answer the 
phone," double-click the icon. Then begin typing to "talk" to your caller. 
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If Chat is running in an open window when another user calls you, 
Chat's title bar flashes to alert you to the incoming call. To pick up the phone 
in this case, click the Answer tool (the middle icon) on the toolbar. Or 
choose the Answer command from Chat's Conversation menu. 

Hanging Up 
When you're finished chatting, click the Hang Up tool (the rightmost icon 
on the toolbar). Or choose the Hang Up command from Chat's Conversation 
menu . 

. Options 
You can use the Font command on Chat's Options menu to change the font 
you use when you type. By default, this is the font that your chat partner 
sees. So if you want to be emphatic, choose a large and bold font. (If your 
partner does not have your font on his or her computer, Chat will use the 
available font nearest in style to your choice.) Your partner may elect to 
ignore your emphatic font, however, by choosing Preferences from the 
Options menu and selecting the Use Own Font option button. You can do 
the same on YOl.ir end if you don't care for the font your chat partner is 
inflicting on you. 

Other commands on the Options menu allow you to suppress the 
display of the toolbar and status line, and to turn off the sound. The sound 
option is particularly useful at times when you don't want to be interrupted. 
If you're working in a maximized window when someone tries to "chat you 
up," you won't even know there's a call coming in if you've turned off the 
sound. 

WINDOWS TIP: If you think silence is golden, but you 
still want to be available for Chat sessions, choose the 
Always on Top command from Chat's Control menu. Then 
close Chat. When someone calls, the Chat icon appears at 
the bottom of your screen, even if you're working in a 
maximized window. 
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Starting a Command Prompt Session 
Start as many command prompt sessions as you want ... 

Ending a Command Prompt Session 
... and end them with a double click. 

Controlling the Command Prompt Window 

t 
m~:; • , . 

A command prompt window is merely an application window like any 
other. You can control its color, size, and other attributes with the Control 
menu. 

Using the Command Prompt 
Running programs from a Windows NT command prompt works almost 
the same as running programs from other command-prompt operating 
systems, but you'll find a few interesting new tricks and features. 

Understanding File Systems and Filenames 
If you're used to MS-DOS, you'll be pleasantly surprised at new Windows 
NT features such as long filenames and better handling of wildcards. 

t 
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Using Command Symbols 
Windows NT lets you use special symbols to combine several commands 
onto a single command line-and determine which commands get exe­
cuted and in which order. 

Using Windows NT Commands 
Whether you're looking at a directory listing or finding strings in a text 
file, Windows NT has some surprising new features-a few little things 
to make your life easier. 

Using Network Commands 
You can handle all your network tasks from File Manager, Print Manager, 
and other utilities, but sometimes a command line provides the fastest 
way to connect to a shared drive or to perform some other network task. 
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indows NT offers two very different but compatible 
., " , modes of working. You can take the newer route with 

the easy-to-use, point-and-click graphical user interface of Program Man­
ager, File Manager, and other Windows-based programs. Or you can choose 
the old-fashioned way, using the efficient but cryptic command prompt 
interface. The real power users will combine the best of both worlds. 

Windows-based graphical interface programs have some advantages 
over MS-DOS-based programs. Windows-based programs provide a very 
intuitive approach to working with data-for example, you can move a file 
or a piece of data by physically moving it on the screen. Pointing and clicking 
is also much easier than learning command-line syntax. On the other hand, 
the MS-DOS command line is undoubtedly the fastest way to work when 
you know exactly where you are and what you are doing. For many expe­
rienced computer users, typing at the command prompt gives a feeling of 
control and power that they don't experience when running Windows-based 
programs. 

Unlike MS-DOS, Windows NT offers multiple command prompts, each 
in its own separate session and protected from any failures that might occur 
in other sessions. Unlike Windows 3.1, Windows NT allows you to run other 
types of programs from the command prompt in addition to MS-DOS-based 
programs. For example, you can run any program for Windows NT, Win­
dows 3.1, OS/2 version l.x, or POSIX. In addition, Windows NT command 
prompt sessions have many enhancements not available in MS-DOS or 
Windows 3.l. 

If you're willing to invest the time to learn how to use it (or if you 
have already invested the time), the Windows NT command prompt offers 
the fastest way to work with your programs. On the other hand, using the 
command prompt is never required in Windows NT; if you hate typing 
convoluted command lines, feel free to skip this chapter. 

Whole books have been written about working from the command 
prompt. We can't possibly cover the entire subject in one chapter, but if 
you're still reading, you probably aren't starting at ground zero. Therefore, 
we'll assume that you have used MS-DOS or some other command-line 
operating system, and we'll concentrate on the new features that make 
Windows NT more powerful than MS-DOS. 
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Starting a Command Prompt Session 
To start a command prompt session, double-click the Command Prompt 
icon in Program Manager. (The Windows NT Setup program puts the Com­
mand Prompt icon in the Main group, but you can copy or move the icon 
to any group you like. For example, you might want to put a copy of the 
Command Prompt icon in the Startup group so that it starts every time you 
log on.) After you start a command prompt session, you can leave it running 
in the background while you work on other tasks. If it takes up too much 
screen real estate, simply minimize it. 

" If you click the Command Prompt icon in Program Manager and then 
choose Properties from the File menu, you can see what makes a command 
prompt session tick. The Command Line entry in the Properties dialog box 
shows the name of the program that Windows runs when you double-click 
the Command Prompt icon-CMD.EXE. CMD.EXE is a command inter­
preter (called a command shell in some operating systems). Its primary 
functions are to display the command prompt and to read, interpret, and 
execute what you enter at the prompt. Double-clicking the Command 
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Prompt icon is the usual way to run CMD.EXE, but you can also run it the 
same way you would any other program-by choosing Run from the File 
menu in File Manager or Program Manager. 

CMD~EXE Versus COMM~ND.COM Ii 
P 

CMD.EXE is to Windows NT what COMMAND.COM is to MS-
DOS. Note that COMMAND.COM is part of MS-DOS, not part of 
Windows. This is an important difference. Under Windows 3.1 a 
command prompt session looks and acts like MS-DOS because 
it is MS-DOS. Under Windows NT, a command prompt session 
may look and act like MS-DOS, but it is actually a far more Ii 
powerful command interpreter capable of running programs II 
from multiple operating systems. 

I: 

WINDOWS TIP: You can open additional command 
prompt windows from the command prompt. For exam­
ple, you might want to open another command prompt 
window to see two directories or to see different tasks in 
side-by-side windows. To open another command prompt 
window, type start or start cmd at the command prompt. 
(If you type cmd without start, you probably won't get the 
results you expect.) For more information about the Start 
command, see "Launching Programs," page 595. 

Ending a Command Prompt Session 
When the command prompt is active, you can end a command prompt 
session in any of the following ways: 

IJ Double-click the Control-menu box. 

IJ Press Alt+ F4. 

; 
.; 

. 

; 
i 

I, 

I 
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r:I Select Close from the command prompt window's Control menu. 

II Type exit at the command prompt. 

If you are running a character-based program in the command prompt 
window, you should terminate the program through its normal exit com­
mand before attempting to close the window. However, if you are sure the 
program doesn't have any unsaved files, you can safely and qUickly close 

I 

it using one of the first three methods listed above. A dialog box appears 
asking if you really want to terminate the program. Click OK. 

C:\BIN\M.EXE 

This Windows application cannot respond to the End Task. 
request. It may be busy, waiting for a response from you, 
or it may have stopped eKecuting. 

o Press Cancel to cancel and return to Windows NT. 

o Press End Task. to close this application immediately. 
You will lose any unsaved information in this application. 

o Press Wait to give the application 20 seconds to finish 
what it is doing and then try to close the application 
again. 

Unfortunately, some programs can fail in a way that breaks their 
normal termination mechanism. You can't quit in the normal way and you 
can't keep running. In operating systems less protected than Windows NT, 
such programs can cause problems for the whole system. This is particularly 
true of programs for MS-DOS, each of which believes it is the only program 
in the system. Windows 3.1 makes valiant efforts to harness rude programs, 
but experienced Windows users can always cite instances of MS-DOS-based 
programs crashing the system. Windows NT, however, really is in control. 
It can't make bad programs behave themselves, but it can send them to bed 
without any supper. 

You can terminate a program that is out of control in the same way 
you terminate a command prompt session-by double-clicking the Control­
menu box and then clicking OK in the dialog box that appears. Another 
method is to choose Settings from the Control menu, and then click the 
Terminate button. This brings up a message box with a warning about the 
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. terrible things that might happen to unsaved program data if you continue. 
Unfortunately, on the rare occasions when you need to use this option, 
those terrible things have most likely happened already and you have no 
choice but to click OK. Just be sure your program has really failed before 
you submit. When you end a program this way, the command prompt 
session in which it is running is also terminated. 

WINDOWS TIP: With Windows 3.1, you can terminate a 
failed program by pressing Ctrl + Alt+ Del. This doesn't work 
with Windows NT. Instead, a dialog box appears that gives 
you several choices, including logging off, shutting down, 
or going to the Task List. If you click the Task List button 
(or press Ctrl+Esc at any time), you can select the program 
you want to kill and click the End Task button. But be 
careful! You won't see any dire warning message. It's up 
to you to be sure there's no hope for your program. 

Controlling the 
Command Prompt Window 

Before we get into the real purpose of a command prompt window-to 
enter command lines-let's look briefly at the window itself. Like most 
application windows, the command prompt window allows you to set op­
tions and execute commands through selections on its Control menu. 

Restore 
Move 
liize 
Minimize 
Ma~imize 

~Iose 

Switch To ... CtrltEsc 
I 

Settings ... Cop~ Enter I 
Eonts ... Easte 
Screen Siz.e And Position ... Scroll 
Screen CQlors ... 
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The firstseveral commands on the command prompt window's Control 
menu are the same as those in other application windows-Restore, Move, 
Size, and so on. For more information about these commands, see "Working 
with Windows," page ·11. The selections near the bottom of the menu 
(beginning with· Edit) are the commands and options unique to command 
prompt windows. 

The ellipses after the menu commands indicate that they bring up 
dialog boxes with options for you to select. Each command brings up a 
slightly different dialog box, but all of the dialog boxes have a Save Con­
figuration check box. Be sure to select this check box if you want to make 
your settings effective every time you start a command prompt session. If 
you don't save the configuration, your changes affect only the current com­
mand prompt session, and your previously stored configuration applies the 
next time you start a session. 

Window settings are saved based on the title of the program window. 
If you start a command prompt window from an icon, the icon title deter­
mines the window title. If you set up multiple icons with different titles or 
set up icons for specific character-based programs, each icon has its own 
settings. You can set the ·window title of a program controlled by a PIF with 
the Window Title field of PIF Editor. (For more information about PIF Editor, 
see "Using Program Information Files," page 670.) The Start command also 
allows you to set the window title for a program. (For more information 
about the Start .command, see "Launching Programs," page 595.) 

Copying and Pasting 
You can copy text from a command prompt window to the Clipboard and 
then paste it into other applications. You can also paste text from the 
Clipboard to the command prompt or to a character-based program. For 
example, you might want to paste a list of files from a directory listing into 
Notepad or into a character-based text editor in another command prompt 
window. 

For information about how to copy and paste text, see "Using the 
Clipboard with Non-Windows-Based Applications," page 171. 
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Setting the Display Mode 
On x86-based computers, command prompt sessions can run in a window, 
or they can run full-screen. To switch between these two modes, press 
Alt+Enter. When running full-screen, press Alt+Esc or Ctrl+Esc to switch to 
another application. When you make the switch, the full-screen command 
prompt session appears as an icon on the Windows desktop. Click the icon 
once to pop up its Control menu, or double-click it to switch back to the 
full-screen command prompt session. 

By default, Windows NT opens command prompt sessions in win­
dowed mode. To change the default so that command prompt sessions open 
in full-screen mode, open a command prompt window and select Settings 
from the Control menu. The following dialog box appears . 

• Illlitill •• :' .. 111 • 

o RuickEdit Mode 

[g] !li~y.:~::~~:~ng~i~~l:Q~) 

IrrtfK71 

IrEa~e1?1 

Click the Full Screen option button, be sure the Save Configuration 
check box is selected, and click OK. 

NOTE: On RiSe-based computers, the dialog box does not have 
a Display Options group because command prompt sessions 
always run in a window. 

Customizing the Window's Appearance 
You can customize the appearance of a command prompt window in several 
ways: You can change its size, select a font, even use eye-pleasing colors. 
And you can save these settings independently for each program item that 
launches a command prompt session, so you can make appropriate settings 
for different tasks. 
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Setting the Window Size and Position 
To change the screen position where any new command prompt window 
appears, move the current session's window to the desired position and 
then choose Screen Size and Position from the Control menu. You'll see a 
dialog box like this: 

Screen Buffer Size 

Width: Urt) 
Height: ~Iil 

[8] Save ~creen Buffer Size 

[8] Save Window Size and Position 

Be sure the Save Window Size and Position check box is selected and 
then click OK. 

Windows NT also lets' you change the size of the "virtual screen" that 
is displayed in a command prompt window. To change the number of 
columns and rows, choose the Screen Size and Position command and set 
the number of columns and ro~s .. 

KEYBOARD TIP: You can set the number of columns 
and rows for the command prompt window using the 
Mode command at the command prompt. For ex~mple, to 
set the screen size to 85 columns and 55 lines, type the 
following at the command prompt: 

C:\>mode con:cols=85 lines=55 

For more information about the Mode command, ,see 
"Mode" in the online Command Ref~rence Help. 
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How Programs Handle 
Unusual Screen-Size Settings 

Changing the size of the command prompt window's virtual 
screen will not necessarily affect the size of the screen when you 
run programs. Many programs are written to use a particular 
screen size. When you start a program that knows how to use 
only an 80x25 screen, the size of the command prompt window 
automatically adjusts to 80x25. More sophisticated programs 
check the screen size when they start and try to run at the same 
size. However, many programs for MS-DOS and OS/2 can run 
only in certain sizes. For example, the Edit program supplied with 
Windows NT knows how to run only 80X25, 80x43, or 80x50. If 
you set the window to an odd size, such as 90x32, Edit adjusts 
the window to the nearest size it understands-80x25. 

Character-based programs for Windows NT can recognize any 
screen size (although there is no guarantee that a particular 
program will be written to do so). For example, the command 
interpreter recognizes and adjusts to any screen size. From a 
command prompt window, try changing the screen width to 
various unusual sizes such as 140 or 60 and then type dir /w. The 
command interpreter uses the screen width to figure out how 
many full columns of filenames can be displayed on the screen 
and adjusts accordingly. 

Selecting a Font Size 
The size of your command prompt window depends on the number of rows 
and columns you select, and on the size of each character-the font. To 
modify the character size (and thus the window size), choose Fonts from 
the command prompt window's Control menu. The Font Selection dialog 
box appears, as shown on the next page. 
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[onl 
4 X 6 ~. 

5 X 12 
6 X 8 
7 X 12 
8 X 8 

10 X 18 
12 X 16 
16 X 8 !if 

Font Selection 

Window Preview 

I '~'t\\1'1lIs~~t1811 
Im:~in~&;rt!'11 

[8J ~ave Configura lion 

Selecled Fonl-----------------, 

C:,IIlHHT> dh­
Dh-cctol-Y of C:,IIIHHI 
~~~.rEM _~ •• <DIR~ ____ ~~-~~-2~ ~:~~a 

Each characler is: 
8 screen pixels wide 

12 screen pixels high 

When you select a size in the Font list box, a sample· of the selected 
font appears at the bottom of the dialog box. The Window Preview section 
shows the relative size of the command prompt window compared to the 
full screen. When you are happy with your selection, click OK. 

To find the best display for your work style, experiment by setting 
different sizes in the Font Selection dialog box, and different window 
heights and widths in the Screen Size and Position dialog box. If you want 
to get as much data as possible in the window, choose one of the smaller 
fonts and set a large height and width. If readability is more important, 
choose fewer columns and rows and a larger font. For information about 
changing the number of columns and rows in the command prompt win­
dow, see "Setting the Window Size and Position," page 582. 

Setting Screen Colors 
You can set the color of the text and background of the command prompt 
window. You can also set the color of the text and background of pop-up 
windows that originate from the command prompt, such as the command 
history. (For more information about the command history, see "Editing the 
Command Line," page 588.) 

To set screen colors, choose Screen Colors from the command prompt 
window's Control menu. The dialog box shown on the next page appears. 

Select the option button for the item you want to set, and then select 
the color you want. The boxes at the bottom of the dialog box show you 
how your colors look. When you are happy with your selections, click OK. 
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Screen Colors 

o Screen I.ext 

o Screen Jtackground 

@ le.~.p.:~.p':J:~.~.~J 
o Popyp Background 

'Selected Screen Colors 

1111111 

I f~'~']jK~'7~~'1 
I F:'Cancel":,:1 

[g] ~aye Configuration 

, S elected PopuP Colors­

C:\WINNT> dir 
Directory of C:\WIN 
~Y~TFM <nlR) 

Using the Command Prompt 
At first glance, running programs from the Windows NT command prompt 
might seem the same as running programs from the command prompt of 
any other operating system. MS-DOS, OS/2, UNIX-if you've seen one, 
you've seen them all. Every operating system has a command to delete files, 
another to display lists of files, another to copy files, and so on. The names 
and details may be different, but it's the same cast of characters. 

Actually, Windows NT has some interesting differences. We'll concen­
trate on these, rather than giving a blow-by-blow account of all the com­
mands available. 

Getting Help 
The first thing you need to know about using the command prompt is how 
to get help. You can get help on any command-line program or internal 

. command supplied with Windows NT in two ways. You can: 

Il Type the name of the command followed by I?~ For example, 

C:\)dir 17 

Il Type help followed by the name of the program. For example, 

C:\)help dir 
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Either method brings up exactly the same help screen showing the 
command followed by its argument syntax. Let's take the Tree command as 
an example: 

The first line gives you a short description of the command. The next 
line shows the command syntax. The command is given in uppercase 
followed by the arguments. Optional arguments are enclosed in square 
brackets. Most commands have options, which consist of the slash character 
followed by a letter. The meaning of the options and any other arguments 
that aren't obvious from their names is displayed below the command 
syntax. 

If this terse form of help is not enough, you can get full details on all 
Windows NT commands from a Windows NT help file. To open the help 
file, double-click the Windows NT Help icon (the yellow question mark) in 
the Main group of Program Manager. Or type: 

C:\)start winhlp32 c:\windows\system32\ntcmds.hlp 

The location of your help file might be different, depending on how you 
set up Windows NT. You'll soon find that you don't need full help very 
often. After you get used to the way commands work, the simple command­
line help will be enough. 

You can also type help with no arguments to get a list of the internal 
commands and system utilities provided with Windows NT. 
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If you're a UNIX user trying out Windows NT, you'll probably 
feel partly at home and partly lost. Most of the commands have 
different names, but somehow they seem familiar. Most 
commands have fewer options than you're used to, and it might 
take you a while to figure out that almost nothing is case-sensitive. 
The directory structure looks the same, but the directory separator 
is a backslash (\) instead of a slash (/). Command-line options 
start with a slash instead of a dash (-), except sometimes· they 
can start with either, and occasionally you'll find a converted 
UNIX program that recognizes only the dash. You'll be shocked 
at filename limitations (eight-character base, three-character 
extension), until you realize that this is only for compatibility and 
you can set up your disk to allow long filenames. If you're a UNIX 
script-file guru, you'll be amazed and amused at the crudeness 
of the Windows NT batch language. 

The Windows NT command prompt interface simply isn't as 
complicated or complex as UNIX, but it's much easier to learn. 
You'll have no trouble picking it up. To get you started, here's a 
list of some of the most common UNIX commands with their 
rough Windows NT equivalents. 

UNIX Windows NT UNIX Windows NT 

cat type grep find, findstr 

Is dir diff fc, camp 
. fIll del chmode attrib 
cp copy, xcopy cd, md, rd cd, md, rd 

mv move, ren more more 

If you try Windows NT and still don't like the command prompt 
interface, don't give up~ Several vendors sell converted UNIX 
command interpreters with all the familiar UNIX utilities. With 
one of these, you can enjoy the terse UNIX syntax and powerful 
script language while still getting the benefits of Windows NT. . 

[1 
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WINDOWS riP: The practice of providing syntax help 
for command-line utilities was common long before Micro­
soft made it standard for MS-DOS and Windows NT. Be­
cause this convention evolved naturally, other software 
vendors don't always do things quite the same way as 
MiCrosoft. Some programs use /h instead of /? as their help 
option. Some programs recognize both a dash (-) and a 
slash (j) as the first character of command-line options. A 
few programs, mostly converted UNIX-based programs, 
recognize only a dash. Many programs display help 
automatically if you enter arguments incorrectly or fail to 
give arguments for a program that requires them. 

Editing the Command Line 
When working on a command line, you frequently have to enter the same 
command several times, or enter several similar commands. If you make a 
mistake when typing a command line, you don't want to retype the whole 
thing-just fix the part that was wrong. Windows NT makes it easy to recall 
previous commands and edit them on the current command line. 

The Windows NT features for command-line editing and recall are 
similar to the ones provided by the Doskey utility in recent versions of 
MS-DOS (5.0 and later). Although Doskey is familiar to most MS-DOS users, 
Windows NT command-line editing has some interesting new features, as 
'we'll see. 

Command-line editing works the way you might expect. The Left and 
Right direction keys move the cursor left and right. The Ins key toggles 
between insert and overwrite modes. The Del key deletes the character at 
the cursor, ana the Backspace key deletes the character to the left of the 
cursor. It's no different than editing on a single line in most text editors. 
Table 18-1 shows the editing keys and what· they do. 
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Up 

Down 

PgUp 
PgDn 

Left 

Right 

Ctrl+Right 

Ctr1+Left 

Home 

End 

Esc 
F6 
F7 

F8 

F9 
Alt+F7 

"", 

Recalls the previous command 

Recalls the next command 

Recalls the earliest command used in this session 

Recalls the most recent command used 

Moves left one character 

Moves right one character 

Moves right one word 

Moves left one word 

Moves to the beginning of the line 

Moves to the end of the line 

Clears the current command 

Inserts an end-of-file character (Ctr1+Z) 

Displays the command history in a scrollable pop-up box 

Displays commands that start with characters currently on 
the command line 

Prompts for the number of the command to execute 

Clears the command history 

" " .. 

TABLE 18-1. 

Command-line editing keys. 

The command-line recall feature works by keeping a history of the 
commands entered during the command session. You use the Up and Down 
direction keys to move back and forth to the command you want. You can 
see how the command history works by pressing the F7 key. A window 
pops up, showing commands you have recently entered. You can scroll 
through the history with the direction keys to select the command you want. 
Some users form a mental picture of the command history and find it easier 
to use the Up and Down direction keys at the command prompt. Others 
prefer using F7 to bring up the pop-up window. 

The F8 key provides a useful alternative to the Up direction key. The 
Up key moves you through the commands to the top of the command buffer 
and then stops. The F8 key does the same, except that when you get to the 
top of the buffer it cycles back to the bottom. Furthermore, F8 does com­
mand completion. Type d at the command prompt (don't press Enter) and 
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then press F8 a few times. You'll cycle through recently entered commands 
that start with d, such Dir and Del. Now type e (after the d) and press F8 
a few more times. You'll cycle through Del commands along with any others 
·that start with de. You can save a lot of keystrokes with F8 if you know the 
first letters of the command you're looking for. 

:~~: .• ·.~·'··.·.·.I·rhpr~~ihg· •. 6~~th~·.M~~··[)bS· •.• [)()Skey.'·CQ..rlmqnd;.·.,:.· .. \{··I·ir.·.··:.· 
,:,.~:,."{,M~~:...;...S.~,~~~,,i. .... ~ ...... ""'::..""'~;""~,,~-:;.~~~""i.""-.:,.~~,,~,-«..::;,"0:.."':;, .... ~~:,w,:<.w~:,.-i:::..".i.;:,:.;:.",:,~"'~.t",<.,.",,:;,,<--\"'~'.:;..\~"'i.:.:..""""@..:~,*',,~:,,~:,::,;,~,~::«~*,"~\-,:~;.,\..M(, .... '~,".:,.'*"%~,;..;,.~"'~:;,,"~~"~~"'J..,,,'.: .. ~~""',:~'v.,~~:..~"'~..i. .. ,:...m.:.&~,.,,~,~~,~"""'....,:"""'''';,~'''\..\, 

In MS-DOS, F7 displays a list of recent commands, but not in a 
scrollable pop-up window. You can look at a numbered list of 
commands and then use F9 to enter the number of the command 
you want. F9 is also available in Windows NT for entering a 
command by number, but you probably won't need it because 
the' pop-up window provides the same feature in a more 
convenient form. 

In MS-DOS, you can use Doskey's /BUFSIZE option to specify 
how much memory is allotted for storing the command history. 
Because Windows NT has virtually unlimited memory, setting 
memory size doesn't make much sense. Instead, you can set the 
maximum number of commands to store with the /LISTSIZE 
option. For example, you might set the list size to 20 if you think 
that anything beyond the previous 20 commands is unlikely to 
be useful. 

Running All Kinds of Programs 
Windows NT runs several different kinds of programs seamlessly,so you 
don't need to know a program's origin or type in order to run it. If it's on 
your disk, simply type its name (and path, if needed) followed by any 
parameters. It should run with no questions asked. 

If you're accustomed to Windows 3.1, the following words will be 
familiar: "This program requires Microsoft Windows." Windows NT auto­
matically detects your program's native environment and adapts to it, so 
you'll never ~ee this bothersome message again. 
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Windows NT can run the following kinds of programs from the com-

mand prompt: 

C Graphics-based programs for Windows NT 

C Graphics-based programs for Windows 3.1 

II Graphics-based programs for MS-DOS 

13 Character-based programs for Windows NT 

C Character-based programs for POSIX (a subset of UNIX) 

C 16-bit character-based programs for OS/2 

[J Character-based programs for MS-DOS 

We'll look at the graphics-based programs first, and then the charac­
ter-based programs. 

Graphics-Based Programs for Windows and Windows NT 
Among the graphics-based programs, Windows NT-based applications run 
the best because they can take advantage of all the sophisticated features 
of Windows NT. The problem might be in finding them. This book is being 
published shortly after the release of Windows NT, when it's not entirely 
clear how the operating system will evolve. By the time you read this, things 
might have cleared up, but if you're an early adopter, here are some com­
ments on what you may find in the early days of Windows NT. 

A new operating system always has the proverbial chicken-and-egg 
problem-people won't write programs for it until it is in wide use, but it 
won't be in wide use until people write programs for it. Microsoft tried to 
minimize this problem in two ways: Programs written for Windows 3.1 run 
unchanged under Windows NT, and software developers can easily convert 
their Windows-based programs to native Windows NT-based programs. 
Because Microsoft provided programming tools for creating Windows NT­
based programs long before its release, Windows NT is starting life with 
more native applications than most new operating systems. However, your 
favorite Windows-based program may not be among them. 

When you see a program running on someone else's Windows NT 
computer, you probably won't be able to tell whether it was written for 
Windows NT or Windows 3.1. However, the user probably knows. If it was 
written for Windows 3.1, it runs slightly slower under Windows NT than if 
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it were running under Windows 3.1. On the other hand, if it's a native 
Windows NT-based program, it probably runs faster than a comparable 
Windows-based program running under Windows 3.1. 

Applications for Windows NT can take advantage of new operating­
system features such as multi-threading, interprocess communications, and 
enhanced security. At first, many'Windows NT-based programs might not 
have these new features. Windows NT-based programs will often look and 
work exactly like their Windows-based counterparts because it is easy to 
create such programs quickly. But you will begin to see more programs 
with Windows NT's advanced features as developers integrate these features 
into their programs. 

Graphics-Based Programs for MS-DOS 
Graphics-based programs for MS-DOS run under Windows NT. On x86-
based computers, they run only in full-screen mode. When a program for 
MS-DOS switches into a graphics mode on these computers, Windows NT 
automatically switches to full-screen mode. On RISC-based computers, 
graphics-based programs for MS-DOS run only in a window. CRISC-based 
computers have no full-screen mode under Windows NT.) 

Character-Based Programs for Windows NT 
Character-based programs for Windows NT work more efficiently than 
MS-DOS-based programs, and they take better advantage of Windows NT's 
operating-system features. Character-based programs for Windows NT can 
be written to recognize any screen size, and they can generally be more 
aware of their video, keyboard, and mouse environment. However, at pub­
lication time, the future of character-based programs for Windows NT is 
not clear. Will software developers convert their character-based programs 
for MS-DOS to run under Windows N1? Or will they concentrate on writing 
new graphics-based versions of their programs? 

Character-Based Programs for POSIX 
POSIX is a standard that allows programmers to convert existing UNIX-based 
programs to native Windows NT-based programs. If you are coming to 
Windows NT from UNIX, chances are that many of your favorite programs 
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will soon be available for Windows NT. You can't simply copy your pro­
grams from a UNIX computer and expect them to run. You'll have to 
purchase new versions from companies that use their POSIX source code 
to create programs for Windows NT. 

Windows iNTon ;RISC-8ased Computers 

Windows 3.1 and Windows for Workgroups run only on com­
puters using the x86 family of processors. Windows NT runs on 
computers with any of several 32-bit processors, including 80386, 
80486, and Pentium processors (known collectively as x86 
processors), and MIPS R4000 and DEe Alpha RIse processors. 
("RISe" means Reduced Instrnction Set Computing.) RISC-based 
computers have power comparable to minicomputer work­
stations. 

Programs for Windows NT run the same way on all processors, 
but compatibility features for running MS-DOS-based programs 
and programs for Windows 3.1 differ. Here are the major 
differences: 

c x86-based computers run programs for MS-DOS and 
programs for Windows 3.1 using the processor in the 
computer. RISe-based computers run these programs by 
emulating an 80286 processor. This means programs that 
use features of the 80386 and higher processors won't 
run on RISe-based computers. 

c . x86-based computers run graphics-based programs for 
MS-DOS full-screen. RISe-based computers run these 
programs in a window. 

c x86-based computers can run character-based programs 
either in a window or full-screen. (You can switch be­
tween windowed and full-screen modes by pressing 
Alt+Enter.) RISC-based computers run character-based 
programs in a window. 
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Character-Based Programs for OS/2 
All character-based programs for OS/2 version l.xand most character-based 
programs for OS/2 version 2.x run under Windows NT. However, graph­
ics-based programs for OS/2 Presentation Manager or Workplace Shell won't 
run under Windows NT. If you have both MS-DOS-based and OS/2-based 
versions of a program, run the OS/2 version on your Windows NT system. 
It will probably work better because it is written for a protected-mode 
operating system. 

Character-Based Programs for MS-DOS 
Most character-based programs for MS-DOS run under Windows NT, but 
unlike other kinds of programs, they assume that they are alone in the world. 
A protected-mode operating system with strict security features such as 
Windows NT has to pull off some amazing sleight of hand to isolate MS­
DOS-based programs from other parts of the system. Essentially, the oper­
ating system simulates a separate PC-with all the accompanying memory 
limitations-for each program. Despite all the behind-the-scenes magic, 
you'll be surprised at how well character-based programs for MS-DOS run 
under Windows NT. 

Because of the limitations of MS-DOS, various techniques and stand­
ards have been developed to enhance MS-DOS programs. Windows NT 
supports both the extended (XMS) and expanded (EMS) memory standards. 
However, programs that use the Virtual Control Program Interface (VCPI) 
or DOS Protected Mode Interface (DPMI) will run under Windows NT only 
on x86-based computers. You don't need to understand what these stand­
ards are, only that DOS-extended programs that use VCPI or DPMI won't 
work on RIse computers. 

MS-DOS-based programs that access hardware devices directly might 
not run under Windows NT without special drivers. For example, some 
file-recovery or disk-defragmenting programs won't run because they access 
disk hardware directly rather than going through the operating system. 
Eventually, vendors of these tools may supply drivers to make them work 
under Windows NT. For information about installing device drivers, see 
"Using CONFIG.NT," page 665. 
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WINDOWS TIP: You might occasionally find an MS­
DOS-based program that Windows NT won't run from the 
command prompt. In the unlikely event that this happens, 
use the Forcedos command to tell Windows NT that this 
is actually an MS-DOS-based program, even though it 
doesn't look like one. For example, to run a program called 
BAD DOG .EXE, type the following at the command 
prompt: 

C:\)forcedos baddog 

For more information about the Forcedos command, 
see "Forcedos" in the online Command Reference Help. 

Launching Programs 
When you start a program from the command prompt under a single-tasking 
operating system such as MS-DOS, you don't expect to see the command 
prompt again until the program is finished. Only one program can run at a 
time, and that's that. The rules change under a multitasking system such as 
Windows NT. 

The old model still makes sense for some programs. For example, 
enter this command: 

C:\)mode 

The system pauses for a second, and then displays your device status. This 
seems natural. You gave the command asking for information, and there's 
probably not much else you need to do before you get the answer. But 
now enter this: 

C:\)calc 

The Windows Calculator accessory comes up on your screen, waiting for 
input. If the command prompt session was windowed, you still see it on 
your screen, but it is frozen, waiting for the Calc command to finish. This 
probably isn't what you intended. You want Calc to run in addition to the 
command prompt session, not instead of it. 

.' L1." ~ 
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Windows NT provides the Start command to allow you to start another 
operation without freezing the command prompt session. To try it, close 
Calculator and then type: 

C: \>sta rt ca 1 c 

Calculator starts again, but without freezing the command prompt session. 
The Start command tells Windows NT to run Calculator and the command 
prompt session at the same time instead of one after the other. 

This works so well that you might think it would be nice to run Mode 
with the Start command so that you can continue working while it works. 
Realistically you'd probably want to do this with a program that takes a 
while, but let's use Mode for this example. Type the following: 

C:\>start mode 

A separate window appears where Mode works while the command prompt 
window remains available. But then the output disappears before you have 
time to read it. This is just what you asked for, if not what you intended. 
Start makes sense for interactive programs or programs that have no visual 
output, but not for command-line utilities that display their output to the 
screen and then terminate. 

For example, try running the command interpreter, CMD.EXE, with 
and without the Start command. First type the following: 

C:\>start tmd 

You get a new command prompt session in a new window. Now type this: 

C: \>cmd 

This time the Windows NT copyright message appears, followed by another 
command prompt. It looks like nothing happened, but in fact something 
has. A second copy of the Cmd program is running and the first copy is 
waiting for the second to terminate. You can confirm this by using the arrow 
keys to go back to previous commands. There aren't any. Now type exitto 
terminate the command interpreter. The window remains and again it looks 
like nothing happened, but if you press the arrow keys you'll see the 
commands from the original command interpreter. Any commands that you 
entered in the second command interpreter are lost. 

Let's try one more example. Type this: 

C:\>start dir 
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You might expect the Dir output to disappear just as the Mode output did, 
but it doesn't. The command prompt appears after the Dir output. The 
difference is that Mode is a program, whereas Dir is an internal command 
of CMD.EXE. The Start command recognizes CMD.EXE's internal com­
mands, such as Dir. To run Dir, it automatically starts a new copy of the 
command interpreter with the IK option, which tells CMD.EXE not to return 
after running the command. You can get the same effect with Mode (or 
other executable programs) by using this form: 

C:\)start emd Ik mode 

Conversely, the IC option tells CMD.EXE to close the window after the 
command finishes. For example: 

C:\)start emd Ie dir 

The Start command has several useful options for specifying how a 
started program should appear on your desktop. For Windows-based pro­
grams, you can use IMIN or lMAX to make the program appear minimized 
or maximized. For character-based programs, you can enter the title that 
you want to appear on the program window in quotation marks. For more 
information, type the following: 

C:\)start I? 

Undersianding file 
Sysiems Olnd filenames 

Windows NT supports three file systems, each with different filename con­
ventions. You can set up your disk with a partition for each file system, but 
you will probably use only one or two of them. The three file systems are: 

c FAT (File Allocation Table) 

c NTFS (NT File System) 

c HPFS (High Performance File System) 

FAT stands for File Allocation Table, but for this discussion let's forget 
the technical jargon and simply call it the MS-DOS file system. Filenames 
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under this system consist of a base name of up to eight characters followed 
by an optional extension of up to three characters. Thus BASENAME.EXT, 
BASENAME, B.EXT, and B.E are all legal MS-DOS filenames. 

NTFS is the new file system designed to speed up Windows NT file 
access without sacrificing MS:-DOS compatibility. In this system you can 
have filenames of up to 256 characters with multiple extensions of any 
length. You can use uppercase and lowercase letters and embedded spaces 
in filenames. With NTFS, you can name your files just about anything you 
like, but keep the following points in mind when working with NTFS files: 

D You cannot have more than one file in a directory with names that 
are identical except for case. 

D You must use quotation marks around any filename containing 
spaces, as in the following: 

C: \>de 1 "Whole Lotta Spaces Go; nOn" 

c Most file-operation commands ignore case in filenames. For exam­
pie, typing: 

C:\>copy *.case b: 

copies the files Mixed.Case, UPPER.CASE, and lower. case to drive 
B. 

c You can change the case of a filename with the Rename command. 
For example: 

C:\>ren ALONGJUMBLEOFWORDS ALongJumbleOfWords 

HPFS is designed for OS/2 and is supported by Windows NT for 
compatibility. If you have it, you probably have an OS/2 installation and 
already know how to use it. If you don't have OS/2, you don't need to know 
about HPFS. 

Converting a Drive to NTFS 
When you install Windows NT, the Setup program gives you an opportunity 
to convert your existing MS-DOS or HPFS drives to NTFS drives. If you 
passed up this opportunity during setup, you can still do it using the Convert 
command. For ~xample, do the follOWing: 

C:\>convert d: Jfs:ntfs 
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The drive you specify can't be the current drive. The IFS option is 

required and only supports converting to NTFS. If Windows NT can't lock 
all users off the drive-for example, if a running program is using a file on 
the drive or if the drive is being shared over the network-the conversion 
is delayed until the next time you shut down your computer. 

Transferring Files Between NTFS and MS-DOS 
What happens when your transfer files between an NTFS disk and an 
MS-DOS disk? Transferring files form MS-DOS to NTFS is simple: The files 
keep the same names in NTFS, all in uppercase. 

But when you transfer an NTFS file to MS-DOS, Windows NT converts 
the filename so that it conforms to MS-DOS filename conventions. It does 
this by using the filename's first six characters and appending a tilde (-) 
and a number identifying the file. It removes spaces and periods, and 
converts other characters not allowed in MS-DOS' filenames to an underscore 
(_). It creates an MS-DOS extension from the first three characters of the 
last NTFS extension. 

For example, assume that drive M is an MS-DOS disk and drive N is 
an NTFS disk. If you type 

N:\>copy "This Is A Long.File.Name" m: 

the resulting MS-DOS file is named THISIS-l.NAM. The number following 
the tild~ in the filename varies if a previously existing file already has this 
name. For example, if you then copy another file with a slightly longer name 
to the same MS-DOS directory, like this: 

N:\>copy "This Is A Longer.File.Name" m: 

the result might be THISIS-2.NAM. 

You can see how an NTFS filename appears in MS-DOS format with 
the Dir command's IX option. When you list a directory with the IX option, 
the files are shown with their short MS-DOS names in a column to the left 
of the long NTFS names, as the following example shows. 
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For more information about changing NTFS filenames to MS-DOS 
filenames, see "NTFS Filenames," page 88, and "Naming a File or Directory" 
in the online help for File Manager. 

Using Wildcards 
Windows NT, like MS-DOS, recognizes two wildcard characters: ? and *. 
The question mark represents any single character in a filename. For exam­
ple, the command 

C:\docs>dir c?t.doc 

matches CAT.DOC, COT.DOC, and CBT.DOC. 

The asterisk matches any number of characters. In MS-DOS, the aster­
isk works only at the end of the filename or extension. Windows NT handles 
the asterisk much more flexibly, as the following examples show. 

Let's assume that you have a directory containing three files named 
ATE.DOC, BATE.DOC, and BAT.DOC. Notice that all three contain the let­
ters AT-one at the beginning, one in the middle, and one at the end. Now 
suppose you want to find the one with AT at the beginning. Enter this 
command: 

C:\docs>dir at*.doc 

Sure enough, this command shows only ATE.DOC. Now look for AT at the 
end: 

C:\docs>dir *at.doc 
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Windows NT finds only BAT.DOC. What will the following command do? 

C:\docs>dir *at*.doc 

Probably not what you expect. Windows NT finds all three files. Why?' 
Because Windows NT interprets the asterisk as zero or more characters. 
ATE.DOC is found because it has zero characters before AT, and BAT.DOC 
is found because it has zero characters after AT. 

With NTFS, filenames can have multiple extensions separated by pe­
riods, and the asterisk can be used to match characters within each group. 
For example, let's assume that your current directory contains the files A.A.A, 
A.B.C, C.B.A, and A.B. C.!? The command dir *.h. * matches A.B.C, C.B.A, 
and A.B.C.D, but not A.A.A. Typing dir a.h.c. * matches only A.B.C and 
A.B.C.D. 

Using Command Symbols 
With the move to Windows and other graphical user interface systems, the 
emphasis has been on interactive programs. However, old-fashioned pro­
grams that take all of their input from a command line and then run unaided 
still have their place. In fact, they are even more useful in a multitasking 
system because you can turn them loose to do complicated processing in 
the background while you continue to work with interactive programs in 
the foreground. Windows NT includes features that make noninteractive 
programs easier to run and more powerful, and that let you chain programs 
together so that later ones use the output of their predecessors as input. 

In order to work together better, many command-line programs follow 
a set of conventions that control their interaction. 

c By default, programs take all of their input as lines of text typed 
at the keyboard, but input in the same format can be redirected 
from a file or any device capable of sending lines of text. 

a By default, programs send all of their output to the screen as lines 
of text, but output in the same format can be redirected to a file 
or another line-oriented device such as a printer. 

tI Programs are written to set a number called a return value when 
they terminate, to indicate the results of the program. 
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When programs are written according to these rules, you can use the 
symbols below to control a program's input and output, and to connect or 
chain programs together. 

> 

» 
< 

& 
&& 
II 

1\ 

(and) 

Redirect output 

Append redirected output 

Redirect input 

Pipe output to input 

Combine commands unconditionally 

Combine commands with logical AND 

Combine commands with logical OR 

Treat next symbol as character 

Group logical commands 

The Redirection Symbols 
Like MS-DOS and UNIX, Windows NT allows you to override the default 
source of input (the keyboard) or the default destination for output (the 
screen). For example, if you want the output of the Dir command to go to 
a file instead of the screen, use a greater than sign (> ) followed by the name 
of the file. For example: 

C:\)dir /b *.bat ) batch.1st 

This command creates a file containing the names of all the BAT files 
in the current directory. The IB option in the example directs the Dir 
command to include only the names without sizes or other directory infor­
mation. 

Windows NT also recognizes the device names shown in Table 18-2. 
You can use one of these names in any context in which you can use a text 
file. For example, you can send the same file list to the printer (the PRN 
device) with this command: 

C:\bat)dir /b *.bat ) prn 
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CON 
AUX 

PRN 
LPTx 
COM x 

NUL 

TABLE 18-2. 

Device names. 

Console device (keyboard input and screen output) 
Default auxiliary device (COMl) 
Default printer device (LPTl) 
Line printer 1, 2, 3, or 4 
Communications port 1, 2, 3, or 4 
Empty device that swallows output or provides blank 
input 

Using two greater than signs (») redirects the output and appends it 
to an existing file. For example: 

C:\bat>dir /b *.cmd » batch.1st 

This command appends a list of CMD files to the previously created 
file containing BAT files. If you use a single greater than sign in this com­
mand line, the command overwrites the existing file rather than appends to 
it. If you use the » symbol to append to a file that doesn't exist, Windows 
NT creates the file. 

Redirecting Input 
Redirected input works the same way as redirected output except that you 
use a less than sign «). Most Windows NT commands don't accept input, 
so there's no need to redirect "input to them. However, the Sort and More 
commands do take text line input. Programs that take text input and give 
text output are called filters because you can send files in one end to be 
filtered so that they come out in a new form on the other end. The following 
example uses Sort to filter the file created with the Dir command above. 

C:\bat>sort < batch.1st 

The input file, BATCH. LST, contains a list of BAT files followed by a list of 
CMD files (assuming you have some of each in the current directory). The 
output to the screen has the same list of files sorted alphabetically by 
filename. Often you'll want to send filtered output to a file, like this: 

C:\bat>sort < batch.1st > sbatch.1st 
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You can then pass the output file as input to another filter, and so on. 
For example, you can send SBATCH.LST as the input to the More command. 

C:\bat)more < sbatch.lst 

(For information about a better way to chain the input and output of 
different programs, see "The Pipe Symbol," page 605.) 

Standard Output and Standard Error 
Programs can be written to send their output either to the standard output 
device or the standard error device. Sometimes programs are written to send 
different types of output to each device. For example, a program might send 
messages indicating invalid data input to standard output, and messages 
indicating program failure to standard error. You can't always tell which is 
which because by default both devices are the screen. However, if you 
redirect output to a file, messages written to standard error still appear on 
the screen, whereas messages written to standard output go into the file. 

The Windows NT Type command illustrates the difference. When used 
with wildcards (something you can't do with the MS-DOS Type command), 
it sends the name of each matching file to standard error and sends the 
contents of the file to standard output. Normally they both go to the screen 
and you see a nice display with each filename followed by its contents. 

However, if you try to redirect output to a file like this: 

C:\bat)type *.bat > std.out 

the filenames still appear on. your screen because standard error is still 
directed to the screen. Only the file contents go to the redirected file. 

MS-DOS does not have a way of redirecting standard error, but Win­
dows NT allows you to qualify the redirection symbol by preceding it with 
a number. Use 1> (or simply » for standard output and 2> for standard 
error. For example: 

C:\bat)type *.bat 2> err.out 

This time the file contents go to the screen and the names go to the redirected 
file. You can redirect both to separate files with this command: 

C:\bat)type *.bat 2) err.out 1> std.out 
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Probably what you really want is to redirect both standard error and 
standard input to a file so that output is the same in the file as on the screen. 
Here's how. 

C:\bat>type *.bat > both.out 2>&1 

Looks like gibberish, doesn't it? What this command says (starting from the 
end of the command line) is: Redirect standard error (2) ) to standard output 
(&1), and redirect standard output (now containing both) to the file 
BOTH. OUT. 

The Pipe Symbol 
The pipe symbol ( I ) is used to pipe the output of one program into a second 
program as the second program's input. Piping is commonly used with the 
More utility, which displays multiple screens of output one screenful at a 
time. For example: 

C:\bat>dir I more 

This command makes the output of Dir the input of More. More filters out 
the first screenful of Dir output, sends it to the screen as its own output, 
and then waits for a keypress before sending more filtered output. 

Here is a more complicated example of piping: 

C:\bat>dir /b *.bat I sort I more 

This example sends the output of Dir as the input of Sort, which sends its 
output as input to More. This single command produces the same result as 
the following sequence of commands. 

C:\bat>dir /b *.bat > tempI 

C:\bat>sort < tempI > temp2 

C: \ba't> more < temp2 

C:\bat>del tempI temp2 

The only difference is that that the system manages the temporary files 
automatically. Under MS-DOS, temporary disk files are created and deleted, 
but Windows NT handles piping transparently in memory. 
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The Command Combination Symbols 
Unlike MS-DOS, Windows NT allows you to enter multiple commands on 
a single command line. Furthermore, you can make later commands depend 
on the results of earlier commands. This feature can be particularly useful 
in batch files and Doskey macros, but you might also find it convenient 
from the command prompt. (For information about batch files, see "Using 
Batch Files," page 644. For more information about Doskey macros, see 
"Using boskey Macros," page 637.) 

To simply combine commands without regard to their results, use the 
& symbol, like this: 

C:\data)copy a:file.dat & edit file.dat 

But what if there is no FILE.DAT on drive A? Then it can't be copied to the 
current drive and the Edit command will fail when it can't find the file. Your 
screen will be littered with error messages. Windows NT provides two 
logical operation symbols for better control over situations like this. 

The && symbol represents the logical AND operation. The I I symbol 
represents the logical OR operation. The success (or failure) of a program 
determines the result of these logical operations. 

If a program fails, it should return false. If it succeeds, it should return 
true. When two operations are combined with the AND operator, if the first 
operation is true and the second operation is true, then the whole command 
line is true. However, if the first operation is false, then the combination 
can't be true. There is no need to perform the second operation, so Windows 
NT doesn't bother. Consider this modified version of the earlier example: 

C:\data)copy a:file.dat && edit file.dat 

If the Copy command fails, the expression can't be true-so the Edit com­
mand is ignored. 

Sometimes you want the opposite effect: Execute the second com­
mand only if the first fails. You can do this with the OR operation, like this: 

C: \data)copy a: fi 1 e. dat II copy b :fi 1 e. dat 

This command line instructs Windows NT to copy the file from drive A, or 
if that doesn't work, try copying from drive B. 

You can use parentheses to specify the order of operations. Compare 
the following command lines. 
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C:\)(findstr "+" *.C I I findstr "*" *.c) && findstr "/" *.C 

C:\)findstr "+" *.C II (findstr "*" *.C && findstr "/" *.c) 

The first says, "if you find + or *, then look for /." The second says, "if you 
can't find +, then look for *, and if you find it, look for /." This can get 
complicated fast! 

Yes, We Have No Errors 

If you've worked with logical operations before, you probably 
know that zero represents false and any other number represents 
true. But when working with return values, everything you know 
is wrong. Zero means true and any other number means false. 
The reason is that most programs can fail in many different ways, 
but they can only succeed in one way. A program can return a 
nonzero number indicating what kind of error it encountered, 
and this error level can be tested in batch files with the ErrorLevel 
statement. This doesn't matter much when you use the command 
combination symbols, which test only for a program's success. 
Whether it indicates success with a zero or some other number 
is unimportant. However, if you're writing your own programs, 
be sure that they return zero for success. 

The problem with testing for return values is that some pro­
grams deliberately disobey the rules, and others simply ignore 
them. Although most programs return zero for success, the author 
of a program may decide that there is only one way to fail, but 
there are lots of interesting ways to succeed. Programs like this 
work fine with ErrorLevel testing in batch files, but everything is 
backward if you try to use them with the command combination 
symbols. 

In most interactive programs, the return value doesn't matter 
and programmers sometimes don't bother to set it at all. In this 
case, the return value comes out random, which means that it 
probably won't be zero. You can even see the inconsistency in 
Windows NT commands. For example, Copy and FindStr return 
false if they fail, but Del and Find don't bother. They always 
returns true regardless of the result. 
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The Escape Symbol 
Some of the symbols used for command combination are legal characters 
in filenames. This leads to ambiguities. You can resolve ambiguities by using 
the caret (/\) as an escape symbol to indicate that the symbol following it is 
intended as a character rather than· a command symbol. 

Consider the following command line. 

C:\cartoons>copy f:\cartoons\Tom&Jerry 

This copies the file F:\CARTOONS\Tom to the current directory, and 
then executes the Jerry command-probably not what you wanted or ex­
pected. You might think that because there is no space before or after the 
& symbol, the system will know that you are referring to the filename 
Tom&Jerry. Not true. When a command symbol appears on the command 
line, whatever follows is assumed to be a command, space or no space. Use 
the caret as shown below to indicate that you are referring to a filename. 

C:\cartoons>copy f:\cartoons\TomA&Jerry 

The ampersand (&), parentheses (the ( and) symbols), and the caret 
(A) are legal in file,' directory, and network names;the pipe (I), less than 
sign «), and greater than sign (» are not. To delete the legal NTFS filename 
Bugs&RogerCrabbits)LikeAs, use the follOWing command: 

C:\cartoons>del BugsA&RogerA(rabbitsA)LikeAAs 

Using Windows NT Commands 
People who like using command lines tend to be a pretty independent 
bunch, and those who don't like command lines have probably skipped 
this chapter. Therefore, this section doesn't do much hand-holding; it merely 
points out some of the ways that Windows NT commands differ from those 
of MS-DOS and other command-line operating systems. 

The Dir Command 
The lowly Dir command gets several new features in Windows NT. You can 
now list multiple directories or file groups with one command, as the 
following example shows. 

C:\>dir \text\*.txt \winword\*.rloc *.bat 
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You can still use the /W option to list filenames in multiple columns. 

If you sort the file list (using the /0 option), the !W option sorts filenames 
by row, but now you can use the /D option instead to sort vertically in 
multiple columns. Try dir /0 /w and then dir /0 /d to see the difference. 

The default output of Dir is different on FAT (MS-DOS) file system 
drives than on NTFS drives. The default format for an NTFS drive is shown 
below. This format-with the filename on the right-is necessary to accom­
modate filenames of different lengths. You can force similar output on 
MS-DOS drives with the /N or IX option. 

N:\animals)dir *.horse 
Volume in drive N is BigDisk 
Volume Serial Number is BC05-0E42 

Directory of N:\animals 

06/14/95 
06/14/95 
12/05/94 
02/11/93 
05/06/94 
OS/28/95 
05/04/92 
10/12/93 

03:26p 
03:26p 
09:00a 
12:33p 
11:45a 
01:09p 
03:18p 
04:11p 

<DIR) 
<DIR) 

281 HiOh Silver.Horse 
28 Mr.Ed.Horse 

1259 MyFriendFlicka.Horse 
35 OfDifferentColor.Horse 
23 Phar Lap.Horse 

503 Trigger.Horse 
8 File(s) 2129 bytes 

62625792 bytes free 

It's easy and safe to experiment with the Dir options. When you find 
the ones you like, you can set them in the DIRCMD environment variable 
to change the default meaning of Dir. For information about environment 
variables, see "Using Environmen~ Variables," page 629. For information 
about setting environment variables with Control Panel, see "InitialiZing 
Environment Variables," page 657. Try this: 

C:\)set dircmd=IOd/N 

This makes Dir always display files sorted by date in the new wide format 
with the filename on the right. 
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MOUSE TIP: As many MS-DOS users know, you can 
press Ctrl+S to pause while scrolling (from a Dir or Type 
command, for example), and then press any key to 
continue. In Windows NT, you can do the same thing with 
the mouse if QuickEdit mode is on. (To see that it is, 
choose Edit Mark from the Control menu.) Click the pri­
mary button to pause scrolling, and then click the second­
ary button to continue. 

The Del Command 
The Del command can delete several groups of files with a single command. 
For example, 

C:\)del *.obj *.lst 

deletes all of the OB] and LST files in the current directory. Needless to say, 
you should use this feature with care. You can also live dangerously with 
the IQ option, which deletes all of.the files in a directory without any warn­
ing prompt. (Without IQ, Del asks you to confirm your intentions if you 
enter a global wildcard specification such as *. * .) The IF option allows you 
to delete read-only files. The IS option lets you delete all files matching a 
wildcard specification from all subdirectories. You can clean up TMP files 
with the following command. 

C:\)del Is Ip *.tmp 

The IP option here causes the command to prompt for a Yor N response 
before deleting each file. 

In short, the new Del options give you more power, but they require 
caution. Be sure you don't give a command like this: 

C:\)del Is If Iq \*.* 

This would leave your entire directory structure intact, but delete every file 
in every directory without any warning. 
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The RmDir (RD) Command 
The RmDir command-usually invoked with its shorter form, RD-can now 
delete a directory that is not empty by using the IS option. In fact, you can 
kill a whole directory tree faster than you can say "disaster." Use at your 
own risk! 

WINDOWS TIP: MS-DOS version 6.0 added a command 
called DelTree that does the same thing as the IS option 
for RmDir. If you prefer the name DelTree, a Doskey macro 
can do the trick. 

C:\)doskey deltree=rd /5 $* 

For information about Doskey macros, see "Using 
Doskey Macros," page 637. 

The Move and Ren Commands 
The Move command moves a file or group of files from one directory to 
another (on the same disk or a different disk). You specify the source 
directory and files in the first argument, and the destination directory in the 
second. For example, 

C:\)move \temp\*.* \tmp 

moves all of the files in the TEMP directory to the TMP directory. Incredibly, 
versions of MS-DOS prior to 6.0 had no Move command. You had to do this 
operation by copying the files to the destination directory and then deleting 
them from the source directory. 

The Ren command (also recognized as Rename) can rename directo­
ries as well as files under Windows NT. Despite this enhancement, the Ren 
command is now redundant. Anything you can do with Ren you can also 
do with Move. For example, the command 

C:\)ren \tempdir \tmpdir 

has the same effect as 

C:\)move \tempdir \tmpdir 
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Moving a directory to a directory with a new name is the same as 
renaming the directory. You can use Move to move files or directories to 
another disk, whereas you can use Ren only to rename a file or directory 
on its current disk. 

The More Command 
The More command allows you to break multiple screens of output from 
commands like Type or Dir into pages. The output stops after each screen 
so that you can read it, and you press a key to continue to the next screen. 
You can use the command as a crude file browser by typing a filename or 
wildcard specification after the command name, as in the example below. 

C:\)more *.txt 

But usually, More is used as a filter for piped output, as in 

C: \)di r I more 

For more information about piping, see "The Pipe Symbol," page 605. 

. The Windows NT version of More has more functionality than MS-DOS 
versions (but far less than many public domain versions). You can specify 
the IE option to make More recognize a variety of commands at the end of 
each screen. Instead of pressing any key to get to the next screen, you can 
press Enter to see the next line, Spacebar to see the next screen, F to see 
the next file (if multiple files were specified), and Q to quit, among others. 
The More command doesn't modify or delete files, so it's safe to experiment 
with it. 

The At Command 
The At command allows you to schedule execution of a command at some 
specified time. Similar utilities are common in multitasking and networked 
systems, but the concept might be new if you are coming to Windows NT 
from MS-DOS. It is easy to schedule programs in a multitasking operating 
system, but very difficult in a Single-tasking system where each program 
thinks it is the only one in the system. 
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Although you don't have to be connected to a network to use the At 
command, you do have to start the network schedule service. To do this, 
take the following steps: 

1. Start Control Panel. (For more information, see "Starting Control 
Panel," page 128.) 

2. Double-click the Services icon in Control Panel. 

3. Select the Schedule service from list of services, as shown below. 

Services 

F-Se;:,,:;rY::;,;ic:..::.e ______ ---'S:..,;;.la:..;,;lu:..::.s_----::..,SIc:,:ar..:..:;lu:.:..,.p _,.,.., 1!~'N;-ao$e~)'r"l 
Net Logon Manual 

~::::;~ ~~~ DSDM ~::;::~ '~~:~~:::~ IF\;'~Itarr~:~'cl 
Remote Procedure Call (RPC) Locator Manual 1P':~sIOP\~3:'1 
Remote Procedure Call (RPC) Service Manual li!:t':fa~~7~S"1 

SUeprSver Started Automatic 1~:C~()nti/iije\1 
Manual ' • 

L.:..:W..:::or:.:::kst:::::at~ion=___ _____ ...,;S:.::ta::.:.:rte:::..d _.-:...::Au::.:=to:.::;:ma:::;:tic:...--..... t4- I':'~;;::; '., ,",,":'. 
!'j;)~a&tup.~"ll" 

SIil,rlup Paramelers: 

'--_____________ .......... 1 Ir~" 'R;tp~7;;;1 

4. If the service is not marked Started in the Status column, click the 
Start button. 

5. Look at the Startup column. The Schedule service will be marked 
Manual, Automatic, or Disabled-probably Manual if you haven't 
changed anything since you set up Windows NT. If you plan to use 
the At command often, you should change the setting to Automatic 
so that the Schedule service starts every time you log on. The Sched­
ule service must be running not only when you schedule a task with 
the At command, but also when it comes time to run the tasks you 
scheduled. If you log off your computer and log on without 
restarting the Schedule service, any tasks scheduled with the At 
command won't be executed. 

6. To set the Schedule service to Automatic, click the Startup button. 
The dialog box shown on the next page appears. 
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S tartup Type 

@Automatic 

o Manual 

Schedule Service 

~O ___ Di_sa_b_le_d ______________ ~ II~nlf~~~1 

log On As: 
o ,System Account 
@I.hisAccount: Ir-c-on-n-ie-e------I.-:::m~'\;··· 

f.assword: 

Confirm 
Password: 

I 
I'"'"'"'"'"'"'"'" 

7. Select Automatic in the Startup Type option button group. 

8. Select This Account in the Log On As group and enter your user 
name and password. If you select System Account, you cannot use 
the At command because the Schedule service will be running in 
the System account, which is available only if you log on as a 
member of the Administrators group. (You can use the System 
Account setting if several people are authorized to use your com­
puter, but you don't want them to be able to schedule tasks with 
the At command. You log on as administrator and schedule the 
tasks. These tasks will then affect all of the users who log onto the 
computer, but they won't be able to change them without authori­
zation.) 

After the Schedule service starts, use the At command to schedule 
commands at a particular time. For example, you can send yourself a re­
minder with the following command. 

C:\>at 16:30 "echo Don't forget to buy groceries & pause" 

This poor man's alternative to the Schedule+ application creates a command 
session window with a reminder message. Note that the time has to be given 
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in 24-hour format. (This command will be executed at 4:30 P.M.) The com­
mand itself must be enclosed in quotation marks. (For information about 
the Echo and Pause commands, see "Anatomy of a Batch File," page 647.) 

You can also use At to schedule a task at regular intervals. For example, 
if you have written a batch file called UPDATE, you can schedule it to run 
every weeknight at 3 A.M. with the following command. 

C:\)at 03:00 levery:M,T,W,Th,F "update" 

You can also indicate the date as a day of the month (for example, 
/EVERY:5, 10, 15,20,25,30), or you can schedule an event on the next occur­
rence of a given date (/NEXT:Su). If the command you give takes filenames 
as arguments, be sure to specify the names with the drive or network name 
and a complete path description. 

You can expect to see many interesting programs that take advantage 
of the At command as developers of programs for MS-DOS and Windows 
become familiar with the possibilities of a multitasking operating system. 

The Find and Findstr Commands 
The Find and Findstr commands are filter programs that search text files for 
specified strings. Find is the junior version inherited unchanged from MS­
DOS. Findstr is the grown-up version inherited from UNIX, where the 
corresponding utility is called grep. 

The difference between the two is in how the search string is specified. 
With Find, you specify a string of characters. With Findstr, you specify a 
string that can include wildcard characters to match variable sequences of 
characters. For example, you can search for all words beginning with W at 
the start of a line, or all words that start with C and end with T. Strings 
containing the wildcard characters shown in Table 18-3 on the next page 
are called regular expressions. 

Explaining regular expressions could take a whole chapter or even a 
book. In addition, Findstr takes a variety of complex options. The following 
example gives a taste of the power of Findstr. 

C:\bat)findstr Is Ic:" [0-9][0-9]*$" *.bat *.cmd 

~ ~ 
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/\ 

$ 

[class] 

[/\class] 

[x-y] 

\x 

\ <word 

word\> 

TABLE 18-3. 

Wildcard: any character 

Repeat: zero or more occurrences of previous character 
or class 

Line position: beginning of line 

Line position: end of line 

Character class: anyone character in set 

Inverse class: anyone character not in set 

Range: any characters within the specified range 

Escape: literal use of symbol x 
Beginning of word 

End of word 

Wildcard characters used by Findstr. 

This command finds every line that ends with a number in every batch file 
(with extension CMD or BAT) on the current drive. The IS option extends 
the search to files in the current directory. and all its subdirectories. The IC 
option forces Findstr to treat spaces as literal characters rather than as 
separators between multiple patterns. The pattern is enclosed in quotation 
marks because it contains a space. The files to be searched are specified 
after the pattern. 

Now let's look closely at the pattern. It begins with a literal space, 
which lets Findstr find the start of a word. The pattern [0-9] tells Findstr to 
find any digit after the space. The second [0-9] pattern is followed by *, 
which means to find zero or more digits after the initial digit. The pattern 
ends with $, which means the end of the line. In other words, this pattern 
searches for something that starts with a space, has one or more digits (but 
no other characters), and comes at the end of the line. 

The XCopy Command 
XCopy is an extended copy command that can copy whole directory trees, 
update files that have changed recently, and perform many other compli­
cated copy operations. The Windows NT version is similar to the MS-DOS 
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version, but it has so many new options that it's hard to keep track of them. 
You might find it more useful to think ofXCopy as a collection of commands 
and use Doskey macros or batch files to give these commands names you 
can remember. For information about changing XCopy behavior with 
Doskey macros, see "Sample Macros," page 642. For information about using 
XCopy for backup operations, see "Backing Up with XCopy," page 394. 

Using Networl{ Commands 
Networking is a fundamental part of Windows NT, not an add-on product 
that you purchase separately, as with MS-DOS. Although you can install 
Windows NT on a single computer that is not connected to other computers, 
most users will be networked. And yet, networking will probably be an 
unfamiliar concept to some users moving to Windows NT from Windows 
3.1 or MS-DOS. 

This section summarizes networking concepts and describes some of 
the most common networking user commands. As with other topics in this 
chapter, networking at the command prompt is completely optional. Any 
operation described here can also be done through File Manager, Print 
Manager, and other Windows NT utilities. 

Because network setup and administration is a topic worthy of a book 
in itself, we'll assume here that your network administrator has already set 
up your system properly and that network services are available to you. 

Using Network Names 
Network resources can include printers, disks, modems, tape drives, and 
just about any other device connected to the computer. If a user somewhere 
on the network makes a device on his or her computer available to users, 
that device is said to be shared. In order to use a shared device on someone 
else's computer, you must connect to that device. Like files and directories, 
network resources must be named so that users have some means of speci­
fying which devices they want to connect to. 
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A network name includes the following elements: 

13 The name always starts with two backslashes (\ \) to distinguish it 
from directory names. 

I'l The computer name appears next. 

a Another backslash separator follows the computer name. 

D The share name completes the network name. 

NOTE: A single resource can be shared with multiple names, 
each having different permissions and settings. To outside users, 
each share appears as a completely different device even 
though it may physically be the same as another share. 

A computer name might consist of an e-mail name and computer 
number, for example. The share name should provide some indication of 
its purpose. Printers might have a room number in the name, and server 
drives shared by a department might have the department name. For exam­
ple, a user with the e-mail name CONNIEE who wants to use a directory 
on her second computer for exchange of files might name her computer 
CONNIEE2 and her share EXCHANGE. Users can access the shared directory 
as \ \CONNIEE2\EXCHANGE. Network names are not case-sensitive. 

Getting Help 
The first thing to learn about using network resources from the command 
prompt is how to get help. You can get help on most network services with 
the Net Help command. Typing this command with no arguments gives you 
a list of all available help topics. 

To get help on a specific service, type net help followed by the name 
of the service. For example, 

C:\)net help share 

gives syntax and a description of the command to share a network resource 
from your computer. Alternatively, you can get help on each command with 
the /HELP or /? option, like this: 

C:\)net share I? 
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Command-line help is terse, but usually sufficient once you get used to it. 
You can get more detailed help from the Windows NT Help file (in your 
Main group in Program Manager). 

When you get an error message from a Net command, an error number 
is displayed along with a brief description. To get more detailed information 
about the error, give the number as an argument of the Net Helpmsg 
command. For example: 

C:\)net helpmsg 2182 

Connecting to Shared Devices 
Using a shared device is the most common network task. You can connect 
to a shared device by specifying a device name and a network name as part 
of the Net Use command. 

C:\)net use x: \\conniee2\exchange * 

This command connects a directory called \ \CONNIEE2\EXCHANGE as the 
X: drive. The asterisk tells the system to prompt you for the password. The 
password is not displayed as you type it. You can type the password instead 
of the asterisk, but anyone looking at your screen can see the password. 
You might want to include the password in batch files, however. 

If the command succeeds, you can use the X: drive exactly as you 
would any drive on your local computer, subject to any restrictions imposed 
by the owner. For example, the owner might allow anyone to read files, 
but allow only selected users to write, modify, or delete them. 

You can connect to network printers in the same way. For example: 

C:\)net use lpt1 \\prn1345\okips 

After this command, anything you print to LPT1 will go to the shared printer. 

If a shared resource doesn't have a password, you can access it directly 
without first connecting to it. Simply use the network name in place of the 
drive name. For example, to copy WORK. BAT from the \BAT directory of 
\ \ STEVE 0 \ PUBLIC to your C drive, use the network name instead of a 
drive letter, as shown below. 

C:\)copy \\steveo\public\bat\work.bat c: 
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This saves you from having to connect the shared drive to a drive letter, 
copy to the drive, then disconnect the drive, but it works only for public 
devices. Because the directory has to be appended directly to the network 
name, there is no place to put the password. 

11 

WINDOWS TIP: If you want to use the network name to 
access a shared directory that is password protected, first 
connect to the share without specifying a drive letter, like I· 
this: 

C:\)net use \\steveo\private * 
After you have connected with a password, the network 

allows you to access files without the password. For 
example: 

C:\)copy \\steveo\private\bat\ball .bat c: 

When you are finished using a resource, you can disconnect by giving 
the Net Use command with the /DELETE option (usually abbreviated as /D), 
as in 

C:\)net use x: /d 

The /PERSISTENT option determines whether any connections that 
existed at your last logoff are restored automatically when you log on again. 
By default, persistence is on. If you want to connect to a share temporarily 
without the resource being reconnected at your next session, use this format: 

C~\)net use x: \\marketing\backup /persistent:no 

If you find yourself turning persistence off for most connections, you can 
change the default with this command: 

C:\)net use /persistent:no 

After this command, you must use the /PERSISTENT option when you 
connect to a resource that you want reconnected automatically at logon. 
For example: 

C:\)net use lptl \\prn1345\okips /persistent:yes 



Chapter 18: Working from the Command Prompt 

Browsing Network Resources 
The Net View command browses the network for the servers and shared 
resources you might be interested in. First you browse domains to see which 
servers are available, and then you browse the servers to see which shares 
are available. 

A domain is a group of servers. A small network might have only one 
domain. In a large corporation', the network might be organized into many 
domains. For example, a company might put each floor, building, or branch 
office in a separate domain. When you log onto Windows NT, you log onto 
a domain-usually one recommended by your system administrator. You 
can browse the servers in your domain by typing net view, which displays 
a list of servers similar to the following. 

C:\>net view 
Server Name Rema rk 

\\CONNIEE2 Connie Ehrlich's second machine 
\\STEVEO Steve Overholt's machine 
\\SHARONG Sharon Gardner's machine 
\\SALES Sales department server 
\\MARKETING Marketing department server 
The command completed successfully. 

The following command checks to see which other domains are avail­
able for browsing. 

C:\>net view Idomain 

To view the servers in a particular domain (other than your own), specify 
the domain name, like this: 

C:\>net view Idomain:boston 

After you've found the name of a server, you can browse its shares. 
For example, typing net view \ \ sales displays information similar to that 
shown on the next page. 

." 

~ .....•... x:." .•. 

~ 

A21 



~ PAR T 4: Running Applications 

622 

Shared resources at \\sales 
Sales departmental server 

Sharename Type Used as Comment 

CONTACTS Disk P: Regional contact sheets 
ACCOUNTS Di sk Accounting reports 
EXCHANGE Disk File exchange area 
OKIPS Print LPTI Okidata Postscript 
HP PRINT LPT2 Laserjet 
The command completed successfully 

When you find a share, you can use the Dir or Tree command to 
examine the contents (as long as the share is public), like this: 

C:\)tree If \\sales\contacts I more 

Browsing through lists of computers and shares should raise some 
concerns about how you want your own computer to appear. Remember 
that everyone on the network can see your computer name (unless you 
specifically hide it) and the shared resources you have. Be sure to keep 
sensitive data in directories that are not shared, or set the passwords and 
protection levels appropriately. If you do want to share a resource, be sure 
to add comments so that browsers will know what you are offering. Com­
ments are optional when you set up your own shares, but they can save a 
lot of frustration for people searching for information. The next section 
describes one way to share your own devices. 

Other Network Commands 
Of the many network commands available (type net help to see a list), most 
are for administrators or advanced users. But all users might find the fol­
lowing commands useful. 

The Net Share Command 
If you want to share a directory on your disk, you'll probably find it easier 
to do so with File Manager. (For information, see "Sharing Directories with 
Other Users on the Network," page 100.) However, you can also use the 
Net Share command, as shown below. 

C:\)net share contacts=c:\contacts Iremarks:"Contact lists" 
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If your computer's name is SHARONG, this command makes your CON­
TACTS directory public with the network name \ \SHARONG\CONTACTS. 
Browsers will see the description given with the /REMARKS option. You 
can't set access restrictions or password-protect your share from the com­
mand prompt; use File Manager if you need these features. 

You can stop sharing the directory with the following command. The 
/D option deletes the share. 

C:\)net share contacts /d 

The Net Send Command 
You can send messages to other users with the Net Send command, as in 
the example below. 

C:\)net send connieel Meeting in my office at 4 pm 

This displays a pop-up message on the CONNIEEI computer if that com­
puter is running the network Messenger service (most computers do so by 
default). In addition to specifying a particular computer as the recipient, 
you can send a message to everyone in your group or everyone in a specified 
domain. Pop-up messages have the potential to be obnoxious, so use dis­
cretion, especially if the receiving group includes a lot of people. 

WINDOWS TIP: If you find that you are receiving too 
many inappropriate messages, you can turn off the Mes­
senger service on your own computer with the Services 
applet in Control Panel or with this command: 

C:\)net stop messenger 

The Net Time Command 
You can use the Net Time command to synchronize your computer's time 
setting with the time of a master server computer. Normally the network 
administrator assigns a computer to keep time for a group or company. If 
you are instructed to use the computer \ \ TIMESVR, for example, you can 
give the following command to synchronize th~ time on your computer: 

C:\)net time \\timesvr /set /y 
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WINDOWS TIP: You can use Doskey macros to shorten 
network commands. Use Notepad or another editor to 
create a file named NET.MAC that contains the following 
information: 

;= Connect to a share, reconnect if that 
;= is the default 
use=net use $* 
;= Connect temporarily to a share, don't 
;= reconnect regardless of default 
uset=net use $* Ipersistent:no 
;= Connect permanently to a share, reconnect 
;= regardless of default 
usep=net use $* Ipersistent:yes 
;= Delete a share 
delete=net use $1 Idelete 
;= View the shares on a machines 
vshares=net view $* 
;= View the machines on a domain 
vdomain=net view Idomain:$l 
;= View the available domains 
vdomains=net view Idomain 
;= Share a resource 
share=net share $* 
;= Send a message 
send=net send $* 
;= 

Then load the macros with this command: 

C:\)doskey Imacrofile=c:\bat\net.mac 

You don't need to know how the macros work to start 
using them. For more information about Doskey, see 
"Using Doskey Macros," page 637. 

The ISET option is required to set your computer's time. Without the /Y 
option, the network shows the time and asks if you want to set your 
computer's time to match the server's time. This option (or its partner IN) 
is used frequently with network commands to specify yes (or no) in response 
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to a prompt. You might want to synchronize the time periodically by placing 
this command in a logon script or by calling it periodically with the At 
command. For example: 

C:\)at 02:00 /every:f "net time \\timesvr /set /y" 

For information about logon scripts, see "Setting Account Policies," 
page 328. For information about the At command, see "The At Command," 
page 612. 
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Using Environment Variables 
Environment variables are the traditional way to pass information be­
tween programs. Sometimes you set environment variables for the system 
to read; sometimes you read variables set by the system. 

Using Doskey Macros 
For simple automation tasks, Doskey macros often work better than batch 
files. They're easy to write and execute instantly. 
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Using Batch Files 
Batch files let you automate your system and create new commands by 
combining old commands. Windows NT offers a few new tricks for the 
batch file guru. 

Customizing Your Configuration 
Windows NT offers many options for configuring command prompt 
sessions, logon behavior, and the operation of MS-DOS-based programs. 
Even unruly TSR programs can be tamed. 
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indows NT runs your old and new programs right out of 
.. ; the box. You don't have to do anything special to run 

character-based programs or to use the command prompt. But if you like, 
you can automate commands, change your working environment, and 
smooth the rough edges between the graphical-user-interface and charac­
ter-based worlds. 

Chapter 4, "Customizing Windows NT with Control Panel," explains 
how to customize the graphical-user-interface world of Windows and Win­
dows NT using Control Panel. This chapter explains how to customize the 
character-based world of command prompts and non-Windows-based pro­
grams. You'll soon see that it really is a different world. Control Panel has 
a consistent feel and easy-to-use interface, but techniques for customizing 
the character-based world, although often powerful, are inconsistent, some­
times confusing, and generally old-fashioned. They are borrowed from 
several earlier operating systems, with a few new touches added specifically 
for Windows NT. 

If you like the command prompt approach because it is terse and 
efficient, then you'll probably enjoy using Doskey macros and batch files 
to make it even more so. If you've used MS-DOS or OS/2, you might already 
know how to write macros and batch files, but Windows NT offers a few 
new twists. For example, you'll find significant differences in how you write 
configuration and initialization files. Program Information Files (PIFs), which 
make non-Windows-based programs work more smoothly under Windows, . 
provide another interesting area for customization. 

As in the previous chapter, we assume that you have some experience 
with batch files and the like from using MS-DOS. Therefore, this chapter 
concentrates on the differences between MS-DOS and Windows NT. 

Using Environment Variables 
Command-prompt operating systems traditionally use environment vari­
ables as a means for programs to share information and read global settings. 
Windows 3.1 and Windows NT use initialization files for the same purpose. 
But the distinction between the old environment-variable system and the 
new initialization-file system is not always clear. Windows-based programs 
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can use environment variables, and non-Windows-based programs can use 
initialization files. For example, many MS-DOS-based programming tools 
read settings from a configuration file called TOOLS.lNI, the location of 
which is determined by the INIT environment variable. 

The following sections explain how to use environment variables for 
these tasks: 

iii Setting and using environment variables to pass information to your 
batch files and programs 

C Reading environment variables set by the system to get information 
about your environment 

EI Setting standard environment variables that have a special meaning 
recognized by the command processor and other programs 

Setting and Using Environment Variables 
The Set command allows you to examine as well as set environment vari­
ables. To examine the current environment variables, open a command 
prompt window (for information about this, see "Starting a Command 
Prompt Session," page 576) and type set (without any arguments). Windows 
NT displays a listing of all the current environment variables and their val­
ues, as the following typical example shows. 

ComSpec=C:\winnt\system32\cmd.exe 
HOMEDRIVE=C: 
HOMEPATH=\users\conniee 
OS=Windows_NT 
Os2LibPath=C:\winnt\system32\os2\dll; 
Path=C:\winnt\system32;C:\winnt;C:\BAT;C:\BIN;C:\DOS 
PROCESSOR-ARCHITECTURE=x86 
PROCESSOR-LEVEL=4 
PROMPT=$P$G 
SystemRoot=C:\winnt 
temp=C:\temp 
tmp=C:\temp 
USERDOMAIN=BOSTON 
USERNAME=ConnieE 
windir=C:\winnt 
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To set an environment variable, use the Set command followed by the 

variable name and value. For example: 

C:\)set FullName=Connie Ehrlich 

When you use the Set command to set an environment variable, the variable 
is in effect in the current command prompt session and in any sessions or 
programs started from that session. To set environment variables that will 
be permanent for all command prompts and programs, use the Control 
Panel's System applet. For more information about the System applet, see 
"Initializing Environment Variables," page 657. 

You can use any case when you specify an environment variable in 
Windows NT. Unlike MS-DOS, which converts all environment variable 
names to uppercase, Windows NT remembers the case you use when you 
define a variable. However, you cannot define multiple variables with the 
same name and different case. Windows NT commands ignore the case of 
variable names. 

Although Windows NT internally ignores the case of environment 
variable names, it retains the case of the value you assign to a variable. The 
environment variable's value is always supplied to programs in the same 
case you used when you assigned it. 

To use the value of an existing environment variable, enclose it in 
percent signs (%). For example, the SystemRoot variable is automatically set 
to the drive and directory where your Windows initialization files are in­
stalled. You can change to this directory with the following command. 

C:\)cd %systemroot% 

MS-DOS recognizes environment names within percent signs in batch files, 
but not on the command line. Windows NT recognizes them almost any­
where-on the command line, in PIF Editor, and in Program Manager dialog 
box fields. We illustrate some of the convenient uses of this feature later in 
the chapter. 
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Using System Environment Variables 
Windows NT automatically sets several environment variables with infor­
mation about your system. You can use these values in batch files, Doskey 
macros, and command lines-and if you're a programmer, in the programs 
you write. The system environment variables include the following. 

ComSpec The path and name of the command 
processor (normally CMD.EXE) 

OS The operating system: "Windows_NT" 

Os2LibPath The directory where OS/2 Dynamic 
Link Libraries (DLLs) are located 

PROCESSOR_ARCHITECTURE The type of the processor, such as 
"x86" or "MIPS" 

PROCESSOR_LEVEL The version of the processor, such as 
"4" (for 486) or "4000" (for MIPS 4000) 

SystemRoot The drive and directory where Setup 
installs INI files, nonnally \ WINNT or 
\ WINDOWS 

HOMEPATH The default directory used by File 
Open and Save As dialog boxes, and 
as the default startup directory for new 
command prompt sessions (For 
information about setting the home 
directory, see "Using Logon Scripts 
and Setting a Home Directory," page 
326.) 

HOMED RIVE The default drive associated with the 
default directory 

USERDOMAIN The network domain you logged onto 

USERNAME The usemame you logged on with 

windir The Windows directory, normally the 
same as SystemRoot 

You should not modify these environment variables. Windows NT 
won't prevent you from doing so, but they won't be of much use if they are 
inaccurate. 
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WINDOWS TIP: If you use MS-DOS and Windows NT on 
the same computer, you might want to set similar variables 
in your MS-DOS setup by putting them in AUTO EXEC. BAT. 
For example, you can set OS to MS-DOS, and then write 
batch files that take different actions depending on 
whether OS is "MS-DOS" or "Windows_NT." Similarly, you 
can write batch files that run on different computers, 
testing the processor or username and taking appropriate 
action. For information about testing values in a batch file, 
see "Anatomy of a Batch File," page 647. 

Setting Standard Environment Variables 
Some environment variables have a standard meaning known to the com­
mand processor and recognized by many other programs. Most standard 
variables have default values, but you can change them in order to change 
the way your system operates. 

The Path Variable 
The Path environment variable determines the order in which programs that 
run other programs (such as CMD.EXE) search for executable files. The 
paths to be searched are listed in order, separated by semicolons. The Path 
variable is so frequently used that Windows NT (and MS-DOS) includes a 
Path command to save you several keystrokes when typing it. The command 

C:\)path c:\winnt\system32:c:\bat:c:\bin:c:\dos: 

is exactly equivalent to 

C:\)set path=c:\winnt\system32:c:\bat:c:\bin;c:\dos: 

The Path command is also useful for listing the existing search path. 

C:\)path 
PATH=C:\winnt\system32;C:\winnt:C:\BAT;C:\BIN;C:\DOS 

The Set command displays the same information, but it also shows all of 
the other environment variables. 
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You should have a strategy for organizing executable files on your 
disk. Choose a few directories where you will store your programs, and put 
those directories in your search path. It takes slightly longer to find a. 
program in a directory at the end of the search path, so you might want to 
put the directories with your most important programs first. Another factor 
to consider when setting up your search path is what happens if you have 
two programs with the same name in different directories. The one found 
first in your search path will be executed. For example, if you have 
DOIT.BAT in your \BAT directory and DOIT.EXE in your \BIN directory, 
and your search path is set up as in the previous example, DOIT.BAT will 
be executed when you type doit at the prompt. 

WINDOWS TIP: If you have a flex-boot system with 
MS-DOS 6 and Windows NT, you can put the MS-DOS 
\ DOS directory at the end of your Windows NT search 
path and the Windows NT %SystemRoot% \ SYSTEM32 
directory at the beginning. This way, if you run utilities 
common to both MS-DOS and Windows NT, such as Sort,· 
the Windows NT version is found first. And you can still 
run MS-DOS utilities like DELTREE.EXE and CHOICE.COM 
because they don't have Windows NT equivalents. But this 
sharing of directories works. only one way. Putting the 
SYSTEM32 directory in your MS-DOS search path will 
cause nothing but trouble. 

The Temp and Tmp Variables 
The Temp and Tmp environment variables should be set to the directory 
where you want temporary files to be created. By convention, programs 
that need to create temporary files check one of these environment variables 
for directions on where to put the files. Unfortunately, the practice of using 
an environment variable to indicate a temporary directory has spread spon­
taneously and inconsistently. Some programs use the Tmp variable, some 

! 
... 
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the Temp variable. Windows NT uses Temp, but some MS-DOS-based 
programs use Tmp. The safest solution is to define both variables and point 
them to the same directory. 

It's a good idea to create a directory directly off your root directory 
for this purpose. When programs that create temporary files crash, they 
usually fail to clean up their files. It is easier to delete these files manually 
if they are located in a directory of their own. 

NOTE: A common technique among MS-DOS users is to point 
the temporary directory to a RAM disk for faster processing of 
temporary files. Because Windows NT has faster disk I/O, no RAM 
disk software is provided. In fact, applications for Windows NT 
rarely use temporary files because new features such as virtual 
memory, named pipes, and memory-mapped I/O make them 
not only unnecessary, but undesirable. For example, MS-DOS 
implements pipes by creating temporary files in the Temp 
directory, but Windows NT implements the same feature more 
efficiently in memory. For more information about pipes, see 
"The Pipe Symbol," page 605. 

The PROMPT Variable 
The PROMPT environment variable determines the appearance of the com­
mand prompt. You can customize your prompt by setting the PROMPT 
variable using text and special character sequences that start with a dollar 
sign. For example, $p represents the current drive and directory, and $g 
represents the greater than sign. Together, $p$g forms the familiar default 
prompt. As it does for the Path variable, Windows NT includes a Prompt 
command to save you keystrokes. You can customize your prompt by typing 
set prompt= or simply prompt followed by the text and special characters 
you want. We won't go into the details here, since you can get all the 
information you need by typing this command: 

C:\>prompt 17 
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But just for fun, here are a couple of examples: 

C:\)set prompt=What's up. Doc?$s 

What's up, Doc? prompt $p$_$d $t$h$h$h$h$h$h$_$v$g 

C:\ 
Sat 12-25-93 11:59 
Windows NT Version 3.10 )prompt 

C:\) 

The first command sets the PROMPT environment variable to "What's 
up, Doc?" followed by a space (represented by $s). The second command 
saves four keystrokes by using the Prompt command instead of the Set 
command to create a multiline prompt with the date, time, and Windows 
NT version number. The $h sequence deletes the seconds portion of the 
time for a cleaner display. 

The Prompt command with no arguments resets the default $p$g 
prompt. After experimenting for a while, chances are you'll go back to the 
simple default prompt so you can get some work done without distraction. 

NOTE: With MS-DOS, you can create complex colored prompts 
anywhere on the screen by using ANSI escape sequences. 
Windows NT does not support the ANSI.SYS driver, so you can't 
duplicate your fancy MS-DOS prompts in Windows NT. (You can 
change the screen colors with the Control menu, however. For 
information about screen colors in a command prompt window, 
see "Setting Screen Colors," page 584.) 

Other Environment Variables 
Any program can check a particular environment variable to get information 
such as a directory path or other options. For example, many programming 
tools check the LIB and INCLUDE environment variables for directories 
containing libraries and include files. Some MS-DOS-based programs check 
the INIT environment variable for a directory containing initialization and 
settings files. CMD.EXE (and COMMAND.COM in MS-DOS versions 5 and 
6) checks the DIRCMD variable for options to control the Dir command. A 
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common technique for programs that take many options is to check an 
environment variable with the program name for default options. For ex­
ample, WHODAT.EXE may check the WHODAT environment variable. 

Using ~oskey Macros 
When you have a task to automate, be sure you choose the right tool. With 
Windows NT, Doskey macros serve as the first level of automation. A macro 
is a keystroke sequence that is passed to the command interpreter when 
you type the name of the macro. Macros are easy to define, take up little 
disk space and memory, and execute instantly. They work best for short­
ening long commands and assigning a name to a simple sequence of com­
mands. At some point, you'll find that the tasks you want to automate are 
too complex for macros. When that happens, move up to the second level 
of automation-batch files. For information about batch files, see "Using 
Batch Files," page 644. 

Batch files and Doskey macros are two similar ways to create new 
commands by combining existing commands and programs. In both cases, 
you essentially give simple names to longer commands or sequences of 
commands. 

Defining Macros 
The simplest Doskey macro is one that gives a long command a short name. 
Starting the Windows help program at the Windows NT command prompt 
normally requires a very long command line. You can abbreviate that com­
mand by entering the following: 

C:\)doskey h=start winhlp32 c:\winnt\system32\ntcmds.hlp 

This command defines a macro named H; the content of the macro is the 
text that follows the equal sign. After defining this macro, you can get help 
on Windows NT commands at any time with the following command. 

C:\)h 

You can make this macro a little more reliable by using the SystemRoot 
environment variable instead of giving an absolute path. Your SYSTEM32 
directory might not be in the C: \ WINNT directory, but it will definitely be 
in the SystemRoot directory. 
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C:\)doskey h=start winhlp32 %systemroot%\system32\ntcmds.hlp 

The new macro overrides the previous definition of the H macro. 

If you want to eliminate an existing macro (perhaps because you gave 
it the wrong name), simply assign the name a blank value, like this: 

C:\)doskey h= 

Managing Macros 
Before we get into some interesting sample macros, let's take a brief look 
at how to manage your Doskey macros. The key point is that Doskey macros 
are local to each command prompt session. If you define a macro in one 
session, it won't work in other sessions. If you exit the session in which you 
defined it, your macro is gone. You should save useful macros so that you 
can load them whenever and wherever you want. 

The easiest way to save macros in a file is with Doskey's /MACROS 
option. This option displays all active macros on the screen. However, the 
default action isn't much use; normally you'll want to redirect your macros 
to a file. For example: 

C:\)doskey /macros ) cmdinit.mac 

After you create a file with Doskey macros from one session, you can 
read them into another session with the /MACROFILE option. 

C:\)doskey /macrofile=c:\cmdinit.mac 

Of course, you don't really want to type this command every time you start 
a new command prompt window, so you should put it in your initialization 
file. For more information about initialization files, see "Initializing Com­
mand Prompt Sessions," page 660. 

After you develop a library of macros, you can organize them in 
different files. You'll probably want one group that you load automatically 
in every command prompt window. Then you might want to add a few 
more files for different types of work. You might have a BACKUP.MAC file 
that you load only when you're backing up files, or a PROGRAM.MAC for 
programming tasks. You can create or edit macro files with any text editor 
(Notepad or Edit, for example). 
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WINDOWS TIP: Complex macros are often not very 
readable, so you might want to keep a description of each 
macro in the file next to the definition. Unfortunately, 
Windows NT doesn't have a comment character, but you 
can define your own. Choose a character that you would 
never use as a command-a semicolon is a good choice­
and follow it by an equal sign so that Doskey won't com­
plain about an illegal macro. Then add the text of your 
comment. Technically, you're defining a macro named ";" 
with the comment text, but you're not going to use that 
macro, so no damage is done. For example: 

;= Set 80x50 line mode 
50=mode con:lines=50 

;= Set 80x25 line mode 
25=mode con:lines=25 

;= Set a given number of lines 
Lines=mode con:lines=$l 

;= Set a given number of columns 
Cols=mode con:cols=$l 

;= Delete all files on a disk matching a given 
;= specification (redirecting standard error to 
NUL 
;= prevents unnecessary messages) 
CleanUp=del Ip Is $* 2> NUL 

,-

The ;= at the end cleans up by clearing the macro 
assigned to the semicolon character. 

< 

. 

; 

: 
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Using Parameters in Macros 
Like batch files, Doskey macros handle replaceable parameters. In batch 
files, you use %1 to %9 to represent up to nine command-line parameters. 
In macros, you use $1 to $9 for the same purpose. For example, you might 
write the following macro to shorten the name of the Start command to the 
letter S. 

C:\)doskey s=start $1 

This is equivalent to writing the following batch file called S.BAT. 

@echo off 
start %1 

You wouldn't really want this macro (or the batch. file, for that matter) 
because it accepts only one argument. If you type s edit /h autoexec. nt, you 
start the editor, but the /H option and the name of the file to edit are lost. 
To handle multiple arguments, you would write the batch file like this: 

@echo off 
start %1 %2 %3 %4 %5 %6 %7 %8 %9 

Then you'd pray that no one ever calls your batch file with more than nine 
arguments. This is one of the few areas where Doskey macros are actually 
more powerful than batch files. In macros, $* represents all the arguments 
passed, even if there are more than nine. 

C:\)doskey s=start $* 

For more information about using replaceable parameters in batch 
files, see "Anatomy of a Batch File," page 647. 

Using Symbols in Macros 
You can use redirection, piping, and command combination symbols in 
macros, but you must use the escape symbol ( A) before each symbol. (For 
more information about these symbols, see "Using Command Symbols," 
page 601.) Otherwise, the symbols are interpreted as part of the command 
line instead of as part of the macro. For example, you might try defining a 
macro that saves your current macros to a file, like this: 

C:\)doskey macsave=doskey /macros ) %temp%\current.mac 
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What this command actually does is redirect the output of the macro defi­
nition line up to the redirection symbol to CURRENT.MAC. But the Doskey 
command doesn't produce any output, so you end up with an empty file. 
Meanwhile, the MacSave macro has been defined to display macros to the 
screen instead of to a file. Not what you intended. Here's the correct defi­
nition command: 

C:\)doskey macsave=doskey Imacros A) %temp%\current.mac 

Here's an example in which the pipe symbol needs an escape symbol. 
The macro creates an enhanced Type command that pipes output through 
the More filter. 

C:\)doskey seymour=type $* AI more Ie 

You need the escape symbol only when defining a macro at the 
commflnd line. Don't put it in your macro files. It won't show up when you 
display current macros with the /MACROS option. 

Doskey originated with MS-DOS, which doesn't have an escape sym­
bol or command combination symbols. To include command symbols in 
macro definitions, MS-DOS Doskey uses special character sequences that 
begin with a dollar sign. For compatibility, Windows NT Doskey recognizes 
the following $ sequences. 

~ ~~fmWlW ~~ 

Redirect output 1\> $G 
Append redirected output 1\>1\> $G$G 
Redirect input 1\< $L 
Pipe output to input 1\1 $B 

Combine commands 1\& $T 
Combine commands with AND 1\&1\& Noway 

Combine commands with OR 1\11\1 Noway 

Display caret 1\ 1\ 

Display dollar sign $$ $$ 

.M ... ' """:' ,"~"'~"" 

L1 ~ 

I! 
I: 

Ii 
I. 

I: 
Ii 

I; 
Ii 
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Sample Macros 
You might find it useful to create a group of directory-listing commands. 
The idea here is that each variation of the Dir command starts with D and 
has one or two modifying letters that indicate its function. Rather than show 
each of these on a command line, we'll show the definitions the way they 
would appear in macro file. 

:= Default directory listing 
D=dir $* 
:= Directory listing with pause 
Dp=dir Ip $* 
:= Directory listing of visible files sorted by extension 
De=dir la-d-h-s $* loe 
:= Directory listing of visible files only 
Df=dir la-d-h-s $* 
:= Wide directory listing sorted in columns 
Dc=dir Id $* 
:= Wide directory listing sorted in rows 
Dr=dir Iw $* 
:= Bare directory listing of visible files 
Db=dir Ib la-d-h-s $* 
:= Tree directory listing of visible files 
Dt=dir Is la-d-h-s $* 

only 

only 

:= Directory listing of both DOS and NTFS filenames 
Dx=dir Ix $* 
;= 

To use these macros, enter the data in your editor, save it as a macro 
file called DIR.MAC, and load it with the Doskey lMACROFILE option.. 
(These macros assume that you have already set global preferences such as 
your sort order in your DIRCMD environment variable. For information 
about DIRCMD, see "The Dir Command," page 608.) When using the mac­
ros, you can include additional options on the command line .. 

You can use Doskey macros to change the behavior of Windows NT 
commands. Consider the Copy command and the XCopy command. Why 
are they separate? XCopy does a better job of almost everything Copy does, 
plus more. You can enhance the Copy command by entering the following 
command. (Ignore the II and IF in the following example; we'll discuss 
them later.) 
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C:\)doskey copy=xcopy Ii If $* 

Voila! Copy now works faster, has a neater, more consistent output, 
and can do nearly any copy operation you can imagine except one-com­
bine multiple files into one. If you need to combine files, nothing but the 
real Copy command will do, but you don't have the real Copy command 
because you've defined it away. 

To use the Copy command, you have two alternatives. First, you can 
still use the Copy command. Simply precede it with one or more spaces on 
the command line. 

c:\) copy one.doc+two.doc onetwo.doc 

Better yet, create a Combine command that does what the Copy com­
mand used to do. 

C:\)doskey combine=copy $* 

Notice that the Combine command calls Copy, but Copy has been redefined 
to mean XCopy. So which Copy does Combine use, the original command 
or the macro? It turns out that macros know nothing about other macros 
and can't call them. The Combine command uses the original Copy com­
mand. 

We've defined Copy to mean XCopy, so now we don't need XCopy 
anymore. Why not redefine XCopy to do the most common XCopy task, 
which for many people is copying entire directory trees? 

C:\)doskey xcopy=xcopy Ie Ii If Ik $* 

The IE option makes XCopy always copy entire trees, including empty 
directories. The IF option shows both the source and destination of each 
file copied. The IK option copies the file attributes of the files copied. 

The /1 option fixes an annoying characteristic of the XCopy command. 
Assume that you try to copy a directory full of files to a new directory. 

C:\)xcopy olddir newdir 
Does newdir specify a file name 
or directory name on the target 
(F = file, D = directory)? 
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To humans the answer seems pretty obvious, but XCopy takes things very 
literally. Because most users will want to copy to a directory 99 times out 
of 100, Windows NT (but not MS-DOS) lets you use the /1 option to suppr.ess 
the question. We used it earlier when redefining Copy to XCopy. 

It's a bit risky to change Windows NT commands. You might forget 
what you did and try to use the old version. If you let someone else use 
your computer, your guest might be confused. If you use someone else's 
computer, you might be confused. Think of the previous illustrations as 
examples of what you can do, not what you should do. Redefining com­
mands will always cause "gotchas." 

For example, our new, more powerful Copy command usually works 
the same as the old version, but not always, as the following command 
illustrates: 

C:\)copy *.doc docfiles 

The old Copy appends all the DOC files to create one combined file called 
DOCFILES. The new Copy command copies the first DOC file to DOCFILE, 
then overwrites it with the second, and so on. The final DOCFILE contains 
only the last DOC file. 

Using BOlich Files 
A batch file is a text file containing a sequence of commands to be executed. 
You define a sequence of commands, name the sequence, and then execute 
the commands by giving the name. 

When you type the name of your batch file at the command prompt, 
the command interpreter opens the file and starts reading the statements. It 
reads the first line, executes the command, and then goes on to the next 
line. On the surface, this is just the same as if you typed each line yourself 
at the command prompt. However, things get much more complicated, 
because you can use parameters with batch files to vary their behavior just 
as you can with programs. Batch files can also respond to values returned 
by programs and to the values of environment variables. 

At this level, writing batch files becomes computer programming. You 
might not feel like a programmer after writing your first batch file-it seems 
too simple. But as you learn to handle parameters, environment variables, 
and values returned from programs, you'll start to feel first a sense of 
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accomplishment, and then eventually some frustration. Programming batch 
files turns out to be one of the most complex and difficult forms of pro­
gramming because the batch language doesn't provide many tools to work 
with. You might eventually graduate to a "real" programming language-but 
that's another book. 

Batch File Basics 
Batch files are text files created with a text editor. You can use Notepad if 
you like a graphics-based editor, or Edit if you prefer a character-based 
editor. More likely, you already have a text editor, or possibly a word 
processor that can produce unformatted files. 

In Windows NT, you can name your batch files with a BAT or CMD 
extension. The Windows NT command interpreter will attempt to execute 
commands from any file with either of these extensions. If you're coming 
to Windows NT from MS-DOS, you might already have some batch files 
with the BAT extension. They should work fine under Windows NT. If you're 
coming from OS/2, you might have batch files with the CMD extension. 
They should also work without change. If you're writing new batch files to 
run only under Windows NT, take your pick. If you have two batch files in 
the same directory with the same base name but different extensions, the 
BAT file will be executed-not the CMD file. We'll use BAT for sample batch 
files in this chapter. 

Batch Command Summary 
Batch commands are the commands that generally make sense only when 
used from a batch file. Some of the commands we'll discuss here can actually 
be used from the command line, but generally aren't. With a few exceptions, 
Windows NT has the same batch file commands as MS-DOS. Most new 
features are subtle changes in the way commands work, but there are also 
a few new commands. We'll start by summarizing all the batch commands 
(see Table 19-1 on the next page), arid then concentrate on the differences 
and new possibilities in Windows NT batch files. We'll explain the new 
commands, but for most commands, this table-along with the Windows 
NT Command Reference Help file-will suffice. You can also get help about 
the commands using the /? option. 
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@ 

Echo [Off Ian] 

Echo msg 
Echo. 

Rem msg 

If [Not] ErrorLevel 
num cmd 

If [Not] Exist file 
cmd 

If [Not] txtl==txt2 
cmd 

Goto label 

: label 

For %%var In (set) 
Do [cmd] %%var 

Shift 

Call batfile args 

SetLocal 

EndLocal 

PushD dir 

PopD 

Pause 

TABLE 19-1. 

Batch commands. 

When used as the first character in a line, 
prevents the line from displaying on the screen 

Turns echoing off or on 

Displays msg on the screen 

Displays a blank line on the screen 

Identifies msg as a comment 

If the ErrorLevel returned from the previous 
command is less than or equal to num, then 
cmd is executed (Not reverses the logic.) 

If file exists, then cmd is executed (Not reverses 
the logic.) 

If txtl is the same as txt2, including case, then 
cmd is executed (Not reverses the logic.) 

Transfers control to the line marked by label 

Names the line to be reached by a Goto 
command 

Loops through the items in set, executing cmd 
for each loop and replacing any instances of var 
with the the matching item from set, which can 
be a list separated by spaces or can contain the 
wildcard characters * and ? 

Shifts command line parameters one place so 
that %1 becomes %2, %2 becomes .%3, and so on 

Executes batfile with args and then returns to 
the calling batch file 

Makes current environment variables local to this 
batch file; any changes to variables are known 
only in this batch file until EndLocal is executed 

Makes environment variables known to the 
system; any changes made after EndLocal remain 
in effect when the batch file terminates 

Saves the current directory on a directory stack 
and changes to dir 

Restores the last directory saved by PushD 

Suspends processing until a key is pressed 

I 

: .. 

I: 

I: 
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WINDOWS TIP: The Rem command is the documented 
way to put comments in your batch files, but it is intrusive 
because the command looks like part of the comment. 
Furthermore, if you leave echoing on while debugging a 
batch file, all of your comments are echoed, making it 
harder to read commands. A better way to comment· code 
is to use two colons, as shown below .. 

:: This line is for humans: computers ignore it 

This kind of comment is never echoed. Be sure you use 
two colons-using only one creates a label that might 
conflict with a legitimate label. Although this commenting 
style is handy, we use the conventional Rem statement in 
this book's examples to avoid confusing readers who miss 
this tip. 

Anatomy of a Batch File 
Rather than trying to discuss each batch file feature in succession, let's 
plunge into the deep end and learn by example. If you're new to batch 
files, the following batch file is easy enough that you can probably figure 
it out, though it won't be easy going. Yet the example is interesting enough 
that you might learn something new even you're a batch file wizard. 

The most important step in writing a batch file (or any other kind of 
computer program) is to state the problem correctly. In this case, the prob­
lem is to quickly and unobtrusively wipe all of the data off a floppy disk, 
leaving the disk bare except for a label name. 

Sounds simple enough, and in fact the Format command can handle 
the quick part if you specify the /Q option. However, the unobtrusive part 
is a problem because Format pauses three times-first to remind you to 
insert the disk, second to ask for the label, and third to ask if you want to 
format another. You can get rid of all those interruptions by creating a new 
WipeOut command that works when you enter a command to specify the 
drive arid the volume name, like this: 

C:\)wipeout b datadisk 
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Our WipeOut command works only on drives A and B, because the 
last thing anyone needs is a quick, efficient way to reformat a hard disk. 
Take a moment to read through WIPEOUT.BAT before we examine it line 
by line. 

@echo off 
rem Check for missing argument 
if "%1"=="" goto Syntax 
rem Validate drive argument 
if %l==b goto Format 
if %l==B goto Format 
if %l==a goto Format 
if %l==A goto Format 
echo Invalid - you must specify floppy drive A or B 
echo. 
goto Syntax 
:Format 
rem Create file to supply input to Format command 
echo. > %temp%\WIPEOUT.TMP 
echo n » %temp%\WIPEOUT.TMP 
rem Quick format using file input to suppress prompts 
format %1: /q /v:%2 < %temp%\WIPEOUT.TMP > NUL 
rem Delete the temporary file 
del %temp%\WIPEOUT.TMP 
goto Done 
rem Display syntax message after invalid input 
:Syntax 
echo SYNTAX: WipeOut {AAIB} [volume] 
:Done 

By default, batch files display each line on the screen before attempting 
to execute it. This is seldom desirable, so probably 95 percent of all batch 
files start with the same line ours starts with: 

@echo off 
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The at sign (@) says not to display the Echo Off command. The Echo 

Off command says not to display any more lines for the rest of the batch 
file. 

The next line tests to be sure the command wasn't used without any 
arguments: 

if "%1"=="" gata Syntax 

The %1 represents the first argument on the command line. (A %2 would 
represent the second, and so on up to %9. A %0 would represent the 
command name, or WipeOut in this case.) So if you type the command 
wipeout a, the command interpreter would see this as the second line in 
the batch file: 

if "a"=="" gata Syntax 

The test for equality would not be true, and so the Goto statement would 
not be executed. But if you type wipeout (without any arguments), the 
command interpreter would see 

if ""=="" gata Syntax 

and the Goto would be executed. 

Notice that the %1 is surrounded by quotation marks. This isn't a 
requirement. We could just as easily have written %1 $==$. All we're doing 
is making sure the command interpreter always sees something on both 
sides of the equal signs. Without a character there, it sees the line as: 

if == gata Syntax 

The result would be a syntax error, causing the batch file to terminate. The 
quotation marks are a readable way to be sure neither side is ever empty. 

If the Goto is executed, the command interpreter jumps to the line 
with the matching label and starts executing the lines it finds following the 
label. A label is a line starting with a colon. In this case the Syntax label is 
near the end of the file. 
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:Syntax 
echo SYNTAX: WipeOut {AAIB} [volume] 

The Echo command displays the text following it-in our case, the 
WipeOut syntax for users who type something invalid. The interesting thing 
about this line is the use of the escape symbol (1\) to indicate that the pipe 
( I) should be treated as a character and not interpreted as a pipe symbol. 
Without the escape symbol, the command interpreter would try to pipe the 
Echo command and the first few words to whatever follows the pipe symbol, 
which would cause a syntax error. You must use the escape symbol any 
time you want to echo a pipe ( I), a greater than sign (», a less than sign 
«), an ampersand (&), or a caret (1\). 

NOTE: MS-DOS has no escape symbol; you cannot echo 

command symbols. This is one of several reasons that 

WIPEOUT.BAT can't be run under MS-DOS. 

Let's go back to the top of the file and continue as if valid arguments 
have been entered for the WipeOut command. After testing for no argument, 
we test for valid arguments with the following lines. 

if %l==b goto Format 
if %l==B goto Format 
if %l==a goto Format 
if %l==A goto Format 
echo Invalid - you must specify floppy drive A or B 
echo. 
goto Syntax 

Because tests with the double equal sign are case-sensitive, we have to test 
both uppercase and lowercase variants. (Because we already know that 
argument 1 exists, we don't have to put the %1 in quotation marks.) If one 
of the four valid inputs is found, the command interpreter jumps to the 
Format label, where the main work of the batch file is done. Otherwise, 
WipeOut echoes a message telling the user what went wrong. The Echo 
command followed by a dot in the next line displays a blank line for a nicer 
display, and the next line jumps to the same Syntax label and message that 
we discussed earlier. 
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WINDOWS TIP: Before we go on to the main point of 
the batch file, here's an extra-credit problem. What would 
happen if we replaced the four lines testing for valid drive 
lett~rs with the following line? 

for %%d in (a A b B) do if %1==%%d goto Format 

And the answer is ... exactly the same thing. The For 
command loops through each of the items in parentheses, 
and for each one replaces the %%d in the Do command 
with the current item. This might be a big leap for begin­
ning batch file authors. Study the online help if you find 
the For command confusing. I' 

Finally, we get to the whole point of this exercise. The following lines 
make the Format command work cleanly with no extra messages or 
prompts. 

:Format 
rem Create file to supply input to Format command 
echo. > %temp%\WIPEOUT.TMP 
echo n » %temp%\WIPEOUT.TMP 
rem Quick format using file input to suppress prompts 
format %1: /q /v:%2 < %temp%\WIPEOUT.TMP > NUL 
rem Delete the temporary file 
del %temp%\WIPEOUT.TMP 

The problem with Format is that it is too careful and polite. First it asks the 
user to insert a blank disk (but we are assuming that WipeOut users have 
already done this), and when finished it asks if the user wants to format 
another (WipeOut users don't). We need to supply input to Format telling 
it our default responses. The way to do this is to redirect input from a file. 
The first line of this file should be blank to simulate pressing the Enter key 
in response to the "insert disk" message. The second line should supply the 
letter n to say "no, we don't want to format another." Our batch file creates 
this input file. Then, when we're done using it, WipeOut politely cleans up 
by deleting it. 
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The first Echo line redirects a blank line to the file WIPEOUT.TMP in 
the directory pointed to by the Temp environment variable. To use the 
contents of an environment variable, put a percent sign (%) on each side 
of the name, like this: %temp%. Notice that this line contains only one greater 
than sign, so that ifWIPEOUT.TMP already exists, the redirection overwrites 
it. (For more information about redirection, see "Th~ Redirection Symbols," 
page 602.) The second Echo line appends a line with an n to the file. 

NOTE: In an MS-DOS batch file line, you can't follow a 
redirection symbol with a parameter or the value of an 
environment variable. In our sample file, for example, you 
couldn't specify the Temp environment variable. This is the 

second reason that WIPEOUT.BAT doesn't work under MS-QOS. 

Finally, we reach the line that does the actual work: 

format %1: Iq Iv:%2 < %temp%\WIPEOUT.TMP > NUL 

This line says to format the disk in drive A or B (we've already verified the 
argument) with the IQ option. The IV option specifies the label name given 
by %2. It then redirects our dummy file into Format to supply answers to 
the prompts. Because we've already responded to all of the Format mes­
sages, we don't want them littering the screen. The final part of the line, 
therefore, sends the output from the Format command to the batch file 
author's black hole-the NUL device. 

But remember, the label argument is optional. What if the user doesn't 
supply one? In this case, the command interpreter sees the command as: 

format a: Iq Iv: < %temp%\WIPEOUT.TMP > NUL 

What happens now depends on what the authors of the Format command 
told it to do with a blank argument to the IV option. It could fail with an 
error message or prompt the user to fill in a label, but we're lucky this 
time-it simply ignores the option and we get the right results. 

NOTE: In some versions of MS-DOS, the IV option doesn't exist, or 
a blank IV option causes a syntax error instead of being 
ignored. That's one more reason that WipeOut doesn't work 
under MS-DOS. 
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A final word about debugging batch files: You usually have to do some 

experimenting to get your batch files to work exactly the way you want. 
You can write the batch file in one command prompt window and test it in 
another. To see exactly what the command interpreter sees, change the first 
line to: 

rem @echo off 

This "comments out" the Echo Off command so that each line echoes to 
the scre'en with parameters and environment variables filled in before it is 
executed. In our sample file, you'd probably also want to temporarily re,­
move the redirection to NUL from the Format command so that you could 
see all the output. You could also comment out the line that deletes the 
temporary input file. That way you could Type the contents of the file to 
be sure it is being created correctly. 

WINDOWS TIP: The Pause command always puts up the 
same boring message: "Press any key to continue." You 
might prefer to instruct your users to type, strike, hit, 
depress, or otherwise activate a key. You can use the Echo 
command to display your own message, and then get rid 
of the unwanted Pause message by redirecting it to the 
NUL device. You might even wax poetic. 

echo If the going gets too tough. 
echo Hit Control+C to stop this stuff. 
echo But if you'd like to see the rest of me. 
echo Continue on! Press any key. 
pause > NUL 

PushD and PopD 
A common sequence of events in a batch file is move to a specific directory, 
do some work there, and then return to the original directory. The problem 
is, your batch file can be run from any directory. If you don't know where 
you are, you can't go back. PushD and PopD to the rescue. 
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The PushD command saves the current directory and sets a new one. 
The PopD command restores the original. Normally you need these com­
mands only in batch files, but an example from the command line shows 
how they work: 

C:\bat>pushd \data 

C:\data>pushd sales 

C:\data\sales>popd 

C:\data>popd 

C:\bat> 

You can probably figure out intuitively what's going on here, but if you're 
not a programmer, you might wonder what "push" and "pop" in the com­
mand names mean. Push means to put something onto a stack. It might be 
a stack of plates or a stack of computers, but in this case we mean a stack 
of directory names. Pop means to take the top item-the only one you can 
get at-off the stack. 

In the example, we first push the BAT directory onto the stack. If we 
popped now, we'd get the BAT directory back. Instead we push another 
directory, DATA. We have to pop it off the stack before we can get at the 
BAT directory. Of course in a batch file we'd be doing some work in each 
directory before we pushed another one or popped to restore the old one. 

NOTE: The online help for PushD says that the directory 
parameter is optional, but don't believe it. If you don't supply 
the directory to the PushD command, the PopD command 
won't restore it. 

SetLocal and EndLocal 
In many cases, a batch file needs to change a standard environment variable 
such as Path. Yet it is extremely rude to change this critical variable without 
restoring it when you are finished. If you're writing the batch file for your 
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own use, it's not difficult to restore modified variables, although it gets 
tiresome after a while. But if you're writing a batch file to be run by others, 
you probably won't even know what settings to restore. 

Windows NT addresses this problem with the SetLocal and EndLocal 
commands. SetLocal makes any further settings or changes to environment 
variables local to the current batch file. EndLocal returns handling of envi­
ronment variables back to normal mode-any further changes remain after 
the batch file terminates. 

You might want to use a batch file to modify environment variables 
for either of two reasons. First, this might be the primary purpose of the 
batch file, as it is in the following short batch file (call it ADDPATH.BAT), 
which adds a directory to the end of the search path. 

@echo off 
set Path=%Path%;%l 

But more often you will use environment variables to save values or 
change program behavior within the batch file. The simple rule is to always 
use SetLocal at the start of the batch file and EndLocal at the end. Even if 
your batch file only sets a temporary environment variable, you want to be 
sure the variable is cleared on termination. Actually, the EndLocal command 
is usually redundant. If you use SetLocal, the system automatically performs 
the equivalent of an EndLocal statement when the batch file terminates. 
Technically, you need the EndLocal statement only if you plan to make a 
permanent. change to an environment variable. However, using SetLocal 
and EndLocal in pairs makes your batch files more consistent and easier to 
understand. For example: 

setlocal 
rem Set new path 
set Path=D:\BIN 
rem Do something with the new path 

endlocal 
rem Path goes back to its original value after EndLocal 
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A·'·~.·.·. i 
WINDOWS TIP: SetLocal and EndLocal are not available 
in MS-DOS, but batch file authors often try to get the same 
functionality by setting temporary environment variables. 
For example: 

rem Save old path and set new 
set Tpath=%Path% 
set Path=D:\BIN 
rem Do something with the new path 

rem Restore old path and destroy temporary 
set Path=%Tpath% 

I ~ 

set Tpath= 

The problem with this technique is that if you press 
Ctrl+C to terminate the batch file during processing, you 
never reach the lines that restore the original path. You 
end up with a modified path and a useless temporary 
variable. In contrast, if you use SetLocal, your original 
environment will be retained no matter how the batch file 
ends. If you have MS-DOS batch files that set and restore 
temporary environment variables, you might want to con­
vert them to use the Windows NT SetLocal technique. 

Customizing Your Configuration 
You can configure the way your command prompt sessions and non­
Windows-based programs work in several ways. This g~ts a bit complicated 
because different parts of the system can be configured using different tools, 
and in some cases you can use the various tools to do the same thing in 
different ways. 

The tools you use to configure command prompt sessions and char­
acter-based programs include: 

C The System applet in Control Panel and AUTOEXEC.BAT to set 
user environment variables (For information, see "Initializing En­
vironment Variables," below.) 

!! 



Chapter 19: Customizing Command Prompt Sessions A 
c Batch files to perform initialization (For information, see "Initializ­

ing Command Prompt Sessions," page 660, and "Using Logon Batch 
Files," page 662.) 

c AUTOEXEC.NT and CONFIG.NT to configure default behavior for 
MS-DOS-based programs (For information, see "Setting the MS­
DOS Configuration," page 664.) 

c Program Information Files, initialization batch files, and system 
configuration files to set behavior for specific MS-DOS-based 
programs (For information, see "Using Program Information Files," 
page 670.) 

Initializing Environment Variables 
You can preset environment variables every time you log on. Every com­
mand prompt session and every character-based or Windows-based pro­
gram you run from Program Manager, File Manager, or a command prompt 
sees these values. You can change them within a command prompt session, 
or even start a specific session with different values. But for now let's talk 
about the starting point. 

Windows NT presets some environment variables, and then lets you 
set additional variables. Three factors determine what your environment 
variables will be after you log on: 

C System variables set by Windows NT 

c Any variables set in your AUTOEXEC.BAT file 

[J User variables you set with the System applet in Control Panel 

When you log on, Windows NT scans the AUTOEXEC.BAT file in the 
root directory of your boot drive. If you use the flex-boot feature, this is the 
same AUTOEXEC.BAT file used by MS-DOS. At logon, the system does not 
actually execute AUTOEXEC.BAT as it does when booting MS-DOS. It simply 
scans for environment variables initialized with the Set command. 

If you want to set some variables for MS-DOS but not for Windows 
NT, you can move the Set statements to a separate batch file that you call 
by including a command like this in AUTOEXEC.BAT: 

ca 11 ENVDOS. BAT 
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When the system starts,· MS-DOS calls this batch file and sets the variables, 
but Windows NT does not. 

To set environment variables specific to Windows NT, use the System 
applet: 

1. Double click the System icon in Control Panel. The System dialog 
box appears. 

System 

Computer Name: conniee l~j;;~1)pil;;7!~Tn 

o;~~:~: r:-i~-:-~:-:-~:-w-s ::-:NT:-:Y-:-e-rsi:-on--:3:-.1:---"'I~::-I Ir;;0\~Cin~;~;;~~1 
. .- IlVlrtual'MelDti~:~tl 

Show list lor ~ seconds 1~;;~a~~na1\\t~1i1 

'-SY-sl-em-E-n-Yi-rOn-m-en-t -Ya-ri-ab-Ie-s:-------' IU1'1~~~lt~lp3:~;t~~11 
ComSpec = C:\windows\system32\cmd.exe 
Os2LibPath = C:\windows\system32\os2\dll; 
Path = C:\windows\system32 
windir c C:\windows 

User Enyironment Yariables for Administrator 

tmp = C:\temp I'"'". C V"" 

~ariable: IPath I Ilf'j";:~ii1sl 
Yi!.lue: ~I C=:\B=IN=N=T=;C=:\=BI=NP=O=SX=~==========~I 1~~'lleleTh;'j;1 

2. Notice the System Environment Variables group. If you click one of 
these settings, nothing happens. You can't modify these settings 
(and you wouldn't want to). 

3. Set any variables you want in the User Environment Variables group. 
To modify an existing variable, select it and then edit it in the Value 
field. To set a new variable, type its name in the Variable field and 
its value in the Value field. In either case, click the Set button (or 
press Enter) when you finish. To remove an existing variable, select 
a variable line and then click Delete. 

Your new variables are initialized and remembered when you click 
OK to leave the System applet, but they do not affect currently running 
programs. If you are running .a command prompt session, the session and 
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programs run from it do not use the new settings. If you terminate the 
session and start a new one, your new settings will be in effect. You can 
verify this with the Set command. Similarly, if you have Windows-based 
programs that use· environment variables, you must close and restart them 
before they will recognize the new settings. 

Variables set in the System applet have precedence over variables with 
the same names in AUTOEXEC.BAT. Thus, for example, if AUTOEXEC.BAT 
includes the statement 

set temp=C:\DOS\TEMP 

but you use the System applet to add the line temp=C\ WINNI\TEMP, the 
Temp variable will have the value C: \ WINNT\ TEMP. 

The Path variable is handled a little differently than other variables. 
Its final value is determined by all three sources-the System Environment 
Variables section, the User Environment Variables section, and AUTO­
EXEC. BAT. Normally the system root is set to C: \ WINNT\ SYSTEM32 or 
C: \ WINDOWS\SYSTEM32, depending on whether you installed Windows 
NT over Windows 3.1. Let's assume you have purchased some programs 
for Windows NT that you put in directory C: \ BINNT and some POSIX-based 
programs that you put in C:\BINPOSX. (BIN, for binary, is a traditional 
name for a directory that contains executable files.) You want these pro­
grams to run under Windows NT, but you don't want them in your MS-DOS 
search path. Set the following user-environment search path with the System 
applet. 

Path=C: \ BINNT;C: \ BINPOSX; 

Let's assume that your MS-DOS search path is set in AUTOEXEC.BAT as 

path C:\DOS;C:\BAT;C:\BIN; 

The effective path (which you can confirm with the Path command) is 

C:\winnt\system32;C:\BINNT;C:\BINPOSX;C:\DOS;C:\BAT;C:\BIN; 

If you want your Windows NT search path to be completely different 
from your MS-DOS search path (or if you don't run MS-DOS), set the 
complete path with the System applet and be sure that no path is set in 
AUTOEXEC.BAT. You can do this by setting DOS environment variables in 
another file, as described on page 657. 
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Initializing Command Prompt Sessions 
You can execute a sequence of commands every time you start a command 
prompt session by attaching an initialization batch file to the Program Man­
ager icon for the command prompt. For example, you might want to always 
load a file with your favorite Doskey macros. 

Use the /K option of CMD.EXE to attach initialization batch files or 
programs to command prompt sessions. The /K option (which has no 
equivalent in MS-DOS) tells Windows NT to run the command that follows 
and then return to the command prompt. You can use /K on the command 
line to specify a program, but the real power of the /K option comes when 
you use it with program icons or Doskey macros to launch startup batch 
files. For more information about the /K option, see "Launching Programs," 
page 595. 

To set up command prompt initialization, do the following: 

1. Write an initialization batch file. For example, CMDINIT.BAT might 
contain the following: 

@echo off 
rem Load standard Doskey macros 
doskey /macrofile=C:\CMDINIT.MAC 
rem Do other standard initialization tasks here 

You can initialize environment variables here if they are needed 
only in command prompt sessions. If programs started from Pro­
gram Manager or File Manager need the environment settings, use 
the System applet in Control Panel. 

2. Select the Command Prompt icon (in the Main group by default) 
and choose Properties from Program Manager's File menu. (Alter­
natively, you can select the icon and press Alt+Enter.) 

3. The Command Line field in the Properties dialog box probably 
contains "CMD.EXE." Modify it as follows and click OK when you 
are done: 

cmd.exe /k c:\cmdinit.bat 
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WINDOWS TIP: It's a good idea to choose a standard 
directory for all of your initialization files. Our examples 
use the root directory, hut you can use your home direc­
tory, O/OSystemRoot%, SYSTEM32, or an INIT directory 
created for the purpose. 

You can also set up a Doskey macro so that a command prompt 
window started from the command prompt initializes the same way. For 
example, you can name your macro CmdS (for Cmd Standard) and add the 
following line to CMDINIT.MAC: 

CmdS=start cmd Ik C:\CMDINIT.BAT 

You might want to have different command prompt icons for different 
purposes. Perhaps you want one command prompt icon that starts an 80x25 
command prompt window and another that starts an 80x50 window. For 
each one, do the following: 

1. Write a startup batch file for each program item. For example, 
CMD50.BAT would contain the following: 

@echo off 
mode con:lines=50 
rem Add other non-standard commands here 
C:\CMDINIT.BAT 

CMD25.BAT would be the same, except that it would contain 
lines=25. Note that the last line invokes the standard CMDINIT.BAT 
file described earlier. (Don't use the Call command to invoke this 
batch file; simply give its name to chain to it.) By invoking the 
standard initialization file rather than duplicating the commands in 
it, you make the two independent. If you want to add or modify 
standard commands, you can do so in one place-in CMDINIT.BAT. 
Custom initialization files like CMD50.BAT will then change auto­
matically. 

2. Select the program group where you want the new icons and select 
New from Program Manager's File menu. 
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3. Name the program item appropriately in the Description field-for 
example, 50-line Command Prompt. You might even want to use 
the Change Icon button to assign different icons to the two items. 

4. In the Command Line fiela, type: 

cmd /k c:\cmd50.bat 

For the 25-line item, use CMD25.BAT. Set any other fields the 
way you want them and click OK. 

To set up Doskey macros to start these sessions from the command 
prompt, add the following lines to CMDINIT.MAC: 

Cmd25=start cmd Ik C:\CMD25.BAT 
Cmd50=start cmd Ik C:\CMD50.BAT 

Notice that you have a Cmd50 batch file and a Cmd50 macro, but that's OK 
because a Doskey macro is always executed instead of an identically named 
batch file. 

Using Logon Batch Files 
If you're used to MS-DOS, you might be surprised to learn that Windows 
NT has no automatic initialization file comparable to AUTOEXEC.BAT. You 
might be even more surprised to realize that you probably don't need one. 
If you examine your MS-DOS AUTOEXEC.BAT carefully, you'll see that most 
of the tasks you do there are done in other ways under Windows NT. 

c Standard environment variables are set with the System applet. 

c Network services are loaded automatically and controlled through 
the Services applet. 

c Most MS-DOS memory-resident programs have Windows NT 
equivalents, and the ones that don't can be loaded with AUTO­
EXEC.NT or CONFIG.NT. (For information about these files, see 
"Setting the MS-DOS Configuration," page 664.) 

c Network connections are reloaded automatically if you have the 
persistent option on. 
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C Many tasks done only once in a single-tasking operating system 

must be done for every command prompt window in Windows 
NT. For example, load Doskey macros' during command prompt 
initialization, not during logon initialization. 

What's left? Not much. However, if you do have a task that you need 
done every time you log on, Windows NT provides two ways to run one­
time-only initialization batch files. 

The first way is to assign an initialization batch file as a logon sCript 
for each account you use. However, if the account you log on with is 
controlled by the network administrator, you can't assign your own logon 
script. You can ask your network administrator to assign a script for you, 
but you'll probably find it easier to start your batch file by putting it in the 
Startup group of Program Manager. For information about assigning a logon 
script, see "Using Logon Scripts and Setting a Home Directory," page 326. 

Normally you use the Startup group to start the Windows tools you 
use most often-maybe Mail, File Manager, Schedule+, and a Command 
Prompt. But there's nothing to prevent you from starting an initialization 
file like the following LOGINIT.BAT: 

·@echo off 
rem Synchronize time with server 
net time \\timesvr /set /y > %temp%\LOGINIT.LOG 
rem Add other initialization commands here 
exit 

Be sure that the programs or commands you call can't generate errors 
and aren't interactive. You might want to redirect output to the NUL device 
or to a log file. Then create a new program item in your Startup group with 
the Command Line field set to LOGINIT.BAT, and check the Run Minimized 
box so that the batch file won't have any visible output. 

If you normally start a command prompt session from your Startup 
group, you might prefer to tie your LOGINIT.BAT to the same program item. 
Select Properties from Program Manager's File menu, and view the Com­
mand Line field. If you followed the procedure that begins on page 660, 
your program item runs a file called CMDINIT.BAT with the /K option: 

cmd /k c: \cmdinit.bat 
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Change the field to run LOGINIT.BAT. 

cmd /k c: \loginit.bat 

Then remove the Exit command and add the following line to the end of 
LOGINIT.BAT so that it will chain to the command prompt initialization 
statements in CMDINIT.BAT: 

C:\CMDINIT.BAT 

Be sure that you call LOGINIT.BAT only from the Command Prompt item 
in the Startup group. You want LOGINIT.BAT to run only once, so don't 
call it from a Command Prompt item in Main or other program groups. 

Setting the MS-DOS Configuration 
The files AUTOEXEC.NT and CONFIG.NT set the configuration used by 
MS-DOS-based programs. These two files serve a purpose similar to that of 
AUTOEXEC.BAT and CONFIG.SYS in MS-DOS, but they also have important 
differences. 

Il AUTOEXEC.NT and CONFIG .NT are executed the first time an 
MS-DOS program is run in a command prompt session. Subsequent 
programs run in the same session use the settings established by 
the first program. This means that if you change either file, you 
must terminate the session and start a new one before the changes 
take effect. 

Il AUTOEXEC.BAT and CONFIG.SYS must be located in the root 
directory of your boot drive. AUTOEXEC.NT and CONFIG.NT must 
be located in the %SystemRoot<>1o \ SYSTEM32 directory. 

Il AUTOEXEC.BAT and CONFIG .SYS are the only configuration files 
needed or available under MS-DOS. AUTOEXEC.NT and CON­
FIG.NT are the default configuration files, but you can actually 
define custom configuration files for different MS-DOS-based 
applications. If you need a configuration command for only one 
particular program, consider setting up custom configuration files 
instead of using the standard ones. For information about setting 
up custom configuration files using PIFs, see "Using Program 
Information Files," page 670. 



Chapter 19: Customizing Command Prompt Sessions 

NOTE: Don't confuse MS-DOS configuration files with command 
prompt Initialization or logon initialization files. AUTOEXEC.NT and 
CONFIG.NT affect only MS-DOS-based programs. The command 
interpreter, CMD.EXE, is a Windows NT-based program and is not 
affected by anything in these configuration files. Use the /K 
option as described on page 660 to initialize a command 
prompt session. 

Using CONFIG.NT 
In MS-DOS, the CONFIG.SYS file contains special commands to load device 
drivers and set global config~ration parameters. Because some MS-DOS­
based programs depend on settings in CONFIG.SYS, Windows NT has to 
provide a comparable configuration system. In order to be compatible with 
past and future versions of MS-DOS, Windows NT does not validate com­
mands in CONFIG.NT. It recognizes and acts on some of the commands 
used in CONFIG.SYS, but it simply ignores anything it doesn't understand. 

When you first run Windows NT Setup, it scans your CONFIG.SYS and 
copies relevant settings to CONFIG.NT. You probably won't need to modify 
it further. However, if you acquire new programs for MS-DOS, you might 
need to make changes. If the manual for your MS-DOS-based program 
recommends a particular setting for CONFIG.SYS, put it in CONFIG.NT. The 
setting might not be used by Windows NT, but usually it won't do"any harm. 

Device drivers are the exception. If your CONFIG.SYS loads a device 
driver with the DEVICE= or DEVICEHIGH= statement, you might not be 
able to load the same driver in CONFIG.NT. The comments in Table 19-2 
on the next page suggest how you should handle device drivers commonly 
used under MS-DOS. 

You can generally experiment safely with CONFIG.NT settings. Win­
dows NT protects the rest of the operating system from your MS-DOS-based 
programs, so failures won't harm the system. Naturally, you won't want to 
do much experimenting with valuable data in your MS-DOS-based pro­
grams, but usually the questionable device drivers you test will fail when 
loading-before the program even starts. 
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HIMEM.SYS 

ANSI.SYS 

COUNTRY.SYS 
and SETVER.EXE 

EMM386.EXE 

SMARTDRV.SYS 

RAMDRIVE.SYS 

DBLSPACE.SYS 

Network drivers 

Drivers for 
hardware devices 

TABLE 19·2. 

Use the Windows NT version if you have 
programs that require it or if you use it in 
MS-DOS. Windows NT installs this in 
CONFIG.NT by default. 

Use the Windows NT version if you have 
MS-DOS-based programs that require it. The 
Windows NT command interpreter is not an 
MS-DOS-based program and it does not 
recognize' ANSI escape sequences. Therefore, 
you can't use them with the Prompt or Echo 
commands. 

Use the Windows NT versions as you would the 
MS-DOS versions if you have MS-DOS-based 
programs that need them. 

Don't use it. Windows NT automatically provides 
equivalent functionality and more. 

Don't use it. Windows NT has built-in disk 
caching. 

Don't use it. Windows NT doesn't support (and 
generally doesn't need) RAM drives. 

Don't use it. Windows NT can't recognize or set 
up DoubleSpace drives on a local hard drive, 
although it can use DoubleSpace drives shared 
from a networked MS-DOS computer. 

Don't use them. Windows NT has built-in 
networking. 

You generally won't be able to use the MS-DOS 
versions. Some vendors might provide Windows 
NT versions of device drivers. 

Using MS-DOS device drivers in Windows NT. 

To see output from device drivers in CONFIG .NT and from programs 
in AUTOEXEC.NT, put the EchoConfig statement at the start of CONFIG .NT. 
Use the Rem statement to add comments or to comment out statements 
during testing. Comment out the EchoConfig statement when you finish 
testing. 
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WINDOWS TIP: In MS-DOS, some people use the Shell 
statement in CONFIG.SYS to install a command processor 
with features different than those of COMMAND.COM. If 
you try this with the Shell statement in CONFIG.NT, it 
won't have the effect you want. If you prefer a different 
command processor, you must first persuade your vendor 
to write a version of the program for Windows NT. Some 
vendors are already working on it. After you have the 
command processor, simply install it with an icon in 
Program Manager the same way CMD.EXE is installed by 
default. Windows NT also provides a COMMAND.COM, 
but it is actually an MS-DOS-based program that links with 
CMD .EXE. Your command interpreter vendor probably 
provides a similar program. You can use this program in 
your Shell statement. Bottom line: Don't use the Shell 
statement unless the manual for your third-party Windows 
NT-based command interpreter instructs you to do so. 

Using AUTOEXEC.NT 
In your AUTOEXEC.NT file, you should load any programs that your MS­
DOS-based programs need. Windows NT gives you a basic AUTOEXEC.NT 
and most likely you won't need to change it. The default file loads 
MSCDEXNT.EXE, REDIREXE, and DOSX.EXE. These programs enable CD­
ROM extensions, network services, and extended MS-DOS services needed 
by some MS-DOS-based programs. 

You can use AUTOEXEC.NT to load memory-resident programs, but 
read the next section for other alternatives. 

Using TSR Programs and MS-DOS Shells 
Terminate-and-Stay-Resident programs (TSRs) are a part of the MS-DOS 
culture. They provide through the back door what Windows NT provides 
through the front door. With Windows NT you don't need a hot key to 
make a TSR utility pop up over your MS-DOS-based programs. Simply run 
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a Windows-based utility and switch to its window whenever you need it. 
In other words, every Windows-based program is a pop-up TSR. Windows 
NT will eventually make MS-DOS-based pop-up programs unnecessary. 

This pie in the sky won't make you feel any better if no one has written . 
a Windows version of your favorite TSR. So, for compatibility, Windows NT 
lets you run MS-DOS-based pop-up programs, but it forces you ,to make 
some hard choices about how they run. TSR programs weren't supposed to 
work under MS-DOS, but software developers, recognizing the needs of 
their customers, found undocumented techniques for doing the impossible. 
Windows NT must support questionable programs of every sort while still 
doing its primary task-running well-behaved native programs. If the fol­
lowing description of options and settings seems complex, remember it's a 
miracle that TSRs work at all. The more TSR programs you use, the more 
likely you are to have compatibility problems and the more you have to 
experiment to find settings that work for you. 

Many of the issues associated with memory-resident programs also 
apply to command interpreter shells run from MS-DOS-based programs. 
Many MS-DOS-based programs have a shell command that allows you to 
start a command interpreter from inside the program. You can do some 
tasks at the command prompt and then return to the program with all 
settings exactly as you left them. This is a useful technique in MS-DOS and 
is supported in Windows NT, although it's much less useful in a multitasking 
operating system. 

When you run a TSR, the program makes a small part of itself resident 
in memory (usually just the part that checks for a hot key) and then termi­
nates back to the command interpreter. But which command interpreter? 
Similarly, when you use a shell command from an MS-DOS-based program, 
a command interpreter is invoked to create the shell. But which one? There's 
the rub. Windows NT provides two different ones: CMD.EXE is a 32-bit 
Windows NT-based program that knows everything about command lines 
except how to recognize hot keys from 16-bit MS-DOS-based programs. 
COMMAND.COM is a 16-bit MS-DOS-based program that knows about hot 
keys and pop-ups, but in other ways is a less capable version of CMD.EXE. 
In particular, it doesn't know about command editing and history. 

By default, when you start a memory-resident program or exit to a 
shell from an MS-DOS program, you end up running COMMAND.COM with 
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all its limitations. If you start a pop-up program from the command prompt, 
you can activate it by pressing its hot key. You can do this at the command 
prompt or in any MS-DOS program you run from the command prompt. 
The only problem is that you lose all of your command history and you 
can't edit the command line-a pretty high price for people who use those 
features hundreds of times a day. You also pay this price anytime you start 
an MS-DOS shell. 

If you don't like this choice, you can put the line 

ntcmdprompt 

in your CONFIG.NT or custom configuration file. After loading a pop-up 
program, you can continue using the command history and editing keys, 
but you can't pop up from the command prompt by pressing your program's 
hot key. If you run an MS-DOS-based program (don't use the Start com­
mand), you can pop up. If you execute a shell command from an MS-DOS­
based program, you can use editing keys and the shell has a separate 
command history, but you can't see the history from other command prompt 
sessions. This isn't as great as you might think, because you'll probably find 
yourself using MS-DOS shells less and less as you get used to having multiple 
command-prompt windows. 

TSRs are notoriously ill-behaved and are frequently incompatible with 
each other and with non-resident programs. You might find cases in which 
TSRs conflict with Windows NT-based· programs. In such a case, you can 
put the following line in CONFIG.NT or a custom configuration file: 

dosonly 

With this setting, you can run only MS-DOS-based programs after running 
a TSR or starting a shell from an MS-DOS-based program. 

You can choose among several different ways of loading memory­
resident programs: 

Il From the command prompt or an initialization batch file 

EJ From CONFIG.NT or a custom configuration file with an Install 
statement, such as: 

install=C:\BIN\POPUP.EXE 

Il From AUTOEXEC.NT or a custom startup batch file 
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If you load your TSR from the command prompt or an initialization 
batch file, you face all the potential compatibility problems and choices 
described earlier. The other methods are essentially equivalent and avoid 
some compatibility problems. However, CONFIG .NT and AUTOEXEC.NT 
(or custom files loaded in PIFs as described in the next section) are executed 
only when you run MS-DOS-based programs. You won't be able to pop up 
from the command prompt. 

WINDOWS TIP: The best way to deal with TSR programs 
is to pretend that they aren't memory resident. Simply 
leave the in running in a window like ordinary programs. 
You can move to the program at any time by clicking its 
window. Some pop-up programs have a command-line 
option that allows them to run as non-resident interactive 
utilities. If yours has this option, use it to create a program 
item in Program Manager. If your utility doesn't have a 
non-resident mode, you can get the same effect by starting 
a separate command prompt window for it. Load it 
(possibly from an initialization batch file) and then activate 
it by pressing its hot key. Then simply leave it running in 
the window. Be sure the NTCmdPrompt command is not 
set, because this would prevent you from activating the 
pop-u p program from the command prompt. 

Using Program Information Files 
Program Information Files-commonly called PIFs-smooth the rough 
edges between the Windows environment and non-Windows-based pro­
grams. PIFs from earlier versions of Windows are recognized under Win­
dows NT. 

Windows NT is smarter than Windows 3.1 and can usually guess the 
appropriate behavior for an MS-DOS-based program without a PIE How­
ever, PIFs are still recognized, and in fact have some new features. You can 
create new PIFs with Windows NT and have them run correctly under 
Windows 3.1. Or you can run your old PIFs from Windows (any version) 
under Windows NT. Many of the Windows PIF settings are irrelevant under 
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Windows NT but do no harm. They are simply ignored. If you use flex boot, 
be sure to define all of the appropriate fields for both Windows and Win­
dows NT so that your PIFs run correctly in both environments. 

The file _DEFAULT.PIF in the %SystemRoot% directory determines the 
default behavior when Windows NT starts an MS-DOS-based program that 
doesn't have a PIF. When creating a new PIF, you might find it more con­
venient to edit _DEFAULT.PIF and then rename it with Save As rather than 
starting from scratch. You might also want to modify _DEFAULT.PIF to 
change the default behavior of MS-DOS-based programs. 

Creating or Modifying a PIF 
Windows NT includes a program called PIF Editor, shown below, that lets 
you create a new PIF or modify an existing one. To start PIF Editor, dou­
ble-click its icon in the Main program group of Program Manager. 

file Mode Help 

f,rogram Filename: IMEM.EXE 

Window Iitle: 

.Qptional Parameters: 

IMS-DOS Memory Analyzer 

litartup Directory: 

~ideo Memory: @ Text 0 low Graphics 

Memory Requirements: KB Required 1128 1 
EMS Memory: KB Required ~ 

XMS Memory: KB Reguired ~ 

o High Graphics 

KB PreferreQ 1640 1 
KB!,.imit ~ 

KBlimit ~ 
. Display Usage: 0 FylJ Screen 

@ Windowed 

Execution: rEl !!.ackground 

o Exclusive 

o ,C,lose Window on Exit 

To create a new PIF, simply make your entries in PIF Editor's initial 
display. To modify an existing PIF, choose Open from PIF Editor's File menu 
and select the PIF you want to edit. 

When you finish making changes, choose Save or Save As from the 
File menu. Use Save As to name a new PIF or rename an existing one. 
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Many of the fields in the PIF Editor window are for older versions of 
Windows. Although Windows NT ignores them, you should set these fields 
if you want to use the same PIF in other environments. PIF Editor has 
complete help on all fields, even those ignored by Windows NT. Table 19-3 
describes only the fields used by Windows NT. 

Program 
Filename 

Window Title 

Optional 
Parameters 

Startup 
Directory 

Display 
Usage 

EMS Memory 
andXMS 
Memory 

TABLE 19·3. 

PIF Editor fields. 

" 

Use the name of an EXE, COM, BAT, or CMD file. PIFs 
are usually used for MS-DOS-based programs, but 
they also work with character-based programs for 
Windows NT or OS/2. 

Enter the name you want to appear under the program 
icon and on the title bar of the window. 

Provide command-line arguments or use a question 
mark (?) to have Windows NT prompt you for 
arguments. Any arguments you provide when starting 
a PIF from a command prompt or a program item 
override arguments in the PIF. 

Normally leave this blank so that the program starts in 
the current directory. 

Select full-screen or windowed. You can switch a 
running program to the other mode by pressing 
Alt+Enter. (RISC-based computers always run 
windowed regardless of this setting. On x86-based 
computers, graphics-based programs for MS-DOS 
always run full-screen regardless of this setting.) 

Windows NT is very flexible in how it allocates 
expanded (EMS) and extended (XMS) memory. If you 
will use the PIF under Windows 3.1, choose whatever 
settings are appropriate for that environment. If you 
will use it only under Windows NT, you can usually 
get maximum flexibility by specifying 0 for the KB 
Required field and -1 (that is, as much memory as the 
program requests) for the KB Limit field. 

(continued) 

1 

1 
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TABLE 19-3. continued 

Close 
Window on 
Exit 

Reserve 
Shortcut Keys 

Application 
Shortcut Key 

If selected, the window closes when the application 
terminates. This is usually the appropriate setting for 
interactive programs, but for programs that leave 
output on the screen, you might want to leave this 
box deselected. The application remains on screen in 
an inactive state so that its output can be examined. 
Use the Control menu to close the window. 

If your application uses one of the Windows NT 
shortcut keys, select the appropriate key to prevent 
Windows NT from acting on the keystroke while the 
application is active. (You set this option by first 
clicking the Advanced button.) 

You can assign a shortcut key to switch to your 
application when it is running. (You set this option by 
first clicking the Advanced button.) 

You can set custom files for a MS-DOS configuration and startup from 
the Windows NT PIF Editor (but not from the Windows 3.1 PIF Editor). 
Click the Windows NT button in the main PIF Editor screen to get the 
following dialog box. 

= Windows NT Options 

Custom loiS-DOS Initialization Files----------, 11A1l~~1 

Autoexec Filename: IMMbinrnffifit1'i:@fM".I'.'!:ii-:" I 
tonfig Filename: \:tSystemRoot:t\SYSTEM32\CONFIG_NT Ir~e1'1 

o Compatible Iimer Hardware Emulation 

This is where you enter the names of configuration files for specific MS­
DOS-based programs. As you can see, the defaults are CONFIG.NT and 
AUTOEXEC.NT. You can replace these with the names of your custom files. 
The easiest way to create custom configuration files is to copy CONFIG.NT 
and AUTOEXEC..NT to the filenames you choose. Then use an editor to add 
any additional statements required for the specific program .. 

The Windows NT Options dialog box also has a c~eck box for Com­
patible Timer Hardware Emulation. You can generally leave this field as is. 
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If you use a timing-dependent MS-DOS-based program that doesn't work 
correctly under Windows NT, try checking this box. Some MS-DOS-based 
games need this setting. 

USing PIFs 
If you want to run a PIF from an icon, choose New from Program Manager's 
File menu. Enter the filename of the PIF-including the path and PIF ex­
tension-in the Command Line field. Fill in other fields the way you want 
them and click OK. You can also run a PIF by double-clicking it in File 
Manager. 

You can run a PIF from the command prompt, but you must use the 
Start command and provide the full path and PIF extension. For example, 
assume that you have a PIF for the Mem program in the %SystemRoot% 
directory. Set the Display Usage to Windowed and deselect the Close Win­
dow on Exit box. Create a new Mem program item in Program Manager 
with %SystemRoot% \MEM.PIF in the Command Line field. Now try running 
the Mem command in different ways. First run from the command prompt: 

C:\)start mem Ie 

The Mem command works, but the PIF settings are ignored (unless the PIF 
happens to be in the current directory). The output ofMem flashes on screen 
and then disappears because the Close Window on Exit setting is ignored. 

Now try it with the full path and PIF extension: 

C:\)start %systemroot%\mem.pif Ie 

This time the PIF settings do have an effect. The output appears, but the 
window doesn't close when the program terminates. Notice that the window 
title identifies the program as inactive. You can read the program output 
and then close the window by double-clicking the Control-menu box. Here's 
a Doskey macro that makes running the program a little easier: 

C:\)doskey smem=start %systemroot%\mem.pif $* 

You might want to create a PIF and a Doskey macro for each MS-DOS­
based program you run in a separate window. An extra benefit of using a 
PIF is that window settings are saved separately for each PIF as long as the 
Window Title field is unique. For example, you can turn off the QuickEdit 
mode for your command prompt and for programs that don't use the mouse 
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(such as Mem). For MS-DOS-based programs that use the mouse (such as 
Edit), create a PIE Then whenyou run the program with the PIp, deselect 
the QuickEdit Mode check box and select the Save Configuration box. The 
program will always start with QuickEdit off regardless of settings for other 
programs or for the command prompt. 

You should establish a consistent naming convention for your configu­
ration and startup files. Under MS-DOS, the file-naming convention was 
established for you-you called them AUTOEXEC.BAT and CONFIG.SYS 
and you liked it. Windows NT recognizes AUTO EXE C. BAT , CONFIG.SYS, 
AUTOEXEC.NT, and CONFIG.NT, but you must name your own startup 
and custom configuration files. You can use the following proposed names 
as a starting point for creating your own convention. 

LOGINIT.BAT 

CMDINIT.BAT 

CMD*.BAT 

CMDINIT.MAC 

*.MAC 

CONF"'.NT 

AUTO*.NT 

Batch file called from the Startup group or as a logon 
script to do one-time initialization. If called from a 
Command Prompt item, its'last line should call 
CMDINIT.BAT. 

Batch file called with CMD /K to do standard 
initialization for a command prompt session. It 
should load CMDINIT.MAC. 

Batch file called with CMD /K to do initialization for 
a specialized command prompt session. Its last line 
should call CMDINIT.BAT to do standard 
initialization. 

Doskey macros to be loaded for every command 
prompt session from CMDINIT.BAT. 

Related Doskey macros to be loaded when needed. 

Custom configuration file to replace CONFIG.NT for 
a specific program. 

Custom configuration file to replace AUTOEXEC.NT 
for a specific program . 

..... ,. 

675 



M(Q]nU1~(QJn[F1)nU1~ 

V©tUJ~ $v~~~m 



Chapter 20 Managing Disks 679 

Chapter 21 Monitoring System Performance 713 

Chapter 22 Using the Windows NT Setup 761 
Program 





Using Disk Administrator 
Configuring space on your hard disk is no longer as hazardous as it used 
to be. Use this powerful tool to create and manage partitions, logical 
drives, and much more. 

Managing Disl< Partitions 
You can create a drive within your hard drive that you treat as a self­
contained unit. Windows NT recognizes two major types of partitions, 
primary and extended. 

Working with Volume Sets 
Disk Administrator lets you set aside space on one or more hard disks 
for use by a particular file system. 

Working with Stripes and Mirrors 
Here are more methods of distributing data across your disks. 

Saving and Restoring Disk Configurations 
Disk Administrator can save and restore disk configurations and even 
overwrite your current configuration. It proceeds with caution, of course. 
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ay back, when. the dust settled and you finally knew in 
your bones what all those pieces of your computer were 

meant to do, one fact was obvious: Without disks, you had no way to save, 
recall and modify, or archive your work. Disks, especially hard disks, are as 
essential to computer use as books and other print documents are to a 
paper-based world. 

Using Disl< Administrator 
Earlier chapters in this book have covered disk formatting, disk and file 
management with File Manager, backups, and the essentials of the MS-DOS 
FAT file system and Windows NTFS. This chapter has little to do with saving 
data, but it has everything to do with giving that data a congenial and 
well-designed home. This chapter is about Disk Administrator, a tool that 
allows you to manage the actual space on your hard disks. With Disk 
Administrator, you can adjust the space allocation on your hard drives, use 
available space more efficiently, and even define a new hard disk if you 
add one to your system. 

If you're familiar with MS-DOS, you'll recognize Disk Administrator as 
something of a graphical super-Fdisk.Even if you've never used Fdisk, 
however, you will most likely still recognize Disk Administra,tor as a tool 
for managing the spaces, known as partitions, on the hard disk or disks 
attached to your system. 

Working with storage space on a hard disk can be a tricky proposition 
because significant changes almost invariably damage or destroy disk con­
tents, as many people know from experience with procedures ,such as 
formatting, unformatting, and directory and file recovery. From this stand­
point, one of the best aspects of Disk Administrator-other than ease of 
use-is its "awareness" of potentially harmful activities. As a result, when­
ever you use Disk Administrator to alter a hard disk in such a way that 
information can be lost, Disk Administrator makes no changes to your 
system until you quit, and even then it makes the changes only after re­
questing confirmation. Furthermore, because Disk Administrator refuses to 
remove the active partition or any logical drive or volume containing NT 
system files on an x86-based machine, the files you need to start and run 
Windows NT are protected from inadvertent deletion. Thus, unlike Fdisk, 
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which can immediately and irrevocably remove your startup partition and 
make your hard disk inaccessible, Disk Administrator adopts a kinder, gen­
tler approach to hard-disk management. 

Who Can Use Disk Administrator, 
When, and For What 
Although Disk Administrator is a powerful aid in configuring and managing 
space on a hard disk, it is not a tool you need to use frequently. You need 
Disk Administrator primarily when: 

c You want to check disk size or the assigned letters of logical drives. 
(For more information, see "Starting Disk Administrator," below.) 

c You are setting up a new hard disk. (For more information, see 
"Managing Disk Partitions," page 687.) 

c You want to create or delete a logical drive, or you want to assign 
a different drive letter to an existing drive. (For more information, 
see "Logical Drives," page 697.) 

c You are comfortable enough with Windows NT that you want to 
consolidate separate regions of free space in a sin'gle volume set. 
(For more information, see "Working with Volume Sets," page 702.) 

c You want to maximize disk performance by spreading data across 
two or more disks in a stripe set. (For more information, see 
"Working with Stripes and Mirrors," page 706.) 

Starting Disk Administrator 
In order to use Disk Administrator, you must be a member of the Adminis­
trators group. If you're not, Disk Administrator refuses to start and displays 
an error message: 

;; Error' a 

• Access is denied. You must be logged on as 
Administrator to run Disk Administrator. 
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WINDOWS TIP: If you use Disk Administrator to set up 
or enhance performance on your system, save the config­
uration as described in "Saving and Restoring Disk Con­
figurations," page 709. The Windows NT Setup program 
automatically saves your original disk information in a file 
named SYSTEM on your Emergency Repair disk. If you 
change the configuration, however, and you like the new 
arrangement better than the old, save the new settings. 
That way, you'll ensure that if anything goes wrong or if 
you later make a mistake in fine-tuning the disk, you will 
be able to restore the disk to its former state. You can save 
a new disk configuration on the Emergency Repair disk (if 
you're certain that you'll never' need the original disk 
information) .or you can save it on a different floppy disk. 

. . . 

After you log on as a member of the Administrators group, you can 
start Disk Administrator in either of two ways: 

[] By double-clicking the Disk Administrator icon (which looks like 
a toolbox) in the Administrative Tools group 

[] By typing windisk or start windisk at the command prompt 
(Including start in your command enables you to continue working 
at the command prompt after starting Disk Administrator; omitting 
start essentially "freezes" the command prompt window until you 
quit Disk Administrator.) 

NOTE: You see the dialog box shown on the next page the first 
time you start Disk Administrator and after you add a new disk to 
your computer. Click OK to continue to Disk Administrator's main 
window. 
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Disk Administrator . 

Disk Administrator has determined that this is the first time 
Disk Administrator has been run. or that one or more disks 
have been added to your computer since Disk Administrator 
was last run. 

System configuration will now be updated. 

Whichever way you start it, Disk Administrator appears in a fuss-free 
window that shows the hard disk or disks attached to your system. Each 
disk is represented by a divided bar known as the disk bar on which each 
partition or logical drive is shown as a labeled segment. The window does 
not show hard disks to which your computer is connected over the network. 

As you can see in the figure above, most of the Disk Administrator 
window is self-explanatory. (Terms such as stripe set, mirror set, and volu:me 
set are defined later in this chapter.) When you first start Disk Administra­
tor, however, it does not select any logical drive, and therefore does not 
show any information in the status bar at the bottom of the window. 

To select a logical drive on the disk, click on it. To extend the selection, 
hold down etrl and click. 
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If you don't know much about disk drives and you always 
assumed that logic was the domain of Greek philosophers and, 
Sherlock Holmes, you might be puzzled by references to logical 
drives on a hard disk. Well, logic in this sense doesn't have a 
whole lot to do with syllogisms or deductive reasoning. When 
applied to a disk drive, the word logical is in many respects the 
opposite of physical. Specifically, a logical drive is a portion of a 
hard disk that you set aside, format, assign a drive letter, and treat 
as if it were a separate disk of however many megabytes you 
decide to set aside. A physical drive, in contrast, is the drive itself, 
whole and indivisible. Thus, you have a physical hard drive 
installed in your computer. On that drive, however, you can 
create many logical drives-drive C as your startup drive, plus 

. drives D, E, F, and so on. For example, suppose you have a 
325-MB hard disk. You can, if you choose, dedicate the entire 
hard disk to Windows NT. In that case, the physical drive and 
the logical drive are identical as far as you're concerned. When 
you talk about drive C, you don't care if you're talking about the 
hardware or the drive letter it bears. You might, however, decide 
to break that 325 MB into smaller chunks: 50 MB for a flex-boot 
MS-DOS/Windows NT startup drive, plus 175 MB for NTFS, and 
another 100 MB for files and programs that rely on the MS-DOS 
FAT file system. In this case, because you want each portion of 
the drive to be iqdependent of the others, you would format each 
chunk separately and assign each its own drive letter: C for the 
startup drive, probably D for the NTFS portion, and E for the FAT 
portion. Each of these resulting segments would then be a logical 
drive that is separate from, but coexists with, the others on your 
325-MB physical drive. For information about how to do this type 
of arranging, see "Managing Disk Partitions," page 687, and "Logi­
cal Drives," page 697. 
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I<EYBOAR 0 TIP: To select the first logical drive on the 
first hard disk with the keyboard, press either Spacebar or 
Enter. To select a different logical drive, use the Right or 
Left direction key to move the selection frame to the de-
sired drive, and then press Enter. To extend the selection, 
hold down Ctrl and press Spacebar or Enter. To select a 
different disk, use the Up or Down direction key. 

Notice, too, that by default Disk Administrator shows the relative sizes 
of the logical drives on the disk (drives C, D, and E in the illustration on 
page 683). If you have more than one hard disk attached to the system, Disk 
Administrator also shows the disks in proportion to one another, although 
the shortest disk bar is never less than 25 percent of the length of the longest 
disk bar. For information about ways to change the look of the screen, see 
"Customizing the Display," page 686. 

Quitting Disk Administrator 
You quit Disk Administrator in much the same way that you quit any other 
Windows NT program. You can do any of the following: 

[I Double-click the Control-menu box 

[I Choose Close from the Control menu 

[I Choose Exit from the Partition menu 

[I Press Alt+F4 

If you made any changes to the configuration of one or more hard 
disks, Disk Administrator always prompts for confirmation before quitting, 
asking if you want to make the changes permanent with the message 
"Changes have been made to your disk configuration. Do you want to save 
the changes?" 

If you choose Yes to save the changes, Disk Administrator updates its 
internal description of your hard disk and then tells you that the system 
must be restarted for those changes to take effect. If you choose OK at this 
point (your only option), Disk Administrator goes the extra mile by shutting 
down and restarting the system for you. 
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WARNING: Be sure that you want to make the changes before 
shutting down. You can restore an earlier configuration, but you 
can do so only if you saved the needed configuration on a 
floppy disk before making your current changes. (For more 
information, see "Saving and Restoring Disk Configurations, " 
page 709.) 

Customizing the Display 
The default Disk Administrator window is functional, easy to read, and 
particularly informative in the way it shows relative disk sizes. If relativity 
is not your style, however, or if you want to change the colors used for 
legends, use the Options menu: 

c The Colors and Patterns command lets you choose from an 
assortment of colors and patterns to customize the disk bars. 

. Colors and Patterns 

Color and paUern for: 

,!;,olors------, 

••• B 
••• 0 
B.EJG 
DED& 

faUerns-------, 

~ ~ f:;:;!:!;!j 

~ c:=J f:;:::;:;:j 
mm [:-:-:-:-:1" 

c The Region Display command lets you show the logical drives on 
'.l disk as equal-sized pieces of the disk bar. 

The default in the Region Display dialog box (shown on the 
next page) is "Let Disk Administrator decide how to size regions." 
This choice affects the sizing of each bar representing a hard disk 
attached to your system. To size the bars of one or more disk drives 
either proportionally or in equal-Sized pieces, choose the drive 
from the For disk drop-down list box and choose the setting you 
want. Click Reset All to restore decision-making for all drives to 
Disk Administrator. 
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Region Display Options 

For disk 1a.1f!J 
o Size regions based on actual size 

o Size all regions equally 

@ Let Disk Administrator decide how to size regions 

Managing Dis~{ Pariiiions 
To any operating system, including Windows NT, a partition is a portion of 
the hard disk that can be treated as a data-saving world unto itself. A section 
of the disk with its own starting and ending track numbers, a partition is 
essentially a drive within a drive. With Windows NT, you can have up to 
four partitions per hard disk. The illustration below shows how partitions 
are related to the disk as a whole and to the logical drives you refer to in 
retrieving and saving files. For ease of reference, the hard disk in the 
illustration is shown as it would be represented by Disk Administrator-that 
is, as if it had been "unwound" and stretched out linearly. 

Partition 1 
I 

Logical 
drive 1 

II 

Physical Disk Drive 
I 

Partition 2 
I 

""1"" "'I""'" """T"" 

I I 
Logical I Logical I Logical Logical 
drive 2 I drive 3 I drive 4 drive 5 

Primary and Extended Partitions 
A partition by any name is always a distinct, physical portion of a hard disk. 
When you look at partitions more closely, especially at what they hold and 
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what they do, you find subtler shades of meaning attached to them. De­
pending on the function it performs, a partition can be primarY or extended, 
and it can be an active, system, or boot partition. 

Starting with the broadest categories, you need to know that Windows 
NT (like MS-DOS) recognizes two major types of partitions, primary and 
extended. 

D A primary partition is the one used by your operating system. With 
MS-DOS, the primary partition usually holds all of MS-DOS. With 
Windows NT, the primary partition can hold the system's st~rtup 
files only, or both the startup, files and the files needed to give the 
operating system its functionality. If your computer is set up as a 
flex-boot system, the primary partition contains both MS-DOS and 
part or all of Windows NT. You can create four primary partitions 
or three primary and one extended partition per hard disk. If you 
are partitioning a disk, bear in mind that you cannot subdivide a 
primary partition into multiple logical drives, but you can subdivide 
an extended partition. 

D An extended partition, of which you can have only one per hard 
disk, covers whatever space remains after you create your primary 
partition or partitions. You cannot boot from an extended partition, 
but you can divide the space in it into as many logical drives as 
you want, of whatever size you want. Each drive in an extended 
partition can be formatted separately for the FAT file system, NTFS, 
or HPFS, and can be treated as a physically separate disk drive. 
During installation, Windows NT can be set up to start from the 
primary partition but run from a logical drive in an extended 
partition. 

The illustration on the next page shows how Disk Administrator dis­
plays information about a 325-MB hard disk divided into a 175-MB primary 
partition and a 150-MB extended partition that is further divided into two 
logical drives, D (formatted for NTFS) and E (formatted for the FAT file , 
system). 
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~-----------------D-is-k-Ad-m-in-is-tr-at-or------------------If~ 

Whereas primary and extended partitions refer to physical portions of 
a disk, system partition, active partition, and boot partition refer more to 
functionality .. The three are closely related: 

c 1'he system partition is the partition that contains the files needed· 
to load Windows NT and enable the operating system to use your 
hardware. It must always be a primary partition, and on xS6-based 
computers, it must be marked as active (a term you might remem­
ber from using the MS-DOS Fdisk program). 

c The active partition must be a primary partition. It is the partition 
from which the computer starts up. If you use Windows NT 
exclusively, the active partition must be the same as the system 
partition. If you use Windows NT and MS-DOS, the active partition 
must contain the startup files for both operating systems. If you 
use Windows NT and OS/2, each operating system occupies its 
own system partition, so you must use Disk Administrator to mark 
the OS/2 partition as active before you run OS/2. After marking 
the active partition, reboot the computer. The concept of the active 
partition applies only to xS6-based computers. RISe-based com­
puters are handled by special configuration programs; the system 
partition does not have to be marked active in order for the 
machine to boot. 

689 



690 

PAR T 5: Maintaining Your System 

EJ The boot partition, which sounds like it ought to be the one you 
boot from, is actually the partition that contains the Windows 
system and support files. If you run Windows NT from a single 
partition (either FAT or NTFS), the boot partition is, indeed, the 
same as the system partition. If you start the system from a FAT 
partition but install Windows NT in a different (NTFS) partition, 
the FAT partition is the system partition and the NTFS partition is 
the boot partition. 

Creating or deleting a partition represents a significant step in the 
configuration or reconfiguration of a hard disk. Creating a new partition 
turns disk space into virgin territory ready for definition as one or more 
logic;al drives, each of which you must format before using. Deleting an 
existing partition essentially means wiping out everything stored in it. In a 

. sense, partitioning all or part of a new hard disk is like creating storage 
where there was just the possibility of storage before. Because partitioning 
is such a sweeping act, the only time you need to create new partitions is 
when you set up a hard disk for the first time or when you plan to rebuild 
and reformat a used hard disk. The only time you should consider deleting 
a partition is when you want to reorganize a disk and are certain that all 
important programs and data have been backed up to another medium. 
Deleting a partition means starting over. 

The following sections describe how to use Disk Administrator to man­
age partitions. Primary partitions are covered first, extended partitions later. . 

Creating a Primary Partition 
To create a new partition, you heed free-that is, unformatted-space on 
your hard disk. This space can belong to a portion of a new hard disk that 
you have not assigned to either a primary or an extended partition, or it can 
be space you make available by deleting an existing partition or a logical 
drive. Remember that there are two types of partitions that you can create: 
primary and extended. 
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To create a new primary partition, one that cannot be divided into 
multiple logical drives, do the following: 

1. In the Disk Administrator window, select the disk space you want 
to include in the partition. 

2. Choose Create from the Partition menu. 

3. Type or choose the partition size by clicking the up or down arrow 
in the dialog box that appears, and then click OK. 

Disk Administrator creates the new partition and assigns it the next 
available drive letter. (Disk Administrator will warn you that the partition 
might not be accessible from MS-DOS if the partition's starting or ending 
cylinder value is too high.) You can assign a different drive letter to the 
partition with the Drive Letter command on the Partition menu. For more 
information, see "Assigning a Drive Letter," page 699. 

NOTE: If the free space you selected is already part of an 
existing partition, the Create command produces a dialog box 
for creating a new logical drive; this dialog box is almost 
identical to the partition dialog box. It appears because you 
cannot create a new partition'within an existing partition. Thus, if 
your entire hard disk has already been assigned to either a 
primary or an extended partition, you cannot create a new 
partition without first deleting an old one. There are some limits to 
this capability, however, because Disk Administrator does not 
allow you to delete either the primary partition on the startup 

. hard disk (always called disk 0) or an extended partition if it 
contains the Windows NT system files. If you have a flex-boot 
system, youjcan do this kind of partitioning by booting with 
MS-DOS and using the Fdisk utility. Be forewarned, however, that 
deleting the primary partition makes your entire hard disk 
unusable until you repartition and reformat the drive and reinstall 
your system software-not a task to be taken lightly. 
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Formatting a New Partition 
Before you can use a new primary partition or a logical drive within an 
extended partition, you must format it and, if you want, give it a volume 
label-a descriptive name, such as DATA FILES-that gives you and others 
an immediate idea of the types of information stored on it. 

Formatting is one task that Disk Administrator does not handle. To 
format a new partition or a logical drive in an extended partition, do the 
following: 

1. Quit Disk Administrator, save the changes you made, and reboot 
the computer to make the changes effective. Disk Administrator is 
fully aware of what has to happen, so all you really need to do is 
click OK a few times when Disk Administrator prompts for confir­
mation as it quits. 

WARNING: If Disk Administrator displays a message telling you to 
edit BOOlIN!, be sure to do so before restarting the system. 
BOOllNI is a file on your boot partition; to see and edit it, you 
must remove the system and read-only attributes. Restore the 
attributes after saving the edited file. For more information, see 
. "Changing Your BOOT" on the next page. 

2. Double-click Command Prompt in the Main program group to open 
a command prompt window. 

3. If you need help with the syntax of the Format command, type 
format /? or help format. 

4. To format the partition (or a logical drive in an extended partition), 
type a command such as the following: 

C:\)format e: Ifs:fat Iq Iv:fat 

This sample command formats drive E. The /FS option identifies which 
file system the partition will use-FAT, in this case. The /Q option produces 
a quick format. The N option assigns the volume label FAT as part of the 
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command and saves time by avoiding the prompt for a volume label that 
othelWise appears when formatting is complete. The volume label can be 
up to 11 characters long and can include spaces, but avoid using special 
characters such as ?, *, and especially I. 

If your Windows NT operating system files are on a drive that is 
an extended partition, you must edit the system information file 
BOOT.lNI when you create an additional primary partition. (For 
more information about' BOOT.lNI, see the troubleshooting 
chapter in the Windows NT System Guide.) 

The [operating system] section of BOOT.lNI tells Windows NT 
which partition'contains its system files. For example, if your hard 
disk contains a primary partition (drive C, partition 1) and an 
extended partition (drive D, partition 2) that holds the Windows 
NT system files, the operating system information in BOOT.lNI 
looks similar to this: 

multi(O)disk(O)rdisk(O)partition(2) 

If you now add a second primary partition, the partition 
number of the drive containing your system files changes because 
Windows NT internally numbers all primary partitions before 
numbering extended partitions. The new primary partition is 
partition 2, and the extended partition containing the Windows 
NT system files is now partition 3. 

You must edit BOOT.lNI to reflect this change before shutting 
down the system so that Windows NT can tell where to find its 
system files when you reboot. In our example, you would edit 
the operating system information in BOOT.lNI to read: 

multi(O)disk(O)rdisk(O)partition(3) 

This tells Windows NT to look for its system files on partition 
3 instead of partition 2. 
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WINDOWS TIP: If you format the drive for the FAT file 
system or HPFS, the IV option is not case-sensitive; the 
Directory, Volume, and Label commands show the volume 
label in uppercase whether you type the label name as fat 
or FAT. However, if you format the drive for NTFS, 
Windows NT distinguishes between uppercase and lower­
case. Thus, if you want the volume label displayed as N1FS, 
be sure to type the label in capital letters. 

Assigning or Changing a Volume Label 
If you choose not to assign a volume label durip.g formatting, or if you later 
decide to change the volume label to a more descriptive one, you can do 
so by using the Label command in a command prompt window. You can 
use the Label command in either of two ways: 

c To have it display the current volume label and prompt for a new 
one, type the command as label followed, if necessary, by the drive 
letter and a colon, like this: 

D:\users\default>label e: 

c To change the volume label quickly, type the label command, the 
drive letter and a colon, and the new volume label, like this: 

D:\users\default>label e: ,jean 

Remember that Windows NT is case-sensitive if the drive is formatted 
for NTFS. 

Marking the Active Partition 
on an x86-8ased System 
As mentioned before, the active partition on a hard disk is the one from 
which your computer boots. Also as mentioned, you need to worry about 
an active partition only if you have an x86-based computer. On these 
machines, one primary partition-the one containing the files needed for 
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startup-must be marked active for the computer to start itself and an 
operating system. The active partition must always be on the first hard disk 
(Disk 0) attached to the system. 

If you're familiar with MS-DOS and the Fdisk program, you already 
know that Fdisk includes an option for setting the active partition. With 
Windows NT, you use Disk Administrator to do the job. Onscreen, Disk 
Administrator indicates the current active partition with a small, x-shaped 
asterisk in the color bar above the partition. If you use Windows NT exclu­
sively, or if you use Windows NT and MS-DOS, not only do you not have 
to change the active partition, Disk Administrator won't let you. The Mark 
Active command you need is dimmed and remains inactive. However, if 
you have installed another operating system, such as OS/2, you must mark 
its system partition as active and reboot the computer in order to use the 
alternate operating sys,tem. 

To mark the active partition and start a different operating system, do 
the following: 

1. In the Disk Administrator window, select the partition you want to 
mark as active. 

2. Choose Mark Active from the Partition menu. 

3. Reboot the computer. 

Creating an E}{tended Partition 
If your hard disk contains no more than three primary partitions, you can 
create an extended partition in the remaining space. The idea of an extended 
partition is a holdover from the MS-DOS operating system, which introduced 
this feature in version 3 as a means of enabling MS-DOS to use hard disks 
larger than 32 MB. These days, the main benefit of an extended partition is 
its ability to support more than one logical drive in a single (large) portion 
of the disk. Using an extended partition, you can define different-sized 
logical drives and assign each the drive letter and type of file system you 
want it to use. 
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To creat~ an extended partition, do the following: 

1. In the Disk Administrator window, select the free space you want 
to assign to the partition'. 

2. Choose Create Extended from the Partition menu. 

3. Type or choose the partition size you want in the dialog box that 
appears. 

Mter you create an extended partition, you must define one or more 
logical drives within it and format each separately. For information about 
how to do this, see "Logical Drives," page 697. 

Deleting a Partition 
The most important thing to know about deleting a partition is this: All 
information in the partition will be irrevocably lost. So be sure that you've 
backed up all needed programs and data files before deleting a partition. 
Although the partition won't actually be deleted until you quit Disk Admin­
istrator and confirm your intention, knowing what you're about to do and 
why will avoid jolts to your nervous system. 

On an x86-based system" Windows NT will not allow you to delete 
the following: 

c The active partition on your startup hard disk 

c The partition containing your Windows NT system fi~es Cif, for 
example, you place them on a logical drive in an extended 
partition) 

CI An extended partition that contains logical drives or volumes that 
have not been deleted (To delete the partition, you must delete 
the drives or volumes first, and then, delete the partition.) 

WARNING: If you're using a RiSe-based computer, take care 
when deleting partitions. Unlike x86-based computers, your 
system does not require you to set an active (system) partition. 
Thus, it is possible for you to delete the partition that contains 
your Windows NT startup files. If you mistakenly begin to delete 
this important partition, quit Disk Administrator and choose No 
when it asks whether you want to save your changes. 
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To delete a partition: 

1. Verify that all needed files have been backed up. 

2. If the partition you want to delete is an extended partition, delete 
any existing logical drives or volumes within it. 

3. In the Disk Administrator window, select the partition you want to 
delete. 

4. Choose Delete from the Partition menu and confirm your intention 
when the Confirm dialog box appears. 

III Confirm a 
All data in the partition or logical drive will be 
lost! 

Are you sure you want to delete the chosen 
partition or logical drive? 

Disk Administrator then changes the on-screen representation to show 
free space in the area formerly occupied by the partition. At this point, the 
deletion is not yet permanent. You can create one or more logical drives in 
the, newly freed space, but you cannot format or use the space yet. Create 
the logical drives you want, as described in the next section. Then finish 
the deletion as follows: 

1. Quit Disk Administrator. 

2. Confirm that you want to save the changes and let Disk Adminis­
trator reboot the computer. 

Logical Drives 
A logical drive is a part of a partition that you "wall off' and format 'so that 
you can use it as if it were a truly separate disk drive. Because Windows 
NT understands the FAT file system, NTFS, and HPFS, logical drives can 
help you enormously in putting a single hard disk to use for storing files in 
different formats. Disk Administrator doesn't help you organize, maintain, 
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or otherwise manage a logical drive, any more than it helps you handle 
those tasks with a partition. What Disk Administrator does is enable you to 
create, delete, and assign drive letters to logical drives with a few simple 
select-and-click operations. 

Creating a Logical Drive 
Creating a logical drive is very similar to creating a new partition. It is, in 
fact, the second step in preparing an extended partition for use. To create 
a new logical drive, you must begin with some free space, either in a primary 
partition (which must become a single logical drive) or in an extended par­
tition (which can be divided into more than one logical drive). To create 
the drive, do the following: 

1. In the Disk Administrator window, select the free space you want 
to assign to the drive. 

2. Choose Create from the Partition menu. (Yes, this is the same 
command you use in creating a new partition. If the space has not 
been partitioned, Windows NT assumes that you want to create a 
partition; if the space has been partitioned, Windows NT assumes 
that you want to create a logical drive.) 

3. When the Create Logical Drive dialog box appears, either type the 
size of the drive you want or choose the size by clicking the up or 
down arrow. 

Create Logical Drive 

Minimum size for the logical drive is 

Maximum size for the logical drive is 

Create logical drive of size 

1 MB 

25 MB 

~MB 
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The dialog box initially proposes a drive size equal to the size 
of the selected free space, but you are free to make the drive smaller. 

4. Click OK, and the new drive appears in the disk bar with a drive 
letter assigned by Windows NT. The letter assigned is the next 
available in the sequence of 24 letters available for use. These letters ' 
comprise all of the alphabet except for A and B, which are reserved 
for floppy drives. 

5. Quit Disk Administrator, save your changes, and format the new 
drive as explained in "Formatting a New Partition," page 692. 

ASSigning a Drive Letter 
Disk Administrator allows you to assign drive letters to your system's logical 
drives in any order you want. If you'd rather not assign drive letters yourself, 
Windows NT takes charge of drive assignments, parceling the letters out 
according to a few simple rules: 

1. It assigns the letter closest to the start of the alphabet to the first 
primary partition on each of your hard disks, beginning with C for 
the primary partition on your startup hard disk, D for the first primary 
partition on the second hard disk (if any), and so on. 

2. ' It then assigns the next available letters, in order, to the logical drives 
on your hard disks, one after the other, beginning with the first hard 
disk (Disk 0), then the second, third, and so on. 

3. Finally, Windows NT assigns drive letters to the remaining primary 
partitions, if any, on your hard disks. 

The result, although, it can look disjointed on a system with two or 
more hard disks, is understandable, as you can see from this illustration: 

., 

First First Second Third 
Disk 0 Primary Logical Logical Logical 

; Drive C Drive E Drive F Drive G 

First Fourth Fifth ", ~Second 

Disl< 1 Primary Logical Logical Primary 

Drive D Drive H Drive F Drive J 

AOO 
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'~h~ckirlgY OurE.,vironment 

When you assign drive letters, you must remember that both your 
operating system and your application software might be making 
some assumptions about where to find specific files. To find out 
what drive-letter information is being passed to your software, 
you can check your computer's environment-a special portion 
of memory where Windows NT (and possibly other operating 
systems) find such information as the search path and the location 
of your temporary directory. To check all or part of the environ­
ment, you can use either of two commands from the command 
prompt: Path, to check on the search path for executable files, 
or Set, to request a look at all current environment variables, 
including the search path, the location of the command 
interpreter (CMD.EXE), and the values being used for your 
domain and username for the current session. 

To check these bits of information, do the following: 

1. Open a command prompt window. Press Alt+Enter if the 
command prompt appears as a full screen. 

2. To check on the search path, type path. To check on the 
current environment variables, type set. 

To save the information, redirect the command output to a 
file with a command such as set> env.txt or path> path.txt. 
Or, if you prefer, you can use the Control Menu as follows: 

1. Open the command prompt window's Control menu and 
choose Edit. When the secondary menu appears, choose 
Mark. 

2. Use the keyboard or the mouse to select the text (the 
search path or the list of environment variables) that you 
want to save, and then press Enter to copy the selection 
to the Clipboard. 

3. Exit the command prompt window, open Notepad, and 
paste the Clipboard contents into Notepad. 

If you want, print the information for a more permanent record. 
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If you want, you can use Disk Administrator to permanently assign 
particular drive letters to specific disks, partitions, or volumes. This is called 
static assignment, and it means that later on, if you add another drive, for 
example, Windows NT will assume that the statically assigned drive letter 
is unavailable for use. 

To assign a letter to a particular drive or partition, do the following: 

1. In the Disk Administrator window, select the drive or partition 
whose drive letter you want to change. 

2. Choose Drive Letter from the Partition menu. The Assign Drive Letter 
dialog box appears. 

Assign Drive letter 

25 fit B Unformatted Logical drive on disk 0 

@ Assign drive letter 11IIIl!I 
o Do not assign a drive letter 

Type the letter you want to assign, or choose the letter from the 
drop-down list box. Choose the second option, "Do not assign a drive letter," 
if you want to delete the letter assigned to a drive or partition. If you delete 
the letter and confirm the change when you quit Disk Administrator, Win­
dows NT assigns the next available letter to the drive when you restart the 
system. 

Deleting a Logical Drive 
As with any form of deletion affecting a hard disk, be very sure that you 
want to delete a logical drive. When you do this, all information on the 
drive is lost, so it's imperative to back up any programs or data you want 
to keep. (For more information about backing up files, see Chapter 13, 
"Backing Up and Restoring Files," page 361.) If you're reorganizing a parti­
tion, you might want to delete one or more logical drives-perhaps to 
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combine them as a single larger drive or to create some free space for use 
as part of a volume set or (if you have more than one hard disk) as part of 
a stripe set. 

NOTE: Don't delete a logical drive if all you want to do is 
change the file system on it. Reformatting will do the job for you. 
You can also use the Convert command from the command 
prompt to switch from the FAT file system to NTFS. If you change 
a drive from the FAT file system to NTFS, however, bear in mind 
that the file-storage structures needed by NTFS will require extra 
megabytes of space. 

Deleting a logical drive· is essentially the same as deleting a partition: 

1. In the Disk Administrator window, select the drive you want to 
delete. 

2. Choose Delete from the Partition menu. 

Just as when you delete a partition, Disk Administrator cautions you 
that all data will be lost and asks you to confirm your intention. If you 
continue, the deleted drive appears as free space on the disk bar. When 
you quit Disk Administrator, you'll be asked if you want to make the changes 
permanent. If you do, Disk Administrator saves the changes and restarts the 
computer. 

Worl<ing with Volume Sets 
A volume, according to Windows NT, is any space on a hard disk that is 
formatted for use by a particular file system. In many cases, a volume is 
equivalent to a logical drive. If you have a flex-boot Windows NT/MS-DOS 
system, for example, your drive C, which is formatted for the FAT file system, 
represents one volume. If your Windows NT files Cother than the startup 
files) are stored on drive D, that drive represents another volume. 

Because Windows NT can work with multiple disks and partitions, 
however, a volume-actually a volume set-can sometimes also be a col­
lection of discontinuous and even different-sized spaces on one or more 
disks, all of which are treated as if they were a single large volume with the 
same drive letter, as shown in the illustration on the next page. 
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Volume Set = Drive E 

I 
I 

Disk 0 Drive C ~Drive 0 "lli -~rive F-Ill 
A volume set can span more than one disk, like this: 

Disk a Drive C 
Drive E~i\'i~ ~rive F 

,------ Volume Set = Drive H 

Disk 1 Drive G 

As you can see immediately, there are two advantages to such unions: 

c You combine two smaller areas into one large logical area without 
having to repartition the disk. 

c You cut down on the number of drive letters in use, because a 
single drive letter refers to more than one storage segment on one 
or more disks. 

Volume sets have two additional but less obvious benefits. First, even 
though Windows NT allows you to combine free space on up to 32 disks 
into a single volume set, this set, once created, becomes invisible to you 
during normal use. As you save files, Windows NT fills one area after the 
other, moving in order from one area of the volume set to the next. Because 
Windows NT handles the logistics of storing and retrieving the files, even 
32 discontinuous areas on 32 separate hard disks act as a single drive as far 
as you're concerned. In addition, if you create a volume set that spans more 
than one drive, you might find that system performance improves. This is 
because disk reads and writes, which are normally slow in relation to other 
activities, are more efficient when spread across two or more disks. 
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Creating a Volume Set 
To create a volume set with Disk Administrator, you must begin with two 
or more areas of free space on one or more disks. These spaces can be 
pre-existing, or you can create them during the curre~t session by deleting 
existing partitions or logical drives. After the spaces you need are freed, do 
the following: 

1. In the Disk Administrator window, select the areas you want to 
I combine into the volume set. Remember that you select multiple 

disk regions by clicking one and then holding down Ctrl while you 
click the others. 

2. Choose Create Volume Set from the Partition menu. The Create 
Volume Set dialog box appears. 

Create Volume Set 

Minimum total size for the volume set is 2 MO 

MaKimum total size for the volume set is 244 MO 

Create volume set of total size IrIEl It) MO 

Specify the size of the volume set you want and click OK. If you 
create a volume set that is smaller than the total free space in the 
selected areas, Disk Administrator divides the free space propor­
tionally so that each piece of the volume set represents approxi­
mately the same percentage of the original free space in each 
selected area. 

When the Disk Administrator window reappears, the volume set is~ 

displayed,with the same identifying color or patte~n and the same drive 
letter at the top of each area in the volume set in the disk bar. If you click 
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one portion of the volume set, you'll notice that Disk Administrator selects 
every area in the volume set.' Quit Disk Administrator to save the changes, 
format the new multipart "drive," and your volume set is ready to use. 

Extending a Volume Set 
Although you cannot-for obvious reasons such as data loss-shrink a 
volume set, you can extend a volume set by adding one or more additional 
areas of free space. The only requirement is that the volume set be formatted 
for NTFS. 

To extend a volume set, do the following: 

1. In the Disk Administrator window, select both the volume set and 
the free space you want to add to it. 

2. Choose Extend Volume Set from the Partition menu. The Extend 
Volume Set dialog box appears. 

Extend Volume Set 

Minimum total size for the volume set is 225 MB 

Maximum total size for the volume set is 225 MB 

Create volume set of total size Iflm !jJ MB 

Specify the new total size of the volume set. If you specify less 
than the total amount of free space, Disk Administrator distributes 
the space assigned to the volume set as described in the previous 
section, "Creating a Volume Set." 
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Deleting a Volume Set 
Deleting a volume set is equivalent to deleting a partition or a logical drive 
in that all information stored in the volume set is lost To delete a volume 
set, back up all information that you want to keep, and then: 

1. In the Disk Administrator window, select the volume set you want 
to delete. 

2. Choose Delete from the Partition menu. 

Just as when you delete a partition, Disk Administrator cautions you 
that all data will be lost and asks you to confirm your intention. If you 
continue, the deleted drive appears as free space on the disk bar. When 
you quit Disk Administrator, you'll be asked if you want to make the changes 
permanent. If you do, Disk Administrator saves the changes and restarts the 
computer. 

Working with Stripes and Mirrors 
Stripes and mirrors are additional means used by Windows NT to distribute 
information across disks. Striping means to "layer" information evenly across 
two or more disks. Mirroring, as the name implies, means to duplicate 
information on two disks. 

Windows NT supports striping, striping with parity, and disk mirroring. 
However, striping with parity and mirroring are usable only on a computer 
running the Advanced Server version of Windows NT, the enhanced form 
of Windows NT designed specifically for use on large network servers 
administered by full-time professional network administrators. 

Both the striping available with the desktop version of Windows NT 
and the striping with parity available with the Advanced Server version of 
Windows NT spread data across two or more disks. Striping with parity and 
disk mirroring provide data protection that allows the server to recover from 
disk failure or data loss. Striping with parity protects data with its parity 
information, which can be used to recover data if part of a "stripe" is lost 
when a disk fails. Mirroring, as its name implies, protects data by duplicating 
it on two disks so that if one of the disks fails, data can still be recovered 

. from the "mirror image" on the other disk. 
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Windows NT, as opposed to Windows NT Advanced Server, supports 
the least sophisticated of these data-distribution methods-the creation and 
management of stripe sets that layer data evenly, in equal blocks, across 2 
through 32 disks. 

Unlike striping with parity, these stripe sets are not designed for data 
protection. Stripe sets improve system performance, but whereas striping 
with parity provides data protection (also known as fault tolerance), stripe 
sets are solely a means of making disk access more efficient. When striping 
with parity is used on a Windows NT Advanced Server machine, the server 
can recover data when a disk fails. When stripe sets are created on a regular 
Windows NT machine, disk failure means that all data is lost (which is 
another reason for regular backups). 

The rest of this discussion refers to stripe sets, not striping with parity. 

Stripe Sets Versus Volume Sets 
Conceptually, you can visualize a stripe set as something like the following, 
although in real life, of course, the disks containing the set are unlikely to 
be as symmetrically organized as the ones shown here: 

I 

Partition { ---7=-----1 

Disk 0 

Stripe set 
I 

8 

Disk 1 

I 
3 ··c~~_. -Stripe 

t 

6 
9 

Disk 2 

After such a stripe set is created, information is layered across the disks 
in the numeric order shown. 
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As you can see from the illustration, stripe sets differ from volume sets 
in two important respects: 

c A stripe set can be created only on a system with two or more 
disks; a volume set can be created on a single disk. 

a A stripe set, because it layers data evenly across disks, contains 
partitions that are approximately equal in size. A volume set can 
include partitions of different sizes. 

Stripe sets and volume sets are alike, however, in four significant 
respects: 

C Both are re~erenced by a single drive letter. 

a Both lose all data if one of the disks fails. 

a Both are selected and deleted as entire units, even though the 
storage areas they cover are physically separated on the same disk 
or on different disks. 

a Both are invisible to MS-DOS because they handle disk storage in 
a way that MS-DOS cannot recognize. 

Creating a Stripe Set 
To create a stripe set, you need areas of free space that you want to combine 
on 2 through 32 disks. The process is simple: 

1. In the Disk Administrator window, select the areas you want to 
combine. 

2. Choose Create Stripe Set from the Partition menu. Specify the size 
of the stripe set you want in the Create Stripe Set dialog box that 
appears, and click OK. 

When Windows NT creates the stripe set, it divides the areas of free 
space you selected into equal-sized partitions on each of the. disks you 
specified. 
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Deleting a Stripe Set 
As is the case with partitions, volume sets, and logical drives, deleting a 
stripe set means losing all information stored in it, so back up all data you 
want to keep before going ahead with the deletion. Otherwise, deleting a 
stripe set is easy: 

1 . In the Disk Administrator window, select the stripe set you want to 
delete. 

2. Choose Delete from the Partition menu. 

Because such a deletion affects data and the organization of your hard 
disks, Windows NT asks for confirmation before carrying out the command. 
Remember, too, that the deletion isn't permanent until you quit Disk Ad­
ministrator. If you have second thoughts, quit Disk Administrator and click 
No when asked if you want to record the change. 

Saving 018101 Resioring 
D~sk Con1iglJJraiions 

Disk Administrator, with its built-in conservatism, always requests confir­
mation before making any permanent changes to your disk configuration. 
You can, however, choose to save the current configuration or restore an 
earlier (saved) configuration. If you want, you can also search for the 
configuration used by a different installation of Windows NT and overwrite 
the current configuration with that of the other installation. 

WARNING: When you restore or replace one configuration with 
another, be aware that data loss can occur if you change the 
definition of drives, volume sets, or stripe sets. Even though Disk 
Administrator asks for confirmation before making potentially 
destructive changes to a disk, be sure you know what you're 
doing, and always involve your system administrator in any such 
activity. 
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When Disk Administrator saves or alters the current disk configuration, 
it affects the following: 

I] Drive letters 

D Volume sets 

c Stripe sets 

c Mirror sets and stripes sets with parity 

Saving, restoring, and searching for a disk configuration are all handled 
by the Configuration command on the Partition menu. When you choose 
this command, a submenu appears: 

D Save saves the current configuration on a floppy disk. Choosing 
this command causes Disk Administrator to display a dialog box 
asking you to place a formatted disk in drive A. You can save the 
configuration either on the Emergency Repair Disk created during 
setup and installation, or you can use a different disk. 

c Restore restores an earlier, saved configuration. Choosing Restore 
produces two dialog boxes. First comes a warning and a request 
for confirmation telling you that drive letters and other configura­
tion information might be lost. If you click OK to confirm, a second 
dialog box asks you to insert the disk containing the saved 
configuration in drive A. 
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a Search causes Disk Administrator to search for other Windows NT 
installations on your computer. Choosing this command produces 
the following: 

o A dialog box asking you to confirm your intention. 

o A search for other installations of Windows NT. 

o If other installations are found, a list of those installations. At 
this point, choose the one you want and click OK to replace the 
current configuration with the installation you selected. 

Breaking Up a Mirror Set 
Although you cannot create a mirror set with Windows NT (or with Windows 
NT Advanced Server), there's a remote possibility that you might have to 
deal with a mirror set on a set of disks or on a computer you take over from 
someone else. Windows NT cannot perform mirroring, but you can do the 
following: 

C Save and use the information in both partitions by assigning new 
drive letters to one or both partitions. 

C Delete the partitions and reformat them to make the space available 
for new storage. 

In order to break up a mirror set, there's one important prerequisite: 
A floppy disk containing the Windows NT Advanced Server disk configu­
ration. Without this disk, Windows NT is unable to recognize the mirrored 
volumes. To break up the mirror set: 

1 . Use the floppy disk and the Restore option of the Configuration 
command to write the Windows NT Advanced Server disk configu­
ration to your Windows NT computer. 

2. When your computer restarts, start Disk Administrator again. You'll 
see the mirrored partitions represented on the disk bar as primary 
partitions or logical drives, but without accompanying drive letters. 

3. To save the information, assign each partition a drive letter. To use 
the space for other storage, delete the mirrored volume, create a 
new logical drive, and reformat the space. 
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What Do You Monitor? 
Windows NT lets you look at your system from different angles. You can 
monitor system events, check your computer's performance as a server, 
and monitor computer efficiency. 

Monitoring System Activities with Event Viewer 
Event Viewer can tell you about four types of events on your system: 
errors, warnings, information events, and audit events. 

Monitoring System Use with Server 
If you share files and other resources, you can monitor and control user 
access using Server. The resulting event logs can be saved for future use. 

c 

715 

716 

728 

Monitoring System Efficiency with Performance Monitor 738 
When computer efficiency is a concern, Performance Monitor can step 
in and help you track a broad range of computer activities. You can 
display the results in a chart, a log, or a report-or request an alert. 
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hether you're in charge of a single workstation or an entire 
"" network, it's always possible that the imps of electronics 

will suddenly start gobbling memory, blocking communication lines, caus­
ing gridlock on a hard disk, or producing pandemonium on the data bus. 
At those times, you might wish you could dive into the system to take an 
up-close and personal look at what's going on. Well, you can't; but with 
Windows NT, you can check on what the computer system is doing. You 
can then put aside a lot of guesswork and base corrective actions on fact. 

Before you go any further, you should know that much of this chapter 
is not necessarily for everyone. Three Windows NT programs are covered 
here: 

EI Event Viewer 

IJ Server 

EI Performance Monitor 

However, only Server is likely to affect your daily work. Event Viewer 
and Performance Monitor are specialized tools that you don't need in order' 
to use Windows NT. You can run applications and access shared directories, 
files, and printers without Event Viewer or Performance Monitor. If you 
work through this chapter, you'll probably be intrigued enough by the 
capabilities of Windows NT to experiment once or twice with Event Viewer 
and Performance Monitor, but normally you won't have to pay much atten­
tion to them. 

Why is this so? First, because Windows NT has the ability to fine-tune 
itself to some degree without your intervention. Second, because monitoring 
system performance falls largely into the realm of network administration, 
the job of the all-powerful person who determines how computers on the 
network are accessed, by whom, and with what levels of permission. For 
people with such job descriptions, performance monitoring is a tool that 
can help keep the whole show running smoothly. 

Still, this book is designed to tell you about a remarkable operating 
system, and the ability to monitor system performance is a significant feature 
of Windows NT. So even if you are not a network administrator, you'll find 
this chapter useful if you have administrator privileges on your own com­
puter and you want to monitor, fine-tune, or buy new hardware for your' 
system. 
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What Do You Monitor? 
Performance monitoring is one of those subjects you can look at from 
several perspectives, seeing different pieces of the whole from each. Basi­
cally, however, performance monitoring boils down to looking at the system 
from three related, but still separate, points of view: 

[] First, there's the issue of "What's going on in there?" For this, Win­
dows NT provides Event Viewer. Event V iewer lets you monitor 
a whole slew of happenings, known collectively as events, that are 
stored continually in a set of files called event logs. Events can range 
from innocuous and expected occurrences, such as logon/logoff 
activities and print jobs, to serious and unexpected errors, such as 
driver problems or a disk on which storage space is becoming 
scarce. With Event Viewer, you can record and monitor significant 
incidents related to the computer, its security, and its applications. 

[] Second, there's the issue of how well a computer is performing its 
duties as a server. Is it being accessed too often at particular times 
of day? Are too many users attempting to open the same file at the 
same time? Can the computer handle the demands made on it as 
both a print server and a file and directory resource? To check on 
a computer's performance as a server, you use the Server applet 
in Control Panel. With the Server applet, you can find out who is 
using the server, which resources are being used, and even how 
much time has passed since a particular person used a particular 
resource. 

Il Third, there's the issue of how the computer itself is performing. 
Here, you are concerned not so much with what is happening (that 
is, with events), as you are with how well the computer is making 
things happen. If you're a programmer, for example, you might be 
interested in how quickly and effectively your program is running 
under Windows NT. This area of performance monitoring focuses 
on matters such as processor time, memory use, disk access, cache 
effectiveness, and the behavior of threads and processes. When 
you need to know how well your own computer or another 
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Windows NT computer on your network is functioning, you turn 
to Performance Monitor, which allows you to view, chart, record, 
and analyze system efficiency. 

Monitoring System 
Activities with Event Viewer 

To Windows NT, an event is any occurrence that is potentially noteworthy­
to you, to other users, to the operating system, or to an application. Event 
Viewer is the operating system's means of telling you about these events . 

. It functions as a combination report card and status report by storing lists 
of events in log files that you can review, archive, or transfer to a database 
or spreadsheet for analysis. 

Windows NT recognizes three broad categories of events: application 
events, system events, and audit events. Application events are generated 
by applications and are recorded in a file called the application log. Appli­
cation events can vary according to the occurrences that the application 
developer chooses to monitor. System events are generated by Windows 
NT itself and are recorded in a file called the system log. Windows NT 
classifies system events according to their severity as either errors, warnings, 
or information events, as follows: 

[] Errors are system events that represent possible loss of data or 
functionality. Examples of errors include events related to network 
contention or a malfunctioning network card, and loss of function­
ality caused by a device or service that doesn't load at startup. 

[] Warnings are system events that represent less significant or less 
immediate problems than errors. Examples of warning events 
include a nearly full disk, a timeout by the network redirector, and 
"illegal" transmissions routed to your workgroup or domain from 
another computer. 

[] Information events are all other system events that Windows NT 
logs. Examples of information events include someone using a 
printer connected to your computer, or the successful loading of 
a database program. 
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Audit events are generated by Windows NT when an activity you 
choose to monitor succeeds (called a success audit event) or fails (called a 
failure audit event). Audit events are recorded in a file called the security 
log. They apply only to NTFS volumes and can be either of two kinds: 

c File-related events, such as attempts to access files and directories, 
or change permissions. To control auditing of file-related events, 
log on as a member of the Administrators group, start File Manager, 
and choose Auditing from the Security menu. The following dialog 
box appears. 

Directory Auditing 

Directory: C:\RUNWIN\monitor 

o RJlPlace Auditing on Subdirectories 
Name: 

Events to Audit-----------, 

Success Failure 

Read 0 0 
~rite 0 0 
Execute 0 0 
I!.elete 0 0 
Change ~ermiuions 0 0 
Take !!wnership 0 0 

1r:~1 
1[1'C~1 

IF'~l 
I~'I 
It,s::'~;;;1 

Specify the groups or users you want to audit as well as the 
events you want to track. 

c Security-related events, such as logon/logoff events and changes 
to security policies. To control auditing of security-related events, 
log on as a member of the Administrators group, start User Manager 
and choose Audit from the Policies menu. The dialog box shown 
on the next page appears. 
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Computer: OMNI1 

o Do Not Audit 

Audit Policy 

• l~~.~i.fI.~·~.~.~:·.·~.·Y..~·~.~.~X,""'; -------'------, 
Success Failure 

hogon and logoff ~ D 
file and Object Access ~ D 
!J.se of User Rights 0 0 
User and !iroup Management 0 0 
~ecurity Policy Changes 0 0 
Restart. Shutdown. and System ~ 0 
frocess T racking ~ 0 

o Halt System when Security E.vent log is Full 

Specify the types of events you want to audit. 

WINDOWS TIP: If you track successful rather than un­
~uccessful events, you can produce massive logs in no 
time-which can, in the eyes of the honest and innocent, 
cast you in a somewhat Orwellian light. In actual fact, 
however, audits can only tell who is using what and when, 
but not why or how. Big Brother is still a little way off ... 
in this area at least. 

Event Logs 
As already mentioned, when you start Windows NT, it keeps track of events 
in one of several logs: 

[] The system log contains events generated by Windows NT itself. 

c The application log, if it exists, contains events generated by appli­
cations. These events will vary according to what the software 
developer chooses to monitor. 



Chapter 21: Monitoring System Performance 

c The security log contains events generated by the security and 
file-related audits you requested. Unlike the system and application 
logs, which can be viewed by anyone, the security log is accessible 
only if you log on as a member of the Administrators group. 

Viewing a Log 
Because Windows NT automatically keeps at least a system log, you can 
easily see what a log looks like even if you never before thought of moni­
toring system performance. To view the system log, double-click the Event 
V iewer icon. When the program starts, the system log is displayed. 

= 
}.og ~iew Qptions Help 

()5127/93 2:29:38 PM Print None 10 Guest OMNI1 
()5/27/93 2:16:33 PM Print None 10 Guest OMNI1 
()5/27/93 2:14:36 PM Print None 10 Guest OMNI1 
()5/26/93 12:06:29 PM Mouclass None 11 N/A OMNI1 
CD 5/27/93 8:48:03 AM Srv None 2013 N/A OMNI1 
05/27193 8:08:19AM Service Control Manager None 7026 N/A OMNI1 
05/26/93 3:57:36 PM Print None 10 Administrator OMNI1 

Most of this display is self-'explanatory. The following items might give ' 
you pause, however: 

IJ The icon at the far left of each line identifies the eve'nt type. You 
might see any of the following icons in an event log: 

e Error. The stop sign indicates an error event such as a loss of 
data or functionality. 

<D Warning. The exclamation point indicates a warning event, such 
as a nearly full disk. 

4) Infonnation. The lowercase i indicates an information event, such 
as someone using a printer attached to your computer. 

~ Success Audit. The lock indicates an audit event that was 
successful, such as someone sucessfully logging onto the system. 

, Failure Audit. The key indicates an audit event that failed, such 
as a failed attempt to log onto the system. 
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1:1 The Source gives the name of the application software or system 
component that logged the event. In the illustration, for example, 
Print refers to Print Manager and, Mouclass refers to the system 
component that monitors mouse actions. 

IJ The Category tells you how the event is classified by the receiving 
software. Although all you see is None in the illustration above, 
categories can be highly descriptive. The security log, for example, 
shows categories such as Logon/Logoff and Object Access (for file 
and directory access). 

IJ The Event shows the ID number used by the event-logging soft­
ware to refer to each particular type of event. 

c The User matches the name of the person Of ap'plicable) involved 
in generating the event. 

Taldng a Closer look 
To get a closer look at an event in the Event Viewer window: 

1. In the Event Viewer window, select the event you want to see. 

2. Press Enter. (Or, if you prefer, choose Detail from the View menu.) 

Event Detail 

Date: 5/26/93 EvenllD: 12 
Time: 12:06:12 PM Source: Sermouse 
!!ser: N/A Type: Information 
C0mPuler: OMNI1 Calegory: None 

,!!escriplion: 

The ring buffer that stores incoming mouse data has overflowed (buffer ~ 
size is configur able via the registry). 

D21a: @ .!!.vIes 0 ~ords 
0000: 00 00 08 00 01 00 62 00 b ~ 

1m Ii Ii !!!!In !! II ;" I 
~ ~I~ 

Immeijl l~iJ I! •• rm 1lfi!~:!~1 
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Some reports, including the one shown on the previous page, provide 
both a description of the event and hexadecimal (base-16) information, 
which can sometimes be useful if you are familiar with the program that 
generated the event. 

Filtering Events 
As you can see from even a cursory look at your system log, events can pile 
up quickly, obscuring those of a particular type (such as print jobs) or those 
that occurred at a particular date and time (such as repeated, failed logon 
attempts). You can use Event Viewer to pinpoint clusters of events, or those 
that occur cyclically, by filtering the log to display only the events that 
interest you. To do this: 

1. In the Event Viewer window, choose the log you want to filter­
system, security, or application-from the Log menu. 

2. Choose Filter Events from the View menu. The following dialog box 
appears. 

View From---' 

@ i6.i:!LE~~!l 
o Events.!ln: 

15/7/93jM 

I 3: 31 : 59 PloIiM 

Types 

[8J information 

[8J ~arning 

[8J f.flor 

Source: I (All) 

Ca!egory: I (All) 

!!..ser: I 
CO!!!puter: I 
Eyent \0: I 

filter 

View Through - lFt'llK"1'\?' 
@ Last Event I~r&cet:q 
o Events On: • 

I 6 114/93jM I~T'gean:;YI 
112 : 29 : 51 PIoIIjI If:}?RelP0?:'1 

[8J ~uccess Audit 

[8J Failure Audit 

I!I 

Specify the time period you want to see in the View From and 
View Through group boxes. You can then specify the event type 
in the Types group box, but you might find this unnecessary 
because the choices you make next in the Source and Category 
drop-down list boxes automatically turn certain event types off or 
on. (The list of source programs and categories varies, as you would 
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expect, with the type of log you choose to filter.) You can refine 
the filter request further, if necessary, by limiting the search to a 
specific user, computername, and event 10. When you have set up 
the filter as you want it, click OK. In a few seconds, a list of events 
matching your specifications appears on screen. The following 
illustration, for examp~~, shows the results of searching a security 
log for all guest logon activity between 8 A.M. and 6 P.M. on May 
26, 1993. 

Searching for Events 
The Find command on Event Viewer's View menu gives you another way 
to search a log. Although less useful than filtering by dates and times, Find 
is exactly what you need when you want to find a single needle in an event 
haystack. When you choose Find, the following dialog box appears. 

Types 

[g] !In!~!:~~i~~:n] 
[g] \1/ arning 

[g] ,Error 

Find 

[g] ,[uccess Audit 

[g] F~ilure Audit 

Source: I (All) 1!lI~ta~m 
Ca!egory: ~(A=I=I)================~I!I~'~ Direction 

Eyent 10: I 0 UJ! 

COmPuter: I @ Dow!! 

!J..ser: I 
.Q.escription: I 
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Most of this dialog box is similar to the Filter dialog box, but some 
elements are new: 

c The Description box allows you to type a portion of the text 
description you see when you view the event details. If you specify 
text here, you can zero in on exactly the event or events you seek. 
However, the Find command does not search for hexadecimal data; 
you cannot type a set of hexadecimal numbers and expect Find to 
show you the event that produced those numbers in the Detail 
dialog box. 

c The Clear button returns you to the default settings for the Find 
command. 

c The Direction box lets you specify the direction of the search. If 
you neglect to specify a direction, don't worry. When Find reaches 
the end of the log, it displays a message asking if you want it to 
continue from the beginning. However, the Direction box can save 
you time by letting you search through the event log from the 
current position to the end (Down), or from the current position 
back to the beginning (Up). 

c The Find Next button is the Find command's version of OK, 
meaning "go and do it." The first time you use Find, you might 
assume that the dialog box will remain on screen so that you can 
click Find Next again if the Find command locates the wrong event 
among several similar or identical events. Not so. The dialog box 
disappears when you click Find Next, but you can repeat the search 
from the keyboard. Press F5 to repeat the search until you find the 
event you want. 

Managing Logs 
Beauty is said to be in the eye of the beholder. So too is the importance of 
a Windows NT log. If you work in a security-conscious environment, or 
one in which users freely access resources on each other's machines, you'll 
find the event logs useful in helping you keep track of who, what, when, 
and where. If you don't care about such details, the system log will probably 
be of little interest to you, but the security log can still be helpful in letting 
you see how shared resources are being used, and the application log can 
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give you insight into how application programs are working. Although 
applications must be designed to record their "thoughts" in the application 
log, those that do provide an obvious benefit-to you, your technical sup­
port person, and even the developer-by profiling their behavior in the log. 

If your computer is set up to share files or a printer with other users, 
checking the system log for print jobs and the security log for logon/logoff 
access will give you a feel for how and when your computer's resources 
are being used. Although the information might simply make you feel more 
in control of your system, you might also find patterns that help you deter­
mine better ways to manage it. Bear in mind, however, that to view the 
security log, you must log on as a member of the Administrators group. 

WINDOWS TIP: If you install Windows NT over an 
existing version of Microsoft Windows, at some point you 
might be greeted at startup with a message telling you that 
the system log is full. If this happens, you can restore peace 
and serenity by optionally saving the log and its contents 
and then choosing the Clear All Events command from 
Event Viewer's Log menu, or by increasing the log size. 
These options are described in the following sections. 

Saving a Log 
You can save the events recorded in your logs for historical purposes, for 
comparison over time, or to document or analyze system use. To save a log 
file, choose the Save As command from Event Viewer's Log menu. This 
command is similar to other Windows NT applications and utilities except 
for the Save File as Type list box, where you choose the format in which 
to save the log. You can save a log in one of two formats: 

e If you choose log-file format, the information is saved in a file with 
the extension EVT. You can later view the file in Event Viewer, 
where it looks just like any current event log. 

e If you choose text-file format, the information is saved in a file with 
the extension TXT, in either of two forms: as a "normal" text 
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document of the type you load into a word processor, or as a 
comma-delimited text file of the type you load into a field-oriented 
application such as a spreadsheet or a database. 

The following illustration shows part of a security log saved in text 
format after being loaded into Microsoft Word for Windows. 

6/2193,9:26:28 AM,Security,Success Audit,Object Access ,562,NT 
'AUTHORlTYlSYSTEM,161831,Handle Closed:~ 

Object Server: Securit~ 

Handle 1D: 140~ 
Process 1D: 86~ 

~ 
6/2193,9:26:28 AM,Securit17,Success Audit,Object Access ,561,Guest,161831,Handle Allocated:~ 

Handle 1D: 140~ 
Operation 1D: {O,7912}~ 

Process 1D: 86~ 

~ 
6/2193,9:26:28 AM,Securit17,Success Audit,Object Access ,560,Guest,161831,Object Open:~ 

Object Server: Securit~ 
Object Type: Fi1e~ 

NOTE: Saving can take a fair amount of time, You'll also notice a 
lot of disk activity as the save progresses, It's normal. Event logs, 
especially full ones, can also take a considerable amount of disk 
space, Because they include binary data, the logs you save as 
EVT files are the largest, TXT files, however, are not that far 
behind. Either type of file can require 100 KB or more of disk 
storage, so you might want to consider either saving your logs on 
floppy disk or saving them temporarily on the hard disk and then 
transferring them to floppies or tape until they are needed. 

Clearing a Log 
The opposite of saving a log is clearing one, meaning erasing all events 
currently recorded in the log. To clear a log: 

1. In the Event Viewer window, display the log you want by chOOSing 
it from the Log menu. 

2. Choose the Clear All Events command, again from the Log menu. 

725 



~ PAR T 5: Maintaining Your System 

726 

You can clear a log whether or not you save it first. Like any good 
operating system, however, Windows NT is cautious and protective of your 
well-being. It always assumes that you really, really want the information 
and so it will not clear a log without first prompting, "Do you want to save 
this event log before clearing it?" You see this message even if you saved 
the log a few seconds before. 

Modifying Settings 
By default, the system, security, and application logs all hold 512 KB of 
information (quite a lot). If the log becomes full, another default tells Win­
dows NT to begin overwriting the oldest information, but only if it is at least 
seven days old. You can adjust either or both of these default settings with 
the Log Settings command on Event Viewer's Log menu. When you choose 
Log Settings, the following dialog box appears. 

Event Log Settings 

~hange Settings for ~llBIJl1'I§iI,IlIlEI!1!1······· log 

Maximum log Size: '-15_1_2_---"'[11_· Kilobytes (64K Increments) 

[vent log Wrapping 

o Overwrite [vents as Heeded 

@ 0 verwrite [vents gJder than 17 19 0 ays 

o J!o Not Overwrite [vents (Clear log Manually) 

I ~l~m'R1;~~'1 
It~a1tt'ill~1 

The Default button on the right side returns the log you choose to the 
default settings described earlier. 

To change the default settings: 

1. Select the log you want from the drop-down list box at the top of 
the dialog box. 

2. Specify the new size of the log in the Maximum Log Size box. 

3. In the Event Log Wrapping group box, choose the option you want 
to use when the log reaches its maximum size and Windows NT 
must begin clearing away old entries. From top to bottom, the list 
represents successively more conservative options. The last option, 
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which requires you to clear the log manually, means that when the 
log is full, the system stops until you clear the log. This option 
ensures that no event records are ever lost, but it also involves a 
significant tradeoff: extra work, down time, and possibly lost data 
in exchange for the highest level of security auditing. 

NOTE: If you specify a log size smaller than the size of the current 
log, Windows NT displays an additional dialog box telling you 
that you must clear the log before the new size takes effect. This 
extra step prevents you from destroying existing records by 
inadvertently making the log too small to hold all of the currently 
recorded events. 

Monitoring Other Computers 
In this section we will assume that you're in charge of the computer at the 
hub of a domain or workgroup, and that it's your responsibility to ensure 
that all computers, especially the server, are functioning well. You have 
Administrator privileges, and are in charge of tracking down unexpected 
system, security, and application-related events. These should be the only 
reasons you monitor a computer used by someone else. After all, anything 
else would be snooping. 

Given these high moral standards, how do you find out what's hap­
pening on another computer? You use the Select Computer command on 
Event Viewer's Log menu, which produces the following dialog box. 

Select Computer 

!;;,omputer: 1-1 _________ --..1 

~elect Computer: 

.!'GOlDFINCH 
~100MllES 
jj!. RCMODEl 
jj!. BUGFIX 
jj!. ULYSSES 
jj!. FINANCE 
jj!. OMNIBUS 
I~ SUPPLIES 

I r;~';~o'''v';;''t~{'r··.·l .. t~,\,\'::>~' ~:']~'~? 0 _ 

l'faliet;i~~1 

1 ~~~''''''''~~1 !f$;H.elp.~\;i', 

!'i 
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You can choose between typing the name of the computer-not the 
user-that you want to monitor, or you can choose the computer name 
from the list box that fills the bottom part of the dialog box. If you type the 
computer name, you must precede the name with two backslashes, ·like 
this: \ \OMNII. 

NOTE: You can monitor any of the following computers: a 
Windows NT workstation, a Windows NT Advanced Server station, 
or a LAN Manager 2.x server. You must, however, log on as a 
member of the Administrators group. 

Monitoring System Use with Server 
If you regularly share files and other resources with· other users, Server 
provides you with some of the most interesting and useful information about 
your computer. Although you share files and directories with File Manager's 
Share As command, and·share and control printers with Print Manager, you 
monitor and control user access to your computer with Server. 

Server on a Windows NT workstation is a smaller version of Server 
Manager provided with Windows NT Advanced Server. Server is less com­
prehensive than Server Manager, but it is fully capable of helping you 
monitor your computer's use as a server. Unlike Event Viewer and Perform­
ance Monitor (which are also described in this chapter), Server starts from 
Control Panel in the Main program group. When you double-click the Server 
icon, the following dialog box appears. 

Usage Summary 

Sessions: 

File locks: 

2 

o 

Server 

Open Files: 4 li\1tllf~mm 
Open Named Pipes: 

~ ____________________ ~Im~~ 
.Q.escription: 
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Notice that Server, like most Control Panel applets, is a look-and-Ieave 
program: You use it, and then you close it. Server has no minimize and 
maximize/restore buttons. 

After you start Server, you can use it to check on: 

[] Who is connected to your computer 

[] Which resources have been made available for sharing 

IJ Which resources are in use, and by whom 

[] Which directories can be replicated (duplicated) on your computer 

IJ Who receives administrative alerts-notices of problems related to 
security, resource availability, and access 

WINDOWS TIP: Server is the graphics-based equivalent 
(and more) of the command prompt Net Session and Net 
Statistics commands. If you prefer to do your monitoring 
from the command prompt, see "Checking from the Com­
mand Prompt," page 733. 

Monitoring Users 
With Server,You can see who is currently using which resources on your 
computer, as well as how long the person has been logged on and how 
much time has passed since the user last initiated an action. To do this: 

1. Click Users in the Server dialog box to display this dialog box: 

User Sessions 

I;.onnected Users Computer Opens Time Idle Guest 

brucem BRUCENT 3 0228 0001 Yes n Craig 
n JOANNEW 

Connected Users: 2 

Resource 

I

.!': IFC! 
.~ print$ 

Craig Stinson 
J0.A:NNEWNT 

03:17 00:03 No 
03:17 00:03 No 

Opens Time 

02:28 
02:28 
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2. When you click the name of a user, the lower part of the dialog box 
shows the resources the selected person is using, the number of 
times each resource (such as a file) has been opened, and the 
amount of time the resource has been open. 

3. Use the Disconnect button to disconnect the selected user; use the 
Disconnect All button to disconnect everyone. However, don't 
disconnect anyone without letting the person know what you intend 
to do. For information about sending alerts to users connected to 
your system, see "Sending Alerts," page 732, and "Making Your 
Intentions Clear," page 737. 

Monitoring Shared Resources 
Server's Shares button shows you pretty much the same information as the 
Users button, but from a different perspective. When you click the Shares 
button, you see a dialog box like this: 

Shared Resources 

~harename Uses Path 

3K 1054hp 1 hp laser'et series ii ,ID 
fi;J A$ 
fi;J ADMIN$ 
fi;J 8$ 
fi;J 8 RADYCO 

Connected Users 

rWiiii# 
Connected Users: 1 

0 
0 
0 
0 

A:\ 
C:\winnt 
8:\ 
D:\8RADYCO 

Time In Use 

00:00 No 

l~llftiJl'1iG~lfim 'iIa;r~~i~ll Imm.1iil 

Here, the top of the dialog box lists the shared resources on your 
computer. The Uses column tells how many people have connected to the 
resource. The Path column gives the name, such as hp laserjet series ii, or 
the directory path of the resource. 
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To see who is using a particular resource, click to select it. The lower 
portion of the dialog box will list the people using the resource, including 
the amount of time each has been connected and whether the person 
currently has the resource open. 

As in the User Sessions dialog box, you can use the Disconnect and 
Disconnect All buttons to kick users off the computer, either individually 
or as a group. But remember to be polite when disconnecting people. For 
information about sending alerts to users connected to your system, see 
"Sending Alerts," page 732, and "Making Your Intentions Clear," page 737. 

Controlling Resource Use 
When you want to see exactly who is doing what and where, you use 
Server's In Use button. Clicking it produces the following dialog box. 

~ '" 
.. 

I 

Open Resources: 7 
File Locks: 0 

!lPened by For Locks Path 
brucem Wllte 0 \PIPE\spoolss + 

~ brucem Execute 0 C;\winnt\s!,'stem32\spool\DRIVERS\W3ZX8 
~ brucem Execute 0 C;\winnt\s!,'stem32\spool\DRIVERS\W3ZX8 
~ JOANNEW Write 0 C;\RUNWIN\TlNKER.DOC 
~ JOAN NEW Write 0 C;\RUNWIN\EVERS.DOC 
~ JOANNEW Write 0 C;\RUNWIN\CHANCE.DOC* 

1~'~ClO$I."~t II rReitesh~:' IlrfiO$en'esouJC(;':I IfCi0$6"A:ifRe$OUfces':J I F~"lleiP~":" I 

This dialog box lists each open resource, the name of the connected 
user, the type of permission held by the user, the number of locks on the 
resource, and the path to the resource. 

This dialog box offers several buttons: 

C Refresh tells Windows NT to check for open resources and update 
the displayed list. The resource list is static, so the Refresh button 
is helpful if you've left the dialog box open and unused for awhile 
or if people are connecting and disconnecting to your computer 
like partners in a square dance. 

[J Close Resource closes the selected resource. Be careful. Closing a 
resource is like disconnecting a user. 

731 



732 

PAR T 5: Maintaining Your System 

I.!I . Close All Resources shuts off access to all shared resources on the 
system, leaving currently connected users in the lurch. Remember 
to send a message before closing one or all resources on your 
system-unless no one is connected. For information about send­
ing alerts to users connected to your system, see "Sending Alerts," 
page 732, and "Making Your Intentions Clear," page 737. 

·····"ReplitC:ltingDireetorie~ , .. , ':' ....•...•••.. '::.\, .... 
"'~""~''''::;~''',''''''' .... ~~~~,;,.,<».'''';.~'<...~:.",,,i-.~,'',~'''''l;.,,,;.~, .... :...,~,,.;,.,,:....s.,,~,,,0..:.;,,,'-<,,\~..,;,;::;,,,,:,,4...~~L,:....:..,.,,,;,..~"'~;~/;...,t,,,:.,~_::....,,:..."i.,:_~:""""'~"'~""'~..::;.."~~~~""""~,~ .... ""'~"':,.~~"';,'.,,.,"',~""':,,""'~"":...''''''':;;..~,,~ ..... ''';,'~, 

Although this feature is not directly connected to monitoring 
server use, Server also provides support for the replication of 
directories. That is, a directory and its files can reside and be 
modified on a server (always a Windows NT Advanced Server 
machine) but they can be duplicated on Windows NT worksta­
tions. When directories are replicated, any changes to the 
"master" copy are transferred to all workstations on which du­
plicates reside. Replication is thus a means of centralizing file and 
directory management, yet ensuring that accurate copies exist 
wherever they are needed. Directory replication can be enabled 
only on a server running Windows NT Advanced Server (the 
export machine). If you are running the desktop version of 
Windows NT-not Advanced Server-you can import replicated 
directories, but you cannot make them available for export. 

Sending Alerts 
The next section in this chapter describes how to use the Net Send command 
from a command prompt to send warning messages to users connected to 
your system. Windows NT supports another type of warning as well, known 
as an administrative alert. These alerts are generated by Windows NT under 
circumstances that can affect the use of a server or its resources-circum­
stances related to security, user access, and user sessions, as well as physical 
events such as available space on a disk becoming scarce. 

With Server, you can control which computers and users are sent 
administrative alerts. To do this, click the Alerts button in the Server dialog 
box. When you do, the following dialog box opens. 
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Alerts 

~end Administrative Alerts To: 
OlvlNI1 
Craig 

Hew Computer or Username: IrAdi$1 
I I '-----------' IWRenlove,) 

[J To add a computer or a user to the alert list, type either the 
computer name (for example, \ \ OMNIl) or the username (for 
example, CRAIG) in the New Computer or Username text box and 
click the Add button. 

C To remove a computer or a user, select the computer name or 
username in the Send Administrative Alerts To list box and click 
the Remove button. 

NOTE: In order for your computer to send alerts, both the Alert 
and Messenger services must be running. In order for a 
computer to receive alerts, the Messenger service must be 
running on it. To check on or start either of these services, use 
Control Panel's Services applet. Highlight the service you want 
and click the Start button to turn on the service. Note that many 
services are turned on automatically at startup. 

Checldng from the Command Prompt 
If you're a longtime user of MS-DOS or UNIX, you might be more comfort­
able working with a command-line interface. Windows NT includes a num­
ber of network commands you can use from the traditional MS-DOS 
command prompt. For more information about working from the command 
prompt, see Chapter 18, "Working from the Command Prompt," page 573. 
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To get to the command prompt: 

1. Open Program Manager. 

2. Double-click the Command Prompt icon. 

When the command prompt appears, you can use the following com­
mands to check on how your computer is being used: 

c Net Session. This command tells you who is currently connected to 
your computer and, optionally, lets you end the sessions of any or 
all connected users. The Net Session command takes the form: 

net session [\\computernameJ [/deleteJ 

where \ \ computername is, optionally, the name of the computer 
you want to check on, and /DELETE ends the connection to 
\ \ computername and closes all open files. If you omit \ \ com­
putername and /DELETE, the command reports on the local 
computer (presumably yours). If you omit \ \ computername but 
include /DELETE, the command ends the sessions of all connected 
computers. The Net Session command produces a report like this: 

Computer User name Client Type 

\\CRAIGS CRAIGS DOS LM 2.0 
\\JOANNEW JOANNEW NT 
\\BRUCENT brucem NT 
The command completed successfully. 

Opens Idle Time 

1 
3 
3 

00:00:58 
00:01:56 
00:02:10 

Net Session is a quick and easy way to see if anyone is connected 
to your computer. It is especially useful if your computer is acting 
as a server and you plan to make the computer unavailable. 

NOTE: Always send a warning to connected users telling them 
that you're going to disconnect them or shut down. Use the Net 
Session command to check on who, if anyone, is connected. To 
send the warning, use the Net Send command described in 
"Making Your Intentions Clear," page 737. 
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IJ Net Statistics Workstation. This is one of two forms in which you 

use the Net Statistics command. (The other is described next.) The 
command has a simple form: 

net statistics workstation 

which you can abbreviate as net stats workstation. This form of the 
command tells you howyour computer is performing as a work­
station on the network with a report like the following: 

Workstation Statistics for \\YOSEMITE 

Statistics since 8/28/93 10:11AM 

Bytes received 
Server Message Blocks (SMBs) received 
Bytes transmitted 
Server Message Blocks (SMBs) transmitted 
Read operations 
Write operations 
Raw reads denied 
Raw writes denied 

Network errors 
Connections made 
Reconnections made 
Server disconnects 

Sessions started 
Hung sessions 
Failed sessions 
Failed operations 
Use count 
Failed use count 

The command completed successfully. 

979315443 
10279145 
1079297331 
10279319 
1056 
5203 
o 
o 

o 
66 
o 
26 

73 
o 
o 
o 
10267750 
8 

IJ Net Statistics Server. This is the second form of the Net Statistics 
command. Again, the form is simple: 

net statistics server 
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and again you can abbreviate statistics as stats. This form of the 
command tells you how your computer is being used as a server 
for other computers. This command produces a report like the 
following: 

Server Statistics for \\YOSEMITE 

Statistics since 8/28/93 10:11AM 

Sessions accepted 0 
Sessions timed-out 12 
Sessions errored-out 2 

Kilobytes sent 2357 
Kilobytes received 2369 

Mean response time (msec) 719 

System errors 0 
Permission violations 0 
Password violations 13 

Files accessed 1028 
Communication devices accessed 0 
Print jbbs spooled 0 

Times buffers exh~usted 

Big buffers 
Request buffers 

The command completed successfully. 

o 
o 

The Net Statistics commands are useful tools for recording system use 
and performance over time. They help you evaluate how your computer is 
being used and whether you need to make changes-such as adjusting 
schedules so that people access often-used directories or files at different 
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times of the day or, perhaps, limiting printer use to certain groups or certain 
hours (although, as you'll see later in this chapter, Performance Monitor is 
a better tool for these tasks). 

To record statistics, use output redirection to send the report to a text 
file as follows: 

D To keep each set of statistics in its own file, use the following 
command, replacing filename with your own filename, such as 
Workstation-statsl or Server-statsl or Of you're working from a FAT 
volume) WKSTN-l or SVR-l: 

net stats workstation> fj7ename 

or: 

net stats server> fj7ename 

D To append statistics to a single file, use the double redirection 
symbol » as follows: 

net stats workstation » fj7ename 

or: 

net stats server » fj7ename 

Maldng Your Intentions Clear 
When you work on a single-user system, you give no thought to booting 
the computer and later turning it off at will. When your computer partici­
pates in a network with Windows NT, however, these simple acts require 
a little more reflection on your part. Remember that when you share files 
or other resources on your computer, you are responsible not only for letting 
people use the resources, but also for ensuring that they do .not lose data. 

To avoid both data loss and the specter of irate colleagues who you've 
unceremoniously bumped off the computer, make a habit of notifying 
everyone connected to your computer before you shut down, close re­
sources, or disconnect users. (Note that this does not include logging off. 
You can safely log off your machine without affecting connected users.) 
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To warn oth~rs of an impending shutdown: 

1. Double-click Command Prompt in the Program Manager group. 

2. . Use the following form of the Net Send command: 

net send /users [message] 

The /USERS portion of the command ensures that the message 
reaches all users connected to your I?achine. Replace message with 
whatever message you want to send. For example: 

C:\)net send /users Shutdown in 10 minutes; get ready. 

NOTE: The Windows NT Messenger service must be running for a 
computer to receive messages and alerts sent out over the 

network. To check or turn on the Messenger service, use Contr 01 
Panel's Services applet. If you are administering a shared 
computer, be sure that your users know about this service. If you 
are using resources on a shared computer, check your own 
system to be sure that the Messenger service is turned on. 

Monitoring System lEg1~cierncy 
with Performance Moni~or 

As its name implies, Performance Monitor helps you see how efficiently a 
computer is working. Performance Monitor is a diagnostic tool that can help 
you: 

c Establish baseline performance values for any network computer 
running Windows NT. 

c Save and compare performance values taken at different times so 
you can see whether, and in what way, a computer's response 
degrades as new or increased demands are made on it. 

When you use Performance Monitor, you specify one or more activities 
that you want to track. What exactly does Performance Monitor track? 
Everything from relatively mundane but critical activities, such as processor 
time and disk access, to far more exotic beasts, such as the number of 
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nonpaging read bytes per second handled by the network redirector, or the 
number of times per second Windows NT switches from one program thread 
(portion of an application) to another. 

Simple or exotic, the activities you choose to observe can be displayed 
by Performance Monitor in any of several ways, the most interesting being 
a "live" chart that constructs graphs resembling the output of a seismograph 
or, perhaps, a lie detector. Here, for example, is a chart showing processor 
time and disk activity on a computer with too little memory to run Windows 
NT adequately: 

The frequent-and huge-spikes on the chart, show that Windows 
NT is accessing the disk almost constantly. Why? Because not a lot of 
information can be kept in memory at anyone time. Therefore, Windows 
NT must resort to disk-based files as the processor (also quite lively in the 
illustration) works its magic on program instructions and data. 

NOTE: This chapter is meant to introduce the main features of 
Performance Monitor and help you become comfortable with 
what it looks like and what it can do. To really put Performance 
Monitor through its paces, especially in monitoring network 
performance, you need more experience and a deeper 
understanding than this chapter can provide. If you are a 
network administrator or if you really want to know the ins and 
outs of Performance Monitor, a recommended source is 
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Optimizing Windows NT, by Russ Blake and edited by Chris 
Dragich. Optimizing Windows NTis volume 3 in the set of books 
collectively titled Microsoft Windows NT Resource Kit. It is written 
specifically for administrators, developers, and advanced users 
who need detailed information on maximizing Windows NT 
performance on the desktop or on a network. 

Objects and Counters 
To understand how Performance Monitor keeps track of what's happening 
in the system, you must know what objects and counters are. Although the 
names are reminiscent of a child's game, objects and counters are, in fact, 
functionally closer to the dials and gauges in a car. They are ways of tagging 
and keeping track of all the activity that goes on "under the hood." 

In Windows NT, an object is any portion of a computer's resources 
that can be assigned characteristics and manipulated as a single identifiable 
element. Windows NT "sees" a computer system, its programs, and its data 
files as a collection of manageable objects, each of a certain type with its 
own characteristics or attributes. So, for example, when Windows NT has 
to open a file, it handles the file as an instance of an object of the type file. 
When Windows NT is told to use the first serial port, it handles the port as 
an instance of an object of the type port. 

What are counters? They are recorders that track various types of 
information about the objects they are assigned to. The processor, for ex­
ample, is an object to Windows NT. With Performance Monitor, you can 
view the information gathered by a number of counters specific to the 
processor object. Each of these counters is descriptively named for you, and 
you can choose among them. There are, for instance, counters named % 

Processor Time, % User Time, and % Privileged Time. Each monitors a 
different phase of processor activity. 

Now, on to Performance Monitor-a sophisticat~d and impressive tool 
that you might not expect if you're used to MS-DOS or Windows. 
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Starting Performance Monitor 
Before you use Performance Monitor, you must do a little preparatory work. 
This involves starting the disk performance counters, which are turned off 
by default. You only have to do this once, but until you start these counters, 
you cannot use Performance Monitor to track physical and logical disk 
activity. To start the disk performance counters: 

1. Log on as a member of the Administrators group. 

2. Start a command prompt window and type: 

C:\)diskperf \\computername 

replacing computername with the name of the machine you want 
to monitor. 

3. If the command reports that Disk Performance counters are not set 
to start when the system is booted, type the command: 

C:\)diskperf -y \\computername 

again replacing computername with the name of the computer­
your own or another-whose disk performance you want to 
monitor. 

4. Reboot the computer you specified in order to start the counters. 

After you've started the Disk Performance counters, you can open and 
work with Performance Monitor without logging on as a member of the 
Administrators group: 

1. Open the Administrative Tools program group. 

2. Double-click the Performance Monitor icon. 

Charting Performance 
When you start Performance Monitor, the first thing you see is a singularly 
unimpressive blank window, as shown on the next page. This is Perform­
ance Monitor's charting window. You can also look at performance data 
from other points of view, but charting is the default, so it's a good place 
to get started. 
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The window is blank at first because Performance Monitor needs you 
to tell it what objects to chart. 

Choosing Objects to Chart 
Perforl11ance Monitor is capable of tracking a large number of objects. Some, 
as already mentioned, are quite exotic. Others, which you'll see here, are 
easier to understand. To choose one or more objects to chart: 

1. Open the Edit menu and choose Add To Chart. The following dialog 
box appears. 

Color:I~11I Scale: 1..-110_0 _-->1_11 Width: I -- III Style: I -- III 

Performance Monitor allows you to choose the computer you 
want to monitor. Your own computer is shown by default, but you 
can either type another computer name or click the button with the 
ellipsis ( ... ) to see a list of eligible candidates. Surprisingly, you 



Chapter 21: Monitoring System Performance 

don't have to log on as a member of the Administrators group to 
monitor another computer (although you need network access). 
You should, however, notify the owner of the other computer. 

2. Use the Object list box to select the object or objects to monitor. In 
the Object drop-down list box, Processor is selected by default, but 
you can click the down arrow to see a list of other objects. 

Add to Chart 

t: Processor ';! 
Nelbeui Resource ~ 

er: 
Objecls t'" Paging File I;" PhysicalDisk 
Process ':': 
Redireclor 

~ Server 
Syslem 1= Thread ~ 

idlh:1 -- I!J Slyle:1 -- I!J Color: 

If you scroll through the list, you'll notice objects ranging from 
the cache, memory, and logical and physical disks to processes, the 
server, and program threads. If you're experimenting with Perform­
ance Monitor, some useful choices are: LogicalDisk, Memory, 
System, NetBEUI (or the network protocol you are using), and, of 
course, Processor. 

3. Next, turn your attention to the Counter list box to specify the type 
of activity that interests you. The list changes with the type of object 
chosen. Here, for example, is the list you see when you choose 
LogicalDisk: 

% Disk Read Time t+ 
t::41 
% Disk Wrile Time 

I % Free Space 
Avg. Disk Byles/Read 
AVfJ. Disk Bples/Transfer 
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% Disk Time is selected by default, and the Instance list box to 
the right shows two items, drive C and drive D. When you choose 
an object or a counter that applies to more than one active element 
(instance of that object) on your system, each element is listed 
separately in the Instance list box, so you can further refine your 
choice by specifying which particular instance you mean. In the 
illustration, for example, you could choose to monitor the % Disk 
Time for either drive C, drive D, or both. 

If you don't understand what a particular counter is or does, 
select it and click the Explain button on the right side of the dialog 
box. A definition appears at the bottom of the dialog box. 

4. To add your selections to the chart, click Add. To signal that you're 
finished, click Done. The dialog box closes and a chart plotting the 
objects and counters you chose begins to appear. 

A Closer Look at the Chart Window 
Before you move on, take a quick look at the window elements that are 
labeled in the following illustration. 

Toolbar 

Chart area 

legend area 

c The toolbar just below the menu bar contains a set of buttons that 
give you quick alternatives to choosing commands from the menus. 
To see what each button does, point to it and hold down the left 
(primary) mouse button. A short description of the button's func­
tion appears in the message bar at the bottom of the window. To 
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avoid clicking the button and thus carrying out its function, slide 
the mouse pointer off the button before releasing the mouse 
button. 

Il The labeled boxes below the chart area display, in turn, the last, 
average, lowest, and highest values currently displayed in the chart 
for the object selected in the legend area (described next). The box 
labeled Graph Time at the far right shows the interval, in hun­
dredths of seconds, between updates to the chart. The default 
interval, as shown in the illustration, is one second. 

WINDOWS TIP: If you choose to monitor processes 
(which are active programs, roughly) with Performance 
Monitor, the Instance list box shows all active processes 
on the system. For an interesting look at your system, try 
the following: 

1. Start Performance Monitor, choose Add To Chart 
from the Edit menu and choose Process from the 
Object drop-down list in the Add to Chart dialog box. 

2. Verify that % Processor Time is selected in the 
Counter list box, and select both Idle and PERFMON 
in the Instance box. (Remember that to select more 
than one item, you select the first item, hold down 
Ctrl, and then scroll to and select the next item.) 

3. Click Add, and then click Done. 

The chart that appears shows the amount of time the 
processor spends idling and the amount of time it devotes 
to Performance Monitor. If your system is quiet, the idle 
line should be very high, while the Performance Monitor 
line is regular and quite low. To make a dent in the 
microprocessor's nap time, size the Performance Monitor 
window so that it occupies only part of the screen and 
then start another program, such as Event Viewer. Idle time 
will dip dramatically as the other program loads into 
memory. 

~.' •... 
~ 
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C The legend area at the bottom of the window displays the names 
of the objects you chose to chart, along with the color, line style, 
and line weight (thickness) Performance Monitor uses for each. 

The chart used in the illustration on page 744 monitors three activities 
related to the processor: % Privileged Time, % Processor Time, and % User 
Time. Privileged time is the amount of time the processor devotes to exe­
cuting the programs that comprise Windows NT itself. Processor time is the 
amount of time the processor spends doing productive work. User time is 
the amount of time the processor spends executing such programs as ap­
plications, graphics and printer drivers, and the window manager. The three 
lines together show you how busy the processor is and how it is spending 
its time. To try this out for yourself, chart processor activity as you playa 
winning game of FreeCell. Do the following: 

1 . Resize the Performance Monitor window so it fits nicely in the lower 
right corner of the screen, pretty much out of the way of any cards 
you'll lay down in the area. 

2. Open the Options menu and click Always On Top. That way, you'll 
be able to play the card game and see "live action" in the chart at 
the same time. (If your concentration suffers, you'll just have to play 
another game or two ... or three.) 

Controlling What Is Displayed 
When you view charts with Performance Monitor, you have several ways 
to control what you see and how the information is presented. As mentioned 
in the preceding section, you can select Always On Top to ensure that the 
Performance Monitor window is never obscured by another window, even 
when Performance Monitor is not the active program. You can also control 
the display of the menu bar and the title bar, the toolbar, and the status bar. 
(Bear in mind that these display options apply not only to the chart window, 
but to the other views described later as well.) 

Select any of the following display options from the Options menu, or 
use the keyboard alternative shown in parentheses: 

C Menu and Title (Ctr1+M) 

C Toolbar CCtrl+T) 
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l'l Status Bar (Ctrl+S) 

l'l Always On Top (Ctrl+P) 

The following options apply to charts only. You can do any of the 
following: 

l'l Start a new chart using the New Chart command on the Edit menu. 

l'l Delete the object selected in the legend area using the Delete From 
Chart command on the Edit menu. 

l'l Change the color, pattern, and width of any or all lines used in the 
chart. To adjust any of these items, either go to the legend area 
and double-click the item you want to change, or choose Edit Chart 
Line from the Edit menu. In either case, the following dialog box 
appears. 

Edit Chart Line 

Color:I-IID Scale: <--11,_0 _---'I_il Width: I -- lID Style: I -- lID 

NOTE: Changing the scale means changing the relationship of 
the chart line to the (unscaled) vertical line of values at the left 
of the chart, thus moving the chart line up or down in the graph. 
Too drastic a change, however, can make the relationship of the 
chart line to the chart so different that the line itself becomes 
useless. 
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WINDOWS TIP: Use a heavier line for the most important 
object being monitored to emphasize that object and make 
it easy to pick out from two or more charted objects. Line 
width is more effective than line style (dotted, dashed, and 
so on) in emphasizing a chart line. (You can use styles 
only with the thinnest line.) 

c Display gridlines, turn labels on or off, switch from a graph to a 
histogram, and adjust both the vertical maximum value and the , 
update interval on the chart. To make any of these changes, choose 
Chart from the Options menu. This dialog box appears: 

[g] i:~~g~:~~) 

[g] Value Bar 

Gallery 

@ Graph 

o Histogram 

Update Time 

Chart Options 

D Vertical Grid 

D Horizontal Grid 

[g] Vertical labels 

Vertical Maximum: 

1100 

Interval (seconds): 

@ Periodic Update 1 1.000 1 

o Manual Update 

1'~i1~'1 
Ip~~l,ll~l 

IfWl~lr~11 

WINDOWS TIP: Turning on a vertical or horizontal grid 
makes a chart much easier to read. Changing the vertical 
maximum can help center chart lines. For example, if all 
the lines are near the top of the chart when the vertical 
maximum is 100, changing the vertical maximum to 200 
centers the lines on the chart. 
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In the Update Time box, you can specify the intervals between 
updates or, if you prefer, specify Manual Update. If you choose 
Manual Update, the chart remains static until you either press 
Ctrl+U, choose Update Now from the Options menu, or click the 
Update Now toolbar button (which l~oks like a camera). 

I'l Turn on chart highlighting so that the line representing the selected 
object is displayed in white. This option has no menu command; 
you turn it on and off by pressing Ctrl+H or the Backspace key. 

Printing Charts 
When you chart object performance, you might assume that Windows NT 
records the data somewhere so you can review the information later. Well, 
Windows NT can record the data, but only if you enable Performance 
Monitor's ability to create logs, as described on page 751. A chart, unlike a 
log, lives very much in the present. You might even say that a chart gives 
a slightly different twist to the meaning of WYSIWYG. What you see on a 
chart is, indeed, what you get. But you get it here and now, not over yonder 
and later. 

Does this focus on the present mean that you cannot save charted 
information? Not at all. You can save it in either of two ways: by taking 
snapshots of the screen whenever something significant occurs, or by ex­
porting the chart data to a text file for "replay" in a word processor, spread­
sheet, or database. 

To take a picture of a chart, you essentially "dump" the screen image 
into a file using a procedure that produces an image very much like the 
illustrations you've seen throughout this book. Here's what to do: 

1. If the chart you want is displayed in a window, press Alt+PrtSc to 
capture its image. If the chart is displayed full-screen, press PrtSc 
alone. Either of these keystrokes copies an image of the screen to 
the Clipboard. 

2. Clipboard contents are temporary, so as soon as you've captured 
the image you want, minimize Performance Monitor and start 
Paintbrush. 

3. When Paintbrush opens, choose Paste from the Edit menu to turn 
the image into a Paintbrush bit map. Don't move the window or 
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click the mouse just yet. Doing so will "paste down" the image into 
the Paintbrush drawing area, and if you've got a partial-screen 
image, you don't necessarily want that to happen. 

4. The next step depends on what you want to do: 

o To print either a full-screen or a partial-screen image, choose 
Print from the File menu. 

o To save a full-screen image, choose Save As from the File menu. 

o To save a partial-screen image, choose Copy To from the Edit 
menu and assign the image a name when the Copy To dialog 
box appears. Why save the image this way instead of using Save 
As? Because using CoPY To can conserve a considerable amount 
of disk space. Copy To saves only the selected image (the 
portion surrounded by a dotted line when you Paste); Save As 
saves the entire Paintbrush image area. The savings, on disk, 
can be a matter of 100 KB or more. 

Exporting Charts 
When you export chart data to a file, you export its data to a text file in 
which values can be separated either by commas or by tabs. Exporting a 
chart does not, therefore, mean that you send a picture of it to another 
program, such as Microsoft Excel. What you do is send the data which, if 
exported to a spreadsheet, can then be regraphed as a chart if the application 
is capable of doing so. 

To export a chart: 

1. Watch the chart. When the data you want to export is displayed, 
choose Export Chart from the File menu. 

2. When the Export As dialog box (which is very much like a Save As 
dialog box) appears, assign a filename and specify the extension 
you want: CSV for a comma-separated format, or TSV for a tab­
separated format. 

3. Click OK. 
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The View Through Other Windows 
Performance Monitor provides four views: charts, log, report, and alert. Of 
the four, charting provides the most colorful and easily interpreted data for 
most people, but for the character-based among us, the report view provides 
a neat, columnar alternative that displays values as numbers rather than as 
up-and-down lines on a graph. Logging, in contrast to both charting and 
reporting, takes the long view, recording object behavior for as long as you 
want, whenever you want, and enabling you to save that data for later 
review and analysis. Alert view, the most specialized, acts like a system 
smoke detector by notifying you every time the behavior of a monitored 
counter goes above or below a value you specify. 

Logs 
By far the most useful of the four views, logging is the way to create a 
historical performance record for a computer or network you are monitor­
ing. By logging activity over time you can, for example, establish a baseline 
for the system and determine when and where performance bottlenecks 
occur. Or you can monitor system performance before and after a significant 
change, such as a hardware upgrade or a reassignment of files, directories, 
or users to other machines in an attempt to ease the load on a busy server. 

When you log object behavior, Performance Monitor stores the infor­
mation you request in a file with the default extension LOG. The file contains 
not only the objects you specify, but the data collected for each object 
counter, at the intervals you request and for the length of time you keep 
the log active. After you've created a log, you can later retrieve it from disk 
and-this is important-replay the information it contains, in any view you 
choose: chart, alert, log, or report. You can even focus on the specific 
segment of time that interests you. 

Not surprisingly, performance logs, like event logs, can grow quickly 
and can take up a surprising amount of disk space. Choosing to log active 
processes, for example, at the default time interval of 15 seconds, can build 
a 100 KB file in almost no time. The moral of the story: Plan ahead. Give 
some thought to which object or objects are most appropriate to the task, 
and consider experimenting with charting or reporting before logging, so 
you can decide on a time interval that gives you a sufficient but not over­
whelming amount of data for analysis. 
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As you'll see at the end of the chapter in the section titled "Reusing 
View Settings and Your Workspace," Performance Monitor saves 
not only log data, but window and workspace settings as well. 
In addition, this versatile program can export the data in the 
current window to a text file for use with a word processor or a 
spreadsheet. To distinguish between different views and export 
types, Performance Monitor uses a number of extensions. When 
you first start using Performance Monitor logs, these extensions 
can be confusing because the File Open command lists files with 
one extension, the Export command lists files with another 
extension, and the Options Log command lists files with yet a 
third extension. None of these are required or enforced; they are 
conventions that can help you organize your work. To help you 
get your bearings, the following list gathers all of these extensions 
into one place for easy reference: 

D LOG files contain the data you collect. When you create 
a LOG file, you can replay the information in it. 

a PMC files store the settings you use in creating a chart. 
These are settings only, not data. 

m PML files store the settings you use in creating a log. Note 
that these settings represent the objects and counters you 
monitor, not the data gathered for them in a LOG file. 

I! PMR files store the settings you use in creating a report. 
Again, these are settings, not data. 

D PMA files store the settings you want used for creating 
alerts. Once again, these are settings, not data. 

I:! PMW files store the information needed to re-create your 
entire workspace, meaning all open Performance Moni­
tor windows (views) and their associated settings. 

1.1 CSV and TSV files contain the data from the current 
window exported as a text file in either comma -separated 
(CSV) or tab-separated (TSV) format. Note that exporting 
to either of these file types from log view exports dis­
played information, not the entire contents of the log file. 
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Starting and Stopping a Log 
To start a log, you begin by choosing Log from the V iew menu. When you 
do this, a new Performance Monitor window opens: 

Just as when you choose chart view, the window appears empty. The 
status bar tells you that the log is expecting to monitor current activity, but 
the Status text box at the top of the window tells you that the log is closed. 
You must open the log and add some objects to it: 

1. In the Performance Monitor window, choose Add To Log from the 
Edit menu. A simple dialog box appears, showing the name of your 
local computer by default and listing all of the objects that Perform­
ance Monitor is capable of tracking: 

Add To Log 

Computer: 1\\OMNI1 ItttJ 1!?:;:TAddl~~'1 

:;;;f:=~::=rc:=ID=iS=k ======================~a;:·· l~carilielY!'1 Objects: 

Memory 
Netbeui 
Netbeui Resource 
Objects 
Paging File 
PhysicalDisk 
Process 
Processor 
Redirector 
Server 
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Choose the computer to monitor from the Computer list box. 
Choose the object(s) to monitor from the list in the Objects box, 
click Add to add the selected object(s), and click Done to signal 
that you're through. 

Notice that the Add To Log dialog box does not include a list of 
counters like those in the Add to Chart dialog box. There's a reason 
for this: When you add an object to the log, you don't ~ add one, 
two, or three counters for that object. You add every single one. In 
this respect, creating a log is like marrying into a large family: Pick 
one, and you get 'em all. 

2. After you've told Performance Monitor what to log, you can start 
the process. Choose Log from the Options menu. This dialog box 
appears: 

Log File 
File Name: 

1_ I 

D
~ 

;\f 

.!!.irectories: 

c: \users\def ault 

E:> c:\ 
12:7 users 
~ default 

List Files of !vpe: Driyes: 

1-1 Lo-=g_F_rle--,s (=-" .I.....:og:.:...) ______ 1M .... '! IIiiiiiI c: om nil 

Update Time 
fnterval (seconds): 

@PeriodicUpdatelL...5 ____ ----lll\!l 
o Manual Update 

l!l 

I ~:;117!'l)l.c?\\~1;"1 
1~'?:tanceJ~1';11 

If you don't want to change the name of the log file or set a 
different update interval, all you do is click the Start Log button on 
the right of the dialog box. (If you choose an existing log file, the 
new data will be appended to it.) If you want to assign your own 
filename (such as a combination of date and object name, or date 
and computername), don't forget to include the LOG extension; 
Performance Monitor does not automatically add the extension for 
you. (On the other hand, it's not really necessary, so do as you like.) 
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Specify a different time interval if you want, and then, as already 
mentioned, click Start Log to set the ball rolling. That's it until you 
want to stop logging. 

3. When you want to stop recording data, choose Log from the Options 
menu again and click the Stop Log button. (If you did not assign a 
filename earlier, you can do so now.) 

That's it. Now, how do you take a look at what you've got? 

Viewing a Log 
Opening and viewing a recorded log is not the most intuitive procedure in 
the world for two main reasons: First, you don't use the File Open cQmmand 
as you might expect; second, the mere act of opening a log doesn't display 
its contents. This is how you go about viewing a log: 

1. In the Performance Monitor window, choose Data From from the 
Options menu. This dialog box appears: 

Data From ... 

Data values disolaued from-------, 

@ lI~·~.~.~.~~.fA~~i.~I~?.1 
o log File: 

I perfmonJog 

Ig01f~;1 

I~~~ 

Open the list box, and choose the log you want to view from 
the Open Input Log File dialog box that appears. Click OK. At this 
point, your screen remains. stubbornly blank, but the status bar at 
the bottom displays a message such as "Data: important.log," telling 
you that any data you choose to view will be taken from your log 
file. 

2. Now choose the view you want from the View menu. Once you've 
recorded a log, you can view it in the chart, alert, or record window, 
or you can even use the log window if you want to relog informa­
tion-for example, for a smaller or larger time interval. 
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3. Next, choose the Time Window command from the Edit menu. This 
dialog box appears: 

Input Log File Timeframe 

27 May 93 11 Jun93 

3:21:53pmD555~~~~~~12:12:12pm 
27 May 93 11 Jun 93 
3:21:53 pm 12:12:12 pm 

If;i\11frn'1TI 

Iftcancet$~l 

l~mlim1Q 
Bookmarks-------------~:::~ 

I I~". 'CtA,''i',!itlW,',I 
IfshlA'$'Sl'OP"'j 

~-----------------~ 

The Time Window command lets you display log entries for a 
specified time period. To indicate starting and stopping times, use 
the sliding bar at the top of the dialog box. (The light portion 
represents the period to be displayed; the dark color uncovered by 
the light bar represents the period that won't be displayed.) 

4. Finally, to display the data itself, choose Add To from the Edit menu 
for the view you've selected. The Add To dialog box appears, but 
as you can see by opening the Object drop-down list box, when 
you view a log, the list contains only the names of the object or ob­
jects recorded in the log. For example, if you logged only processor, 
memory, cache, and physical disk activity, these are the only objects 
you see listed. 

Choose the object for which you want to view log data and click 
Add. Next, choose the counters and, if appropriate, the instances 
that interest yOU. Do the same for every object and counter you 
want to view, and click Done when you finish. There's your log. 
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Reports 
A Performance Monitor report is basically a chart in text form, like this: 

Compuler: \\OMNI1 
Object: Processor 0 

% Privileged Time 4.493 
% Processor Time 8.051 
% User Time 3.594 

Object: Process Idle PEAFMON PBAUSH 

% Processor Time 91.949 1.198 C::::::::::::::::::::Q::g:~9j 

Although you can't see it happening in the illustration, the report 
displays constantly changing values for the objects and counters you choose 
to monitor. Creating a report is almost the same as creating a chart: 

1. In the Performance Monitor window, choose Report from the View 
menu. 

2. Choose Add To Report from the Edit menu. 

3. Choose the objects and counters you want to monitor, click Add, . 
and then click Done. 

As mentioned in the preceding section, you can also choose to display 
a log in report format. To do that, follow the steps in "Viewing a Log," page 
755, choosing report view from the View menu. Change the Time Window 
(the easiest way to do this is in chart view) to change the reported interval. 
You can also export a report to a comma-separated or a tab-separated text 
file with the Export command, as described in "Exporting Charts," page 750. 
Unlike a chart, however, an exported report contains only a single set of 
values-those displayed at the time the report is exported. To save a con­
tinuous set of values, export the data as a chart, or log the data and view it 
later in report view. 
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Alerts 
Alerts are designed to help you determine when and where a noteworthy 
event has occurred. In Performance Monitor, you can use alerts to check 
the behavior of a specific counter at periodic intervals, and to determine 
whether its performance is above or below a certain value. For example, if 
your system doesn't seem to be working efficiently, you can use Perform­
ance Monitor alerts to find out when, say, memory pages/sec exceed 20 or 
physical disk activity exceeds 75(%) for sustained periods, or free disk space 
is running short. 

As you work with Performance Monitor, you are notified whenever 
an alert occurs. If you are working in the alert window, you see a report-like 
display that gives you the details, including time, date, alert value, and other 
essentials, of every instance in which Performance Monitor checks and finds 
that the counter value is above or below the value you specified. If you are 
working in a different view, you see a number accompanied by a red circle 
with an exclamation point at the right edge of the status bar whenever an 
alert is registered: 

Alert symbol 

To set up alerts, do the following: 

1. In the Performance Monitor window, choose Alert from the View 
menu. 

2. Choose Add To Alert from the Edit menu. Choose the object and 
counter that interests you in the resulting dialog box. In addition, 
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you must specify a value in the Alert If group box and click Over 
or Under so that Performance Monitor knows when an alert occurs. 
If you want, you can also use the Run Program on Alert group box 
to specify the name of a program that you want Performance Monitor 
to run, either the first time the alert occurs or every time it occurs. 
When you finish, click Done. 

3. If you want to be switched into alert view whenever an alert occurs, 
or you want to send a network message or specify an update time 
other than the default five seconds, choose Alert from the Options 
menu and change the settings accordingly. 

As is the case with charts and reports, you can export alerts to a 
comma-separated or a tab-separated file for work in a spreadsheet, database, 
or other application. Do this with the Export Alert command on the File 
menu, as described in "Exporting Charts," page 750. 

Reusing View Settings and Your Workspace 
If you're establishing a baseline for measuring system performance, or if 
you need to check system use regularly at particular times of day, you need 
to be able to save and reuse Performance Monitor settings. You can save 
the settings for a single view, or for several views you've opened to monitor 
the behavior of the same or different objects. When you save settings, you 
not only save a record of the selected objects and counters, you also save 
the window's display options and size. You do not, however, save the data 
in the window. Remember: There's a difference between saving settings 
(the monitoring environment, so to speak) and saving data (your Perform­
ance Monitor logs). Forget this distinction and you might find yourself 
confused about whether to use the Open command on the File menu or 
the Data From command on the Options menu, as well as wondering why 
the Open command does not display the log you saved so carefully the last 
time you used Performance Monitor. 

1. To save the settings of the current window, you use the File menu: 

o Choose Save (Chart, Report, Alert, or Log) Settings; if it's the first 
time you've saved settings, assign the settings a filename in the 
Save As dialog box that appears. Pay attention to the extension 
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you choose or type. Use PMC for a chart, PMR for a report, PMA 
for an alert, or PML for a log (log settings, that is, not the log 
itself). 

o Choose Save to save the current settings under an existing 
name-for example, after you've edited previously sav~d set­
tings. 

2. To save workspace settings, use the Save Workspace command, also 
on the File menu. Assign a filename in the Save Workspace As dialog 
box that appears, and be sure to use the workspace extension, PMW. 
The Workspace saves its screen position as well as all settings. 

3. To open a window or a workspace with previously saved settings, 
use the Open command on the File menu. 

You're in business. 

WINDOWS TIP: To open settings for a single window in 
a particular view, choose the view you want before you 
choose Open from the File menu. That way, you don't 
have to specify the file extension. By default, the File Open 
dialog· box displays the names of files with the extension 
appropriate for the view you're in-PMC for charts, PMR 
for reports, and so on. 



II 

t 
II 

I I 

t r 

Using Setup and Its Relatives 
Not to be confused with the full-scale Setup that installed Windows NT 
on your machine, this little icon in the Main program group is used to 
make adjustments to your system configuration. 

Changing System Settings 
Use Setup to add a new video driver, mouse, or keyboard. 

Using Setup to Create Program Items 
Here's where to shop for program items that launch applications on your 
hard drive. Select one or many from the list that Setup offers you. 

Removing Optional Components from Your System 
You can clear out some of the optional Windows NT components that 
you never use. Later, if you change your mind, Setup will help you 
reinstall them. 
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Adding and Removing SCSI Adapters and Tape Drives 774 
Use the Drivers applet to tell your system that you've added one of these 
devices. 
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Deleting User Profiles 
Windows NT can copy another person's user profile to your computer 
when he or she logs on temporarily. Use Setup to delete that profile once 
the person leaves. 

A Note About Logging Off and Shutting Down 
Turn to this section for a last bit of advice about exiting Setup. 
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